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F60 Feeder Protection System

Chapter 1: Introduction

Introduction

This chapter outlines safety and technical support information.

1.1  Safety symbols and definitions
Before attempting to install or use the device, review all safety indicators in this document to help prevent injury, 
equipment damage, or downtime.

The following safety and equipment symbols are used in this document.

1.1.1  General cautions and warnings
The following general safety precautions and warnings apply.

Follow the requirements of this manual, including adequate wiring size and type, terminal torque settings, voltage, 
current magnitudes applied, and adequate isolation/clearance in external wiring from high to low voltage circuits.
Use the device only for its intended purpose and application.
Ensure that all ground paths are uncompromised for safety purposes during device operation and service.
Ensure that the control power applied to the device, the alternating current (AC), and voltage input match the ratings 
specified on the relay nameplate. Do not apply current or voltage in excess of the specified limits.

Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

Indicates practices not related to personal injury.

Ensure that all connections to the product are correct so as to avoid accidental risk of shock 
and/or fire, for example such as can arise from high voltage connected to low voltage terminals.
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Only qualified personnel are to operate the device. Such personnel must be thoroughly familiar with all safety 
cautions and warnings in this manual and with applicable country, regional, utility, and plant safety regulations.
Hazardous voltages can exist in the power supply and at the device connection to current transformers, voltage 
transformers, control, and test circuit terminals. Make sure all sources of such voltages are isolated prior to 
attempting work on the device.
Hazardous voltages can exist when opening the secondary circuits of live current transformers. Make sure that 
current transformer secondary circuits are shorted out before making or removing any connection to the current 
transformer (CT) input terminals of the device.
For tests with secondary test equipment, ensure that no other sources of voltages or currents are connected to such 
equipment and that trip and close commands to the circuit breakers or other switching apparatus are isolated, 
unless this is required by the test procedure and is specified by appropriate utility/plant procedure.
When the device is used to control primary equipment, such as circuit breakers, isolators, and other switching 
apparatus, all control circuits from the device to the primary equipment must be isolated while personnel are working 
on or around this primary equipment to prevent any inadvertent command from this device.
Use an external disconnect to isolate the mains voltage supply.
Personal safety can be affected if the product is physically modified by the end user. Modifications to the product 
outside of recommended wiring configuration, hardware, or programming boundaries is not recommended end-use 
practice. Product disassembly and repairs are not permitted. All service needs to be conducted by the factory.

1.2  For further assistance
For product support, contact the information and call center as follows:

GE Grid Solutions
650 Markland Street
Markham, Ontario
Canada L6C 0M1
Worldwide telephone: +1 905 927 7070
Europe/Middle East/Africa telephone: +34 94 485 88 54
North America toll-free: 1 800 547 8629
Fax: +1 905 927 5098
Worldwide e-mail: multilin.tech@ge.com
Europe e-mail: multilin.tech.euro@ge.com
Website: http://www.gegridsolutions.com/multilin 

When contacting GE by e-mail, optionally include a device information file, which is generated in the EnerVista software by 
clicking the Service Report button. The service report also can be generated in the field, for example with a USB cable 
connected between the graphical front panel and a computer, and the Device Setup configured for the USB connection.

LED transmitters are classified as IEC 60825-1 Accessible Emission Limit (AEL) Class 1M. Class 1M 
devices are considered safe to the unaided eye. Do not view directly with optical instruments.

This product is rated to Class A emissions levels and is to be used in Utility, Substation Industrial 
environments. Not to be used near electronic devices rated for Class B levels.

mailto:multilin.tech@ge.com
mailto:multilin.tech.euro@ge.com
http://www.gegridsolutions.com/multilin
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Figure 1-1: Generate service report in EnerVista software
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F60 Feeder Protection System

Chapter 2: Product description

Product description

This chapter outlines the product, order codes, and specifications.

2.1  Product description
The F60 Feeder Protection System is part of the Universal Relay (UR) series of products. It is a microprocessor-based relay 
for feeder protection.

Overvoltage and undervoltage protection, overfrequency and underfrequency protection, breaker failure protection, 
directional current supervision, fault diagnostics, remote terminal unit (RTU), and programmable logic functions are 
provided. This relay also provides phase, neutral, ground and negative sequence, instantaneous and time overcurrent 
protection. The time overcurrent function provides multiple curve shapes or FlexCurves™ for optimum co-ordination. 
Automatic reclosing, synchrocheck, and line fault locator features are also provided. When equipped with a type 8Z current 
transformer/voltage transformer (CT/VT) module, an element for detecting high impedance faults is provided.

Voltage, current, and power metering are built in as standard features. Current parameters are available as total 
waveform root mean square (RMS) magnitude, or as fundamental frequency only RMS magnitude and angle (phasor).

Diagnostic features include an event recorder that stores 1024 time-tagged events. The internal clock used for time-
tagging can be synchronized with an IRIG-B signal, using the Simple Network Time Protocol (SNTP) over the Ethernet port, 
or using the Precision Time Protocol (PTP). This precise time stamping allows the sequence of events to be determined 
throughout the system. Events can also be programmed (via FlexLogic™ equations) to trigger oscillography data capture 
that can be set to record the measured parameters before and after the event for viewing on a computer. These tools 
significantly reduce troubleshooting time and simplify report generation in the event of a system fault.

Several options are available for communication. An RS232 port (USB port with the graphical front panel) can be used to 
connect to a computer to program settings and monitor actual values. The rear RS485 port allows independent access by 
operating and engineering staff. It can be connected to system computers with baud rates up to 115.2 kbps. All serial ports 
use the Modbus RTU protocol. The IEC 60870-5-103 protocol is supported on the RS485 interface. IEC 60870-5-103, DNP, 
and Modbus cannot be enabled simultaneously on this interface. Also only one of the DNP, IEC 60870-5-103, and IEC 
60870-5-104 protocols can be enabled at any time on the relay. When the IEC 60870-5-103 protocol is chosen, the RS485 
port has a fixed even parity and the baud rate can be either 9.6 kbps or 19.2 kbps. The 100Base-FX or 100Base-TX Ethernet 
interface provides fast, reliable communications in noisy environments. The Ethernet port supports IEC 61850, IEC 61850-
90-5, Modbus/TCP, TFTP, and PTP (according to IEEE Std. 1588-2008 or IEC 61588), and it allows access to the relay via any 
standard web browser (F60 web pages). The IEC 60870-5-104 protocol is supported on the Ethernet port. The Ethernet port 
also supports the Parallel Redundancy Protocol (PRP) of IEC 62439-3 (clause 4, 2012) when purchased as an option.

GOOSE and secure Routable GOOSE (R-GOOSE) are supported with software options. Process Bus GOOSE is supported with 
a hardware module and software options.
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With a Process Bus Module that supports IEC 61850-9-2LE and IEC 61869, PRP is supported on two Ethernet ports to IEC 
62439, and High-availability Seamless Redundancy (HSR) is supported on four Ethernet ports for dual HSR ring 
architecture.

Settings and actual values can be accessed from the front panel or EnerVista software.

The F60 uses flash memory technology that allows field upgrading as new features are added. Firmware and software are 
upgradable.

The following single-line diagram illustrates the relay functionality using American National Standards Institute (ANSI) 
device numbers.

Table 2-1: ANSI device numbers and functions supported

Figure 2-1: Single-line diagram 

Device number Function Device number Function

25 Synchrocheck 51_2 Negative-sequence time overcurrent

27P Phase undervoltage 52 AC circuit breaker

27X Auxiliary undervoltage 59N Neutral overvoltage

32 Sensitive directional power 59P Phase overvoltage

32N Wattmetric zero-sequence directional 59X Auxiliary overvoltage

49 Thermal overload protection 59_2 Negative-sequence overvoltage

50BF/50NBF Breaker failure 67N Neutral directional overcurrent

50DD Disturbance detector 67P Phase directional overcurrent

50G Ground instantaneous overcurrent 67_2 Negative-sequence directional overcurrent

50N Neutral instantaneous overcurrent 79 Automatic recloser

50P Phase instantaneous overcurrent 81O Overfrequency

50_2 Negative-sequence instantaneous overcurrent 81R Rate of change frequency

51G Ground time overcurrent 81U Underfrequency

51N Neutral time overcurrent 87RGF Restricted ground fault

51P Phase time overcurrent
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Table 2-2: Other device functions

2.2  Security
The following security features are available:

• Password security — Basic security present by default

• EnerVista security — Role-based access to various EnerVista software screens and configuration elements. The 
feature is present by default in the EnerVista software.

• CyberSentry security — Advanced security available using a software option. When purchased, the option is enabled 
automatically, and the default Password security and EnerVista security are disabled.

2.2.0.1  EnerVista security
The EnerVista security management system is a role-based access control (RBAC) system that allows an administrator to 
manage the privileges of multiple users. This allows for access control of UR devices by multiple personnel within a 
substation and conforms to the principles of RBAC as defined in ANSI INCITS 359-2004. The EnerVista security 
management system is disabled by default to allow the administrator direct access to the EnerVista software after 
installation. It is recommended that security be enabled before placing the device in service.

Basic password or enhanced CyberSentry security applies, depending on purchase.

2.2.0.2  Password security
Password security is a basic security feature present by default.

Two levels of password security are provided: command and setting. Use of a password for each level controls whether all 
users can enter commands and/or change settings.

Two types of connection security are provided: password entry from local or remote connection. Local access is defined as 
access to settings or commands via the front panel interface. This includes both keypad entry and the through a front 
panel port. Remote access is defined as access to settings or commands via any rear communications port. This includes 
both Ethernet and RS485 connections. These two settings are on by default and apply to all users.

Function Function Function

Breaker arcing current (I2t) Ethernet Global Data Pilot schemes

Breaker control Event recorder Setting groups (6)

Breaker flashover Fault detector and fault report Synchrophasor (PMU)

Breaker restrike Fault locator Thermal overload protection

Broken conductor detection FlexElements™ (8) Time synchronization over IRIG-B or IEEE 
1588

Cold load pickup FlexLogic equations Time synchronization over SNTP

Contact inputs (up to 120) High impedance fault detection (Hi-Z) Transducer inputs and outputs

Contact outputs (up to 72) IEC 60870-5-103 communications User-definable displays

Control pushbuttons IEC 61850 communications User-programmable LEDs

CT failure detector IEC 62351-9 data and communications 
security

User-programmable pushbuttons

CyberSentry™ security Incipient cable fault detection User-programmable self-tests

Data logger Load encroachment Virtual inputs (64)

Demand Metering: current, voltage, power, PF, 
energy, frequency, harmonics, THD

Virtual outputs (96)

Digital counters (8) Modbus user map VT fuse failure

Digital elements (48) Non-volatile latches

Direct inputs and outputs (32) Non-volatile selector switch

Disconnect switches Oscillography
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When entering a settings or command password via EnerVista or any serial interface, the user must enter the 
corresponding connection password. If the connection is to the back of the F60, the remote password is used. If the 
connection is to a front panel port, the local password applies. (These two local and remote password settings are not 
shown the figure.)

Password access events are logged in the Event Recorder.

Figure 2-2: Access control by passwords and connection type

2.2.0.3  CyberSentry security
CyberSentry security is available using software options that provide advanced security. When the option is purchased, the 
basic password security is disabled automatically.

CyberSentry provides security through the following features:

• An Authentication, Authorization, Accounting (AAA) Remote Authentication Dial-In User Service (RADIUS) client that is 
managed centrally, enables user attribution, provides accounting of all user activities, and uses secure standards-
based strong cryptography for authentication and credential protection. In other words, this option uses a RADIUS 
server for user authentication.

• A Role-Based Access Control (RBAC) system that provides a permission model that allows access to UR device 
operations and configurations based on specific roles and individual user accounts configured on the AAA server. 
That is, Administrator, Supervisor, Engineer, Operator, and Observer roles are used.

• Security event reporting through the Syslog protocol for supporting Security Information Event Management (SIEM) 
systems for centralized cybersecurity monitoring

• Strong encryption of all access and configuration network messages between the EnerVista software and UR devices 
using the Secure Shell (SSH) protocol, the Advanced Encryption Standard (AES), and 128-bit keys in Galois Counter 
Mode (GCM) as specified in the U.S. National Security Agency Suite B extension for SSH and approved by the National 
Institute of Standards and Technology (NIST) FIPS-140-2 standards for cryptographic systems

CyberSentry user roles
CyberSentry user roles (Administrator, Supervisor, Engineer, Operator, Observer) limit the levels of access to various UR 
functions. This means that the EnerVista software allows for access to functionality based on the user’s logged in role.

Example: Administrative functions can be segmented from common operator functions, or engineering type access, all of 
which are defined by separate roles so that access of UR devices by multiple personnel within a substation is allowed.

One role of one type is allowed to be logged in at a time. For example, one Operator can be logged in but not a second 
Operator at the same time. This prevents subsets of settings from being changed at the same time.
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Figure 2-3: CyberSentry user roles 

The table lists user roles and permissions.

Table 2-3: Permissions by user role with CyberSentry

Administrator Engineer Operator Supervisor Observer

Summary Complete access Complete access 
except for
CyberSentry 
Security

Command 
menu

Authorizes
writing

Default role

Device Definition R R R R R

Settings

|---------- Product Setup

|--------------- Security 
(CyberSentry)

RW R R R R

|--------------- Supervisory See table notes R R See table 
notes

R

|--------------- Display Properties RW RW R R R

|--------------- Clear Relay Records 
(settings)

RW RW R R R

|--------------- Communications RW RW R R R

|--------------- Modbus User Map RW RW R R R

|--------------- Real Time Clock RW RW R R R

|--------------- Oscillography RW RW R R R

|--------------- Data Logger RW RW R R R

|--------------- Demand RW RW R R R

|--------------- User-Programmable 
LEDs

RW RW R R R

|--------------- User-Programmable 
Self Tests

RW RW R R R

|--------------- Control Pushbuttons RW RW R R R

|--------------- User-Programmable 
Pushbuttons

RW RW R R R

|--------------- Flex state 
Parameters

RW RW R R R

|--------------- User-Definable 
Displays

RW RW R R R

|--------------- Direct I/O RW RW R R R

|--------------- Teleprotection RW RW R R R

|--------------- Installation RW RW R R R

|---------- System Setup RW RW R R R
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Table Notes:

RW = read and write access

R = read access

Supervisor = RW (default), Administrator = R (default), Administrator = RW (only if Supervisor role is disabled)

NA = the permission is not enforced by CyberSentry security

CyberSentry user authentication
The following types of authentication are supported by CyberSentry to access the UR device:

|---------- FlexLogic RW RW R R R

|---------- Grouped Elements RW RW R R R

|---------- Control Elements RW RW R R R

|---------- Inputs / Outputs RW RW R R R

|--------------- Contact Inputs RW RW R R R

|--------------- Contact Input 
threshold

RW RW R R R

|--------------- Virtual Inputs RW RW R R R

|--------------- Contact Outputs RW RW R R R

|--------------- Virtual Outputs RW RW R R R

|--------------- Resetting RW RW R R R

|--------------- Direct Inputs RW RW R R R

|--------------- Direct Outputs RW RW R R R

|--------------- Teleprotection RW RW R R R

|--------------- Direct Analogs RW RW R R R

|--------------- Direct Integers RW RW R R R

|---------- Transducer I/O RW RW R R R

|---------- Testing RW RW R R R

|---------- Front Panel Label Designer NA NA NA NA NA

|---------- Protection Summary NA NA NA NA NA

Commands RW RW RW R R

|---------- Virtual Inputs RW RW RW R R

|---------- Clear Records RW RW RW R R

|---------- Set Date and Time RW RW RW R R

User Displays R R R R R

Targets R R R R R

Actual Values R R R R R

|---------- Front Panel R R R R R

|---------- Status R R R R R

|---------- Metering R R R R R

|---------- Transducer I/O R R R R R

|---------- Records R R R R R

|---------- Product Info R R R R R

Maintenance RW RW R R R

|---------- Modbus Analyzer NA NA NA NA NA

|---------- Change front panel RW RW RW R R

|---------- Update firmware Yes No No No No

|---------- Retrieve file Yes No No No No

Administrator Engineer Operator Supervisor Observer
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• Device Authentication (local UR device authenticates)

• Server Authentication (RADIUS server authenticates)

The EnerVista software allows access to functionality that is determined by the user role, which comes either from the local 
UR device or the RADIUS server.

The EnerVista software has a device authentication option on the login screen for accessing the UR device. When the 
"Device" button is selected, the UR uses its local authentication database and not the RADIUS server to authenticate the 
user. In this case, it uses its built-in roles (Administrator, Engineer, Supervisor, Observer, Operator, or Administrator and 
Supervisor when Device Authentication is disabled) as login names and the associated passwords are stored on the UR 
device. As such, when using the local accounts, access is not user-attributable.

In cases where user-attributable access is required especially to facilitate auditable processes for compliance reasons, use 
RADIUS authentication.

When the "Server" Authentication Type option is selected, the UR uses the RADIUS server and not its local authentication 
database to authenticate the user.

No password or security information is displayed in plain text by the EnerVista software or UR device, nor is such 
information ever transmitted without cryptographic protection.

CyberSentry server authentication

The UR has been designed to direct automatically the authentication requests based on user names. In this respect, local 
account names on the UR are considered as reserved and not used on a RADIUS server.

The UR detects automatically whether an authentication request is to be handled remotely or locally. As there are five local 
accounts possible on the UR, if the user ID credential does not match one of the five local accounts, the UR forwards 
automatically the request to a RADIUS server when one is provided.

If a RADIUS server is provided, but is unreachable over the network, server authentication requests are denied. In this 
situation, use local UR accounts to gain access to the UR system.

2.3  Order codes
The order code is on the product label and indicates the product options applicable.

The F60 is available as a 19-inch rack horizontal mount or reduced-size (¾) vertical unit. It consists of the following 
modules: power supply, CPU, CT/VT, contact input and output, transducer input and output, and inter-relay 
communications. Module options are specified at the time of ordering.

The order codes shown here are subject to change without notice. See the web page for the product for the latest options.

The letters in the top row of the table correspond to slots in the UR chassis, for example slot F, H, or U.

2.3.1  Order codes with enhanced CT/VT modules

Table 2-4: F60 order codes for horizontal units

The R-GOOSE protocol described in IEC 61850-8-1 is available through the IEC 61850 software option. R-GOOSE 
security requires the CyberSentry software option.

Process Bus GOOSE requires an IEC 61850-9-2LE / IEC 61869 Process Bus Module, as well as the IEC 61850 and IEEE 
1588 software options.

For Japanese, the settings display in Japanese on the graphical front panel, while the keys printed on the panel are 
in English.

F60 - * ** - * * * - F ** - H ** - M ** - P ** - U ** - W/X ** Full Size Horizontal Mount
BASE UNIT F60 | | | | | | | | | | | Base Unit
CPU T | | | | | | | | | | RS485 and Three Multi-mode fiber 100Base-FX (SFP with LC) 

U | | | | | | | | | | RS485 and Two Multi-mode fiber 100Base-FX (SFP with LC), One 10/100Base-TX 
(SFP with RJ45) 

V | | | | | | | | | | RS485 and Three 10/100Base-TX (SFP with RJ45)
W | | | | | | | | | | RS485 with Two 100Base-FX Ethernet, multimode ST + 10/100Base-TX Ethernet, 

RJ-45
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SOFTWARE OPTIONS 00 | | | | | | | | | No Software Options
01 | | | | | | | | | Ethernet Global Data (EGD)
03 | | | | | | | | | IEC 61850
04 | | | | | | | | | Ethernet Global Data (EGD) and IEC 61850
06 | | | | | | | | | Phasor measurement unit (PMU)
07 | | | | | | | | | Phasor measurement unit (PMU) and IEC 61850
A0 | | | | | | | | | CyberSentry Lvl 1
A1 | | | | | | | | | CyberSentry Lvl 1 and Ethernet Global Data (EGD)
A3 | | | | | | | | | CyberSentry Lvl 1 and IEC 61850
A4 | | | | | | | | | CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
A6 | | | | | | | | | CyberSentry Lvl 1 and phasor measurement unit (PMU)
A7 | | | | | | | | | CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit (PMU)
B0 | | | | | | | | | IEEE 1588
B1 | | | | | | | | | IEEE 1588 and Ethernet Global Data (EGD)
B3 | | | | | | | | | IEEE 1588 and IEC 61850
B4 | | | | | | | | | IEEE 1588 and IEC 61850 and Ethernet Global Data (EGD)
B6 | | | | | | | | | IEEE 1588 and phasor measurement unit (PMU)
B7 | | | | | | | | | IEEE 1588 and IEC 61850 and phasor measurement unit (PMU)
C0 | | | | | | | | | Parallel Redundancy Protocol (PRP)
C1 | | | | | | | | | PRP and Ethernet Global Data
C3 | | | | | | | | | PRP and IEC 61850
C4 | | | | | | | | | PRP, Ethernet Global Data, and IEC 61850
C6 | | | | | | | | | PRP and PMU
C7 | | | | | | | | | PRP, IEC 61850, and PMU
D0 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1
D1 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and Ethernet Global Data (EGD)
D3 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850
D4 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
D6 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and phasor measurement unit (PMU)
D7 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit 

(PMU)
E0 | | | | | | | | | IEEE 1588 and PRP
E1 | | | | | | | | | IEEE 1588, PRP, and Ethernet Global Dada
E3 | | | | | | | | | IEEE 1588, PRP, and IEC 61850
E4 | | | | | | | | | IEEE 1588, PRP, Ethernet Global Data, and IEC 61850
E6 | | | | | | | | | IEEE 1588, PRP, and PMU
E7 | | | | | | | | | IEEE 1588, PRP, IEC 61850, and PMU
F0 | | | | | | | | | PRP and CyberSentry Lvl1
F1 | | | | | | | | | PRP, CyberSentry Lvl1, and Ethernet Global Data
F3 | | | | | | | | | PRP, CyberSentry Lvl 1, and IEC 61850
F4 | | | | | | | | | PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
F6 | | | | | | | | | PRP, CyberSentry Lvl 1, and PMU
F7 | | | | | | | | | PRP, CyberSentry Lvl 1, IEC 61850, and PMU
G0 | | | | | | | | | IEEE 1588, PRP, and CyberSentry Lvl 1
G1 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data
G3 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and IEC 61850
G4 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
G6 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and PMU
G7 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, IEC 61850, and PMU
J0 | | | | | | | | | IEC 60870-5-103
J1 | | | | | | | | | IEC 60870-5-103 + EGD
J3 | | | | | | | | | IEC 60870-5-103 + IEC 61850
J4 | | | | | | | | | IEC 60870-5-103 + EGD + IEC 61850
J6 | | | | | | | | | IEC 60870-5-103 + PMU
J7 | | | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU
K0 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103
K1 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD
K3 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850
K4 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD + IEC 61850
K6 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + PMU
K7 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU
L0 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1
L1 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD
L3 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850
L4 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD + IEC 61850
L6 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + PMU
L7 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850 + PMU
M0 | | | | | | | | | IEC 61850 + PMU + 61850-90-5
M7 | | | | | | | | | CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MD | | | | | | | | | IEEE 1588 + IEC 61850 + PMU + 61850-90-5
MJ | | | | | | | | | PRP + IEC 61850 + PMU + 61850-90-5
MP | | | | | | | | | IEEE 1588 + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MV | | | | | | | | | IEEE 1588 + PRP + IEC 61850 + PMU + 61850-90-5
N1 | | | | | | | | | PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
N7 | | | | | | | | | IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
ND | | | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NJ | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NP | | | | | | | | | IEC 60870-5-103 + IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 

61850-90-5
MOUNT/COATING H | | | | | | | | Horizontal (19” rack) - Standard

A | | | | | | | | Horizontal (19” rack) - With harsh environmental coating
FRONT PANEL + INTERFACE C | | | | | | | English display

D | | | | | | | French display
R | | | | | | | Russian display
A | | | | | | | Chinese display
P | | | | | | | English display with 4 small and 12 large programmable pushbuttons
G | | | | | | | French display with 4 small and 12 large programmable pushbuttons
S | | | | | | | Russian display with 4 small and 12 large programmable pushbuttons
B | | | | | | | Chinese display with 4 small and 12 large programmable pushbuttons
K | | | | | | | Enhanced front panel with English display
M | | | | | | | Enhanced front panel with French display
Q | | | | | | | Enhanced front panel with Russian display
U | | | | | | | Enhanced front panel with Chinese display
L | | | | | | | Enhanced front panel with English display and user-programmable pushbuttons
N | | | | | | | Enhanced front panel with French display and user-programmable pushbuttons
T | | | | | | | Enhanced front panel with Russian display and user-programmable pushbuttons
V | | | | | | | Enhanced front panel with Chinese display and user-programmable pushbuttons
W | | | | | | | Enhanced front panel with Turkish display
Y | | | | | | | Enhanced front panel with Turkish display and user-programmable pushbuttons
I | | | | | | | Enhanced front panel with German display
J | | | | | | | Enhanced front panel with German display and user-programmable pushbuttons
H | | | | | | | Enhanced front panel with Polish display
O | | | | | | | Enhanced front panel with Polish display and user-programmable pushbuttons

F60 - * ** - * * * - F ** - H ** - M ** - P ** - U ** - W/X ** Full Size Horizontal Mount
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Table 2-5: F60 order codes for reduced-size vertical units

E | | | | | | | 7" Graphical front panel display in multiple languages with USB front port and 
user-programmable pushbuttons (English, French, Chinese, Russian, Turkish, 
German, Polish, Japanese)

POWER SUPPLY
(redundant supply must
be same type as main supply)

H | | | | | | 125 / 250 V AC/DC power supply
H | | | | | RH 125 / 250 V AC/DC with redundant 125 / 250 V AC/DC power supply
L | | | | | | 24 to 48 V (DC only) power supply
L | | | | | RL 24 to 48 V (DC only) with redundant 24 to 48 V DC power supply

ENHANCED DIAGNOSTICS CT/VT DSP
(8L, 8M, 8N, 8R require DSP to be 
enhanced diagnostic)

| | XX | XX | No DSP module (slots M and U only)
8L | 8L | | | Standard 4CT/4VT with enhanced diagnostics
8M | 8M | | | Sensitive Ground 4CT/4VT with enhanced diagnostics
8N | 8N | | | Standard 8CT with enhanced diagnostics
8R | 8R | | | Sensitive Ground 8CT with enhanced diagnostics
| | 8Z * | | | Hi-Z 4CT (required for high-impedance fault detection element)

CONTACT INPUTS/OUTPUTS XX XX XX XX XX No Module
4A 4A 4A 4A 4A 4 Solid-State (no monitoring) MOSFET outputs
4B 4B 4B 4B 4B 4 Solid-State (voltage with optional current) MOSFET outputs
4C 4C 4C 4C 4C 4 Solid-State (current with optional voltage) MOSFET outputs
4D 4D 4D 4D 4D 16 Contact inputs with Auto-Burnishing (maximum of three modules within a case)
4L 4L 4L 4L 4L 14 Form-A (no monitoring) Latching outputs
67 67 67 67 67 8 Form-A (no monitoring) outputs
6A 6A 6A 6A 6A 2 Form-A (voltage with optional current) and 2 Form-C outputs, 8 contact inputs
6B 6B 6B 6B 6B 2 Form-A (voltage with optional current) and 4 Form-C outputs, 4 contact inputs
6C 6C 6C 6C 6C 8 Form-C outputs
6D 6D 6D 6D 6D 16 Contact inputs
6E 6E 6E 6E 6E 4 Form-C outputs, 8 contact inputs
6F 6F 6F 6F 6F 8 Fast Form-C outputs
6G 6G 6G 6G 6G 4 Form-A (voltage with optional current) outputs, 8 contact inputs
6H 6H 6H 6H 6H 6 Form-A (voltage with optional current) outputs, 4 contact inputs
6K 6K 6K 6K 6K 4 Form-C and 4 Fast Form-C outputs
6L 6L 6L 6L 6L 2 Form-A (current with optional voltage) and 2 Form-C outputs, 8 contact inputs
6M 6M 6M 6M 6M 2 Form-A (current with optional voltage) and 4 Form-C outputs, 4 contact inputs
6N 6N 6N 6N 6N 4 Form-A (current with optional voltage) outputs, 8 contact inputs
6P 6P 6P 6P 6P 6 Form-A (current with optional voltage) outputs, 4 contact inputs
6R 6R 6R 6R 6R 2 Form-A (no monitoring) and 2 Form-C outputs, 8 contact inputs
6S 6S 6S 6S 6S 2 Form-A (no monitoring) and 4 Form-C outputs, 4 contact inputs
6T 6T 6T 6T 6T 4 Form-A (no monitoring) outputs, 8 contact inputs
6U 6U 6U 6U 6U 6 Form-A (no monitoring) outputs, 4 contact inputs
6V 6V 6V 6V 6V 2 Form-A outputs, 1 Form-C output, 1 Form-A latching output, 8 contact inputs
6W 6W 6W 6W 6W 30 Contact inputs - pin terminals (max 4 modules)
6X 6X 6X 6X 6X 18 Form-A (no monitoring) outputs - pin terminals (max 4 modules)

TRANSDUCER INPUTS/OUTPUTS
(select a maximum of 3 per unit)

5A 5A 5A 5A 5A 4 DCmA inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
5C 5C 5C 5C 5C 8 RTD inputs
5D 5D 5D 5D 5D 4 RTD inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
5E 5E 5E 5E 5E 4 RTD inputs, 4 DCmA inputs
5F 5F 5F 5F 5F 8 DCmA inputs

INTER-RELAY
COMMUNICATIONS
(select a maximum of 1 per unit)

2A C37.94SM, 1300 nm single-mode, ELED, 1 channel single-mode
2B C37.94SM, 1300 nm single-mode, ELED, 2 channel single-mode
2E Bi-phase, single channel
2F Bi-phase, dual channel
2G IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 1 Channel
2H IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 2 Channels
2I Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1300 nm, single-mode, 

Laser
2J Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1550 nm, single-mode, 

Laser
72 1550 nm, single-mode, Laser, 1 Channel
73 1550 nm, single-mode, Laser, 2 Channel
74 Channel 1 - RS422; Channel 2 - 1550 nm, single-mode, Laser
75 Channel 1 - G.703; Channel 2 - 1550 nm, Single-mode Laser
76 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 1 Channel
77 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 2 Channels
7A 820 nm, multimode, LED, 1 Channel
7B 1300 nm, multimode, LED, 1 Channel
7C 1300 nm, single-mode, ELED, 1 Channel
7D 1300 nm, single-mode, Laser, 1 Channel
7E Channel 1 - G.703; Channel 2 - 820 nm, multimode
7F Channel 1 - G.703; Channel 2 - 1300 nm, multimode
7G Channel 1 - G.703; Channel 2 - 1300 nm, single-mode ELED
7H 820 nm, multimode, LED, 2 Channels
7I 1300 nm, multimode, LED, 2 Channels
7J 1300 nm, single-mode, ELED, 2 Channels
7K 1300 nm, single-mode, Laser, 2 Channels
7L Channel 1 - RS422; Channel 2 - 820 nm, multimode, LED
7M Channel 1 - RS422; Channel 2 - 1300 nm, multimode, LED
7N Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, ELED
7P Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, Laser
7Q Channel 1 - G.703; Channel 2 - 1300 nm, single-mode Laser
7R G.703, 1 Channel
7S G.703, 2 Channels
7T RS422, 1 Channel
7W RS422, 2 Channels

* When an 8Z module is ordered, rear slot F must have an 8F or 8G module.

F60 - * ** - * * * - F ** - H ** - M ** - P/R ** Reduced Size Vertical Mount (see note regarding P/R slot below)
BASE UNIT F60 | | | | | | | | | Base Unit
CPU T | | | | | | | | RS485 and Three Multi-mode fiber 100Base-FX (SFP with LC) 

U | | | | | | | | RS485 and Two Multi-mode fiber 100Base-FX (SFP with LC), One 10/100Base-TX 
(SFP with RJ45) 

V | | | | | | | | RS485 and Three 10/100Base-TX (SFP with RJ45)
W | | | | | | | | RS485 with Two 100Base-FX Ethernet, multimode ST + 10/100Base-TX Ethernet, 

RJ-45

F60 - * ** - * * * - F ** - H ** - M ** - P ** - U ** - W/X ** Full Size Horizontal Mount
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SOFTWARE OPTIONS 00 | | | | | | | No Software Options
01 | | | | | | | Ethernet Global Data (EGD)
03 | | | | | | | IEC 61850
04 | | | | | | | Ethernet Global Data (EGD) and IEC 61850
06 | | | | | | | Phasor measurement unit (PMU)
07 | | | | | | | Phasor measurement unit (PMU) and IEC 61850
A0 | | | | | | | CyberSentry Lvl 1
A1 | | | | | | | CyberSentry Lvl 1 and Ethernet Global Data (EGD)
A3 | | | | | | | CyberSentry Lvl 1 and IEC 61850
A4 | | | | | | | CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
A6 | | | | | | | CyberSentry Lvl 1 and phasor measurement unit (PMU)
A7 | | | | | | | CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit (PMU)
B0 | | | | | | | IEEE 1588
B1 | | | | | | | IEEE 1588 and Ethernet Global Data (EGD)
B3 | | | | | | | IEEE 1588 and IEC 61850
B4 | | | | | | | IEEE 1588 and IEC 61850 and Ethernet Global Data (EGD)
B6 | | | | | | | IEEE 1588 and phasor measurement unit (PMU)
B7 | | | | | | | IEEE 1588 and IEC 61850 and phasor measurement unit (PMU)
C0 | | | | | | | Parallel Redundancy Protocol (PRP)
C1 | | | | | | | PRP and Ethernet Global Data
C3 | | | | | | | PRP and IEC 61850
C4 | | | | | | | PRP, Ethernet Global Data, and IEC 61850
C6 | | | | | | | PRP and PMU
C7 | | | | | | | PRP, IEC 61850, and PMU
D0 | | | | | | | IEEE 1588 and CyberSentry Lvl 1
D1 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and Ethernet Global Data (EGD)
D3 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850
D4 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
D6 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and phasor measurement unit (PMU)
D7 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit 

(PMU)
E0 | | | | | | | IEEE 1588 and PRP
E1 | | | | | | | IEEE 1588, PRP, and Ethernet Global Dada
E3 | | | | | | | IEEE 1588, PRP, and IEC 61850
E4 | | | | | | | IEEE 1588, PRP, Ethernet Global Data, and IEC 61850
E6 | | | | | | | IEEE 1588, PRP, and PMU
E7 | | | | | | | IEEE 1588, PRP, IEC 61850, and PMU
F0 | | | | | | | PRP and CyberSentry Lvl1
F1 | | | | | | | PRP, CyberSentry Lvl1, and Ethernet Global Data
F3 | | | | | | | PRP, CyberSentry Lvl 1, and IEC 61850
F4 | | | | | | | PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
F6 | | | | | | | PRP, CyberSentry Lvl 1, and PMU
F7 | | | | | | | PRP, CyberSentry Lvl 1, IEC 61850, and PMU
G0 | | | | | | | IEEE 1588, PRP, and CyberSentry Lvl 1
G1 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data
G3 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and IEC 61850
G4 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
G6 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and PMU
G7 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, IEC 61850, and PMU
J0 | | | | | | | IEC 60870-5-103
J1 | | | | | | | IEC 60870-5-103 + EGD
J3 | | | | | | | IEC 60870-5-103 + IEC 61850
J4 | | | | | | | IEC 60870-5-103 + EGD + IEC 61850
J6 | | | | | | | IEC 60870-5-103 + PMU
J7 | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU
K0 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103
K1 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD
K3 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850
K4 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD + IEC 61850
K6 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + PMU
K7 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU
L0 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1
L1 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD
L3 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850
L4 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD + IEC 61850
L6 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + PMU
L7 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850 + PMU
M0 | | | | | | | IEC 61850 + PMU + 61850-90-5
M7 | | | | | | | CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MD | | | | | | | IEEE 1588 + IEC 61850 + PMU + 61850-90-5
MJ | | | | | | | PRP + IEC 61850 + PMU + 61850-90-5
MP | | | | | | | IEEE 1588 + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MV | | | | | | | IEEE 1588 + PRP + IEC 61850 + PMU + 61850-90-5
N1 | | | | | | | PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
N7 | | | | | | | IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
ND | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NJ | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NP | | | | | | | IEC 60870-5-103 + IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 

61850-90-5
MOUNT/COATING V | | | | | | Vertical (3/4 rack) - Standard

B | | | | | | Vertical (3/4 rack) - With harsh environmental coating
FRONT PANEL + INTERFACE F | | | | | English display

K | | | | | Enhanced front panel with English display
M | | | | | Enhanced front panel with French display
Q | | | | | Enhanced front panel with Russian display
U | | | | | Enhanced front panel with Chinese display
L | | | | | Enhanced front panel with English display and user-programmable pushbuttons
N | | | | | Enhanced front panel with French display and user-programmable pushbuttons
T | | | | | Enhanced front panel with Russian display and user-programmable pushbuttons
V | | | | | Enhanced front panel with Chinese display and user-programmable pushbuttons
W | | | | | Enhanced front panel with Turkish display
Y | | | | | Enhanced front panel with Turkish display and user-programmable pushbuttons
I | | | | | Enhanced front panel with German display
J | | | | | Enhanced front panel with German display and user-programmable pushbuttons

F60 - * ** - * * * - F ** - H ** - M ** - P/R ** Reduced Size Vertical Mount (see note regarding P/R slot below)
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2.3.2  Order codes with process bus modules

Table 2-6: F60 order codes for horizontal units with process bus

POWER SUPPLY H | | | | 125 / 250 V AC/DC power supply
L | | | | 24 to 48 V (DC only) power supply

ENHANCED DIAGNOSTICS CT/VT DSP
(8L, 8M, 8N, 8R require DSP to be 
enhanced diagnostic)

XX | XX | No DSP module (slots F and M only)
8L | 8L | Standard 4CT/4VT with enhanced diagnostics
8M | 8M | Sensitive Ground 4CT/4VT with enhanced diagnostics
8N | 8N | Standard 8CT with enhanced diagnostics
8R | 8R | Sensitive Ground 8CT with enhanced diagnostics
| | 8Z * | Hi-Z 4CT (required for high-impedance fault detection element)

CONTACT INPUTS/OUTPUTS XX XX XX No Module
4A 4A 4A 4 Solid-State (no monitoring) MOSFET outputs
4B 4B 4B 4 Solid-State (voltage with optional current) MOSFET outputs
4C 4C 4C 4 Solid-State (current with optional voltage) MOSFET outputs
4D 4D 4D 16 Contact inputs with Auto-Burnishing (maximum of three modules within a case)
4L 4L 4L 14 Form-A (no monitoring) Latching outputs
67 67 67 8 Form-A (no monitoring) outputs
6A 6A 6A 2 Form-A (voltage with optional current) and 2 Form-C outputs, 8 contact inputs
6B 6B 6B 2 Form-A (voltage with optional current) and 4 Form-C outputs, 4 contact inputs
6C 6C 6C 8 Form-C outputs
6D 6D 6D 16 Contact inputs
6E 6E 6E 4 Form-C outputs, 8 contact inputs
6F 6F 6F 8 Fast Form-C outputs
6G 6G 6G 4 Form-A (voltage with optional current) outputs, 8 contact inputs
6H 6H 6H 6 Form-A (voltage with optional current) outputs, 4 contact inputs
6K 6K 6K 4 Form-C and 4 Fast Form-C outputs
6L 6L 6L 2 Form-A (current with optional voltage) and 2 Form-C outputs, 8 contact inputs
6M 6M 6M 2 Form-A (current with optional voltage) and 4 Form-C outputs, 4 contact inputs
6N 6N 6N 4 Form-A (current with optional voltage) outputs, 8 contact inputs
6P 6P 6P 6 Form-A (current with optional voltage) outputs, 4 contact inputs
6R 6R 6R 2 Form-A (no monitoring) and 2 Form-C outputs, 8 contact inputs
6S 6S 6S 2 Form-A (no monitoring) and 4 Form-C outputs, 4 contact inputs
6T 6T 6T 4 Form-A (no monitoring) outputs, 8 contact inputs
6U 6U 6U 6 Form-A (no monitoring) outputs, 4 contact inputs
6V 6V 6V 2 Form-A outputs, 1 Form-C output, 2 Form-A (no monitoring) latching outputs, 8 

contact inputs
6W 6W 6W 30 Contact inputs - pin terminals (max 4 modules)
6W 6X 6X 18 Form-A (no monitoring) outputs - pin terminals (max 4 modules)

TRANSDUCER INPUTS/OUTPUTS
(select a maximum of 3 per unit)

5A 5A 5A 4 DCmA inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
5C 5C 5C 8 RTD inputs
5D 5D 5D 4 RTD inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
5E 5E 5E 4 RTD inputs, 4 DCmA inputs
5F 5F 5F 8 DCmA inputs

INTER-RELAY
COMMUNICATIONS
(select a maximum of 1 per unit)
For the last module, rear slot P is used for digital and 
transducer input/output modules; rear slot R is used for 
inter-relay communications modules.

2A C37.94SM, 1300 nm single-mode, ELED, 1 channel single-mode
2B C37.94SM, 1300 nm single-mode, ELED, 2 channel single-mode
2E Bi-phase, single channel
2F Bi-phase, dual channel
2G IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 1 Channel
2H IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 2 Channels
2I Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1300 nm, single-mode, 

Laser
2J Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1550 nm, single-mode, 

Laser
72 1550 nm, single-mode, Laser, 1 Channel
73 1550 nm, single-mode, Laser, 2 Channel
74 Channel 1 - RS422; Channel 2 - 1550 nm, single-mode, Laser
75 Channel 1 - G.703; Channel 2 - 1550 nm, single-mode Laser
76 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 1 Channel
77 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 2 Channels
7A 820 nm, multimode, LED, 1 Channel
7B 1300 nm, multimode, LED, 1 Channel
7C 1300 nm, single-mode, ELED, 1 Channel
7D 1300 nm, single-mode, Laser, 1 Channel
7E Channel 1 - G.703; Channel 2 - 820 nm, multimode
7F Channel 1 - G.703; Channel 2 - 1300 nm, multimode
7G Channel 1 - G.703; Channel 2 - 1300 nm, single-mode ELED
7H 820 nm, multimode, LED, 2 Channels
7I 1300 nm, multimode, LED, 2 Channels
7J 1300 nm, single-mode, ELED, 2 Channels
7K 1300 nm, single-mode, Laser, 2 Channels
7L Channel 1 - RS422; Channel 2 - 820 nm, multimode, LED
7M Channel 1 - RS422; Channel 2 - 1300 nm, multimode, LED
7N Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, ELED
7P Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, Laser
7Q Channel 1 - G.703; Channel 2 - 1300 nm, single-mode Laser
7R G.703, 1 Channel
7S G.703, 2 Channels
7T RS422, 1 Channel
7W RS422, 2 Channels

* When an 8Z module is ordered, slot F must have an 8F or 8G module.

F60 - * ** - * * * - F ** - H ** - M ** - P ** - U ** - W/X ** Full Size Horizontal Mount
BASE UNIT F60 | | | | | | | | | | | Base Unit
CPU T | | | | | | | | | | RS485 and Three Multi-mode fiber 100Base-FX (SFP with LC) 

U | | | | | | | | | | RS485 and Two Multi-mode fiber 100Base-FX (SFP with LC), One 10/100Base-TX 
(SFP with RJ45) 

V | | | | | | | | | | RS485 and Three 10/100Base-TX (SFP with RJ45)
W | | | | | | | | | | RS485 with Two 100Base-FX Ethernet, multimode ST + 10/100Base-TX Ethernet, 

RJ-45

F60 - * ** - * * * - F ** - H ** - M ** - P/R ** Reduced Size Vertical Mount (see note regarding P/R slot below)
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SOFTWARE OPTIONS 00 | | | | | | | | | No Software Options
01 | | | | | | | | | Ethernet Global Data (EGD)
03 | | | | | | | | | IEC 61850
04 | | | | | | | | | Ethernet Global Data (EGD) and IEC 61850
06 | | | | | | | | | Phasor measurement unit (PMU)
07 | | | | | | | | | Phasor measurement unit (PMU) and IEC 61850
A0 | | | | | | | | | CyberSentry Lvl 1
A1 | | | | | | | | | CyberSentry Lvl 1 and Ethernet Global Data (EGD)
A3 | | | | | | | | | CyberSentry Lvl 1 and IEC 61850
A4 | | | | | | | | | CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
A6 | | | | | | | | | CyberSentry Lvl 1 and phasor measurement unit (PMU)
A7 | | | | | | | | | CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit (PMU)
B0 | | | | | | | | | IEEE 1588
B1 | | | | | | | | | IEEE 1588 and Ethernet Global Data (EGD)
B3 | | | | | | | | | IEEE 1588 and IEC 61850
B4 | | | | | | | | | IEEE 1588 and IEC 61850 and Ethernet Global Data (EGD)
B6 | | | | | | | | | IEEE 1588 and phasor measurement unit (PMU)
B7 | | | | | | | | | IEEE 1588 and IEC 61850 and phasor measurement unit (PMU)
C0 | | | | | | | | | Parallel Redundancy Protocol (PRP)
C1 | | | | | | | | | PRP and Ethernet Global Data
C3 | | | | | | | | | PRP and IEC 61850
C4 | | | | | | | | | PRP, Ethernet Global Data, and IEC 61850
C6 | | | | | | | | | PRP and PMU
C7 | | | | | | | | | PRP, IEC 61850, and PMU
D0 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1
D1 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and Ethernet Global Data (EGD)
D3 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850
D4 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
D6 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and phasor measurement unit (PMU)
D7 | | | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit 

(PMU)
E0 | | | | | | | | | IEEE 1588 and PRP
E1 | | | | | | | | | IEEE 1588, PRP, and Ethernet Global Dada
E3 | | | | | | | | | IEEE 1588, PRP, and IEC 61850
E4 | | | | | | | | | IEEE 1588, PRP, Ethernet Global Data, and IEC 61850
E6 | | | | | | | | | IEEE 1588, PRP, and PMU
E7 | | | | | | | | | IEEE 1588, PRP, IEC 61850, and PMU
F0 | | | | | | | | | PRP and CyberSentry Lvl1
F1 | | | | | | | | | PRP, CyberSentry Lvl1, and Ethernet Global Data
F3 | | | | | | | | | PRP, CyberSentry Lvl 1, and IEC 61850
F4 | | | | | | | | | PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
F6 | | | | | | | | | PRP, CyberSentry Lvl 1, and PMU
F7 | | | | | | | | | PRP, CyberSentry Lvl 1, IEC 61850, and PMU
G0 | | | | | | | | | IEEE 1588, PRP, and CyberSentry Lvl 1
G1 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data
G3 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and IEC 61850
G4 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
G6 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and PMU
G7 | | | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, IEC 61850, and PMU
J0 | | | | | | | | | IEC 60870-5-103
J1 | | | | | | | | | IEC 60870-5-103 + EGD
J3 | | | | | | | | | IEC 60870-5-103 + IEC 61850
J4 | | | | | | | | | IEC 60870-5-103 + EGD + IEC 61850
J6 | | | | | | | | | IEC 60870-5-103 + PMU
J7 | | | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU
K0 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103
K1 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD
K3 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850
K4 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD + IEC 61850
K6 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + PMU
K7 | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU
L0 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1
L1 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD
L3 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850
L4 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD + IEC 61850
L6 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + PMU
L7 | | | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850 + PMU
M0 | | | | | | | | | IEC 61850 + PMU + 61850-90-5
M7 | | | | | | | | | CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MD | | | | | | | | | IEEE 1588 + IEC 61850 + PMU + 61850-90-5
MJ | | | | | | | | | PRP + IEC 61850 + PMU + 61850-90-5
MP | | | | | | | | | IEEE 1588 + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MV | | | | | | | | | IEEE 1588 + PRP + IEC 61850 + PMU + 61850-90-5
N1 | | | | | | | | | PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
N7 | | | | | | | | | IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
ND | | | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NJ | | | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NP | | | | | | | | | IEC 60870-5-103 + IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 

61850-90-5
MOUNT/COATING H | | | | | | | | Horizontal (19” rack) - Standard

A | | | | | | | | Horizontal (19” rack) - With harsh environmental coating
FRONT PANEL + INTERFACE C | | | | | | | English display

D | | | | | | | French display
R | | | | | | | Russian display
A | | | | | | | Chinese display
P | | | | | | | English display with 4 small and 12 large programmable pushbuttons
G | | | | | | | French display with 4 small and 12 large programmable pushbuttons
S | | | | | | | Russian display with 4 small and 12 large programmable pushbuttons
B | | | | | | | Chinese display with 4 small and 12 large programmable pushbuttons
K | | | | | | | Enhanced front panel with English display
M | | | | | | | Enhanced front panel with French display
Q | | | | | | | Enhanced front panel with Russian display
U | | | | | | | Enhanced front panel with Chinese display
L | | | | | | | Enhanced front panel with English display and user-programmable pushbuttons
N | | | | | | | Enhanced front panel with French display and user-programmable pushbuttons
T | | | | | | | Enhanced front panel with Russian display and user-programmable pushbuttons
V | | | | | | | Enhanced front panel with Chinese display and user-programmable pushbuttons
W | | | | | | | Enhanced front panel with Turkish display
Y | | | | | | | Enhanced front panel with Turkish display and user-programmable pushbuttons
I | | | | | | | Enhanced front panel with German display
J | | | | | | | Enhanced front panel with German display and user-programmable pushbuttons
H | | | | | | | Enhanced front panel with Polish display
O | | | | | | | Enhanced front panel with Polish display and user-programmable pushbuttons

F60 - * ** - * * * - F ** - H ** - M ** - P ** - U ** - W/X ** Full Size Horizontal Mount
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Table 2-7: F60 order codes for reduced-size vertical units with process bus

E | | | | | | | 7" Graphical front panel display in multiple languages with USB front port and 
user-programmable pushbuttons (English, French, Chinese, Russian, Turkish, 
German, Polish, Japanese)

POWER SUPPLY
(redundant supply must
be same type as main supply)

H | | | | | | 125 / 250 V AC/DC power supply
H | | | | | RH 125 / 250 V AC/DC with redundant 125 / 250 V AC/DC power supply
L | | | | | | 24 to 48 V (DC only) power supply
L | | | | | RL 24 to 48 V (DC only) with redundant 24 to 48 V DC power supply

PROCESS BUS
(non-HardFiber requires IEC 61850 
and IEEE 1588 software options)

XX 81 XX | XX | IEC 61850 Process Bus Module for HardFiber, 8 x
XX 85 XX | XX | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 2 x 1000Base-F, LC
XX 86 XX | XX | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 1000Base-F + 4 x 

100Base-FX, LC
XX 87 XX | XX | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 100Base-FX, LC

CONTACT INPUTS/OUTPUTS XX XX XX XX XX No Module
4A 4A | 4 Solid-State (no monitoring) MOSFET outputs
4B 4B | 4 Solid-State (voltage with optional current) MOSFET outputs
4C 4C | 4 Solid-State (current with optional voltage) MOSFET outputs
4D 4D | 16 Contact inputs with Auto-Burnishing (maximum of three modules within a case)
4L 4L | 14 Form-A (no monitoring) Latching outputs
67 67 | 8 Form-A (no monitoring) outputs
6A 6A | 2 Form-A (voltage with optional current) and 2 Form-C outputs, 8 contact inputs
6B 6B | 2 Form-A (voltage with optional current) and 4 Form-C outputs, 4 contact inputs
6C 6C | 8 Form-C outputs
6D 6D | 16 Contact inputs
6E 6E | 4 Form-C outputs, 8 contact inputs
6F 6F | 8 Fast Form-C outputs
6G 6G | 4 Form-A (voltage with optional current) outputs, 8 contact inputs
6H 6H | 6 Form-A (voltage with optional current) outputs, 4 contact inputs
6K 6K | 4 Form-C and 4 Fast Form-C outputs
6L 6L | 2 Form-A (current with optional voltage) and 2 Form-C outputs, 8 contact inputs
6M 6M | 2 Form-A (current with optional voltage) and 4 Form-C outputs, 4 contact inputs
6N 6N | 4 Form-A (current with optional voltage) outputs, 8 contact inputs
6P 6P | 6 Form-A (current with optional voltage) outputs, 4 contact inputs
6R 6R | 2 Form-A (no monitoring) and 2 Form-C outputs, 8 contact inputs
6S 6S | 2 Form-A (no monitoring) and 4 Form-C outputs, 4 contact inputs
6T 6T | 4 Form-A (no monitoring) outputs, 8 contact inputs
6U 6U | 6 Form-A (no monitoring) outputs, 4 contact inputs
6V 6V | 2 Form-A outputs, 1 Form-C output, 2 Form-A (no monitoring) latching outputs, 8 

contact inputs
6W 6W | 30 Contact inputs - pin terminals (max 4 modules)
6X 6X | 18 Form-A (no monitoring) outputs - pin terminals (max 4 modules)

INTER-RELAY
COMMUNICATIONS
(select a maximum of 1 per unit)

2A C37.94SM, 1300 nm single-mode, ELED, 1 channel single-mode
2B C37.94SM, 1300 nm single-mode, ELED, 2 channel single-mode
2E Bi-phase, single channel
2F Bi-phase, dual channel
2G IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 1 Channel
2H IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 2 Channels
2I Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1300 nm, single-mode, 

Laser
2J Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1550 nm, single-mode, 

Laser
72 1550 nm, single-mode, Laser, 1 Channel
73 1550 nm, single-mode, Laser, 2 Channel
74 Channel 1 - RS422; Channel 2 - 1550 nm, single-mode, Laser
75 Channel 1 - G.703; Channel 2 - 1550 nm, single-mode Laser
76 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 1 Channel
77 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 2 Channels
7A 820 nm, multimode, LED, 1 Channel
7B 1300 nm, multimode, LED, 1 Channel
7C 1300 nm, single-mode, ELED, 1 Channel
7D 1300 nm, single-mode, Laser, 1 Channel
7E Channel 1 - G.703; Channel 2 - 820 nm, multimode
7F Channel 1 - G.703; Channel 2 - 1300 nm, multimode
7G Channel 1 - G.703; Channel 2 - 1300 nm, single-mode ELED
7H 820 nm, multimode, LED, 2 Channels
7I 1300 nm, multimode, LED, 2 Channels
7J 1300 nm, single-mode, ELED, 2 Channels
7K 1300 nm, single-mode, Laser, 2 Channels
7L Channel 1 - RS422; Channel 2 - 820 nm, multimode, LED
7M Channel 1 - RS422; Channel 2 - 1300 nm, multimode, LED
7N Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, ELED
7P Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, Laser
7Q Channel 1 - G.703; Channel 2 - 1300 nm, single-mode Laser
7R G.703, 1 Channel
7S G.703, 2 Channels
7T RS422, 1 Channel
7W RS422, 2 Channels

F60 - * ** - * * * - F ** - H ** - M ** - P/R ** Reduced Size Vertical Mount (see note regarding P/R slot below)
BASE UNIT F60 | | | | | | | | | Base Unit
CPU T | | | | | | | | RS485 and Three Multi-mode fiber 100Base-FX (SFP with LC) 

U | | | | | | | | RS485 and Two Multi-mode fiber 100Base-FX (SFP with LC), One 10/100Base-TX 
(SFP with RJ45) 

V | | | | | | | | RS485 and Three 10/100Base-TX (SFP with RJ45)
W | | | | | | | | RS485 with Two 100Base-FX Ethernet, multimode ST + 10/100Base-TX Ethernet, 

RJ-45

F60 - * ** - * * * - F ** - H ** - M ** - P ** - U ** - W/X ** Full Size Horizontal Mount
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SOFTWARE OPTIONS 00 | | | | | | | No Software Options
01 | | | | | | | Ethernet Global Data (EGD)
03 | | | | | | | IEC 61850
04 | | | | | | | Ethernet Global Data (EGD) and IEC 61850
06 | | | | | | | Phasor measurement unit (PMU)
07 | | | | | | | Phasor measurement unit (PMU) and IEC 61850
A0 | | | | | | | CyberSentry Lvl 1
A1 | | | | | | | CyberSentry Lvl 1 and Ethernet Global Data (EGD)
A3 | | | | | | | CyberSentry Lvl 1 and IEC 61850
A4 | | | | | | | CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
A6 | | | | | | | CyberSentry Lvl 1 and phasor measurment unit (PMU)
A7 | | | | | | | CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit (PMU)
B0 | | | | | | | IEEE 1588
B1 | | | | | | | IEEE 1588 and Ethernet Global Data (EGD)
B3 | | | | | | | IEEE 1588 and IEC 61850
B4 | | | | | | | IEEE 1588 and IEC 61850 and Ethernet Global Data (EGD)
B6 | | | | | | | IEEE 1588 and phasor measurement unit (PMU)
B7 | | | | | | | IEEE 1588 and IEC 61850 and phasor measurement unit (PMU)
C0 | | | | | | | Parallel Redundancy Protocol (PRP)
C1 | | | | | | | PRP and Ethernet Global Data
C3 | | | | | | | PRP and IEC 61850
C4 | | | | | | | PRP, Ethernet Global Data, and IEC 61850
C6 | | | | | | | PRP and PMU
C7 | | | | | | | PRP, IEC 61850, and PMU
D0 | | | | | | | IEEE 1588 and CyberSentry Lvl 1
D1 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and Ethernet Global Data (EGD)
D3 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850
D4 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and Ethernet Global Data (EGD)
D6 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and phasor measurement unit (PMU)
D7 | | | | | | | IEEE 1588 and CyberSentry Lvl 1 and IEC 61850 and phasor measurement unit 

(PMU)
E0 | | | | | | | IEEE 1588 and PRP
E1 | | | | | | | IEEE 1588, PRP, and Ethernet Global Dada
E3 | | | | | | | IEEE 1588, PRP, and IEC 61850
E4 | | | | | | | IEEE 1588, PRP, Ethernet Global Data, and IEC 61850
E6 | | | | | | | IEEE 1588, PRP, and PMU
E7 | | | | | | | IEEE 1588, PRP, IEC 61850, and PMU
F0 | | | | | | | PRP and CyberSentry Lvl1
F1 | | | | | | | PRP, CyberSentry Lvl1, and Ethernet Global Data
F3 | | | | | | | PRP, CyberSentry Lvl 1, and IEC 61850
F4 | | | | | | | PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
F6 | | | | | | | PRP, CyberSentry Lvl 1, and PMU
F7 | | | | | | | PRP, CyberSentry Lvl 1, IEC 61850, and PMU
G0 | | | | | | | IEEE 1588, PRP, and CyberSentry Lvl 1
G1 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data
G3 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and IEC 61850
G4 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, Ethernet Global Data, and IEC 61850
G6 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, and PMU
G7 | | | | | | | IEEE 1588, PRP, CyberSentry Lvl 1, IEC 61850, and PMU
J0 | | | | | | | IEC 60870-5-103
J1 | | | | | | | IEC 60870-5-103 + EGD
J3 | | | | | | | IEC 60870-5-103 + IEC 61850
J4 | | | | | | | IEC 60870-5-103 + EGD + IEC 61850
J6 | | | | | | | IEC 60870-5-103 + PMU
J7 | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU
K0 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103
K1 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD
K3 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850
K4 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + EGD + IEC 61850
K6 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + PMU
K7 | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU
L0 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1
L1 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD
L3 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850
L4 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + EGD + IEC 61850
L6 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + PMU
L7 | | | | | | | IEC 60870-5-103 + IEEE1588 + PRP + CyberSentry Lvl 1 + IEC 61850 + PMU
M0 | | | | | | | IEC 61850 + PMU + 61850-90-5
M7 | | | | | | | CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MD | | | | | | | IEEE 1588 + IEC 61850 + PMU + 61850-90-5
MJ | | | | | | | PRP + IEC 61850 + PMU + 61850-90-5
MP | | | | | | | IEEE 1588 + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
MV | | | | | | | IEEE 1588 + PRP + IEC 61850 + PMU + 61850-90-5
N1 | | | | | | | PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
N7 | | | | | | | IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 61850-90-5
ND | | | | | | | IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NJ | | | | | | | IEEE 1588 + PRP + IEC 60870-5-103 + IEC 61850 + PMU + 61850-90-5
NP | | | | | | | IEC 60870-5-103 + IEEE 1588 + PRP + CyberSentry UR Lvl 1 + IEC 61850 + PMU + 

61850-90-5
MOUNT/COATING V | | | | | | Vertical (3/4 rack) - Standard

B | | | | | | Vertical (3/4 rack) - With harsh environmental coating
FRONT PANEL + INTERFACE F | | | | | English display

D | | | | | French display
R | | | | | Russian display
A | | | | | Chinese display
K | | | | | Enhanced front panel with English display
M | | | | | Enhanced front panel with French display
Q | | | | | Enhanced front panel with Russian display
U | | | | | Enhanced front panel with Chinese display
L | | | | | Enhanced front panel with English display and user-programmable pushbuttons
N | | | | | Enhanced front panel with French display and user-programmable pushbuttons
T | | | | | Enhanced front panel with Russian display and user-programmable pushbuttons
V | | | | | Enhanced front panel with Chinese display and user-programmable pushbuttons
W | | | | | Enhanced front panel with Turkish display
Y | | | | | Enhanced front panel with Turkish display and user-programmable pushbuttons
I | | | | | Enhanced front panel with German display
J | | | | | Enhanced front panel with German display and user-programmable pushbuttons

F60 - * ** - * * * - F ** - H ** - M ** - P/R ** Reduced Size Vertical Mount (see note regarding P/R slot below)
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2.3.3  Replacement modules
Replacement modules can be ordered separately. When ordering a replacement CPU module or front panel, provide the 
serial number of your existing unit.

Not all replacement modules apply to the F60 relay. The modules specified in the order codes for the F60 are available as 
replacement modules for the F60.

The order codes shown here are subject to change without notice. See the web page for the product for the latest options.

Table 2-8: UR order codes for replacement modules, horizontal units

POWER SUPPLY H | | | | 125 / 250 V AC/DC power supply
L | | | | 24 to 48 V (DC only) power supply

PROCESS BUS
(non-HardFiber requires IEC 61850 
and IEEE 1588 software options)

XX 81 XX | IEC 61850 Process Bus Module for HardFiber, 8 x
XX 85 XX | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 2 x 1000Base-F, LC
XX 86 XX | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 1000Base-F + 4 x 

100Base-FX, LC
XX 87 XX | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 100Base-FX, LC

CONTACT INPUTS/OUTPUTS XX XX XX No Module
4A 4 Solid-State (no monitoring) MOSFET outputs
4B 4 Solid-State (voltage with optional current) MOSFET outputs
4C 4 Solid-State (current with optional voltage) MOSFET outputs
4D 16 Contact inputs with Auto-Burnishing (maximum of three modules within a case)
4L 14 Form-A (no monitoring) Latching outputs
67 8 Form-A (no monitoring) outputs
6A 2 Form-A (voltage with optional current) and 2 Form-C outputs, 8 contact inputs
6B 2 Form-A (voltage with optional current) and 4 Form-C outputs, 4 contact inputs
6C 8 Form-C outputs
6D 16 Contact inputs
6E 4 Form-C outputs, 8 contact inputs
6F 8 Fast Form-C outputs
6G 4 Form-A (voltage with optional current) outputs, 8 contact inputs
6H 6 Form-A (voltage with optional current) outputs, 4 contact inputs
6K 4 Form-C and 4 Fast Form-C outputs
6L 2 Form-A (current with optional voltage) and 2 Form-C outputs, 8 contact inputs
6M 2 Form-A (current with optional voltage) and 4 Form-C outputs, 4 contact inputs
6N 4 Form-A (current with optional voltage) outputs, 8 contact inputs
6P 6 Form-A (current with optional voltage) outputs, 4 contact inputs
6R 2 Form-A (no monitoring) and 2 Form-C outputs, 8 contact inputs
6S 2 Form-A (no monitoring) and 4 Form-C outputs, 4 contact inputs
6T 4 Form-A (no monitoring) outputs, 8 contact inputs
6U 6 Form-A (no monitoring) outputs, 4 contact inputs
6V 2 Form-A outputs, 1 Form-C output, 2 Form-A (no monitoring) latching outputs, 8 

contact inputs
6W 30 Contact inputs - pin terminals (max 4 modules)
6X 18 Form-A (no monitoring) outputs - pin terminals (max 4 modules)

INTER-RELAY
COMMUNICATIONS
(select a maximum of 1 per unit)
For the last module, rear slot P is used for digital 
input/output modules; rear slot R is used for inter-relay
communications modules.

2A C37.94SM, 1300 nm single-mode, ELED, 1 channel single-mode
2B C37.94SM, 1300 nm single-mode, ELED, 2 channel single-mode
2E Bi-phase, single channel
2F Bi-phase, dual channel
2G IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 1 Channel
2H IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 2 Channels
2I Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1300 nm, single-mode, 

Laser
2J Channel 1 - IEEE C37.94, MM, 64/128 kbps; Channel 2 - 1550 nm, single-mode, 

Laser
72 1550 nm, single-mode, Laser, 1 Channel
73 1550 nm, single-mode, Laser, 2 Channel
74 Channel 1 - RS422; Channel 2 - 1550 nm, single-mode, Laser
75 Channel 1 - G.703; Channel 2 - 1550 nm, Single-mode Laser
76 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 1 Channel
77 IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 2 Channels
7A 820 nm, multimode, LED, 1 Channel
7B 1300 nm, multimode, LED, 1 Channel
7C 1300 nm, single-mode, ELED, 1 Channel
7D 1300 nm, single-mode, Laser, 1 Channel
7E Channel 1 - G.703; Channel 2 - 820 nm, multimode
7F Channel 1 - G.703; Channel 2 - 1300 nm, multimode
7G Channel 1 - G.703; Channel 2 - 1300 nm, single-mode ELED
7H 820 nm, multimode, LED, 2 Channels
7I 1300 nm, multimode, LED, 2 Channels
7J 1300 nm, single-mode, ELED, 2 Channels
7K 1300 nm, single-mode, Laser, 2 Channels
7L Channel 1 - RS422; Channel 2 - 820 nm, multimode, LED
7M Channel 1 - RS422; Channel 2 - 1300 nm, multimode, LED
7N Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, ELED
7P Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, Laser
7Q Channel 1 - G.703; Channel 2 - 1300 nm, single-mode Laser
7R G.703, 1 Channel
7S G.703, 2 Channels
7T RS422, 1 Channel
7W RS422, 2 Channels

UR - ** - *
POWER SUPPLY
redundant supply only available in horizontal 
units and must be same type as main supply

| SH A | 125 / 300 V AC/DC
| SL A | 24 to 48 V (DC only)

CPU | T | RS485 with 3 100Base-FX Ethernet, multimode, SFP with LC
| U | RS485 with 1 100Base-TX Ethernet, SFP RJ-45 + 2 100Base-FX Ethernet, multimode, SFP with LC
| V | RS485 with 3 100Base-TX Ethernet, SFP with RJ-45
| W | RS485 with 2 100Base-FX Ethernet, multimode ST + 10/100Base-TX Ethernet, RJ-45

F60 - * ** - * * * - F ** - H ** - M ** - P/R ** Reduced Size Vertical Mount (see note regarding P/R slot below)
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FRONT PANEL + INTERFACE | 3C | Horizontal front panel with keypad and English display
| 3D | Horizontal front panel with keypad and French display
| 3R | Horizontal front panel with keypad and Russian display
| 3A | Horizontal front panel with keypad and Chinese display
| 3P | Horizontal front panel with keypad, user-programmable pushbuttons, and English display
| 3G | Horizontal front panel with keypad, user-programmable pushbuttons, and French display
| 3S | Horizontal front panel with keypad, user-programmable pushbuttons, and Russian display
| 3B | Horizontal front panel with keypad, user-programmable pushbuttons, and Chinese display
| 3K | Enhanced front panel with English display
| 3M | Enhanced front panel with French display
| 3Q | Enhanced front panel with Russian display
| 3U | Enhanced front panel with Chinese display
| 3L | Enhanced front panel with English display and user-programmable pushbuttons
| 3N | Enhanced front panel with French display and user-programmable pushbuttons
| 3T | Enhanced front panel with Russian display and user-programmable pushbuttons
| 3V | Enhanced front panel with Chinese display and user-programmable pushbuttons
| 3I | Enhanced front panel with German display
| 3J | Enhanced front panel with German display and user-programmable pushbuttons
| 3H | Enhanced front panel with Polish display
| 3O | Enhanced front panel with Polish display and user-programmable pushbuttons
| 3Z | Enhanced front panel with Japanese display
| 3X | Enhanced front panel with Japanese display and user-programmable pushbuttons
| 3E | 7" Graphical front panel display in multiple languages with USB front port and user-programmable pushbuttons

CONTACT INPUTS AND OUTPUTS | 4A | 4 Solid-State (no monitoring) MOSFET outputs
| 4B | 4 Solid-State (voltage with optional current) MOSFET outputs
| 4C | 4 Solid-State (current with optional voltage) MOSFET outputs
| 4D | 16 Contact inputs with Auto-Burnishing
| 4L | 14 Form-A (no monitoring) Latching outputs
| 67 | 8 Form-A (no monitoring) outputs
| 6A | 2 Form-A (voltage with optional current) and 2 Form-C outputs, 8 contact inputs
| 6B | 2 Form-A (voltage with optional current) and 4 Form-C outputs, 4 contact inputs
| 6C | 8 Form-C outputs
| 6D | 16 Contact inputs
| 6E | 4 Form-C outputs, 8 contact inputs
| 6F | 8 Fast Form-C outputs
| 6G | 4 Form-A (voltage with optional current) outputs, 8 contact inputs
| 6H | 6 Form-A (voltage with optional current) outputs, 4 contact inputs
| 6K | 4 Form-C and 4 Fast Form-C outputs
| 6L | 2 Form-A (current with optional voltage) and 2 Form-C outputs, 8 contact inputs
| 6M | 2 Form-A (current with optional voltage) and 4 Form-C outputs, 4 contact inputs
| 6N | 4 Form-A (current with optional voltage) outputs, 8 contact inputs
| 6P | 6 Form-A (current with optional voltage) outputs, 4 contact inputs
| 6R | 2 Form-A (no monitoring) and 2 Form-C outputs, 8 contact inputs
| 6S | 2 Form-A (no monitoring) and 4 Form-C outputs, 4 contact inputs
| 6T | 4 Form-A (no monitoring) outputs, 8 contact inputs
| 6U | 6 Form-A (no monitoring) outputs, 4 contact inputs
| 6V | 2 Form-A outputs, 1 Form-C output, 2 Form-A (no monitoring) latching outputs, 8 contact inputs
| 6W | 30 Contact inputs - pin terminals (max 4 modules)
| 6X | 18 Form-A (no monitoring) outputs - pin terminals (max 4 modules)

CT/VT MODULES | 8L | Standard 4CT/4VT with enhanced diagnostics
(not available for the C30) | 8N | Standard 8CT with enhanced diagnostics

| 8M | Sensitive Ground 4CT/4VT with enhanced diagnostics
| 8R | Sensitive Ground 8CT with enhanced diagnostics
| 8Z | Hi-Z 4CT

PROCESS BUS MODULES | 81 | IEC 61850 Process Bus Module for HardFiber, 8 x
| 85 | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 2 x 1000Base-F, LC
| 86 | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 1000Base-F + 4 x 100Base-FX, LC
| 87 | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 100Base-FX, LC

INTER-RELAY COMMUNICATIONS | 2A | C37.94SM, 1300 nm single-mode, ELED, 1 channel single-mode
| 2B | C37.94SM, 1300 nm single-mode, ELED, 2 channel single-mode
| 2E | Bi-phase, single channel
| 2F | Bi-phase, dual channel
| 2G | IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 1 Channel
| 2H | IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 2 Channels
| 2I | Channel 1 - IEEE C37.94, multimode, 64/128 kbps; Channel 2 - 1300 nm, single-mode, Laser
| 2J | Channel 1 - IEEE C37.94, multimode, 64/128 kbps; Channel 2 - 1550 nm, single-mode, Laser
| 72 | 1550 nm, single-mode, Laser, 1 Channel
| 73 | 1550 nm, single-mode, Laser, 2 Channel
| 74 | Channel 1 - RS422; Channel 2 - 1550 nm, single-mode, Laser
| 75 | Channel 1 - G.703; Channel 2 - 1550 nm, single-mode Laser
| 76 | IEEE C37.94, 820 nm, multimode, LED, 1 Channel
| 77 | IEEE C37.94, 820 nm, multimode, LED, 2 Channels
| 7A | 820 nm, multimode, LED, 1 Channel
| 7B | 1300 nm, multimode, LED, 1 Channel
| 7C | 1300 nm, single-mode, ELED, 1 Channel
| 7D | 1300 nm, single-mode, Laser, 1 Channel
| 7E | Channel 1 - G.703; Channel 2 - 820 nm, multimode
| 7F | Channel 1 - G.703; Channel 2 - 1300 nm, multimode
| 7G | Channel 1 - G.703; Channel 2 - 1300 nm, single-mode ELED
| 7H | 820 nm, multimode, LED, 2 Channels
| 7I | 1300 nm, multimode, LED, 2 Channels
| 7J | 1300 nm, single-mode, ELED, 2 Channels
| 7K | 1300 nm, single-mode, Laser, 2 Channels
| 7L | Channel 1 - RS422; Channel 2 - 820 nm, multimode, LED
| 7M | Channel 1 - RS422; Channel 2 - 1300 nm, multimode, LED
| 7N | Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, ELED
| 7P | Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, Laser
| 7Q | Channel 1 - G.703; Channel 2 - 1300 nm, single-mode Laser
| 7R | G.703, 1 Channel
| 7S | G.703, 2 Channels
| 7T | RS422, 1 Channel
| 7W | RS422, 2 Channels

TRANSDUCER INPUTS/OUTPUTS | 5A | 4 DCmA inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
| 5C | 8 RTD inputs
| 5D | 4 RTD inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
| 5E | 4 DCmA inputs, 4 RTD inputs
| 5F | 8 DCmA inputs

* When an 8Z module is ordered, rear slot F must have an 8F or 8G module.

UR - ** - *
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Table 2-9: UR order codes for replacement modules, vertical units
UR - ** - *

POWER SUPPLY | SH B | 125 / 300 V AC/DC
| SL B | 24 to 48 V (DC only)

CPU | T | RS485 with 3 100Base-FX Ethernet, multimode, SFP with LC
| U | RS485 with 1 100Base-TX Ethernet, SFP RJ-45 + 2 100Base-FX Ethernet, multimode, SFP with LC
| V | RS485 with 3 100Base-TX Ethernet, SFP with RJ-45
| W | RS485 with 2 100Base-FX Ethernet, multimode ST + 10/100Base-TX Ethernet, RJ-45

FRONT PANEL + INTERFACE | 3F | Vertical front panel with keypad and English display
| 3D | Vertical front panel with keypad and French display
| 3R | Vertical front panel with keypad and Russian display
| 3A | Vertical front panel with keypad and Chinese display
| 3K | Enhanced front panel with English display
| 3M | Enhanced front panel with French display
| 3Q | Enhanced front panel with Russian display
| 3U | Enhanced front panel with Chinese display
| 3L | Enhanced front panel with English display and user-programmable pushbuttons
| 3N | Enhanced front panel with French display and user-programmable pushbuttons
| 3T | Enhanced front panel with Russian display and user-programmable pushbuttons
| 3V | Enhanced front panel with Chinese display and user-programmable pushbuttons
| 3I | Enhanced front panel with German display
| 3J | Enhanced front panel with German display and user-programmable pushbuttons

CONTACT INPUTS/OUTPUTS | 4A | 4 Solid-State (no monitoring) MOSFET outputs
| 4B | 4 Solid-State (voltage with optional current) MOSFET outputs
| 4C | 4 Solid-State (current with optional voltage) MOSFET outputs
| 4D | 16 Contact inputs with Auto-Burnishing
| 4L | 14 Form-A (no monitoring) Latching outputs
| 67 | 8 Form-A (no monitoring) outputs
| 6A | 2 Form-A (voltage with optional current) and 2 Form-C outputs, 8 contact inputs
| 6B | 2 Form-A (voltage with optional current) and 4 Form-C outputs, 4 contact inputs
| 6C | 8 Form-C outputs
| 6D | 16 Contact inputs
| 6E | 4 Form-C outputs, 8 contact inputs
| 6F | 8 Fast Form-C outputs
| 6G | 4 Form-A (voltage with optional current) outputs, 8 contact inputs
| 6H | 6 Form-A (voltage with optional current) outputs, 4 contact inputs
| 6K | 4 Form-C and 4 Fast Form-C outputs
| 6L | 2 Form-A (current with optional voltage) and 2 Form-C outputs, 8 contact inputs
| 6M | 2 Form-A (current with optional voltage) and 4 Form-C outputs, 4 contact inputs
| 6N | 4 Form-A (current with optional voltage) outputs, 8 contact inputs
| 6P | 6 Form-A (current with optional voltage) outputs, 4 contact inputs
| 6R | 2 Form-A (no monitoring) and 2 Form-C outputs, 8 contact inputs
| 6S | 2 Form-A (no monitoring) and 4 Form-C outputs, 4 contact inputs
| 6T | 4 Form-A (no monitoring) outputs, 8 contact inputs
| 6U | 6 Form-A (no monitoring) outputs, 4 contact inputs
| 6V | 2 Form-A outputs, 1 Form-C output, 2 Form-A (no monitoring) latching outputs, 8 contact inputs
| 6W | 30 Contact inputs - pin terminals (max 4 modules)
| 6X | 18 Form-A (no monitoring) outputs - pin terminals (max 4 modules)

CT/VT MODULES
(not available for the C30)

| 8L | Standard 4CT/4VT with enhanced diagnostics
| 8N | Standard 8CT with enhanced diagnostics
| 8M | Sensitive Ground 4CT/4VT with enhanced diagnostics
| 8R | Sensitive Ground 8CT with enhanced diagnostics
| 8Z * | HI-Z 4CT

PROCESS BUS | 81 | IEC 61850 Process Bus Module for HardFiber, 8 x
| 85 | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 2 x 1000Base-F, LC
| 86 | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 1000Base-F + 4 x 100BaseFx, LC
| 87 | IEC 61850-9-2LE and IEC 61869 Process Bus Module, 4 x 100Base-FX, LC

INTER-RELAY COMMUNICATIONS | 2A | C37.94SM, 1300 nm single-mode, ELED, 1 channel single-mode
| 2B | C37.94SM, 1300 nm single-mode, ELED, 2 channel single-mode
| 2E | Bi-phase, single channel
| 2F | Bi-phase, dual channel
| 2G | IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 1 Channel
| 2H | IEEE C37.94, 820 nm, 128 kbps, multimode, LED, 2 Channels
| 2I | Channel 1 - IEEE C37.94, multimode, 64/128 kbps; Channel 2 - 1300 nm, single-mode, Laser
| 2J | Channel 1 - IEEE C37.94, multimode, 64/128 kbps; Channel 2 - 1550 nm, single-mode, Laser
| 72 | 1550 nm, single-mode, Laser, 1 Channel
| 73 | 1550 nm, single-mode, Laser, 2 Channel
| 74 | Channel 1 - RS422; Channel 2 - 1550 nm, single-mode, Laser
| 75 | Channel 1 - G.703; Channel 2 - 1550 nm, single-mode Laser
| 76 | IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 1 Channel
| 77 | IEEE C37.94, 820 nm, 64 kbps, multimode, LED, 2 Channels
| 7A | 820 nm, multimode, LED, 1 Channel
| 7B | 1300 nm, multimode, LED, 1 Channel
| 7C | 1300 nm, single-mode, ELED, 1 Channel
| 7D | 1300 nm, single-mode, Laser, 1 Channel
| 7E | Channel 1 - G.703; Channel 2 - 820 nm, multimode
| 7F | Channel 1 - G.703; Channel 2 - 1300 nm, multimode
| 7G | Channel 1 - G.703; Channel 2 - 1300 nm, single-mode ELED
| 7H | 820 nm, multimode, LED, 2 Channels
| 7I | 1300 nm, multimode, LED, 2 Channels
| 7J | 1300 nm, single-mode, ELED, 2 Channels
| 7K | 1300 nm, single-mode, Laser, 2 Channels
| 7L | Channel 1 - RS422; Channel 2 - 820 nm, multimode, LED
| 7M | Channel 1 - RS422; Channel 2 - 1300 nm, multimode, LED
| 7N | Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, ELED
| 7P | Channel 1 - RS422; Channel 2 - 1300 nm, single-mode, Laser
| 7Q | Channel 1 - G.703; Channel 2 - 1300 nm, single-mode Laser
| 7R | G.703, 1 Channel
| 7S | G.703, 2 Channels
| 7T | RS422, 1 Channel
| 7W | RS422, 2 Channels

TRANSDUCER INPUTS/OUTPUTS | 5A | 4 DCmA inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
| 5C | 8 RTD inputs
| 5D | 4 RTD inputs, 4 DCmA outputs (only one 5A or 5D module is allowed)
| 5E | 4 DCmA inputs, 4 RTD inputs
| 5F | 8 DCmA inputs

* When an 8Z module is ordered, rear slot F must have an 8F or 8G 
module.
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2.4  Signal processing

2.4.1  UR signal processing
The URs are microprocessor-based protective relays that are designed to measure power system conditions directly via CT 
and VT inputs and via other sources of information, such as analog inputs, communications inputs, and contact inputs. The 
following figure shows the overall signal processing in URs.

An analog low pass anti-aliasing filter with a 3 dB corner frequency is set at 2.4 kHz and is used for current and voltage 
analog filtering as well as signal conditioning. The same filtering is applied for phase, ground currents, phase-to-phase 
(when applicable), and auxiliary voltages. The 2.4 kHz cut-off frequency applies to both 50 and 60 Hz applications and fixed 
in the hardware, and thus is not dependent on the system nominal frequency setting.

Figure 2-4: UR signal processing 

The UR samples its AC signals at 64 samples per cycle, that is, at 3840 Hz in 60 Hz systems, and 3200 Hz in 50 Hz systems. 
The sampling rate is adjusted dynamically to the actual system frequency by an accurate and fast frequency tracking 
system.

The analog/digital converter has the following ranges of AC signals:
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Voltages:

Eq. 2-1

Currents:

Eq. 2-2

Current harmonics are estimated based on raw samples with the use of the full-cycle Fourier filter. Harmonics 2nd through 
25th are estimated.

True RMS value for the current is calculated on a per-phase basis. The true RMS can be used for demand recording or as an 
input signal to Time Overcurrent function, if the latter is intended for thermal protection. The true RMS is calculated as per 
the widely accepted definition:

Eq. 2-3

RMS values include harmonics, inter-harmonics, DC components, and so on, along with fundamental frequency values. 
The true RMS value reflects thermal effects of the current and is used for the thermal related monitoring and protection 
functions.

Protection and control functions respond to phasors of the fundamental and/or harmonic frequency components 
(magnitudes and angles), with an exception for some functions that have an option for RMS or fundamental 
measurements, or some function responding to RMS only. This type of response is explained typically in each element's 
section in this instruction manual.

Currents are pre-filtered using a Finite Impulse Response (FIR) digital filter. The filter is designed to reject DC components 
and low-frequency distortions, without amplifying high-frequency noise. This filter is referred to as a modified MIMIC filter, 
which provides excellent filtering and overall balance between speed and accuracy of filtering. The filter is cascaded with 
the full-cycle Fourier filter for the current phasor estimation.

Voltages are pre-filtered using a patented FIR digital filter. The filter has been optimized to reject voltage-transformer-
specific distortions, such as Capacitive Voltage Transformer (CVT) noise and high-frequency oscillatory components. The 
filter is cascaded with the half-cycle Fourier filter for the voltage phasor estimation.

The URs measure power system frequency using the Clarke transformation by estimating the period of the waveform from 
two consecutive zero-crossings in the same direction (negative-to-positive). Voltage or current samples are pre-filtered 
using a Finite Impulse Response (FIR) digital filter to remove high frequency noise contained in the signal. The period is 
used after several security conditions are met, such as true RMS signal must be above 6% nominal for a certain time. If 
these security conditions are not met, the last valid measurement is used for a specific time after which the UR reverts to 
nominal system frequency.

Synchrophasors are calculated using a patented convolution integral algorithm. This algorithm allows use of the same 
time-stamped samples, which are used for protection and taken at the same sampling frequency. This allows URs to use 
one sampling clock for both protection algorithms and synchrophasors.

Synchrophasors on firmware versions 7.23 and up have been tested and certified to meet IEEE C37.118-2011 and 
C37.118.1a-2014 standards for both metering and protection classes with outputs available up to 60 synchrophasors per 
second for the metering class and 120 synchrophasors per second for the protection class. Synchrophasors measurement 
is also available via IEC 61850-90-5 protocol.

The contact inputs threshold is settable in the firmware with 17, 33, 84, and 166 V DC settings available. Inputs are scanned 
every 0.5 ms and can be conditioned for the critical applications, using debounce time timer, settable from 0.0 to 16.0 ms. 
Contact inputs with auto-burnishing are available as well, when external contacts are exposed to the contamination in a 
harsh industrial environment.

All measured values are available in the UR metering section on the front panel and via communications protocols. 
Measured analog values and binary signals can be captured in COMTRADE format with sampling rates from 8 to 64 
samples per power cycle. Analog values can be captured with the Data Logger, allowing much slower rates extended over 
a long period of time.
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Other advanced UR order code options are available to support IEC 61850 (including fast GOOSE, ICD/CID/IID files, and so 
on), IEEE 1588 (IEEE C37.238 power profile) based time synchronization, CyberSentry (advanced cyber security), the Parallel 
Redundancy Protocol (PRP), IEC 60870-5-103, and so on.

2.5  Specifications
Specifications are subject to change without notice.

2.5.1  Protection elements
The operating times include the activation time of a trip rated form-A output contact unless otherwise indicated. FlexLogic 
operands of a given element are 4 ms faster. Take this into account when using FlexLogic to interconnect with other 
protection or control elements of the relay, building FlexLogic equations, or interfacing with other intelligent electronic 
devices (IEDs) or power system devices via communications or different output contacts. If not specified, the operate times 
given here are for a 60 Hz system at nominal system frequency. Operate times for a 50 Hz system are 1.2 times longer.

NOTE 1 — Protection and control elements with NOTE 1 have additional operating time of up to 3 ms if the F60 is ordered 
with an IEC 61850-9-2LE / IEC 61869 Process Bus Module (order code 85, 86, 87).

RESTRICTED GROUND FAULT
Pickup: 0.005 to 30.000 pu in steps of 0.001
Dropout: 97 to 98% of pickup
Slope: 0 to 100% in steps of 1%
Level accuracy:

0.1 to 2.0 x CT rating: ±0.5% of reading or ±1% of rated (whichever is greater)
>2.0 x CT rating ±1.5% of reading

Pickup delay: 0 to 600.00 s in steps of 0.01
Dropout delay: 0 to 600.00 s in steps of 0.01
Operate time: <1 power system cycle (see NOTE 1)

PHASE/NEUTRAL/GROUND TOC
Current: Phasor or RMS
Pickup level: 0.020 to 30.000 pu in steps of 0.001
Dropout level: 97% to 98% of pickup
Level accuracy:

0.1 to 2.0  CT: ±0.5% of reading or ±0.4% of rated (whichever is greater)
> 2.0  CT: ±1.5% of reading > 2.0  CT rating

Curve shapes: IEEE Moderately/Very/Extremely Inverse; IEC (and BS) A/B/C and Short Inverse; GE IAC Inverse, 
Short/Very/ Extremely Inverse; I2t; FlexCurves™ (programmable); Definite Time (0.01 s base 
curve)

Curve multiplier: Time Dial = 0.00 to 600.00 in steps of 0.01
Reset type: Instantaneous/Timed (per IEEE)
Curve timing accuracy at 1.03 to 20 x pickup:

±3.5% of operate time or ±½ cycle (whichever is greater) from pickup to operate (see NOTE 1)
Voltage restraint: Modifies pickup current for voltage in the range of 0.1 < V < 0.9 VT Nominal in a fixed linear rela-

tionship

PHASE/NEUTRAL/GROUND IOC
Pickup level: 0.020 to 30.000 pu in steps of 0.001
Dropout level: 97 to 98% of pickup
Level accuracy:

0.1 to 2.0  CT rating: ±0.5% of reading or ±0.4% of rated (whichever is greater)
> 2.0  CT rating: ±1.5% of reading

Overreach: <2%
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Pickup delay: 0.00 to 600.00 s in steps of 0.01
Reset delay: 0.00 to 600.00 s in steps of 0.01
Operate time: <16 ms at 3  pickup at 60 Hz (Phase/Ground IOC) (see NOTE 1)

<20 ms at 3  pickup at 60 Hz (Neutral IOC) (see NOTE 1)
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)

NEGATIVE SEQUENCE TOC
Pickup level: 0.020 to 30.000 pu in steps of 0.001
Dropout level: 97% to 98% of pickup
Level accuracy: ±0.5% of reading or ±0.4% of rated (whichever is greater)

from 0.1 to 2.0 x CT rating
±1.5% of reading > 2.0 x CT rating

Curve shapes: IEEE Moderately/Very/Extremely Inverse; IEC (and BS) A/B/C and Short Inverse; GE IAC Inverse, 
Short/Very/ Extremely Inverse; I2t; FlexCurves™ (programmable); Definite Time (0.01 s base 
curve)

Curve multiplier (Time dial): 0.00 to 600.00 in steps of 0.01
Reset type: Instantaneous/Timed (per IEEE) and Linear
Curve timing accuracy
at 1.03 to 20 x pickup: ±3.5% of operate time or ±½ cycle (whichever is greater) from pickup to operate (see NOTE 1)

NEGATIVE SEQUENCE IOC
Pickup level: 0.020 to 30.000 pu in steps of 0.001
Dropout level: 97 to 98% of pickup
Level accuracy: 0.1 to 2.0  CT rating: ±0.5% of reading or ±0.4% of rated (whichever is greater); >2.0  CT rating: 

±1.5% of reading
Overreach: <2%
Pickup delay: 0.00 to 600.00 s in steps of 0.01
Reset delay: 0.00 to 600.00 s in steps of 0.01
Operate time: <20 ms at 3  pickup at 60 Hz (see NOTE 1)
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)

PHASE DIRECTIONAL OVERCURRENT
Relay connection: 90° (quadrature)
Quadrature voltage: ABC phase seq.: phase A (VBC), phase B (VCA), phase C (VAB); ACB phase seq.: phase A (VCB), phase 

B (VAC), phase C (VBA)
Polarizing voltage threshold: 0.004 to 3.000 pu in steps of 0.001
Current sensitivity threshold: 0.05 pu
Characteristic angle: 0 to 359° in steps of 1
Angle accuracy: ±2°
Operation time (FlexLogic operands):

Tripping (reverse load, forward fault): <12 ms, typically (see NOTE 1)
Blocking (forward load, reverse fault):  <8 ms, typically (see NOTE 1)

NEUTRAL DIRECTIONAL OVERCURRENT
Directionality: Co-existing forward and reverse
Polarizing: Voltage, Current, Dual, Dual-V, Dual-I
Polarizing voltage: V_0 or VX
Polarizing current: IG
Operating current: I_0
Level sensing: 3  (|I_0| – K  |I_1|), IG
Restraint, K: 0.000 to 0.500 in steps of 0.001
Characteristic angle: –90 to 90° in steps of 1
Limit angle: 40 to 90° in steps of 1, independent for forward and reverse
Angle accuracy: ±2°
Offset impedance: 0.00 to 250.00  in steps of 0.01
Pickup level: 0.002 to 30.000 pu in steps of 0.01
Dropout level: 97 to 98%
Operation time: <16 ms at 3  pickup at 60 Hz (see NOTE 1)
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NEGATIVE SEQUENCE DIRECTIONAL OC
Directionality: Co-existing forward and reverse
Polarizing: Voltage
Polarizing voltage: V_2
Operating current: I_2
Level sensing:

Zero-sequence: |I_0| – K  |I_1|
Negative-sequence: |I_2| – K  |I_1|

Restraint, K: 0.000 to 0.500 in steps of 0.001
Characteristic angle: 0 to 90° in steps of 1
Limit angle: 40 to 90° in steps of 1, independent for forward and reverse
Angle accuracy: ±2°
Offset impedance: 0.00 to 250.00  in steps of 0.01
Pickup level: 0.015 to 30.000 pu in steps of 0.01
Dropout level: 97 to 98%
Operation time: <16 ms at 3  pickup at 60 Hz (see NOTE 1)

WATTMETRIC ZERO-SEQUENCE DIRECTIONAL
Measured power: zero-sequence
Number of elements: 2
Characteristic angle: 0 to 360° in steps of 1
Minimum power: 0.001 to 1.200 pu in steps of 0.001
Pickup level accuracy: ±1% or ±0.0025 pu, whichever is greater
Hysteresis: 3% or 0.001 pu, whichever is greater
Pickup delay: definite time (0 to 600.00 s in steps of 0.01), inverse time, or FlexCurve
Inverse time multiplier: 0.01 to 2.00 s in steps of 0.01
Curve timing accuracy: ±3.5% of operate time or ±1 cycle (whichever is greater) from pickup to operate
Operate time: <30 ms at 60 Hz

SENSITIVE DIRECTIONAL POWER
Measured power: 3-phase, true RMS
Number of stages: 2
Characteristic angle: 0 to 359° in steps of 1
Calibration angle: 0.00 to 0.95° in steps of 0.05
Minimum power: –1.200 to 1.200 pu in steps of 0.001
Pickup level accuracy: ±1% or ±0.001 pu, whichever is greater
Hysteresis: 2% or 0.001 pu, whichever is greater
Pickup delay: 0 to 600.00 s in steps of 0.01
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)
Operate time: <50 ms (plus up to 5 ms with Process Bus Module with order code 85, 86, 87)

PHASE UNDERVOLTAGE
Voltage: Phasor only
Pickup level: 0.004 to 3.000 pu in steps of 0.001
Dropout level: 102 to 103% of pickup
Level accuracy: ±0.5% of reading from 10 to 208 V
Curve shapes: GE IAV Inverse;

Definite Time (0.1 s base curve)
Curve multiplier: Time dial = 0.00 to 600.00 in steps of 0.01
Curve timing accuracy at <0.90 x pickup:

±3.5% of operate time or ±1/2 cycle (whichever is greater) from pickup to operate
Operate time: <30 ms at 0.9 pickup at 60 Hz for Definite Time mode

AUXILIARY UNDERVOLTAGE
Pickup level: 0.004 to 3.000 pu in steps of 0.001
Dropout level: 102 to 103% of pickup
Level accuracy: ±0.5% of reading from 10 to 208 V
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Curve shapes: GE IAV Inverse, Definite Time
Curve multiplier: Time Dial = 0 to 600.00 in steps of 0.01
Curve timing accuracy at <0.90 x pickup:

±3.5% of operate time or ±1/2 cycle (whichever is greater) from pickup to operate
Operate time: <30 ms at 0.9 pickup at 60 Hz for Definite Time mode

PHASE OVERVOLTAGE
Voltage: Phasor only
Pickup level: 0.004 to 3.000 pu in steps of 0.001
Dropout level: 97 to 98% of pickup
Level accuracy: ±0.5% of reading from 10 to 208 V
Pickup delay: 0.00 to 600.00 in steps of 0.01 s
Operate time: <30 ms at 1.10  pickup at 60 Hz
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)

NEUTRAL OVERVOLTAGE
Pickup level: 0.004 to 3.000 pu in steps of 0.001
Dropout level: 97 to 98% of pickup
Level accuracy: ±0.5% of reading from 10 to 208 V
Pickup delay: 0.00 to 600.00 s in steps of 0.01 (definite time) or user-defined curve
Reset delay: 0.00 to 600.00 s in steps of 0.01
Curve timing accuracy at >1.1  pickup: ±3.5% of operate time or ±1 cycle (whichever is greater) from pickup to operate
Operate time: <30 ms at 1.10  pickup at 60 Hz

AUXILIARY OVERVOLTAGE
Pickup level: 0.004 to 3.000 pu in steps of 0.001
Dropout level: 97 to 98% of pickup
Level accuracy: ±0.5% of reading from 10 to 208 V
Pickup delay: 0 to 600.00 s in steps of 0.01
Reset delay: 0 to 600.00 s in steps of 0.01
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)
Operate time: <30 ms at 1.10  pickup at 60 Hz

NEGATIVE SEQUENCE OVERVOLTAGE
Pickup level: 0.004 to 1.250 pu in steps of 0.001
Dropout level: 97 to 98% of pickup
Level accuracy: ±0.5% of reading from 10 to 208 V
Pickup delay: 0 to 600.00 s in steps of 0.01
Reset delay: 0 to 600.00 s in steps of 0.01
Timer accuracy: ±3% of operate time or ±20 ms, whichever is greater
Operate time: <30 ms at 1.10  pickup at 60 Hz

UNDERFREQUENCY
Minimum signal: 0.10 to 1.25 pu in steps of 0.01
Pickup level: 20.00 to 65.00 Hz in steps of 0.01
Dropout level: pickup + 0.03 Hz
Level accuracy: ±0.001 Hz
Time delay: 0 to 65.535 s in steps of 0.001
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)
Operate time: typically 4 cycles at 0.1 Hz/s change

typically 3.5 cycles at 0.3 Hz/s change
typically 3 cycles at 0.5 Hz/s change

Typical times are average operate times including variables, such as frequency change instance, and test method, and can vary by ±0.5 
cycles.

OVERFREQUENCY
Pickup level: 20.00 to 65.00 Hz in steps of 0.01
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Dropout level: pickup – 0.03 Hz
Level accuracy: ±0.001 Hz
Time delay: 0 to 65.535 s in steps of 0.001
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)
Operate time: typically 4 cycles at 0.1 Hz/s change

typically 3.5 cycles at 0.3 Hz/s change
typically 3 cycles at 0.5 Hz/s change

Typical times are average operate times including variables such as frequency change instance, test method, and so on, and can vary by 
±0.5 cycles.

RATE OF CHANGE OF FREQUENCY
df/dt trend: increasing, decreasing, bi-directional
df/dt pickup level: 0.10 to 15.00 Hz/s in steps of 0.01
df/dt dropout level: 96% of pickup
df/dt level accuracy: 80 mHz/s or 3.5%, whichever is greater
Overvoltage supv.: 0.100 to 3.000 pu in steps of 0.001
Overcurrent supv.: 0.020 to 30.000 pu in steps of 0.001
Pickup delay: 0 to 65.535 s in steps of 0.001
Reset delay: 0 to 65.535 s in steps of 0.001
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)
95% settling time for df/dt: <24 cycles
Operate time: typically 9.5 cycles at 2  pickup

typically 8.5 cycles at 3  pickup
typically 6.5 cycles at 5  pickup

Typical times are average operate times including variables such as frequency change instance, test method, and so on, and can vary by 
±0.5 cycles.

BREAKER FAILURE
Mode: 1-pole, 3-pole
Current supervision: phase, neutral current
Current supv. pickup: 0.020 to 30.000 pu in steps of 0.001
Current supv. dropout: 97 to 98% of pickup
Current supv. accuracy:

0.1 to 2.0  CT rating: ±0.75% of reading or ±2% of rated (whichever is greater)
above 2  CT rating: ±2.5% of reading

BREAKER ARCING CURRENT
Principle: accumulates breaker duty (I2t) and measures fault duration
Initiation: programmable per phase from any FlexLogic operand
Compensation for auxiliary relays: 0 to 65.535 s in steps of 0.001
Alarm threshold: 0 to 50000 kA2-cycle in steps of 1
Fault duration accuracy: 0.25 of a power cycle
Availability: 1 per CT bank with a minimum of 2

BREAKER FLASHOVER
Operating quantity: phase current, voltage, and voltage difference
Pickup level voltage: 0.004 to 1.500 pu in steps of 0.001
Dropout level voltage: 97 to 98% of pickup
Pickup level current: 0.020 to 1.500 pu in steps of 0.001
Dropout level current: 97 to 98% of pickup
Level accuracy: ±0.5% or ±0.1% of rated, whichever is greater
Pickup delay: 0 to 65.535 s in steps of 0.001
Timer accuracy: ±3% of operate time or ±42 ms, whichever is greater
Operate time: <42 ms at 1.10  pickup at 60 Hz (see NOTE 1)

BREAKER RESTRIKE
Principle: detection of high-frequency overcurrent condition ¼ cycle after breaker opens
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Availability: one per digital signal processor (DSP)
Pickup level: 0.1 to 2.00 pu in steps of 0.01
Reset delay: 0.000 to 65.535 s in steps of 0.001

INCIPIENT CABLE FAULT DETECTION
Principle: detection of ½ cycle or less overcurrent condition during normal load
Availability: two per CT/VT module (not including 8Z modules)
Pickup level: 0.1 to 10.00 pu in steps of 0.01
Reset delay: 0.000 to 65.535 s in steps of 0.001
Operating mode: number of counts, counts per time window

SYNCHROCHECK
Max voltage difference: 0 to 400000 V in steps of 1
Max angle difference: 0 to 100° in steps of 1
Max freq. difference: 0.00 to 2.00 Hz in steps of 0.01
Hysteresis for max. freq. diff.: 0.00 to 0.10 Hz in steps of 0.01
Dead source function: None, LV1 & DV2, DV1 & LV2, DV1 or DV2, DV1 xor DV2, DV1 & DV2 (L = Live, D = Dead)
S-CLS MAX dF: 0.10 to 2.00 Hz in steps of 0.01
S-CLS MIN dF: 0.00 to 1.00 Hz in steps of 0.01
V2 MAG CORR FACTOR: 0.10 to 10.00 in steps of 0.01
V2 ANGLE SHIFT: -180° to +180° in steps of 1° 

AUTORECLOSURE
Single breaker applications, 3-pole tripping schemes
Up to four reclose attempts before lockout
Independent dead time setting before each shot
Possibility of changing protection settings after each shot with FlexLogic

PILOT-AIDED SCHEMES
Permissive Overreaching Transfer Trip (POTT)
Directional Comparison Blocking Scheme

LOAD ENCROACHMENT
Responds to: Positive-sequence quantities
Minimum voltage: 0.004 to 3.000 pu in steps of 0.001
Reach (sec. ): 0.02 to 250.00  in steps of 0.01
Impedance accuracy: ±5%
Angle: 5 to 50° in steps of 1
Angle accuracy: ±2°
Pickup delay: 0 to 65.535 s in steps of 0.001
Reset delay: 0 to 65.535 s in steps of 0.001
Timer accuracy: ±3% of operate time or ±1/4 cycle (whichever is greater)
Operate time: <30 ms at 60 Hz (see NOTE 1)

THERMAL OVERLOAD PROTECTION
Thermal overload curves: IEC 255-8 curve
Base current: 0.20 to 3.00 pu in steps of 0.01
Overload (k) factor: 1.00 to 1.20 pu in steps of 0.05
Trip time constant: 0 to 1000 min. in steps of 1
Reset time constant: 0 to 1000 min. in steps of 1
Minimum reset time: 0 to 1000 min. in steps of 1
Timer accuracy (cold curve): ±100 ms or 2%, whichever is greater
Timer accuracy (hot curve): ±500 ms or 2%, whichever is greater for Ip < 0.9 × k × Ib and I / (k × Ib) > 1.1

TRIP BUS (TRIP WITHOUT FLEXLOGIC)
Number of elements: 6
Number of inputs: 16
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Operate time: <2 ms at 60 Hz
Timer accuracy: ±3% or 10 ms, whichever is greater

2.5.2  User-programmable elements

FLEXLOGIC
Programming language: Reverse Polish Notation with graphical visualization (keypad programmable)
Lines of code: 1024
Internal variables: 64
Supported operations: NOT, XOR, OR (2 to 16 inputs), AND (2 to 16 inputs), NOR (2 to 16 inputs), NAND (2 to 16 inputs), 

latch (reset-dominant), edge detectors, timers
Inputs: any logical variable, contact, or virtual input
Number of timers: 32
Pickup delay: 0 to 60000 (ms, sec., min.) in steps of 1
Dropout delay: 0 to 60000 (ms, sec., min.) in steps of 1

FLEXCURVES™
Number: 4 (A through D)
Reset points: 40 (0 through 1 of pickup)
Operate points: 80 (1 through 20 of pickup)
Time delay: 0 to 65535 ms in steps of 1

FLEX STATES
Number: up to 256 logical variables grouped under 16 Modbus addresses
Programmability: any logical variable, contact, or virtual input

FLEXELEMENTS™
Number of elements: 8
Operating signal: any analog actual value, or two values in differential mode
Operating signal mode: signed or absolute value
Operating mode: level, delta
Comparator direction: over, under
Pickup Level: –90.000 to 90.000 pu in steps of 0.001
Hysteresis: 0.1 to 50.0% in steps of 0.1
Delta dt: 20 ms to 60 days
Pickup and dropout delay: 0.000 to 65.535 s in steps of 0.001

NON-VOLATILE LATCHES
Type: set-dominant or reset-dominant
Number: 16 (individually programmed)
Output: stored in non-volatile memory
Execution sequence: as input prior to protection, control, and FlexLogic

USER-PROGRAMMABLE LEDs (Enhanced and basic front panels)
Number: 48 plus trip and alarm
Programmability: from any logical variable, contact, or virtual input
Reset mode: self-reset or latched

LED TEST
Initiation: from any contact input or user-programmable condition
Number of tests: 3, interruptible at any time
Duration of full test: approximately 3 minutes
Test sequence 1: all LEDs on
Test sequence 2: all LEDs off, one LED at a time on for 1 s
Test sequence 3: all LEDs on, one LED at a time off for 1 s
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USER-DEFINABLE DISPLAYS (Enhanced and basic front panels)
Number of displays: 16
Lines of display: 2  20 alphanumeric characters
Parameters: up to 5, any Modbus register addresses
Invoking and scrolling: keypad, or any user-programmable condition, including pushbuttons

CONTROL PUSHBUTTONS (Enhanced and basic front panels)
Number of pushbuttons: 7
Operation: drive FlexLogic operands

USER-PROGRAMMABLE PUSHBUTTONS (Optional)
Number of pushbuttons: 12 on basic front panel

16 on enhanced horizontal front panel
6 on enhanced vertical front panel
16 on graphical front panel (8 physical pushbuttons, 8 graphical interface pushbuttons)

Mode: self-reset, latched
Display message: 2 lines of 20 characters each
Drop-out timer: 0.00 to 60.00 s in steps of 0.05
Autoreset timer: 0.2 to 600.0 s in steps of 0.1
Hold timer: 0.0 to 10.0 s in steps of 0.1

SELECTOR SWITCH
Number of elements: 2
Upper position limit: 1 to 7 in steps of 1
Selecting mode: time-out or acknowledge
Time-out timer: 3.0 to 60.0 s in steps of 0.1
Control inputs: step-up and 3-bit
Power-up mode: restore from non-volatile memory or synchronize to a 3-bit control input or synch/restore mode

DIGITAL ELEMENTS
Number of elements: 48
Operating signal: any FlexLogic operand
Pickup delay: 0.000 to 999999.999 s in steps of 0.001
Dropout delay: 0.000 to 999999.999 s in steps of 0.001
Timing accuracy: ±3% or ±4 ms, whichever is greater

2.5.3  Monitoring

OSCILLOGRAPHY
Maximum records: 64
Sampling rate: 64 samples per power cycle
Triggers: any element pickup, dropout, or operate; contact input change of state; contact output change 

of state; FlexLogic equation
Data: AC input channels; element state; contact input state; contact output state
Data storage: in non-volatile memory

EVENT RECORDER
Capacity: 1024 events
Time-tag: to 1 microsecond
Triggers: any element pickup, dropout, or operate; contact input change of state; contact output change 

of state; self-test events
Data storage: in non-volatile memory

DATA LOGGER
Number of channels: 1 to 16
Parameters: any available analog actual value
Sampling rate: 15 to 3600000 ms in steps of 1
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Trigger: any FlexLogic operand
Mode: continuous or triggered
Storage capacity: (NN is dependent on memory)

1-second rate:
01 channel for NN days

16 channels for NN days


60-minute rate:
01 channel for NN days
16 channels for NN days

FAULT LOCATOR
Number of independent fault locators: 1 per CT bank (to a maximum of 3)
Method: single-ended
Voltage source: wye-connected VTs, delta-connected VTs and neutral voltage, delta-connected VTs and zero-

sequence current (approximation)
Maximum accuracy if: fault resistance is zero or fault currents from all line terminals are in phase
Relay accuracy: ±1.5% (V > 10 V, I > 0.1 pu)
Worst-case accuracy:

VT%error + user data
CT%error + user data
ZLine%error + user data
RELAY ACCURACY%error + 1.5%

HI-Z
Detections: Arc Suspected, Arc Detected, Downed Conductor, Phase Identification

PHASOR MEASUREMENT UNIT
Output format: per IEEE C37.118-2011, C37.118.1a-2014, or IEC 61850-90-5 standard
Number of channels: 14 synchrophasors, 8 analogs, 16 digitals
TVE (total vector error): <1%
Triggering: frequency, voltage, current, power, rate of change of frequency, user-defined
Reporting rate: 1, 2, 5, 10, 12, 15, 20, 25, 30, 50, or 60 times per second for P and M class, and 100 or 120 times 

per second for P class only
Number of clients: one over TCP/IP port and one over UDP/IP per aggregator
AC ranges: as indicated in appropriate specification sections
Network reporting format: 16-bit integer (for IEEE C37.118) or 32-bit IEEE floating point numbers
Network reporting style: rectangular (real and imaginary for IEEE C37.188) or polar (magnitude and angle) coordinates
Post-filtering: none, 3-point, 5-point, 7-point
Calibration: ±5° (angle) and ±5% (magnitude)

2.5.4  Metering

RMS CURRENT: PHASE, NEUTRAL, AND GROUND
Accuracy at

0.1 to 2.0  CT rating: ±0.25% of reading or ±0.1% of rated (whichever is greater)
2.0  CT rating: ±1.0% of reading

RMS VOLTAGE
Accuracy: ±0.5% of reading from 10 to 208 V

REAL POWER (WATTS)
Accuracy at 0.1 to 1.5 x CT rating and 0.8 to 1.2 x VT rating:

±1.0% of reading at –1.0  PF < –0.8 and 0.8 < PF 10

REACTIVE POWER (VARS)
Accuracy at 0.1 to 1.5 x CT rating and 0.8 to 1.2 x VT rating:
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±1.0% of reading at –0.2  PF  0.2

APPARENT POWER (VA)
Accuracy at 0.1 to 1.5 x CT rating and 0.8 to 1.2 x VT rating:

±1.0% of reading

WATT-HOURS (POSITIVE AND NEGATIVE)
Accuracy: ±2.0% of reading
Range: ±0 to 1  106 MWh
Parameters: three-phase only
Update rate: 50 ms

VAR-HOURS (POSITIVE AND NEGATIVE)
Accuracy: ±2.0% of reading
Range: ±0 to 1  106 Mvarh
Parameters: three-phase only
Update rate: 50 ms

CURRENT HARMONICS
Harmonics: 2nd to 25th harmonic: per phase, displayed as a % of f1 (fundamental frequency phasor)

THD: per phase, displayed as a % of f1
Accuracy: When with Process Bus Module (order code 85, 86, 87), valid for 2nd to 12th harmonic and Anti-

Aliasing filter disabled
When with Process Bus Module (order code 85, 86, 87), valid for 2nd to 10th harmonic and Anti-
Aliasing filter enabled

HARMONICS: 1. f1 > 0.4pu: (0.20% + 0.035% / harmonic) of reading or 0.15% of 100%, whichever is greater
2. f1 < 0.4pu: as above plus %error of f1

THD: 1. f1 > 0.4pu: (0.25% + 0.035% / harmonic) of reading or 0.20% of 100%, whichever is greater
2. f1 < 0.4pu: as above plus %error of f1

VOLTAGE HARMONICS
Harmonics: 2nd to 25th harmonic: per phase, displayed as a % of f1 (fundamental frequency phasor)

THD: per phase, displayed as a % of f1
Accuracy: When with Process Bus Module (order code 85, 86, 87), valid for 2nd to 12th harmonic and Anti-

Aliasing filter disabled
When with Process Bus Module (order code 85, 86, 87), valid for 2nd to 10th harmonic and Anti-
Aliasing filter enabled

HARMONICS: 1. f1 > 0.4pu: (0.20% + 0.035% / harmonic) of reading or 0.15% of 100%, whichever is greater
2. f1 < 0.4pu: as above plus %error of f1

THD: 1. f1 > 0.4pu: (0.25% + 0.035% / harmonic) of reading or 0.20% of 100%, whichever is greater
2. f1 < 0.4pu: as above plus %error of f1

FREQUENCY
Accuracy at

V = 0.8 to 1.2 pu: ±0.001 Hz (when voltage signal is used for frequency measurement)
I = 0.1 to 0.25 pu: ±0.02 Hz (when current signal is used for frequency measurement)
I > 0.25 pu: ±0.005 Hz (when current signal is used for frequency measurement)

DEMAND
Measurements: Phases A, B, and C present and maximum measured currents

3-Phase Power (P, Q, and S) present and maximum measured currents
Accuracy: ±2.0%

2.5.5  Inputs

AC CURRENT
CT rated primary: 1 to 50000 A
CT rated secondary: 1 or 5 A by connection
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Relay burden: < 0.2 VA at rated secondary
Conversion range:

Standard CT: 0.02 to 46  CT rating RMS symmetrical
Sensitive Ground CT module: 0.002 to 4.6  CT rating RMS symmetrical

HI-Z CT module: 0.002 to 4.6  CT rating RMS symmetrical
Current withstand: 20 ms at 250 times rated

1 sec at 100 times rated
continuous 4xInom

Short circuit rating: 150000 RMS symmetrical amperes, 250 V maximum (primary current to external CT)

AC VOLTAGE
VT rated secondary: 50.0 to 240.0 V
VT ratio: 1.00 to 24000.00
Relay burden: < 0.25 VA at 120 V
Conversion range: 1 to 275 V
Voltage withstand: continuous at 260 V to neutral

1 min/hr at 420 V to neutral

FREQUENCY
Nominal frequency setting: 25 to 60 Hz
Sampling frequency: 64 samples per power cycle
Tracking frequency range: 20 to 70 Hz

20 to 65 Hz with Process Bus Module (order code 85, 86, 87)

CONTACT INPUTS
Dry contacts: 1000  maximum
Wet contacts: 300 V DC maximum
Selectable thresholds: 17 V, 33 V, 84 V, 166 V
Tolerance: ±10%
Contacts per common return: 4
Recognition time: < 1 ms
Debounce time: 0.0 to 16.0 ms in steps of 0.5
Continuous current draw: 4 mA (when energized)

CONTACT INPUTS WITH AUTO-BURNISHING
Dry contacts: 1000  maximum
Wet contacts: 300 V DC maximum
Selectable thresholds: 17 V, 33 V, 84 V, 166 V
Tolerance: ±10%
Contacts per common return: 2
Recognition time: < 1 ms
Debounce time: 0.0 to 16.0 ms in steps of 0.5
Continuous current draw: 4 mA (when energized)
Auto-burnish impulse current: 50 to 70 mA
Duration of auto-burnish impulse: 25 to 50 ms

DCMA INPUTS
Current input (mA DC): 0 to –1, 0 to +1, –1 to +1, 0 to 5, 0 to 10, 0 to 20, 4 to 20 (programmable)
Input impedance: 379  ±10%
Conversion range: –1 to + 20 mA DC
Accuracy: ±0.2% of full scale
Type: Passive

RTD INPUTS
Types (3-wire): 100  Platinum, 100 and 120  Nickel, 10  Copper
Sensing current: 5 mA
Range: –50 to +250°C
Accuracy: ±2°C
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Isolation: 36 V pk-pk

IRIG-B INPUT
IRIG formats accepted: B000…B007, B120…B127
IRIG control bits: IEEE Std C37.118.1-2011
Amplitude modulation: 1 to 10 V pk-pk
DC shift: TTL–Compatible
Input impedance: 50 k
Isolation: 2 kV

DIRECT INPUTS
Input points: 32
Remote devices: 16
Default states on loss of comms.: On, Off, Latest/Off, Latest/On
Ring configuration: Yes, No
Data rate: 64 or 128 kbps
CRC: 32-bit
CRC alarm:

Responding to: Rate of messages failing the CRC
Monitoring message count: 10 to 10000 in steps of 1
Alarm threshold: 1 to 1000 in steps of 1

Unreturned message alarm:
Responding to: Rate of unreturned messages in the ring configuration
Monitoring message count: 10 to 10000 in steps of 1
Alarm threshold: 1 to 1000 in steps of 1

TELEPROTECTION
Input points: 16
Remote devices: 3
Default states on loss of comms.: On, Off, Latest/Off, Latest/On
Ring configuration: No
Data rate: 64 or 128 kbps
CRC: 32-bit

2.5.6  Power supply

LOW RANGE
Nominal DC voltage: 24 to 48 V
Minimum DC voltage: 20 V
Maximum DC voltage: 75 V for SL power supply module
Voltage loss hold-up: 200 ms duration at maximum load
NOTE: Low range is DC only.

HIGH RANGE
Nominal DC voltage: 125 to 250 V
Minimum DC voltage: 88 V
Maximum DC voltage: 300 V
Nominal AC voltage: 100 to 240 V at 50/60 Hz
Minimum AC voltage: 88 V at 25 to 100 Hz
Maximum AC voltage: 265 V at 25 to 100 Hz
Voltage loss hold-up: 200 ms duration at maximum load

ALL RANGES
Volt withstand: 2  Highest Nominal Voltage for 10 ms
Power consumption: typical = 15 to 20 W/VA

maximum = 45 W/VA
contact factory for exact order code consumption
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INTERNAL FUSE
Ratings:

Low range power supply: 8 A / 250 V
High range power supply: 4 A / 250 V

Interrupting capacity:
AC: 100 000 A RMS symmetrical
DC: 10 000 A

2.5.7  Outputs

FORM-A RELAY
Make and carry for 0.2 s: 30 A as per ANSI C37.90
Carry continuous: 6 A
Break (DC inductive, L/R = 40 ms):

Operate time: < 4 ms
Contact material: silver alloy

LATCHING RELAY
Make and carry for 0.2 s: 30 A as per ANSI C37.90
Carry continuous: 6 A as per IEEE C37.90
Break (DC resistive as per IEC61810-1):

Operate time: < 4 ms
Contact material: silver alloy
Control: separate operate and reset inputs
Control mode: operate-dominant or reset-dominant

FORM-A VOLTAGE MONITOR
Applicable voltage: approx. 15 to 250 V DC
Trickle current: approx. 1 to 2.5 mA

FORM-A CURRENT MONITOR
Threshold current: approx. 80 to 100 mA

FORM-C AND CRITICAL FAILURE RELAY
Make and carry for 0.2 s: 30 A as per ANSI C37.90
Carry continuous: 8 A

Voltage Current

24 V 1 A

48 V 0.5 A

125 V 0.3 A

250 V 0.2 A

Voltage Current

24 V 6 A

48 V 1.6 A

125 V 0.4 A

250 V 0.2 A
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Break (DC inductive, L/R = 40 ms):

Operate time: < 8 ms
Contact material: silver alloy

FAST FORM-C RELAY
Make and carry: 0.1 A max. (resistive load)
Minimum load impedance:

Operate time: < 0.6 ms
Internal Limiting Resistor: 100  2 W

SOLID-STATE OUTPUT RELAY
Operate and release time: <100 µs
Maximum voltage: 265 V DC
Maximum leakage current in off state
(excluding voltage monitor circuit current): 100 µA
Maximum continuous current: 5 A at 45°C; 4 A at 65°C
Make and carry:

for 0.2 s: 30 A as per ANSI C37.90
for 0.03 s: 300 A

Breaking capacity:

CONTROL POWER EXTERNAL OUTPUT (For dry contact input)
Capacity: 100 mA DC at 48 V DC
Isolation: ±300 Vpk

DIRECT OUTPUTS
Output points: 32

Voltage Current

24 V 1 A

48 V 0.5 A

125 V 0.3 A

250 V 0.2 A

Input voltage Impedance

2 W Resistor 1 W Resistor

250 V DC 20 K 50 K

120 V DC 5 K 2 K

48 V DC 2 K 2 K

24 V DC 2 K 2 K

Note: values for 24 V and 48 V are the same due to a 
required 95% voltage drop across the load 
impedance.

Specification UL 508 Utility application
(autoreclose scheme)

Industrial application

Operations per 
interval

5000 operations,
1 second on,
9 seconds off

5 operations
0.2 seconds on
0.2 seconds off
within 1 minute

10000 operations
0.2 seconds on
30 seconds off

1000 operations
0.5 seconds on,
0.5 seconds off

Break capability
(0 to 250 V DC)

3.2 A at L/R = 10 ms 10 A at L/R = 40 ms 10 A at L/R = 40 ms

1.6 A at L/R = 20 ms

0.8 A
L/R  = 40 ms



2-34 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

SPECIFICATIONS CHAPTER 2: PRODUCT DESCRIPTION

2

DCMA OUTPUTS
Range: –1 to 1 mA, 0 to 1 mA, 4 to 20 mA
Max. load resistance: 12 k for –1 to 1 mA range

12 k for 0 to 1 mA range
600  for 4 to 20 mA range

Accuracy: ±0.75% of full-scale for 0 to 1 mA range
±0.5% of full-scale for –1 to 1 mA range
±0.75% of full-scale for 0 to 20 mA range

99% Settling time to a step change: 100 ms
Isolation: 1.5 kV
Driving signal: any FlexAnalog quantity
Upper and lower limit for the driving signal: –90 to 90 pu in steps of 0.001

2.5.8  Communication protocols

IEC 61850
IEC 61850: Supports IEC 61850 Editions 1.0 and 2.0. See the UR Family Communications Guide and its con-

formance statements.

RS232 (Enhanced and basic front panels)
Front port: 19.2 kbps, Modbus RTU

USB (Graphical front panel)
Front port: USB 2.0 type B

RS485
1 rear port: up to 115 kbps, Modbus RTU, DNP 3, IEC 60870-5-103
Typical distance: 1200 m
Isolation: 2 kV, isolated together at 36 Vpk

FIBER ETHERNET PORT

ETHERNET (10/100 MB TWISTED PAIR)
Modes: 10 Mb, 10/100 Mb (auto-detect)
Connector: RJ45

SIMPLE NETWORK TIME PROTOCOL (SNTP)
Clock synchronization error: <10 ms (typical)

PRECISION TIME PROTOCOL (PTP)
PTP IEEE Std 1588-2008 (version 2)
Power Profile (PP) per IEEE Standard PC37.238-2011
Clock: Slave-only ordinary clock when using station bus Ethernet interface

Boundary clock when using process bus Ethernet interface

Parameter Fiber type

100 Mb multimode

Wavelength 1310 nm

Connector LC

Transmit power –20 dBm

Receiver sensitivity –30 dBm

Power budget 10 dB

Maximum input power –14 dBm

Typical distance 2 km

Full duplex yes

Redundancy yes



CHAPTER 2: PRODUCT DESCRIPTION SPECIFICATIONS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 2-35

2

Peer delay measurement mechanism

PARALLEL REDUNDANCY PROTOCOL (PRP) 
(IEC 62439-3 CLAUSE 4, 2012)
Ethernet ports used: 2 and 3
Networks supported: 10/100 Mb Ethernet

PROCESS BUS MODULE (NON-HARDFIBER)
Ethernet ports: 2 x 1000Base-F, 1Gbps LC connectors,

4 x 1000Base-F (1Gbps) + 4 x 100Base-FX (100Mbps) LC connectors, or
4 x 100Base-FX, LC connectors

Number of sampled value (SV) streams: Up to 8
SV subscription profiles: IEC 61850-9-2LE (1 ASDU only)
Sampling Rate: 4800 Hz (80 samples/cycle) fixed for 60Hz - Protection class; or 

4000 Hz (80 samples/cycle) fixed for 50Hz - Protection class
GOOSE support: P1 class 1 TxGOOSE, and 8 RxGOOSE
Network Config modes: IEC 62439-3:2012 PRP (ports 1 and2); IEC 62439-3:2012 HSR (ports 1 and 2); or Point-to-Point 

(ports 1 to 8)
Time synchronization: IEC 61850-9-3 PTPv2 Utility profile; PTPv2/PP (IEEE C37.238-2017 over Process Bus Module; 

PTPv2/PP (IEEE C37.238-2017; or IGIB-B over CPU for PTP master
Time synchronization mode: Slave-only, master-only, master-slave on Process Bus Module, and slave-only on CPU
Simulation mode: Supported for both GOOSE and SV
Test mode (test, test/block): Supported for both GOOSE and SV

OTHER
TFTP, SFTP, HTTP, IEC 60870-5-104, Ethernet Global Data (EGD), IEEE C37.118

2.5.9  Inter-relay communications

SHIELDED TWISTED-PAIR INTERFACE OPTIONS

LINK POWER BUDGET AND MAXIMUM OPTICAL INPUT POWER
The following specifications apply to filter interface modules manufactured from January 2012.

Interface type Typical distance

RS422 1200 m

G.703 100 m

RS422 distance is based on transmitter power and does not take into consideration the clock source provided by 
the user.

Emitter, fiber type Cable type Transmit power Received 
sensitivity

Power budget Maximum 
optical input 
power

820 nm, Multimode 62.5/125 μm -16 dBm -32 dBm 16 dBm -8 dBm

50/125 μm -20 dBm 12 dBm

1300 nm, Multimode 62.5/125 μm -16 dBm -32 dBm 16 dBm -8 dBm

50/125 μm -20 dBm 12 dBm

1300 nm, Single 
mode

9/125 μm -15 dBm -32 dBm 17 dBm -8 dBm

1300 nm Laser, 
Single mode

9/125 μm 0 dBm -34 dBm 34 dBm -8 dBm

1550 nm Laser, 
Single mode

9/125 μm 5 dBm -34 dBm 39 dBm -10 dBm
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The following specifications apply to filter interface modules implemented before January 2012.

TYPICAL LINK DISTANCE

CONNECTOR LOSSES (Total of both ends)
ST connector: 0.7 dB (each)

FIBER LOSSES
820 nm multimode: 3 dB/km
1300 nm multimode: 1 dB/km
1300 nm single mode: 0.35 dB/km
1550 nm single mode: 0.25 dB/km
Splice losses: one splice every 2 km at 0.05 dB loss per splice

SYSTEM MARGIN
3 dB additional loss added to calculations to compensate for all other losses.

Compensated difference in transmitting and receiving (channel asymmetry) channel delays using GPS satellite clock: 10 ms

Emitter, fiber type Transmit 
power

Received 
sensitivity

Power budget Maximum optical 
input power

820 nm LED, Multimode –20 dBm –30 dBm 10 dB –7.6 dBm

1300 nm LED, Multimode –21 dBm –30 dBm 9 dB –11 dBm

1300 nm ELED, Single mode –23 dBm –32 dBm 9 dB –14 dBm

1300 nm Laser, Single mode –1 dBm –30 dBm 29 dB –14 dBm

1550 nm Laser, Single mode +5 dBm –30 dBm 35 dB –14 dBm

The power budgets are calculated from the manufacturer’s worst-case transmitter power and worst case receiver 
sensitivity.

The power budgets for the 1300 nm ELED are calculated from the manufacturer's transmitter power and receiver 
sensitivity at ambient temperature. At extreme temperatures these values deviate based on component tolerance. 
On average, the output power decreases as the temperature is increased by a factor of 1 dB / 5 °C.

Emitter, fiber type Cable type Connector 
type

Typical distance

Before 
January 
2012

From 
January 
2012

820 nm LED,
multimode

62.5/125 μm ST 1.65 km 2 km

50/125 μm ST 1.65 km 2 km

1300 nm LED,
multimode

62.5/125 μm ST 4 km 5 km

50/125 μm ST 4 km 5 km

1300 nm ELED,
single mode

9/125 μm ST 11.4 km 20 km

1300 nm Laser,
single mode

9/125 μm ST 64 km 65 km

1550 nm Laser,
single mode

9/125 μm ST 105 km 125 km

Typical distances listed are based on the following assumptions for system loss. As actual losses vary from one 
installation to another, the distance covered by your system can vary.



CHAPTER 2: PRODUCT DESCRIPTION SPECIFICATIONS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 2-37

2

2.5.10  CyberSentry security

OPTIONS
Software options: Level 1

2.5.11  Graphical front panel

DISPLAY
Type: color graphical back-lit LCD display
Size: 7 inches (17.8 cm)
Resolution: 800 by 480 pixels
Pages: 5 single-line diagram pages with controls, status, and metering values

up to 8 annunciator pages with total of 96 annunciator windows
1 phasor metering page for each AC Source
5 tabular metering pages with dynamic metering and status
event records page with dynamic update
product information page
settings, actual values, error messages (targets)

LED INDICATORS
Functions: 5 device status indicators

9 event cause indicators
8 user-programmable pushbutton indicators

PUSHBUTTONS
Type: membrane
Functions: 5 bottom Tab pushbuttons and 1 Home pushbutton for page recall

4 directional, 1 ENTER, and 1 ESCAPE pushbutton element selection
10 side pushbuttons for power system element control
RESET pushbutton
8 physical user-programmable pushbuttons, 8 graphical interface pushbuttons

INGRESS PROTECTION
IP code: IP54 front, IP10 back (IP20 back with IP20 cover accessory)

2.5.12  Environmental

AMBIENT TEMPERATURES
Storage temperature: –40 to 85°C
Operating temperature: –40 to 60°C; the LCD contrast can be impaired at temperatures less than –20°C

HUMIDITY
Humidity: operating up to 95% (non-condensing) at 55°C (as per IEC60068-2-30 variant 1, 6 days)

OTHER
Altitude: 2000 m (maximum)
Pollution degree: II
Overvoltage category: II
Ingress protection: IP20 front, IP10 back (basic front panel and Rev. 1 enhanced front panel)

IP40 front, IP10 back (Rev. 2 enhanced front panel)
IP54 front with IP54 mounting collar accessory (Rev. 2 enhanced front panel)

Ingress protection with IP20 cover accessory:
IP20 back

Noise: 0 dB
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2.5.13  Type tests

F60 TYPE TESTS

1 Not tested by third party.

2.5.14  Production tests

THERMAL
Products go through an environmental test based upon an Accepted Quality Level (AQL) sampling process.

Test Reference standard Test level

Dielectric voltage withstand EN 60255-51 2.2 kV

Impulse voltage withstand EN 60255-51 5 kV

Damped oscillatory IEC 61000-4-18 / IEC 60255-22-1 2.5 kV CM, 1 kV DM

Electrostatic discharge EN 61000-4-2 / IEC 60255-22-2 Level 3

RF immunity EN 61000-4-3 / IEC 60255-22-3 Level 3

Fast transient disturbance EN 61000-4-4 / IEC 60255-22-4 Class A and B

Surge immunity EN 61000-4-5 / IEC 60255-22-5 Level 3 and 4

Conducted RF immunity EN 61000-4-6 / IEC 60255-22-6 Level 3

Power frequency immunity EN 61000-4-71 / IEC 60255-22-7 Class A and B

Voltage interruption and ripple DC IEC 60255-11 12% ripple, 200 ms interrupts

Radiated and conducted emissions CISPR11 / CISPR22 / IEC 60255-25 Class A

Sinusoidal vibration IEC 60255-21-1 Class 1

Shock and bump IEC 60255-21-2 Class 1

Seismic IEC 60255-21-3 Class 1

Power magnetic immunity IEC 61000-4-8 Level 5

Pulse magnetic immunity IEC 61000-4-9 Level 4

Damped magnetic immunity IEC 61000-4-10 Level 4

Voltage dip and interruption IEC 61000-4-11 0, 40, 70, 80% dips; 250 / 300 cycle interrupts

Damped oscillatory IEC 61000-4-121 2.5 kV CM, 1 kV DM

Conducted RF immunity, 0 to 150 kHz IEC 61000-4-16 Level 4

Voltage ripple IEC 61000-4-17 15% ripple

Ingress protection IEC 605291 IP20 front, IP10 back

Cold IEC 60068-2-1 –40°C for 16 hours

Hot IEC 60068-2-2 85°C for 16 hours

Humidity IEC 60068-2-30 6 days, variant 1

Damped oscillatory IEEE/ANSI C37.90.1 2.5 kV, 1 MHz

RF immunity IEEE/ANSI C37.90.2 20 V/m, 80 MHz to 1 GHz

Safety UL 508 e83849 NKCR

Section 43 - Temperature test
Energization of Contact Inputs and/or Contact 
Outputs for continuous duty is not to exceed a 
total of 31 W of power

Safety UL C22.2-14 e83849 NKCR7

Safety UL 1053 e83849 NKCR

Safety IEC 60255-27 Insulation: class 1, Pollution degree: 2, Over 
voltage cat II
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2.5.15  Approvals
APPROVALS

2.5.16  Maintenance

MOUNTING
Attach mounting brackets using 20 inch-pounds (±2 inch-pounds) of torque.

CLEANING
Normally, cleaning is not required. When dust has accumulated on the front panel display, wipe with a dry cloth.

Compliance Applicable council directive According to

CE Low voltage directive EN 60255-5

EMC directive EN 60255-26 / EN 50263

EN 61000-6-5

C-UL-US --- UL 508

UL 1053

C22.2 No. 14

To avoid deterioration of electrolytic capacitors, power up units that are stored in a de-energized 
state once per year, for one hour continuously.
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F60 Feeder Protection System

Chapter 3: Installation

Installation

This chapter outlines installation of hardware and software. You unpack, mount, wire the unit, turn on power, then install 
the software and configure settings.

3.1  Unpack and inspect
1. Open the relay package and check that the following items have been delivered:

– F60

– Mounting screws

– GE EnerVista™ DVD (software and documentation)

– F60 Instruction Manual (soft copy on DVD; printed copy if ordered)

– UR Family Communications Guide (soft copy on DVD; printed copy if Instruction Manual ordered)

– Certificate of Calibration

– Test Report

– EC Declaration of Conformity

– Front panel label package

2. Inspect the unit for physical damage.

3. View the rear nameplate and verify that the correct model has been delivered. The model number is at the top right.

4. Any protective plastic film on the front panel is normally peeled off, but also can be left on.

5. For any issues, contact GE as outlined in the For Further Assistance section in chapter 1.

6. Check that you have the latest copy of the F60 Instruction Manual and the UR Family Communications Guide, for the 
applicable firmware version, at http://www.gegridsolutions.com/multilin/manuals/index.htm

http://www.gegridsolutions.com/multilin/manuals/index.htm
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The Instruction Manual outlines how to install, configure, and use the unit. The Communications Guide is for advanced use 
with communication protocols. The warranty is included at the end of this instruction manual and on the GE Grid Solutions 
website.

3.2  Panel cutouts
This section does not apply to the HardFiber Brick; see its instruction manual.

Install the relay in an indoor environment within the environmental specifications. The relay complies with Pollution 
Category II, which means installation in an office, laboratory, or testing environment.

3.2.1  Horizontal units
The F60 is available as a 19-inch rack horizontal mount unit with a removable front panel. The front panel is specified as 
enhanced, basic, or graphical at the time of ordering. The enhanced and graphical front panels have additional user-
programmable pushbuttons and LED indicators, while the basic front panel has additional user-programmable 
pushbuttons.

The modular design allows the relay to be upgraded and repaired by qualified service personnel. The front panel is hinged 
to allow access to the modules. The front panel is itself removable to allow mounting on doors with limited rear depth and 
for upgrading.

In November 2017, GE began transitioning to a new enhanced horizontal front panel, referred to as the IP54 Front Panel or 
Enhanced Front Panel Rev. 2. This panel can be identified by the use of a screw instead of a knob to close the panel. It can 
conform to an IP54 rating with the IP54 mounting collar purchased separately. The IP54 mounting collar can be used in 
panel-mount installations, not 19-inch rack-mount installations. The IP54 mounting collar cannot be used with Rev. 1 
enhanced front panels.

The case dimensions are shown in the following figures, along with panel cutout details for panel mounting. When 
planning the location of your panel cutout, ensure that provision is made for the front panel to swing open without 
interference to or from adjacent equipment.

Mount the relay such that the front panel sits semi-flush with the panel or switchgear door, allowing the operator access to 
the keypad and the front communications port.
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Figure 3-1: Horizontal dimensions (Rev. 1 enhanced front panel) 
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Figure 3-2: Horizontal dimensions (Rev. 2 enhanced front panel) 

Figure 3-3: Horizontal mounting (enhanced and graphical front panels) 
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Figure 3-4: Horizontal dimensions and mounting (basic front panel) 

Figure 3-5: Horizontal dimensions (graphical front panel) 
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Figure 3-6: Horizontal dimensions (IP54 mounting collar) 

3.2.2  Vertical units
The F60 is available as a reduced size (¾) vertical mount unit, with a removable front panel. The front panel is specified as 
enhanced or basic at the time of ordering. The enhanced front panel contains additional user-programmable pushbuttons 
and LED indicators, while the basic front panel has additional user-programmable pushbuttons.

The modular design allows the relay to be upgraded and repaired by qualified service personnel. The front panel is hinged 
to allow easy access to the modules. The front panel is itself removable to allow mounting on doors with limited rear depth 
and for upgrading.

The case dimensions are shown in the following figures, along with panel cutout details for panel mounting. When 
planning the location of your panel cutout, ensure that provision is made for the front panel to swing open without 
interference to or from adjacent equipment.

Mount the relay such that the front panel sits semi-flush with the panel or switchgear door, allowing the operator access to 
the keypad and the RS232 communications port.
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Figure 3-7: Vertical dimensions and mounting (enhanced front panel) 
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Figure 3-8: Vertical dimensions and mounting (basic front panel) 

For side-mounting F60 devices with the enhanced front panel, see the following documents available on the UR DVD and 
the GE Grid Solutions website:

• GEK-113180 — UR-Series UR-V Side-Mounting Front Panel Assembly Instructions

• GEK-113181 — Connecting a Remote UR-V Enhanced Front Panel to a Vertical UR Device Instruction Sheet

• GEK-113182 — Connecting a Remote UR-V Enhanced Front Panel to a Vertically-Mounted Horizontal UR Device 
Instruction Sheet

http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=3
http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=3
http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=3
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For side-mounting F60 devices with the basic front panel, use the following figures.

Figure 3-9: Vertical side-mounting installation (basic front panel) 
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Figure 3-10: Vertical side-mounting rear dimensions (basic front panel) 

3.2.3  Rear terminal layout
The rear terminals depend on order code. An example is shown.
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Terminal number assignments are three characters long and assigned by module slot position, row number, and column 
letter. Two-slot wide modules take their slot designation from the first slot position (nearest to CPU module), indicated by 
an arrow on the terminal block. The figure shows an example of rear terminal assignments.

Do not touch any rear terminals while the relay is energized, else death or serious injury can 
result from electrical shock.

Small form-factor pluggable ports (SFPs) are pluggable transceivers. They transmit, receive, and 
convert electrical signals to optical signals and vice-versa. Supplied with the device, they are inserted 
into the Ethernet ports on the CPU module. A photo in the Maintenance chapter shows this plug-in 
device. Do not use non-validated transceivers or install validated transceivers in the wrong Ethernet 
slot, else damage can occur.
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Figure 3-11: Example of modules in F and H slots 

The torque used to connect the screws that connect the terminal blocks (top screws a, b, c) and the metal plates over 
empty slots to the chassis is 9 inch-pounds. For the screws used to wire the terminal blocks (rows 1 to 8), use 19±1 inch-
pounds.

The CPU module type depends on order code. During manufacturing, the power supply and CPU modules are installed in 
slots B and D of the chassis with 13 inch-pounds of torque on the screws at the top and bottom of the modules. Wire 
connections to these two modules at 13 inch-pounds.

Figure 3-12: CPU modules and power supply 

The following figure shows the optical connectors for CPU modules.
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Figure 3-13: LC fiber connector (left) and ST fiber connector (right)

Speeds for the LC connections on non-HardFiber Process Bus Modules are as follows:

• Order code 85 — 1000Base-F ports 1a and 1b, or ports 3a and 3b

• Order code 86 — 1000Base-F ports 1a, 1b, 3a, 3b; 100Base-FX ports 2a, 2b, 4a, 4b

• Order code 87 — 100Base-FX ports 1a, 1b, 2a, 2b

3.3  Wiring

3.3.1  Typical wiring

For Sampled Value (SV) applications using a Process Bus Module with order code 85, 86, or 87 with IRIG-B for 
synchronization, follow the recommended cables and grounding connections outlined here and later.
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Figure 3-14: Typical wiring diagram (T module shown for CPU) 
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Figure 3-15: Typical wiring diagram with high-impedance detection (T module shown for CPU) 

3.3.2  Dielectric strength
Dielectric strength is the maximum electric strength that can be sustained without breakdown. It is measured in volts.

The table shows the dielectric strength of the UR-series module hardware.
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Table 3-1: Dielectric strength of UR modules

3.3.3  Control power

The power supply module is ordered with one of two possible voltage ranges, and the F60 can be ordered with or without a 
redundant power supply module option. Each range has a dedicated input connection for proper operation. The ranges 
are as follows (see the Specifications section of chapter 2 for details):

• Low (LO) range — 24 to 48 V (DC only) nominal

• High (HI) range — 125 to 250 V nominal

The power supply module provides power to the relay and supplies power for dry contact input connections.

The power supply module provides 48 V DC power for dry contact input connections and a critical failure relay (see the 
Typical Wiring Diagram earlier). The critical failure relay is a form-C device that is energized once control power is applied 
and the relay has successfully booted up with no critical self-test failures. If ongoing self-test diagnostic checks detect a 
critical failure (see the Self-Test Errors section in chapter 7) or control power is lost, the relay de-energizes.

To connect power to the relay:

1. On the power supply module in the first slot, slot B, on the back of the device, connect the three wires to the terminals, 
or connect two to the terminals and the third to the ground screw. 14 gauge stranded wire with disconnect devices is 
recommended. Use 13 inch-pounds torque. Connect all wires to the relay before turning on power.

Module type Module function Terminals Dielectric strength

From To

1 Power supply High (+); Low (+); (–) Chassis 2000 V AC for 1 minute

1 Power supply 48 V DC (+) and (–) Chassis 2000 V AC for 1 minute

1 Power supply Relay terminals Chassis 2000 V AC for 1 minute

2 Reserved N/A N/A N/A

3 Reserved N/A N/A N/A

4 Digital contact inputs/
outputs

All Chassis 2000 V AC for 1 minute

5 Analog inputs/outputs All except 8b Chassis < 50 V DC

6 Digital contact inputs/
outputs

All Chassis 2000 V AC for 1 minute

7 G.703 All except 2b, 3a, 7b, 8a Chassis 2000 V AC for 1 minute

RS422 All except 6a, 7b, 8a Chassis < 50 V DC

8 CT/VT All Chassis 2000 V AC for 1 minute

9 CPU All Chassis 2000 V AC for 1 minute

Filter networks and transient protection clamps are used in the hardware to prevent damage caused 
by high peak voltage transients, radio frequency interference (RFI), and electromagnetic interference 
(EMI). These protective components can be damaged by application of the ANSI/IEEE C37.90 
specified test voltage for longer than the specified minute.

Power supplied to the relay must be connected to the matching power supply range of the relay. If 
incorrect voltage is applied or voltage is applied to the wrong terminals, damage can occur.

The F60, like almost all electronic relays, contains electrolytic capacitors. These capacitors are well-
known to deteriorate over time if voltage is not applied periodically. Deterioration can be avoided by 
powering up the relay at least once a year.

Connect all wires at be back of a UR before connecting to power, else death or serious injury can 
result from electrical shock.
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For high-reliability systems, the F60 has a redundant option in which two F60 power supplies are placed in parallel on the 
bus. If one of the power supplies becomes faulted, the second power supply assumes the full load of the relay without any 
interruptions. Each power supply has a green LED on the front of the module to indicate that it is functional. The critical fail 
relay of the module also indicates a faulted power supply.

An LED on the front of the control power module shows the status of the power supply, as outlined in the table.

Table 3-2: Power supply LED on module

Figure 3-16: Control power connection 

3.3.3.1  Non-volatile data storage
Non-volatile data is temporary data required after a power cycle for relay state, such as latch status before reboot. The 
relay saves this data in non-volatile storage every two minutes or when a state change occurs.

If a state change occurs just before a power down (less than two minutes) and the relay power is cycled, some temporary 
data can be saved and the prior state is retained at power up. Otherwise, a two-minute powered on period after a state 
change ensures that all temporary state changes required after reboot have been saved. A command also is available to 
initiate saving of data in the compact flash memory using Commands > Relay Maintenance > Save Volatile Data.

3.3.4  CT/VT modules
The CT and VT inputs are analog current transformer and voltage transformer signals used to monitor AC power lines. The 
UR-series relays support 1 A and 5 A CTs.

A CT/VT module can have current or voltage inputs on channels 1 through 4 inclusive, or channels 5 through 8 inclusive. 
Channels 1 and 5 are intended for connection to phase A, and are labelled as such in the relay. Likewise, channels 2 and 6 
are intended for connection to phase B, and channels 3 and 7 are intended for connection to phase C.

Channels 4 and 8 are intended for connection to a single-phase source. For voltage inputs, these channels are labelled as 
auxiliary voltage (VX). For current inputs, these channels are intended for connection to a CT between system neutral and 
ground, and are labelled as ground current (IG).

LED indication Power supply

Continuous on OK

On/off cycling Failure

Off Failure or no power
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To connect to the module, size 12 American Wire Gauge (AWG) is used commonly; the maximum size is 10 AWG.

CT/VT modules can be ordered with a standard ground current input that is the same as the phase current input. Each AC 
current input has an isolating transformer and an automatic shorting mechanism that shorts the input when the module is 
withdrawn from the chassis. There are no internal ground connections on the current inputs. Current transformers with 1 
to 50000 A primaries and 1 A or 5 A secondaries can be used.

CT/VT modules with a sensitive ground input are also available. The ground CT input of the sensitive ground modules is 10 
times more sensitive than the ground CT input of standard CT/VT modules. However, the phase CT inputs and phase VT 
inputs are the same as those of regular CT/VT modules.

These modules have enhanced diagnostics that can detect automatically CT/VT hardware failure and take the relay out of 
service.

CT connections for both ABC and ACB phase rotations are identical, as shown in the Typical Wiring Diagram.

The exact placement of a zero-sequence core balance CT to detect ground fault current is shown as follows. Twisted-pair 
cabling on the zero-sequence CT is recommended.

Figure 3-17: Zero-sequence core balance CT installation 

The phase voltage channels are used for most metering and protection purposes. The auxiliary voltage channel is used as 
input for the synchrocheck and volts-per-hertz features, which are optional features for some UR models.

Verify that the connection made to the relay terminals for nominal current of 1 A or 5 A matches the 
secondary rating of the connected CTs. Unmatched CTs can result in equipment damage or 
inadequate protection.

Substitute the tilde “~” symbol with the slot position of the module in the following figure.
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Figure 3-18:     CT/VT module wiring 

A relay configured for high impedance fault detection element includes two CT/VT modules: one type 8F, 8G, 8H, or 8J 
module and one type 8Z module. For correct operation of the high impedance fault detection element, the ground current 
terminals of the two CT modules must be connected to a ground current source, either a zero-sequence CT (see the Typical 
wiring diagram with high impedance fault detection earlier in this chapter) or, if a zero-sequence CT is not available, to the 
neutral conductor of the phase CTs (see diagram below).
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Figure 3-19: Typical 8Z module wiring with phase CTs 

3.3.5  Process Bus Module for HardFiber
The F60 can be ordered with a process bus interface module to interface with the HardFiber Process Bus System, or 
HardFiber Brick, allowing bidirectional IEC 61850 fiber-optic communications with up to eight HardFiber Bricks. The 
HardFiber system integrates seamlessly with the existing UR-series applications, including protection functions, FlexLogic, 
metering, and communications.

This process bus system offers the following benefits:

• Reduces labor associated with design, installation, and testing of protection and control applications using the UR by 
reducing the number of individual copper terminations

• Integrates seamlessly with existing UR applications, since the IEC 61850 process bus interface module replaces the 
traditional CT/VT modules

• Communicates using open standard IEC 61850 messaging

For details on the HardFiber system, see its Instruction Manual.
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3.3.6  Contact inputs and outputs
Nearly all contact input/output modules have 24 terminal connections. The connections are arranged typically as three 
terminals per row, with eight rows in total. A given row of three terminals can be used for the outputs of one relay. For 
example, for form-C relay outputs, the terminals connect to the normally open (NO), normally closed (NC), and common 
contacts of the relay. For a form-A output, there are options of using current or voltage detection for feature supervision, 
depending on the module ordered. The terminal configuration for contact inputs is different for the two applications.

The contact inputs are grouped with a common return. The input/output modules have three versions of grouping: four 
inputs per common return, five inputs per common return on a high-density module, and two inputs per common return. 
When a contact input/output module is ordered, four inputs per common is used. If the inputs must be isolated per row, 
then two inputs per common return are selected (4D module). If the space limitation in the relay requires use of a high-
density input module (6W), five inputs share one common return and the module has six banks of inputs.

The tables and diagrams that follow illustrate the module types (6A and so on) and contact arrangements that can be 
ordered for the relay. Since an entire row is used for a single contact output, the name is assigned using the module slot 
position and row number. However, since there are two contact inputs per row, these names are assigned by module slot 
position, row number, and column position.

Some form-A / solid-state relay outputs include circuits to monitor the DC voltage across the output contact when it is 
open, and the DC current through the output contact when it is closed. Each of the monitors contains a level detector 
whose output is set to logic “On = 1” when the current in the circuit is above the threshold setting. The voltage monitor is 
set to “On = 1” when there is a voltage across open contact (the detector allows a current of about 1 to 2.5 mA), and the 
current monitor is set to “On = 1” when the current flowing through the closed contact exceeds about 80 to 100 mA. The 
voltage monitor is intended to check the health of the overall trip circuit, and the current monitor can be used to seal-in 
the output contact until an external contact has interrupted current flow. If enabled, the current monitoring can be used as 
a seal-in signal to ensure that the form-A contact does not attempt to break the energized inductive coil circuit and weld 
the output contacts.

Block diagrams are shown as follows for form-A and solid-state relay outputs with optional voltage monitor, optional 
current monitor, and with no monitoring. The actual values shown for contact output 1 are the same for all contact 
outputs. Form-A contact output with or without a current or voltage monitoring option is not polarity sensitive. The polarity 
shown in the figure is required for solid-state contact output connection.
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Figure 3-20: Form-A and solid-state contact outputs with voltage and current monitoring 

The operation of voltage and current monitors is reflected with the corresponding FlexLogic operands (CONT OP # VON, CONT 
OP # VOFF, and CONT OP # ION) that can be used in protection, control, and alarm logic. The typical application of the voltage 
monitor is breaker trip circuit integrity monitoring; a typical application of the current monitor is seal-in of the control 
command.

See the Digital Elements section of chapter 5 for an example of how form-A and solid-state relay contacts can be applied 
for breaker trip circuit integrity monitoring.

Consider relay contacts unsafe to touch when the unit is energized. Death or serious injury can 
result from touching live relay contacts.

USE OF FORM-A AND SOLID-STATE RELAY OUTPUTS IN HIGH-IMPEDANCE CIRCUITS
For form-A and solid-state relay output contacts internally equipped with a voltage measuring circuit across the 
contact, the circuit has an impedance that can cause a problem when used in conjunction with external high-input 
impedance monitoring equipment, such as modern relay test set trigger circuits. These monitoring circuits can 
continue to read the form-A contact as being closed after it has closed and subsequently opened, when measured 
as an impedance.

The solution is to use the voltage measuring trigger input of the relay test set, and connect the form-A contact 
through a voltage-dropping resistor to a DC voltage source. If the 48 V DC output of the power supply is used as a 
source, a 500 Ω, 10 W resistor is appropriate. In this configuration, the voltage across either the form-A contact or 
the resistor can be used to monitor the state of the output.

Where a tilde “~” symbol appears, substitute the slot position of the module. Where a number sign “#” appears, 
substitute the contact number.
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For high-density input/output modules 6W and 6X, use the following guidelines to connect. The new I/O modules use pin 
type terminal blocks instead of the current ring type. The new terminals are required to achieve higher I/O count per 
module.

• 12 to 24 AWG (3.3 mm2 to 0.2 mm2), single wire termination

• 16 to 24 AWG (1.31 mm2 to 0.2 mm2), multiple wire termination with matching wire sizes and stranding. Two wires 
maximum per circuit.

• Suggested wiring screw tightening torque is a minimum 4.43 in-lb (0.5 Nm) and maximum 5.31 in-lb (0.6 Nm)

• Minimum suggested temperature rating for the conductors is 75°C

• Wire type: copper

Table 3-3: Contact input and output module assignments

When current monitoring is used to seal-in the form-A and solid-state relay contact outputs, give the 
FlexLogic operand driving the contact output a reset delay of 10 ms to prevent damage of the output 
contact (in situations when the element initiating the contact output is bouncing, at values in the 
region of the pickup value).

~6A module ~6B module ~6C module ~6D module

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output Terminal 
assignment

Output

~1 Form-A ~1 Form-A ~1 Form-C ~1a, ~1c 2 Inputs

~2 Form-A ~2 Form-A ~2 Form-C ~2a, ~2c 2 Inputs

~3 Form-C ~3 Form-C ~3 Form-C ~3a, ~3c 2 Inputs

~4 Form-C ~4 Form-C ~4 Form-C ~4a, ~4c 2 Inputs

~5a, ~5c 2 Inputs ~5 Form-C ~5 Form-C ~5a, ~5c 2 Inputs

~6a, ~6c 2 Inputs ~6 Form-C ~6 Form-C ~6a, ~6c 2 Inputs

~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs ~7 Form-C ~7a, ~7c 2 Inputs

~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs ~8 Form-C ~8a, ~8c 2 Inputs

~6E module ~6F module ~6G module ~6H module

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

~1 Form-C ~1 Fast Form-C ~1 Form-A ~1 Form-A

~2 Form-C ~2 Fast Form-C ~2 Form-A ~2 Form-A

~3 Form-C ~3 Fast Form-C ~3 Form-A ~3 Form-A

~4 Form-C ~4 Fast Form-C ~4 Form-A ~4 Form-A

~5a, ~5c 2 Inputs ~5 Fast Form-C ~5a, ~5c 2 Inputs ~5 Form-A

~6a, ~6c 2 Inputs ~6 Fast Form-C ~6a, ~6c 2 Inputs ~6 Form-A

~7a, ~7c 2 Inputs ~7 Fast Form-C ~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs

~8a, ~8c 2 Inputs ~8 Fast Form-C ~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs

~6K module ~6L module ~6M module ~6N module

Terminal 
assignment

Output Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

~1 Form-C ~1 Form-A ~1 Form-A ~1 Form-A

~2 Form-C ~2 Form-A ~2 Form-A ~2 Form-A

~3 Form-C ~3 Form-C ~3 Form-C ~3 Form-A

~4 Form-C ~4 Form-C ~4 Form-C ~4 Form-A

~5 Fast Form-C ~5a, ~5c 2 Inputs ~5 Form-C ~5a, ~5c 2 Inputs
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~6 Fast Form-C ~6a, ~6c 2 Inputs ~6 Form-C ~6a, ~6c 2 Inputs

~7 Fast Form-C ~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs

~8 Fast Form-C ~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs

~6P module ~6R module ~6S module ~6T module

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

~1 Form-A ~1 Form-A ~1 Form-A ~1 Form-A

~2 Form-A ~2 Form-A ~2 Form-A ~2 Form-A

~3 Form-A ~3 Form-C ~3 Form-C ~3 Form-A

~4 Form-A ~4 Form-C ~4 Form-C ~4 Form-A

~5 Form-A ~5a, ~5c 2 Inputs ~5 Form-C ~5a, ~5c 2 Inputs

~6 Form-A ~6a, ~6c 2 Inputs ~6 Form-C ~6a, ~6c 2 Inputs

~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs

~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs

~6U module ~6V module ~6W module 6X module

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

~1 Form-A ~1 Form-A ~1a - ~2a Input ~1a, ~1b 2 Outputs

~2 Form-A ~2 Form-A ~3a - ~4a Input ~2a, ~2b 2 Outputs

~3 Form-A ~3 Form-C ~5a - ~6a Input ~3a, ~3b 2 Outputs

~4 Form-A ~4 2 Outputs ~7a - ~8a Input ~4a, ~4b 2 Outputs

~5 Form-A ~5a, ~5c 2 Inputs ~9a - ~10a Input ~5a, ~5b 2 Outputs

~6 Form-A ~6a, ~6c 2 Inputs ~11a - ~12a Input ~7a, ~7b 2 Outputs

~7a, ~7c 2 Inputs ~7a, ~7c 2 Inputs ~13a - ~14a Input ~8a, ~8b 2 Outputs

~8a, ~8c 2 Inputs ~8a, ~8c 2 Inputs ~15a - ~16a Input ~9a, ~9b 2 Outputs

--- --- --- --- ~17a - ~18a Input ~10a, ~10b 2 Outputs

--- --- --- --- ~1b - ~2b Input ~11a, ~11b 2 Outputs

--- --- --- --- ~3b - ~4b Input ~13a, ~13b 2 Outputs

--- --- --- --- ~5b - ~6b Input ~14a, ~14b 2 Outputs

--- --- --- --- ~7b - ~8b Input ~15a, ~15b 2 Outputs

--- --- --- --- ~9b - ~10b Input ~16a, ~16b 2 Outputs

--- --- --- --- ~11b - ~12b Input ~17a, ~17b 2 Outputs

--- --- --- --- ~13b - ~14b Input --- ---

--- --- --- --- ~15b - ~16b Input --- ---

--- --- --- --- ~17b - ~18b Input --- ---

~67 module ~4A module ~4B module ~4C module

Terminal 
assignment

Output Terminal 
assignment

Output Terminal 
assignment

Output Terminal 
assignment

Output

~1 Form-A ~1 Not Used ~1 Not Used ~1 Not Used

~2 Form-A ~2 Solid-State ~2 Solid-State ~2 Solid-State

~6K module ~6L module ~6M module ~6N module

Terminal 
assignment

Output Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input

Terminal 
assignment

Output or 
input
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~3 Form-A ~3 Not Used ~3 Not Used ~3 Not Used

~4 Form-A ~4 Solid-State ~4 Solid-State ~4 Solid-State

~5 Form-A ~5 Not Used ~5 Not Used ~5 Not Used

~6 Form-A ~6 Solid-State ~6 Solid-State ~6 Solid-State

~7 Form-A ~7 Not Used ~7 Not Used ~7 Not Used

~8 Form-A ~8 Solid-State ~8 Solid-State ~8 Solid-State

~4D module ~4L module

Terminal 
assignment

Output Terminal 
assignment

Output

~1a, ~1c 2 Inputs ~1 2 Outputs

~2a, ~2c 2 Inputs ~2 2 Outputs

~3a, ~3c 2 Inputs ~3 2 Outputs

~4a, ~4c 2 Inputs ~4 2 Outputs

~5a, ~5c 2 Inputs ~5 2 Outputs

~6a, ~6c 2 Inputs ~6 2 Outputs

~7a, ~7c 2 Inputs ~7 2 Outputs

~8a, ~8c 2 Inputs ~8 Not Used

~67 module ~4A module ~4B module ~4C module

Terminal 
assignment

Output Terminal 
assignment

Output Terminal 
assignment

Output Terminal 
assignment

Output
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Figure 3-21: Contact input and output module wiring (Sheet 1 of 3) 
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Figure 3-22: Contact input and output module wiring (Sheet 2 of 3) 
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Figure 3-23: Contact input and output module wiring (Sheet 3 of 3) 

3.3.6.1  Contact inputs
A dry contact has one side connected to terminal B3b. This is the positive 48 V DC voltage rail supplied by the power supply 
module. The other side of the dry contact is connected to the required contact input terminal. Each contact input group 
has its own common (negative) terminal that must be connected to the DC negative terminal (B3a) of the power supply 
module. When a dry contact closes, a current of 1 to 3 mA flows through the associated circuit.

A wet contact has one side connected to the positive terminal of an external DC power supply. The other side of this 
contact is connected to the required contact input terminal. If a wet contact is used, then the negative side of the external 
source must be connected to the relay common (negative) terminal of each contact group. The maximum external source 
voltage for this arrangement is 300 V DC.

The voltage threshold at which each group of four contact inputs detects a closed contact input is programmable as 
17 V DC for 24 V sources, 33 V DC for 48 V sources, 84 V DC for 110 to 125 V sources, and 166 V DC for 250 V sources.

Figure 3-24: Dry and wet contact input connections 

For proper functionality, observe the polarity shown in the figures for all contact input and output 
connections.

Where a tilde “~” symbol appears, substitute the slot position of the module.
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There is no provision in the relay to detect a DC ground fault on 48 V DC control power external output. We recommend 
using an external DC supply.

3.3.6.2  General application considerations
Contacts outputs of protective relays, auxiliary contacts from breakers, disconnectors and other devices are connected 
generally to contacts inputs of protective relays. In some situations, the contact outputs of some protective relays can 
have high impedance connected across it. When such a contact output is connected across a F60 contact input, it can 
spuriously operate the F60 input even when the output is open, if there is a substantial distributed capacitance 
(represented by C1) present in the wiring between the output and the F60 input, and the debounce time setting in the F60 
relay is low enough. This false assertion of the contact input, when there is inadvertent ground present at the DC positive 
terminal, can be prevented by inserting a resistor across the F60 input.

The following figure shows a typical DC circuit, with battery ground detection, of contact input. The contact output has 
parallel impedance across it (represented by R1).

Figure 3-25: Typical contact input DC circuit 

The presence of the impedance path (R1) across the contact output allows the stray (distributed) capacitance C1 to charge 
as shown, thus developing a voltage across the contact input enough to momentarily operate the input while the 
capacitance discharges in the presence of DC ground on the positive terminal of the battery.

The duration of the discharge depends on the value of the distributed capacitance, the initial voltage of the distributed 
capacitance, and the input impedance of the contact input. If the duration is greater than the debounce time setting, then 
the contact input operates.

The application example that follows describes how to mitigate this issue by connecting a resistor across the contact 
input, as shown in the next figure, or by adjusting the debounce time setting to a value greater than the discharge time to 
prevent spurious operation of the contact input only if the voltage (with output open) across the contact input due to trickle 
current is less than the threshold voltage. This operation of contact inputs also can be prevented by using the Auto-Burnish 
contact inputs or contact inputs with active impedance.
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Figure 3-26: Contact input connected to a contact output with resistor (R2) across the input 

Application example
This example is for illustrative purposes only and the calculations present the worst-case scenario. In practice, the value of 
debounce time can be lower.

Contact input ON state impedance used in the calculation of the discharge period is based on the following table.

Table 3-4: Discharge period

Debounce time setting = 2 ms

Assume a stray capacitance of 0.1 μF.

Assume an initial voltage across the stray capacitance "Vinitial" = 19 V (Vthreshold - 65 V), where Vthreshold = 84 V. The 
initial voltage Vinitial depends on values of impedance of R1 and contact inputs when the contact input is OFF (non-
activated state).

Therefore, discharge time constant (τ) =50 kΩ *0.1 μF = 5 ms.

Discharge period t is calculated from the following equation:

Vthreshold = (Vbatt - VInitial) *e^ (-t/τ)

84 = -149 *e^ (t/0.005) Eq. 3-1

T = -0.005 * ln (84/149) = 0.0029 s

Therefore, in this example the contact inputs operate.

To prevent this operation, the debounce time must be increased to 4 ms (set debounce time as per the following table) or 
insert a resistor less than or equal to "R" as calculated later.

Table 3-5: Typical debounce time setting

Battery voltage (V) Input impedance (kΩ)

130 50

250 97

Stray capacitance (μF) Battery voltage (V) Debounce time (ms)

0.05 130 2

0.1 130 4

0.2 130 6

0.05 250 3
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* Default debounce time on contact inputs is 6 ms.

The value of this resistor "R" is calculated as follows:

1. Determine the minimum voltage (V threshold) required to turn on the input. This is determined by direct measurement 
or referenced in the input specifications.

2. Calculate the resistance necessary to limit the voltage to 1/3 V threshold (when the contact is OFF, the non-activated 
state) as follows:

R = (Vthreshold / 3) / (2 mA) Eq. 3-2

The 2 mA current is used in case the contact input is connected across the GE Form A contact output with voltage 
monitoring. Otherwise use the amperage of the active circuit connected to the contact input when its contact output 
is open and the voltage across the contact input is third trigger threshold to calculate the resistor value.

3. When the contact is ON (operate state), the battery voltage appears across the resistor. The wattage rating of the 
resistor is then:

PR = 1.3 * (Vbatt) ^2 / R Watts Eq. 3-3

4. Applying the following equation to our example:

R = 84 V / 3 * (1 / 2 mA) = 14 kΩ

PR = 1.57 Watts Eq. 3-4

5. Calculating the voltage across the contact input with the Burden Resistor, Voltage across the contact Input:

Vresistor = 2 mA * 14 Kohm = 28 V

Vresistor < contact input threshold (84 V) Eq. 3-5

In conclusion, in this example, the contact input does NOT operate falsely with the Burden Resistor across its input AND 
when a battery ground is present.

3.3.6.3  Use of contact inputs with auto-burnishing
The contact inputs sense a change of state of the external device contact based on the measured current. When external 
devices are located in a harsh industrial environment (either outdoor or indoor), their contacts can be exposed to various 
types of contamination. Normally, there is a thin film of insulating sulfidation, oxidation, or contaminates on the surface of 
the contacts, sometimes making it difficult or impossible to detect a change of state. This film must be removed to 
establish circuit continuity — an impulse of higher than normal current can accomplish this.

The contact inputs with auto-burnish create a high current impulse when the threshold is reached to burn off this oxidation 
layer as a maintenance to the contacts. Afterwards the contact input current is reduced to a steady-state current. The 
impulse has a five-second delay after a contact input changes state.

Figure 3-27: Current through contact inputs with auto-burnishing 

0.1 250 6 *

0.2 250 11

Stray capacitance (μF) Battery voltage (V) Debounce time (ms)
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Regular contact inputs limit current to less than 3 mA to reduce station battery burden. In contrast, contact inputs with 
auto-burnishing allow currents up to 50 to 70 mA at the first instance when the change of state is sensed. Then, within 25 
to 50 ms, this current is slowly reduced to 3 mA as indicated. The 50 to 70 mA peak current burns any film on the contacts, 
allowing for proper sensing of state changes. If the external device contact is bouncing, the auto-burnishing starts when 
external device contact bouncing is over.

Another important difference between the auto-burnishing input module and the regular input modules is that only two 
contact inputs have common ground, as opposed to four contact inputs sharing one common ground (see the Contact 
Input and Output Module Wiring diagrams). This is beneficial when connecting contact inputs to separate voltage sources. 
Consequently, the threshold voltage setting is also defined per group of two contact inputs.

The auto-burnish feature can be disabled or enabled using the DIP switches found on each daughter card. There is a DIP 
switch for each contact, for a total of 16 inputs.

Figure 3-28: Auto-burnish DIP switches 

The auto-burnish circuitry has an internal fuse for safety purposes. During regular maintenance, check the auto-burnish 
functionality using an oscilloscope.

3.3.6.4  Use of contact inputs with active impedance
Contact inputs can be susceptible to parasitic capacitance, caused by long cable runs affected by switching surges from 
external circuits. This can result in inadvertent activation of contact inputs with the external contact open. In this case, GE 
recommends using the contact I/O module with active impedance circuit.

Active impedance contact input can tolerate external cable capacitance of up to 0.2 µF, without entering the ON state for 
more than 2 ms. The contact input debounce time can still be set above 2 ms for added security to prevent contact input 
activations caused by external transient ON states.

An active impedance contact input is normally in Low impedance mode during OFF contact state (non-activated 
condition). During Low impedance state, contact input impedance is maintained at 10 K Ohms impedance to allow fast 
discharge of the stray capacitance of the long cables.

When the contact input voltage exceeds the set threshold, active impedance maintains 10 K Ohms impedance. If voltage 
starts rapidly decreasing, this indicates that stray capacitance is being discharged through the contact input. If, however, 
voltage stabilizes above the set threshold, the input impedance is switched to High impedance mode of 100 K Ohms. This 
value reduces the input current to <3 mA, and contact input switches to the ON state (operated state).

The figure shows the active impedance contact input V-I characteristic. Different thresholds with their corresponding 
characteristics are shown by color. The contact input is in the ON (operated) state if the input voltage is to the right of the 
colored threshold band (+/-10% tolerance), and the contact input is in the OFF (non-activated) state when input voltage is 
to the left of the band. A contact input is in LOW state during non-operated system condition, and actively switches to 
HIGH state upon detection of input voltage above the settable threshold.

CONTACT INPUT 1 AUTO-BURNISH = OFF
= OFFCONTACT INPUT 2 AUTO-BURNISH

CONTACT INPUT 1 AUTO-BURNISH
CONTACT INPUT 2 AUTO-BURNISH

= ON
= OFF

CONTACT INPUT 1 AUTO-BURNISH
CONTACT INPUT 2 AUTO-BURNISH

= OFF
= ON

CONTACT INPUT 1 AUTO-BURNISH
CONTACT INPUT 2 AUTO-BURNISH

= ON
= ON

842751A1.CDR
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Figure 3-29: Active impedance contact input V-I characteristic 

3.3.7  Transducer inputs and outputs
Transducer input modules receive input signals from external DCmA output transducers (DCmA In) or resistance 
temperature detectors (RTDs). Hardware and software are provided to receive signals from these external transducers and 
convert these signals into a digital format for use as required.

Transducer output modules provide DC current outputs in several standard DCmA ranges. Software is provided to 
configure virtually any analog quantity used in the relay to drive the analog outputs.

Each transducer input/output module has 24 terminal connections. These connections are arranged as three terminals 
per row over eight rows. A given row can be used for either inputs or outputs, with terminals in column "a" having positive 
polarity and terminals in column "c" having negative polarity. Since an entire row is used for a single input/output channel, 
the name of the channel is assigned using the module slot position and row number.

Each module also requires that a connection from an external ground bus be made to terminal 8b. The current outputs 
require a twisted-pair shielded cable, where the shield is grounded at one end only. The following figure illustrates the 
transducer module types (5A, 5C, 5D, 5E, and 5F) and channel arrangements that can be ordered for the relay.
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Figure 3-30: Transducer input/output module wiring 

The following figure show how to connect RTDs.

Where a tilde “~” symbol appears, substitute the slot position of the module.
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Figure 3-31: RTD connections 

3.3.8  RS232 port
On the enhanced and basic front panels is a nine-pin RS232C serial port for programming with a computer. All that is 
required to use this interface is a computer running the EnerVista UR Setup software provided with the relay. Cabling for 
the RS232 port is shown in the following figure for the nine-pin connector on the UR and nine or 25-pin connector on a 
computer.

The baud rate for this port can be set, with a default of 115200 bps.

Figure 3-32: RS232 front panel port connection 
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3.3.9  CPU communication ports

3.3.9.1  Overview
There is a rear RS485 communication port on the CPU module. The CPU module does not require a surge ground 
connection.

For Sampled Value (SV) applications using a Process Bus Module with order code 85, 86, or 87 with IRIG-B for 
synchronization, follow the recommended cables and grounding connections.
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Figure 3-33: CPU module communications wiring 

3.3.9.2  RS485 port
RS485 data transmission and reception are accomplished over a single twisted-pair wire with transmit and receive data 
alternating over the same two wires. Through the use of the port, continuous monitoring and control from a remote 
computer, SCADA system, or Power Line Carrier (PLC) is possible.
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To minimize errors from noise, the use of shielded twisted-pair wire is recommended. Correct polarity must be observed. 
For instance, the relays must be connected with all RS485 “+” terminals connected together, and all RS485 “–” terminals 
connected together. Though data is transmitted over a two-wire twisted pair, all RS485 devices require a shared reference, 
or common voltage. This common voltage is implied to be a power supply common. Some systems allow the shield (drain 
wire) to be used as common wire and to connect directly to the F60 COM terminal (#3); others function correctly only if the 
common wire is connected to the F60 COM terminal, but insulated from the shield.

To avoid loop currents, ground the shield at only one point. If other system considerations require the shield to be 
grounded at more than one point, install resistors (typically 100 ohms) between the shield and ground at each grounding 
point. Each relay needs to be daisy-chained to the next one in the link. A maximum of 32 relays can be connected in this 
manner without exceeding driver capability. For larger systems, additional serial channels must be added. It is also 
possible to use commercially available repeaters to have more than 32 relays on a single channel. Avoid star or stub 
connections entirely.

Lightning strikes and ground surge currents can cause large momentary voltage differences between remote ends of the 
communication link. For this reason, surge protection devices are provided internally at both communication ports. An 
isolated power supply with an optocoupled data interface also acts to reduce noise coupling. To ensure maximum 
reliability, ensure that all equipment has similar transient protection devices installed.

Terminate both ends of the RS485 circuit with an impedance as shown in the figure.

Figure 3-34: RS485 serial connection 

3.3.9.3  100Base-FX fiber optic ports
The fiber-optic communication ports allow for fast and efficient communications between relays at 100 Mbps. Optical 
fiber can be connected to the relay supporting a wavelength of 1310 nm in multimode.

Ensure that the dust covers are installed when the fiber is not in use. Dirty or scratched connectors can lead to high losses 
on a fiber link.



CHAPTER 3: INSTALLATION DIRECT INPUT AND OUTPUT COMMUNICATIONS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 3-39

3

3.3.10  IRIG-B
There is a round IRIG-B connector at the back of the CPU module, marked "IN." Use is optional.

IRIG-B is a standard time code format that allows stamping of events to be synchronized among connected devices. The 
IRIG-B code allows time accuracies of up to 100 ns. The GE MultiSync 100 1588 GPS Clock as well as third-party equipment 
are available for generating the IRIG-B signal. This equipment can use a global positioning system (GPS) satellite system to 
obtain the time reference so that devices at different geographic locations can be synchronized. The IRIG time code 
formats are serial, pulse width-modulated codes that can be either DC level shifted or amplitude modulated (AM). Using 
IRIG-B input, the F60 operates an internal oscillator with 1 µs resolution and accuracy.

Figure 3-35: Options for IRIG-B connection 

3.4  Direct input and output communications

3.4.1  Description
The direct inputs and outputs feature makes use of the type 7 series of communications modules and allows direct 
messaging between UR devices. The communications modules are outlined in the table later in this section.

Using an amplitude-modulated receiver causes errors up to 1 ms in event time stamping.
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The communications channels are normally connected in a ring configuration, as shown in the following figure. The 
transmitter of one module is connected to the receiver of the next module. The transmitter of this second module is then 
connected to the receiver of the next module in the ring. This is continued to form a communications ring. The figure 
illustrates a ring of four UR-series relays with the following connections: UR1-Tx to UR2-Rx, UR2-Tx to UR3-Rx, UR3-Tx to 
UR4-Rx, and UR4-Tx to UR1-Rx. A maximum of 16 URs can be connected in a single ring.

Figure 3-36: Direct input and output single-channel connection 

Inter-relay communication (IRC) modules with protocol C37.94 and G.703 are designed for back-to-back communication 
connections, so the ring configuration shown in the previous figure does not apply. To establish inter-relay communication 
in more than two URs, you need to have a two-channel IRC module and enable the DIRECT I/O CHANNEL CROSSOVER setting 
in all relays, as shown in the next figure. This configuration can be expanded to 16 URs, and this configuration does not 
provide a redundancy ring since both channels are made into a single ring by the channel crossover function. As per the 
figure entitled Typical Pin Interconnection between Two G.703 Interfaces later in this chapter, the clock is supplied typically 
by multiplexer (MUX) and all URs are in Loop Timing Mode. If there is no MUX, then UR1 and UR3 can be in Internal Timing 
Mode and UR2 and UR4 can be in Loop Timing Mode. That is, connected channels must have opposite timing modes.

Figure 3-37: Ring configuration for C37.94 module (concept also applies to G.703) 

The interconnection for dual-channel type 7 communications modules is shown as follows. Two-channel modules allow for 
a redundant ring configuration. That is, two rings can be created to provide an additional independent data path. The 
required connections are: UR1-Tx1 to UR2-Rx1, UR2-Tx1 to UR3-Rx1, UR3-Tx1 to UR4-Rx1, and UR4-Tx1 to UR1-Rx1 for the 
first ring; and UR1-Tx2 to UR4-Rx2, UR4-Tx2 to UR3-Rx2, UR3-Tx2 to UR2-Rx2, and UR2-Tx2 to UR1-Rx2 for the second ring.
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Figure 3-38: Direct input and output dual-channel connection 

The following figure shows the connection for three UR-series relays using two independent communication channels. UR1 
and UR3 have single type 7 communication modules; UR2 has a dual-channel module. The two communication channels 
can be of different types, depending on the type 7 modules used. To allow the direct input and output data to cross-over 
from channel 1 to channel 2 on UR2, set the DIRECT I/O CHANNEL CROSSOVER setting to “Enabled” on UR2. This forces UR2 to 
forward messages received on Rx1 out Tx2, and messages received on Rx2 out Tx1.

Figure 3-39: Direct input and output single/dual channel combination connection 

The inter-relay communications modules are available with several interfaces and some are outlined here in more detail. 
Those that apply depend on options purchased. The options are outlined in the Inter-Relay Communications section of the 
Order Code tables in Chapter 2. All of the fiber modules use ST type connectors.
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3.4.2  Fiber: LED and ELED transmitters
The following figure shows the configuration for the 7A, 7B, 7C, 7H, 7I, and 7J fiber-only modules.

Figure 3-40: LED and ELED fiber modules 

3.4.3  Fiber laser transmitters
The following figure shows the configuration for the 72, 73, 7D, and 7K fiber-laser modules.

Figure 3-41: 7x Laser fiber modules 

The following figure shows configuration for the 2I and 2J fiber-laser modules.
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Figure 3-42: 2I and 2J laser fiber modules 

3.4.4  G.703 interface

3.4.4.1  Description
G.703 is an International Telecommunications Union (ITU) standard for the transmission of data and voice signals. Modules 
7R (one channel) and 7S (two channels) apply.

The following figure shows the 64K ITU G.703 co-directional interface configuration. This is module 7S.

The G.703 module is fixed at 64 kbps. The SETTINGS  PRODUCT SETUP  DIRECT I/O  DIRECT I/O DATA RATE setting is not 
applicable to this module.

AWG 24 twisted shielded pair wiring is recommended for external connections, with the shield grounded only at one end. 
Connecting the shield to pin X1a or X6a grounds the shield since these pins are connected internally to ground. Thus, if 
pin X1a or X6a is used to ground the shield at one end, do not ground the shield at the other end. This interface module is 
protected by surge suppression devices.

Figure 3-43: G.703 interface configuration 

Observing any fiber transmitter output can injure the eye.

When using a laser Interface, attenuators can be necessary to ensure that you do not exceed the 
maximum optical input power to the receiver.
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The following figure shows the typical pin interconnection between two G.703 interfaces. For the actual physical 
arrangement of these pins, see the Rear Terminal Layout section earlier in this chapter. All pin interconnections are to be 
maintained for a connection to a multiplexer.

Figure 3-44: Typical pin interconnection between two G.703 interfaces 

3.4.4.2  G.703 selection switch procedures

1. With the power to the relay off, remove the G.703 module (7R or 7S) as follows. Record the original location of the 
module to help ensure that the same or replacement module is inserted into the correct slot.

2. Simultaneously pull the ejector/inserter clips located at the top and at the bottom of each module in order to release 
the module for removal. (For more information on accessing modules, see the Maintenance chapter.)

3. Remove the module cover screw.

4. Remove the top cover by sliding it towards the rear and then lift it upwards.

5. Set the timing selection switches (channels 1 and 2) to the required timing modes.

6. Replace the top cover and the cover screw.

7. Re-insert the G.703 module. Take care to ensure that the correct module type is inserted into the correct slot position. 
The ejector/inserter clips located at the top and bottom of each module must be in the disengaged position as the 
module is inserted smoothly into the slot. Once the clips have cleared the raised edge of the chassis, engage the clips 
simultaneously. When the clips have locked into position, the module is inserted fully.

Pin nomenclature differs from one manufacturer to another. It is not uncommon to see pinouts numbered TxA, TxB, 
RxA, and RxB. In such cases, assume that “A” is equivalent to “+” and “B” is equivalent to “–.”
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Figure 3-45: G.703 timing selection switch setting 

Table 3-6: G.703 timing selections

3.4.4.3  G.703 octet timing
If octet timing is enabled (ON), this 8 kHz signal is asserted during the violation of bit 8 (LSB) necessary for connecting to 
higher order systems. When F60s are connected back-to-back, octet timing is disabled (OFF).

3.4.4.4  G.703 timing modes
There are two timing modes for the G.703 module: internal timing mode and loop timing mode (default).

• Internal Timing Mode — The system clock is generated internally. Therefore, set the G.703 timing selection to internal 
timing mode for back-to-back (UR-to-UR) connections. For back-to-back connections, set octet timing (S1 = OFF) and 
timing mode to internal timing (S5 = ON and S6 = OFF).

• Loop Timing Mode — The system clock is derived from the received line signal. Therefore, set the G.703 timing 
selection to loop timing mode for connections to higher order systems. For connection to a higher order system (UR-
to-multiplexer, factory defaults), set to octet timing (S1 = ON) and set timing mode to loop timing (S5 = OFF and S6 = 
OFF).

The switch settings for the internal and loop timing modes are shown.

Switches Function

S1 OFF octet timing disabled
ON octet timing 8 kHz

S5 and S6 S5 = OFF and S6 = OFF loop timing mode
S5 = ON and S6 = OFF internal timing mode
S5 = OFF and S6 = ON minimum remote loopback mode
S5 = ON and S6 = ON dual loopback mode
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Figure 3-46: Switches 

3.4.4.5  G.703 test modes
In minimum remote loopback mode, the multiplexer is enabled to return the data from the external interface without any 
processing to assist in diagnosing G.703 line-side problems irrespective of clock rate. Data enters from the G.703 inputs, 
passes through the data stabilization latch that also restores the proper signal polarity, passes through the multiplexer, 
and then returns to the transmitter. The differential received data is processed and passed to the G.703 transmitter module 
after which point the data is discarded. The G.703 receiver module is fully functional and continues to process data and 
passes it to the differential Manchester transmitter module. Since timing is returned as it is received, the timing source is 
expected to be from the G.703 line side of the interface.

Figure 3-47: G.703 minimum remote loopback mode 

In dual loopback mode, the multiplexers are active and the functions of the circuit are divided into two with each receiver/
transmitter pair linked together to deconstruct and then reconstruct their respective signals. Differential Manchester data 
enters the Differential Manchester receiver module and then is returned to the differential Manchester transmitter module. 
Likewise, G.703 data enters the G.703 receiver module and is passed through to the G.703 transmitter module to be 
returned as G.703 data. Because of the complete split in the communications path and because, in each case, the clocks 
are extracted and reconstructed with the outgoing data, in this mode there must be two independent sources of timing. 
One source lies on the G.703 line side of the interface while the other lies on the differential Manchester side of the 
interface.

Figure 3-48: G.703 dual loopback mode 
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3.4.5  RS422 interface

3.4.5.1  Description
There are two RS422 inter-relay communications modules available: single-channel (module 7T) and dual-channel (module 
7W). The modules can be configured to run at 64 kbps or 128 kbps. AWG 20 to 24 twisted shielded pair cable is 
recommended for external connections. These modules are protected by optically-isolated surge suppression devices.

The shield pins (6a and 7b) are connected internally to the ground pin (8a). Proper shield termination is as follows:

• Site 1 — Terminate shield to pins 6a or 7b or both

• Site 2 — Terminate shield to COM pin 2b

Match the clock terminating impedance with the impedance of the line.

Figure 3-49: RS422 interface connections 

The following figure shows the typical pin interconnection between two single-channel RS422 interfaces installed in slot W. 
All pin interconnections are to be maintained for a connection to a multiplexer.

Figure 3-50: Typical pin interconnect between two RS422 interfaces 

3.4.5.2  Two-channel application via multiplexers
The RS422 interface can be used for single-channel or two-channel applications over SONET/SDH or multiplexed systems. 
When used in single-channel applications, the RS422 interface links to higher-order systems in a typical way, observing 
transmit (Tx), receive (Rx), and send timing (ST) connections. However, when used in two-channel applications, certain 
criteria must be followed since there is one clock input for the two RS422 channels. The system functions correctly when 
the following connections are observed and your data module has a terminal timing feature. Terminal timing is a common 
feature in most synchronous data units that allows the module to accept timing from an external source. Using the 
terminal timing feature, two-channel applications can be achieved if these connections are followed: the send timing 
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outputs from the multiplexer (data module 1) connects to the clock inputs of the UR RS422 interface in the usual way. In 
addition, the send timing outputs of data module 1 are also paralleled to the terminal timing inputs of data module 2. By 
using this configuration, the timing for both data modules and both UR RS422 channels is derived from a single clock 
source. As a result, data sampling for both of the UR RS422 channels is synchronized via the send timing leads on data 
module 1, shown as follows. If the terminal timing feature is not available or this type of connection is not wanted, the 
G.703 interface is a viable option that does not impose timing restrictions.

Figure 3-51: Timing configuration for RS422 two-channel, three-terminal application 

Data module 1 provides timing to the F60 RS422 interface via the ST(A) and ST(B) outputs. Data module 1 also provides 
timing to data module 2 TT(A) and TT(B) inputs via the ST(A) and AT(B) outputs. The data module pin numbers have been 
omitted in the figure because they vary by manufacturer.

3.4.5.3  Transmit timing
The RS422 interface accepts one clock input for transmit timing. It is important that the rising edge of the 64 kHz transmit 
timing clock of the multiplexer interface is sampling the data in the center of the transmit data window. Therefore, it is 
important to confirm clock and data transitions to ensure proper system operation. For example, the following figure 
shows the positive edge of the Tx clock in the center of the Tx data bit.
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Figure 3-52: Clock and data transitions 

3.4.5.4  Receive timing
The RS422 interface utilizes NRZI-MARK modulation code and therefore does not rely on an Rx clock to recapture data. 
NRZI-MARK is an edge-type, invertible, self-clocking code.

To recover the Rx clock from the data-stream, an integrated digital phase lock loop (DPLL) circuit is utilized. The DPLL is 
driven by an internal clock, which is 16-times over-sampled, and uses this clock along with the data-stream to generate a 
data clock that can be used as the serial communication controller (SCC) receive clock.

3.4.6  RS422 and fiber interface
The following figure shows the combined RS422 plus fiberoptic interface configuration at 64 K baud. The 7L, 7M, 7N, 7P, 
and 74 modules are used in two-terminal with a redundant channel or three-terminal configurations where channel 1 is 
employed via the RS422 interface (possibly with a multiplexer) and channel 2 via direct fiber.

AWG 20 to 24 twisted shielded pair wiring is recommended for external RS422 connections. Ground the shield only at one 
end. For the direct fiber channel, address power budget issues properly.

Figure 3-53: RS422 and fiber interface connection 

The connections shown in the figure are for multiplexers configured as data communications equipment (DCE) units.

When using a laser interface, attenuators can be necessary to ensure that you do not exceed 
maximum optical input power to the receiver.

831733A1.CDR

Tx Clock

Tx Data
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3.4.7  G.703 and fiber interface
The following figure shows the combined G.703 plus fiber-optic interface configuration at 64 kbps. The 7E, 7F, 7G, 7Q, and 
75 modules are used in configurations where channel 1 is employed via the G.703 interface (possibly with a multiplexer) 
and channel 2 via direct fiber. AWG 24 twisted shielded pair wiring is recommended for external G.703 connections 
connecting the shield to pin 1a at one end only. For the direct fiber channel, address power budget issues properly. See 
previous sections for details on the G.703 and fiber interfaces.

Figure 3-54: G.703 and fiber interface connection 

3.4.8  IEEE C37.94 interface
IEEE C37.94 is a standard interface between teleprotection equipment and digital multiplexers.

The UR-series IEEE C37.94 modules (module types 2G, 2H, 2I, 2J, 76, and 77) are designed to interface with IEEE C37.94 
compliant digital multiplexers or an IEEE C37.94 compliant interface converter for use with direct input and output 
applications. The IEEE C37.94 standard defines a point-to-point optical link for synchronous data between a multiplexer 
and a teleprotection device. Data speed is typically 64 kbps, but the standard provides for speeds up to 64n kbps, where n 
= 1, 2,…, 12. The UR-series C37.94 communication modules are either 64 kbps (with n fixed at 1) or 128 kbps (with n fixed at 
2). The frame is a valid International Telecommunications Union (ITU-T) recommended G.704 pattern from the standpoint 
of framing and data rate. The frame is 256 bits and is repeated at a frame rate of 8000 Hz, with a resultant bit rate of 2048 
kbps.

The specifications for the module are as follows:

• IEEE standard — C37.94 for 1  128 kbps optical fiber interface (for 2G and 2H modules) or C37.94 for 2  64 kbps 
optical fiber interface (for 76 and 77 modules)

• Fiber-optic cable type — 50 nm or 62.5 μm core diameter optical fiber

• Fiber-optic mode — multimode

• Fiber-optic cable length — up to 2 km

• Fiber-optic connector — type ST

• Wavelength — 820 ±40 nm

• Connection — as per all fiber-optic connections, a Tx-to-Rx connection is required

The UR-series C37.94 module can be connected directly to any compliant digital multiplexer that supports the IEEE C37.94 
standard. The figure shows the concept.

When using a laser interface, attenuators can be necessary to ensure that you do not exceed the 
maximum optical input power to the receiver.
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Figure 3-55: IEEE C37.94 connection to compliant digital multiplexer 

The UR-series C37.94 communication module can be connected to the electrical interface (G.703, RS422, or X.21) of a non-
compliant digital multiplexer via an optical-to-electrical interface converter that supports the IEEE C37.94 standard. The 
following figure shows the concept.

Figure 3-56: IEEE C37.94 connection to non-compliant digital multiplexer 

In 2008, GE Grid Solutions released revised modules 76 and 77 for C37.94 communication to enable multi-ended fault 
location functionality with firmware 5.60 release and higher. All modules 76 and 77 shipped since the change support this 
feature and are fully backward compatible with firmware releases below 5.60. For customers using firmware release 5.60 
and higher, the module can be identified with "Rev D" printed on it and is to be used on all ends of F60 communication for 
two and three terminal applications. Failure to use it at all ends results in intermittent communication alarms. For 
customers using firmware revisions below 5.60, it is not required to match the revision of the modules installed.

The UR-series C37.94 communication module has six switches to set the clock configuration. The following figure shows 
the functions of these control switches.

Figure 3-57: Switches 

For the internal timing mode, the system clock is generated internally. Therefore, set the timing switch selection to internal 
timing for relay 1 and loop timed for relay 2. There must be only one timing source configured.

For the looped timing mode, the system clock is derived from the received line signal. Therefore, set the timing selection to 
loop timing mode for connections to higher order systems.

To remove the IEEE C37.94 communications module cover and set the switches:

1. With power to the relay off, remove the IEEE C37.94 module (type 2G, 2H, 2I, 2J, 76, or 77 module) as follows. Record 
the original location of the module to help ensure that the same or replacement module is inserted into the correct 
slot.

2. Simultaneously pull the ejector/inserter clips located at the top and bottom of each module in order to release the 
module for removal.

3. Remove the module cover screw.
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4. Remove the top cover by sliding it towards the rear and then lift it upwards.

5. Set the timing selection switches (channels 1 and 2) to the required timing modes (see description earlier).

6. Replace the top cover and the cover screw.

7. Re-insert the IEEE C37.94 module. Take care to ensure that the correct module type is inserted into the correct slot 
position. The ejector/inserter clips located at the top and at the bottom of each module must be in the disengaged 
position as the module is inserted smoothly into the slot. Once the clips have cleared the raised edge of the chassis, 
engage the clips simultaneously. When the clips have locked into position, the module is inserted fully.

Figure 3-58: IEEE C37.94 timing selection switch setting 

Modules shipped since January 2012 have status LEDs that indicate the status of the DIP switches, as shown in the 
following figure.
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Figure 3-59: Status LEDs 

The clock configuration LED status is as follows:

• Flashing green — loop timing mode while receiving a valid data packet

• Flashing yellow — internal mode while receiving a valid data packet

• Solid red — (switch to) internal timing mode while not receiving a valid data packet

The link/activity LED status is as follows:

• Flashing green — FPGA is receiving a valid data packet

• Solid yellow — FPGA is receiving a "yellow bit" and remains yellow for each "yellow bit"

• Solid red — FPGA is not receiving a valid packet or the packet received is invalid

3.4.9  C37.94SM interface
The UR-series C37.94SM communication modules (2A and 2B) are designed to interface with modified IEEE C37.94 
compliant digital multiplexers or IEEE C37.94 compliant interface converters that have been converted from 820 nm multi-
mode fiber optics to 1300 nm ELED single-mode fiber optics. The IEEE C37.94 standard defines a point-to-point optical link 
for synchronous data between a multiplexer and a teleprotection device. This data is typically 64 kbps, but the standard 
provides for speeds up to 64n kbps, where n = 1, 2,…, 12. The UR-series C37.94SM communication module is 64 kbps only 
with n fixed at 1. The frame is a valid ITU-recommended G.704 pattern from the standpoint of framing and data rate. The 
frame is 256 bits and is repeated at a frame rate of 8000 Hz, with a resultant bit rate of 2048 kbps.

The specifications for the module are as follows:

• Emulated IEEE standard — Emulates C37.94 for 1  64 kbps optical fiber interface (modules set to n = 1 or 64 kbps)

• Fiber-optic cable type — 9/125 m core diameter optical fiber

• Fiber-optic mode — Single-mode, ELED compatible with HP HFBR-1315T transmitter and HP HFBR-2316T receiver

• Fiber-optic cable length — Up to 11.4 km

• Fiber-optic connector — Type ST

• Wavelength — 1300 ±40 nm

• Connection — As per all fiber-optic connections, a Tx-to-Rx connection is required
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The UR-series C37.94SM communication module can be connected directly to any compliant digital multiplexer that 
supports C37.94SM, as shown. 

It also can be connected directly to any other UR-series relay with a C37.94SM module, as shown. 

In 2008, GE Grid Solutions released revised modules 2A and 2B for C37.94SM communication to enable multi-ended fault 
location functionality with firmware 5.60 release and higher. All modules 2A and 2B shipped since the change support this 
feature and are fully backward compatible with firmware releases below 5.60. For customers using firmware release 5.60 
and higher, the module can be identified with "Rev D" printed on it and is to be used on all ends of F60 communication for 
two and three terminal applications. Failure to use it at all ends results in intermittent communication alarms. For 
customers using firmware revisions below 5.60, it is not required to match the revision of the modules installed.

The UR-series C37.94SM module has six switches that are used to set the clock configuration. The following figure shows 
the functions of these control switches.

Figure 3-60: Switches 

For the internal timing mode, the system clock is generated internally. Therefore, set the timing switch selection to internal 
timing for relay 1 and loop timed for relay 2. There must be only one timing source configured.

For the looped timing mode, the system clock is derived from the received line signal. Therefore, set the timing selection to 
loop timing mode for connections to higher-order systems.

To remove the C37.94SM communications module cover and set the switches:

1. With power to the relay off, remove the C37.94SM module (module 2A or 2B) as follows. Record the original location of 
the module to help ensure that the same or replacement module is inserted into the correct slot.

2. Simultaneously pull the ejector/inserter clips located at the top and at the bottom of each module in order to release 
the module for removal.

3. Remove the module cover screw.

4. Remove the top cover by sliding it towards the rear and then lift it upwards.

5. Set the timing selection switches (channels 1 and 2) to the required timing modes (see description earlier).
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6. Replace the top cover and the cover screw.

7. Re-insert the C37.94SM module. Take care to ensure that the correct module type is inserted into the correct slot 
position. The ejector/inserter clips located at the top and at the bottom of each module must be in the disengaged 
position as the module is inserted smoothly into the slot. Once the clips have cleared the raised edge of the chassis, 
engage the clips simultaneously. When the clips have locked into position, the module is inserted fully.

Figure 3-61: C37.94SM timing selection switch setting 

Modules shipped since January 2012 have status LEDs that indicate the status of the DIP switches, as shown in the 
following figure.
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Figure 3-62: Status LEDs 

The clock configuration LED status is as follows:

• Flashing green — loop timing mode while receiving a valid data packet

• Flashing yellow — internal mode while receiving a valid data packet

• Solid red — (switch to) internal timing mode while not receiving a valid data packet

The link/activity LED status is as follows:

• Flashing green — FPGA is receiving a valid data packet

• Solid yellow — FPGA is receiving a "yellow bit" and remains yellow for each "yellow bit"

• Solid red — FPGA is not receiving a valid packet or the packet received is invalid

3.5  Activate relay
The relay is in the default “Not Programmed” state when it leaves the factory. When powered up successfully, looking at 
the front panel, the "Trouble" LED is on and the "In Service" LED is off. The relay in the “Not Programmed” state blocks 
signaling of any output relay. These conditions remain until the relay is explicitly put into “Programmed” state.

The relay can be activated on the front panel or in the EnerVista software.

To activate the relay using the front panel:

1. Press the MENU key until the SETTINGS header flashes momentarily and the PRODUCT SETUP message displays.

2. Press the MESSAGE right arrow until the SECURITY message displays.

3. Press the MESSAGE down arrow until the INSTALLATION message displays.

4. Press the MESSAGE right arrow until the RELAY SETTINGS: Not Programmed message displays.

RELAY SETTINGS:
Not Programmed

When the relay is powered up, the "Trouble LED" is on, the "In Service" LED is off, and this message 
displays, indicating that the relay is in the "Not Programmed" state and is safeguarding (output 
relays blocked) against the installation of a relay whose settings have not been entered. This 
message remains until the relay is explicitly put into "Programmed" state.
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35. After the RELAY SETTINGS: Not Programmed message displays, press a VALUE key to change the selection to 
"Programmed."

6. Press the ENTER key to save the change.

7. When the "NEW SETTING HAS BEEN STORED" message appears, the relay is in "Programmed" state and the "In Service" 
LED turns on.

To activate the relay using EnerVista software:

1. Navigate to Settings > Product Setup > Installation and change the Relay Settings field to "Programmed."

2. Save the change.

3.6  Install software

3.6.1  EnerVista communication overview
The EnerVista UR Setup software communicates to the relay via the front panel RS232 or USB port or the rear RS485 / 
Ethernet ports.

To communicate via the RS232 port, use a standard straight-through serial cable. Connect the DB-9 male end to the relay 
and the DB-9 or DB-25 female end to the computer COM2 port as described in the CPU Communication Ports section 
earlier in this chapter.

SETTINGS


 SETTINGS
 PRODUCT SETUP   SECURITY

 

  DISPLAY
 PROPERTIES



  INSTALLATION
  RELAY SETTINGS:

Not Programmed

RELAY SETTINGS:
Not Programmed

RELAY SETTINGS:
Programmed

NEW SETTING
HAS BEEN STORED
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Figure 3-63: Relay communication options 

To communicate through the F60 rear RS485 port from a computer RS232 port, the GE Grid Solutions RS232/RS485 
converter box is required. This device (catalog number F485) connects to the computer using a straight-through serial 
cable. A shielded twisted-pair wire (20, 22, or 24 AWG) connects the F485 converter to the F60 rear communications port. 
The converter terminals (+, –, GND) are connected to the F60 communication module (+, –, COM) terminals. See the CPU 
Communication Ports section in chapter 3 for details. The line is terminated with an R-C network (that is, 120 , 1 nF) as 
described in this chapter.

3.6.2  System requirements
The relay front panel or the EnerVista UR Setup software can be used to communicate with the relay. The software 
interface is the preferred method to edit settings and view actual values because the computer monitor can display more 
information.

The system requirements for the EnerVista software are as follows:

• Intel Pentium processor (dual core) or (recommended) Core Duo

• Microsoft Windows 7 with Service Pack 1 (32-bit or 64-bit), Windows 10, Windows Server 2008 Release 2 with Service 
Pack 1 (64-bit), or Windows Server 2012 Release 2 (64-bit), in the required EnerVista language, such as French or 
Japanese

• 1 GB free hard drive space

• 2 GB RAM

• 1280 x 800 display screen
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3.6.3  Install software
After ensuring that the requirements for using EnerVista UR Setup software are met, there are three ways to install the 
software:

• From the DVD

• Download EnerVista Launchpad software from http://www.gegridsolutions.com/multilin and install it

• Download the EnerVista UR Setup software from http://www.gegridsolutions.com/multilin and install it

Install on a computer that has an operating system in the required language, for example a German operating system for 
use with EnerVista software in German.

To install the software from the DVD and using EnerVista Launchpad:

1. Insert the DVD into the DVD drive of your computer.

2. Click the Install Now button and follow the instructions.

3. When installation is complete, start the EnerVista Launchpad application.

4. Click the IED Setup section of the Launch Pad window.

Figure 3-64: Adding a UR device in Launchpad window

5. In the EnerVista Launch Pad window, click the Add Product button and select the appropriate product as follows. 
Select the Web option to ensure the most recent software release, or select CD if you do not have an Internet 
connection, then click the Add Now button to list software items for the product. EnerVista Launchpad obtains the 
software from the Internet or DVD and automatically starts the installation program after prompting about updates.

From the web, the software is downloaded. A wizard opens.

The front panel can be switched in the EnerVista software between enhanced and basic panels under 
Maintenance > Change Front Panel.

http://www.gegridsolutions.com/multilin
http://www.gegridsolutions.com/multilin
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Figure 3-65: Identifying the UR device type

6. In the wizard, click the Next button and complete the process. The files are installed in the directory indicated, and the 
installation program automatically creates icons and adds an entry to the Windows start menu.

The UR device is added to the EnerVista Launchpad window, as shown.

Figure 3-66: UR device added to Launchpad window

7. For other than English, configure the language for the front panel in the EnerVista software under Settings > Product 
Setup > Display Properties. User-entered strings are not translated, for example relay names, so setting the language 
now ensures that the names are entered/displayed in the required language. For the EnerVista software language, 
access the View > Language menu item.

3.7  Add device to software
You connect remotely to the F60 through the rear RS485 or Ethernet port with a computer running the EnerVista UR Setup 
software. The F60 also can be accessed locally with a computer through the front panel RS232 or USB port or the rear 
Ethernet port using the Quick Connect feature.

The following procedures are outlined:

• Add device for serial access; see the Configure Serial Connection section

• Add device for the rear Ethernet port; see the Configure Ethernet Connection section

• Add device for access using a modem; see the Configure Modem Connection section
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• Connect locally with a computer through either the front RS232 or USB port or rear Ethernet port; see the Connect to 
the F60 section

• Discover automatically UR devices within a network; see the Automatic Discovery of UR Devices section

Devices in the Device Setup window are listed in the order entered.

Devices in the main software window are listed alphabetically. Use the Device Name to order them as required, for 
example B30 Odessa, B30 Truro, B90, T35.

You cannot import a file to add a device to the software. You can import settings as outlined at the end of the chapter.

The Quick Connect button also can be used to add devices. The device is added to a Quick Connect menu item in the 
Online Window area, cannot be moved from it to another grouping, and needs to be renamed in the Device Setup window. 
GE instead recommends using the Device Setup window to add devices, as outlined here.

3.7.1  Set IP address in UR
Implement IP addresses for the computer and a F60 device as follows.

The UR family supports the use of subnetworks as documented in RFC 950, which divides class-based networks into 
subnetworks (non-CIDR). The classes and IP address ranges are defined as follows.

Table 3-7: IP address classes

Both network and subnet addresses are contained within a range. The number of hosts determines the class and 
addresses as follows:

• Class A 255.0.0.0 — The first octet (255) specifies the network, the second to fourth octets (0) specify the subnet and 
host. Use this class when you have more than 65,535 hosts (UR devices).

• Class B 255.255.0.0 — The first two octets (255) specify the network, the third octet (0) specifies the subnet, and the 
fourth octet (0) specifies the host. Use this class when you have 255 to 65,534 hosts (UR devices).

• Class C 255.255.255.0 — The first three octets (255) specify the network and the last octet (0) specifies the subnet and 
host. Use this class when you have up to 254 hosts (UR devices).

An example of implementation is one computer and one UR device. Because there is one UR device, class C addressing is 
required. So we use UR 192.167.2.x with subnet mask 255.255.255.0 and computer 192.167.3.x with subnet mask 
255.255.255.0.

For older, non-CIDR routing protocols, such as RIP version 1, follow these restrictions:

• Identical subnet masks — Use a single mask for all subnets within a network

• Contiguous subnets — The subnets must be contiguous and not split among networks. The subnets cannot pass 
traffic through other networks.

The IP and subnet addresses need to be added to the UR for Ethernet communication.

For serial communication, for example using any front RS232 port and the Quick Connect feature, the addresses are not 
required, but typically they are entered to add/configure devices for regular use.

To add the IP addresses:

1. On the front of the UR, press the MENU key until the SETTINGS menu displays.

2. Navigate to SETTINGS  PRODUCT SETUP  COMMUNICATIONS  NETWORK   NETWORK PORT  PRT IP ADDRESS.

3. Enter an IP address, for example 10.11.33.01, and press the ENTER key to save the value. For example, press the period 
key to clear any existing address, then press the number keys to add anew address.

Classes IP address range Default subnet mask address UR devices

A 1.0.0.0 to 127.255.255.255 255.0.0.0 65,535 or more

B 128.0.0.0 to 191.255.255.255 255.255.0.0 255 to 65,534

C 192.0.0.0 to 223.255.255.255 255.255.255.0 0 to 254

D 224.0.0.0 to 239.255.255.255 (Reserved for multicasting)

E 240.0.0.0 to 255.255.255.255 (Reserved)
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4. In the same menu, select the PRT SUBNET IP MASK setting. Enter a subnet IP address, for example 255.000.000.000 for 
255.0.0.0.

5. Press the ENTER key to save a value.

The gateway address also needs to be configured when connecting through an Ethernet network. Access SETTINGS  
PRODUCT SETUP  COMMUNICATIONS  IPv4 ROUTE TABLE  DEFAULT IPv4 ROUTE  GATEWAY ADDRESS.

If using a blue or grey Ethernet cable, skip the rest of the this section. If using an orange cross-over Ethernet cable, the 
computer needs to be set up as follows.

1. Use an orange Ethernet cross-over cable to connect the computer to the rear Ethernet port. In case you need it, the 
following figure shows the pinout for an Ethernet cross-over cable.

Figure 3-67: Ethernet cross-over cable PIN layout 

Next, assign the computer an IP address compatible with the relay’s IP address.

1. From the Windows desktop, right-click the My Network Places icon and select Properties to open the network 
connections window. Or in Windows 7, access the Network and Sharing Center in the Control Panel.

842799A1.CDR

END 1 END 2

Pin Wire color Diagram Pin Wire color Diagram

1 White/orange 1 White/green

2 Orange 2 Green

3 White/green 3 White/orange

4 Blue 4 Blue

5 White/blue 5 White/blue
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8 Brown 8 Brown
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2. Right-click the Local Area Connection icon and select Properties.

3. Select the Internet Protocol (TCP/IP) item from the list, and click the Properties button.

4. Click the “Use the following IP address” box.

5. Enter an IP address with the first three numbers the same as the IP address of the F60 relay and the last number 
different (in this example, 1.1.1.2).

6. Enter a subnet mask equal to the one set in the F60 (in this example, 255.0.0.0).

7. Click the OK button to save the values.
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Before continuing, test the Ethernet connection.

1. Open a Windows console window, for example by selecting Start > Run from the Windows Start menu and typing 
“cmd” or clicking the Start button and entering "cmd".

2. Type the following command, substituting the IP address of 1.1.1.1 with yours:
C:\WINNT>ping 1.1.1.1

3. If the connection is successful, the system returns four replies similar to the following:
Pinging 1.1.1.1 with 32 bytes of data:

Reply from 1.1.1.1: bytes=32 time<10ms TTL=255
Reply from 1.1.1.1: bytes=32 time<10ms TTL=255

Reply from 1.1.1.1: bytes=32 time<10ms TTL=255

Reply from 1.1.1.1: bytes=32 time<10ms TTL=255
Ping statistics for 1.1.1.1:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip time in milliseconds:
Minimum = 0ms, Maximum = 0ms, Average = 0 ms

4. Note that the values for time and TTL vary depending on local network configuration.

5. If the following sequence of messages appears when entering the C:\WINNT>ping 1.1.1.1 command:
Pinging 1.1.1.1 with 32 bytes of data:

Request timed out.

Request timed out.
Request timed out.

Request timed out.

Ping statistics for 1.1.1.1:

Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),
Approximate round trip time in milliseconds:

Minimum = 0ms, Maximum = 0ms, Average = 0 ms

Pinging 1.1.1.1 with 32 bytes of data:

verify the physical connection between the F60 and the computer, and double-check the programmed IP address in 
the PRODUCT SETUP  COMMUNICATIONS  NETWORK  IP ADDRESS setting, then repeat step 2.

6. If the following sequence of messages appears when entering the C:\WINNT>ping 1.1.1.1 command:
Pinging 1.1.1.1 with 32 bytes of data:

Hardware error.

Hardware error.
Hardware error.

Hardware error.

Ping statistics for 1.1.1.1:
Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),

Approximate round trip time in milliseconds:

Minimum = 0ms, Maximum = 0ms, Average = 0 ms
Pinging 1.1.1.1 with 32 bytes of data:

verify the physical connection between the F60 and the computer, and double-check the programmed IP address in 
the PRODUCT SETUP  COMMUNICATIONS  NETWORK  IP ADDRESS setting, then repeat step 2.

7. If the following sequence of messages appears when entering the C:\WINNT>ping 1.1.1.1 command:
Pinging 1.1.1.1 with 32 bytes of data:

Destination host unreachable.
Destination host unreachable.

Destination host unreachable.

Destination host unreachable.
Ping statistics for 1.1.1.1:

Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),

Approximate round trip time in milliseconds:
Minimum = 0ms, Maximum = 0ms, Average = 0 ms

Pinging 1.1.1.1 with 32 bytes of data:

verify the IP address is programmed in the local computer by entering the ipconfig command in the command 
window.

C:\WINNT>ipconfig

Windows IP Configuration
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Ethernet adapter <F4FE223E-5EB6-4BFB-9E34-1BD7BE7F59FF>:
Connection-specific DNS suffix. . :

IP Address. . . . . . . . . . . . : 0.0.0.0

Subnet Mask . . . . . . . . . . . : 0.0.0.0
Default Gateway . . . . . . . . . :

Ethernet adapter Local Area Connection:

Connection-specific DNS suffix  . :
IP Address. . . . . . . . . . . . : 1.1.1.2

Subnet Mask . . . . . . . . . . . : 255.0.0.0

Default Gateway . . . . . . . . . :
C:\WINNT>

Before using the Quick Connect feature through the Ethernet port, disable any configured proxy settings in Internet 
Explorer.

1. Start the Internet Explorer software.

2. Select the Tools > Internet Options menu item and click the Connections tab.

3. Click on the LAN Settings button to open the following window.

4. Ensure that the “Use a proxy server for your LAN” box is not checked.

If this computer is used to connect to the Internet, re-enable any proxy server settings after the computer has been 
disconnected from the F60 relay.

1. Start the Internet Explorer software.

2. Select the UR device from the EnerVista Launchpad to start EnerVista UR Setup.
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3. Click the Quick Connect button to open the window.

4. Select the Ethernet interface and enter the IP address assigned to the F60, then click the Connect button. The 
EnerVista UR Setup software creates a site named “Quick Connect” with a corresponding device also named “Quick 
Connect” and displays them on the left side of the screen.

5. Expand the sections to view data directly from the F60 device.

Each time that the EnerVista UR Setup software is initialized, click the Quick Connect button to establish direct 
communications to the F60. This ensures that configuration of the EnerVista UR Setup software matches the F60 model 
number.

When direct communications with the F60 via Ethernet is complete, make the following changes:

1. From the Windows desktop, right-click the My Network Places icon and select Properties to open the network 
connections window.

2. Right-click the Local Area Connection icon and select the Properties item.

3. Select the Internet Protocol (TCP/IP) item from the list provided and click the Properties button.

4. Set the computer to “Obtain a relay address automatically” as shown.
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If the computer is used to connect to the Internet, re-enable any proxy server settings after the computer has been 
disconnected from the F60 relay.

3.7.2  Configure serial connection
Two options are possible: local connection between computer and front RS232 port, and remote connection using the rear 
RS485 terminals.

To use the RS485 terminals at the back of the relay, a GE Grid Solutions F485 converter (or compatible RS232-to-RS485 
converter) is required. See the F485 instruction manual for details.

1. Connect the computer to the F485 and the F485 to the RS485 terminal on the back of the UR device. Or connect the 
computer to the RS232 port on the front of the relay.

2. Start the EnerVista UR Setup software, or in EnerVista Launchpad select the UR device to start the software.

3. Click the Device Setup button. The window opens.

4. Click the Add Site button. A new category is added. Enter a site name in the Site Name field. Optionally add a short 
Description of the site. This example uses “Location 1” as the site name.

5. Click the Add Device button. A new device is added.

6. Enter a name in the Device Name field, up to 15 characters, and optionally add a Description of the site. The Color is 
for the text in the device list in the Online Window.

7. Select “Serial” from the Interface drop-down list. Interface parameters display that must be entered for serial 
communications. Try to load automatically the fields by clicking the Read Order Code button.

Figure 3-68: Configuring serial communication

8. Enter the COM port used by the computer, the baud rate, and parity settings from the front panel SETTINGS  PRODUCT 
SETUP  COMMUNICATIONS  SERIAL PORTS menu, and the relay slave address setting from the front panel SETTINGS 
 PRODUCT SETUP  COMMUNICATIONS  MODBUS PROTOCOL  MODBUS SLAVE ADDRESS menu in their respective 
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fields.

Baud Rate — Typically 19200 bits per second (bps) for RS232, and higher for RS485. Both modems need to use the 
same rate, meaning at the computer and the F60 ends.

Parity — Set to None if unsure

Bits — Set to 8 if unsure

Stop Bits — Set to 1 if unsure

Post Terminal Window — Enable this option if you have a Schweitzer Engineering (SEL) SEL-203x Communications 
Processor, such as an SEL-2030 or SEL-2032. This option enables display of a terminal window to allow interaction 
with the other device.

9. Click the Read Order Code button to connect to the F60 and upload the order code to the EnerVista software. If a 
communications error occurs, ensure that the EnerVista software serial communications values entered in the 
previous step correspond to the relay setting values, and also ensure that the same IP address is not assigned to 
multiple F60 ports.

10. Click the OK button when the relay order code has been received. The new site and device are added to the Online 
Window.

The device has been configured for serial communications. Proceed to the Connect to the F60 section to begin 
communication.

3.7.3  Configure Ethernet connection
You connect the Ethernet cable, define a site in the software, then add the relay as a device for the site.

The Ethernet cable can be connected from the relay to an Ethernet network or directly to the computer. The computer and 
UR device must be on the same subnet.

1. Connect the Ethernet network cable and any SFP supplied with the F60 to the Ethernet port on the back of the device.

2. Start the EnerVista UR Setup software, or in EnerVista Launchpad select the UR device to start the software.

3. Click the Device Setup button. The window opens.

4. Click the Add Site button. A new category is added. Enter a site name in the Site Name field. Optionally add a short 
Description of the site. This example uses “Location 1” as the site name. 

5. Click the Add Device button. A new device is added.

6. Enter a name in the Device Name field, up to 15 characters, and optionally add a Description of the site. The Color is 
for the text in the device list in the Online Window.

7. Select “Ethernet” from the Interface drop-down list. This displays a number of interface parameters that must be 
entered for Ethernet functionality.
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Figure 3-69: Configuring Ethernet communication

8. Enter the relay IP Address, which can be viewed on the device front panel under SETTINGS  PRODUCT SETUP  
COMMUNICATIONS  NETWORK  NETWORK PORT  PRT IP ADDRESS. Once the IP address is entered, try to load 
automatically the fields by clicking the Read Order Code button.

9. Enter the relay Slave address and Modbus Port address values from the settings in the front panel SETTINGS  
PRODUCT SETUP  COMMUNICATIONS MODBUS PROTOCOL menu.

10. If using a gateway to connect to the device, select Yes from the drop-down list.

11. Click the Read Order Code button to connect to the F60 device and upload the order code. If the device was entered 
already, a message displays "Device ’x’ is also using IP address...." If a communications error occurs, ensure that the 
values entered in the previous steps correspond to the relay setting values, and also ensure that the same IP address 
is not assigned to multiple F60 ports.

12. Click the OK button when the relay order code has been received. The new site and device are added to the Online 
Window.

The device has been configured for Ethernet communications. Proceed to the Connect to the F60 section to begin 
communications.

3.7.4  Configure modem connection
A modem connection allows a computer to communicate with a UR device over phone lines.

Two modems are required. One modem is connected to the UR device, either by connecting the serial cable to the front 
panel port or through a RS485 box to the rear terminals of the UR device. The second modem is connected to the 
computer that initiates the connection.

To add a UR device for modem connections:

1. Connect the modems to the computer and UR.
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2. Start the EnerVista UR Setup software, or in EnerVista Launchpad select the UR device to start the software.

3. Click the Device Setup button. The window opens.

4. Click the Add Site button. A new category is added. Enter a site name in the Site Name field, such as London East. 
Optionally add a short Description of the site, such as the address or intersection.

5. Click the Add Device button. A new device is added.

6. Enter a name in the Device Name field, up to 15 characters, and optionally add a Description of the site. The Color is 
for the text in the device list in the Online Window.

7. Select “Modem” from the Interface drop-down list. This displays a number of interface parameters that must be 
entered.

8. Select "Generic Modem" from the Modem Name drop-down list, then enter the Phone Number to dial to establish 
communication with the remote modem.

Post Terminal Window — Enable this option if you have a Schweitzer Engineering (SEL) SEL-203x Communications 
Processor, such as an SEL-2030 or SEL-2032. It enables display of a terminal window to allow interaction with the 
other device.

9. Once the phone number is entered, try to load automatically the device information by clicking the Read Order Code 
button.

10. Click the OK button when the relay order code has been received. The new device is added to the Online window.

The UR device has been added to the software.

3.7.5  Automatic discovery of UR devices
The EnerVista UR Setup software can find and communicate to all UR-family devices located on an Ethernet network.

Using the Discover button in the Device Setup window, a single click of the mouse triggers the software to detect any URs 
located on the network. This is done by searching a range of IP addresses based on the subnet mask of the computer. 
When a UR device is detected, the EnerVista UR Setup software proceeds to configure all settings and order code options 
in the window. This feature allows the user to identify and interrogate all UR devices at a location.

Examples of address ranges are as follows:

• If the host has an IP address of 3.94.247.10 and its subnet mask is 255.255.252.0, then the host’s subnet is 3.94.244.0, 
and the possible IP addresses in this subnet are 

3.94.244.1 to 254

3.94.245.1 to 254

3.94.246.1 to 254

3.94.247.1 to 254

The discover function scans all those possible IP addresses to detect UR relays.

• If the host has an IP address of 3.94.247.145 and its subnet mask is 255.255.255.128, then the host’s subnet is 
3.94.247.128, and the discover function scans IP addresses of 3.94.247.128 to 3.94.248.254 for UR relays

To automatically add UR devices:

1. In the EnerVista software, click the Device Setup button. The window opens.

2. Click the Discover button. The software searches for UR devices on the computer subnet and adds any found to the 
Online Window area. If a required device is not found, add it manually as outlined earlier.
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Figure 3-70: Discover button to detect UR devices in network

3.8  Connect to the F60
There are four ways to the connect to the device, as follows:

• RS232 or USB port (outlined here)

• RS485 port

• Ethernet port (outlined here)

• LAN

When unable to connect because of an "ACCESS VIOLATION," access Device Setup and refresh the order code for the 
device.

When unable to connect, ensure that the same IP address is not assigned to multiple F60 ports, for example under 
Settings > Product Setup > Communications > Network.

If still unable to connect, try unplugging and replugging the Ethernet connection. If that does not work, try to ping the 
device from the computer, and if unsuccessful, restart the computer.

3.8.1  Connect to the F60 in EnerVista
For information on using the EnerVista software, see the Interfaces chapter.

To access the relay in EnerVista:

1. Open the Settings > Product Setup > Display Properties window as shown. The window opens with a status indicator 
on the lower left of the EnerVista UR Setup window.

When multiple computers are connected to a F60 device, EnerVista settings windows are not updated 
automatically. They are refreshed when re-opened. If a user changes a setting on one computer, the other users 
need to refresh the display by closing and opening the settings window to see the change. To ensure that current 
settings are always viewed, close settings windows when not in use so that they are up-to-date when next 
accessed.
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Figure 3-71: EnerVista window 

2. If the status indicator is red, verify that the Ethernet network cable is properly connected to the Ethernet port on the 
back of the relay and that the relay has been properly set up for communication.

3. If a relay icon appears in place of the status indicator, then a report (such as an oscillography or event record) is open. 
Close the report to re-display the green status indicator.

4. The Display Properties settings can now be viewed, edited, or printed.

3.8.1.1  Quick action hot links
The EnerVista UR Setup software has several quick action buttons to provide instant access to several functions that are 
performed often when using URs. From the online window, users can select the relay to interrogate from a pull-down 
window, then click the button for the action to perform. The following quick action functions are available:

• View the event record

• View the last recorded oscillography record

• View the F60 protection summary

• View all of the F60 metering values

• View the status of all F60 inputs and outputs

• Generate a service report

3.8.2  Use Quick Connect via front RS232 port
This feature applies to the enhanced and basic front panels.

To connect to the UR from a computer using a serial cable:

1. Connect an RS232 serial cable to the computer and the front panel RS232 port. For example, use a USB-to-serial 
RS232 DB9M converter cable when connecting to the USB port on the computer.

2. Start the EnerVista UR Setup software, or in EnerVista Launchpad select the UR device to start the software.

3. Click the Quick Connect button. The window opens.

842743A3.CDR

Communications status indicators:

Green = OK

Red = No communications

UR icon = report is open

Quick action hot links

Expand the site list by double-clicking

or selecting the +/– box.
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Figure 3-72: Quick Connect window to access a device

4. Select the serial Interface and the communications port (COM Port) from the drop-down lists, then click Connect. The 
COM Port is that of the computer.

5. The EnerVista software creates a site named “Quick Connect” with a corresponding device also named “Quick 
Connect” and displays them in the Online Window. Expand the sections to view data directly from the UR device. Use 
the Device Setup button to change the site name.

Each time that the EnerVista UR Setup software is initialized, click the Quick Connect button to establish direct 
communications to the F60. This ensures that configuration of the EnerVista UR Setup software matches the F60 model 
number.

3.8.3  Use Quick Connect via front USB port
This feature applies to the graphical front panel.

To connect to the UR from a computer using a USB cable:

1. Connect the cable to the computer and the front panel USB port (square connector).

2. Start the EnerVista UR Setup software, or in EnerVista Launchpad select the UR device to start the software.

3. Click the Quick Connect button to open the window.

4. Select the USB Interface and the "GE Virtual Serial Port" driver from the drop-down list, then click Connect. If the GE 
driver does not display, it means that the USB cable was connected on Windows 10 when upgrading the UR software. 
You need to re-install the EnerVista software with the USB cable disconnected.

5. The EnerVista software creates a site named “Quick Connect” with a corresponding device also named “Quick 
Connect” and displays them in the Online Window. Expand the sections to view data directly from the UR device. Use 
the Device Setup button to change the site name.

Each time that the EnerVista UR Setup software is initialized, click the Quick Connect button to establish direct 
communications to the F60. This ensures that configuration of the EnerVista UR Setup software matches the F60 model 
number.

3.8.4  Use Quick Connect via a rear Ethernet port
To connect to a UR using an Ethernet cable:

1. In the EnerVista software, click the Quick Connect button. The window opens.



3-74 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

SET UP CYBERSENTRY AND CHANGE DEFAULT PASSWORD CHAPTER 3: INSTALLATION

3

Figure 3-73: Quick Connect window for Ethernet connection

2. Select the Ethernet interface and enter the IP address assigned to the F60, then click the Connect button. The 
EnerVista UR Setup software creates a site named “Quick Connect” with a corresponding device also named "Quick 
Connect" and displays them in the Online Window.

3. Expand the sections to view data directly from the F60 device. Use the Device Setup button to change the site name.

Each time that the EnerVista software is initialized, click the Quick Connect button to establish direct communications to 
the F60. This ensures that configuration of the EnerVista UR Setup software matches the F60 model number.

3.9  Set up CyberSentry and change default password
If and when first using CyberSentry security, use the following procedure for set up.

1. Log in to the relay as Administrator by using the VALUE keys on the front panel or through EnerVista connected serially 
(so that no IP address is required). If logging in through EnerVista choose Device authentication (see figure). Enter the 
default password "ChangeMe1#". Note that the "Lock relay" setting needs to be disabled in the Security > Supervisory 
menu. When this setting is disabled, configuration and firmware upgrade are possible. By default, this setting is 
disabled.

2. Enable the Supervisor role if you have a need for it.

3. Make any required changes in configuration, such as setting a valid IP address for communication over Ethernet.

4. Log out of the Administrator account by choosing None.

Next, device or server authentication can be chosen on the login screen, but the choice is available only in EnerVista. Use 
Device authentication to log in using the five pre-configured roles (Administrator, Supervisor, Engineer, Operator, Observer, 
or Administrator and Supervisor when Device authentication is disabled). When using a serial connection, only Device 
authentication is supported. When Server authentication is required, characteristics for communication with a RADIUS 
server must be configured on the UR. This is possible only through the EnerVista software. The RADIUS server itself also 
must be configured. At the end of this instruction manual, the appendix called RADIUS Server Configuration gives an 
example of how to set up a simple RADIUS server. Once both the RADIUS server and the parameters for connecting the UR 
to the server have been configured, you can choose Server authentication on the login screen of EnerVista.
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Figure 3-74: Login screen for CyberSentry

During the commissioning phase, you have the option to bypass the use of passwords. Do so by enabling the Bypass 
Access setting under Settings > Product Setup > Security > Supervisory. Be sure to disable this bypass setting after 
commissioning the device.

You can change the password for any role either from the front panel or through EnerVista. If using EnerVista, navigate to 
Settings > Product Setup > Security. Change the Local Administrator Password, for example. It is strongly recommended 
that the password for the Administrator be changed from the default. Changing the passwords for the other three roles is 
optional.

3.10  Import settings
The following file types can be imported:

• URS — UR settings file (firmware version7.3x or earlier)

• IID — Instantiated IED capability description file — Actual settings on UR

• CID — Configured IED description file — Settings sent to the UR (may or may not be actual settings). When using IEC 
61850, network settings can also be configured by accepting a CID file that includes them, as long as the IP address of 
at least one port is manually configured in the relay before the CID file is sent and the IP address matches that in the 
file.

The import is done in the Offline Window area.

To import a settings file:

1. In the Offline Window area, right-click the device and select the Add Device from File option. The device is that from 
which you want to import settings.

2. If required, change the Files of type drop-down list.

3. Select the file to import.

To apply the settings to a live device:

1. Drag-and-drop the device entry from the Offline Window area to its entry in the Online Window area.

Individual settings also can be dragged and dropped between Online and Offline Window areas.

The order codes much match.

This is what happens:

• CID — For version 7.30 or later, a new URS file generates and moves into a new device folder, generating SCL files from 
the new URS file. Files in the folder have new time stamps. The CID file retains its time stamp.

• URS — When not IEC 61850 and version is lower than 7.30, the file is added and time stamp is unchanged. When 
clicking in the software on the tree element, a device folder is created, the original file moves into it, and time stamp is 
on the URS file is retained.
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When EIC 61850 and version is 7.30 or later, the file is added and time stamp is unchanged. When clicking in the 
software on the tree element, a device folder is created, the original file moves into it, SCL files are generated there, 
and the "Last modified" time stamp on the URS file changes.

3.11  Connect to D400 gateway
A GE Multilin D400 Substation Gateway can be used to collect data from UR devices in a local area network (LAN). It collects 
metering, status, event, and fault report data from serial or LAN-based intelligent substation devices, and it pre-processes 
the data. The D400 supports up to 16 serial and eight network connections, with multiple devices possible on each serial 
connection. Up to 10 concurrent file transfer sessions are possible, meaning data for up to 10 URs can be transferred at 
the same time and any additional IEDs are queued on a first-come-first-served basis. The D400 can then upload files to a 
demilitarized zone (DMZ) server at the enterprise level.

Setup is as follows. For UR devices with the CyberSentry software option, when there is a need to retrieve periodically the 
logs from the UR securely without a human interface, the following approach can be used. See the D400 manual for 
configuration details to achieve it.

A UR in the substation can authenticate a user either connecting to a RADIUS server or on the device itself. This depends 
on the user name used for authentication on a connection. The D400 connects to the UR device using an Ethernet, USB, or 
serial port on the UR. At the other end, the cable attaches to the rear of D400. Use the D400 software to configure a serial 
or network communication/connection for the UR, then to configure the IED device blocks/clients for the UR, and then to 
configure record retrieval. Once configured, the UR and D400 use a keyfile authentication mechanism to establish 
communication.

For UR devices with the IEC 61850 software option, also use the D400 IEC 61850 Loader software.

When a D400 detects new files available for download from a UR, it connects to the UR and reads the files via sFTP 
protocol. The following files can be transferred:

• Oscillography files

• Event records

• Log files

• Configuration (setting) files

The D400 information is viewable in its software and in a web browser.

3.11.1  Oscillography files
These are stored in COMTRADE format in the D400 folder system using the UR site and device name.

3.11.2  Event records
These are stored as the EVT.TXT file in the D400 folder system using the UR site and device name.

3.11.3  Log files
Log files can be retrieved for UR 7.0 and later. The following file types are possible, stored in the D400 folder system using 
the UR site and device name:

• factory_event.txt — Information about change methods and origins. Saved with a "_YYMMDDhhmmss" retrieval time 
stamp, for example FACTORY_EVENT_170525183124.TXT.

• setting_changes.log — Information on what settings have been changed. Saved with a "_YYMMDDhhmmss" retrieval 
time stamp, for example SETTING_CHANGES_170525183124.TXT.
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3.11.4  Setting files
These are the configuration/settings files in the IEC 61850 SCL/IID format. The ur.iid file is saved with a 
"_YYMMDDhhmmss" retrieval time stamp, for example ur_170525183124.iid. It is stored in the D400 folder system using 
the UR site and device name.
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F60 Feeder Protection System

Chapter 4: Interfaces

Interfaces

This chapter explains the EnerVista software interface, the front panel interface, logic diagrams, and Engineer interface for 
logic design and monitoring.

4.1  EnerVista software interface

4.1.1  Introduction
The EnerVista UR Setup software provides a single facility to configure, monitor, maintain, and troubleshoot relays 
connected over local or wide-area networks. It can be used while disconnected (offline) or connected (online) to a UR 
device. In offline mode, settings files can be created for eventual downloading to the device. In online mode, 
communication with the device is real-time.

The EnerVista UR Setup software is provided with every F60. This chapter outlines the EnerVista software interface. The 
EnerVista UR Setup help file in the software also provides details for getting started and using the software interface.

4.1.2  Settings files
The EnerVista software supports the following three ways of handling changes to relay settings:

• In offline mode (relay disconnected) to create or edit relay settings files for later transfer to relays

• While connected to a relay to modify relay settings, and then save the settings to the relay

• Create/edit settings files and then write them to the relay while connected to the relay

See the back up section in the Maintenance chapter for instructions on how to create a settings file either offline or online.

Settings files are organized on the basis of file names assigned by the user. A settings file contains data pertaining to the 
following types of relay settings:

• Device definition

• Product setup

• System setup

• FlexLogic

• Grouped elements

• Control elements

• Inputs/outputs
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• Remote resources

• Testing

Factory default values are supplied and can be restored after any changes.

The following communications settings are not transferred to the F60 with settings files:
Modbus Slave Address
Modbus TCP Port Number
RS485 COM2 Baud Rate
RS485 COM2 Parity
COM2 Minimum Response Time
COM2 Selection
RRTD Slave Address
RRTD Baud Rate
IP Address (see end of previous chapter for information)
IP Subnet Mask
IP Routing

When a settings file is loaded to a F60 that is in-service, the following sequence occurs:

1. The F60 takes itself out of service.

2. The F60 issues a UNIT NOT PROGRAMMED major self-test error.

3. The F60 closes the critical fail contact.

The Maintenance chapter outlines how to use a settings file in the .urs format for backup and restore.

4.1.3  Event viewing
In online or offline mode, you can view and analyze data generated by triggered parameters as follows:

• Event recorder — The event recorder captures contextual data associated with the last 1024 events, listed 
chronologically from most recent to oldest

• Oscillography — The oscillography waveform traces and digital states are used to provide a visual display of power 
system and relay operation data captured during specific triggered events

Event records are viewable at software and device-specific levels. Access the former under Admin > Event Log > View. 
Access the latter under Actual Values > Records > Event Record.

Event record entries for CyberSentry are explained in the next chapter. The following table outlines some software-level 
entries.

Table 4-1: Event record descriptions

Event Description

EnerVista UR Setup SESSION STARTED The EnerVista software was launched

Language was changed. The user changed the software language using the View > Language menu item

DEFAULT USERS CREATED The user management window was launched using the Admin > User Management menu 
item

: Successful upload of firmware
END
Firmware verified
Firmware uploaded
Firmware erased
START: Upload new firmware

The firmware on a device was upgraded

EnerVista UR Setup EVENT LOG CLEARED The event record was cleared. All event records were deleted using the Admin > Event Log > 
Clear menu item.
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4.1.4  File support
The following support applies, where the Settings List is at the bottom left and the Site List is at the top left of the EnerVista 
window:

• Execution — Any EnerVista UR Setup file that is opened launches the application or provides focus to the already 
opened application. If the file was a settings file (has a .urs extension) that had been removed from the Settings List 
navigation menu, it is added back to the menu.

• Drag and Drop — The device settings and individual settings can be dragged and dropped between the Online and 
Offline Window areas. Also, any Windows Explorer directory folder is a file drag source and drop target.

New files that are dropped into the Offline Window are added to the tree, which is automatically sorted alphabetically 
with respect to settings file names. In the Online Window, files or individual menu items that are dropped in the 
selected device menu are sent automatically to the online device.

4.1.5  EnerVista main window
The EnerVista UR Setup software window has the following components:

1. Title bar that shows the pathname of the active data view or the name of the software

2. Main window menu bar

3. Main window toolbar

4. Site list / online window area

5. Settings list / offline window area

6. Software windows, with common toolbar

7. Settings file data view windows, with common toolbar

8. Workspace area with data view tabs

9. Status bar

10. Quick action hot links
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Figure 4-1: EnerVista UR Setup software window 

4.1.6  Protection summary window
The Protection Summary is a graphical user interface to manage elements, such as enabling and disabling them. Access it 
under Settings > Protection Summary. See the Settings chapter for information on use.
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Figure 4-2: Protection Summary interface (B30 example shown)

4.1.7  Settings templates
Settings file templates simplify the configuration and commissioning of multiple relays that protect similar assets. An 
example is a substation that has 10 similar feeders protected by 10 UR F60 relays.

In these situations, typically 90% or greater of the settings are identical among devices. The templates allow engineers to 
configure and test these common settings, then lock them so that they are not available to users. For example, locked 
settings can be hidden from view for field engineers, allowing them to quickly identify and concentrate on specific settings.

The remaining settings (typically 10% or less) can be specified as editable and made available to field engineers installing 
the devices. These are settings such as protection element pickup values and CT and VT ratios.

The settings template mode allows the user to define which settings are visible in the software. Settings templates can be 
applied to both settings files (settings file templates) and online devices (online settings templates). The functionality is 
identical for both purposes.

Settings file conversion from previous firmware versions is supported.

4.1.7.1  Enable the settings template
The settings file template feature is disabled by default. It can be enabled in offline or online mode.

To enable in offline mode the settings template for UR settings files:

1. Locate the settings file in the Offline Window area of the EnerVista UR Setup software. If not there, a file can be added 
from an online device by right-clicking it and selecting the Add Device to Offline Window option.

2. In the Offline Window area, right-click the selected device or settings file and select the Template Mode > Create 
Template option.

The settings file template is now enabled and the file menus display in light blue. The settings file is now in template 
editing mode. To undo the action, select Template Mode > Remove Template.

Template mode is available in the English software only.
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Alternatively, to apply the settings template to online settings:

1. Locate the device in the Online Window area of the EnerVista UR Setup software.

2. Right-click the device and select the Template Mode > Create Template option. The software prompts for a template 
password. This password is required to use the template feature and must be at least four characters in length.

Figure 4-3: Entering a settings file password

3. Enter and re-enter the new password, then click OK to continue.

The online settings template is now enabled. The device is now in template editing mode.

4.1.7.2  Edit the settings template
The settings template editing feature allows the user to specify which settings are available for viewing and modification in 
EnerVista UR Setup. By default, all settings except the FlexLogic equation editor settings are locked.

1. With the template already enabled, locate the device or settings file in the Online or Offline Window area in the 
software.

2. Right-click the device or file and select the Template Mode > Edit Template option to verify or place the device in 
template editing mode (check mark beside option). If prompted, enter the template password then click OK.

3. Open the relevant settings window that contains settings to be specified as viewable.

By default, all settings are specified as locked and displayed against a grey background. The icon on the upper right of 
the settings window indicates that the EnerVista software is in EDIT mode. The following example shows the phase 
time overcurrent settings window in edit mode.

Figure 4-4: Settings template with all settings specified as locked

4. Specify the settings to make viewable by clicking them.

A setting available to view displays with a yellow background.
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Figure 4-5: Settings template with two settings specified as editable

5. Click the Save button to save changes to the settings template.

6. Continue through any other settings window to specify all viewable settings.

The next time that the device/settings are accessed, only those specified as viewable/editable display in the menu 
hierarchy.

4.1.7.3  Add password protection to a template
GE recommends that templates be saved with password protection to maximize security.

To add password protection to a settings file template:

1. In the Offline Window area, right-click the device and select the Template Mode > Password Protect Template 
option.

The software prompts for a template password. This password must be at least four characters in length.

2. Enter and re-enter the new password, then click OK to continue.

The settings file template is now secured with password protection.

4.1.7.4  View the settings template
Once all necessary settings are specified for viewing, users are able to view the settings template on the online device or 
settings file. There are two ways to specify the settings view with the settings template feature:

• Display only those settings available for editing

• Display all settings, with settings not available for editing greyed-out

To display settings available for editing:

1. Right-click the device in the Online or Offline Window area and apply the template by selecting the Template Mode > 

When templates are created for online settings, the password is added during the initial template creation step. It 
does not need to be added after the template is created.
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View In Template Mode option.

2. Enter the template password if prompted, then click OK to apply the template.

Once the template has been applied, users are limited to view and edit the settings specified by the template. The effect of 
applying the template to the phase time overcurrent settings is shown.

Figure 4-6: Applying templates using the View in Template Mode command 

Viewing the settings in template mode also modifies the settings menu, showing only the settings categories that contain 
editable settings. The effect of applying the template to a typical settings menu is shown as follows.

Figure 4-7: Applying templates using the View in Template Mode settings command

To display settings available for editing and settings locked by the template:

1. Right-click the device in the Online or Offline Window area and apply the template by selecting the Template Mode > 
View All Settings option.

2. Enter the template password then click OK to apply the template.

Once the template has been applied, users are limited to edit the settings specified by the template, but all settings are 
shown. The effect of applying the template to the phase time overcurrent settings is shown as follows.

Phase time overcurrent settings window without template applied.

Phase time overcurrent window with template applied via

the command.

The template specifies that only the and

settings be available.

Template Mode > View In Template Mode

Pickup Curve

842858A1.CDR
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Figure 4-8: Applying templates using the View All Settings command 

4.1.7.5  Remove the settings template
Once a settings template is removed, it cannot be reapplied and a new settings template needs to be defined before use.

1. Right-click the device in the Online or Offline Window area and select the Template Mode > Remove Template option.

2. Enter the template password if prompted and click OK to continue.

3. Confirm that you want to remove the template by clicking Yes.

The EnerVista software removes all template information and all settings are available.

4.1.8  Secure and lock FlexLogic equations
The UR allows users to secure some or all FlexLogic equations, preventing unauthorized viewing or modification of critical 
FlexLogic applications. This is accomplished using the settings template feature to lock individual entries within FlexLogic 
equations.

Secured FlexLogic equations remain secure when files are sent to and retrieved from any UR-series device.

Locking can be tied to the serial number too.

4.1.8.1  Lock FlexLogic equations
To lock individual entries of a FlexLogic equation:

1. Right-click the settings file or online device and select the Template Mode > Create Template item to enable the 
settings template feature.

2. If prompted, enter the template password.

3. Select the FlexLogic > FlexLogic Equation Editor settings menu item.

By default, all FlexLogic entries are specified as viewable and display against a yellow background. The icon on the 
upper right of the window also indicates that EnerVista UR Setup is in EDIT mode.

4. Specify the entries to lock by clicking them.

The locked entries display a grey background as shown in the example.

Phase time overcurrent settings window without template applied. Phase time overcurrent window with template applied via

the command.

The template specifies that only the and

settings be available.

Template Mode > View All Settings

Pickup Curve

842859A1.CDR
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Figure 4-9: Locking FlexLogic equation entries in Edit Mode

5. Click the Save button to save and apply changes to the settings template.

6. Select the Template Mode > View In Template Mode option to view the template.

7. Optionally apply a password to the template by right-clicking the device and selecting the Template Mode > 
Password Protect Template option.

Once the template has been applied, users are limited to view and edit the FlexLogic entries not locked by the template. 
The effect of applying the template to the FlexLogic entries is shown here.

Figure 4-10: Locking FlexLogic entries through settings templates 

The FlexLogic entries are also shown as locked in the graphical view and on the front panel display.

Typical FlexLogic™ entries without template applied. Typical locked with template via

the command.Template Mode > View In Template Mode

FlexLogic™ entries

842861A1.CDR
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Figure 4-11: Secured FlexLogic in graphical view

4.1.8.2  Lock FlexLogic equations to the serial number
A settings file and associated FlexLogic equations also can be locked to a UR serial number. Once FlexLogic entries in a 
settings file have been secured, use the following procedure to lock the settings file to a serial number. A serial number is 
viewable under Actual Values > Product Info > Model Information, the inside front panel, and the rear of the device.

1. Right-click the setting file in the Offline Window area and select the Edit Device Properties item. The window opens.
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Figure 4-12: Settings file properties window

2. Enter the serial number of the F60 device to lock to the settings file in the Serial # Lock field.

3. Click the OK button to apply the change. The serial number is not validated.

The settings file and corresponding secure FlexLogic equations are now locked to the F60 device specified by the serial 
number.

4.1.9  Settings file traceability
A traceability feature for settings files allows the user to quickly determine if the settings in a F60 device have been 
changed since the time of installation from a settings file. When a settings file is transferred to a F60 device, the date, time, 
and serial number of the F60 are sent back to EnerVista UR Setup and added to the settings file on the local computer. This 
information can be compared with the F60 actual values at any later date to determine if security has been compromised.

The traceability information is only included in the settings file if a complete settings file is either transferred to the F60 
device or obtained from the F60 device. Any partial settings transfers by way of drag and drop do not add the traceability 
information to the settings file.
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Figure 4-13: Settings file traceability 

With respect to the figure, the traceability feature is used as follows.

• The transfer date of a settings file written to a F60 is logged in the relay and can be viewed in the EnerVista software 
or the front panel display. Likewise, the transfer date of a settings file saved to a local computer is logged in the 
EnerVista software.

• Comparing the dates stored in the relay and on the settings file at any time in the future indicates if any changes have 
been made to the relay configuration since the settings file was saved.

4.1.9.1  Settings file traceability information
The serial number and file transfer date are saved in the settings files when they are sent to a F60 device.

The F60 serial number and file transfer date are included in the settings file device definition within the EnerVista UR Setup 
offline window as shown in the example.

Figure 4-14: Device definition showing traceability data 

This information is also available in printed settings file reports as shown in the example. A report is generated by right-
clicking and selecting the Print Settings option.

Traceability data in settings

file device definition

842863A1.CDR
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Figure 4-15: Settings file report showing traceability data 

4.1.9.2  Online device traceability information
The F60 serial number and file transfer date are available for an online device through the actual values. Select the Actual 
Values > Product Info > Model Information menu item within the EnerVista online window as shown in the example.

Figure 4-16: Traceability data in Actual Values window

This information is also available from the front panel display through the following actual values:
ACTUAL VALUES  PRODUCT INFO  MODEL INFORMATION  SERIAL NUMBER

ACTUAL VALUES  PRODUCT INFO  MODEL INFORMATION  LAST SETTING CHANGE

4.1.9.3  Additional traceability rules
The following additional rules apply for the traceability feature:

• If the user changes any settings within the settings file in the offline window, then the traceability information is 
removed from the settings file

• If the user creates a new settings file, then no traceability information is included in the settings file

• If the user converts an existing settings file to another revision, then any existing traceability information is removed 
from the settings file

• If the user duplicates an existing settings file, then any traceability information is transferred to the duplicate settings 
file

Traceability data

in settings report

842862A1.CDR
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4.2  Front panel interface
This section explains use of the enhanced, basic, and graphical front panels.

4.2.1  Front panel

4.2.1.1  Enhanced front panel
The enhanced front panel consists of LED panels, an RS232 port, keypad, LCD display, control pushbuttons, and optional 
user-programmable pushbuttons.

The front panel is hinged to allow access to removable modules inside the chassis. The F60 enhanced front panel can be 
horizontal or vertical. The following figure shows the horizontal front panel.

Figure 4-17: Enhanced horizontal front panel 

4.2.1.2  Basic front panel
The basic front panel consists of LED panels, an RS232 port, keypad, LCD display, control pushbuttons, and optional user-
programmable pushbuttons.

The front panel is hinged to allow easy access to removable modules inside the chassis. There is also a removable dust 
cover that is to be removed when accessing the keypad. The F60 basic front panel can be horizontal or vertical. The 
following figure shows the horizontal front panel.
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Figure 4-18: Basic horizontal front panel 

The following figure shows the vertical front panel for relays ordered with the vertical option.

Figure 4-19: Basic vertical front panel 
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4.2.1.3  Graphical front panel
The graphical front panel consists of a USB port, LED panel, color screen display, user-programmable pushbuttons, and 
navigation keys. The screen is used to read data, such as metering actual values, alarms, self-test messages, and event 
records, and for viewing single-line diagrams. Settings can be changed on the front panel, except for the graphical front 
panel itself and for IEC 61850. The USB port connects to a computer with the EnerVista software and can be used to 
upgrade the relay and to transfer files and settings. The USB port is the square type B.

User-programmable pushbuttons 9 to 16 can be programmed among the 10 pushbuttons on the left and right sides of the 
display.

Figure 4-20: Graphical front panel 

4.2.2  Front panel display

4.2.2.1  Enhanced and basic front panels
Messages display on a backlit liquid crystal display (LCD) to make them visible under poor lighting conditions. When the 
keypad and display are not actively being used, the display defaults to user-defined messages. Any high-priority event-
driven message overrides the default messages.

Up to 20 characters can be used to configure some setting names in the software, while up to 12 characters display on the 
front panel. A tilde ~ symbol is used for the twelfth character on the front panel when a name extends beyond the 12 
character limit. An example is shown for a Virtual Input.

Figure 4-21: Tilde symbols displays with names 12 or more characters long

The front panel can be viewed and used in the EnerVista software, for example to view an error message displayed on the 
front panel or the LEDs.

To view the front panel in EnerVista software:

1. Click Actual Values > Front Panel, then any option.
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Figure 4-22: Front panel use in the software (C60 shown)

4.2.2.2  Graphical front panel
The graphical front panel has a seven-inch (17.8 cm) color liquid crystal display (LCD). The display provides convenient 
access to operational data generated by the relay, enables local control of power system devices, and allows display/
editing of settings.

Header content varies by page. The home page displays any active icons, such as security status, active setting group, and 
active target messages. It shows the date and time of the relay. If the relay synchronizes to an external time source via PTP, 
IRIG-B, SNTP, and so on, the date/time is shown in white, and otherwise in yellow. On pages other than the home page, the 
header displays the name of the page.

The footer dynamically labels the Tab, or control, pushbuttons immediately below.

Page content displays between the header and footer.
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Figure 4-23: Home page example with default content (product information) 

There are multiple ways to navigate pages, by using the pushbuttons and the menu hierarchy. The menu hierarchy is 
similar to the other front panels whereby you select a submenu using Up and Down arrow pushbuttons, and press the 
ENTER or Right pushbutton. On setting pages, opening a setting for editing is done by highlighting the setting using Up and 
Down pushbuttons, and pressing the ENTER or Right pushbutton.

Home page
Press the Home pushbutton to display the root page no matter the state. Any edit, control, or password entry sessions are 
cancelled. The header shows several relay/system status icons. The default content of the home page is the product 
information page and can be user-configured to show the content of any single-line diagram page, annunciator page, 
metering page, or event records page for example. The Tab pushbuttons on the bottom row each navigate to their page. 
The home page displays for a user-configured time period, then scrolls through user-configured pages, a feature referred 
to as rolling.

Holding the Home pushbutton for one second displays the product information page. The Home page also can display 
when settings are saved.

Configure the home page in the software under Settings > Product Setup > Graphical Panel > Home Page. The menu 
does not display when there is no graphical front panel.

Security indicator, showing how many people are logged in, including local and remote users. The lock is red when 
one or more users are logged in and other otherwise green.
When no users are logged in because login is not required, an icon does not display.

Identifies the active setting group number (not shown)

Displays when an abnormal annunciator alarm is present. Navigate to the Annunciator for details. When there 
are no such alarms, the icon does not display.
Even when you acknowledge/reset an alarm, the icon displays as long as the condition remains. For example, a 
breaker trouble alarm displays, you acknowledge it, but the icon remains because the breaker trouble remains.

Active targets symbol, where targets are error messages.
View error messages by pressing the Menu Tab pushbutton, then accessing the TARGETS menu. Pressing the 
RESET button clears those messages that can be.
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Rolling mode
After a user-defined period of inactivity, the graphical front display rolls among up to 10 user-selected pages. The roll-to-
pages are selected in the EnerVista software, with the defaults being the product information page. Each page displays for 
less than five seconds. Also, the display backlight intensity is lowered after a configurable period to a user-defined level (0, 
10, 20, or 30%); lower intensity extends the life of the display.

Configure rolling mode in the software under Settings > Product Setup > Graphical Panel > Rolling Mode.

Operation works as follows:

• Press the Home pushbutton or ESCAPE pushbutton twice to cancel rolling, restore full backlight intensity, and return 
to the Home page

• Press the ENTER, ESCAPE, or a pushbutton to pause rolling once and restore full backlight intensity

Rolling is disabled by setting the delay to 0.

The following buttons display at the top of the window:

• Save — Updates the connected device if online or the open setting file if offline with changes made

• Restore — Undoes changes that have not been saved

• Default — Changes all rolling mode settings to their factory default values

• Reset — Displays factory default values. Previous changes are not lost unless you save the reset window.

Single-line diagrams
A single-line diagram, or mimic diagram, is a line drawing of elements in an electrical system. The graphical front panel 
displays up to five single-line diagrams. Each can be configured to show the arrangement of a portion of the power 
system, the status of circuit breakers and of ground and disconnect switches, user-programmable pushbuttons, and 
metering and status values. Each also enables control of the displayed power system devices.

One diagram is provided by default, single_bus_line_dsc.mif, which can be modified.

Configure the diagrams under Settings > Product Setup > Graphical Panel > Single Line Diagram Editor.

Each single-line diagram page has a user-configurable name that appears in the header and in the footer Tab pushbutton 
label. Factory default names are SLD 1 to SLD 5. Pages that have no configured content have a blank Tab pushbutton 
label, and the Tab pushbutton does nothing. The label for the current page has a blue background.

Figure 4-24: Toolbar options for single-line diagram 
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The letters T, S, B, R, and X next to a controllable element have the following meaning. An example (TSB) is shown in the 
next figure.

• T — The element is "tagged." Local and remote control of the device are inhibited, both open and close. Tripping is 
unaffected unless additional logic has been configured.

• S — The position indication of the device is substituted with a manually entered value

• B — Blocking open/close command is bypassed

• R — Autoreclose is enabled and not blocked

• X — The device is out-of-service and control is not available

Single-line diagram example
The following example outlines how to create a circuit breaker diagram, then how to close the second circuit breaker. The 
figure shows six switches (SW, M), two breakers (CB), feeder (arrow), and ground (lined arrow).

Figure 4-25: Single-line diagram of open circuit breakers

Under Settings > System Setup > Switches and Breakers, enable and name the six switches and two breakers. Switch 6, 
M568G, has the A/3 Pole Opened setting on.
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Figure 4-26: Configure Breaker and Switch settings

In the EnerVista software, open the single-line diagram editor under Settings > Product Setup > Graphical Panel > Single 
Line Diagram Editor.

Add the four switches for the top line by clicking the GE switch symbol in the toolbar, then clicking in the window. (If the UR 
device is not online, the software attempts to connect.) Right-click to edit properties. Rotate switches SW569 and SW5682 
to 270 degrees. Rotate switches 5681 and SW523 to 90 degrees. Ignore the TSB text.

Add the two lower switches. Leave rotation at 0 degrees.

Add the two breakers by clicking the GE breaker symbol in the toolbar, then click in the window. Right-click to edit 
properties, rotating 90 degrees and setting the color to red (open).

Draw lines to fill in the gaps between the switches and breakers by clicking the line symbol in the toolbar, then clicking and 
dragging on the canvas to draw a line. Do not draw a single line for the top line, but instead draw several small lines.

Add the feeder arrow head by clicking the symbol in the toolbar, then clicking the end of the line.

Add the ground symbol by clicking the symbol in the toolbar, then clicking the end of the line.

Add three metered values by clicking the M symbol in the toolbar, then clicking near the feeder arrow. Double-click to edit. 
The three metered values are SRC1 Vag Mag, SRC 1 P, and SRC 1 Q.

Name the page by right-clicking the bottom tab. Here, page 1 is renamed "Milton line M568M."

Note that active symbols in the toolbar display and those that are inactive are greyed-out.

The diagram has been created. Save it by clicking the Save button.

Next is to close circuit breaker CB523. This circuit breaker is shown at the top right of the figure. A vertical line means that 
it is open, and the color can be set as red or green.

On the graphical front panel, press the Home pushbutton, then press the SLDs pushbutton to activate the first single-line 
diagram page.
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Figure 4-27: Single-line diagram on graphical front panel

Press the Enable Control pushbutton. The side pushbutton labels display.

Figure 4-28: Side pushbutton display on graphical front panel

Press the CB523 breaker pushbutton. Its menu displays.
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Figure 4-29: Pushbuttons to control the breaker

Press the pushbutton to close the breaker, confirming the action at the prompt.

In this diagram, the two circuit breakers have hard-coded actions available to them. No action is possible on the switches.

Note the USER PB 9 and 10 entries in the earlier figure. As outlined later, these are activated by clicking the PB icon on the 
software toolbar. These two pushbuttons can be configured under Settings > Product Setup > User-Programmable 
Pushbuttons.

Single-line diagram editor use
Start the application in the EnerVista software under Settings > Product Setup > Graphical Panel > Single Line Diagram 
Editor.

The following buttons display at the top of the window:

• Save — Updates the connected device if online or the open setting file if offline with changes made

• Restore — Undoes changes that have not been saved

• Load — Opens single-line diagram files, which replaces one or all five windows with that in the file selected

• Store — Saves all five single-line diagrams as a .mif file. Because single-line diagrams are not retained when using the 
Convert Device Settings function, for example when converting in the Offline Window area from version 7.6 to 7.7, GE 
recommends making backup files using this function.

On the right side of the window is a toolbox containing the components that can be added to the window. These include 
line, breaker, disconnect, metering value, status value, text, and miscellaneous power system elements. To create the 
single-line diagram, click the symbol, then click in the window. Once in the window, the component can be positioned and 
its properties modified. When using the pointing device to position a component, the component can snap to the nearest 
snap point. Snap points are in a 4 x 4 rectangular grid. The keyboard arrow keys move the selected component(s) in one 
pixel increments when snap locations are inadequate. Multiple components can be selected and moved or deleted as a 
group, or copied and pasted to another location. Right- or double-clicking a component opens the properties window.

Ctrl+A selects all objects in a diagram.

Lines

Line components represent power system buses or electrical connections between power system elements. They can also 
be used as visual dividers and underline.

To add a line component, click it in the toolbox, then click in the window. Double-click a line to open its properties window 
to set orientation.
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Figure 4-30: Line and bus crossover symbols

Static symbols

Static symbols depicting power system elements are available. For information, see the ANSI/IEEE 315A and IEC 60617 
standards.

Up to 32 static symbols can be used per single-line diagram.

To add a symbol, click it in the toolbox, then click in the window. Double-click the symbol to open its properties window to 
set orientation.

Figure 4-31: IEEE and IEC static symbols

Breaker and disconnect components

Breaker components and disconnect components are interfaces to the UR breaker control elements and disconnect 
switch elements. On a UR device they show dynamically the breaker or disconnect status as calculated by the element, 
and provide means to open, close, tag, bypass interlock, and substitute (force status of) the element. Breaker components 
in addition provide means to enable/disable breaker autoreclose.

Each breaker and disconnect component can be configured to use UR-style symbols, IEC symbols, or simple square/slash 
symbols as shown in the following figure. The symbols assume horizontal symbol orientation, red - closed color, and green 
- open scheme. With vertical orientation, they are rotated 90 degrees.
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Figure 4-32: Single-line diagram symbols

To add a breaker or disconnect component, click it in the toolbox, then click in the window. Up to 10 dynamic components 
can be added to each single-line diagram.

Breaker and disconnect components have three different parts: label, symbol, and flags. Drag each of its parts to their final 
locations. Double or right-click any of these parts to open the properties window. Properties that can be edited are label 
text, breaker control element or disconnect switch element number, symbol orientation (horizontal or vertical), color 
scheme (red - closed, or red - open), and assigned side button (if any). If the selected breaker or disconnect element does 
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not exist in the target relay or has not been enabled, then the component is displayed in the graphical front panel and in 
the drawing edit window in grey. The color scheme selection has no effect when an IEC style symbol is used because IEC 
style symbols do not use color.

Symbol orientation

The figure shows the orientation available for the breaker and disconnect switch (taking Open status as examples). The 
default position is 0 degrees.

Figure 4-33: Single-line diagram symbol orientation

A question mark displays in a symbol on the graphical front panel when status is bad. The question mark does not rotate 
with orientation.

Figure 4-34: Symbols when status is bad

The following figures show the orientation available for the static components. The default position is 0 degrees.
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Figure 4-35: Single-line diagram static symbol orientation (sheet 1 of 2)
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Figure 4-36: Single-line diagram static symbol orientation (sheet 2 of 2)

User-programmable pushbuttons

User-programmable pushbuttons 1 to 8 are physical pushbuttons on the right side of the graphical front panel, numbering 
down the two columns.

User-programmable pushbuttons 9 to 16 can be programmed among the 10 pushbuttons on the left and right sides of the 
screen display. They show dynamically and provide a means to perform the same control as the other pushbuttons.
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Figure 4-37: Assigning pushbuttons 9 to 16 to the display

As an example, if you set up a single-line diagram with two breakers and six switches, then eight of the side pushbuttons 
are used automatically for control of the breakers and switches. Side pushbuttons 9 and 10 are available. In the single-line 
diagram, let us set side pushbutton 9 to clear event records as follows:

• Show side pushbutton 9 on the graphical front panel — Click the PB symbol in the toolbar, then set Side button 9 to 
pushbutton 9 in the drop-down list. This pushbutton then displays when appropriate on the right side of the screen 
display.

• Program event record clearing — Set Settings > Product Setup > Clear Relay Records > Clear Event Records to 
FlexLogic operand PUSHBUTTON 9 ON 

• Program pushbutton 9 — Set Settings > Product Setup > User-Programmable Pushbuttons > Pushbutton 9 
Function to "Self-reset." When pressed, pushbutton 9 clears the event records.

To instead set the second user pushbutton (not a side pushbutton) to clear events, follow the second and third bullet 
points, selecting settings of PUSHBUTTON 2 ON and Pushbutton 2.

Metering components

Metering components show dynamically the value of a FlexAnalog operand or actual value. Up to 16 metering 
components can be added to each single-line diagram.

To add a metering component, click the M symbol in the toolbox, then click in the window. Drag it to its final location. 
Double-click it to open the properties window. The figure shows the properties that can be edited.
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Figure 4-38: Metering properties

Status components

Status components show dynamically the value of a FlexLogic operand. Up to 16 can be used in a diagram and 30 in all 
single-line diagrams.

An example is to show the Off or On state of the ANY MAJOR ERROR FlexLogic operand. The name of the operand displays in 
the single-line diagram editor, then as Off or On on the graphical front panel.

To add a status component, click the S symbol in the toolbox, then click in the window. Drag it to its final location. Double-
click it to open the properties window. Properties that can be edited include parameter (any FlexLogic operand), text color 
background color, and on and off text.

Optionally add a text label to display beside the status.

Text

Text components show a single line of user-configured text.

Up to 16 text components can be used per single-line diagram.

To add a text component, click the T symbol in the toolbox, then click in the window. Drag it to its final location. Double-
click it to open the properties window. Properties that can be edited are text, color, and size.

Annunciator
An annunciator is a grid of small windows for alarms, actual values, self-test messages, and product information.

The graphical front panel emulates a conventional annunciator panel. The annunciator has 96 windows, each with a 
description of the alarm condition that lights the window. The windows are arranged in rows and columns of 3 x 4, 4 x 6, or 
6 x 8 over several pages. Each window can have up to three lines of configurable text, and one line can instead be a 
metered value. Normally the window background is dark, and when the configured FlexLogic operand becomes On, the 
window lights up.

The figure shows that two alarms are active. One alarm is configured red and the other alarm is configured blue. The red 
alarm type is Self Reset, so the alarm displays in a solid color. The blue alarm type is Acknowledgeable, so the alarm flashes 
until it is acknowledged, for example by navigating with the arrow keys and pressing the ENTER button. The alarm then 
remains blue until the trigger condition is eliminated.
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Figure 4-39: 3x4 annunciator page with two active windows

To display the annunciator, press the Home pushbutton, then the Annunciator Tab pushbutton. If there is one or more 
window in alarm or requiring reset, the annunciator page showing the first of these opens. Otherwise the first annunciator 
page opens.

Alarms do not display automatically. Set the Home page and/or rolling pages to display annunciator pages.

The Tab pushbutton labels populate with the annunciator pages. The label text for each annunciator page is configurable 
and displays in the header and Tab label. The current page has a blue Tab label. Tab labels for annunciator pages that 
have an active window (that is, on, latched, or unacknowledged) are red. Pages where alarms are not triggered have a grey 
Tab label. Pages that have no configured windows do not have Tab pushbuttons and do not display.

The Up, Down, Left, and Right pushbuttons cause the selection to move one window in the indicated direction. Pressing the 
Right pushbutton past the last window in a row scrolls the display to any next annunciator page, not the next row. The 
behavior is similar for the other pushbuttons, for example pressing the Up pushbutton while in the top row goes to any 
previous page. If no previous page exists, no action occurs.

Annunciator windows are positioned statically, so that all windows are visible no matter their state.

Alarm types of each window can be configured as Self Reset, Latched, or Acknowledgeable. In Self Reset mode, the 
window lighting follows the state of the configured FlexLogic operand. The self-reset mode alarm sequence conforms to 
ISA-18.1-1979 (R2004) standard type A 4 5 6.

Figure 4-40: Annunciator alarm sequence in Self Reset mode 
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Latched mode is intended for transient signals such as trip, and it conforms to ISA-18.1-1979 (R2004) standard type M 6.

Figure 4-41: Annunciator alarm sequence in Latched mode 

In Acknowledgeable mode, both Off to On and On to Off state changes in the configured operand cause the background to 
flash; the window must be acknowledged/reset to cancel flashing. This mode conforms to ISA-18.1-1979 (R2004) standard 
type R-6.

Figure 4-42: Annunciator alarm sequence in Acknowledgeable mode 

To reset all annunciator windows:

1. In the software, access Actual Values > Graphical Panel > Annunciator Panel.

To acknowledge/reset all annunciator windows on a page:

1. On the graphical front panel with none of the annunciator windows selected, press the RESET pushbutton once for 
acknowledgement and twice for reset. The flashing stops.

To acknowledge an annunciator window:

1. On the graphical front panel, press the Up, Down, Left, and Right pushbuttons to select the window, so that is has a 
yellow outline. Press the RESET or ENTER pushbutton. While a window is selected, if that window has activated since 
the last restart, the date/time of the last activation of that window displays in the header.

Process: Abnormal or Normal
Sequence: Alarm
Visual: Fast Flash

Process: Normal
Sequence: Normal
Visual: Off

Process: Abnormal
Sequence: Acknowledged
Visual: On

Reset while 
Normal

To Abnormal

Reset while 
Abnormal

Re
tu

rn
 to

 N
or

m
al

859857A1.vsd

Process: Normal
Sequence: Ringback
Visual: Slow Flash

Process: Abnormal or Normal
Sequence: Alarm
Visual: Fast Flash

Process: Normal
Sequence: Normal
Visual: Off

Process: Abnormal
Sequence: Acknowledged
Visual: On

Reset while Normal

To Abnormal

Reset while 
Abnormal

Return to Abnormal

Reset

Return to Normal

859858A1.vsd



4-34 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

FRONT PANEL INTERFACE CHAPTER 4: INTERFACES

4

An alarm remains in an alarm state (for example, displays red) when the condition remains. That is, if you acknowledged a 
flashing alarm but the alarm condition remains, the background color remains red.

The SETTINGS > INPUTS/OUTPUTS > RESETTING > RESET ANNUNCIATOR setting can be used to select a FlexLogic 
operand that when activated acknowledges/resets all annunciator windows.

Annunciator editor
The annunciator editor is used to configure alarms and actual value displays for the graphical front panel.

The path in the EnerVista software is Settings > Product Setup > Graphical Panel > Annunciator Editor.

The figure shows the annunciator editor and its preview window. The page name is entered as General at the top right. 
Acknowledgeable and self-resetting alarms are set for basic functions, such as online/offline, Ethernet ports, unauthorized 
access/failed logins, and battery failure. The text to display in the annunciator window is entered. The IN SERVICE LED is set 
to be green because when the device is on, this LED is green. The preview shows what the annunciator looks like with all 
alarms triggered. The last window is not configured and displays blank/grey. In order for the Ethernet and battery alarms 
to work, the corresponding self-test alarms have been enabled under Settings > Product Setup > User-Programmable 
Self Tests (not shown). The LEDs can be viewed on the front panel, so adding them to the annunciator is for illustrative 
purposes only.

Figure 4-43: Annunciator editor and preview window
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The three page layouts (3 × 4, 4 × 6, and 6 × 8) select the number of rows x columns of windows that appear in a page. 
Annunciator window size and text size shrink as the number of annunciator windows in a page increases.

Properties that can be edited include alarm type (acknowledgeable, latched, self-reset), alarm input (any FlexLogic 
operand), text color, and alarm background color.

The following buttons display at the top of the window:

• Save — Updates the connected device if online or the open setting file if offline with changes made

• Restore — Undoes changes that have not been saved

• Default — Changes all annunciator settings to their factory default values

• Reset — Displays factory default values. Previous settings are not lost unless you save the reset window.

Metering editor
The metering editor is an actual values display tool. It creates pages of actual values for the graphical front panel. There 
are two types: tables and phasor diagrams. Tabular actual values pages have settings to configure, while phasor actual 
values pages have no settings. Five tabular metering pages can be configured, while there can be a phasor page for each 
configured AC source. They display on the graphical front panel using the Metering Tab pushbutton.

The path to the editor is Settings > Product Setup > Graphical Panel > Metering Editor.

Figure 4-44: Metering editor with preview window

The inputs are selected at the top. Select from the drop-down list or start typing in the field.

The page, page name, and grid layout are set below the inputs.

Content to display is configured with the cell lines. The content can be actual values, a status indicator, or text.
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• Actual value — Select from the FlexAnalogs applicable to the F60, where a FlexAnalog is an analog parameter

• Status — Select from the FlexLogic operands identified in the Status Inputs at the top of the window. An example is to 
display text to indicate whether the BATTERY FAIL operand is on or off.

• Text — Enter text to display in the table, for example name of table or column heading

If the metering input is other than OFF, the value of the selected metering input displays, formatted according to the size, 
text color, units, multiplier, and decimal configuration. Otherwise either the Text or the Off Text displays depending on the 
value of the operand selected by setting Status Input/Index.

A maximum of eight Status Inputs/Indexes can be used per metering page and 16 in all metering pages.

The following buttons display at the top of the window:

• Save — Updates the connected device if online or the open setting file if offline with changes made

• Restore — Undoes changes that have not been saved

• Default — Changes all actual value settings to their factory default values

• Reset — Displays factory default values. Previous settings are not lost unless you save the reset window.

Configurable navigation editor
Configurable Navigation is a feature that opens specified pages when specific FlexLogic operands are activated. This 
feature is useful to open the annunciator page containing an annunciator window that has entered its abnormal state.

In the example shown, failure of any of the three Ethernet ports triggers the Product Information page to display. With 
unauthorized access (such as wrong password), IRIG-B clock failure, or breaker trouble, the Event Records display. When a 
breaker opens, a single-line diagram displays. For the Ethernet and IRIG-B failure pages to work, these functions also have 
been enabled under Settings > Product Setup > User-Programmable Self Tests. For the breaker trouble, the single-line 
diagram has been configured.

Figure 4-45: Navigation editor

The path is Settings > Product Setup > Graphical Panel > Configurable Navigation.

The settings consist of 64 field pairs, each with a condition and an activation page. The condition selects any FlexLogic 
operand. The activation page selection is the standard set, such as product information, event records, annunciator pages, 
and single-line diagrams.

To use the feature, select a CONDITION, select its ACTIVATE PAGE option, then save. When selecting the condition 
operand, open the drop-down list and start typing in the field to auto-fill. For example, typing F displays FIRST ETHERNET 
FAIL.

The following buttons display at the top of the window:

• Save — Updates the connected device if online or the open setting file if offline with changes made

• Restore — Undoes changes that have not been saved
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• Default — Changes all settings in the window to factory default values

• Reset — Displays factory default values. Previous settings are not lost unless you save the reset window.

4.2.3  Front panel navigation keys

4.2.3.1  Enhanced and basic front panels
Display messages are organized into pages under the following headings: actual values, settings, commands, and targets. 
The MENU key navigates through these pages. Each heading page is divided further into further submenus.

The MESSAGE keys navigate through the submenus. The VALUE keys increment or decrement numerical setting values when 
in programming mode. These keys also scroll through alphanumeric values in the text edit mode. Alternatively, values can 
be entered with the numeric keypad.

The decimal key initiates and advances to the next character in text edit mode or enters a decimal point.

The HELP key can be pressed at any time for context-sensitive help messages.

The ENTER key stores setting values.

When entering an IP address on the front panel, key in the first sequence of the number, then press the • key for the 
decimal place. For example, for 127.0.0.1, press 127, then •, then 0, then •, then 0, then •, then 1. To save the address, press 
the ENTER key.

When entering or changing an order code with two lines, press the down arrow to access the second line. On a basic front 
panel, do this under ACTUAL VALUES  PRODUCT INFO  MODEL INFORMATION.

The figure shows the sequence to use to enter a setting. Subsequent sections provide more detail.

Figure 4-46: Front panel keypad use (basic front panel shown) 

4.2.3.2  Graphical front panel
These keys and pushbuttons navigate and select items.

Up/Down/Left/Right — These pushbuttons move the selector among the options on a page. The selection is 
indicated by a yellow background or a yellow border. On menu pages, the Right pushbutton activates the selected 
submenu drilling down the menu hierarchy, and the Left pushbutton backs up the menu hierarchy. These 
pushbuttons have a typematic feature on some pages: after a short pause, the pushbutton repeats as long as it is 
pressed.

ENTER — Activates the selection on the display, for example a submenu, a control, a keypad key, or a setting. Also 
stores updated settings.
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4.2.4  LED indicators

4.2.4.1  Enhanced front panel
The enhanced front panel display provides five columns of LED indicators. The first column contains 14 status and event-
cause LEDs. The next four columns contain the 48 user-programmable LEDs.

The RESET key is used to reset any latched LED indicator or target message, once the condition has been cleared (these 
latched conditions can also be reset via the SETTINGS  INPUT/OUTPUTS  RESETTING menu).

The USER keys are used by the breaker control feature.

Figure 4-47: Typical LED panel for enhanced front pane 

The status indicators in the first column are as follows:

ESCAPE — If a setting is open for edit, this pushbutton closes the setting without saving. If a popup menu is open, 
this pushbutton closes it. If an item is selected, this pushbutton deselects it. Otherwise this pushbutton activates 
the previous page in the page hierarchy.

RESET — Clears all latched LED indications and target messages. When a page with acknowledgeable/resettable 
items is displayed, it instead resets/acknowledges all items on that page, or if an item on that page is selected, it 
resets/acknowledges that item.
If you reset/acknowledge alarms, they stop flashing but remain in the alarm state as long as that state remains. In 
other words, a red alarm does not switch off just because you acknowledged the alarm.

Home — Activates the home page, which is the root page. The page displays product information by default and 
is configurable.

Side pushbutton — Five pushbuttons on the left side of the display and five pushbuttons on the right side of the 
display. They perform various functions depending on the displayed page, such as switchgear controls. The 
display dynamically shows its label next to each side pushbutton when the pushbutton has an assigned function.
These pushbuttons can also be programmed to function as user-programmable pushbuttons 9 to 16.

Tab pushbutton — Five pushbuttons under the display. They navigate through the page hierarchy, and on some 
pages activate other actions. The display footer dynamically labels the page or action that is activated by the Tab 
pushbutton.

User-programmable pushbutton — Eight physical pushbuttons are associated with the first eight user-
programmable pushbutton elements. Numbering is down, that is, 1 to 4 down the left column and 5 to 8 down the 
right column.
These elements control a set of FlexLogic operands that can be used to initiate outputs or select modes. Each 
physical pushbutton has an integrated LED indicator that can be user-configured to display the appropriate 
status.
These pushbuttons have clear covers behind which custom labels can be mounted. A utility is available to print 
the labels, under File > Front Panel Report in the software.

842811A1.CDR
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• IN SERVICE — Indicates that control power is applied, all monitored inputs/outputs and internal systems are fine, and 
the relay is in (online) Programmed mode (under Settings > Product Setup > Installation)

• TROUBLE — Indicates that the relay has detected an internal problem. Check the self-test messages outlined at the 
end of the Commands and Targets chapter, and view the event records under Actual Values > Records. For a beta / 
pre-release, this LED is always on.

• TEST MODE — Indicates that the relay is in test mode. For information, see the Test Mode section in the Settings 
chapter.

• TRIP — Indicates that the selected FlexLogic operand serving as a trip input has operated. Set the operand under 
Settings > Product Setup > User-Programmable LEDs > Trip & Alarm LEDs. This indicator latches; initiate the reset 
command to reset the latch.

• ALARM — Indicates that the FlexLogic operand serving as an alarm switch has operated. Set the operand under 
Settings > Product Setup > User-Programmable LEDs > Trip & Alarm LEDs. This indicator never latches.

• PICKUP — Indicates that an element is picked up. This indicator never latches.

The event-cause indicators in the first column are as follows.

Event-cause LEDs are below the status LEDs. They are turned on or off by protection elements that have their respective 
target setting selected as either “Enabled” or “Latched.” If a protection element target setting is “Enabled,” then the 
corresponding event-cause LEDs remain on as long as the operand associated with the element remains asserted. If a 
protection element target setting is “Latched,” then the corresponding event-cause LEDs turn on when the operate 
operand associated with the element is asserted and remains on until the RESET button on the front panel is pressed after 
the operand is reset.

All elements that are able to discriminate faulted phases can independently turn off or on the phase A, B, or C LEDs. This 
includes phase instantaneous overcurrent, phase undervoltage, and so on. This means that the phase A, B, and C operate 
operands for individual protection elements are ORed to turn on or off the phase A, B, or C LEDs.

• VOLTAGE — This LED indicates voltage was involved

• CURRENT — This LED indicates current was involved

• FREQUENCY — This LED indicates frequency was involved

• OTHER — This LED indicates a composite function was involvedThis LED indicates a composite function was involved

• PHASE A — This LED indicates phase A was involved

• PHASE B — This LED indicates phase B was involved

• PHASE C — This LED indicates phase C was involved

• NEUTRAL/GROUND — This LED indicates that neutral or ground was involved

The user-programmable LEDs consist of 48 amber LED indicators in four columns. The operation of these LEDs is user-
defined. Support for applying a customized label beside every LED is provided. Default labels are shipped in the label 
package of every F60, together with custom templates. The default labels can be replaced by user-printed labels.

User customization of LED operation is of maximum benefit in installations where languages other than English are used 
to communicate with operators. See the User-Programmable LEDs section in chapter 5 for the settings used to program 
the operation of the LEDs on these panels.

4.2.4.2  Basic front panel
The basic front panel consists of three panels with LED indicators, keys, and a communications port. The RESET key is used 
to reset any latched LED indicator or target message, once the condition has been cleared (these latched conditions can 
also be reset via the SETTINGS  INPUT/OUTPUTS  RESETTING menu). The RS232 port is for connection to a computer.

The USER keys are used by the breaker control feature.
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Figure 4-48: LED panel 1

Status indicators
• IN SERVICE — Indicates that control power is applied, all monitored inputs/outputs and internal systems are fine, and 

the relay is in (online) Programmed mode (under Settings > Product Setup > Installation)

• TROUBLE — Indicates that the relay has detected an internal problem. Check the self-test messages outlined at the 
end of the Commands and Targets chapter, and view the event records under Actual Values > Records. For a beta / 
pre-release, this LED is always on.

• TEST MODE — Indicates that the relay is in test mode. For information, see the Test Mode section in the Settings 
chapter.

• TRIP — Indicates that the selected FlexLogic operand serving as a trip switch has operated. This indicator always 
latches; initiate the reset command to reset the latch.

• ALARM — Indicates that the selected FlexLogic operand serving as an alarm switch has operated. This indicator never 
latches.

• PICKUP — Indicates that an element is picked up. This indicator never latches.

Event-cause indicators
Event-cause LEDs are turned on or off by protection elements that have their respective target setting selected as either 
“Enabled” or “Latched.” If a protection element target setting is “Enabled,” then the corresponding event cause LEDs 
remain on as long as the operand associated with the element remains asserted. If a protection element target setting is 
“Latched,” then the corresponding event cause LEDs turn on when the operate operand associated with the element is 
asserted and remains on until the RESET button on the front panel is pressed after the operand is reset.

All elements that are able to discriminate faulted phases can independently turn off or on the phase A, B, or C LEDs. This 
includes phase instantaneous overcurrent, phase undervoltage, and so on. This means that the phase A, B, and C operate 
operands for individual protection elements are ORed to turn on or off the phase A, B, or C LEDs.

• VOLTAGE — Indicates voltage was involved

• CURRENT — Indicates current was involved

• FREQUENCY — Indicates frequency was involved

• OTHER — Indicates a composite function was involved

• PHASE A — Indicates phase A was involved

• PHASE B — Indicates phase B was involved

• PHASE C — Indicates phase C was involved

• NEUTRAL/GROUND — Indicates that neutral or ground was involved
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User-programmable indicators
The second and third panels provide 48 amber LED indicators whose operation is controlled by the user. Custom labelling 
can be done.

User customization of LED operation is of maximum benefit in installations where languages other than English are used 
to communicate with operators. See the User-programmable LEDs section in chapter 5 for the settings used to program 
the operation of the LEDs on these panels.

Figure 4-49: LED panels 2 and 3 (index template)

Default labels for LED panel 2
The default labels are intended to represent the following:

• GROUP 1...6 — The illuminated GROUP is the active settings group

• BREAKER 1(2) OPEN — The breaker is open

• BREAKER 1(2) CLOSED — The breaker is closed

• BREAKER 1(2) TROUBLE — A problem related to the breaker has been detected

• SYNCHROCHECK NO1(4) IN-SYNCH — Voltages have satisfied the synchrocheck element

• RECLOSE ENABLED — The recloser is operational

• RECLOSE DISABLED — The recloser is not operational

• RECLOSE IN PROGRESS — A reclose operation is in progress

• RECLOSE LOCKED OUT — The recloser is not operational and requires a reset

The relay is shipped with the default label for the LED panel 2. The LEDs, however, are not pre-programmed. To match the 
pre-printed label, the LED settings must be entered as shown in the User-programmable LEDs section of chapter 5. The 
LEDs are fully user-programmable. The default labels can be replaced by user-printed labels for both panels as explained in 
the next section.

Firmware revisions 2.9x and earlier support eight user setting groups; revisions 3.0x and higher support six setting 
groups. For convenience of users using earlier firmware revisions, the relay panel shows eight setting groups. Even 
though the LEDs have default labels, they are fully user-programmable.
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Figure 4-50: LED panel 2 (default labels)

4.2.4.3  Graphical front panel
The graphical front panel has 14 LEDs. LEDs 1 to 5 are fixed status LEDs, and LEDs 6 to 14 are programmable.

Status indicators
• IN SERVICE — Indicates that control power is applied, all monitored inputs/outputs and internal systems are fine, the 

relay’s test mode is disabled, and the relay is in (online) Programmed mode (under Settings > Product Setup > 
Installation)

• TROUBLE — Indicates that the relay has detected an internal problem. Check the self-test messages outlined at the 
end of the Commands and Targets chapter, and view the event records under Actual Values > Records. For a beta / 
pre-release, this LED is always on.

• TEST MODE — Indicates that the relay is in Isolated (solid) or Forcible (flashing) test mode. For information, see the Test 
Mode section in the Settings chapter.

• TRIP — Indicates that the selected FlexLogic operand serving as a trip input has operated. Set the operand under 
Settings > Product Setup > User-Programmable LEDs > Trip & Alarm LEDs. This indicator latches; initiate the reset 
command to reset the latch.

• ALARM — Indicates that the selected FlexLogic operand serving as an alarm input has operated. Set the operand 
under Settings > Product Setup > User-Programmable LEDs > Trip & Alarm LEDs.

Figure 4-51: Example of LEDs on graphical front panel
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User-programmable event-cause indicators
Event-cause LEDs are below the status LEDs. They are turned on or off by protection elements that have their respective 
target setting selected as “Self-Reset” or “Latched.” If set to “Self-Reset,” then the corresponding event cause LED remains 
on as long as the operand associated with the element remains asserted. If set to “Latched” and asserted, then it remains 
on until the operand is reset and then a reset command initiated.

All elements that are able to discriminate faulted phases can independently turn on or off the phase A, B, or C LEDs. This 
includes phase instantaneous overcurrent, phase undervoltage, and so on. This means that the phase A, B, and C operate 
operands for individual protection elements are ORed to turn on or off the phase A, B, or C LEDs.

The LEDs have defaults and can be configured to show instead the status of any FlexLogic operand.

The labelling area has a clear cover for custom labels. A utility is available to print stick-on labels, as outlined later in this 
chapter.

These LEDs are programmed by default as follows:

• PICKUP — LED 6 — Indicates that an element is picked up, and hence a trip can be imminent

• VOLTAGE — LED 7 — Indicates voltage was involved

• CURRENT — LED 8 — Indicates current was involved

• FREQUENCY — LED 9 — Indicates frequency was involved

• OTHER — LED 10 — Indicates a composite function was involved

• PHASE A — LED 11 — Indicates phase A was involved

• PHASE B — LED 12 — Indicates phase B was involved

• PHASE C — LED 13 — Indicates phase C was involved

• NEUTRAL/GROUND — LED 14 — Indicates that neutral or ground was involved

4.2.5  Front panel labelling

4.2.5.1  Enhanced front panel
The following procedure requires these pre-requisites:

• The UR front panel label cutout sheet (GE part number 1006-0047) has been downloaded from 
http://www.gegridsolutions.com/products/support/ur/URLEDenhanced.doc and printed

• Small-bladed knife

To create custom LED and pushbuttons labels for the enhanced front panel:

1. Start the EnerVista UR Setup software.

2. If not already copied to the Offline Window area, right-click the online device and select the Add Device to Offline 
Window option. Click the Receive button in the window that opens to save the settings file to the Offline Window area.

3. Type labels as follows. Select the File > Front Panel Report. The window opens.

http://www.gegridsolutions.com/products/support/ur/URLEDenhanced.doc
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Figure 4-52: Enhanced front panel label designer

4. Enter the text to appear next to each LED and above each user-programmable pushbutton in the fields provided. The 
LED Offsets and Button Offsets buttons move all labels left/right and up/down on the page (they both do the same 
action, so use either button). The Button Offsets button does not display when there are no pushbuttons to customize.

5. Feed the UR front panel label cutout sheet into a printer and press the Print button in the front panel report window.

6. When printing is complete, fold the sheet along the perforated lines and punch out the labels.

7. Remove the UR label insert tool from the package and bend the tabs as described in the following procedures. These 
tabs are used for removal of the default and custom LED labels.

The label package shipped with every F60 contains the three default labels, the custom label template sheet, and the label 
removal tool.

If the default labels are suitable for your application, insert them in the appropriate slots and program the LEDs to match 
them. If you require custom labels, use the following procedures to remove the original labels and insert the new ones.

Use the tool with the printed side containing the GE part number facing the user.
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To set up and use the label removal tool:

1. Bend the tabs at the left end of the tool upwards as shown.

Bend the tab at the center of the tool tail as shown.

To remove the LED labels from the F60 front panel and insert the custom labels:

1. Use the knife to lift the LED label and slide the label tool underneath. Ensure that the bent tabs are pointing away from 
the relay.
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2. Slide the label tool under the LED label until the tabs snap out as shown. This attaches the label tool to the LED label.

3. Remove the tool and attached LED label as shown.

4. Slide the new LED label inside the pocket until the text is properly aligned with the LEDs, as shown.

To remove the user-programmable pushbutton labels from the F60 front panel and insert the custom labels:

1. Use the knife to lift the pushbutton label and slide the tail of the label tool underneath, as shown. Ensure that the bent 
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tab points away from the relay.

2. Slide the label tool under the user-programmable pushbutton label until the tabs snap out as shown. This attaches the 
label tool to the user-programmable pushbutton label.

3. Remove the tool and attached user-programmable pushbutton label.

4. Slide the new user-programmable pushbutton label inside the pocket until the text is properly aligned with the 
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buttons.

4.2.5.2  Basic front panel
After programming LEDs and pushbuttons under Settings > Product Setup > User-Programmable Leds and User-
Programmable Pushbuttons, labels can be created for the front panel.

To create LED and pushbutton labels for a basic front panel:

1. In the EnerVista software, if the F60 is not already listed in the Offline Window area, add it by right-clicking it and 
selecting the Add Device to Offline Window option.

2. Click the File > Front Panel Report menu item and select the device.

3. In the Front Panel Report window, double-click an LED or pushbutton slot and type a label. If you need to see the 
existing front panel remotely, access Actual Values > Front Panel for the online device. If you need to see the In the 
figure, note that labelling is being done for the third set of LEDs because the second panel of LEDs was factory-
labelled.
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Figure 4-53: Basic front panel label designer (LEDs shown)

4. Optionally save the changes by clicking the Save icon on the toolbar.

5. Click the Print icon on the toolbar. Consider printing to PDF format and adjusting the zoom for appropriate label size, 
then print on a physical printer.

6. Cut labels as a block or individually, for example with scissors or an Exacto knife.

7. If there is a plastic cover over the front panel, remove it by gently pushing in on the right side and lifting off the cover.

8. Remove the plastic cover over the LEDs or pushbutton(s) using a screw driver.

9. Insert the labels.

10. Re-attach the plastic covers.

4.2.5.3  Graphical front panel
The F60 includes software for labelling the LEDs and pushbuttons on the graphical front panel and a sticker sheet with pre-
printed and blank labels. The pre-printed labels are on the top-left of the template sheet, and the blank labels are on the 
bottom-right. Use the pre-printed labels, or use the designer provided in the software and print labels onto the template. 
One sheet is provided.

The example shows LED labeling, wjth pushbutton labeling below it (cut off).

To create LED and pushbutton labels for the front panel:

1. In the EnerVista software, in the Online or Offline Window area, access Settings > Front Panel Label Designer or 
Front Panel Label Designer (at the product root level). The designer window opens with pre-configured labels.

2. Under File > Print Setup, change the page orientation to Landscape.

3. In the label designer window, delete all labels not wanted for printing. This can be done by clicking the Reset button to 
clear all labels, or by selecting each unwanted label and deleting it. Otherwise, all labels displayed print on the 
template and use up the template. If you make a mistake, exit the window and open it again to view the default labels.

4. Based on the location on the template on which to print, create the labels by typing in the appropriate slots.
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Figure 4-54: Front panel label designer for graphical front panel

5. Click the Print button in the window and select the printer.

6. Once printed, peel the labels off the template and stick them on the front panel. For the enhanced and graphical front 
panels, they go over the clear plastic inserts, not under. For the basic front panel, they go under or over the plastic 
covers.

Any changes are not saved. Each time that the label designer window opens, the original template displays. Any labels 
deleted are not lost.

4.2.6  Menu navigation
Press the MENU key to display selections or home page. Each press of the key advances through the following main 
headings:

• Actual Values

• Settings

• Commands

• Targets

• Factory Service

• User displays (when enabled)

4.2.6.1  Enhanced and basic front panels
The setting and actual value pages are arranged hierarchically. Header display pages are indicated by double scroll bars 
(), while sub-header pages are indicated by a single scroll bar (). The header display pages represent the highest level 
of the hierarchy and the sub-header display pages fall below this level. Use the down, right, left, and up arrows to navigate 
the menu. The MESSAGE up and down arrow keys move within a group of headers, sub-headers, setting values, or actual 
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values. Continually pressing the MESSAGE right arrow from a header display displays specific information for the category. 
Conversely, continually pressing the MESSAGE left arrow from a setting value or actual value display returns to the header 
display.

Default values are indicated in this instruction manual in mixed case. In the example shown here, the default access level is 
Restricted.

Example

4.2.6.2  Graphical front panel
Access the main menu by pressing the Home pushbutton, then the Menu Tab pushbutton.

Use the Up and Down arrow pushbuttons to select a submenu, then press the Right or ENTER pushbutton to drill into that 
submenu. The Left and ESCAPE pushbuttons back up the menu hierarchy.

The Page Up and Page Down Tab pushbuttons also navigate through the list. When there is only a single page of options, 
they jump to the first and last entries.

The options displayed depend on order code.

Highest level Lowest level (setting value)

  SETTINGS
  PRODUCT SETUP   SECURITY

  ACCESS LEVEL:
Restricted


 SETTINGS
 SYSTEM SETUP

 ACTUAL VALUES
 STATUS

Press the MENU key until the Actual Values header page appears. This page contains system 
and relay status information.


 SETTINGS
 PRODUCT SETUP

Press the MENU key until the Settings header page appears. This category contains settings to 
configure the relay.


 SECURITY


Press the MESSAGE right arrow once to display the first sub-header (Security).


ACCESS LEVEL:
Restricted

Press the MESSAGE right arrow once to display the first setting for Security.


 SECURITY


Press the MESSAGE left arrow to return to the Security heading. 


 DISPLAY
 PROPERTIES

Press the MESSAGE down arrow to display the second setting sub-header associated with the 
Product Setup header.


LANGUAGE:
English

Press the MESSAGE right arrow once to display the first setting for Display Properties.


 SETTINGS
 SYSTEM SETUP

Press the MESSAGE left arrow to return to the Display Properties page, then again to return to 
the Product Setup Page. Press the MESSAGE down arrow to move to the next Settings page. This 
page contains settings for System Setup.
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Figure 4-55: Main menu on graphical front panel

4.2.7  Change settings

4.2.7.1  Enhanced and basic front panels

Numerical data
Each numerical setting has its own minimum, maximum, and increment value associated with it. These parameters define 
what values are acceptable for a setting.

Two methods of editing and storing a numerical setting value are available.

• 0 to 9 and decimal point — The relay numeric keypad works the same as a calculator. A number is entered one digit at 
a time. The leftmost digit is entered first and the rightmost digit is entered last. Pressing the MESSAGE left arrow or 
pressing the ESCAPE key, returns the original value to the display.

• VALUE keys — The VALUE up arrow increments the displayed value by the step value, up to the maximum value 
allowed. While at the maximum value, pressing the VALUE up arrow again allows the setting selection to continue 
upward from the minimum value. The VALUE down arrow decrements the displayed value by the step value, down to 
the minimum value. While at the minimum value, pressing the VALUE down arrow again allows the setting selection to 
continue downward from the maximum value.

FLASH MESSAGE
TIME: 10.0 s

For example, select the SETTINGS  PRODUCT SETUP  DISPLAY PROPERTIES  FLASH 
MESSAGE TIME setting.


MINIMUM: 0.5
MAXIMUM: 10.0

Press the HELP key to view the minimum and maximum values. Press the key again to view the 
next context sensitive help message.

FLASH MESSAGE
TIME: 2.5 s

As an example, set the flash message time setting to 2.5 seconds. Press the appropriate numeric 
keys in the sequence “2 . 5". The display message changes as the digits are being entered.


NEW SETTING
HAS BEEN STORED

Until ENTER is pressed, editing changes are not registered by the relay. Press ENTER to store the 
new value in memory. This flash message momentarily appears as confirmation of the storing 
process. Numerical values that contain decimal places are rounded-off if more decimal place digits 
are entered than specified by the step value.



CHAPTER 4: INTERFACES FRONT PANEL INTERFACE

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 4-53

4

Enumeration data
Enumeration settings have data values that are part of a set, whose members are explicitly defined by a name. A set has 
two or more members.

Enumeration type values are changed using the VALUE keys. The VALUE up arrow displays the next selection while the 
VALUE down arrow displays the previous selection.

Alphanumeric text
Text settings have data values that are fixed in length, but user-defined in characters. They can be upper-case letters, 
lower-case letters, numerals, and a selection of special characters.

There are several places where text messages can be programmed to allow the relay to be customized for specific 
applications. One example is the Message Scratchpad. Use the following procedure to enter alphanumeric text messages.

For example, enter the text “Breaker #1”.

1. Press the decimal point to enter text edit mode.

2. Press the VALUE keys until the character 'B' appears; press the decimal key to advance the cursor to the next position.

3. Repeat step 2 for the remaining characters: r,e,a,k,e,r, ,#,1.

4. Press ENTER to store the text.

5. If you have any problem, press HELP to view context sensitive help. Flash messages appear sequentially for several 
seconds each. For the case of a text setting message, pressing HELP displays how to edit and store new values.

4.2.7.2  Graphical front panel
When enabling an element in the EnerVista software that outputs to an actual value, the actual values menu is not 
updated on the graphical front panel via Ethernet connection when that menu is active on the graphical front panel. 
Navigate out and back into the menu for activation.

Numerical data
This example outlines how to change the FLASH MESSAGE TIME setting. Flash messages are status, warning, error, and 
information messages displayed in response to certain key presses during settings programming. An example is a 
confirmation message upon saving settings. This setting specifies how long to display the message.

Press the Menu pushbutton to display the main menu.

ACCESS LEVEL:
Restricted

For example, the selections available for ACCESS LEVEL are "Restricted," "Command," "Setting," and 
"Factory Service."

ACCESS LEVEL:
Setting

If the ACCESS LEVEL needs to be "Setting," press the VALUE keys until the proper selection displays. 
Press HELP at any time for the context sensitive help messages.


NEW SETTING
HAS BEEN STORED

Changes are not registered by the relay until the ENTER key is pressed. Pressing ENTER stores the 
new value in memory. This flash message momentarily appears as confirmation.
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Figure 4-56: Main menu

Use the Up or Down pushbutton to select SETTINGS, then press the Right or ENTER pushbutton.

Figure 4-57: Settings menu

With PRODUCT SETUP selected, press the Right or ENTER pushbutton.



CHAPTER 4: INTERFACES FRONT PANEL INTERFACE

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 4-55

4

Figure 4-58: Product Setup menu

Use the Up or Down pushbutton to select DISPLAY PROPERTIES, then press the Right or ENTER pushbutton.

Figure 4-59: Display Properties menu

Use the Up or Down pushbutton to select FLASH MESSAGE TIME, then press the Right or ENTER pushbutton. If the relay is 
configured to require login to edit settings, and the user is not already logged in, the login page displays. When the user 
has successfully logged in, the setting is opened for edit. As the FLASH MESSAGE TIME setting accepts a numerical value, a 
keypad displays. The time is to be changed to 4.0 seconds.

The current setting displays. A flashing cursor line marks the insertion point, initially positioned after the last character of 
the setting. The setting range displays under the text.

Press the <--  Move Cursor and Move Cursor  --> Tab pushbuttons to move the insertion point. Place it after the 2.

Press the Backspace Tab pushbutton to remove the character to the left of the cursor, in this case the 2.

Using the arrow keys, enter another time, for example 4 for four seconds. These Up, Down, Left, and Right pushbuttons 
move the keypad key selector. Pressing the ENTER pushbutton with the -  key selected inverts the sign. Pressing the ENTER 
pushbutton with the decimal point selected enters that character at the insertion point. Push ENTER now to accept the 4.
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Figure 4-60: Settings page with numeric keypad

Press the Save Tab pushbutton, which does a range check on the value, saves the setting when valid, closes the page, and 
displays the previous page.

When a setting is not saved due to an invalid value, a message flashes, for example being out of range. In cases where the 
relay needs to be restarted for settings to take effect, the flash message advises.

Setting entry can be cancelled without impact on the original value by pressing the ESCAPE or Home pushbutton.

Alphanumeric text
Settings that accept alphanumeric values display a keyboard. An example is a pushbutton name.

The &123 key toggles between text and numbers.

The shift key (up arrow on keyboard) is green upon activation, while the keyboard letters switch to upper case. Double-click 
the shift key to lock capital lettering, or full capitals.

The globe key (shown greyed-out) toggles the keyboard language between English and another display language selected, 
for example between English and French. (The second language needs to be activated under Settings > Product Setup > 
Display Properties.)

For Japanese and Chinese, up to 10 characters can be input in a field, not 20.

To add accents, highlight a key and hold the ENTER pushbutton on the graphical front panel. Any special characters 
associated with the key display.

Figure 4-61: Settings page with keyboard and accents
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4.2.8  View actual values

4.2.8.1  Graphical front panel
In addition to data viewable in the Actual Values menu on the front panel, phasor diagrams and metered data can be 
displayed. The metered data can be arranged as a table.

The update rate of metered values is 500 ms.

A phasor page for each configured AC Source and up to five user-configurable metering pages can be displayed. The 
phasor pages are not configurable. Each phasor page shows a phasor plot and numerical values of all currents, voltages, 
and symmetrical components of a single AC source.

The Annunciator and Metering pages can be configured to display data. Each has a user-configured number of rows and 
columns. Each cell can include either configurable static text or the value of a selected FlexLogic operand, FlexAnalog 
operand, or actual value.

To display a metering page, press the Home pushbutton, then the Metering Tab pushbutton. The first metering page 
opens, with phasor pages listed before tabular pages. The Tab pushbuttons display any other metering page, as do the Up, 
Down, Left and Right pushbuttons. The current page is highlighted with a blue Tab pushbutton.

Each phasor page has a name, which consists of the value of the SOURCE NAME # setting appended with " Phasors." 
Phasor pages that have no configured CTs or VTs do not have a Tab pushbutton, and phasor pages that have no 
configured cells cannot be displayed.

Figure 4-62: Phasor display

The configurable name displays in the header and Tab pushbutton label. Factory default names are Page 1, Page 2, and so 
on.
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Figure 4-63:  Metered actual values

The phasor sources are configured under Settings > System Setup > Signal Sources. The tables to display the actual 
values are configured in the software under Settings > Product Setup > Graphical Panel > Metering Editor.

4.2.9  Breaker control
The F60 can interface with associated circuit breakers. In many cases the application monitors the state of the breaker, 
that can be presented on front panel LEDs, along with a breaker trouble indication. Breaker operations can be manually 
initiated from the front panel keypad or automatically initiated from a FlexLogic operand. A setting is provided to assign 
names to each breaker; this user-assigned name is for the display of related flash messages. These features are provided 
for two breakers; the user can use only those portions of the design relevant to a single breaker, which must be breaker 1.

It is assumed in the following discussion that the SETTINGS  SYSTEM SETUP  BREAKERS  BREAKER 1(2)  BREAKER 
FUNCTION setting is "Enabled" for each breaker.

4.2.9.1  Control mode selection and monitoring
Installations can require that a breaker be operated in the three-pole only mode (3-pole), or in the one and three-pole (1-
pole) mode, selected by setting. If the mode is selected as three-pole, a single input tracks the breaker open or closed 
position. If the mode is selected as one-pole, all three breaker pole states must be input to the relay. These inputs must be 
in agreement to indicate the position of the breaker.

For the following discussion it is assumed that the SETTINGS  SYSTEM SETUP  BREAKERS  BREAKER 1(2)  BREAKER 
1(2) PUSH BUTTON CONTROL setting is “Enabled” for each breaker.

4.2.9.2  Front panel (user key) control
After the 30 minute interval during which command functions are permitted after a correct command password, the user 
cannot open or close a breaker via the keypad. The following discussions begin from the not-permitted state.

4.2.9.3  Control of two breakers
For the following setup example, the (Name) field represents the user-programmed variable name.

For this example, the relay is connected and programmed for both breaker 1 and breaker 2. The USER 1 key performs the 
selection of which breaker is to be operated by the USER 2 and USER 3 keys. The USER 2 key manually closes the breaker, and 
the USER 3 key manually opens the breaker.
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4.2.9.4  Control of one breaker
For this application, the relay is connected and programmed for breaker 1 only. Operation for this application is identical to 
that described in the previous section for two breakers.

4.2.10  Change passwords
The information in this section refers to password security. For information on how to set the password for the first time or 
change CyberSentry passwords, see the previous chapter or the Settings > Product Setup > Security > CyberSentry section 
in the next chapter.

The F60 supports password entry from a local or remote connection.

Local access is defined as access to settings or commands via the front panel. This includes both keypad entry and the 
RS232 port. Remote access is defined as access to settings or commands via any rear communications port. This includes 
both Ethernet and RS485 connections. Any change to the local or remote password enables this functionality.

When entering a settings or command password via EnerVista or any serial interface, the user must enter the 
corresponding connection password. If the connection is to the back of the F60, the remote password must be used. If the 
connection is to the RS232 port of the front panel, the local password must be used.

There are two user security access levels, setting and command, for which you can set a password for each. Use of a 
password for each level controls whether users can enter commands or change settings. Another option is to specify 
setting and/or command access for individual user accounts.

• Setting — Allows the user to make any changes to any of the setting values:

– Changing any setting

– Test mode operation

• Command — Restricts the user from making any settings changes, but allows the user to perform the following 
operations:

– Operating the breakers via front panel keypad

– Changing the state of virtual inputs

ENTER COMMAND
PASSWORD

This message appears when the USER 1, USER 2, or USER 3 key is pressed and a COMMAND 
PASSWORD is required, that is, if COMMAND PASSWORD is enabled and no commands have been 
issued within the last 30 minutes.

Press USER 1
To Select Breaker

This message appears if the correct password is entered or if none is required. This message 
displays for 30 seconds or until the USER 1 key is pressed again.

BKR1-(Name) SELECTED
USER 2=CLS/USER 3=OP

This message displays after the USER 1 key is pressed for the second time. Three possible actions 
can be performed from this state within 30 seconds as per the following items (1), (2) and (3).

(1)

USER 2 OFF/ON
To Close BKR1-(Name)

If the USER 2 key is pressed, this message appears for 20 seconds. If the USER 2 key is pressed 
again within that time, a signal is created that can be programmed to operate an output relay to 
close breaker 1.

(2)

USER 3 OFF/ON
To Open BKR1-(Name)

If the USER 3 key is pressed, this message appears for 20 seconds. If the USER 3 key is pressed 
again within that time, a signal is created that can be programmed to operate an output relay to 
open breaker 1.

(3)

BKR2-(Name) SELECTED
USER 2=CLS/USER 3=OP

If the USER 1 key is pressed at this step, this message appears showing that a different breaker is 
selected. Three possible actions can be performed from this state as per (1), (2) and (3). Repeatedly 
pressing the USER 1 key alternates between available breakers. Pressing keys other than USER 1, 2, 
or 3 at any time cancels the breaker control function.
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– Clearing the event records

– Clearing the oscillography records

– Clearing fault reports

– Changing the date and time

– Clearing the breaker arcing current

– Clearing energy records

– Clearing the data logger

– Clearing the user-programmable pushbutton states

To enter the initial setting or command password:

1. Press the MENU key until the SETTINGS header flashes momentarily and the PRODUCT SETUP message appears on the 
display.

2. Press the MESSAGE right arrow until the ACCESS LEVEL message appears on the display.

3. Press the MESSAGE down arrow until the CHANGE LOCAL PASSWORDS message appears on the display.

4. Press the MESSAGE right arrow until the CHANGE SETTING PASSWORD or CHANGE COMMAND PASSWORD message 
appears on the display.

5. After the CHANGE...PASSWORD message appears on the display, press the VALUE up or down arrow to change the 
selection to “Yes.”

6. Press the ENTER key and the display prompts you to ENTER NEW PASSWORD.

7. Type in a password and press the ENTER key.

8. When VERIFY NEW PASSWORD displays, re-type the password and press ENTER.

9. When the NEW PASSWORD HAS BEEN STORED message appears, your new Setting (or Command) password is active.

4.2.11  Invalid password entry
By default, when an incorrect Command or Setting password has been entered via the front panel three times within five 
minutes, the LOCAL ACCESS DENIED FlexLogic operand is set to “On” and the F60 does not allow settings or command level 
access via the front panel for five minutes.

By default, when an incorrect Command or Setting password has been entered via any external communications interface 
three times within five minutes, the REMOTE ACCESS DENIED FlexLogic operand is set to “On” and the F60 does not allow 
settings or command access via the any external communications interface for five minutes. The REMOTE ACCESS DENIED 
FlexLogic operand is set to “Off” after five minutes for a Command password or 30 minutes for a Settings password.

These default settings can be changed in EnerVista under Settings > Product Setup > Security.

 SECURITY
  ACCESS LEVEL:

Restricted

  CHANGE LOCAL
 PASSWORDS  CHANGE COMMAND

PASSWORD: No

 CHANGE SETTING
PASSWORD: No

CHANGE SETTING
PASSWORD: No

CHANGE SETTING
PASSWORD: Yes

ENTER NEW
PASSWORD: ##########

VERIFY NEW
PASSWORD: ##########

NEW PASSWORD
HAS BEEN STORED



CHAPTER 4: INTERFACES LOGIC DIAGRAMS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 4-61

4

4.3  Logic diagrams
Logic diagrams in this instruction manual provide an overview of function and settings. A logic diagram is based on

• Inputs-on the left side, which are setting and operands

• Logical gates, which is Boolean algebra to combine logical lines using AND, OR, NOT, and other gates to get a new 
logical state

• Logical operators, which are timers, one-shot operations, latches, and so on

• Outputs-on the right side, which are products of the manipulations with inputs, logical gates, and logical operators to 
produce new operands and define the output state of the element

True and false values are denoted by 1 and 0 respectively. A function usually is high/on/enabled when 1.

Reading from right to left in the following diagram, the TRIP BUS 1 OP and TRIP BUS 1 PKP FlexLogic operands on the right side 
are triggered when either the settings or reset latch in the middle of the diagram is triggered. When this applies, the TRIP 
BUS 1 OP operand is triggered after the delay set by the TRIP BUS 1 PICKUP DELAY or TRIP BUS 1 RESET DELAY setting, while the 
TRIP BUS 1 PKP operand initiates immediately. The settings or reset latch in the middle of the diagram is triggered as follows.

• For the reset, one of three conditions are required to meet the OR requirement shown at the bottom left. That is, the 
TRIP BUS 1 LATCHING setting must be 0=Disabled (which is negated by the NOT function to become 1=Enabled), output 
from the TRIP BUS 1 RESET FlexLogic operand must be 1, or output from the RESET OP FlexLogic operand must be 1.

• For the settings, one of 16 input conditions at the top left must be met for the OR, the TRIP BUS 1 FUNCTION must be 
Enabled, and the TRIP BUS 1 BLOCK output must output as 0, which is then negated/reversed by NOT to become 1.

Table 4-2: Logic diagram symbols

Symbol Description

= Off Output from FlexLogic operand, so user-defined

= Enabled 1 = Enabled and 0 = Disabled

OR Any function input on the left side satisfies the condition

AND All functions input on the left side are required to satisfy the condition

 Not. Negates/reverses the output, for example 0 becomes 1.

 Connection

S, R Set, Reset

TPKP Timer pickup. Triggered by the settings latch in the diagram.

TRST Timer reset. Triggered by the reset latch in the diagram.
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Figure 4-64: Logic diagram 

4.4  FlexLogic design using Engineer
Parts of EnerVista Viewpoint Engineer software are integrated in the EnerVista UR Setup software. Engineer can be used to 
create and modify FlexLogic that is used by a device, such as to monitor output, monitor triggers, and create self-tests.

Features include

• Automatically displays existing FlexLogic

• Drag-and-drop interface

• Open multiple tabs and edit simultaneously

• Display symbols in IEC, ISO, or UR formats

• Export a diagram as BMP file or copy it to the clipboard for import into other applications

• Scale and print files in various paper sizes

• Works with all UR firmware versions

The figure shows an example where several inputs are used to trigger an output. With the OR function, any one of the 
inputs can trigger the output.

*
*

*

SETTINGS

= Off

TRIP BUS 1 INPUT 2

= Off

TRIP BUS 1 INPUT 1

= Off

TRIP BUS 1 INPUT 16

OR

SETTINGS

= Enabled

TRIP BUS 1

FUNCTION

= Off

TRIP BUS 1 BLOCK AND

AND

Latch

S

R

Non-volatile,

set-dominant

SETTINGS

= Enabled

TRIP BUS 1

LATCHING

= Off

TRIP BUS 1 RESET

FLEXLOGIC OPERAND

TRIP BUS 1 PKP

OR

SETTINGS

TRIP BUS 1 PICKUP

DELAY

TRIP BUS 1 RESET

DELAY

TPKP

TRST

FLEXLOGIC OPERAND

RESET OP

FLEXLOGIC OPERAND

TRIP BUS 1 OP

842023A1.CDR
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Figure 4-65: Inputs triggering output in Engineer

The process is as follows:

• Modify or create a logic diagram in the Offline Window area of the EnerVista UR Setup software

• Compile it and troubleshoot any errors

• The logic populates automatically into the FlexLogic Equation Editor

• Upload the file to the live device

• Monitor the output

This section explains how to use Engineer. It outlines the following topics:

• Design logic

• Send file to and from device

• Monitor logic

• View front panel

• Generate connectivity report

• Preferences
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• Toolbars

4.4.1  Design logic
FlexLogic can be created with a block diagram. Note that although work is completed in the Offline Window area of the 
software, communication occurs with the online device, for example when switching to monitoring mode.

The following procedures are outlined:

• Examples

• Add existing FlexLogic equations

• Create a logic diagram/sheet

• Rapidly add logic blocks in sequence

• Connect two logic diagrams/sheets

• Optimize the logic

• Change logic order

• Search logic

• Exclude sheet from compile

4.4.1.1  Examples
The symbols are displayed in the UR format.

Create oscillography trigger every three minutes

Figure 4-66: Three-minute timer turns on LED for 10 seconds

Preparation — Under Settings > Inputs/Outputs > Virtual Outputs, the first and second virtual outputs are named 
OscTrigger

Top logic — Three-minute timer trigger

Bottom logic — Turn on LED 1 for 10 seconds when the trigger starts

Create data logger trigger every seven minutes

Figure 4-67: Seven-minute timer turns on LED for 10 seconds

Preparation — Under Settings > Inputs/Outputs > Virtual Outputs, virtual outputs 3 and 4 are named DLTrigger

Top logic — Seven-minute timer trigger

Bottom logic — Turn on LED 9 for 10 seconds when the trigger starts
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Create events every minute, then every 100 ms

Figure 4-68: One-minute timer turns on LED and creates events every 100 ms

Preparation — Under Settings > Inputs/Outputs > Virtual Outputs, virtual output 5 is named EVStart, 6 is named 
EVTriggered, and 7 is named EVMakeEvent

Top logic — One-minute timer trigger

Middle logic — Turn on LED 17 for 10 seconds when trigger starts

Bottom logic — Create events at 100 ms intervals for the same 10 second period

4.4.1.2  Add existing FlexLogic equations
A logic diagram can be created using existing FlexLogic equations (this section) or by creating new ones (next section).

When using existing equations, you modify them in the FlexLogic Equation Editor in the Offline Window area, then apply 
them.

To create a logic diagram using existing FlexLogic equations:

1. In the Offline Window area, modify the FlexLogic for the device under FlexLogic > FlexLogic Equation Editor. If the 
device is not listed, right-click the device in the Online Window area and select the Add Device to Offline Window 
option.

Upon saving the modified FlexLogic, a yellow icon appears for the device in the Offline Window area to indicate that 
the logic differs from the Online device.

2. In the Offline Window area, access Engineer for the device, then Logic Designer. The logic opens.

3. Click the Edit > Auto Populate Workbook menu item. If the software prompts if you want to keep or discard existing 
sheets, either is acceptable, with the older excluded sheeted being denoted by brackets, such as < Sheet 1 >. The logic 
displays in the various tabs. The FlexLogic created in the equation editor appears in Sheet 1, for example.

4.4.1.3  Create logic diagram
Upon access of the Logic Designer, the FlexLogic equations of the device display. You can create new logic in new sheets or 
modify the ones that display.

This procedure uses input / output logic as an example.

1. In the Offline Window area, access Engineer for the device, then Logic Designer. If the device is not listed, right-click 
the device in the Online Window area and select the Add Device to Offline Window option.

The FlexLogic Equation Editor window is in view-only mode when the Logic Designer is open. To instead work in the 
FlexLogic Equation Editor, close the Logic Designer window, then re-open the FlexLogic Equation Editor.
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Figure 4-69: Access Engineer in the Offline Window area

A default block diagram opens that shows 48 inputs (boxes) and 48 user-programmable LEDs (circles).

For the graphical front panel, no LEDs can be added to the window and the LEDs are removed when opening any 
existing files. For these existing files with the LEDs removed, save the file without them.

Figure 4-70: Default view of FlexLogic designer

2. Optionally delete the default logic diagram by right-clicking its tab at the bottom of the window and selecting Delete.

3. To add a blank sheet, click Edit > Add Sheet. A new tab displays. Or use the last tab displayed, which is a blank sheet.

4. Optionally right-click the new tab and Rename it.

5. Add the input blocks to the logic diagram. For example, click the I/O Tokens tab on the right, click the Input element, 
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then click in the logic sheet to add it. Or drag-and-drop it.

6. Double-click the block on the sheet to configure it, selecting from the two drop-down lists. The figure shows that 
virtual input 61 is being added. The View Associated Screen button opens its settings window.

Figure 4-71: Configuring an input block

7. Add the output blocks to the logic diagram. For example, click the I/O Tokens tab, click the Virtual Output element, 
then click in the logic sheet to add it. Double-click the block on the sheet to configure it. For the name, make it unique. 
The figure shows virtual output 61 is being added, with a suffix of "io" added to the name to make it unique. Note that 
the outline color of a block is red until it is configured, and that this properties window varies by block and the 
selectable options by order code.

Figure 4-72: Configuring an output block

8. Connect the input blocks to the output blocks by drawing a line as follows. Click at the end of one block and drag the 
line to the next block. Or click the Drawing Tools tab, then select the Line option. The cursor needs to be at the 
connection point to end the line, not elsewhere on the block. Note that the outline color is no longer red on the blocks.
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Figure 4-73: Completed inputs and outputs

9. Add any remaining blocks or information. Right-click a block to copy and paste it. Notes are as follows.

Add a text box — Drawing Tools > Text

Add a FlexElement — Elements > FlexElement. An analog input is expected where a small arrow head shows in the 
box.

Figure 4-74: FlexElement accepts analog inputs on left side where arrow heads display

Add an Element — Elements tab. Available elements reflect the product, for example the Control Elements category.

Figure 4-75: Elements reflect Control Elements

10. Check for any blocks that have a red outline. These are invalid. Fix them before continuing, for example by configuring 
them.

11. Compile the logic diagram to check for errors by clicking the Compile button at the bottom left or by pressing the F7 
key.

If prompted about a message about sorting, click Yes to apply the default (for this example), which can be automatic 
sorting based on an algorithm that applies fastest execution time.

With successful compiling, the file is saved and the FlexLogic equations populate automatically. Scroll up through the 
compile messages, with the red errors being the only messages that require fixing before proceeding.

The figure shows that we forgot to add the "Io" suffix to the names of virtual outputs 62 and 63, as indicated by 
"Warning: Virtual output xx using default name." This warning is a minor warning.

The warning "input using disabled feature" means that input needs to be enabled. Double-click the block, click the 
View Associated Screen button, enable the setting, save, and recompile.

The output and messages are explained in the next section.
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Some information displayed in the compile messages updates automatically, for example messages after a device is 
unplugged.

Figure 4-76: Compile and check the logic

12. View the FlexLogic equations by navigating in the Offline Window area to FlexLogic > FlexLogic Equation Editor. The 
window opens with the entries displayed in the next tab.

Figure 4-77: Logic displayed in FlexLogic Equation Editor

13. Save the work.

The logic diagram has been created and the FlexLogic equations populated. The next steps are to upload the file to the 
device and to monitor the device.

4.4.1.4  Compiled results and warning messages
When a yellow caution symbol displays in the Offline Window area, it means that the settings file is not synchronized with 
the online device. Right-click the device in the Offline Window area, and select the Update SCL files option. SCL refers to 
the Substation Configuration Language. An Instantiated IED capability description (IID) file is an example of an SCL file and 
contains the actual settings on a UR device.

Figure 4-78: Settings files not synchronized between offline and online files

When the Update SCL files option is selected, the CID and IID files in the device folder are updated by the user 
configuration in the IEC 61850 panel and thereby become synchronized. The CID file and the IID file (depending on the 
preference 'Do not update IID file when updating SCL files') are updated. If the CID file is not already there, it is generated. 
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The location of these files is C:\ProgramData\GE Power Management\urpc, for example, in the Offline and Online folders. 
Any FlexLogic equations entered in the Offline Window area are erased. The logic drawn in the Logic Designer window in 
Engineer in the Offline Window area remain. The warning icon disappears after updating.

The following information is contained in the compile window.

Figure 4-79: Compiled results

Number of Lines Saved — The number of compiled logic lines eliminated by using the optimization algorithm, as set in the 
Optimize Compiled Output option of the Preferences. In the example shown, no lines were saved because the optimizer is 
disabled.

FlexLogic Lines — The number of lines that the compiled logic uses, for example seven of 512 available.

Virtual Output equations — The number of FlexLogic equations used in the Logic Designer window.

Timers used — The number of timers used in the Logic Designer window.

Memory Used — The percent of memory used in the Logic Designer window.

Errors

Table 4-3: Errors from compiling

Category Block or gate 
affected

Message Description

Error All Number of lines (nnn) exceeds 
maximum limit of 512

The compiled result exceeds the limit of 512. Reduce the number of 
equations to 512 or less.

Error Tag-In Tag-in not configured (TAG_ID, 
SheetReference)

A Tag-In is connected to a circuit but the Tag-In is not referencing an 
existing Tag-Out

Error 1 Shots One Shot is over limit 
(SYMBOL_ID, SheetReference)

The number of One-Shots contained within all of the VO blocks has 
exceeded the maximum allowed for the firmware revision. This value can 
either be 0 or 32.

Error =VO VO has no inputs (VO_ID, 
SheetReference)

A Virtual Output block is located within the FlexLogic diagram and there 
is no block connected as input to it. Connect and identify the inputs.
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Warnings
When using the 'Reset OP' operand, a warning can appear indicating that this is a disabled feature. This means that the 
Reset Settting's FlexLogic operand is set to OFF. Resetting of the relay can be done by pressing the reset button on the front 
panel of the relay or by sending a Reset command through communications.

Table 4-4: Warning messages from compiling

4.4.1.5  Rapidly add logic blocks in sequence
Blocks are added by clicking an element then clicking in the drawing area, or by dragging and dropping the element onto 
the canvas. Blocks can be added rapidly in sequence, for example when you have inputs 1 to 10, without having to select 
the element each time.

1. In Engineer, click File > Preferences. The window opens.

2. Click the Editor entry.

3. Enable the Repeat Symbol check box.

4. Click the Ok button to save and exit from the window.

5. In the logic diagram, select an element, then click in the drawing area to add it, click again to add a second box, and 
so on.

Error Timer Timer used more than once 
(TIMER_ID, SheetReference)

The same timer is used in more than one place in the editor. This means 
either the circuit that the Timer belongs to has been branched, or the 
Timer has been duplicated.

Error Input Unrecognized Parameter 
(SYMBOL_ID,Name,SheetRefere
nce)

An Input symbol is configured to an item that is not recognized by the 
current order code and version. Possible cause: The order code and/or 
version of the settings file was converted causing the input parameter to 
become unavailable.

Category Block or 
gate 
affected

Message Description

Minor warning Input Input set to unused VO 
(SYMBOL_ID,Name,Sheet)

An Input symbol is using an unassigned Virtual Output

Major warning Tag-Out Tag-out not connected 
(TAG_ID,Sheet)

A Tag-Out symbol has no input

Major warning All Symbol not connected 
(SYMBOL_ID,Name,Sheet)

A symbol’s input and/or output is not connected and is not part of a 
VO block. Draw the input and/or output to the block.

Minor warning =VO Virtual Output n using default 
name (VO_ID,Sheet)

The Assigned Virtual Output is using the default name. Change the 
name.

Minor warning Input Input using default name 
(SYMBOL_ID,Name,Sheet)

An Input symbol is using a Contact Input, Contact Output, Digital 
Element, FlexElement, or Digital Counter set to the default name. 
Change the name so that it is unique.

Setting warning Input Input using disabled feature 
(SYMBOL_ID,Name,Sheet)

An Input symbol is using a disabled Virtual Input, Contact Input, Digital 
Element, FlexElement, Digital Counter, Control Pushbutton, 
Programmable Pushbutton, Contact Output, or Protection/Monitoring 
Element. Enable it and try again.

Major warning Input Input set to OFF 
(SYMBOL_ID,Sheet)

An Input symbol is set to OFF

Major warning Input Input set to ON 
(SYMBOL_ID,Sheet)

An Input symbol is set to ON

Setting warning Input Contact Output Operate is OFF 
(SYMBOL_ID, Contacts)

The symbol block is using the default setting of OFF

Setting warning Input Contact Output Seal-In is OFF 
(SYMBOL_ID, Contacts)

The symbol block is using the default setting of OFF

Category Block or gate 
affected

Message Description
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4.4.1.6  Connect two logic diagrams
When the logic is complex and requires two sheets, for example, these two sheets can be connected. By connecting them, 
the logic is continuous from one sheet to the next.

1. In the first sheet, click the I/O Tokens tab.

2. Scroll to the bottom, and click and drag the Tag Out element to the sheet where the next sheet is to connect.

3. Double-click the element and in the window that opens, give it a name, such as "To Sheet 2" or "To IO Sheet 2."

Figure 4-80: Connecting sheet 1 to sheet 2

4. In the second sheet, click and drag the Tag In element to the sheet where the first sheet is to connect.

5. Double-click the element and in the window that opens, select the first sheet from the drop-down list to connect the 
two sheets.

6. Save the work.

4.4.1.7  Optimize the logic
The number of available FlexLogic entries depends on firmware, for example 515 or 1024 lines. The software can 
automatically optimize a logic diagram to reduce space and free up entries.

1. In Engineer, under File > Preferences, select the Compiler option. Ensure that the Optimize Compiled Output option is 
enabled.

2. Run the compiler again, for example by clicking the Compile button at the bottom left of the software. The results 
display in the Optimization Summary. Changes also display when the FlexLogic Equation Editor is accessed. The logic 
diagram does not change. In the example shown, no lines were saved to free up space.

Figure 4-81: Code optimization results

4.4.1.8  Change logic order
The order in which the FlexLogic is populated in the FlexLogic Equation Editor window depends on settings.
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First, when automatic sorting is not enabled, the sequence in which the blocks were drawn is followed.

Second, the order in which equations are executed can be manually changed, as outlined here.

Third, automatic sorting can be set in preferences, as outlined here. It is enabled by default and means that an algorithm is 
implemented to give best results and quickest performance, For example, the block with the fastest execution time is 
entered first in the FlexLogic. When two block functions have the same execution time the block drawn first displays first in 
the FlexLogic. For example, drawing input 61 to output 61, then input 62 to output 62 causes the input/output 61 to be 
entered into the FlexLogic first. Automatic sorting takes precedence over manual sort; if you enable this option, manual 
sorting is not implemented.

To manually change logic order:

1. In the compile area, click the VO Order tab.

2. If the window is blank, click the Refresh button.

3. Select an entry and click the up or down arrow. To cancel any manual changes, click the Sort or Refresh button.

4. Recompile. The change is not executed or saved if automatic sorting is enabled.

Figure 4-82: Ordering FlexLogic entries

To set automatic sorting:

1. In Engineer, under File > Preferences, select the Compiler option. The Automatically Sort VOs option means that the 
block with the fastest execution time is entered first in the FlexLogic. When two block functions have the same 
execution time the block drawn first displays first in the FlexLogic. For example, drawing input 61 to output 61, then 
input 62 to output 62 causes the input/output 61 to be entered into the FlexLogic first.

4.4.1.9  Search logic
Items that can be searched in a logic diagram include gates, Input, Contact Input, Contact Output, Timer, Virtual Output, 
Tag In, Tag Out, and User-programmable LED. A search can be performed while designing or monitoring.

1. In the compiler area of Engineer, click the Search tab.

2. Use one of the following methods to set search criteria:

– Select an element from the first drop-down list. Results display automatically.

– Type in the second text string box, or select any of the 32 previous searches from the drop-down list. Click the 
Search button. Any results display.

The search applies to all tabs, not just the active tab.

3. Double-click a search result to view the item.

Figure 4-83: Search function
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4.4.1.10  Exclude sheet from compile
While designing the FlexLogic equations, entire sheets can be removed from the compile logic. This allows the user to test 
various schemes by placing schemes on separate sheets and including either sheet at compile time.

1. In the Logic Designer window, right-click the tab and select the Exclude from Compile option so that the check mark 
displays. When sheets are excluded, a message displays with each compile that "excluded sheets will not be reflected 
in the RPN." An excluded sheet is denoted with end brackets, similar to < Sheet 1 >.

Figure 4-84: Excluding a tab from compiling

Figure 4-85: Tab excluded from compiling

4.4.2  Send file to and from device
With the logic diagram created, compiled, and errors eliminated, the FlexLogic can be sent to a live device. And, 
conversely, a file from a live device can be added to the Offline Window area for additional work.

To send a file to a device:

1. In the Offline Window area of the software, right-click the device name and select the Write Settings to Device option. 
A prompt can appear that the URS file has been repaired; acknowledge the message.

2. When a window opens, select the device to which you want to send the file, then click the Send button and confirm. 
The order codes and IEC 61850 edition must match. The file is sent to the live device. Any errors can be viewed in the 
log file at the prompt.

To import a file from a device:

1. Close all open files in Engineer that relate to the device, else a message displays to that effect, for example to close 
the FlexLogic view associated with the file. When the file is not associated with a live device, a message displays to 
that effect; you need to identify the device to which you want to send the file. The order codes must match.

2. Right-click the device in the Online Window area and select the Add Device to Offline Window option. After you enter 
a name for the file, it is written to the Offline Window area.

You can also select an element from the drop-down list on the toolbar. It is then highlighted in the logic diagram.
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4.4.3  Monitor logic
After creating the logic diagram, validating it, and uploading the FlexLogic to a device, the results from the device can be 
viewed.

The following checks are performed automatically when switching from design to monitoring, and prompts display when 
necessary:

• Verify that the order code of the linked relay matches the settings file

• Verify that the version of the linked relay matches the settings file

• Verify that the FlexLogic Equation Editor of the linked relay matches the settings file. Solution: Compile the FlexLogic 
logic diagram and send the settings file to the relay.

• Verify that the FlexLogic Timers of the linked relay match the settings file. Solution: Compile the FlexLogic logic 
diagram and send the settings file to the relay.

• If the settings file contains a serial number lock, then verify that the serial number of the linked relay matches the 
settings file

To view results:

1. In the Offline Window area of the software, expand the Engineer entry for the device.

2. Double-click the Logic Designer entry and Compile the logic.

3. Double-click the Logic Monitor entry, or click the M button in the toolbar at the top of the window. With successful 
launch, the logic displays and a green indicator displays at the bottom of the tab.

When the file is not associated with a live device, a message displays to that effect; you need to identify the device to 
which you want to send the file. The order codes must match between the Offline Window and the Online Window.

When the device is offline, a message indicates problems communicating with the device.

When the devices are not synchronized, a message indicates the FlexLogic does not match the settings file. To send 
the offline file to the device, right-click the device name and select the Write Settings to Device option.

When the state of a symbol is OFF, the symbol is shown in the default color or no color.

When a symbol's state changes to ON, the symbol and connection line turns green.

The state of some symbols can either be unknown or the state transitions faster than the update interval. For these 
two cases, the state of the symbol is considered 'UNKNOWN' and the symbol is outlined in red.

The colors for the ON and Unknown state can be customized in the Preferences.

The figure shows that the software is communicating with devices (square green indicator) and that a minor error is 
present (green box outline). In this case, the battery is weak and needs to be replaced. This can be viewed as the 
Replace Battery message on the front panel of the device and in the EnerVista software under Actual Values > Front 
Panel > Front Panel or Display/Keypad.

Figure 4-86: Monitoring a device, with minor error caused by weak battery
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4.4.4  View front panel and print labels
This window displays the LEDs that are on the front panel. You can create labels and print them for the device. You do not 
use the window to add text labels and upload them to the device. Custom labelling is also outlined earlier in this chapter; 
see the Front Panel Labelling section.

To view the front panel:

1. In the Offline Window area of the software, expand the Engineer entry for the device.

2. Double-click the Front Panel Report entry. The report displays. The Device Summary is read from the settings file and 
cannot be changed. The LEDs and pushbuttons display below the summary.

3. To save the report, click File > Save As, enter a file name, and select the front panel report (FPR), JPG, or PDF format.

Figure 4-87: Front panel display in Engineer

To print labels:

1. In the Front Panel Report window, double-click an LED or pushbutton and enter text.

2. To print the labels, click the Print icon on the toolbar.

3. To save the report and labels, click File > Save As, enter a file name, and select the FPR, JPG, or PDF format.

4. Use the instructions in the second tab of the window to add the labels to the physical device.

4.4.5  Generate connectivity report
This report displays basic information about a device, such as order code, port numbers, inputs and outputs. You can use it 
to create a PDF file of basic information. The report is based on CID and/or IID files, and not the system or full SCD. All 
device details including Remote Inputs, Remote Outputs, and Analog Inputs/Outputs are indicated, including quantities 
used and available.

To display a device report:

1. In the Offline Window area of the software, expand the Engineer entry for the device.

2. Double-click the Device Connectivity Report entry. The report displays.

3. To save as a PDF file, click File > Save As.
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Figure 4-88: Device Connectivity Report

4.4.6  Preferences
Preferences determine functionality. As such, you are encouraged to review them. This section outlines some options 
available in the menus and preference panels.

Access them in the Logic Designer panel under the View menu and under File > Preferences. The Logic Designer and 
Logic Monitor preferences are outlined here, not all preferences for a device.

4.4.6.1  View menu
View > Toolbar > Advanced Actions — Active when in Logic Designer. Toggles a toolbar to nudge, rotate, flip, or change 
the order of an element.

View > Show Unused Pins — Enable to display unconnected pins. Disable to eliminate unconnected pins from the view, for 
example when printing.

Figure 4-89: Unused pins on and off

4.4.6.2  Logic designer
The path is File > Preferences > Logic Designer.
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Workbook Setup

Size and Units

Size and Units — Changes the size of diagram area displayed in Engineer. If you set the size to be smaller than an existing 
logic diagram, the content is cut off.

WorkBook

Print Scale — The scale for logic diagram when printing. Scaling a large diagram to 200 percent, for example, results in the 
diagram being cut off.

Orphan Protection — When enabled, the printing output prevents Virtual Output circuits from spanning more than a single 
page. The largest Virtual Output circuit is scaled to fit on a single page and all remaining Virtual Output circuits are scaled 
so that all circuits are printed using the same scale.

Show Title Block — When enabled, places an information box at the bottom right of the diagram when printing. Enter the 
information in the File Information panel.

Show Sheet Name — When enabled, shows Sheet 1, Sheet 2, or any other name at the top of the logic diagram when 
printing.

Start Sheet On New Page — Places the sheet on the next page when printing.

Show Notes Selection — When other than None, prints the text from any information notes added to the document (under 
Drawing Tools tab > Note). The text is printed after the logic diagram.

File Information

The text entered here displays at the bottom right of a diagram when printing, provided that the Show Title Block option is 
enabled. Note the option to change the logo from the GE logo to your company logo.

Display
The panel sets how the element boxes display. The figure shows how an AND gate displays when the UR default, IEC, or 
ISO symbol type is selected.

Figure 4-90: AND gate varies by standard selected

Symbol Style — IEC, ISO, UR Setup — Sets how the gates display in the logic diagram.

Symbol Color — When set to Black & White, only logic blocks with issues continue to display red.

Zoom Operation — Determines what happens when the View > Zoom functions are used. When set to Sheet Only and the 
zoom is changed, the single tab changes. When set to Workbook, all tabs change.

Editor
Repeat Symbol — Enable this feature to add element blocks rapidly in sequence, for example when you have inputs 1 to 
10, without having to select the element each time. Select the element block from the toolbox, click the diagram, then 
continue to click to add additional blocks.

Use first available VO / Timer — When enabled and you copy and paste a virtual output or timer element, the numbering 
continues in sequence. For example, you copy timer 5 and paste it as timer 6. When disabled and you copy and paste a 
virtual output or timer element, the same number is used. For example, you copy timer 5 and paste it as timer 5.

Auto-Save Logic Designer every x minutes — Logic diagrams with changes are saved automatically according to this 
interval. The range is 5 minutes (default) to 30 minutes. With auto-save, the file extension of the saved file is .auto. This file 
remains until you save the file manually.
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Auto Populate
These options work in the Edit > Auto Populate Workbook function.

VOs per Worksheet — When an existing settings file is opened in the Logic Designer, the Logic Designer populates the 
canvas and attempts to evenly distribute the Virtual Output circuits across multiple sheets. A value of 100 in this setting 
places all FlexLogic equations on a single sheet until there are 100, then the next ones are placed on another sheet. A value 
of 1 places each Virtual Output circuit on a separate sheet.

Show / FlexLogic Merge / Show Unused — If Show Contact Outputs and Show LEDs are selected, for example, the function 
places Contact Output and User-programmable LED symbols for settings that are configured. If you disable the LED check 
boxes, then the LED tab/sheet does not display when you next open the Logic Designer window. The settings apply to all 
products, not just the active window when it is next opened. Close then reopen the Logic Designer window for the setting 
to take effect.

Compiler
Show Warnings — Options to filter the messages that display when logic compiles.

Minor — Enable to display minor errors. An example is using the default values of an element added to the diagram, such 
as the name of the element. An example is "Warning: Virtual output xx using default name," for which you simply click into 
the element to rename it.

Major — Enable to display major errors. Examples are an input that does not have a corresponding output, using disabled 
features, and failing to connect a symbol. Fix these errors.

Setting — Enable to display error message related to settings, such as an improperly configured setting, such as using ON 
or OFF.

Automatically Sort VOs — When enabled, the logic is compiled with an algorithm to give best results and quickest 
performance, for example the fastest logic first. The fastest logic displays in the FlexLogic Equation Editor output as the 
first entries in the table. Use sorting when virtual outputs have dependencies on other virtual outputs. This setting takes 
precedence over order set manually in the VO Order tab in the compiler.
When disabled, the sequence in which the blocks were drawn is followed.

Optimize Compiled Output — With this option enabled, the software automatically optimizes a logic diagram to reduce 
space and free up FlexLogic entries. Run the compiler again, for example by clicking the Compile button at the bottom left 
of the software. The number of saved lines displays in the Optimization Summary. Changes also display when the FlexLogic 
Equation Editor is accessed. The logic diagram does not change.

4.4.6.3  Logic monitor

Display
The software displays the color specified when an element is on. There is no color when the element is off.

The software displays another color when the status cannot be determined and is unknown.

Timing
Timing Information can be displayed in the monitoring window. This timing information is only an approximate 
representation of how Engineer sees transitions. Use the device's Event Record to view accurate timing information.

The timing information can also be streamed to a comma-separated values (CSV) spreadsheet.

The timing information displayed and recorded can be filtered based on six categories. If a category is not selected, any 
timing information related to that category does not display and is not recorded to the CSV file.

Show Timing Information in Output Window — Enable to display times in the monitoring window.

Because of the update rate of the Logic Monitoring, the timing information cannot be used as an accurate representation 
of the events that occur within the relay. Use instead the device's event record. Timing information can be delayed by 30 
seconds.
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Save Timing Information to CSV File — Enable to write timing information in a spreadsheet. The timing information is 
recorded in a text file that uses commas to separate each of the fields. This file uses the extension CSV that is supported by 
any spreadsheet application.

Every change written to the CSV file requires a timestamp.

The format for the timing information in the output window is as follows:

yyyy/mm/dd hh:dd:ss

   devicename offline

yyyy/mm/dd hh:dd:ss

   devicename ONLINE

yyyy/mm/dd hh:dd:ss

   VO1: Virt Out 1- 0

   VI4: Virt In 4- 1

   DI3: Direct In 3- 0

   RI2: Remote In 2- 1

   H5a: Contact In 1- 1

   H1: Contact Output 1- 0

Data is only appended to the CSV file. The format for the data is as follows:

yyyy/mm/dd hh:dd:ss, devicename, offline

yyyy/mm/dd hh:dd:ss, devicename, ONLINE

yyyy/mm/dd hh:dd:ss, VO1: Virt Out 1, 0

yyyy/mm/dd hh:dd:ss, VI4: Virt In 4, 1

yyyy/mm/dd hh:dd:ss, DI3: Direct In 3, 0

yyyy/mm/dd hh:dd:ss, RI2: Remote In 2, 1

yyyy/mm/dd hh:dd:ss, H5a: Contact In 1, 1

yyyy/mm/dd hh:dd:ss, H1: Contact Output 1, 0

Options display for filtering, such as recording timing for Virtual Inputs and Outputs, but not Communications Status.

4.4.6.4  COMTRADE waveforms
Waveform files are viewable in the EnerVista software. The preferences are unrelated to Engineer and are outlined in the 
UR Family Communications Guide.

4.4.7  Toolbars
These are toggled in the View > Toolbar menu.

The UR symbols are displayed for the toolbox icons. They change when the default setting is changed to IEC or ISO 
symbols. The symbols displayed in the toolbox also vary by firmware version, reflecting what is supported for each release.

4.4.7.1  FlexLogic Editor toolbar

New Device Create a new settings file
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4.4.7.2  Token Toolbox

Drawing Tools

Open File Open an existing settings file in the URS, CID, or IID format

Save FlexLogic Save the Logic Designer diagram

PDF Report Create a PDF document from Logic Designer diagram(s). Settings can be 
changed under File > Preferences > Workbook Setup.

Toggle Compile Window Display or hide the compile window area

Sort Order Select to change the sort order of the Virtual Output list to the right of the 
icon. Virtual Outputs can be sorted numerically in ascending and 
descending order based on numbers and names.

Select VO to View (x - x) Select a Virtual Output to locate and select it in the workbook. Each Virtual 
Output listed also contains the name of the sheet where the Virtual Output 
is located.

Edit Mode
Logic Designer

Switch to Logic Designer mode

Monitor Mode
Logic Monitor

Switch to Logic Monitor mode

Turn On ALL Communications Turn on all communications to all Logic Designer diagrams that are in the 
monitoring mode. Default upon each launch of Engineer.

Turn Off All Communications Turn off all communications to all Logic Designer diagrams that are in the 
monitoring mode. This is a legacy function for serial communication to turn 
off communication to devices. Turning off communication applies to the 
current session only. When you re-launch the EnerVista software, 
communication is on by default.

Draw a line. Click and drag to draw.

Draw multiple joined lines. Click and drag for each line. Double-click to finish.

Draw multi-sided object. Click for each line. Double-click to finish.

Draw four-sided object. Click and drag to draw.

Draw multiple curves. Click for each line. Double-click to finish.

Draw multiple, closed curves. Click for each line. Double-click to finish.
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I/O Tokens
These are parts used in FlexLogic equations. They are the inputs and outputs of the Virtual Output equations. The display 
can vary from that shown here.

Draw oval or circle. Click and drag to draw.

Add text box with rectangle around it. Click to add. Double-click it to change text.

Add figure. Select file in the window that opens, then click on diagram canvas to add figure.

Add note icon and text. Click to add. Double-click to edit the title and text.

Input symbol that can be configured to any FlexLogic operand value

Remote inputs from other devices

Input from another UR device. Teleprotection inputs/outputs and direct inputs/outputs are mutually exclusive and 
cannot be used simultaneously.

Teleprotection inputs/outputs and direct inputs/outputs are mutually exclusive and cannot be used simultaneously.

FlexAnalog symbol that can be used as the input to a FlexElement or use the FlexAnalog symbol to monitor an actual 
value when in logic Monitoring mode

Contact Input Gate is similar to the Input symbol but is restricted to the operands associated with a Contact Input

Contact Output Gate is similar to the Input symbol but is restricted to the operands associated with a Contact Output. 
The Operate and Seal-In settings can be configured graphically.
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Boolean Tokens
These symbols are used to create FlexLogic Equations. Use them as intermediate logic for the Virtual Output equations. 
The display can vary from that shown here.

The Non-Volatile Latch is similar to the Input symbol but is restricted to the operands associated with a Non-Volatile 
Latch. The Set and Reset settings can be configured graphically.

The final output of an equation is a numbered register called a virtual output. Virtual outputs can be used as an input 
operand in any equation, including the equation that generates the output, as a seal-in or other type of feedback.

Place and configure a Remote Output. The UR's order code and firmware version then determine the availability of the 
Remote Output.

Place and configure a Direct Output. The UR's order code and firmware version then determine the availability of the 
Direct Output to another UR device.

Place and configure a Teleprotection Output. The UR's order code and firmware version then determine the availability 
of the Teleprotection Output.

Place a User Programmable LED in the Logic Designer diagram. Not applicable when using a graphical front panel.

A Tag Out can be used in 1 of 2 ways. The first use of the Tag Out is to break up logic that needs to span several sheets. 
The second use of the Tag Out is to associate a frequently used block of code with the Tag Out and then repeatedly use 
the same block of code using a Tag In. When a Tag Out is referenced more than once, the Tag Out is replaced with a 
Virtual Output during the compile phase.

 Tag-In can is used to reference an existing Tag-Out. It joins another diagram to a previous diagram.

Place an OR gate in the Logic Designer diagram. Only one action needs to occur. Any function input on the left side 
satisfies the condition.
The number of inputs is configurable from two to 16.

Place an AND gate in the Logic Designer diagram. Multiple actions need to occur. All functions input on the left side are 
required to satisfy the condition.
The number of inputs is configurable from two to 16.

Place a NOR gate in the Logic Designer diagram. Gives the value of one when all input operands have a value of zero 
and otherwise gives a value of zero. It gives an output signal when there are no input signals. An inverter that reverses 
the logic state.
The number of inputs is configurable from two to 16.
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Elements
These blocks configure properties of the element or use element operands as input to FlexLogic equations.

Place a NAND gate in the Logic Designer diagram. Gives the value of zero when all input operands have a value of one 
and otherwise gives a value of one. It gives an output signal until all signals are present on its inputs. An inverter that 
reverses the logic state.
The number of inputs is configurable from two to 16.

Place a XOR gate in the Logic Designer diagram, which is two exclusive OR gates. Only one action needs to occur. If 
there are two inputs or there is no input, there is no output.

Place a NOT gate in the Logic Designer diagram. Gives the value of one when the input operand has a value of zero and 
otherwise gives a value of zero. It gives an output signal when there is no input signal. An inverter that reverses the 
logic state.

Place a latch in the Logic Designer diagram. A latch has two inputs and one output. One input is the Set input, and 
other input is the Reset input.

Place a positive one shot symbol that responds to a positive going edge in the Logic Designer diagram. A "one shot" is a 
single input gate that generates a pulse ins response to an edge on the input.

Place a negative one shot symbol that responds to a negative going edge in the Logic Designer diagram

Place a positive one shot and a negative one shot symbol in the Logic Designer diagram

Place a timer in the Logic Designer diagram

Place and configure a FlexElement. A FlexElement is a universal comparator used to monitor any analog actual value 
calculated by the relay or a net difference of any two analog actual values of the same type.

Place and configure the Settings Group settings

Place and configure a Selector Switch element. Firmware version determines feature availability. The Selector Switch 
element is intended to replace a mechanical selector switch. Typical applications include setting group
control or control of multiple logic sub-circuits in user-programmable logic. The element provides for two control inputs.
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4.4.7.3  Basic Actions toolbar

4.4.7.4  Advanced Actions toolbar

Only basic objects (lines, rectangles, ellipses) can be rotated and flipped.

Only objects from the Drawing Toolbar can be structured (grouped, ungrouped, forward, backward).

Place and configure a Digital Element. A Digital Element can monitor any FlexLogic operand
and present a target message and/or enable events recording depending on the output operand state.

Place and configure a Digital Counter element. A Digital Counter counts the number of state transitions
from Logic 0 to Logic 1. The counter is used to count operations such as the pickups of an element.

Select Select components. Click one component and hold down the CTRL key to select others. 
Or click and drag an area that contains multiple components to select.

Edit Vertices Shows vertices points for the component selected (if the component support vertices 
manipulation)

Properties Shows the properties of the selected component

Zoom Normal Zoom in and center the screen to the spot selected

Zoom to Fit Zoom in to a magnitude that fits your entire schema layout on your entire screen

Zoom Custom Zoom in on the components that you have selected

Pan Move the viewable area of your screen around the schema. To activate, select this tool 
and then place the hand icon over and part of your schema. Click and drag the hand in 
a direction to move around the schema.

Align Top, Middle, Bottom Align the selected components to the top, middle, or bottom of the reference 
component

Align Left, Center, Right Align the selected components to the left, middle, or right of the reference component

Space Across Evenly space the selected components across a horizontal axis, starting from the far 
left component and ending at the far right component

Space Down Evenly space the selected components across a vertical axis, starting from the top 
component and ending at the bottom component

Same Width Set the width of the selected components to the same width as the reference 
component

Same Height Set the height of the selected components to the same height as the reference 
component

Same Size Set the width and height of the selected components to the same width and height of 
the reference component

Nudge Up, Down, Left, Right Moves selected component one pixel upward, downward, left, right
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Rotate Rotates selected component freely. Once selected, put your mouse cursor over the 
component and move the component clockwise or counter-clockwise depending on 
what you need.

Rotate Left, Right Rotates selected component 90 degrees counter-clockwise or clockwise

Flip Vertical Flips the selected component on the vertical axis

Flip Horizontal Flips the selected component on the horizontal axis

Group, Ungroup Combines all selected components into one combined entity. Ungroups them into 
separate components.

Front, Back Moves current components to the absolute front or back of all viewable layers

Forward, Backward Moves current components on layer higher or lower than its original layer hierarchy
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F60 Feeder Protection System

Chapter 5: Settings

Settings

This chapter outlines front panel and/or software settings. The relay is not taken out of service when saving settings; the 
relay is taken out of service when a settings file is written to it.

Settings can be viewed remotely in a web browser by entering the IP address of the relay, accessing the Device 
Information Menu option, then the Front-Panel Display Report option.

When indicated that a restart is required for a setting change to take effect, use the Maintenance > Reboot Relay 
Command in the software.

Settings file conversion from previous firmware versions is supported. See the Maintenance chapter.

5.1  Settings menu

 SETTINGS
 PRODUCT SETUP   SECURITY

 
See page 5-8

   DISPLAY
 PROPERTIES

See page 5-26

  GRAPHICAL FRONT PANEL
 

Access in EnerVista
See page 5-28

  CLEAR RELAY
 RECORDS

See page 5-40

  COMMUNICATIONS
 

See page 5-41

  MODBUS USER MAP
 

See page 5-111

  REAL TIME
 CLOCK

See page 5-112

  FAULT REPORTS
 

See page 5-117

  OSCILLOGRAPHY
 

See page 5-119
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  DATA LOGGER
 

See page 5-121

  DEMAND
 

See page 5-123

  USER-PROGRAMMABLE
 LEDS

See page 5-124

  USER-PROGRAMMABLE
 SELF TESTS

See page 5-128

  CONTROL
 PUSHBUTTONS

See page 5-129

  USER-PROGRAMMABLE
 PUSHBUTTONS

See page 5-131

  FLEX STATE
 PARAMETERS

See page 5-137

  USER-DEFINABLE
 DISPLAYS

See page 5-138

  DIRECT I/O
 

See page 5-140

  TELEPROTECTION
 

See page 5-146

   INSTALLATION
 

See page 5-147

 REMOTE RESOURCES
   

 
Access in EnerVista
See page 5-148

 SETTINGS
 SYSTEM SETUP   AC INPUTS

 
See page 5-149

   POWER SYSTEM
 

See page 5-150

  SIGNAL SOURCES
 

See page 5-151

  BREAKERS
 

See page 5-154

  SWITCHES
 

See page 5-159

  FLEXCURVES
 

See page 5-164

   PHASOR MEASUREMENT
 UNIT

See page 5-171

 PROCESS BUS
 MODULE   GENERAL

 
Access in EnerVista
See page 5-192

   TIME SYNC
 

See page 5-199

   SV STREAM CONFIG
 

Access in EnerVista
See page 5-199

 SETTINGS
 FLEXLOGIC   FLEXLOGIC

 EQUATION EDITOR
See page 5-231

   FLEXLOGIC
 TIMERS

See page 5-231
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  FLEXELEMENTS
 

See page 5-231

   NON-VOLATILE
 LATCHES

See page 5-235

 SETTINGS
 GROUPED ELEMENTS   SETTING GROUP 1

 
See page 5-236

   SETTING GROUP 2
 

  SETTING GROUP 3
 

  SETTING GROUP 4
 

  SETTING GROUP 5
 

   SETTING GROUP 6
 

 SETTINGS
 CONTROL ELEMENTS   TRIP BUS

 
See page 5-296

   SETTING GROUPS
 

See page 5-298

  SELECTOR SWITCH
 

See page 5-300

  UNDERFREQUENCY
 

See page 5-307

  OVERFREQUENCY
 

See page 5-308

  FREQUENCY RATE
 OF CHANGE

See page 5-309

  SYNCHROCHECK
 

See page 5-311

  AUTORECLOSE
 

See page 5-316

  DIGITAL ELEMENTS
 

See page 5-322

  DIGITAL COUNTERS
 

See page 5-325

  MONITORING
 ELEMENTS

See page 5-327

  COLD LOAD PICKUP
 

See page 5-355

   PILOT SCHEMES
 

See page 5-356

 SETTINGS
 INPUTS / OUTPUTS   CONTACT INPUTS

 
See page 5-361

   VIRTUAL INPUTS
 

See page 5-363

  CONTACT OUTPUTS
 

See page 5-364
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5.2  Overview

5.2.1  Introduction to elements
For URs, the term element is used to describe a feature that is based around a comparator. The comparator is provided 
with an input (or set of inputs) that is tested against a programmed setting (or group of settings) to determine if the input is 
within the defined range that sets the output to logic 1, also referred to as setting the flag. A single comparator can make 
multiple tests and provide multiple outputs. For example, the time overcurrent comparator sets a pickup flag when the 
current input is above the setting and sets an operate flag when the input current has been at a level above the pickup 
setting for the time specified by the time-current curve settings. All comparators use analog actual values as the input.

Elements are arranged into two classes, grouped and control. Each element classed as a grouped element is provided with 
six alternate sets of settings, in setting groups numbered 1 through 6. The performance of a grouped element is defined by 
the setting group that is active at a given time. The performance of a control element is independent of the selected active 
setting group.

  VIRTUAL OUTPUTS
 

See page 5-368

  RESETTING
 

See page 5-368

  DIRECT INPUTS
 

See page 5-369

  DIRECT OUTPUTS
 

See page 5-369

   TELEPROTECTION
 

See page 5-373

 SETTINGS
 TRANSDUCER I/O   DCMA INPUTS

 
See page 5-375

   RTD INPUTS
 

See page 5-376

   DCMA OUTPUTS
 

See page 5-377

 SETTINGS
 TESTING  TEST MODE

FUNCTION: Disabled
See page 5-381

  TEST MODE FORCING:
On

See page 5-381

  PMU
 TEST VALUES

See page 5-382

  FORCE CONTACT
 INPUTS

See page 5-383

   FORCE CONTACT
 OUTPUTS

See page 5-384

 SETTINGS
 SIMULATION   GOOSE & SV

 
See page 5-384

An exception to this rule is digital elements, which use logic states as inputs.
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The main characteristics of an element are shown on a logic diagram. This includes the inputs, settings, fixed logic, and the 
output operands generated. The previous chapter explains how to read a logic diagram, and the abbreviations used in a 
diagram are defined in the Abbreviations chapter.

Some settings are specified in per-unit (pu) calculated quantities:

pu quantity = (actual quantity) / (base quantity)

Where the current source is from a single current transformer (CT), the base quantity is the nominal secondary or primary 
current of the CT. Use the secondary current base to convert per-unit settings to/from a secondary current value, and use 
the primary current base to convert to/from a primary current value.

Where the current source is the sum of two or more CTs with different nominal primary current, the primary base quantity 
is the largest nominal primary current. For example, if CT1 = 300 / 5 A and CT2 = 100 / 1 A, then in order to sum these, CT2 
is scaled to the CT1 ratio. In this case, the base quantity is 300 A primary, 5 A secondary for CT1, and 300/(100/1) = 3 A 
secondary for CT2.

For voltage elements, the primary base quantity is the nominal phase-to-phase primary voltage of the protected system 
provided that the VT ratio setting is set to the nominal ratio of the VTs and the secondary voltage setting is set to the 
phase-to-phase voltage seen by the relay when the voltage of the protected system in nominal. The UR uses the 
convention that nominal voltages in a three-phase system are phase-to-phase voltages.

For example, on a system with a 13.8 kV nominal primary voltage, the base quantity is 13800 V. With 14400:120 V delta-
connected VTs, the secondary base quantity and secondary voltage setting is:

Eq. 5-1

For wye-connected VTs, the primary and secondary base quantities are as before, but the secondary voltage setting (here
a phase-to-ground value) is:

Eq. 5-2

Some settings are common to many elements, outlined as follows:

• FUNCTION setting — This setting programs the element to operate when selected as “Enabled.” The factory default is 
“Disabled.” Once “Enabled,” any element associated with the function becomes active and all options become 
available.

• NAME setting — This setting is used to uniquely identify the element.

• SOURCE setting — This setting is used to select the AC source to be monitored. See the Introduction to AC Sources 
section later.

• PICKUP setting — For simple elements, this setting is used to program the level of the measured parameter above or 
below which the pickup state is established. In more complex elements, a set of settings can be provided to define the 
range of the measured parameters that cause the element to pick up.

• PICKUP DELAY setting — This setting sets a time-delay-on-pickup, or on-delay, for the duration between the pickup 
and operate output states.

• RESET DELAY setting — This setting is used to set a time-delay-on-dropout, or off-delay, for the duration between the 
operate output state and the return to logic 0 after the input transits outside the defined pickup range.

• BLOCK setting — The default output operand state of all comparators is a logic 0 or “flag not set.” The comparator 
remains in this default state until a logic 1 is asserted at the RUN input, allowing the test to be performed. If the RUN 
input changes to logic 0 at any time, the comparator returns to the default state. The RUN input is used to supervise 
the comparator. The BLOCK input is used as one of the inputs to RUN control.

• TARGET setting — This setting is used to define the operation of an element target message. When set to "Disabled," 
no target message or illumination of a front panel LED indicator is issued upon operation of the element. When set to 
“Self-Reset,” the target message and LED indication follow the operate state of the element and self-resets once the 
operate element condition clears. When set to “Latched,” the target message and LED indication remains visible after 
the element output returns to logic 0 until a RESET command is received by the relay.

13800
14400
-------------- 120 115 V=

13800
14400
-------------- 120

3
-------- 66.4 V=
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• EVENTS setting — This setting is used to control whether the pickup, dropout, or operate states are recorded by the 
event recorder. When set to “Disabled,” element pickup, dropout, or operate are not recorded as events. When set to 
“Enabled,” events are created for

<Element> PKP (pickup)
<Element> DPO (dropout)
<Element> OP (operate)

The DPO event is created when the measure and decide comparator output transits from the pickup state (logic 1) to 
the dropout state (logic 0). This can happen when the element is in the operate state if the reset delay time is not zero.

Not every operand of a given element in a UR relay generates events, only the major output operands. Elements, 
asserting output per phase, log operating phase output only, without asserting the common three-phase operand 
event.

5.2.2  Introduction to AC sources

5.2.2.1  Background
A mechanism called a source configures the routing of CT and VT input channels to measurement sub-systems. Sources, in 
the context of UR series relays, refer to the logical grouping of current and voltage signals such that one source contains all 
the signals required to measure the load or fault in a particular power apparatus. A given source can contain all or some of 
the following signals: three-phase currents, single-phase ground current, three-phase voltages, and an auxiliary voltage 
from a single VT for checking for synchronism.

The basic idea of an AC source is to select a point on the power system where the voltages and currents are of interest. To 
illustrate the concept of sources, as applied to current inputs only, consider the breaker-and-a-half scheme that follows. 
(The breaker-and-a-half scheme is used for illustrative purposes and is available on select UR products.) In this application, 
the current flows as shown by the arrows. Some current flows through the upper bus bar to some other location or power 
equipment, and some current flows into transformer winding 1. The current into winding 1 is the phasor sum (or difference) 
of the currents in CT1 and CT2 (whether the sum or difference is used depends on the relative polarity of the CT 
connections). The same considerations apply to transformer winding 2. The protection elements require access to the net 
current for transformer protection, but some elements can need access to the individual currents from CT1 and CT2.

Figure 5-1: Breaker-and-a-half scheme 
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In conventional analog or electronic relays, the sum of the currents is obtained from an appropriate external connection of 
all CTs through which any portion of the current for the element being protected can flow. Auxiliary CTs are required to 
perform ratio matching if the ratios of the primary CTs to be summed are not identical. In the UR series of relays, provisions 
have been included for all the current signals to be brought to the UR device where grouping, ratio correction, and 
summation are applied internally via configuration settings.

A major advantage of using internal summation is that the individual currents are available to the protection device, for 
example as additional information to calculate a restraint current, or to allow the provision of additional protection 
features that operate on the individual currents, such as breaker failure.

Given the flexibility of this approach, it becomes necessary to add configuration settings to the platform to allow the user 
to select which sets of CT inputs are to be added to form the net current into the protected device.

The internal grouping of current and voltage signals forms an AC source. This source can be given a specific name through 
the settings and becomes available to protection and metering elements in the UR platform. Individual names can be 
given to each source to help identify them for later use. For example, in the scheme shown in the preceding figure, the user 
configures one source to be the sum of CT1 and CT2 and can name this source as “Wdg1 I.”

Once the sources have been configured, the user has them available as selections for the choice of input signal for the 
protection elements and as metered quantities.

5.2.2.2  CT/VT module configuration
CT and voltage transformer (VT) input channels are contained in CT/VT modules. The type of input channel can be phase/
neutral/other voltage, phase/ground current, or sensitive ground current. The CT/VT modules calculate total waveform 
RMS levels, fundamental frequency phasors, symmetrical components, and harmonics for voltage or current, as allowed 
by the hardware in each channel. These modules can calculate other parameters as directed by the CPU module.

A CT/VT module contains up to eight input channels, numbered 1 through 8. The channel numbering corresponds to the 
module terminal numbering 1 through 8 and is arranged as follows. Channels 1, 2, 3, and 4 are always provided as a group, 
hereafter called a “bank,” and all four are either current or voltage, as are channels 5, 6, 7, and 8. Channels 1, 2, 3 and 5, 6, 
7 are arranged as phase A, B, and C respectively. Channels 4 and 8 are either another current or voltage.

Banks are ordered sequentially from the block of lower-numbered channels to the block of higher-numbered channels, 
and from the CT/VT module with the lowest slot position letter to the module with the highest slot position letter, as follows.

The UR platform allows for a maximum of six sets of three-phase voltages and six sets of three-phase currents. The result 
of these restrictions leads to the maximum number of CT/VT modules in a chassis to three. The maximum number of 
sources is six. A summary of CT/VT module configurations is as follows.

5.2.2.3  CT/VT input channel configuration
Upon relay startup, configuration settings for every bank of current or voltage input channels in the relay are generated 
automatically from the order code. Within each bank, a channel identification label is assigned automatically to each bank 
of channels in a given product. The bank naming convention is based on the physical location of the channels, required by 
the user to know how to connect the relay to external circuits. Bank identification consists of the letter designation of the 
slot in which the CT/VT module is mounted as the first character, followed by numbers indicating the channel, either 1 or 5. 
See the HardFiber instruction manual for designations of HardFiber voltage and current banks.

For three-phase channel sets, the number of the lowest numbered channel identifies the set. For example, F1 represents 
the three-phase channel set of F1/F2/F3, where F is the slot letter and 1 is the first channel of the three channels.

Increasing slot position letter -->

CT/VT module 1 CT/VT module 2 CT/VT module 3

< bank 1 > < bank 3 > < bank 5 >

< bank 2 > < bank 4 > < bank 6 >

Item Maximum number

CT/VT Module 2

CT Bank (3 phase channels, 1 ground channel) 4

VT Bank (3 phase channels, 1 auxiliary channel) 2
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Upon startup, the CPU configures the settings required to characterize the current and voltage inputs, and it displays them 
in the appropriate section in the sequence of the banks (as described earlier) as follows for a maximum configuration: F1, 
F5, M1, M5, U1, and U5. 

5.3  Product setup

5.3.1  Security

5.3.1.1  Security overview
The following security features are available:

• Password security — Basic security present by default

• EnerVista security — Role-based access to various EnerVista software screens and configuration elements. The 
feature is present by default in the EnerVista software.

• CyberSentry security — Advanced security available using a software option. When purchased, the option is enabled 
automatically, and the default Password security and EnerVista security are disabled.

Lost password
If all passwords are lost, recovery is possible by resetting the unit to default values. Note that the relay is reset to default 
values, not just the passwords.

To reset the unit after a lost password:

1. Email GE customer service at multilin.tech@ge.com with the serial number and using a recognizable corporate email 
account. Customer service provides a code to reset the relay to the factory defaults.

2. Enter the reset code on the front panel, under COMMANDS  RELAY MAINTENANCE  SERVICE COMMAND.

3. Change the default password of ChangeMe1# as outlined in the Set Up CyberSentry and Change Default Password 
section at the end of the Installation chapter.

Password requirements
A user account requires an alpha-numeric password that meets the following requirements:

• Password is case-sensitive

• Password cannot contain the user account name or parts of the user account that exceed two consecutive 
characters

• Password must be 8 to 20 characters in length

• Password must contain characters from all of the following categories:

– English uppercase characters (A through Z)

– English lowercase characters (a through z)

– Base 10 digits (0 through 9)

– Non-alphabetic characters (for example, ~, !, @, #, $,%, &)

5.3.1.2  Password security
SETTINGS  PRODUCT SETUP  SECURITY

 SECURITY
  ACCESS LEVEL:

Restricted
Range: Restricted, Command, Setting,
Factory Service (for factory use only)

  CHANGE LOCAL
 PASSWORDS

See page 5-10
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The F60 supports password entry from a local or remote connection.

Local access is defined as access to settings or commands via the front panel. This includes both keypad entry and the 
RS232 port. Remote access is defined as access to settings or commands via any rear communications port. This includes 
both Ethernet and RS485 connections. Any change to the local or remote password enables this functionality.

ACCESS LEVEL — This setting is viewable on the front panel. The Setting and Command passwords can be changed in the 
EnerVista interface.

The "Restricted" option means that settings and commands can be accessed, but there is no access to factory 
configuration. Access automatically reverts to the Restricted level according to the access level timeout setting values. The 
access level is set to Restricted when control power is cycled.

The "Factory Service" level is not available and intended for factory use only.

There are two user security access levels, setting and command, for which you can set a password for each. Use of a 
password for each level controls whether users can enter commands or change settings. Another option is to specify 
setting and/or command access for individual user accounts.

• Setting — Allows the user to make any changes to any of the setting values:

– Change any setting

– Test mode operation

• Command — Restricts the user from making any settings changes, but allows the user to perform the following 
operations:

– Operate the breakers via front panel keypad

– Change the state of virtual inputs

– Clear the event records

– Clear the oscillography records

– Clear fault reports

– Change the date and time

– Clear the breaker arcing current

– Clear energy records

– Clear the data logger

– Clear the user-programmable pushbutton states

When entering a settings or command password via EnerVista or any serial interface, the user must enter the 
corresponding connection password. If the connection is to the back of the F60, use the remote password. If the 
connection is to the RS232 port of the front panel, use the local password.

The local setting and command sessions are initiated by the user through the front panel display and are disabled either by 
the user or by timeout (via the setting and command level access timeout settings). The remote setting and command 
sessions are initiated by the user through the EnerVista software and are disabled either by the user or by timeout.

The state of the session (local or remote, setting or command) determines the state of the following FlexLogic operands:

• ACCESS LOC SETG OFF — Asserted when local setting access is disabled

• ACCESS LOC SETG ON — Asserted when local setting access is enabled

• ACCESS LOC CMND OFF — Asserted when local command access is disabled

• ACCESS LOC CMND ON — Asserted when local command access is enabled

  CHANGE REMOTE
 PASSWORDS

See page 5-10

  AC CESS
 SUPERVISION

See page 5-11

  DUAL PERMISSION
 SECURITY ACCESS

See page 5-12

 PASSWORD ACCESS
EVENTS: Disabled

Range: Disabled, Enabled
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• ACCESS REM SETG OFF — Asserted when remote setting access is disabled

• ACCESS REM SETG ON — Asserted when remote setting access is enabled

• ACCESS REM CMND OFF — Asserted when remote command access is disabled

• ACCESS REM CMND ON — Asserted when remote command access is enabled

PASSWORD ACCESS EVENTS — This setting allows recording of password access events in the event recorder.

Change local passwords
SETTINGS  PRODUCT SETUP  SECURITY  CHANGE LOCAL PASSWORDS

As outlined in the previous section, there are two user security access levels, setting and command. Use of a password for 
each level controls whether users can enter commands or change settings.

Proper password codes are required to enable each access level. When a CHANGE COMMAND PASSWORD or CHANGE 
SETTING PASSWORD setting is programmed to “Yes” via the front panel interface, the following message sequence is 
invoked:

1. ENTER NEW PASSWORD: ____________.

2. VERIFY NEW PASSWORD: ____________.

3. NEW PASSWORD HAS BEEN STORED.

To gain write access to a “Restricted” setting, program the ACCESS LEVEL setting in the main security menu to “Setting” and 
then change the setting, or attempt to change the setting and follow the prompt to enter the programmed password. If the 
password is correctly entered, access is allowed. Access automatically reverts to the “Restricted” level according to the 
access level timeout setting values and when power is cycled.

Change remote passwords
Proper passwords are required to enable each command or setting level access, which are explained in the previous 
section.

SETTINGS  PRODUCT SETUP  SECURITY  CHANGE REMOTE PASSWORDS

To set the command or setting password in EnerVista:

1. In the EnerVista software or from the front panel, navigate to Settings > Product Setup > Security menu item to open 

A command or setting write operation is required to update the state of the remote and local security operands 
listed.

When a setting password or command password is set or updated, user access with a graphical front panel is 
removed. Simply log in again on the graphical front panel.

When the setting password is set or updated, the graphical front panel Access Level displays as Command. This is 
because the graphical front panel is a Modbus client and it does not have automatic access to the password 
change.

 CHANGE LOCAL
 PASSWORDS  CHANGE SETTING

PASSWORD: No
Range: No, Yes

 CHANGE COMMAND
PASSWORD: No

Range: No, Yes

If the setting and command passwords are identical, then this one password allows access to both commands and 
settings.

If a remote connection is established, local passcodes are not visible.

 CHANGE REMOTE
 PASSWORDS  CHANGE SETTING

PASSWORD: No
Range: No, Yes

 CHANGE COMMAND
PASSWORD: No

Range: No, Yes
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the remote password settings window.

2. Click the command or setting password Change button.

3. Enter the new password in the New Password field. Requirements are outlined in the Password Requirements section 
earlier in this chapter. When an original password has already been used, enter it in the Enter Password field and click 
the Send Password to Device button.

4. Re-enter the password in the Confirm Password field.

5. Click the OK button. The password is checked to ensure that it meets requirements.

Access supervision
SETTINGS  PRODUCT SETUP  SECURITY  ACCESS SUPERVISION

This menu displays when the ACCESS LEVEL setting is other than Restricted or Command.

The following access supervision settings are available.

INVALID ATTEMPTS BEFORE LOCKOUT — This setting specifies the number of times that an incorrect password can be entered 
within a three-minute time span before lockout occurs. When lockout occurs, the LOCAL ACCESS DENIED or REMOTE ACCESS 
DENIED FlexLogic operands are set to “On.” These operands are returned to the “Off” state upon expiration of the lockout.

PASSWORD LOCKOUT DURATION — This setting specifies the time that the F60 locks out password access after the number 
of invalid password entries specified by the INVALID ATTEMPTS BEFORE LOCKOUT setting has occurred.

The F60 provides a means to raise an alarm upon failed password entry. If password verification fails while accessing a 
password-protected level of the relay (either settings or commands), the UNAUTHORIZED ACCESS FlexLogic operand is 
asserted. The operand can be programmed to raise an alarm via contact outputs or communications. This feature can be 
used to protect against both unauthorized and accidental access attempts.

The UNAUTHORIZED ACCESS operand is reset with the COMMANDS  CLEAR RECORDS  RESET UNAUTHORIZED ALARMS 
command. Therefore, to apply this feature with security, password-protect the Command level. The operand does not 
generate events or targets.

If events or targets are required, the UNAUTHORIZED ACCESS operand can be assigned to a digital element programmed with 
event logs or targets enabled.

The following table outlines access level timeout settings.

If you establish a local (serial) connection to the relay, you cannot view remote passcodes.

 ACCESS
 SUPERVISION   ACCESS LEVEL

 TIMEOUTS
See below

 INVALID ATTEMPTS
BEFORE LOCKOUT: 3

Range: 2 to 5 in steps of 1

 PASSWORD LOCKOUT
DURATION: 5 min

Range: 5 to 60 minutes in steps of 1
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SETTINGS  PRODUCT SETUP  SECURITY  ACCESS SUPERVISION  ACCESS LEVEL TIMEOUTS

These settings allow the user to specify the length of inactivity required before returning to the Restricted access level. 
Note that the access level is set to Restricted when control power is cycled.

COMMAND LEVEL ACCESS TIMEOUT — This setting specifies the length of inactivity (no local or remote access) required to 
return to Restricted access from the Command password level.

SETTING LEVEL ACCESS TIMEOUT — This setting specifies the length of inactivity (no local or remote access) required to return 
to Restricted access from the Command password level.

Dual-permission security access
SETTINGS  PRODUCT SETUP  SECURITY  DUAL PERMISSION SECURITY ACCESS

This menu displays when the ACCESS LEVEL setting is other than Restricted or Command.

This feature provides a mechanism to prevent unauthorized or unintended upload of settings to a relay through the local 
or remote interface.

The following settings are available through the local (front panel) interface only.

• LOCAL SETTING AUTH — This setting is used for local (front panel or RS232 interface) setting access supervision. Valid 
values for the FlexLogic operands are either “On” (default) or any physical “Contact Input ~~ On” value.

If this setting is “On,“ then local setting access functions as normal; that is, a local setting password is required. If this 
setting is any contact input on FlexLogic operand, then the operand must be asserted (on) prior to providing the local 
setting password to gain setting access.

If setting access is not authorized for local operation (front panel or RS232 interface) and the user attempts to obtain 
setting access, then the UNAUTHORIZED ACCESS message displays on the front panel.

If this setting is "Off," firmware upgrades are blocked. If this setting is "On," firmware upgrades are allowed.

• REMOTE SETTING AUTH — This setting is used for remote (Ethernet or RS485 interface) setting access supervision.

If this setting is “On” (the default setting), then remote setting access functions as normal; that is, a remote password is 
required. If this setting is “Off,” then remote setting access is blocked even if the correct remote setting password is 
provided. If this setting is any other FlexLogic operand, then the operand must be asserted (set as on) prior to 
providing the remote setting password to gain setting access.

If this setting is "Off," firmware upgrades are blocked. If this setting is "On," firmware upgrades are allowed.

• ACCESS AUTH TIMEOUT — This setting represents the timeout delay for local setting access. This setting is applicable 
when the LOCAL SETTING AUTH setting is programmed to any operand except “On.” The state of the FlexLogic operand 
is monitored continuously for an off-to-on transition. When this occurs, local access is permitted and the timer 
programmed with the ACCESS AUTH TIMEOUT setting value is started. When this timer expires, local setting access is 
immediately denied. If access is permitted and an off-to-on transition of the FlexLogic operand is detected, the 
timeout is restarted. The status of this timer updates every five seconds.

 ACCESS LEVEL
 TIMEOUTS  COMMAND LEVEL ACCESS

TIMEOUT: 5 min
Range: 5 to 480 minutes in steps of 1

 SETTING LEVEL ACCESS
TIMEOUT: 30 min

Range: 5 to 480 minutes in steps of 1

 DUAL PERMISSION
 SECURITY ACCESS  LOCAL SETTING AUTH:

On
Range: selected FlexLogic operands (see below)

 REMOTE SETTING AUTH:
On

Range: FlexLogic operand

 ACCESS AUTH
TIMEOUT: 30 min

Range: 5 to 480 minutes in steps of 1
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The following settings are available through the remote (EnerVista UR Setup) interface only. Select the Settings > Product 
Setup > Security menu item to display the security settings window.

The Remote Settings Authorized setting is used for remote (Ethernet or RS485 interface) setting access supervision. If this 
setting is “On” (the default setting), then remote setting access functions as normal; that is, a remote password is required. 
If this setting is “Off,” then remote setting access is blocked even if the correct remote setting password is provided. If this 
setting is any other FlexLogic operand, then the operand must be asserted (on) prior to providing the remote setting 
password to gain setting access.

The Access Authorized Timeout setting represents the timeout delay remote setting access. It applies when the Remote 
Settings Authorized setting is programmed to any operand except “On” or “Off.” The state of the FlexLogic operand is 
continuously monitored for an off-to-on transition. When this occurs, remote setting access is permitted, and the timer 
programmed with the Access Authorized Timeout setting value is started. When this timer expires, remote setting access 
is denied immediately. If access is permitted and an off-to-on transition of the FlexLogic operand is detected, the timeout 
is restarted. The status of this timer updates every five seconds.

5.3.1.3  EnerVista security

Enable the security management system
The EnerVista security system allows an administrator to manage access privileges of multiple users of EnerVista.

It is disabled by default to allow access to the device immediately after installation. When security is disabled, all users 
have administrator access. GE recommends enabling the EnerVista security before placing the device in service.
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To enable the security system and require password use:

1. Select the Security > User Management menu to open the user management window.

2. Enable the Enable Security check box in the lower-left corner to enable the security management system.

3. Click the Ok button.

Security is now enabled for the EnerVista UR Setup software. Upon starting the software, users are now required to enter a 
username and password.

Add a new user
The following pre-requisites are required to add user accounts to the EnerVista security management system:

• The user adding the account must have administrator rights

• The EnerVista security management system must be enabled (previous section)

To add a user account:

1. Select the Security > User Management item from the top menu to open the user management window.

2. Enter a username in the User field. The username must be four to 20 characters in length.

If you force password entry by using this feature, ensure that you know the Administrator password. If you do not 
know the password and are locked out of the software, contact GE Grid Solutions for the default password of a UR 
device. When using CyberSentry, the default password is "ChangeMe1#".
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3. Select the user access rights by enabling the check box of one or more fields.

The table outlines access rights.

Table 5-1: Access rights summary

4. Click OK to add the user account to the system.

Modify user privileges
The following pre-requisites are required to modify user privileges in the EnerVista security management system:

• The user modifying the privileges must have administrator rights

• The EnerVista security management system must be enabled (the Enable Security check box enabled)

To modify user privileges:

1. Select the Security > User Management item from the top menu to open the user management window.

2. Locate the username in the User field.

Field Description

Delete Entry Deletes the user account when exiting the user management window

Actual Values Allows the user to read Actual Values

Settings Allows the user to read Settings values

Commands Allows the user to execute Commands

Event Recorder Allows the user to use the Event Recorder

FlexLogic Allows the user to read FlexLogic values

Update Info Allows the user to write to any function to which they have read privileges. When any of the Settings, Event 
Recorder, and FlexLogic check boxes are enabled by themselves, the user is granted read access. When 
any of them are enabled in conjunction with the Update Info box, they are granted read and write access. 
The user is not granted write access to functions that are not enabled, even if the Update Info field is 
enabled.

Admin When the check box is enabled, the user becomes an EnerVista UR Setup administrator and has all 
administrative rights. Exercise caution when granting administrator rights.
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3. Modify the user access rights by enabling or disabling one or more of the check boxes.

The table outlines access rights.

Table 5-2: Access rights summary

4. Click OK to save the changes.

5.3.1.4  CyberSentry security

The EnerVista software provides the means to configure and authenticate the F60 access using either a server or the 
device. Access to functions depends on user role.

The login screen of EnerVista has two options for access to the F60, these being Server and Device authentication.

Field Description

Delete Entry Deletes the user account when exiting the user management window

Actual Values Allows the user to read actual values

Settings Allows the user to read setting values

Commands Allows the user to execute commands

Event Recorder Allows the user to use the digital fault recorder

FlexLogic Allows the user to read FlexLogic values

Update Info Allows the user to write to any function to which they have read privileges. When any of the Settings, Event 
Recorder, and FlexLogic check boxes are enabled by themselves, the user is granted read access. When 
any of them are enabled in conjunction with the Update Info box, they are granted read and write access. 
The user is not granted write access to functions that are not enabled, even if the Update Info field is 
enabled.

Admin When this check box is enabled, the user becomes an EnerVista UR Setup administrator and has all 
administrative rights. Exercise caution when granting administrator rights.

This feature requires a CyberSentry software option. See the Order Codes section in chapter 2 for details.
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Figure 5-2: Login screen for CyberSentry

When the "Server" Authentication Type is selected, the F60 uses the RADIUS server and not its local authentication 
database to authenticate the user.

When the "Device" button is selected, the F60 uses its local authentication database and not the RADIUS server to 
authenticate the user. In this case, it uses built-in roles (Administrator, Engineer, Supervisor, Operator, Observer, or 
Administrator and Supervisor when Device Authentication is disabled), as login accounts and the associated passwords 
are stored on the F60 device. In this case, access is not user-attributable. In cases where user-attributable access is 
required, especially for auditable processes for compliance reasons, use server authentication (RADIUS) only.

No password or security information is displayed in plain text by the EnerVista software or the UR device, nor are they ever 
transmitted without cryptographic protection.

When CyberSentry is enabled, Modbus communications over Ethernet is encrypted, which is not always tolerated by 
SCADA systems. The UR has a bypass access feature for such situations, which allows unencrypted Modbus over Ethernet. 
The Bypass Access setting is available on the SETTINGS  PRODUCT SETUP  SECURITY  SUPERVISORY screen. Note that 
other protocols (DNP, 101, 103, 104, EGD) are not encrypted, and they are good communications options for SCADA 
systems when CyberSentry is enabled.

When using the rear RS485 port and CyberSentry, registers can be read with a maximum buffer of 64 bytes. Settings may 
not be written, so use another port or configure the SERIAL INACTIVITY TIMEOUT setting to a high value, such as eight 
minutes, to give the relay enough time to finish the task.

CyberSentry settings through EnerVista
CyberSentry security settings are configured under Device > Settings > Product Setup > Security.

Only (TCP/UDP) ports and services that are needed for device configuration and for customer enabled features are 
open. All the other ports are closed. For example, Modbus is on by default, so its TCP port 502, is open. But if 
Modbus is disabled, port 502 is closed. This function has been tested and no unused ports have been found open.
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Figure 5-3: Security panel when CyberSentry installed

For the Device > Settings > Product Setup > Supervisory option, the panel looks like the following.

Figure 5-4: Supervisory panel

For the Security panel, the following settings are available.
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Table 5-3: RADIUS server settings

Table 5-4: General security settings

Setting name Description Minimum Maximum Default Units Minimum 
permission

Primary RADIUS IP 
Address 

IP address of the main RADIUS server. 
Default value indicates no Primary 
RADIUS server is configured, and hence 
RADIUS is disabled.
Restart the relay for any change to take 
effect.

0.0.0.0 223.255.255.254 0.0.0.0 - Administrator

Primary 
Authentication Port

RADIUS authentication port 1 65535 1812 - Administrator

Primary Accounting 
Port 

RADIUS accounting port 1 65535 1813 - Administrator

Vendor ID An identifier that specifies RADIUS 
vendor-specific attributes used with the 
protocol

Value that 
represents 
General 
Electric

Administrator

RADIUS 
Authentication 
Method 

Authentication method used by RADIUS 
server. Can use EAP-TTLS, PEAP-GTC, or 
PAP. Selecting the PEAP-GTC option 
disables RADIUS authentication.

EAP-TTLS PAP EAP-TTLS - Administrator

RADIUS 
Authentication 
(Shared) Secret 

Shared secret used in authentication. It 
displays as asterisks. This setting must 
meet the CyberSentry password 
requirements.

See the 
Password 
Requirements 
section earlier 
in this chapter

See the following 
password section 
for requirements

N/A - Administrator

Timeout Timeout in seconds between re-
transmission requests

0 9999 10 sec Administrator

Retries Number of retries before giving up 0 9999 3 - Administrator

Confirm RADIUS 
Authentication 
(Shared) Secret 

Confirmation of the shared secret. The 
entry displays as asterisks.

See the 
Password 
Requirements 
section

245 characters N/A - Administrator

Setting name Description Minimum Maximum Default Units Minimum 
permission

Session Lockout Number of failed authentications before the 
device blocks subsequent authentication 
attempts for the lockout period

0 (lockout 
disabled)

99 3 - Administrator

Session Lockout 
Period

The period in minutes that a user is prevented 
from logging in after being locked out

0 (no period) 9999 3 min Administrator

Syslog Server IP 
Address

The IP address of the target Syslog server to 
which all security events are transmitted

0.0.0.0 223.255.
255.254

0.0.0.0 - Administrator

Syslog Server Port 
Number

The UDP port number of the target syslog 
server to which all security events are 
transmitted

1 65535 514 - Administrator

Device 
Authentication

When enabled, local Device authentication 
with roles is allowed. When disabled, the UR 
only authenticates to the AAA server (RADIUS).
NOTE: Administrator and Supervisor (if still 
enabled) remain active even after Device 
authentication is disabled. The only permission 
for local Administrator is to re-enable Device 
authentication when Device authentication is 
disabled. To re-enable Device authentication, 
the Supervisor unlocks the device for setting 
changes, and then the Administrator can re-
enable Device authentication.

Disabled Enabled Enabled - Administrator
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Table 5-5: Security alarm settings

CyberSentry settings through the front panel
SETTINGS  PRODUCT SETUP  SECURITY

Firmware Lock
(via Lock Relay)

Indicates if the device receives firmware 
upgrades. If Enabled and the firmware 
upgrade attempt is made, the device denies 
the upgrade and displays an error message 
that the lock is set. On each firmware upgrade, 
this setting goes back to the default.

The Lock Relay setting blocks settings and 
firmware updates.

Disabled Enabled Enabled - Administrator

Factory Service 
Mode

When enabled, the device can go into factory 
service mode. To enable, Supervisor 
authentication is necessary.

Disabled Enabled Disabled - Supervisor 
(Administrator 
when Supervisor 
is disabled)

Restore to Defaults Sets the device to factory defaults No Yes No - Administrator

Supervisor Role When enabled, the Supervisor role is active. To 
enable, Administrator authentication is 
necessary. When disabled, the Supervisor role 
is inactive. To disable, Supervisor 
authentication is necessary.

Disabled Enabled Enabled - Administrator to 
enable and 
Supervisor to 
disable

RADIUS user names Ensures that RADIUS user names are not the 
same as local/device role names

See RADIUS 
server 
documents

See 
RADIUS 
server 
document
s

- Administrator

Password Local/device roles except for Observer are 
password-protected. All RADIUS users are 
password-protected.

See the 
Password 
Requirements 
section earlier 
in this chapter

See the 
following 
password 
section for 
requireme
nts

Change
Me1#

Text The specified 
role and 
Administrator, 
except for 
Supervisor, 
where it is only 
itself

Setting name Description / Details Min Max Default Units Minimum 
permissions

Failed 
Authentications

A threshold number indicating when an alarm 
is set off to indicate too many failed 
authentication attempts

0 
(disabled)

99 3 - Administrator

Firmware Lock A value indicating if the device can receive a 
firmware upgrade. If Enabled and a firmware 
upgrade attempt is made, the device alarm 
activates. If Disabled, the device alarm does 
not activate. On each firmware upgrade this 
setting goes back to the default.

Disabled Enabled Enabled - Administrator

Settings Lock A value indicating if the device can accept any 
settings changes. If Enabled and a settings 
change attempt is made, the device alarm 
activates. If Disabled, the device alarm does 
not activate.

Disabled Enabled Enabled - Supervisor 
(Administrator if 
Supervisor has 
been disabled)

 SECURITY
  LOGIN:

None
Range: Administrator, Engineer, Supervisor,
Operator, Factory (for factory use only), None

  CHANGE LOCAL
 PASSWORDS

See page 5-21

Setting name Description Minimum Maximum Default Units Minimum 
permission
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LOGIN — This setting is applicable for Device authentication only. This setting allows a user to log in with a specific role, as 
outlined here. For the Supervisor role, enable the “Supervisor Role” setting. Log out by right-clicking the device in EnerVista 
and selecting the Disconnect option.

Whenever a new role is logged in, the user is prompted to enter a password. Passwords must obey the requirements 
specified earlier in the chapter in the Password Requirements section.The UR device supports five roles. Roles have their 
corresponding passwords, except the Observer role, which does not require a password. There are no time-outs for the 
Administrator, Engineer, Operator, and Supervisor when logged in using the front panel; log out manually or use the 
Command > Security commands in the software.

The roles are defined as follows:

• Administrator — Complete read/write access to all settings and commands. This role does not allow concurrent 
access. This role has an operand to indicate when it is logged on.

• Engineer — Complete read/write access to all settings and commands except configuring Security settings and 
firmware upgrades. This role does not allow concurrent access.

• Operator — The Operator has read/write access to all settings under the Commands menu/section. This role does not 
exist offline.

• Supervisor — This is only an approving role. This role’s authentication commits setting changes submitted by 
Administrator or Engineer. The Supervisor role authenticates to unlock the UR relay for setting changes and not 
approve changes after the fact. Only a Supervisor can set the Settings Lock and Firmware Lock in the Security 
settings. This role also has the ability to forcefully log off any other role and clear the security event log. This role can 
also be disabled, but only through a Supervisor authentication. When this role is disabled its permissions are assigned 
to the Administrator role.

• Observer — This role has read-only access to all F60 settings. This role allows unlimited concurrent access but it has 
no download access to any files on the device. Observer is the default role if no authentication has been done to the 
device. This role displays as "None" on the front panel. When local authentication is used, no password is required for 
this role. When RADIUS server authentication is used, a password is required.

Change local passwords
SETTINGS  PRODUCT SETUP  SECURITY  CHANGE LOCAL PASSWORDS

The menu is shown on the front panel upon successful login of the Administrator role.

  SESSION
 SETTINGS

See page 5-22

  RESTORE DEFAULTS
 

See page 5-22

  SUPERVISORY
 

See page 5-22

 SYSLOG IP ADDRESS:
0.0.0.0

Range: 0.0.0.0, 255.255.255.255

 SYSLOG PORT NUMBER:
514

Range: 1 to 65535

The Factory service role is not available. It is for factory use only.

The Local Access Denied message on the front panel can mean that you need to log in to the UR in order to 
complete the action.

 CHANGE LOCAL
 PASSWORDS  LOGIN:

None
Range: 20 alphanumeric characters

 NEW PASSWORD: Range: 20 alphanumeric characters

 CONFIRM PASSWORD: Range: 20 alphanumeric characters
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The LOGIN setting in this menu is similar to that described in SETTINGS > PRODUCT SETUP > SECURITY except for the factory 
role.

Passwords are stored in text format. No encryption is applied.

Session settings
SETTINGS  PRODUCT SETUP  SECURITY  SESSION SETTINGS

SESSION LOCKOUT — This setting specifies the number of failed authentications before the device blocks subsequent 
authentication attempts for the lockout period. A value of zero means lockout is disabled.

SESSION LOCKOUT PERIOD — This setting specifies the period of time in minutes of a lockout period. A value of 0 means that 
there is no lockout period.

Restore defaults
SETTINGS  PRODUCT SETUP  SECURITY  RESTORE DEFAULTS

LOAD FACTORY DEFAULTS — This setting is used to reset all the settings, communication, and security passwords. An 
Administrator role is used to change this setting and a Supervisor role (if not disabled) approves it.

Supervisory
SETTINGS  PRODUCT SETUP  SECURITY  SUPERVISORY

The Supervisory menu settings are available for Supervisor role only, or if the Supervisor role is disabled then for the 
Administrator role only.

In Device authentication mode, the Observer role does not have a password associated with it. In Server 
authentication mode the Observer role requires a password.
If you are locked out of the software, contact GE Grid Solutions for the default password. When using CyberSentry, 
the default password is "ChangeMe1#".
Once the passwords are set, the Administrator with Supervisor approval can change the role-associated password.

In CyberSentry, password encryption is not supported.

 SESSION
 SETTINGS  SESSION LOCKOUT:

  3
Range: 0 to 99

 SESSION LOCKOUT
PERIOD: 3 min

Range: 0 to 9999 minutes

 RESTORE DEFAULTS
  LOAD FACTORY

DEFAULTS: No
Range: Yes, No

 SUPERVISORY
  DEVICE

AUTHENTICATION: Yes
Range: Yes, No

 BYPASS ACCESS:
Disabled

Range: Local, Remote, Local and Remote, Disabled, 
Pushbuttons

 LOCK RELAY:
Disabled

Range: Enabled, Disabled

 FACTORY SERVICE
MODE: Disabled

Range: Enabled, Disabled

  SELF TESTS


See below

 SUPERVISOR ROLE:
Disabled

Range: Enabled, Disabled

 SERIAL INACTIVITY
TIMEOUT: 1 min

Range: 1 to 9999 minutes
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DEVICE AUTHENTICATION — This setting is enabled by default, meaning "Yes" is selected. When enabled, Device 
authentication with roles is enabled. When this setting is disabled, the UR only authenticates to the AAA server (RADIUS). 
However, the Administrator and Supervisor (when enabled) remain active even after device authentication is disabled and 
their only permission is to re-enable Device authentication. To re-enable Device authentication, the Supervisor unlocks the 
device for settings changes, then the Administrator re-enables device authentication.

BYPASS ACCESS — The bypass security feature provides an easier access, with no authentication and encryption for those 
special situations when this is considered safe. Only the Supervisor, or the Administrator when the Supervisor role is 
disabled, can enable this feature.

The bypass options are as follows:

• Local — Bypasses authentication for push buttons, keypad, RS232, and RS485

• Remote — Bypasses authentication for Ethernet

• Local and Remote — Bypasses authentication for push buttons, keypad, RS232, RS485, and Ethernet

• Pushbuttons — Bypasses authentication for front panel push buttons only. On the graphical front panel, the 
authentication for side pushbuttons to control breakers and disconnects also is bypassed.

LOCK RELAY — This setting uses a Boolean value (Enabled/Disabled) to indicate if the device accepts settings changes and 
whether the device can receive a firmware upgrade. This setting can be changed by the Supervisor role, if it is enabled, or 
by the Administrator if the Supervisor role is disabled. The Supervisor role disables this setting for the relay to start 
accepting settings changes, command changes, or firmware upgrade. After all the setting changes are applied or 
commands executed, the Supervisor enables to lock settings changes.

Example: If this setting is enabled and an attempt is made to change settings or upgrade the firmware, the UR device 
denies the settings changes or denies upgrading the firmware. If this setting is disabled, the UR device accepts settings 
changes and firmware upgrade.

This role is disabled by default.

FACTORY SERVICE MODE — When Enabled, the device can go into factory service mode. For this setting to become enabled a 
Supervisor authentication is necessary. The default value is Disabled.

SUPERVISOR ROLE — When Enabled, the Supervisor role is active. To Disable this setting a Supervisor authentication is 
necessary. If disabled, the Supervisor role is not allowed to log in. In this case, the Administrator can change the settings 
under the Supervisory menu.

If enabled, Supervisor authentication is required to change the settings in the Supervisory menu. If the Supervisor disables 
their role after authentication, the Supervisor session remains valid until they switch to another role using MMI or until they 
end the current Supervisor session if using communications.

This role is disabled by default.

SERIAL INACTIVITY TIMEOUT — The role logged via a serial port is auto logged off after the Serial Inactivity timer times out. A 
separate timer is maintained for RS232 and RS485 connections. Set this value to a high number, such as eight minutes, 
when using the rear RS485 terminals for settings write.

GE recommends setting this value to at least 3 minutes for the following scenario: while connected to a CyberSentry 
device, with serial or USB cable connected to the front panel, and performing "Add Device to Offline Window" or an online/
offline comparison. With less than the recommended 3 minutes, the serial activity timeout interrupts the connection and 
the security role login window appears. Upon login, the process resumes.

Self-tests

SETTINGS  PRODUCT SETUP  SECURITY  SUPERVISORY  SELF TESTS

Mode Front panel or serial (RS232, RS485) Ethernet

Normal mode Authentication — Role Based Access Control (RBAC)
and passwords in clear

Authentication — RBAC and passwords encrypted
SSH tunneling

Bypass access mode No passwords for allowed RBAC levels No passwords for allowed RBAC levels
No SSH tunneling

 SELF TESTS
   FAILED

 AUTHENTICATE
See below
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FAILED AUTHENTICATE — If this setting is Enabled then the number of failed authentications is compared with the Session 
Lockout threshold. When the Session Lockout threshold is exceeded, this minor alarm indication comes up.

FIRMWARE LOCK — If this setting is Enabled, then any firmware upgrade operation attempt when the Lock Relay setting is 
enabled brings up this self test alarm.

SETTINGS LOCK — If this setting is Enabled then an unauthorized write attempt to a setting for a given role activates this self 
test.

SETTINGS  PRODUCT SETUP  SECURITY  SUPERVISORY  SELF TESTS  FAILED AUTHENTICATE

CyberSentry setup
When first using CyberSentry security, use the following procedure for setup.

1. Log in to the relay as Administrator by using the VALUE keys on the front panel to enter the default password 
"ChangeMe1#". Note that the Lock Relay setting needs to be disabled in the Security > Supervisory menu. When this 
setting is disabled, configuration and firmware upgrade are possible. By default, this setting is disabled.

2. Enable the Supervisor role if you have a need for it.

3. Make any required changes in configuration, such as setting a valid IP address for communication over Ethernet.

4. Log out of the Administrator account by choosing None.

5. Next, Device or Server authentication can be chosen on the login screen, but the choice is available only in EnerVista. 
Use Device authentication to log in using the five pre-configured roles (Administrator, Supervisor, Engineer, Operator, 
Observer). When using a serial connection, only Device authentication is supported. When Server authentication is 
required, characteristics for communication with a RADIUS server must be configured. This is possible only in the 
EnerVista software. The RADIUS server itself also must be configured. The appendix called RADIUS Server at the end of 
this instruction manual gives an example of how to set up a simple RADIUS server. Once both the RADIUS server and 
the parameters for connecting the UR to the server have been configured, you can choose Server authentication on 
the login screen of EnerVista.

To configure Server authentication:

1. In the EnerVista software, choose Device authentication and log in as Administrator.

2. Configure the following RADIUS server parameters: IP address, authentication port, shared secret, and vendor ID.

3. On the RADIUS server, configure the user accounts. Do not use the five pre-defined roles as user names (Administrator, 
Supervisor, Engineer, Operator, Observer) in the RADIUS server. If you do, the UR relay automatically provides the 
authentication from the device.

4. In the EnerVista software, choose Server authentication and log in using the user name and password configured on 
the RADIUS server for Server authentication login.

 FIRMWARE LOCK:
Enabled

Range: Enabled, Disabled

 SETTINGS LOCK:
Enabled

Range: Enabled, Disabled

 FAILED
 AUTHENTICATE  FAILED AUTHENTICATE:

Enabled
Range: Enabled, Disabled

The use of CyberSentry for devices communicating through an Ethernet-to-RS485 gateway is not 
supported. Because these gateways do not support the secure protocols necessary to communicate 
with such devices, the connection cannot be established. Use the device as a non-CyberSentry 
device.

Users logged in through the front panel are not timed out and cannot be forcefully logged out by a 
supervisor. Roles logged in through the front panel that do no allow multiple instances (Administrator, 
Supervisor, Engineer, Operator) must switch to None (equivalent to a logout) when they are done in 
order to log out.

For all user roles except Observer, only one instance can be logged in at a time, for both login by front 
panel and software.
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5. After making any required changes, log out.

Pushbuttons (both user-control buttons and user-programmable buttons) located on the front panel can be pressed by an 
Administrator or Engineer role. This also applies to the RESET button, which resets targets, where targets are errors 
displayed on the front panel or the Targets panel of the EnerVista software. The RESET button has special behavior in that it 
allows these two roles to press it even when they are logged in through the RS232 port and not through the front panel.

To reset the security event log and self-test operands:

1. Log in as Supervisor (if the role is enabled) or Administrator (if the Supervisor role is disabled) and execute a clear 
security command under Commands > Security > Clear Security.

Security events
The security events produced when the CyberSentry option is purchased are sent as sytem log (syslog) messages to a 
syslog server, if one is configured. The format is as follows.

Event Number — Event identification number (index)

Date & Timestamp — UTC date and time

Username — 255 chars maximum, but in the security log it is truncated to 20 characters

IP address — Device IP address

Role — 16 bit unsigned, of type format F617

Activity Value — 16 bit unsigned

When changing settings offline, ensure that only settings permitted by the role that performs the 
settings download are changed because only those changes are applied.

Security log Event Number Date & 
Timestamp

Username IP address Role Activity Value

Enumeration Role

0 None

1 Administrator

2 Supervisor

3 Engineer

4 Operator

5 Factory

Enumeration Description

1 Authentication Failed

2 User Lockout

3 FW Upgrade

4 FW Lock

5 Settings Lock

6 Settings Change. Because this can fill the entire event log, it is supported by the 
already existing Settings_Change.log file. This event is not required.

7 Clear Oscillography command

8 Clear Data Logger command (not applicable to all UR products)

9 Clear Demand Records command (not applicable to all UR products)

10 Clear Energy command (not applicable to all UR products)

11 Clear Unauthorized Access command

12 Clear Teleprotection Counters command (not applicable to all UR products)

13 Clear All Relay Records command

14 Role Log in
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In addition to supporting syslog, a F60 with CyberSentry also saves the security events in two local security files, these 
being SECURITY_EVENTS.CSV and SETTING_CHANGES.LOG. Details on these files and how to retrieve them are available in 
the EnerVista software under Maintenance > Retrieve File. Depending on the level of criticality/severity, a syslog server or 
a reporting tool gathering information from a syslog server can produce reports, charts, and so on. All severity levels are 
per RFC 5424.

Table 5-6: CyberSentry system events recorded

5.3.2  Display properties
SETTINGS  PRODUCT SETUP  DISPLAY PROPERTIES

15 Role Log off

Event Severity Description

FAILED_AUTH, ORIGIN, TIMESTAMP Notice (5) A failed authentication with origin information (username and IP:MAC 
address), a time stamp in UTC time when it occurred

AUTH_LOCKOUT, ORIGIN, TIMESTAMP Warning (4) An authentication lockout has occurred because of too many failed 
authentication attempts

FIRMWARE_UPGD, ORIGIN, 
TIMESTAMP

Information (6) Indicates that a change of firmware has occurred

FIRMWARE_LOCK, ORIGIN, 
TIMESTAMP

Warning (4) An attempt was made to change firmware while the firmware lock was 
enabled

SETTING_CHG, ORIGIN, TIMESTAMP Notice (5) Indicates setting change(s)

SETTING_LOCK, ORIGIN, TIMESTAMP Warning (4) An attempt was made to change settings while the settings lock was enabled

LOGIN, ORIGIN, TIMESTAMP Information (6) Indicates when a certain role logged in

LOGOUT, ORIGIN, TIMESTAMP Information (6) Indicates when a certain role logged out or timed out

CLEAR_OSCILLOGRAPHY Notice (5) Clear oscillography command was issued

CLEAR_DATA_LOGGER Notice (5) Clear data logger command was issued

CLEAR_DEMAND_RECS Notice (5) Clear demand records command was issued

CLEAR_ENERGY Notice (5) Clear energy command was issued

RESET_UNAUTH_ACCESS Notice (5) Reset Unauthorized access command was issued

CLEAR_TELEPROTECTION_CNT Notice (5) Clear teleprotection counters command was issued

CLEAR_ALL_RECS Notice (5) Clear all records command was issued

WRITE_SETTING_FILE Notice (5) Write settings file to the relay

 DISPLAY
 PROPERTIES 

LANGUAGE:
English

Range: English; English, French; English, Russian; English, 
Chinese; English, German (examples; depends on order code)
Visible when language other than English purchased

 FLASH MESSAGE
TIME: 1.0 s

Range: 0.5 to 10.0 s in steps of 0.1

 DEFAULT MESSAGE
TIMEOUT: 300 s

Range: 10 to 900 s in steps of 1

 DEFAULT MESSAGE
INTENSITY: 25 %

Range: 25%, 50%, 75%, 100%
Visible when a VFD is installed

 SCREEN SAVER
FEATURE: Disabled

Range: Disabled, Enabled
Visible when an LCD is installed

 SCREEN SAVER WAIT
TIME: 30 min

Range: 1 to 65535 min. in steps of 1
Visible when an LCD is installed

 CURRENT CUT-OFF
LEVEL: 0.020 pu

Range: 0.002 to 0.020 pu in steps of 0.001

 VOLTAGE CUT-OFF
LEVEL: 1.0 V

Range: 0.1 to 1.0 V secondary in steps of 0.1

Enumeration Description
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Some relay messaging characteristics can be modified to suit different situations using the display properties settings.

LANGUAGE — This setting selects the language used to display settings, actual values, and targets. This setting displays 
when a language other than English was purchased, and the range depends on the order code of the relay.

For Japanese, the settings display in Japanese on the graphical front panel, while the keys printed on the panel are in 
English.

For Japanese and Chinese, up to 10 characters can be input in a field on the graphical front panel, not 20.

With the graphical front panel, the language can be changed regardless of the language purchased. That is, all languages 
can be used. If you select a language with which you are unfamiliar and want to switch back to English for example, the 
menu order remains the same. That is, Settings is always second, Product Setup is always first, Display Properties is always 
second, and Language is always first.

If the language is changed after entering user-configured names, such as relay names, the strings are not translated. For 
example, a relay name is entered in English, the language is changed to Japanese, and the relay name remains in English. 
Set the language before changing settings.

The language can be selected also for the front panel in EnerVista under Maintenance > Change Front Panel.

The language of the EnerVista software can be changed under View > Language. Languages supported by the operating 
system display; that is for Polish or Japanese to display, the software needs to be installed on a Polish or Japanese 
operating system.

FLASH MESSAGE TIME — Flash messages are status, warning, error, and information messages displayed in response to 
certain key presses during settings programming. These messages override any normal messages. Use this setting to 
change the duration of flash messages on the display.

DEFAULT MESSAGE TIMEOUT — If the keypad is inactive for a period of time, the relay automatically reverts to a default 
message. The inactivity time is modified using this setting to ensure that messages remain on the screen long enough 
during programming or reading of actual values. This setting is not supported on the graphical front panel.

DEFAULT MESSAGE INTENSITY — To extend phosphor life in the vacuum fluorescent display, the brightness can be 
attenuated during default message display. During keypad interrogation, the display always operates at full brightness. 
This setting is not supported on the graphical front panel.

SCREEN SAVER FEATURE and SCREEN SAVER WAIT TIME — These settings are only visible if the F60 has a liquid crystal display 
(LCD) and control its backlighting. When the SCREEN SAVER FEATURE is “Enabled,” the LCD backlighting turns off after the 
DEFAULT MESSAGE TIMEOUT followed by the SCREEN SAVER WAIT TIME, provided that no keys have been pressed and no 
target messages are active. When a keypress occurs or a target becomes active, the LCD backlighting turns on. These 
settings are not supported on the graphical front panel.

CURRENT CUT-OFF LEVEL — This setting modifies the current cut-off threshold. Very low currents (1 to 2% of the rated value) 
are very susceptible to noise. Some customers prefer very low currents to display as zero, while others prefer the current to 
display even when the value reflects noise rather than the actual signal. The F60 applies a cut-off value to the magnitudes 
and angles of the measured currents. If the magnitude is below the cut-off level, it is substituted with zero. This applies to 
phase and ground current phasors as well as true RMS values and symmetrical components. The cut-off operation applies 
to quantities used for metering, protection, and control, as well as those used by communications protocols. Note that the 
cut-off level for the sensitive ground input is 10 times lower that the CURRENT CUT-OFF LEVEL setting value. Raw current 
samples available via oscillography are not subject to cut-off.

VOLTAGE CUT-OFF LEVEL — This setting modifies the voltage cut-off threshold. Very low secondary voltage measurements 
(at the fractional volt level) can be affected by noise. Some customers prefer these low voltages to be displayed as zero, 
while others prefer the voltage to be displayed even when the value reflects noise rather than the actual signal. The F60 
applies a cut-off value to the magnitudes and angles of the measured voltages. If the magnitude is below the cut-off level, 
it is substituted with zero. This operation applies to phase and auxiliary voltages, and symmetrical components. The cut-off 
operation applies to quantities used for metering, protection, and control, as well as those used by communications 
protocols. Raw samples of the voltages available via oscillography are not subject to cut-off.
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The CURRENT CUT-OFF LEVEL and the VOLTAGE CUT-OFF LEVEL are used to determine the metered power cut-off levels. The 
power cut-off level is calculated using the following equations. For Delta connections:

Eq. 5-3

For Wye connections:

Eq. 5-4

Eq. 5-5

where VT primary = VT secondary  VT ratio and CT primary = CT secondary  CT ratio.

For example, given the following settings:
CURRENT CUT-OFF LEVEL: “0.02 pu”
VOLTAGE CUT-OFF LEVEL: “1.0 V”
PHASE CT PRIMARY: “100 A”
PHASE VT SECONDARY: “66.4 V”
PHASE VT RATIO: “208.00 : 1"
PHASE VT CONNECTION: “Delta”

We have:
CT primary = “100 A”, and
VT primary = PHASE VT SECONDARY x PHASE VT RATIO = 66.4 V x 208 = 13811.2 V

The power cut-off is therefore:
power cut-off= (CURRENT CUT-OFF LEVEL  VOLTAGE CUT-OFF LEVEL  CT primary  VT primary)/VT secondary
= (  0.02 pu  1.0 V  100 A  13811.2 V) / 66.4 V 
= 720.5 watts

Any calculated power value below this cut-off does not display. As well, the three-phase energy data do not accumulate if 
the total power from all three phases does not exceed the power cut-off.

5.3.3  Graphical front panel

Use the EnerVista software to configure the graphical front panel. The settings are not accessible from the graphical front 
panel.

The following screens are available:

• Home page

• Rolling mode

• Metering editor

• Single-line diagram editor

• Annunciator editor

Lower the VOLTAGE CUT-OFF LEVEL and CURRENT CUT-OFF LEVEL with care as the relay accepts lower signals as valid 
measurements. Unless dictated otherwise by a specific application, the default settings of “0.02 pu” for CURRENT 
CUT-OFF LEVEL and “1.0 V” for VOLTAGE CUT-OFF LEVEL are recommended.

The graphical front panel is a hardware option. See the Order Codes section in chapter 2 for details.

3-phase power cut-off 3 CURRENT CUT-OFF LEVEL VOLTAGE CUT-OFF LEVEL VT primary CT primary
VT secondary

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

3-phase power cut-off 3 CURRENT CUT-OFF LEVEL VOLTAGE CUT-OFF LEVEL VT primary CT primary
VT secondary

----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

per-phase power cut-off CURRENT CUT-OFF LEVEL VOLTAGE CUT-OFF LEVEL VT primary CT primary
VT secondary

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------=
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• Configurable navigation

The settings menu itself and the event record pages are not configurable.

Multiple screens can be opened in the EnerVista software, but the first remains active and the others can be read-only. For 
example, the Annunciator Editor and Single Line Diagram Editor can be open and active, then subsequently opened Rolling 
Mode and Home Page screens are read-only. Close the windows, then re-open the one required.

5.3.3.1  Home page
This window sets the home page displayed on the graphical front panel and the date and time formats for all pages. Home 
page options include display of product information, alarms, actual values, and event records.

The path is Settings > Product Setup > Graphical Panel > Home Page. The menu does not display when there is no 
graphical front panel.

Figure 5-5: Home page with product information 

Figure 5-6: Home page settings

Home Page Content
Range: Product Information, SLD 1…5, Annunciator, Annunciator 1…8, Phasors 1…6, Tabular 1…5, Event Records, Targets
Default: Product Information

This setting specifies the page to display between the home page header and footer. Pressing the Home button returns 
the display to this page. The home page displays for the rolling mode delay specified, then changes to the rolling mode 
pages.

The "Annunciator" option without a page number specifies the first annunciator page in the following sequence:

– The first annunciator page that contains an annunciator window that is in alarm (fast flash)
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– The first annunciator page that contains an annunciator window that is in ringback. Ringback is a "return alert." 
Visual and audible signals are given when conditions return to normal, then the sequence returns to normal by 
pushing the RESET button.

– The first annunciator page that contains an annunciator window that is in abnormal state

– Annunciator page 1

Whenever an annunciator window changes state this list is re-evaluated, which can result in the home page displaying 
a different annunciator page.

The Tabular option displays a configured actual values/metering page.

The Targets option displays error messages, such as wrong transceiver, similar to event record entries.

Date Format
Range:  yyyy-mm-dd, dd-mmm-yy, yyyy/mm/dd, m/d/yyyy, m/d/yy, mm/dd/yy, mm/dd/yyyy, yy/mm/dd
Default: yyyy-mm-dd

This setting specifies the format for dates on the graphical front panel. It applies to the page header, the events records, 
the annunciator, and everywhere else a date displays on the panel. If the relay is synchronized to an external time 
source via PTP, IRIG-B, SNTP, and so on, the date/time is shown in white, and otherwise in yellow.

yyyy — four-digit year, for example 2017

yy — two-digit year, for example 17 for 2017

mmm — abbreviation of month name, for example Jan for January

mm — two-digit month, for example 01 for January

m — one or two-digit month, for example 1 for January and 10 for October

dd — two-digit day, for example 08

d — one or two-digit day, for example 8 and 28

To set the date and time, access Synchronize Devices in the software, synchronize to a time source using Settings > 
Product Setup > Real Time Clock, or synchronize to the computer using Commands > Set Date and Time.

Time Format
Range: hh:mm:ss, h:mm:ss tt
Default: hh:mm:ss

This setting specifies the format for time on the graphical front panel. It applies to the page header and everywhere else 
a time displays on the panel. When the Date Format and the Time Format use the defaults, the date and time are 
separated by the character "T" per the ISO convention, such as "2017-09-24T10:58:31". Otherwise the date and time are 
separated by a space. If the relay is synchronized to an external time source via PTP, IRIG-B, SNTP, and so on, the date/
time is shown in white, and otherwise in yellow.

hh — two-digit hour, for example 02 for two o’clock

h — one or two-digit hour, for example 2 for two o’clock

mm — two-digit minute, for example 51 minutes

ss — two-digit second (can have a decimal and further digits appended), for example 16 seconds

tt — AM or PM based on 12 hour clock

If microseconds have to be displayed, for example, in the event records, the 24-hour clock is adopted. The representation 
of an accumulated period (for example hh:mm) is not affected by the selected time format.

To set the date and time, access Synchronize Devices in the software or synchronize to a time source using Settings > 
Product Setup > Real Time Clock.

5.3.3.2  Rolling mode
After a user-defined period of inactivity, the graphical front panel changes, or rolls, to user-selected pages. Up to 10 pages 
can be specified. Similarly, the display backlight intensity is lowered to a specified level; lower intensity extends the life of 
the display.

Each rolling page displays for a few seconds; duration cannot be set.

The path is Settings > Product Setup > Graphical Panel > Rolling Mode.
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Figure 5-7: Rolling mode settings

Rolling Mode Delay
Range: 0 to 900 s in steps of 1
Default: 300 s

Set this delay to 0 to disable the rolling mode feature.

Otherwise, after no pushbutton has been pressed for the amount of time specified by this setting, the display 
automatically enters rolling mode. While in the rolling mode, the Rolling Mode Pages display. Rolling mode can be 
interrupted when a setting changes, such as changing the home page, then resumes rolling.

Automatic Annunciator Recall
Range: Enabled, Disabled
Default: Enabled

When Enabled, an annunciator window changes state, and the display is in rolling mode, this setting terminates rolling 
mode and displays the annunciator page containing the changed state.

The Configurable Navigation feature takes precedence over this setting when the Automatic Annunciator Recall and 
Configurable Navigation are activated by the same input.

Screen Saver Delay
Range: 0 to 900 s in steps of 1
Default: 300 s

The screen saver mode extends the life of the display. After the amount of time set here, the screen saver activates and 
the display intensity is reduced to the level set by the Screen Saver Intensity setting. When in rolling mode, rolling 
continues while the screen saver is active. The screen saver terminates when rolling mode terminates. To disable the 
screen saver, set the delay to 0.

Screen Saver Intensity
Range: 0, 10, 20, or 30 %
Default: 30 %

This setting sets the brightness of the display while the screen saver is active. For example, 0% means that the screen is 
dark and nothing displays. Pressing a pushbutton or changing a setting in the software, for example, re-activates the 
display.

Number of Rolling Mode Pages
Range: 1 to 10 in steps of 1
Default: 1

This setting specifies the number of rolling pages. During rolling mode, the graphical front panel displays pages from 1 
to the selected number.
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Rolling Mode Page 1 to 10
Range: Product Information, SLD 1…5, Annunciator, Annunciator 1…8, Phasors 1…6, Tabular 1…5, Event Records, Targets
Default: Product Information

These settings specify the pages to display on the graphical front panel while in rolling mode.

The "Annunciator" selection without a page number specifies the first annunciator page in the following sequence:

– The first annunciator page that contains an annunciator window that is in alarm (fast flash)

– The first annunciator page that contains an annunciator window that is in ringback. Ringback is a "return alert." 
Visual and audible signals are given when conditions return to normal, then the sequence returns to normal by 
pushing the RESET button.

– The first annunciator page that contains an annunciator window that is in abnormal state

– Annunciator page 1

Whenever an annunciator window changes state the list is re-evaluated, which can result in the display of a different 
annunciator page in the rolling sequence.

The Tabular option displays a configured actual values/metering page.

The Targets option displays error messages, such as wrong transceiver, similar to event record entries.

5.3.3.3  Metering editor
This feature creates tables of actual/metered values for the graphical front panel. It configures the content that displays in 
the Metering Tab pushbutton. An actual value, status, or text can be displayed. Five tabular metering pages can be 
configured. There also can be a phasor page for each configured AC source, and these pages are not configurable.

The path is Settings > Product Setup > Graphical Panel > Metering Editor.

Set the Current Page, Page Name, Layout, configure the top inputs, then the cells. The 16 inputs at the top of the page are 
used as inputs for the Status Index fields. Click the Preview button to view the page.

For a phasor diagram, configure the source under Settings > System Setup > Signal Sources. The diagram is then 
viewable by pushing the Metering Tab pushbutton on the graphical front panel. The Metering Editor is not used for these 
phasor diagrams.

The figures show setup and table preview.

The Cells configured are not retained when using the Convert Device Settings function, for example when converting a 
file in the Offline Window from version 7.6 to 7.7.



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-33

5

Figure 5-8: Metering Editor window

Figure 5-9: Preview for graphical front panel

STATUS INPUTS 1 to 16
Range: OFF, ON, any FlexLogic operand
Default: OFF

This setting identifies the potential inputs for use in the STATUS INDEX fields, for display of the status of FlexLogic 
operands.

A maximum of eight Status Inputs can be used per metering page, and 16 in all metering pages.

Select the metering input from the drop-down list. The options reflect the FlexLogic operands applicable to the F60. They 
are inputs for all five metering pages, not just the current page.
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CURRENT PAGE
Range: Page 1...Page 5
Default: Page 1

Select the metering page to configure from the drop-down list. There are five pages possible, viewable with the Tab 
pushbuttons on the graphical front panel.

PAGE NAME
Range: Page 1...Page 5
Default: Page 1

Up to 20 characters can be input here as the name of each metering page. The name displays for the Tab pushbutton on 
the graphical front panel.

LAYOUT
Range: 3x4, 4x6, 6x8, 6x4, 8x6, 12x8, 12x4, 16x6, 18x8
Default: 6x4

This setting determines how many rows and columns display on the graphical front panel with the metering information. 
The configurable rows in the settings window change dynamically based on this setting.

CONTENT
Range: Actual, Status, Text
Default: Text

Select the type of content to display. 

– Actual — an actual value/data. The Configure button becomes active for the actual value to be selected.

– Status — one of the operands selected from the STATUS INPUTS fields. Select it in the STATUS INDEX field.

– Text — indicates that text is to display instead of a metered value

STATUS INDEX
Range: 1...16
Default: 

This field becomes active when the CONTENT field is set to Status. It selects the input from the STATUS INPUTS to display 
the on/off status of the selected operand.

A maximum of eight Status Inputs can be used per metering page, and 16 in all metering pages.

TEXT
Range: up to 20 alphanumeric characters
Default: 

Enter the text to display on the graphical front panel. This field is active when the CONTENT field is set to Text or Status. 
When Status is selected, the text displays when the status input is in the "on" state.

OFF TEXT
Range: up to 20 alphanumeric characters
Default: 

Enter the text to display on the graphical front panel when the element being monitored is in an off/closed state. This 
field is active when the CONTENT field is set to Status. The text displays when the status input is in the "off" state.

FONT
Range: 16, 18, 20
Default: 16

Set the font size to display on the graphical front panel.

TEXT COLOR
Range: 24-bit color selector
Default: Black

Set the text color to display in the specified cell.
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BACK COLOR
Range: 24-bit color selector
Default: Grey

Set the background color to display in the specified cell.

ACTUAL (Configure)
Range: Configure
Default: Configure

The Configure button becomes active when the CONTENT field is set to "Actual." The window specifies the metering 
data to display.

Figure 5-10: Metering value properties window

Parameter
Range: any FlexAnalog parameter
Default: 

This setting selects a FlexAnalog parameter that specifies the metered value to display in the metering window. A 
FlexAnalog is an analog parameter.

Units
Range: up to eight alphanumeric characters
Default: 

This setting specifies the units of measurement for the metered value and is populated based on the Parameter 
selected. The field can be left blank when units of measure do not apply.

Scale Factor
Range: G Giga, M Mega, k Kilo, None
Default: None

This setting allows the user to specify the scaling factor for the metering units value. Options depend on the Parameter.

Multiplier
Range: -1000000 to 1000000
Default: 1.0

This setting allows the user to specify a multiplier for the metering parameter value. The multiplier must be in 
compliance with the 32-bit floating-point format per IEEE 754, otherwise, the input value is represented as per the IEEE 
standard. For example, 1234.56789 is represented as 1234.567871094, and 9876.54321 as 9876.54296875.
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Number of Integers
Range: 1 to 12 in steps of 1
Default: 1

This setting specifies the number of integers in the displayed metered value. It can be used to provide for leading 
character spacing of the display value.

For example, setting the number to 2 displays 00.000[V] and setting it to 3 displays 000.000[V].

Number of Decimals
Range: 0 to 10 in steps of 1
Default: 3

This setting specifies the number of decimal places in the displayed metered value. For example, setting the number to 1 
displays 0.0 and setting it to 2 displays 0.00.

5.3.3.4  Single-line diagram editor
The path is Settings > Product Setup > Graphical Panel > Single Line Diagram Editor. Use is explained in the Interfaces 
chapter.

5.3.3.5  Annunciator editor
The annunciator editor is used to create annunciator content for the graphical front panel, including alarms and actual 
values. Use is explained in the Interfaces chapter.

The path is Settings > Product Setup > Graphical Panel > Annunciator Editor.

To add an alarm, access the Annunciator Editor, configure the Layout and Page Name, configure the alarm or actual value, 
set the text and color, then save. On the graphical front panel, view the content by pressing the Annunciator Tab 
pushbutton at the bottom of the Home page. (Alarms do not display automatically.) Acknowledge the alarm by navigating 
to it with the arrow pushbuttons, then pressing the ENTER or RESET pushbutton.

The figure shows alarms for basic functions. The last annunciator page is named Device Alarms. Alarms are set for the 
device being offline, Ethernet cable issues, unauthorized access, battery failure, and high ambient temperature. They can 
reset themselves when conditions return to normal, except for unauthorized access and temperature monitoring, which 
require the alarms to be acknowledged. The self-test error functions, here for Ethernet and battery failures, also have been 
enabled under Settings > Product Setup > User-Programmable Self Tests (not shown). When the alarms are triggered, 
they display with a red background. An alarm is acknowledged by using the arrow keys on the graphical front panel then 
pressing the ENTER button.
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Figure 5-11: Annunciator editor with preview shown

Reset
Range: ON, OFF, any FlexLogic operand
Default: OFF

This setting selects a FlexLogic operand that when activated acknowledges/resets all annunciator windows in the 
graphical front panel. For example, to have the first user pushbutton resets all alarms, set this to PUSHBUTTON 1 ON and 
turn on the pushbutton under Settings > Product Setup > User-Programmable Pushbuttons. This setting is the same 
as the one defined in Settings > Inputs/Outputs > Resetting > Reset Annunciator. See the Resetting section later in this 
chapter.

LAYOUT
Range: 3x4, 4x6, 6x8
Default: 3x4

Selects the number of rows and columns to display on the annunciator pages. For example, 3x4 means 12 windows 
display per page over eight pages. Up to 96 entries are possible.

To view the layout, click the Preview button.

PAGE NAMES
Range: up to 20 alphanumeric characters
Default: Page 1...Page 8

Up to 20 characters can be input as the name of each annunciator page. The number of pages depends on the Layout. 
The name displays for the Tab pushbutton on the graphical front panel.
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PARAMETER
Range: Indicator 1...Indicator 96
Default: Indicator 1...Indicator 96

Read-only field. Up to 96 windows are possible.

CONTENT
Range: Actual, Alarm, Mixed
Default: Alarm

Select if the cell is to be an alarm, an actual value, or a combination thereof, for example consists of a single metered 
value (set to “Actual”), contains a single alarm indication (set to “Alarm”), or contains both a metered value and an alarm 
indication (set to “Mixed”).

ALARM INPUT
Range: OFF, ON, any FlexLogic operand
Default: OFF

Select a trigger for the alarm, or the input signal connected to the alarm. For example, when set to "FIRST ETHERNET 
FAIL" and the Ethernet cable connected to port 1 is removed, the alarm is triggered. (Note that when the Ethernet cable 
is inserted into an SFP connector and the SFP connector is removed, the alarm is not triggered.) The field is read-only for 
an actual value.

The selectable options are the FlexLogic operands specific to the product.

ALARM TYPE
Range: Acknowledgeable, Self Reset, Latched
Default: Acknowledgeable

Set the alarm type. The field is read-only for an actual value.

Acknowledgeable — Follow the state transitions, as outlined in the Annunciator section of the Interfaces chapter. The 
alarm blinks until acknowledged, then remains on until the condition clears.

Self Reset — Track the state of the input operand. The alarm turns on when the trigger activates and off when the trigger 
clears.

Latched — Alarm is on until acknowledged/reset individually or until the RESET button is pressed.

To acknowledge/reset/unlatch an alarm, use the arrow buttons on the graphical front panel and press the ENTER 
button.

TEXT (LINE 1 to 3)
Range: up to 10 alphanumeric characters
Default: 

The text that displays in the annunciator cell. Three lines can be displayed. Note that a specified metering value replaces 
the text for the selected line. This means that a line can display text or be set to show an actual metered value. If the text 
does not display it is because an actual metered value is over-riding it; change the line for the text or for the actual value.

TEXT COLOR
Range: 24-bit color selector
Default: White

The color to display for the three text or actual value lines specified.

BACK COLOR
Range: 24-bit color selector
Default: Red

The background color to display for any triggered cell, for example when an alarm is triggered.

ACTUAL (Configure)
Range: Configure
Default: Configure

The Configure button becomes active when the CONTENT field is set to "Actual" or "Mixed." The window specifies the 
metering data to display.
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Parameter
Range: any FlexAnalog parameter
Default: 

This setting selects a FlexAnalog parameter that specifies the metered value to display in the annunciator alarm.

Units
Range: up to eight alphanumeric characters
Default: 

This setting specifies the units of measurement for the metered value and is populated based on the Parameter 
selected. The field can be left blank when units of measure do not apply.

Scale Factor
Range: G Giga, M Mega, k Kilo, None
Default: None

This setting allows the user to specify the scaling factor for the metering units value. Options depend on the Parameter.

Multiplier
Range: -1000000 to 1000000
Default: 1.0

This setting allows the user to specify a multiplier for the metering parameter value. The multiplier must be in 
compliance with the 32-bit floating-point format per IEEE 754, otherwise, the input value is represented as per the IEEE 
standard. For example, 1234.56789 is represented as 1234.567871094, and 9876.54321 as 9876.54296875.

Number of Integers
Range: 1 to 12 in steps of 1
Default: 1

This setting specifies the number of integers in the displayed analog value. It can be used to provide for leading 
character spacing of the display value.

For example, setting the number to 2 displays 00.000[V] and setting it to 3 displays 000.000[V].

Number of Decimals
Range: 0 to 10 in steps of 1
Default: 3

This setting specifies the number of decimal places in the displayed analog value. For example, setting the number to 1 
displays 0.0 and setting it to 2 displays 0.00.

Display in Line
Range: 1, 2, 3
Default: 1

This setting specifies the line in the annunciator alarm window to display the metered value. The actual value replaces 
the text for the selected line. For example, 2 means the value displays in line 2 of the text; any text configured to display 
in that line does not display.

5.3.3.6  Configurable navigation
The path is Settings > Product Setup > Graphical Panel > Configurable Navigation.

This feature allows FlexLogic operands to trigger page display on the graphical front panel. It consists of 64 setting pairs, 
each with a condition and an activation page. The condition selects any FlexLogic operand. The activation page selects 
any page available for the graphical front panel. The page opens whenever the selected operand transitions from Off to 
On. The page remains open until rolling mode initiates, another trigger initiates from Configurable Navigation, or the Home 
button is pressed.

Avoid selecting condition operands that are likely to operate simultaneously but activate different pages, as only one page 
can be opened at a time. For example, do not select a single-line diagram page for breaker status open and select an 
annunciator page for a trip alarm.
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In the example shown, failure of any of the three Ethernet ports triggers the Product Information page to display. With 
unauthorized access (such as wrong password), IRIG-B clock failure, or breaker trouble, the Event Records display. When a 
breaker opens, a single-line diagram displays. For the Ethernet and IRIG-B failure operation to work, these functions also 
have been enabled under Settings > Product Setup > User-Programmable Self Tests.

Figure 5-12: Configurable navigation editor

To use the feature, select a CONDITION, select an ACTIVATE PAGE, then save.

CONDITION
Range: OFF, ON, any FlexLogic operand
Default: OFF

Select the FlexLogic operand for the trigger. When it transitions from Off to On, it opens the page specified by the 
ACTIVATE PAGE setting. The FlexLogic operands selectable depend on product. Select it from the drop-down list. Or click 
or select the field and start typing to auto-fill. For example, typing F displays FIRST ETHERNET FAIL, while typing BR 
displays the first breaker option.

ACTIVATE PAGE
Range: Product Information, SLD 1…5, Annunciator, Annunciator 1…8, Actual Values Phasors 1…6, Tabular 1…5, Event 
Records, Targets
Default: Product Information

This setting specifies the page to display on the graphical front panel when the FlexLogic operand selected by its 
CONDITON setting transitions from Off to On.

The "Annunciator" option without a page number specifies the first annunciator page in the following sequence:

– The first annunciator page that contains an annunciator window that is in alarm (fast flash)

– The first annunciator page that contains an annunciator window that is in ringback. Ringback is a "return alert." 
Visual and audible signals are given when conditions return to normal, then the sequence returns to normal by 
pushing the RESET button.

– The first annunciator page that contains an annunciator window that is in abnormal state

– Annunciator page 1

The Tabular option displays a configured actual values/metering page.

The Targets option displays error messages, such as wrong transceiver, similar to event record entries.

5.3.4  Clear relay records
SETTINGS  PRODUCT SETUP  CLEAR RELAY RECORDS

 CLEAR RELAY
 RECORDS  CLEAR FAULT REPORTS:

Off
Range: FlexLogic operand
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RESET UNAUTH ACCESS — Resets the access restriction counter.

Selected records can be cleared from user-programmable conditions with FlexLogic operands. Assigning user-
programmable pushbuttons to clear specific records is a typical application for these commands. Since the F60 responds 
to rising edges of the configured FlexLogic operands, they must be asserted for at least 50 ms to take effect.

Clearing records with user-programmable operands is not protected by the command password. However, user-
programmable pushbuttons are protected by the command password. Thus, if they are used to clear records, the user-
programmable pushbuttons can provide extra security if required.

For example, to assign user-programmable pushbutton 1 to clear demand records, apply the following settings.

1. Assign the clear demand function to pushbutton 1 by making the following change in the SETTINGS  PRODUCT SETUP 
 CLEAR RELAY RECORDS menu:

CLEAR DEMAND: “PUSHBUTTON 1 ON”

2. Set the properties for user-programmable pushbutton 1 by making the following changes in the SETTINGS  PRODUCT 
SETUP  USER-PROGRAMMABLE PUSHBUTTONS  USER PUSHBUTTON 1 menu:

PUSHBUTTON 1 FUNCTION: “Self-reset”
PUSHBTN 1 DROP-OUT TIME: “0.20 s”

5.3.5  Communications

5.3.5.1  Menu
SETTINGS  PRODUCT SETUP  COMMUNICATIONS

 CLEAR EVENT RECORDS:
Off

Range: FlexLogic operand

 CLEAR OSCILLOGRAPHY:
Off

Range: FlexLogic operand

 CLEAR DATA LOGGER:
Off

Range: FlexLogic operand

 CLEAR ARC AMPS 1:
Off

Range: FlexLogic operand

 CLEAR ARC AMPS 2:
Off

Range: FlexLogic operand

 CLEAR DEMAND:
Off

Range: FlexLogic operand

 CLEAR ENERGY:
Off

Range: FlexLogic operand

 CLEAR HIZ RECORDS:
Off

Range: FlexLogic operand

 RESET UNAUTH ACCESS:
Off

Range: FlexLogic operand

 CLEAR DIR I/O STATS:
Off

Range: FlexLogic operand
Visible only for units with Direct I/O module

 COMMUNICATIONS
   SERIAL PORTS

 
See below

  NETWORK
 

See page 5-43

  IPv4 ROUTE TABLE
 

See page 5-48
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5.3.5.2  Serial ports
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  SERIAL PORTS

The front RS232 port applies to enhanced and basic front panels.

RS232 BAUD RATE, RS485 COM2 BAUD RATE, and PARITY — The F60 is equipped with two independent serial communication 
ports. The front panel RS232 port (USB port with graphical front panel) is intended for local use. The rear COM2 port is 
RS485 and has settings for baud rate and parity. It is important that these parameters agree with the settings used on the 
computer or other equipment that is connected to these ports. Any of these ports can be connected to a computer 
running the EnerVista software, for example to download and upload setting files, view measured parameters, and 
upgrade the relay firmware. A maximum of 32 relays can be daisy-chained and connected to a DCS, PLC, or computer 
using the RS485 ports. If IEC 60870-103 is chosen as the protocol, valid baud rates are 9600 and 19200 bit/s, and valid 
parity is Even.

RS485 COM2 RESPONSE MIN TIME — This setting specifies the minimum time before the rear RS485 port transmits after 
receiving data from a host. This feature allows operation with hosts that hold the RS485 transmitter active for some time 
after each transmission.

  MODBUS PROTOCOL
 

See page 5-51

  PROTOCOL
 

See page 5-52

  DNP PROTOCOL
 

See page 5-53

  DNP / IEC104
 POINT LISTS

See page 5-56

  IEC 61850 PROTOCOL
 

Access in EnerVista
See page 5-57

  WEB SERVER
 HTTP PROTOCOL

See page 5-102

  TFTP PROTOCOL
 

See page 5-103

  IEC 60870-5-104
 PROTOCOL

See page 5-103

  EGD PROTOCOL
 

See page 5-105

  IEC103
 PROTOCOL

See page 5-106

  USB 2.0 PORT
 

See page 5-111

 SERIAL PORTS
  RS232 BAUD

RATE: 115200
Range: 19200, 115200

 RS485 COM2 BAUD
RATE: 19200

Range: 300, 1200, 2400, 4800, 9600, 14400, 19200, 
28800, 33600, 38400, 57600, 115200 bit/s

 RS485 COM2 PARITY:
Even

Range: None, Odd, Even

 RS485 COM2 RESPONSE
MIN TIME: 0 ms

Range: 0 to 1000 ms in steps of 10
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5.3.5.3  Ethernet network topology
The F60 has three Ethernet ports. Each Ethernet port must belong to a different network or subnetwork. Configure the IP 
address and subnet to ensure that each port meets this requirement. Two subnets are different when the bitwise AND 
operation performed between their respective IP address and mask produces a different result. Communication becomes 
unpredictable when more than one port is configured to the same subnet.

Example 1
IP1/Mask1: 10.1.1.2/255.255.255.0 (where LAN 1 is 10.1.1.x/255.255.255.0)

IP2/Mask2: 10.2.1.2/255.255.255.0 (where LAN2 is 10.2.1.x/255.255.255.0)

IP3/Mask3: 10.3.1.2/255.255.255.0 (where LAN3 is 10.3.1.x/255.255.255.0)

Example 2
IP1/Mask1: 10.1.1.2/255.0.0.0 (where LAN1 is 10.x.x.x/255.0.0.0)

IP2/Mask2: 11.1.1.2/255.0.0.0 (where LAN2 is 11.x.x.x/255.0.0.0)

IP3/Mask3: 12.1.1.2/255.0.0.0 (where LAN3 is 12.x.x.x/255.0.0.0)

Example 3 — Incorrect
IP1/Mask1: 10.1.1.2/255.0.0.0

IP2/Mask2: 10.2.1.2/255.0.0.0

IP3/Mask3: 10.3.1.2/255.0.0.0

This example is incorrect because the mask of 255.0.0.0 used for the three IP addresses makes them belong to the same 
network of 10.x.x.x.

Single LAN, no redundancy
The topology shown in the following figure allows communications to SCADA, local configuration/monitoring through 
EnerVista, and access to the public network shared on the same LAN. No redundancy is provided.

Figure 5-13: Network configuration for single LAN 

EnerVista Software

ML3000

Public Network

SCADA

UR

P2 P3

LAN1

P1
IP1/

MAC1

859708A2.vsd
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Multiple LANS, with redundancy
The following topology provides local configuration/monitoring through EnerVista software and access to the public 
network shared on LAN1, to which port 1 (P1) is connected. There is no redundancy provided on LAN1. Communications to 
SCADA is provided through LAN2. P2 and P3 are connected to LAN2, where P2 is the primary channel and P3 is the 
redundant channel. In this configuration, P3 uses the IP and MAC addresses of P2.

Figure 5-14: Multiple LANs, with redundancy 

Multiple LANS, no redundancy
The following topology provides local configuration/monitoring through EnerVista software on LAN1, to which port 1 (P1) is 
connected, access to the public network on LAN2, to which port 2 (P2) is connected, and communications with SCADA on 
LAN3, to which port 3 (P3) is connected. There is no redundancy.
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Figure 5-15: Multiple LANS, no redundancy 

5.3.5.4  Network
As outlined in the previous section, when using more than one Ethernet port, configure each to belong to a different 
network or subnet using the IP addresses and mask. Configure the network IP and subnet settings before configuring the 
routing settings.

Follow the IP and subnet mask rules outlined in the Set IP Address in UR section of the Installation chapter.

To obtain a list of all port numbers used, for example for audit purposes, contact GE technical support with substantiating 
information, such as the serial number and order code of your device.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  NETWORK 1(3)

 NETWORK PORT 1
  PRT1 IP ADDRESS:

127.0.0.1
Range: standard IPV4 address format

 PRT1 SUBNET IP MASK:
255.0.0.0

Range: standard IPV4 address format

 PRT1 FUNCTION:
Enabled

Range: Enabled, Disabled

 NETWORK PORT 2
  PRT2 IP ADDRESS:

127.0.0.1
Range: standard IPV4 address format

 PRT2 SUBNET IP MASK:
255.0.0.0

Range: standard IPV4 address format

 PRT2 REDUNDANCY:
None

Range: None, Failover, PRP
Range if no PRP license: None, Failover

 PRP MCST ADDR:
01154E000100

Range: 01-15-4E-00-01-00 to 01-15-4E-00-01-FF

 PRT2 FUNCTION:
Enabled

Range: Enabled, Disabled
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The IP addresses are used with the DNP, Modbus/TCP, IEC 61580, IEC 60870-5-104, TFTP, HTTP, and PRP protocols. PRP is 
explained in its own section later.

Use the front panel to change these settings. When online, the EnerVista software can be used to enable/disable each port 
only. In the Offline Window area, all settings can be changed except port 2 redundancy (depending on firmware version).

When using GOOSE, in failover or PRP mode, port 3 configuration in the CID file is ignored. The Port 3 ConnectedAP 
elements has no meaning, as ports 2 and 3 use the port 2 MAC address, IP address, and mask.

PRT1 (2 or 3) IP ADDRESS — This setting sets the port’s IPv4 address in standard IPV4 format. This setting is valid on port 3 if 
port 2 REDUNDANCY is set to None.

PRT1 (2 or 3) SUBNET MASK — This setting sets the port’s IPv4 subnet mask in standard IPV4 format. This setting is valid on 
port 3 if port 2 REDUNDANCY is set to None.

PRT1 (2 or 3) FUNCTION — This setting enable/disables network communication on the respective port. When the port 
function is Disabled, the network traffic on this port is disabled. The PRT2 redundancy setting has no effect on this 
functionality. The change takes effect upon relay restart.

If you disable a port here that is used to communicate between the relay and the software, this can take down all 
communication between the two. For example, an Ethernet connection set to the IP address of the relay can be disabled 
and cannot be reached, even when pinging. The port needs to be re-enabled, IP and any gateway addresses need to be 
checked, and the relay needs to be set to Programmed.

PRT2 REDUNDANCY — Determines if ports 2 and 3 operate in redundant or independent mode. If a license for PRP was 
purchased, the options are None, Failover, and PRP. If a license for PRP was not purchased, the options are None and 
Failover. In non-redundant mode (REDUNDANCY set to None), ports 2 and 3 operate independently with their own MAC, IP, 
and mask addresses. If REDUNDANCY is set to Failover, the operation of ports 2 and 3 is as follows:

• Ports 2 and 3 use the port 2 MAC address, IP address, and mask

• The configuration fields for IP address and mask on port 3 are hidden

• Port 3 is in standby mode and does not actively communicate on the Ethernet network but monitors its link to the 
Multilink switch. If port 2 detects a problem with the link, communications is switched to Port 3. Port 3 is, in effect, 
acting as a redundant or backup link to the network for port 2. Once port 2 detects that the link between itself and the 
switch is good and that communication is healthy for five minutes, then switching back to port 2 is performed. The 
delay in switching back ensures that rebooted switching devices connected to the F60, which signal their ports as 
active prior to being completely functional, have time to completely initialize themselves and become active. Once 
port 2 is active again, port 3 returns to standby mode.

If REDUNDANCY is set to PRP, the operation of ports 2 and 3 is as follows:

• Ports 2 and 3 use the port 2 MAC address, IP address, and mask

• The configuration fields for IP address and mask on port 3 are overwritten with those from port 2. This is visible on the 
front panel but not displayed in the EnerVista software.

• Port 2 MCST ADDRESS field is visible

• The port 2 PTP function still uses only port 2 and the port 3 PTP function still uses only port 3. The relay still 
synchronizes to whichever port has the best master. When ports 2 and 3 see the same master, as is typically the case 
for PRP networks, the port with the better connectivity is used.

Behavior for GOOSE messages is as follows:

• If REDUNDANCY is set to Failover or PRP, In order to transmit a GOOSE message on port 2, the CID file must be 
configured to have the corresponding GSE element in both ConnectedAPs S2 and S3. In the EnerVista software, the 

 NETWORK PORT 3
  PRT3 IP ADDRESS:

127.0.0.1
Range: standard IPV4 address format

 PRT3 SUBNET IP MASK:
255.0.0.0

Range: standard IPV4 address format

 PRT3 FUNCTION:
Enabled

Range: Enabled, Disabled
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TxGOOSE PORT ASSIGNMENT needs to be "Ports-1,2,3" to transmit GOOSE on both ports 1 and 2, or "Ports-2,3" to have 
GOOSE only on port 2, with failover/ PRP.

• If REDUNDANCY is set to PRP, the port 2 configured GOOSE message is simultaneously transmitted on ports 2 and 3

• If REDUNDANCY is set to failover and the port 2 link fails, then only the port 2 configured GOOSE message is transmitted 
on port 3

For any changes to this setting to take effect, restart the unit.

PRT2 PRP MCST ADDR — This setting allows the user to change the multicast address used by the PRP supervision frames. 
This setting is available if REDUNDANCY is set to PRP. All devices in the same PRP network need to have the same multicast 
address. Choose an address that does not conflict with another multicast protocol.

5.3.5.5  Far-End Fault Indication (FEFI)
Since 100BASE-FX does not support Auto-Negotiation, a Far-End Fault Indication (FEFI) feature is included since UR 7 that 
allows for detection of link failures.

The purpose of the Far-End Fault feature is to allow the stations on both ends of a pair of fibers to be informed when there 
is a problem with one of the fibers. Without the Far-End Fault feature, it is impossible for a fiber interface to detect a 
problem that affects only its transmit fiber.

When the Far-End Fault feature is supported, a loss of receive signal (link) causes the transmitter to generate a Far-End 
Fault pattern in order to inform the device at the far end of the fiber pair that a fault has occurred.

When the local receiver again detects a signal, the local transmitter automatically returns to normal operation.

If a Far-End Fault pattern is received by a fiber interface that supports the Far-End Fault feature and it is enabled, it reacts 
by dropping the link as if there were no signal at all.

If the receiving interface does not support the Far-End Fault feature or has it disabled, an incoming Far-End Fault pattern is 
ignored.

It is strongly recommended to have switches used for substation automation that support the Far-End Fault feature, 
especially when UR 7 redundancy Failover is selected for redundancy.

5.3.5.6  Parallel Redundancy Protocol (PRP)

The Parallel Redundancy Protocol (PRP) defines a redundancy protocol for high availability in substation automation 
networks. It applies to networks based on Ethernet technology (ISO/IEC 8802-3) and is based on the second edition (July 
2012) of IEC 62439-3, clause 4.

PRP is designed to provide seamless recovery in case of a single failure in the network, by using a combination of LAN 
duplication and frame duplication. Identical frames are sent on two completely independent networks that connect source 
and destination. Under normal circumstances both frames reach the destination and one of them is sent up the OSI stack 
to the destination application, while the second one is discarded. If an error occurs in one of the networks and traffic is 
prevented from flowing on that path, connectivity is provided through the other network to ensure continuous 
communication. Take care when designing the two LANs, so that no single point of failure (such as a common power 
supply) is encountered, as such scenarios can bring down both LANs simultaneously.

The two ports must be connected to completely independent LANs with no single point of failure, such as common 
power supplies that feed switches on both LANs.

The F60 is provided with optional PRP capability. This feature is specified as a software option at the time of 
ordering. See the Order Codes section in chapter 2 for details.
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Figure 5-16: Example of parallel redundant network

PRP uses specialized nodes called doubly attached nodes (DANPs) for handling the duplicated frames. DANP devices have 
an additional module, called a Link Redundancy Entity (LRE). LRE is responsible for duplicating frames and adding the 
specific PRP trailer when sending the frames out on the LAN, as well as making decisions on received frames as to which 
one is sent up the OSI stack to the application layer and which one is discarded. LRE is responsible for making PRP 
transparent to the higher layers of the stack.

In addition, there is a second type of specialized device used in PRP networks, called RedBox, with the role of connecting 
Single Attached Nodes (SANs) to a redundant network.

UR relays implement the DANP functionality. The RedBox functionality is not implemented.

The original standard IEC 62439-3 (2010) was amended to align PRP with the High-availability Seamless Redundancy (HSR) 
protocol. To achieve this, the original PRP was modified at the cost of losing compatibility with the PRP 2010 version. The 
revised standard IEC 62439-3 (2012) is commonly referred to as PRP-1, while the original standard is PRP-0. The UR relays 
support PRP-1.

The relay implements PRP on two of its Ethernet ports, specifically Ports 2 and 3 of the CPU module. Use the previous 
section (network port configuration) to configure PRP.

PRP is purchased as a separate option. If purchased (valid order code), PRP can be enabled in configuration through a 
setting available on the network configuration menu, REDUNDANCY, which already has the capability of enabling failover 
redundancy. The options on this setting must be changed to accommodate two types of redundancy: failover and PRP. 
When REDUNDANCY is set to either failover or PRP, the ports dedicated for PRP (Ports 2 and 3) operate in redundant mode. 
In this mode, Port 3 uses the MAC, IP address, and mask of Port 2.

5.3.5.7  IPv4 route table
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IPv4 ROUTE TABLE 1(6)

A default route and up to six static routes can be configured.

The default route is used as the last choice when no other route towards a given destination is found.

 IPv4 ROUTE TABLE
   DEFAULT IPv4 ROUTE



  IPv4 NETWORK
 ROUTE 1



  IPv4 NETWORK
 ROUTE 6

 DEFAULT IPv4 ROUTE
  GATEWAY ADDRESS:

127.0.0.1
Range: standard IPV4 unicast address format

 IPv4 NETWORK
 ROUTE 1  RT1 DESTINATION:

127.0.0.1
Range: standard IPV4 address format
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Configure the network IP and subnet settings before configuring the routing settings.

Add and delete static routes
Host routes are not supported at present.

The routing table configuration is available on the serial port and front panel. This is a deliberate decision, to avoid loss of 
connectivity when remotely configuring the F60.

By default, the value of the destination field is 127.0.0.1 for all static routes (1 to 6). This is equivalent to saying that the 
static routes are not configured. When the destination address is 127.0.0.1, the mask and gateway also must be kept on 
default values.

By default, the value of the route gateway address is 127.0.0.1. This means that the default route is not configured.

To add a route:

1. Use any of the static network route entries numbered 1 to 6 to configure a static network route. Once a route 
destination is configured for any of the entries 1 to 6, that entry becomes a static route and it must meet all the rules 
listed in the next section, General Conditions to be Satisfied by Static Routes.

2. To configure the default route, enter a default gateway address. Once a default gateway address is configured, it 
must be validated against condition 2 of the General Conditions to be Satisfied by Static Routes, where the route 
gateway must be on a connected network.

To delete a route:

1. Replace the route destination with the default loopback address of 127.0.0.1. When deleting a route, the mask and 
gateway also must be brought back to default values.

2. Delete the default route by replacing the default gateway with the default value of 127.0.0.1.

General conditions to be satisfied by static routes
The following rules are validated internally:

• The route mask has IP mask format. In binary this needs to be a set of contiguous bits of 1 from left to right, followed 
by one or more contiguous bits of 0.

• The route destination and mask must match. This can be verified by checking that 
RtDestination and RtMask = RtDestination
Example of good configuration: RtDestination = 10.1.1.0; Rt Mask = 255.255.255.0
Example of bad configuration: RtDestination = 10.1.1.1; Rt Mask = 255.255.255.0

The following rules must be observed when you configure static routes:

• The route destination must not be a connected network

• The route gateway must be on a connected network. This rule applies to the gateway address of the default route as 
well. This can be verified by checking that:
(RtGwy & Prt1Mask) == (Prt1IP & Prt1Mask) || (RtGwy & Prt2Mask) == (Prt2IP & Prt2Mask) || (RtGwy & Prt3Mask) == (Prt3IP 
& Prt3Mask)

where

& is the bitwise-AND operator

== is the equality operator

|| is the logical OR operator

 RT1 NET MASK:
255.0.0.0

Range: standard IPV4 subnet mask format

 RT1 GATEWAY:
127.0.0.1

Range: standard IPV4 unicast address format
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Routing behavior compared to previous releases
Prior to release 7.10, UR devices did not have an explicit manner of configuring routes. The only available route was the 
default route configured as part of the network settings (port gateway IP address). This limited the ability to route to 
specific destinations, particularly if these destinations were reachable through a different interface than the one on which 
the default gateway was.

Starting with UR 7.10, up to six static network routes can be configured in addition to a default route. The default route 
configuration was also moved from the network settings into the routing section.

The figure shows an example of topology that benefits from the addition of static routes.

Figure 5-17: Using static routes 

In the figure, the UR connects through the following two Ethernet ports:

• Port 1 (IP address 10.1.1.2) connects the UR to LAN 10.1.1.0/24 and to the Internet through Router1. Router1 has an 
interface on 10.1.1.0/24 and the IP address of this interface is 10.1.1.1.

• Port 2 (IP address 10.1.2.2) connects the UR to LAN 10.1.2.0/24 and to the EnerVista software through Router2. Router2 
has an interface on 10.1.2.0/24 and the IP address of this interface is 10.1.2.1.

The configuration before release 7.10 was as follows:

• PRT1 IP ADDRESS = 10.1.1.2
PRT1 SUBNET IP MASK = 255.255.255.0
PRT1 GWY IP ADDRESS = 10.1.1.1
PRT2 IP ADDRESS = 10.1.2.2
PRT2 SUBNET IP MASK = 255.255.255.0

The behavior before release 7.10 was as follows. When sending packets to EnerVista, the UR noticed that the destination 
was not on a connected network and it tried to find a route to destination. Since the default route was the only route it 
knew, it used it. Yet EnerVista was on a private network, which was not reachable through Router1. Hence a destination 
unreachable message was received from the router.

The configuration starting with release 7.10 is as follows:

• PRT1 IP ADDRESS = 10.1.1.2
PRT1 SUBNET IP MASK = 255.255.255.0
PRT2 IP ADDRESS = 10.1.2.2
PRT2 SUBNET IP MASK = 255.255.255.0
IPV4 DEFAULT ROUTE: GATEWAY ADDRESS = 10.1.1.1
STATIC NETWORK ROUTE 1: RT1 DESTINATION = 10.1.3.0/24; RT1 NET MASK = 255.255.255.0; and RT1 GATEWAY = 
10.1.2.1
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Public network

UR

P1
IP1/

MAC1

P2 
IP2/

MAC2

ML3000

10.1.1.0/24
10.1.2.0/24

P3 
IP3/

MAC3

Router2

Router1

10.1.3.0/24

.1

.1

.2 .2

859714A1.vsd



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-51

5

The behavior since release 7.10 is as follows. There is one added static network route to the destination 10.1.3.0/24, where 
a computer running EnerVista is located. This static route uses a different gateway (10.1.2.1) than the default route. This 
gateway is the address of Router2, which has knowledge about 10.1.3.0 and is able to route packets coming from the UR 
and destined to EnerVista.

Show routes and ARP tables
This feature is available on the Web interface, where the main menu contains an additional Communications menu and 
two submenus:

• Routing Table

• ARP Table

The tables outline the information displayed when the two submenus are selected.

Table 5-7: Routing table information

Table 5-8: IP ARP information

5.3.5.8  Modbus protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  MODBUS PROTOCOL

The serial communication ports utilize the Modbus protocol, unless the port is configured for DNP or IEC 60870-5-103 
operation. This allows the EnerVista UR Setup software to be used on the port. UR devices operate as Modbus slave 
devices only.

For more information on the protocol, including the memory map table, see the UR Family Communications Guide.

MODBUS SLAVE ADDRESS — When using the Modbus protocol on the RS232 port, the F60 responds regardless of the 
MODBUS SLAVE ADDRESS programmed. For the RS485 port, each device on the serial bus must have a unique slave address 
from 1 to 254. Address 0 and addresses from 248 and up are reserved by the Modbus protocol specification, and so their 
use here is not recommended. Address 0 is the broadcast address to which all Modbus slave devices listen. Addresses do 
not have to be sequential, but no two devices can have the same address or conflicts resulting in errors occur. Generally, 
starting at 1, set each device added to the link to use the next higher address. When using Modbus TCP/IP, the client must 
use the programmed MODBUS SLAVE ADDRESS value in the Unit Identifier field.

MODBUS TCP PORT NUMBER — Modbus over TCP/IP can also be used on any of the Ethernet ports. The listening TCP port 502 
is reserved for Modbus communications, and only in exceptional cases when MODBUS TCP PORT NUMBER is set to any other 
port. The MODBUS TCP PORT NUMBER setting sets the TCP port used by Modbus on Ethernet. A MODBUS TCP PORT NUMBER of 
0 disables Modbus over TCP/IP, meaning closes the Modbus TCP port. When the port number is changed to 0, the change 
takes effect when the F60 is restarted. When it is set to 0, use the front panel or serial port to communicate with the relay.

Field Description

Destination The IP address of the remote network to which this route points

Mask The network mask for the destination

Gateway The IP address of the next router to the remote network

Interface Interface through which the specified network can be reached

Field Description

IP Address The network address that corresponds to Hardware Address

Age (min) Age, in minutes, of the cache entry. A hyphen (-) means the address is local. 

Hardware Address LAN hardware address, a MAC address that corresponds to network address

Type Dynamic or Static

Interface Interface to which this address mapping has been assigned

 MODBUS PROTOCOL
  MODBUS SLAVE

ADDRESS: 254
Range: 1 to 254 in steps of 1

 MODBUS TCP PORT
NUMBER(502): 502

Range: 0 to 65535 in steps of 1
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5.3.5.9  Protocol selection
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  PROTOCOL

The PROTOCOL menu allows selection of one of the following protocols: DNP 3.0, IEC60870-104, or IEC60870-103.

SCADA PROTOCOL — This setting selects the SCADA protocol on which the unit communicates, among DNP3.0, IEC 60870-
104, and IEC 60870-103, with DNP being the default. Options depend on order code. For any change to take effect, restart 
the unit.

MMS CONNECTION TIMEOUT — This setting specifies a time delay for the detection of network TCP connection lost. If there is 
no data traffic on the TCP connection for greater than the time specified by this setting, the connection is terminated. This 
frees up the connection to be re-used by a client. A setting of 10 seconds disables this timer. The TCP connection then is 
managed by a standard TCP KeepAlive message sequence. These messages are transmitted every 20 seconds when there 
is no MMS communication between the relay and the client. If there are no responses to the TCP KeepAlive messages, the 
connection is closed. For any change to this setting to take effect, restart the unit. The change takes effect for a new 
connection. For any existing open connection when the change is made, close and re-open the connection. Cycling power 
to the relay also applies the new setting.

The table shows which of DNP 3.0, IEC 60870-5-104, IEC 60870-5-103, and IEC 61850 protocols are operational on the 
RS232, RS485, and Ethernet ports. It shows all possible combinations of the PROTOCOL and DNP CHANNEL 1(2) PORT settings.

Do not set more than one protocol to the same TCP/UDP port number, as this results in unreliable operation of 
those protocols.

 PROTOCOL
  SCADA PROTOCOL:

DNP 3.0
Range: DNP 3.0, IEC 60870-5-104, IEC 60870-5-103

 MMS CONNECTION
TIMEOUT: 120 s

Range: 10 to 7200 in steps of 10

 IEC61850 EDITION:
Edition2

Range: Edition1, Edition2
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Table 5-9: Port and protocol combinations

IEC61850 EDITION — Switches between Editions 1 and 2 of the IEC 61850 protocol. For Process Bus GOOSE, the setting is 
fixed at Edition 2. When switching, settings default with the change, except GGIO1, GGIO2, GGIO4, and those for the 
graphical front panel. A message displays that a reboot is required, which can be done using Maintenance > Reboot Relay 
Command.

5.3.5.10  DNP protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  DNP PROTOCOL

PROTOCOL 
setting

DNP CHANNEL 1(2) PORT 
settings

RS232 RS485 Ethernet

DNP Channel 1: Eth TCP
Channel 2: Eth TCP

Modbus Modbus DNP, Modbus, IEC 61850

Channel 1: Eth TCP
Channel 2: none

Modbus Modbus DNP, Modbus, IEC 61850

Channel 1: none
Channel 2: Eth TCP

Modbus Modbus DNP, Modbus, IEC 61850

Channel 1: Eth UDP
Channel 2: none

Modbus Modbus DNP, Modbus, IEC 61850

Channel 1: Eth TCP
Channel 2: RS485

Modbus DNP DNP, Modbus, IEC 61850

Channel 1: Eth TCP
Channel 2: RS232

DNP Modbus DNP, Modbus, IEC 61850

Channel 1: Eth UDP
Channel 2: RS485

Modbus DNP DNP, Modbus, IEC 61850

Channel 1: Eth UDP
Channel 2: RS232

DNP Modbus DNP, Modbus, IEC 61850

Channel 1: RS485
Channel 2: Eth TCP

Modbus DNP DNP, Modbus, IEC 61850

Channel 1: RS232
Channel 2: Eth TCP

DNP Modbus DNP, Modbus, IEC 61850

Channel 1: RS485
Channel 2: RS232

DNP DNP Modbus, IEC 61850

Channel 1: RS232
Channel 2: RS485

DNP DNP Modbus, IEC 61850

Channel 1: RS485
Channel 2: none

Modbus DNP Modbus, IEC 61850

IEC 104 Modbus Modbus IEC 104, Modbus, IEC 61850

IEC 103 Modbus IEC 103 Modbus, IEC 61850

 DNP PROTOCOL
   DNP CHANNELS


See below

 DNP ADDRESS:
1

Range: 0 to 65535 in steps of 1

  DNP NETWORK
 CLIENT ADDRESSES

See below

 DNP TCP/UDP PORT
NUMBER(20000): 20000

Range: 0 to 65535 in steps of 1

 DNP UNSOL RESPONSE
FUNCTION: Disabled

Range: Enabled, Disabled

 DNP UNSOL RESPONSE
TIMEOUT: 5 s

Range: 0 to 60 s in steps of 1

 DNP UNSOL RESPONSE
MAX RETRIES: 10

Range: 1 to 255 in steps of 1
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 DNP UNSOL RESPONSE
DEST ADDRESS: 1

Range: 0 to 65519 in steps of 1

 DNP CURRENT SCALE
FACTOR: 1

Range: 0.001, 0.01. 0.1, 1, 10, 100, 1000, 10000, 
100000, 1000000, 10000000, 100000000

 DNP VOLTAGE SCALE
FACTOR: 1

Range: 0.001, 0.01. 0.1, 1, 10, 100, 1000, 10000, 
100000, 1000000, 10000000, 100000000

 DNP POWER SCALE
FACTOR: 1

Range: 0.001, 0.01. 0.1, 1, 10, 100, 1000, 10000, 
100000, 1000000, 10000000, 100000000

 DNP ENERGY SCALE
FACTOR: 1

Range: 0.001, 0.01. 0.1, 1, 10, 100, 1000, 10000, 
100000, 1000000, 10000000, 100000000

 DNP PF SCALE
FACTOR: 1

Range: 0.001, 0.01. 0.1, 1, 10, 100, 1000, 10000, 
100000, 1000000, 10000000, 100000000

 DNP OTHER SCALE
FACTOR: 1

Range: 0.001, 0.01. 0.1, 1, 10, 100, 1000, 10000, 
100000, 1000000, 10000000, 100000000

 DNP CURRENT DEFAULT
DEADBAND: 30000

Range: 0 to 100000000 in steps of 1

 DNP VOLTAGE DEFAULT
DEADBAND: 30000

Range: 0 to 100000000 in steps of 1

 DNP POWER DEFAULT
DEADBAND: 30000

Range: 0 to 100000000 in steps of 1

 DNP ENERGY DEFAULT
DEADBAND: 30000

Range: 0 to 100000000 in steps of 1

 DNP PF DEFAULT
DEADBAND: 30000

Range: 0 to 100000000 in steps of 1

 DNP OTHER DEFAULT
DEADBAND: 30000

Range: 0 to 100000000 in steps of 1

 DNP TIME SYNC IIN
PERIOD: 1440 min

Range: 1 to 10080 min. in steps of 1

 DNP MESSAGE FRAGMENT
SIZE: 240

Range: 30 to 2048 in steps of 1

 DNP OBJECT 1
DEFAULT VARIATION: 2

Range: 1, 2

 DNP OBJECT 2
DEFAULT VARIATION: 2

Range: 1, 2, 3

 DNP OBJECT 20
DEFAULT VARIATION: 1

Range: 1, 2, 5, 6

 DNP OBJECT 21
DEFAULT VARIATION: 1

Range: 1, 2, 9, 10

 DNP OBJECT 22
DEFAULT VARIATION: 1

Range: 1, 2, 5, 6

 DNP OBJECT 23
DEFAULT VARIATION: 1

Range: 1, 2, 5, 6

 DNP OBJECT 30
DEFAULT VARIATION: 1

Range: 1, 2, 3, 4, 5

 DNP OBJECT 32
DEFAULT VARIATION: 1

Range: 1, 2, 3, 4, 5, 7

 DNP NUMBER OF PAIRED
CONTROL POINTS: 0

Range: 0 to 32 in steps of 1
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The Distributed Network Protocol (DNP) allows for the optimization of control and data acquisition between the equipment 
in the substation and the central control center. The protocol is scalable; that is, it is designed to be compatible with the 
latest high speed LAN technology yet still be implemented over slower speed serial links.

The DNP improves upon many master-slave protocols by improving overall communication performance requirements 
and provides time-stamping with millisecond accuracy.

The F60 supports DNP version 3.0.

DNP is enabled when the SETTINGS  PRODUCT SETUP  COMMUNICATIONS  PROTOCOL setting is set to DNP 3.0. The F60 
can be used as a DNP slave device connected to multiple DNP masters (usually an RTU or a SCADA master station). Since 
the F60 maintains two sets of DNP data change buffers and connection information, two DNP masters can actively 
communicate with the F60 at one time.

DNP is not available using the USB port on the graphical front panel.

See the UR Family Communications Guide for more information on DNP.

The DNP Channels sub-menu is shown.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  DNP PROTOCOL  DNP CHANNELS

The DNP CHANNEL 1 PORT and DNP CHANNEL 2 PORT settings select the communications port assigned to the DNP protocol 
for each channel. Once DNP is assigned to a serial port, DNP is the only protocol running on that port; Modbus or IEC 
60870-5-103 are disabled. If DNP is assigned to RS485, the protocol must be set to DNP on the serial port configuration as 
well, for the change to take effect. When the DNP CHANNEL 1(2) PORT setting is set to “Network - TCP,” the channel 1(2) DNP 
protocol can be used over TCP/IP on the Ethernet ports. When this value is set to “Network - UDP,” the DNP protocol can be 
used over UDP/IP on channel 1 only. The "Front Panel - RS232" setting does not apply to the graphical front panel; when 
selected the DNP client cannot establish a connection on a USB port.

For any change to take effect, restart the relay.

The DNP ADDRESS setting is the DNP slave address. This number identifies the F60 on a DNP communications link. Assign a 
unique address to each DNP slave.

The F60 can specify a maximum of five clients for its DNP connections. These are IP addresses for the controllers to which 
the F60 can connect. The settings follow.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  DNP PROTOCOL  DNP NETWORK CLIENT ADDRESSES

The DNP TCP/UDP PORT NUMBER setting is for normal DNP operation. To close the port, set the port number to 0. The change 
takes effect when the F60 is restarted.

 DNP TCP CONNECTION
TIMEOUT: 120 s

Range: 10 to 7200 s in steps of 1

 DNP EVENT TIME BASE:
LOCAL

Range: UTC, LOCAL

 DNP CHANNELS
  DNP CHANNEL 1 PORT:

NONE
Range: NONE, COM1 - RS485, COM2 - RS485, FRONT 
PANEL - RS232, NETWORK - TCP, NETWORK - UDP

 DNP CHANNEL 2 PORT:
NONE

Range: NONE, COM1 - RS485, COM2 - RS485, FRONT 
PANEL - RS232, NETWORK - TCP

Do not set more than one protocol to the same TCP/UDP port number, as this results in unreliable operation of 
those protocols.

 DNP NETWORK
 CLIENT ADDRESSES  CLIENT ADDRESS 1:

0.0.0.0
Range: standard IP address



 CLIENT ADDRESS 5:
0.0.0.0

Range: standard IP address
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The DNP UNSOL RESPONSE FUNCTION is set to “Disabled” for RS485 applications since there is no collision avoidance 
mechanism. The DNP UNSOL RESPONSE TIMEOUT sets the time the F60 waits for a DNP master to confirm an unsolicited 
response. The DNP UNSOL RESPONSE MAX RETRIES setting determines the number of times the F60 retransmits an 
unsolicited response without receiving confirmation from the master; a value of “255” allows infinite re-tries. The DNP 
UNSOL RESPONSE DEST ADDRESS is the DNP address to which all unsolicited responses are sent. The IP address to which 
solicited responses are sent is determined by the F60 from the current TCP connection or the most recent UDP message.

The DNP scale factor settings are numbers used to scale analog input point values. These settings group the F60 analog 
input data into the following types: current, voltage, power, energy, power factor, and other. Each setting represents the 
scale factor for all analog input points of that type. For example, if the DNP VOLTAGE SCALE FACTOR setting is set to “1000,” 
all DNP analog input points that are voltages are returned with values 1000 times smaller (for example, a value of 72000 V 
on the F60 is returned as 72). These settings are useful when analog input values must be adjusted to fit within certain 
ranges in DNP masters. Note that a scale factor of 0.1 is equivalent to a multiplier of 10 (that is, the value is 10 times larger).

The DNP DEFAULT DEADBAND settings determine when to trigger unsolicited responses containing analog input data. These 
settings group the F60 analog input data into the following types: current, voltage, power, energy, power factor, and other. 
Each setting represents the default deadband value for all analog input points of that type. For example, to trigger 
unsolicited responses from the F60 when any current values change by 15 A, the DNP CURRENT DEFAULT DEADBAND setting 
is set to “15.” Note that these settings are the deadband default values. DNP object 34 points can be used to change 
deadband values, from the default, for each individual DNP analog input point. For any change to take effect, restart the 
relay. Whenever power is removed and re-applied to the F60, the default deadbands are in effect.

The DNP TIME SYNC IIN PERIOD setting determines how often the Need Time Internal Indication (IIN) bit is set by the F60. 
Changing this time allows the DNP master to send time synchronization commands more or less often, as required.

The DNP MESSAGE FRAGMENT SIZE setting determines the size, in bytes, at which message fragmentation occurs. Large 
fragment sizes allow for more efficient throughput; smaller fragment sizes cause more application layer confirmations to 
be necessary, which provides more robust data transfer over noisy communication channels.

The DNP OBJECT 1 DEFAULT VARIATION to DNP OBJECT 32 DEFAULT VARIATION settings select the DNP default variation 
number for object types 1, 2, 20, 21, 22, 23, 30, and 32. The default variation refers to the variation response when variation 
0 is requested and/or in class 0, 1, 2, or 3 scans. See the DNP Implementation section in the UR Family Communications 
Guide.

The DNP binary outputs typically map one-to-one to IED data points. That is, each DNP binary output controls a single 
physical or virtual control point in an IED. In the F60 relay, DNP binary outputs are mapped to virtual inputs. However, some 
legacy DNP implementations use a mapping of one DNP binary output to two physical or virtual control points to support 
the concept of trip/close (for circuit breakers) or raise/lower (for tap changers) using a single control point. That is, the DNP 
master can operate a single point for both trip and close, or raise and lower, operations. The F60 can be configured to 
support paired control points, with each paired control point operating two virtual inputs. The DNP NUMBER OF PAIRED 
CONTROL POINTS setting allows configuration of 0 to 32 binary output paired controls. Points not configured as paired 
operate on a one-to-one basis.

The DNP TCP CONNECTION TIMEOUT setting specifies a time delay for the detection of dead network TCP connections. If 
there is no data traffic on a DNP TCP connection for greater than the time specified by this setting, the connection is 
aborted by the F60. This frees up the connection to be re-used by a client. For any change to take effect, restart the relay.

5.3.5.11  DNP / IEC 60870-5-104 point lists
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  DNP / IEC104 POINT LISTS

Check the “DNP Points Lists” F60 web page to view the analog inputs and/or binary inputs points lists. This page 
can be viewed with a web browser by entering the IP address of the F60 Ethernet port employed to access the F60 
Main Menu, then by clicking the Device Information Menu item, then the DNP Points Lists item.

 DNP / IEC104
 POINT LISTS   BINARY INPUT / MSP

 POINTS
See below

  ANALOG INPUT / MME
 POINTS

See below
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Up to 256 binary and up to 256 analog input points for the DNP protocol, or the MSP and MME points for IEC 60870-5-104 
protocol, can be configured. The value for each point is user-programmable and can be configured by assigning FlexLogic 
operands for binary inputs / MSP points or FlexAnalog parameters for analog inputs / MME points.

The menu for the binary input points (DNP) or MSP points (IEC 60870-5-104) follows.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  DNP / IEC104 POINT LISTS  BINARY INPUT / MSP POINTS

Up to 256 binary input points can be configured for the DNP or IEC 60870-5-104 protocols. The points are configured by 
assigning an appropriate FlexLogic operand. See the Introduction to FlexLogic section in this chapter for the range of 
assignable operands.

Changes to the DNP / IEC 60870-5-104 point lists take effect when the F60 is restarted.

The menu for the analog input points (DNP) or MME points (IEC 60870-5-104) follows.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  DNP / IEC104 POINT LISTS  ANALOG INPUT / MME 
POINTS

Up to 256 analog input points can be configured for the DNP or IEC 60870-5-104 protocols. The analog point list is 
configured by assigning an appropriate FlexAnalog parameter to each point. See the FlexAnalog Parameters section in 
Appendix A for the range of assignable parameters.

Changes to the DNP / IEC 60870-5-104 point lists take effect when the F60 is restarted.

5.3.5.12  IEC 61850 protocol

The IEC 61850 settings are accessible in EnerVista software or a substation configuration language (SCL) generating tool. 
The path is Settings > Product Setup > Communications > IEC 61850 or Settings > IEC 61850. The settings are not 
accessible from the front panel of the device.

 BINARY INPUT / MSP
 POINTS  Point: 0

Off
Range: FlexLogic operand

 Point: 1
Off

Range: FlexLogic operand



 Point: 255
Off

Range: FlexLogic operand

 ANALOG INPUT / MME
 POINTS  Point: 0

Off
Range: any FlexAnalog parameter

 Point: 1
Off

Range: any FlexAnalog parameter



 Point: 255
Off

Range: any FlexAnalog parameter

The DNP / IEC 60870-5-104 point lists always begin with point 0 and end at the first “Off” value. Since DNP / IEC 
60870-5-104 point lists must be in one continuous block, any points assigned after the first “Off” point are ignored.

The F60 is provided with optional IEC 61850 communications. This feature is specified as a software option at 
the time of ordering. See the Order Codes section in chapter 2 for details.

IEC 61850 messaging can form part of protection schemes. Consider IEC 61850 settings with the same criticality as 
protection element settings. To ensure reliable performance of protection schemes utilizing IEC 61850 messaging, 
route IEC 61850 traffic on a separate port from SCADA communications, or use redundant, independent ports, and 
a high-speed network recovery method, such as PRP.
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Overview
IEC 61850 is a series of international standards and technical reports applicable to power utility automation systems. It 
includes semantics, abstract communication services, specific communication services, performance specifications, 
network engineering guidelines, configuration description methodologies, and engineering processes. The standard 
enables interoperability among intelligent electronic devices (IEDs) from different suppliers and interoperability among 
software configuration tools from different suppliers. Interoperability in this case is the ability for IEDs to operate on the 
same network or communication path sharing information and commands, and for configuration tools to understand 
each other's configuration files.

The UR family supports a large subset of IEC 61850 features. These are detailed in the UR Family Communications Guide 
and include the information model, GOOSE publish, GOOSE subscribe, buffered report server, unbuffered report server, and 
Manufacturing Message Specification (MMS) query, read, write, and control services. In addition, the URs and their 
EnerVista UR Setup software support IEC 61850 Substation Configuration Language (SCL) file import/export and merging.

Many settings of UR protection, control, and monitoring elements, that is to say elements that are not concerned with the 
IEC 61850 protocol, can nevertheless be accessed via IEC 61850. These settings are documented elsewhere in this Settings 
chapter. This section of the Settings chapter deals solely with the settings that configure the IEC 61850 protocol itself.

The maximum number of simultaneous clients supported by the UR family is five.

IEC 61850 Editions 1 and 2
This release supports IEC 61850 Edition 1 and Edition 2. The default is Edition 2.

Select IEC 61850 Edition 1 or Edition 2 under Settings > Product Setup > Communications > Protocol. When a non-
HardFiber Process Bus Module is present, only Edition 2 is used. Switching defaults the IEC 61850 settings, except GGIO1, 
GGIO2, GGIO4, and those for the graphical front panel. A message displays that a reboot is required, which can be done 
using Maintenance > Reboot Relay Command.

Edition 2.0 is used with certain modifications according to IEC/TR 61850-90-5. Only edition 2.0 61850 configuration tools 
can interoperate with edition 2.0 devices, such as the UR 7.3x, 7.4x, or 7.6x release. When using Edition 2, the UR release 
uses edition 2.0 SCL, which differs from edition 1.0 SCL. 

Fixed GOOSE, GSSE, and Edition 1 report services are not supported beyond version 7.2x. UR devices using these features 
must be set to use configurable GOOSE to communicate with a 7.3x or later device.

When set to Edition 1

• The Test Flag in the Tx GOOSE message header is set to TRUE when the TEST MODE FUNCTION is set to Forcible or 
Isolated

• The test flag in the received GOOSE message header is not validated

• Routable GOOSE is not supported

• Process Buss Module is not supported (order code 85, 86, or 87)

• Process Bus GOOSE is not supported

• The FlexLogic category does not display in the IEC 61850 panels in the EnerVista UR Setup software

• With SCL file import, for Edition 1 the IP address in the ConnectedAP element must match one IP address of the device, 
while for Edition 2 one of the three IP addresses in the ConnectedAP element must match

The fields that display in the software depend on the Edition selected and the F60. Differences are noted in the sections 
that follow. If required, consult the Model Implementation Conformance Statement (MICS) section of the UR Family 
Communications Guide to understand what applies to your setup.

EnerVista setup for IEC 61850
The EnerVista UR Setup software provides the interface to configure F60 settings for the IEC 61850 protocol. This section 
describes this interface. The software also supports import/export and merging of IEC 61850 Substation Configuration 
Language (SCL) files as documented in the UR Family Communications Guide.

The IEC 61850 protocol configuration settings cannot be accessed through the UR front panel and are instead accessible 
with the EnerVista software, via MMS query, read, and write services, or via 61850 SCL file transfer. Accordingly, whereas 
other settings are presented in this manual as they appear on the front panel, IEC 61850 settings are presented as they 



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-59

5

appear in the software. See the UR Family Communications Guide for MMS and SCL access. Note that if you update the IEC 
61850 settings in the EnerVista software by writing to them by MMS while the corresponding IEC 61850 panel is open in 
EnerVista, you need to close then open the panel in EnerVista for the correct readings to display.

IEC 61850 protocol configuration settings are accessed through software panels that are selected either in the Online 
Window area (see figure) or the Offline Window area in the EnerVista software.

The EnerVista software also includes an interface that is compatible with firmware versions 5.0 to 7.2 to configure 
subscribers. Use the Simplified GOOSE Configurator in the Offline Window area.

Figure 5-18: IEC 61850 protocol panel in EnerVista software (Edition 2)

The IEC 61850 window is divided into a navigation pane on the left and a settings panel on the right. You expand and click 
an option on the left to display its panel on the right. The following figure shows an example for Server Configuration. The 
SETTING column contains the names of the settings, and the PARAMETER column is used to enter the settings. Hovering 
the mouse over a setting name displays a tool-tip showing the 61850 information model name of the setting or its location 
in SCL files.

Figure 5-19: IEC 61850 panel (Edition 2)
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Opening the IEC 61850 window while online causes the UR Setup software to retrieve and import an SCL file from the F60. 
This System Configuration Description (SCD) file contains all the settings in the UR at the time of the file request, both those 
that are mapped into the IEC 61850 information model (that is, the "public" sections) and those that are not in the model 
(that is, the "private" section). The UR EnerVista Setup software imports all of these settings into the current session, not just 
those in the IEC 61850 window. To avoid loss of any unsaved setting changes made in other panels during the current 
session, all other panels for the F60 must be closed before the IEC 61850 panel can be opened, and the software prompts 
for this when applicable. Panels for other devices can be open concurrently to facilitate parameter coordination.

When CyberSentry security is enabled, editable settings depend on the user role logged in. For example, an Administrator 
and Engineer can change settings. If prompted for a "Settings password," it means the Administrator or Engineer 
password.

The Restore button restores settings in the window to their last saved values. The Default button reverts settings in the 
window to factory default values or Oscillography, Data Logger, or FlexLogic Equation Editor pre-configured values. The 
Reset button reverts all IEC 61850 settings to the factory default values, not just the current window. (In other settings 
windows, the button reverts settings in the window to factory default values.)

When a setting is enabled, its panel continues to read Disabled until relaunched. There is no polling capability to update 
automatically the IEC 61850 readings, so the panel needs to be closed then opened for the correct status to display. Good 
practice is to close any panel not in use because changes being made by other users too are reflected only upon relaunch 
of the panel.

Some of the IEC 61850 settings use floating point data, which guarantees accurate representation of real numbers up to 
seven digits. Numbers with more than seven digits are approximated within a certain precision. This can result in 
differences between what is entered and what is saved, and for example results in differences shown on a settings 
comparison report.

Create CID and settings files
A configured IED description (CID) file is created when settings are sent to the device, for example from the Offline Window 
area. A CID file can be created by right-clicking a device in the Offline Window area and selecting the Save As option.

When the Save button is clicked in the online IEC 61850 window, UR Setup software prepares a CID file containing all the 
settings of the UR and sends the CID file to the F60. Upon receipt, the F60 checks the CID file for correctness, going out of 
service, then back into service when the CID file is accepted. The software displays a message when the F60 is running the 
new settings, confirming successful transfer. This process can take a minute or so due to the amount of processing 
required by the software and the F60.

When the Save button is clicked in the offline IEC 61850 window, UR Setup software saves to local storage, for example the 
hard drive, a .urs file containing all settings of the UR.

View IID/CID files
The file types are described as follows:

• IID — Instantiated IED capability description file — Actual settings on UR

• CID — Configured IED description file — Settings sent to the UR (may or may not contain the present settings)

The IID file type applies to IEC 61850 Edition 2 only.

IID and CID files are viewable. For example, after modifying settings in the IEC 61850 panels and clicking Developer IID/
CID Viewer in the software, a CID file generates and an SCL Viewer shows the updated CID file content. There are no edit 
or save functions; use instead the Back Up and Restore Settings instructions later in this document to save the files.

Searches are case insensitive.



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-61

5

Figure 5-20: View CID settings file (Edition 2)

Server configuration
The Server Configuration panel contains IEC 61850 settings relevant to the server functions of the IED implementation.

The path is Settings > Product Setup > Communications > IEC 61850 > Server Configuration.

The following settings are available, where <iedName> is a syntactic variable representing the present value of the IED 
NAME setting.

IED NAME
Range: 1 to 58 VisibleString characters
Default: TEMPLATE

The value entered sets the IED name used by IEC 61850 for the F60. An IED name unique within the network must be 
entered for proper operation. Valid characters are upper and lowercase letters, digits, and the underscore (_) character. 
The first character must be a letter.

The IED NAME and the Product LD inst name comprise the <LDName> for a product. The longest LD inst are "Master" 
and "System" at six characters, with Master being fixed and the others configurable with the configurable Logical device 
feature. So the IED NAME needs to be restricted to 58 characters to meet a 64 character limit.

Access Point
Range: S1, S2, S3
Default: S1

This setting applies to IEC 61850 Edition 1. It is the subnetwork.

Location
Range: 0 to 255 ASCII characters
Default: Location

The value entered sets the value of the data attribute <LDName>/LPHD1.PhyNam.location. This data attribute is 
provided by the protocol to allow the user to declare where the equipment is installed.

Latitude
Range: -90.000 to 90.000 degrees in steps of 0.001 degree
Default: 0.000 deg

The value entered sets the value of the data attribute <LDName>/LPHD1.PhyNam.latitude. This data attribute is provided 
by the protocol to declare the geographical position of the device in WGS84 coordinates -latitude. Negative values 
indicate a southern latitude. WGS refers to the world geodetic system, which is used in global positioning systems (GPS), 
and 84 is the current version of the standard.
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Longitude
Range: -180.000 to 180.000 degrees in steps of 0.001 degree
Default: 0.000 deg

The value entered sets the value of the data attribute <LDName>/LPHD1.PhyNam.longitude. This data attribute is 
provided by the protocol to declare the geographical position of the device in WGS84 coordinates -longitude. Negative 
values indicate a western longitude.

Altitude
Range: 0 to 10,0000 m in steps of 1 m
Default: 0 m

The value entered sets the value of the data attribute <LDName>/LPHD1.PhyNam.altitude. This data attribute is provided 
by the protocol to declare the geographical position of the device in WGS84 coordinates - altitude.

Prefix for GGIO1
Range for Edition 2: 0 to 11 VisibleString characters
Range for Edition 1: 0 to 6 VisibleString characters
Default: 

This setting sets the LN Prefix of the FlexLogic operand interface logical node GGIO1 that is described in the GGIO1 
section later. Valid characters are upper and lowercase letters, digits, and the underscore (_) character. The first 
character must be a letter. UR Setup software does not allow entry of a prefix that duplicates any other GGIO1 prefix 
that is used by the product, such as ConIn and ConOut.

Prefix for GGIO2
Range for Edition 2: 0 to 11 VisibleString characters
Range for Edition 1: 0 to 6 VisibleString characters
Default: 

This setting sets the LN Prefix of the Virtual Inputs Interface logical node GGIO2 that is described in the GGIO2 section 
later. Valid characters are upper and lowercase letters, digits, and the underscore (_) character. The first character must 
be a letter. UR Setup software does not allow entry of a prefix that duplicates any other GGIO2 prefix that is used by the 
product.

Prefix for GGIO4
Range for Edition 2: 0 to 11 VisibleString characters
Range for Edition 1: 0 to 6 VisibleString characters
Default: 

This setting sets the LN Prefix of the FlexAnalog operand interface logical node GGIO4 that is described in the GGIO4 
section later. Valid characters are upper and lowercase letters, digits, and the underscore (_) character. The first 
character must be a letter. UR Setup software does not allow entry of a prefix that duplicates any other GGIO4 prefix 
that is used by the product.

LLN0.Mod.ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: sbo-with-normal-security

This setting specifies the control service that clients must use to control the TEST MODE FUNCTION of the F60. An "on" 
control to <LDName>/LLN0.Mod changes TEST MODE FUNCTION to Disabled, a test control changes it to Forcible, and a 
test/blocked control changes it to Isolated.

Configuration Type
Range: G2, E3-2.0
Default: G2

This setting is read only. It specifies the method used to describe GOOSE subscription configuration in SCL. See the UR 
Family Communications Guide for details. In the G2 mode, the CID file contains IED elements for IEDs subscribed to by 
this IED containing GOOSE subscription information. In the E3 2.0 mode, the CID file has only one IED element and 
GOOSE subscription information is coded in data objects in the standard LGOS logical node used to monitor reception of 
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the subscribed GOOSE. UR 7.30 or later accepts either mode. The set value is for the entire EnerVista installation and is 
preserved between sessions. To change this global field, click File > Preferences and access the IEC 61850 panel; you do 
not need to be connected to the device.

Logical devices
The Logical Devices panel contains IEC 61850 settings relevant to the configurable logical devices feature, wherein logical 
device naming can be reconfigured and logical nodes re-assigned.

The path is Settings > Product Setup > Communications > IEC 61850 > Logical Devices.

Figure 5-21: Default IEC 61850 Logical Devices panel with devices middle and nodes right (Edition 2)

To configure logical devices and nodes:

1. Right-click an entry and edit an existing device, add a new one, or move a logical node. The rest of this section 
explains the window and how to perform these actions.

The default logical device categories are as follows:

• Master — Communications, including GOOSE, reports, Remote I/O, Virtual Inputs, Modbus, DNP, and setting group 
control

• System — Power system devices: breakers, switches, CTs, VTs, and so on, including interfaces to these, such as AC 
inputs, contact I/O, transducer I/O, HardFiber I/O

• Prot — Protection and protection-related functions

• Ctrl — Control and monitoring functions

• Meter — Metering and measurement functions

• Gen — FlexLogic, Virtual Outputs, non-volatile latches, FlexElements, recording (for example oscillography), security, 
front panel, clock

• PBus — UR Process Bus Module functions, such as SV subscription, AC Banks, and process bus Time Synchronization. 
Order code requires a Process Bus Module. Logical device is read-only.

For the Master logical device, the following logical nodes have fixed assignment:

• The LLN0 in the Master logical device, which includes setting group, GOOSE and report control blocks, and datasets

• LPHD1 — Models common issues for physical devices

• GGIO1 — For unmapped FlexLogic operands

• GGIO2 — For Virtual Input control

• GGIO3 — For RxGOOSE Inputs

• GGIO4 — For unmapped FlexAnalog operands
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• LGOS logical nodes — For GOOSE subscription

The Logical Devices panel has middle and right panes. The middle pane has a list of the instantiated logical devices in the 
sequence that they appear in SCL, with one device selected. The right pane has a list of the logical nodes presently 
assigned to the selected logical device in lexicographic order by logical node name.

In the middle pane logical devices are shown with their product-related name, followed in brackets by their function-
related ldName, and followed by the value of their confRev. In the following example, by right-clicking and editing, the 
Protection logical device has been set to instance name "Prot," the function-related name "Feeder1Prot" and the 
configuration revision "2016-03-07 08:46." The text is clipped on the right if the line is longer than the available width. The 
next paragraphs explain how to do this setup.

Figure 5-22: Protection logical node selected

Right-clicking a logical device displays the menu that allows insertion of a new logical device immediately below the 
selected one, deletion of the selected logical device, or editing the selected logical device's parameters. The insert option is 
disabled and greyed-out if there are already 16 logical devices instantiated. The delete option is disabled and greyed-out if 
the selected logical device is Master or it contains any logical nodes other than LLN0.

Figure 5-23: Menu for logical node

If the insert option is selected, or the edit option is selected for other than the Master logical device, a logical device 
parameters edit dialog opens.
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Figure 5-24: Insert new logical node (Edition 2)

If the edit option is selected for the Master logical device, the Product LD inst name setting is not editable.

Figure 5-25: Edit logical node

When the Ok button is clicked, the entered values for Product LD inst name and Functional ldName are checked for 
uniqueness within the UR, and they are updated in the pane.

The settings are explained as follows, where <iedName> is a syntactic variable representing the present value of the IED 
NAME setting. When adding or editing a logical device entry, these are the fields that need to be completed.

Product LD inst name
Range: 1 to 64 VisibleString characters
Default: as per the following table

Each logical device has this setting. The value is fixed at "Master" in the first logical device and configurable in all others. 
Valid characters are upper and lowercase letters, digits, and the underscore (_) character. The first character must be a 
letter. The entered value sets the logical device inst name. Each logical device inst name is required to be unique within 
the device, and it cannot be blank. Also, if the corresponding functional ldName setting is blank, the concatenation of the 

Customized logical nodes are not saved in the URS file.
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IED name and the logical device inst name must form an LDName that is unique within the network for proper operation. 
It is recommended that the length of the IED NAME plus the length of this setting be not greater than 64 to respect the 
requirements of IEC 61850 7 2:2010 22.2 for LDName.

The factory default configuration is for six logical devices with Product LD inst name settings and logical node 
assignments as per the following table.

Table 5-10: Factory default logical nodes

Functional ldName
Range: 0 to 64 VisibleString characters
Default: empty string

Each logical device has this setting. The value is configurable in all logical devices. Valid characters are upper and 
lowercase letters, digits, and the underscore (_) character. If the number of characters entered is greater than zero, the 
setting sets the value of the function-related name used in communications. If an ldName is entered, it must form an 
LDName that is unique within the network for proper operation. The standard recommends choosing this name 
according to IEC 81346-1. If the number of characters entered is zero, no function-related name is defined.

configRev
Range: 0 to 255 ASCII characters
Default: 

This data attribute is provided by the protocol to declare changes to the semantic of the data model of the UR. The intent 
is that the user changes Master configRev each time that the semantic or data model changes, so that clients can 
readily detect the change. A semantic change is a logical node getting a new semantic use; for example, an instance of 
logical node CSWI is now serving a different physical switch, or an instance of a logical node PDIS is now used for 
another zone. A data model change is a change in the presence of logical nodes, data objects, data attributes, or 
instance names.

The scope of Maser configRev is the entire relay configuration, as the Master logical device is the root logical device. 
Similar settings are provided for the other logical nodes; the scope of these other configRev settings is limited to the 
corresponding logical device configuration.

paramRev
Range: -2,147,483,648 to 2,147,483,647
Default: 0

The configurable data attribute paramRev has a scope that includes the entire device, and thus is modified whenever 
any setting in the device changes. The UR increments the value of paramRev by one whenever one or multiple setting 
changes occurs in one Modbus write request by any means (front panel, Modbus, or MMS) other than by SCL file 

Default logical 
device inst name

Contains logical nodes modeling...

Master
(root logical device; 
name is fixed)

communications, including GOOSE, reports, Remote I/O, Virtual Inputs, Modbus, DNP, and so on.
Setting group control.
This is the root logical device.
To comply with IEC 61850 7 1 Ed2 clause 6.4.5.1, all group L logical nodes (logical nodes with class names 
begin with "L"), except LLN0, belonging to this IED are in this logical device.

Protection (Prot) protection functions

Control (Ctrl) control and monitoring functions

System power system devices: breakers, switches, CTs, VTs, and so on, including interface to these such as AC inputs, 
contact I/O, transducer I/O, HardFiber I/O

Metering (Meter) metering and measurement (other than PMU), including Signal Sources

General (Gen) FlexLogic, virtual outputs, non-volatile latches, FlexElements, FlexMath, recording (for example oscillography), 
security, front panel, clock

Throughout the remainder of this IEC 61850 section, <LDName> is a syntactic variable representing the present 
LDName of the master logical device. In other contexts LDName can refer to some other logical device. Depending 
on its context, <LDName> can be a product-related name or a function-related name.
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download. Incrementing occurs whether or not the setting is represented in the information model. When a UR device or 
EnerVista UR Setup accepts an SCL file, paramRev is set to the value in that SCL file. When EnerVista UR Setup changes 
one or more settings, and prepares an SCL file, it increments paramRev to the next higher multiple of 10 000.

In the right pane, logical nodes assigned permanently to the Master logical device and LLN0 in all logical devices are 
greyed-out as shown earlier. These are not movable. Any other logical node can be dragged to any of the logical devices in 
the middle pane, which causes that logical device to be re-assigned to that logical device. Right-clicking a logical node 
device displays a menu that lists the logical devices that this logical node can be moved to. Clicking one of these re-assigns 
the logical node. Other common keyboard and/or mouse action can be used to select one or more logical nodes and move 
the selected nodes together.

Figure 5-26: Move logical node (Edition 2)

GOOSE
GOOSE, Routable GOOSE, and Process Bus GOOSE are supported, depending on hardware and software options.

The path is Settings > Product Setup > Communications > IEC 61850 > GOOSE.

Support for Routable GOOSE

Routable GOOSE (R-GOOSE) is supported in firmware release 7.4 and later for IEC 61850 Edition 2. Routable GOOSE allows 
UR and other devices to be located in separate networks. Encryption/decryption of messages is performed by a separate 
gateway device. Messages are routed using a separate router, using IP addresses.

Note the following behavior:

• A v7.4 device can send an R-GOOSE message to another v7.4 device when both have R-GOOSE active as the protocol

Each logical device has a name: LDName. (Note the upper case LD.) LDName has both a product-related form and 
a function-related form as per IEC 61850 6:2009 8.5.3.

SCL files invariably use the product-related form of LDName. The product-related form is the concatenation of the 
IED name of the device and the individual logical device's inst name. The IED name is the value of the "IED NAME" 
setting on the Server Configuration panel, and the logical device inst names are each the value of the 
corresponding "Product LD inst name" setting here. The "Product LD inst name" of the first logical device is fixed at 
"Master." 

Communications use the function-related form of LDName if a function-related name is defined, otherwise 
communications use the product-related name. The function-related name is the value of the corresponding 
"Functional ldName" setting if this setting is not empty, if empty the function-related name is not defined.

In SCL, the function-related name is specified by the LDevice element attribute ldName (note the lower case ld). 
Absence of this attribute indicates the function-related name is not defined. In SCL the product-related name is 
specified by the name attribute of the IED element and the inst attribute of the LDevice element.
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• A v7.4 device can send a GOOSE message to another v7.4 device when both have GOOSE active as the protocol

• A v7.4 device cannot send an R-GOOSE message to non-R-GOOSE devices, such as v7.3 or v5.9 UR device

• UR devices with firmware below v7.3 can send a GOOSE message to a v7.4 device that has GOOSE as the active 
protocol

GOOSE and Process Bus Modules

A Process Bus Module (order code 85, 86, or 87) is supported in order to subscribe sampled value (SV) messages on the 
process bus. GOOSE functionality is supported on the Process Bus Module, which allows both reception and transmission 
of GOOSE messages in the process bus.

GOOSE functionality on the Process Bus Module has the following limits:

• A maximum of two fast datasets (prefixed with TT6) are supported with 32 data attributes in each

• Only the attributes with types BOOLEAN, QUALITY, and TIME are supported. Only the data objects with structure 
{BOOLEAN, QUALITY, TIME} are supported.

• A maximum of eight GOOSE control blocks can be transmitted on the Process Bus Module, and any of the two fast 
datasets can be assigned to these GOOSE control blocks

• A maximum of eight GOOSE messages can be subscribed using the Process Bus Module for non-B30 order codes

• When an SCL file is imported, if TxGOOSE# is assigned to a Process Bus Module and the TxGOOSE# Mode is R-GOOSE, 
the SCL file is rejected and displays an error message. Similarly when importing an SCL file, if RxGOOSE# configured 
for receipt on the Process Bus Module is of type R-GOOSE, the SCL file is rejected and displays an error message.

On a user save request on the IEC 61850 configurator screen, the UR EnerVista Setup software populates an error 
message, if any of the above rules fail. When a SCL file is imported and the validation against the above rules fail, the SCL 
file is rejected with an appropriate error message in the UR EnerVista Setup software and UR SCL log.

TxGOOSE

IEC 61850 GOOSE is an efficient method for simultaneous high-speed delivery of generic substation event information by a 
publishing device to more than one subscribing device. A TxGOOSE is a UR element implementing a single IEC 61850 
GOOSE message publishing service. The subscribing function in URs is performed by RxGOOSE elements, as described in 
the next section. Each UR with IEC 61850 order code options has 16 TxGOOSE elements. Each TxGOOSE can either use the 
original format specified in IEC 61850 8 1:2011 or the routable GOOSE (R-GOOSE; IEC 61850 Edition 2) format specified in 
IEC TR 61850-90-5:2012. Each TxGOOSE element can publish the values of up to 64 attributes of the IEC 61850 nodes in the 
UR.

Published TxGOOSE messages configured in the EnerVista UR Setup software can be subscribed by and the published 
operand values understood by other UR devices. Furthermore, they can be subscribed to and understood by any device of 
any manufacturer that implements the IEC 61850 edition 1.0 or 2.0 GOOSE subscription mechanism. The messages are 
published with a multicast address so that the network sends the messages to all devices; any number of devices that 
want to subscribe can.

For wide area protection, control, and monitoring schemes, R-GOOSE wraps the proven original format GOOSE in IP/UDP to 
multicast (or unicast) the data over a Wide Area Network (WAN). Sample applications are Wide area Remedial Action 
Scheme (RAS) and Under Voltage/ Frequency Load Shedding Schemes (UVLS/UFLS). R GOOSE uses IGMPv3 (Internet Group 
Management Protocol version-3, RFC 3376) for multicasting.

The entities whose values are published in GOOSE messages are known as members. The members are itemized in an 
ordered list known as a data set. Each TxGOOSE can use any one of the configured data sets. (See the DataSets section 
later for details.) The performance of a TxGOOSE is determined by its dataset. Booleans in fast GOOSE datasets are 
designed for the TT6 transfer time class (3 ms), while Booleans in the Normal datasets are designed for the TT3 class (100 
ms). Due to the significant amount of CPU time required to compose a TT6 TxGOOSE message and the limited amount of 
time allowed by the TT6 class, at most four of these can be configured in a given UR. So only four fast GOOSE are allowed 

R-GOOSE is available through the IEC 61850 software option. If R-GOOSE security is required, the CyberSentry 
software option also must be purchased.
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to be configured, and the UR software has a check to disallow the use of more than four fast datasets in GOOSE. If six fast 
datasets are configured outside of UR software and the file sent directly to the relay, the relay rejects the file. The design 
does allow six fast datasets to be used in report control blocks, which allows fast scanned data in reports.

Each enabled TxGOOSE transmits its message whenever a value change is detected in one or more of its members. If the 
changed value is a Boolean in a fast dataset, then the change detect occurs in the TT6 detection time of 3 ms or less. If the 
member is an analog value in a fast dataset, the change detect occurs in theTT3 time of 100 ms. In Normal GOOSE 
Datasets, change detection for all dataset members occurs in the TT3 time of 100 ms. To guard against the possibility that 
such a message is lost in the network before it reaches all subscribers, the message is quickly retransmitted several times. 
To allow subscribers to verify that their link to the publisher and the publisher itself are healthy, each message is also 
retransmitted periodically even while the values are unchanging. These latter messages are known as heartbeat 
messages, while the former are known as event messages. Heartbeat messages also provide means for a subscriber 
newly online to receive the published values in the absence of an event.

The details of TxGOOSE message construction are contained in the UR Family Communications Guide. Knowledge of these 
details is not required to configure GOOSE.

The UR does not implement the Fixed-Length encoded GOOSE messages option specified in IEC 61850-8-1:2011 clause 
A.3; the UR always uses the ASN.1 Basic encoding rules (as specified in ISO/IEC 8825-1) as specified in IEC 61850 edition 1.0 
and as optional in IEC 61850 edition 2.0.

Navigate to Settings > Product Setup > Communications > IEC 61850 > GOOSE > TxGOOSE > TxGOOSE1 to access the 
settings for the first TxGOOSE. The settings and functionality for the others are similar.

Figure 5-27: IEC 61850 TxGOOSE panel (Edition 2 and with Process Bus Module)

A data set needs to be set up and selected in the TxGOOSEx DatSet field for all content to display.

When saving changes, when a "dataset member is empty" message displays, you need to set the member in the bottom 
right of the window.
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TxGOOSE1 MODE
Range for Edition 2: Disabled, GOOSE, R-GOOSE
Range for Edition 1: Disabled, GOOSE
Default: Disabled

When set to Disabled, TxGOOSE1 messages are not published. When set to GOOSE, TxGOOSE1 messages are published 
in IEC 61850 8 1:2011 GOOSE format. When set to R-GOOSE, TxGOOSE1 messages are published in Routable GOOSE 
format according to IEC 61850 90-5, and the TxGOOSE1 DST MAC address is set to 00 00 00 00 00 00 and cannot be 
changed.

TxGOOSE1 GoCB name
Range: 0 up to 32 VisibleString characters
Default: GoCB01

The entered value sets the GOOSE control block (GoCB) name value for TxGOOSE1.

An ObjectReference to the control block, which consists of the concatenation of the string "<LDName>/LLN0." and the 
control block name, is published in the gocbRef field of TxGOOSE1 messages and is used by subscribers to discriminate 
TxGOOSE1 messages from other GOOSE messages. <LDName> is a syntactic variable that is set to the value of setting 
Master functional ldName if one or more characters have been entered to that setting, otherwise the value of setting IED 
NAME suffixed with "Master".

TxGOOSE1 GoID
Range for Edition 2: 0 to 129 VisibleString characters
Range for Edition 1: 0 to 65 VisibleString characters
Default: TxGOOSE1

The entered value sets the goID value published in TxGOOSE1 messages, and can be used by subscribers to discriminate 
the TxGOOSE1 messages from other GOOSE messages. Special characters are not allowed, such as <, >, &, ’, and ".

TxGOOSE1 DatSet
Range: None, TT6DataSet1,TT6 DataSet2, … TT3DataSet01,TT3 DataSet02, …
Default: None

This setting selects the published data set using the UR Setup software designator for the data set. If None is selected, 
no TxGOOSE1 messages are sent.

The IEC 61850 name of the data sets are configured in the Datasets panel, as described later.

Some datasets are designed for the TT6 transfer time class (3 ms), while others are designed for the TT3 class (100 ms). 
The performance of a TxGOOSE is determined by its dataset. Use TT6 datasets for trips and blocking applications, TT3 
datasets for slow automatic interactions. The 61850 name of the datasets are configured in the Datasets panel.

An ObjectReference to the data set, which consists of the concatenation of the string "<LDName>/LLN0." and the data 
set name, is published in the datSet field of TxGOOSE1 messages and can be used by subscribers to discriminate 
TxGOOSE1 messages from other GOOSE messages. <LDName> is a syntactic variable that is set to the value of setting 
Master functional ldName if one or more characters have been entered to that setting, otherwise the value of setting IED 
NAME suffixed with "Master".

To configure a DataSet, select it at the top of the window from the drop-down list. In the lower part of the window, drag 
and drop configuration items to the right side. Dataset members configured here affect other Report or TxGOOSE 
control blocks that use the same DataSet.

The performance of the TxGOOSE is determined by the performance of the selected dataset. When the selection is 
TT3DataSet01, TT3DataSet02, … it is possible that transient events can be missed.

TxGOOSE1 DST MAC
Range: any 12 digit hexadecimal number
Default: 01-0C-CD-01-00-00

When the TxGOOSE1 MODE setting is R-GOOSE, the TxGOOSE1 DST MAC address is set to 00 00 00 00 00 00 and cannot be 
changed. Otherwise, the value entered here sets the Ethernet destination Media Access Control (MAC) address in 
published TxGOOSE1 messages. As the standard requires that the address have the multicast bit set TRUE, that is to say 
the second digit is set to an odd number, messages transmitted have the multicast bit set TRUE no matter its value in 
this setting.
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The destination MAC address can be used by the network to restrict message delivery to selected devices that need to 
receive them, reducing network load. This address also can be used by hardware in receiving devices to filter out 
messages that are of no interest to them, reducing processor burden. Different filtering algorithms are implemented by 
different devices. The standard recommends that the algorithm used by hardware of the receiving device be considered 
when assigning destination multicast addresses.

Subscribers can use this address to discriminate TxGOOSE1 messages from other GOOSE messages.

When using a Process Bus Module (order code 85, 86, or 87) and configuring multiple TxGOOSE to publish, ensure that 
the MAC addresses differ. When the MAC addresses are the same, a message displays to change them, for example 
"TxGOOSE1 & TxGOOSE2 assigned to PBM have the same DstMAC address. Unique DstMAC addresses are required 
between the TxGOOSE for ’PBM Port Assignment’ to work correctly."

TxGOOSE1 VLAN PRIORITY
Range: 0, 1, 2, 3, 4, 5, 6, 7, 5-4, 6-4, 6-5, 7-4, 7-5, 7-6
Default: 4

When the value entered is 0, 1, 2, 3, 4, 5, 6, or 7, the User Priority value in the IEEE 802.1Q VLAN tag included in published 
TxGOOSE1 messages is set to that value. When one of the two-digit values is entered, the dynamic priority feature is 
selected: the first event message has the User Priority value of the first digit, and User Priority is decremented in each 
following message until reaching the value of the second digit. For instance, if the selected value is 7-5, then the User 
Priority values in successive messages beginning with the message triggered by an event is 7, 6, 5, 5, 5, 5, 5, and so on. 
Do not make a dynamic priority selection when standard behavior is required.

Network devices can forward a message with a higher priority value before a message with a lower priority value, which 
speeds delivery of high-priority messages in heavily loaded networks. The standard recommends that higher-priority 
messages, such as GOOSE, have priority values in the range of 4 to 7.

TxGOOSE1 VLAN ID
Range: 0 to 4095 in steps of 1
Default: 0

The value entered sets the VID value in the IEEE 802.1Q VLAN tag included in published TxGOOSE1 messages. VID can be 
used by network devices to direct messages to only selected devices, reducing network burden. VID values of 0 and 1 
are assigned by IEEE 802.1Q to other functions and are not to be used for GOOSE.

TxGOOSE1 ETYPE APPID
Range: 0 to 65535 in steps of 1
Default: 0

The value entered sets the APPID value in published GOOSE messages and can be used by subscribers to discriminate 
TxGOOSE1 messages from other GOOSE messages.

The standard reserves the value range 0 to 16383 for GOOSE Type 1 (Fast messages), and reserves the value range 
32768 to 41151 for GOOSE Type 1A (Trip messages). Some subscribers can process messages in the Type 1A range 
faster than messages in the Type 1 range. The standard reserves the default value (0) to indicate lack of configuration. 
The standard strongly recommends unique, source-orientated APPIDs within a given system.

TxGOOSE1 CONFREV
Range: 0 to 4294967295 in steps of 1
Default: 1

The entered value sets the confRev value in published GOOSE messages and can be used by subscribers to discriminate 
TxGOOSE messages of the expected configuration revision from messages of a different revision. The standard requires 
that CONFREV be incremented each time the members or the order of the members published is changed. The standard 
states that the value of 0 is reserved.

TxGOOSE1 RETRANS TIME
Range: 0 to 100 ms in steps of 1 ms
Default: 4 ms

If the entered time is non-zero, when a member value change is detected, four event transmissions are sent, then 
heartbeat transmissions resume. The interval between the first and second event transmissions, and between the 
second and third, is the time set here. The interval between the third and the fourth event transmission is double the set 
time. If the entered time is zero, only a single event transmission occurs, then heartbeat transmissions resume.
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TxGOOSE1 TIME TO LIVE
Range: 1 to 60 s in steps of 1 s
Default: 60 s

The value entered sets the timeAllowedtoLive value in published TxGOOSE1 messages. The standard requires 
subscribers to assume a failure has occurred when another TxGOOSE1 message is not received within the published 
timeAllowedtoLive time.

Base this setting on the TxGOOSE UPDATE TIME and the tolerable number of contiguous message delivery misses. For 
example, if the heartbeat time is 10 s, and missing up to three successive messages is tolerable, make the setting 
10 * 3 + 1 = 31 s. The extra second is to ensure that arrival of the third heartbeat transmission beats the 
timeAllowedtoLive timer.

In the imported CID file, if the TxGOOSE1 TIME TO LIVE is greater than 60 seconds, clamp the setting value to 60 seconds 
and an information log is provided in SCL log.

TxGOOSE1 UPDATE TIME
Range: 1 to 59 s in steps of 1 s
Default: 30 s

This setting specifies the time interval between heartbeat messages, meaning messages that are sent periodically while 
no events are detected.

TxGOOSE1 PORT ASSIGNMENT
Range: Disabled, Port-1; Port-2; Port-3; Ports-1,2; Ports-2,3; Ports-1,3; Ports-1,2,3
Default: Ports-1, 2, 3

This setting applies to IEC 61850 Edition 2.

This setting specifies the Ethernet ports for transmission of TxGOOSE1. When set to disabled, TxGOOSE1 messages are 
not transmitted on any port no matter the state of GoEna. When set to Port-1, TxGOOSE1 is published over Ethernet 
Port-1 only; while selecting Ports-1, 3 option, the same TxGOOSE1 is published to both Ports 1 and 3; and similarly if set 
to Ports-1, 2, 3, all ports publish TxGOOSE1.

TxGOOSE1 PB PORT ASSIGNMENT
Range: Individual ports may or may not be checked (PB Port-1…PB Port-8)
Default: None of the ports are selected

This setting displays when the order code includes a non-HardFiber Process Bus Module.

When using a UR Process Bus Module, this setting specifies the Ethernet ports on the Process Bus Module for 
transmission of TxGOOSE1. When none of the ports are selected, a TxGOOSE1 message is not transmitted on any port no 
matter the state of GoEna. When set to PB Port-1, TxGOOSE1 is published over Process Bus Module Port-1 only. Similarly, 
if all ports are selected (PB Port-1 to PB Port-8) all Process Bus Module ports publish TxGOOSE1.

When the TxGOOSE1 Mode is set to R-GOOSE, the setting is read-only.

A maximum of 64 data attributes (in one or more datasets) are allowed to transmit on all TxGOOSE messages that are 
configured to transmit on the Process Bus Module.

R-TxGOOSE1 IP CLASS
Range: 0 to 256 in steps of 1
Default: 46

This setting applies to IEC 61850 Edition 2.

When the TxGOOSE1 MODE setting is other than R-GOOSE, the value of this setting is not used. Otherwise this setting 
selects the IPv4 Differentiated Services Code Point-DSCP (formerly called TypeOfService-TOS) value. This value provides 
priority routing, when supported in the routers. The default value is for Expedited Forwarding (101110B, 46 or 2EH).

When setting PRT2 REDUNDANCY to Failover or to PRP, the TxGOOSE 1 port assignment needs to be set to ports 2 
and 3 (Ports-2,3).

Also, Port 3 configuration in the CID file is ignored. The Port 3 ConnectedAP elements has no meaning, as ports 2 
and 3 use the port 2 MAC address, IP address, and mask.
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R-TxGOOSE1 DST IP
Range: 0.0.0.0 to 255.255.255 in steps of 1
Default: 224.0.0.0

This setting applies to IEC 61850 Edition 2. 

When the TxGOOSE1 MODE setting is other than R-GOOSE, the value of this setting is not used. Otherwise this setting 
specifies destination IP address for the R-TXGOOSE1 that is entered in Standard IPV4 address format. The destination IP 
address needs to be a valid multicast or unicast IP address. The value specified in this setting is mapped to IPv4 header 
32 bit field for Destination IP Address while publishing R-GOOSE1.

The default IP address 224.0.0.0 is reserved, and hence not a valid multicast IP address.

The source IP address is that of the UR port from which the R-GOOSE messages are transmitted.

R-TxGOOSE1 SECURITY
Range: None, Signature, SignatureAndEncryption
Default: None

This setting applies to IEC 61850 Edition 2.

This setting specifies level of security (authentication/encryption) used for TxGOOSE1. None specifies no security 
mechanisms are to be used. Signature specifies only signature (no encryption) is to be used. SignatureAndEncryption 
specifies that both signature and encryption are to be used.

RxGOOSE

Navigate to Settings > Product Setup > Communications > IEC 61850 > GOOSE > RxGOOSE > RxGOOSE Messages.

IEC 61850, GOOSE is an efficient method for simultaneous high-speed delivery of the same generic substation event 
information by a publishing device to more than one subscribing device. An RxGOOSE is a UR element implementing a 
single IEC 61850 GOOSE message subscribing service. The publishing function in URs is performed by TxGOOSE elements, 
as described in the previous section.

Each UR with the IEC 61850 order code option has 64 RxGOOSE elements. Each RxGOOSE element can subscribe to GOOSE 
messages from a specified publisher. Each RxGOOSE can either use the original format specified in IEC 61850 8 1:2011 or 
the routable GOOSE (R-GOOSE; IEC 61850 Edition 2) format specified in IEC TR 61850-90-5:2012. Subscribed message 
members can be DataObjects, SubDataObjects, DataAttributes or SubAttributes. In E2-2.0 mode members are restricted to 
basic types BOOLEAN, FLOAT32, INT32, Dbpos, TimeStamp or Quality. Each subscribed message can contain up to 64 
values. A member can be a structure containing several values; note that it is the number of values rather than the number 
of members that are limited to 64.

GOOSE messages from any device of any manufacturer that implements the IEC 61850 Edition 1.0 or 2.0 GOOSE publish 
service or the 61850-90-5 R-GOOSE service (IEC 61850 Edition 2) can be subscribed to. The UR accepts both the variable 
length encoded GOOSE messages specified IEC 61850 8 1:2004 and the Fixed-Length encoded GOOSE messages as 
specified in IEC 61850 8 1:2011 clause A.3.

Each enabled RxGOOSE monitors for interruption of the GOOSE messages it subscribes to based on the value in the 
timeAllowedtoLive field of the last message received. If a new message is not received within that time interval, the 
RxGOOSE assumes that connectivity is lost. FlexLogic operands (for example RxGOOSE1 On, RxGOOSE1 Off) reflect the 
status of each RxGOOSE connectivity. An RxGOOSE connection is also considered lost after the UR finishes restart until a 
message is received. While any RxGOOSE connectivity is lost, a common RxGOOSE Fail self-test is activated.

Messages that contain the value true in the ndsCom field are never accepted. Messages that contain the value true in the 
simulation field (test field in edition 1.0 messages) are accepted only when the UR Test Mode Function setting is set to 
Forcible or Isolated.

RxGOOSE messages can be received through a UR CPU module Ethernet port or a UR Process Bus Module Ethernet port. A 
maximum of eight RxGOOSE messages can be received from the Process Bus Module.

Navigate to Settings > Product Setup > Communications > IEC 61850 > GOOSE > RxGOOSE > RxGOOSE Messages > 
RxGOOSE1 to access the settings that specify the messages to be accepted by the first RxGOOSE element. The settings 
and functionality for the other RxGOOSE are similar. The following settings are available. They allow RxGOOSE1 to 
recognize the GOOSE messages it is to accept. Most of these settings are automatically configured by UR Setup software 
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when an association to an RxGOOSE Boolean Input, RxGOOSE DPS Input, and/or RxGOOSE Analog Input is made as 
described in the sections following this. For IEC 61850 Edition 2, settings R-RxGOOSE1 RECEPTION MODE, R-RxGOOSE1 
SECURITY, and R-RxGOOSE SRC IP need to be manually completed as the information is not contained in publisher SCL.

Figure 5-28: IEC 61850 RxGOOSE Messages panel (Edition 2)

RxGOOSE1 MODE
For Ed2: Main CPU GOOSE, Main CPU R-GOOSE, Process Bus Module GOOSE
For Ed1: GOOSE
Default: Main CPU GOOSE

When set to "Main CPU GOOSE," the relay subscribes to RxGOOSE1 messages if received on any of the three main CPU 
ports and if they comply with IEC 61850-8-1:2011 GOOSE format.

When set to "Main CPU R-GOOSE," the relay subscribes to RxGOOSE1 messages if received on any of the three main CPU 
ports and if they comply with the R-GOOSE format according to IEC 61850-90-5.

When set to "Process Bus Module GOOSE," the relay subscribes to RxGOOSE1 messages if received on any of the eight 
UR Process Bus Module ports and if they comply with IEC 61850-8-1:2011 GOOSE format.

RxGOOSE1 goID
Range: 0 to 129 VisibleString characters
Default: empty string

If the entered value has one or more characters, the goID field of incoming GOOSE messages must exactly match this 
value for the message to be accepted as a valid RxGOOSE1 message. If the entered value is the empty string, RxGOOSE1 
does not check the value received in the goID field. Special characters are not allowed, such as <, >, &, ’, and ".

If the publisher is a UR 7.3x series device, this setting needs match the value of the publisher's TxGOOSE GoID setting.

RxGOOSE1 Dst MAC
Range: any 12 digit hexadecimal number
Default: 01-0C-CD-01-00-00

When the RxGOOSE1 MODE setting is R-GOOSE, the value of this setting is not used, the destination Media Access 
Control (MAC) address for RxGOOSE1 messages is calculated based on the RxGOOSE DST IP address. Otherwise, set this 
setting to the MAC address of the publisher. Only received GOOSE messages having a MAC address equal to this value 
are accepted as valid RxGOOSE1 messages. An entered address of zero disables RxGOOSE1.

If the publisher is a UR series 7.3x device, the setting needs to match the value of the publisher’s TxGOOSE DST MAC 
setting.
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RxGOOSE1 ETYPE APPID
Range: 0 to 65535 in steps of 1
Default: 0

If the value entered is non-zero, the APPID field of incoming GOOSE messages must exactly match this value for the 
message to be accepted as a valid RxGOOSE1 message. If the value entered is zero, RxGOOSE1 does not check the value 
received in the APPID field.

If the publisher is a UR series 7.3x device, the setting needs to match the value of the publisher’s TxGOOSE ETYPE APPID 
setting.

RxGOOSE1 GoCBRef
Range: 0 to 129 alphanumeric, underscore, slash and period characters, beginning with an alpha character

The gocbRef field of incoming GOOSE messages must match this value for the message to be accepted as a valid 
RxGOOSE1 message. If the entered value is the empty string, RxGOOSE1 is disabled. If not the empty string, the entry 
needs to be an ACSI ObjectReference to the publishing control block in the format:

<LDName>/LLN0.<GoCBName>

where <LDName> is the function-related name if the logical device containing the publishing control block has "ldName" 
configured, otherwise the product-related name of that logical device, and <GoCBName> is the name of the publishing 
control block.

The F60 translates the ACSI format required for this setting to the MMS format used in GOOSE messages:

<LDName>/LLN0$GO$<GoCBName>

If the publisher is a UR 7.3x or 7.40 series device, <LDName> is the value of the publisher's Master functional ldName 
setting if that setting is not empty, otherwise it is the value of the publisher's IED NAME suffixed with "Master". If the 
publisher is a UR 7.3x series device, <GoCBName> is "GoCB" suffixed with the two digit TxGOOSE instance number, for 
example "GoCB01". If the publisher is a UR 7.40 series device, <GoCBName> is as specified earlier in the TxGOOSE 
section of this chapter.

RxGOOSE1 datSet
Range: 0 to 32 alphanumeric and underscore characters, beginning with an alpha character
Default: empty string

If the entered value has one or more characters, the datSet field of incoming GOOSE messages must exactly match this 
value prefixed by <LDName>/LLN0$ for the message to be accepted as a valid RxGOOSE1 message. <LDName> is as 
specified in the RxGOOSE GoCBRef setting above. If the entered value is the empty string, RxGOOSE1 does not check the 
value received in the datSet field.

If the publisher is a UR 7.3x series device, set this setting to the value of the publisher's DataSetxx name setting, where xx 
is the instance number of the data set selected by the publisher's TxGOOSE datSet setting. If the publisher is a UR 7.40 
series device, datSet is as specified in the DataSets section of this chapter.

RxGOOSE1 ConfRev
Range: 0 to 4294967295 in steps of 1
Default: 1

If the value entered is non-zero, the confRev field of incoming GOOSE messages must exactly match this value for the 
message to be accepted as a valid RxGOOSE1 message. If the entered value is zero, RxGOOSE1 does not check the value 
received in the confRev field.

If the publisher is a UR 7.3x series device, set this setting to match the value of the publisher's TxGOOSE ConfRev setting.

R-RxGOOSE1 RECEPTION MODE
Range: SSM, ASM, Unicast
Default: SSM

This setting applies to IEC 61850 Edition 2.

When the RxGOOSE1 MODE setting is other than R-GOOSE the value of this setting is not used. Otherwise it selects the 
R-GOOSE reception mode.
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R-RxGOOSE RECEPTION MODE specifies the R-RxGOOSE DST IP range. When set to SSM, R-RxGOOSE DST IP must be in 
the range of 232.0.0.1 to 232.255.255.255. When set to ASM, R-RxGOOSE DST IP must be in the range of 224.0.0.1 to 
239.255.255.255, excluding the SSM range. Note that the SSM range is inside the ASM range and therefore the ASM use 
excludes the SSM range. The default destination IP address 224.0.0.0 is reserved, and hence not a valid multicast IP 
address.

The reception modes are related to Layer-3 R-GOOSE reception from routers/WAN. The subscription to multicasting of R-
GOOSE is supported using IGMP Protocol Independent Multicast (PIM). It is made available in either Source Specific 
Multicast (SSM) mode or Any Source Multicast (ASM) mode. Unicast (over UDP) mode can also be used. In case of 
multicasting (IGMPv3 based SSM or ASM), the R-GOOSE subscriber device requests the Last Hop Router (LHR) to 
subscribe to a specific multicasting group.

If the publisher is using a unicast destination IP address for this R-GOOSE, then set R-RxGOOSE1 RECEPTION MODE to 
Unicast. Otherwise set R-RxGOOSE1 RECEPTION MODE to the SSM or ASM mode used by the local routers/firewalls.

R-RxGOOSE1 SRC IP
Range: 0.0.0.0 to 255.255.255 in steps of 1
Default: 127.0.0.1

This setting applies to IEC 61850 Edition 2.

When the RxGOOSE1 MODE setting is other than R-GOOSE, the value of this setting is not used. When the RxGOOSE1 
MODE setting is R-GOOSE and the R-RxGOOSE RECEPTION MODE setting is ASM, the value of this setting is not used. 
Otherwise the Source IP Address field of incoming R-GOOSE messages must exactly match this value for the message to 
be accepted as a valid RxGOOSE1 message. Set this setting to the value of the source IP address used by the publisher. 
For UR publishers, this value is in setting PRT# IP ADDRESS.

The UR does not validate the address entered. The default IP address 127.0.0.1 is a reserved, not a valid IP address. Enter 
a valid IP source address.

R-RxGOOSE1 DST IP
Range: 0.0.0.0 to 255.255.255 in steps of 1
Default: 224.0.0.0

This setting applies to IEC 61850 Edition 2.

When the RxGOOSE1 MODE setting is other than R-GOOSE, the value of this setting is not used. Otherwise the 
Destination IP Address field of incoming R GOOSE messages must exactly match this value for the message to be 
accepted as a valid RxGOOSE1 message. Set this setting to the same value as the R-GOOSE publisher's Destination IP 
Address. For UR publishers, this value is in setting R-TxGOOSE# DST IP.

The destination IP address needs to be a valid multicast or unicast IP address. The UR does not validate the address 
entered. The default IP address 224.0.0.0 is reserved, and hence not a valid multicast IP address.

R-RxGOOSE1 SECURITY
Range: None, Signature, SignatureAndEncryption
Default: None

This setting applies to IEC 61850 Edition 2.

This setting specifies the level of security (authentication/encryption) used for RxGOOSE1. None indicates no security 
mechanisms are in use. Signature indicates only signature (no encryption) is in use. SignatureAndEncryption indicates 
that both signature and encryption are in use. Normally this setting is set to match the GOOSE publisher's security 
method.

RxGOOSE1 Member 1
Range: End of List, BOOLEAN, FLOAT32, INT32, Dbpos (DPS), Quality, TimeStamp, Struct
Default: End of List

This setting specifies the type that the first member of incoming GOOSE messages must be for the message to be 
accepted as a valid RxGOOSE1 message. There are similar settings for each of the up to 64 members that the UR is able 
to subscribe to in a given GOOSE message. The member before the first member setting set to "End of List" must be the 
last member of the message for the message to be accepted as a valid RxGOOSE1 message.

If the publisher is a UR 7.3x or 7.40 series device, set these settings to match the basic type of the members of the 
publisher's data set selected by the publisher's TxGOOSE datSet setting.
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If the publisher dataset includes members with structured data, that is, data attributes, sub-data objects, and/or data 
attributes with sub-data attributes, configuration must use one of the new 7.40 UR Setup RxGOOSE Inputs pages. In this 
case the Member setting displays as the product-related name used by the publishing IED of the data object or data 
attribute, in standard SCSM format (e.g. Publisher1LD1/LLN0$ST$Off$stVal).

Note that a dataset can hold at most 64 basic data attribute values, and that a single structured data object or attribute 
can contain multiple basic data attribute values. UR Setup software does not allow more that 64 basic data attribute 
values to be entered, in which case the last several members settings cannot be changed from End of List.

Note that the publisher's name alone does not contain all the information required for subscription, additional publisher 
information model information is stored elsewhere. For this reason, manual entry of the name is not supported.

RxGOOSE inputs

The values received by RxGOOSE elements need to be converted to FlexLogic or FlexAnalog operands so that they can be 
used by other UR elements. This conversion is done by RxGOOSE Boolean, RxGOOSE DPS, and RxGOOSE Analog elements. 
Each RxGOOSE Boolean can convert the value of a specified Boolean value received by a specified RxGOOSE to a FlexLogic 
operand. Each RxGOOSE DPS can convert the value of a specified Dbpos (Double bit position) value to four FlexLogic 
operands, one for each of the four possible Dbpos states. Each RxGOOSE Analog can convert the value of a specified 
FLOAT32 member to a FlexAnalog operand. Each of these operands reverts to its default state when the RxGOOSE 
connectivity is lost. Other types of values can be present in subscribed GOOSE messages, but cannot be converted to 
operands.

When an RxGOOSE Input is mapped to a value in the GOOSE message, the associated q value is validated, if the q value is 
included in that GOOSE message as part of the data object. 

The RxGOOSE Input value is reverted to its default value, if the associated:

• q.validity is invalid

• or q.test bit is set and the relay test mode is disabled

When the test mode function is Forcible or Isolated, the q.test bit is not validated. That means, when the relay is in Test or 
Test/blocked mode, the q.test = False is treated same as q.test = True.

RxGOOSE Boolean, RxGOOSE DPS, and RxGOOSE Analog elements are mapped to various data objects in 
<iedName>Master/GGIO3. This is to allow reading of their values via MMS and to allow references to them in SCL files. 
GGIO3 has no settings, nor is it visible in the UR Setup software. See the UR Family Communications Guide for more 
information on GGIO3.

RxGOOSE Boolean inputs

Navigate to Settings > Product Setup > Communications > IEC 61850 > GOOSE > RxGOOSE > RxGOOSE Boolean Inputs.

The number of RxGOOSE Boolean (remote inputs) is 256.

There are Add IED and Remove IED buttons. The Add IED button allows SCL files to be used, including ICD, CID, and SCD 
(supported in version 7.40 and later). With SCL file import, for Edition 1 the IP address in the ConnectedAP element must 
match one IP address of the device, while for Edition 2 one of the three IP addresses in the ConnectedAP element must 
match. When the file format is SCD, the system lists all IEDs inside the SCD file and lets the user select the ones to add. The 
figure shows a selection being made by importing a CID file using the Add IED function.
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Figure 5-29: RxGOOSE Boolean panel (Edition 2)

Most of the settings are configured by drag-and-drop. However the ID, DEFAULT STATE, and EVENTS settings must be 
individually entered when the factory default values are not acceptable.

RxGOOSE Boolean1 ID
Range: 0 to 20 characters
Default: RxG Bool1

This setting allows the user to assign descriptive text to the name of the RxGOOSE Boolean1 FlexLogic operand. The full 
operand name is the value of this setting appended with " On". The basic and enhanced front panels display the first 17 
characters of this setting plus " On" to fit the 20 character display.

RxGOOSE Boolean1 RxGOOSE
Range: None, RxGOOSE1, RxGOOSE2, and so on
Default: None

This setting selects the RxGOOSE containing the value that drives the RxGOOSE Boolean1 FlexLogic operand. If set to 
None, the RxGOOSE Boolean1 FlexLogic operand assumes its default state.

RxGOOSE Boolean1 Member
Range: 1 to 64 in steps of 1
Default: 1

This setting selects the GOOSE message member that drives the RxGOOSE Boolean1 FlexLogic operand. A setting of 1 
selects the first member, 2 selects the second member, and so on. Entering a number greater than the number of 
members in the message and entering the number of a member which does not contain a BOOLEAN results in the 
RxGOOSE Boolean1 FlexLogic operand assuming its default state. The Subscribed to column identifies the particular 
Boolean subscribed to even if the member is a structure containing more than one Boolean.

RxGOOSE Boolean1 DEFAULT STATE
Range: On, Off, Latest/On, Latest/Off
Default: Off

This setting selects the logic state for the RxGOOSE Boolean1 FlexLogic operand if the UR has just completed startup and 
the selected RxGOOSE has not yet received a message, or the selected RxGOOSE has lost its connectivity with the 
publisher. The following choices are available:
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– "On" value defaults the input to logic 1

– "Off" value defaults the input to logic 0

– "Latest/On" freezes the input in case of lost connectivity. If the latest state is unknown, such as after UR power-up 
but before the first communication, the input defaults to logic 1. When communication resumes, the input 
becomes fully operational.

– "Latest/Off" freezes the input in case of lost connectivity. If the latest state is unknown, such as after UR power-up 
but before the first communication, the input defaults to logic 0. When communication resumes, the input 
becomes fully operational.

RxGOOSE Boolean1 EVENTS
Range: Disabled, Enabled
Default: Disabled

This setting selects whether Off to On transitions of the RxGOOSE Boolean1 FlexLogic operand are recorded by the event 
recorder. If set to Enabled, Off to On transitions are recorded. On to Off transitions are never recorded, even if events are 
enabled.

RxGOOSE DPS inputs

Navigate to Settings > Product Setup > Communications > IEC 618560 > GOOSE > RxGOOSE > RxGOOSE DPS Inputs.

There are Add IED and Remove IED buttons. The Add IED button allows SCL files to be used, including ICD, CID, and SCD 
(supported in version 7.40 and later). With SCL file import, for Edition 1 the IP address in the ConnectedAP element must 
match one IP address of the device, while for Edition 2 one of the three IP addresses in the ConnectedAP element must 
match. When the file format is SCD, the system lists all IEDs inside the SCD file and lets the user select the ones to add.

Figure 5-30: RxGOOSE DPS Inputs panel (Edition 2)

RxGOOSE DPS1 ID
Range: 0 to 20 characters
Default: RxG DPS1

This setting allows the user to assign descriptive text to the names of the four RxGOOSE DPS1 FlexLogic operands. The 
full operand name is the value of this setting appended with "Interm," "On," "Off,"  or "Bad." The basic and enhanced front 
panels display the first 13 characters of this setting plus the state suffix to fit the 20 character display.
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RxGOOSE DPS1 RxGOOSE
Range: None, RxGOOSE1, RxGOOSE2, and so on
Default: None

This setting selects the GOOSE message containing the value that drives the RxGOOSE DPS1 FlexLogic operand. If set to 
None, the RxGOOSE DPS1 FlexLogic operand assumes its default state.

RxGOOSE DPS1 Member
Range: 1 to 64 in steps of 1
Default: 1

This setting selects the GOOSE message member that drives the RxGOOSE DPS1 FlexLogic operand. A setting of 1 selects 
the first member, 2 selects the second member, and so on. Entering a number greater than the number of members in 
the message and entering the number of a member that is not a Dbpos results in the RxGOOSE DPS1 FlexLogic operand 
assuming its default state. In the case that the member is a structure containing more than one Dbpos, the Subscribed 
to column identifies the particular Dbpos subscribed to.

RxGOOSE DSP1 DEFAULT STATE
Range: Intermediate-state, Off, On, Bad-state, Latest
Default: Latest

This setting selects the logic state for the data attribute @Master/GGIO3.IndPos01.stVal and the DPS FlexLogic operands 
when the UR has just completed start-up and the selected RxGOOSE has not yet received a message, and when the 
RxGOOSE has lost its connection with the publisher. When this setting is selected to Latest, the value of @Master/
GGIO3.IndPosψψ.stVal is Intermediate-state when the UR has just completed start-up and the selected RxGOOSE has 
not yet received a message, and the latest received value when the RxGOOSE loses its connectivity with the publisher.

RxGOOSE DPS1 EVENTS
Range: Disabled, Enabled
Default: Disabled

This setting selects whether Off to On transitions of the RxGOOSE DPS1 FlexLogic operands are recorded by the event 
recorder. If set to Enabled, Off to On transitions are recorded. On to Off transitions are never recorded, even if events are 
enabled.

RxGOOSE analog inputs

Navigate to Settings > Product Setup > Communications > IEC 61850 > GOOSE > RxGOOSE > RxGOOSE Analog Inputs.

There are Add IED and Remove IED buttons. The Add IED button allows SCL files to be used, including ICD, CID, and SCD 
(supported in version 7.40 and later). With SCL file import, for Edition 1 the IP address in the ConnectedAP element must 
match one IP address of the device, while for Edition 2 one of the three IP addresses in the ConnectedAP element must 
match. When the file format is SCD, the system lists all IEDs inside the SCD file and lets the user select the ones to add.
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Figure 5-31: RxGOOSE Analog Inputs panel (Edition 2)

There are 32 RxGOOSE analog inputs.

RxGOOSE Analog1 ID
Range: 0 to 20 characters
Default: RxG Analog1

This setting allows the user to assign descriptive text to RxGOOSE Analog1. Unlike RxGOOSE Booleans and RxGOOSE 
DPS, the RxGOOSE Analog operands have fixed names, for example RxGOOSE Analog1.

RxGOOSE Analog1 RxGOOSE
Range: None, RxGOOSE1, RxGOOSE2, and so on
Default: None

This setting selects the GOOSE message that drives the RxGOOSE Analog1 FlexAnalog operand. If set to None, the 
RxGOOSE Analog1 FlexAnalog operand assumes its default state.

RxGOOSE Analog1 Member
Range: 1 to 64 in steps of 1
Default: 1

This setting selects the GOOSE message member that drives the RxGOOSE Analog1 FlexAnalog operand. A setting of 1 
selects the first member, 2 selects the second member, and so on. Entering a number greater than the number of 
members in the message and entering the number of a member that does not contain a FLOAT32 results in the 
RxGOOSE Analog1 FlexAnalog operand assuming its default state. The Subscribed to column identifies the particular 
FLOAT32 subscribed to even if the member is a structure containing more than one FLOAT32.

RxGOOSE Analog1 DEFAULT
Range: -1000000.000 to 1000000.000 in steps of 0.001
Default: 1000.000

This setting specifies the value of the GOOSE analog input when the selected RxGOOSE has lost its connectivity with the 
publisher and the RxGOOSE Analog1 DEFAULT MODE is set to "Default Value." Otherwise this setting has no effect. This 
setting is stored as an IEEE 754 / IEC 60559 floating point number. Because of the large range of this setting, not all 
possible values can be stored. Some values can be rounded to the closest possible floating point number.
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RxGOOSE Analog1 DEFAULT MODE
Range: Default Value, Last Known
Default: Default Value

When the selected RxGOOSE has lost its connectivity with the publisher and this setting is "Last Known," the value of the 
RxGOOSE Analog1 FlexLogic operand remains at the last received value. When the selected RxGOOSE has lost its 
connectivity with the publisher and this setting value is "Default Value," then the RxGOOSE Analog1 FlexLogic operand is 
defined by the RxGOOSE Analog1 DEFAULT setting. After restart, until a message is received, the operand value is the 
default value.

RxGOOSE Analog1 UNITS
Range: up to 4 characters
Default: empty string

This setting specifies a four-character string that is used in the actual values display of RxGOOSE Analog1.

RxGOOSE Analogs are floating-point values, with no units. The RxGOOSE UNIT and PU base settings allow the user to 
configure RxGOOSE Analog, so that it can be used in a FlexElement.

RxGOOSE Analogs that represent current, voltage, power, frequency, angles, or power factor can be used in a 
FlexElement. The following text must be used in the UNITS setting, to represent these types of analogs: A, V, W, var, VA, 
Hz, deg, and no text (blank setting) for power factor.

RxGOOSE Analogs can be compared to other RxGOOSE Analogs with any character string or no string.

RxGOOSE Analog1 PU Base in kilo
Range: 0.000 to 1000000000.000 in steps of 0.001
Default: 1.000

This setting specifies the per-unit base value for other F60 features to use with the RxGOOSE Analog1 operand. A 
FlexElement for instance subtracts two quantities after converting their values to integers rescaled to a common base, 
the common base being the largest of the base values of the two quantities. If one of quantities is RxGOOSE Analog1 and 
its per-unit base value is not appropriate, the rescaling operation can result in unnecessary loss of precision or overflow 
in the integer result. The FlexElement Base Units table in the Settings > FlexLogic > FlexElements section later, which 
tabulates the per-unit base value used by its pickup setting and implies the per-unit base used by other FlexAnalogs, can 
be of use in selecting a value for the RxGOOSE Analog1 PU setting.

Some UR elements have requirements for the type of input operands, for instance current type or voltage type. These 
elements assume that RxGOOSE Analog operands are of whatever type is necessary to meet these requirements.

The per-unit base setting represents thousands, not single units. For example, a PU base of 1.000 is actually 1000 and a 
PU base of 0.001 is 1.

When using RxGOOSE Analogs and PU base in FlexElements, the largest value that can be displayed in the FlexElement 
actual values is 2,140,000.000.

Reports
Navigate to Settings > Product Setup > Communications > IEC 61850 > Reports.

Report settings

Navigate to Settings > Product Setup > Communications > IEC 61850 > Reports > Report Settings.

ReportSettings rptID
Range: Dyn, Conf
Default: Dyn

When set to Dyn, the RptID attribute in any buffered and unbuffered report control block can be modified by an MMS 
client while the control block's RptEna attribute is false. The RptID is the name of the report.

ReportSettings optFields
Range: Dyn, Conf
Default: Dyn

When set to Dyn, the OptFlds attribute in any buffered and unbuffered report control block can be modified by an MMS 
client while the control block's RptEna attribute is false.



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-83

5

ReportSettings bufTime
Range: Dyn, Conf
Default: Dyn

When set to Dyn, the BufTm attribute in any buffered and unbuffered report control block can be modified by an MMS 
client while the control block's RptEna attribute is false.

ReportSettings trgOps
Range: Dyn, Conf
Default: Dyn

When set to Dyn, the TrgOps attribute in any buffered and unbuffered report control block can be modified by an MMS 
client while the control block's RptEna attribute is false.

ReportSettings intgPd
Range: Dyn, Conf
Default: Dyn

When set to Dyn, the IntgPd attribute in any buffered and unbuffered report control block can be modified by an MMS 
client while the control block's RptEna attribute is false.

Buffered and unbuffered reports

Navigate to Settings > Product Setup > Communications > IEC 61850 > Reports > Buffered Reports or Unbuffered 
Reports.

Figure 5-32: IEC 61850 buffered report panel
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An IEC 61850 Report server is an efficient method to deliver generic substation event information from a single server to a 
single client, such as a supervisory control IED. A Configurable Report is a UR element implementing an IEC 61850 Report 
server, either of the buffered or unbuffered kind. The following table lists the number of Configurable Report elements. 
Each Configurable Report element can report the values of up to 64 FlexLogic or FlexAnalog operands. Buffered report 
elements queue value changes that occur while the client is offline and delivered when the client re-connects. Up to 512 
events can be queued. Unbuffered control blocks purge all value change events when the connection to the client is lost; 
any events that occur while the client is not connected are lost.

Table 5-11: Number of report elements

When using IEC 61850 Edition 2, configurable Reports interoperate with any client device of any manufacturer that 
conforms to the IEC 61850 edition 1.0 or 2.0 report client requirements.

When using IEC 61850 Edition 1, configurable Reports interoperate with any client device of any manufacturer that 
conforms to the IEC 61850 edition 1.0 report client requirements.

The entities whose values are reported by a Configurable Report are known as members. The members are itemized in an 
ordered list known as a data set. Each Configurable Report can use any one of the data sets provided that no more than 
four data sets are used for reports. This restriction is to limit the amount of processing power that can be allocated to 
reporting.

Each enabled Configurable Report transmits an update to its client whenever a value change is detected in one or more of 
its members. Also, the control block can be configured to send integrity reports containing the present value of all 
members either on demand from the client or periodically. A TCP handshaking mechanism causes messages that are not 
read and acknowledged by the client to be retransmitted.

For a Configurable Report to operate, its members must be selected (that is, its data set configured) and a client must open 
a connection to, configure, and enable its report control block. Control blocks and data sets can be pre-configured by 
sending the F60 a CID file. See the UR Family Communications Guide for details. EnerVista UR Setup also can be used to 
select the data set members and to pre-configure the control blocks.

Each buffered report has the following settings.

Buffered Report1 RptID
Range for Edition 2: 0 to 129 VisibleString characters
Range for Edition 1: 0 to 65 VisibleString characters
Default: empty string

The name of the report. The entered value sets the RptID value in Buffered Report1 messages, and it can be used by the 
client to discriminate Buffered Report1 messages from other messages. If the number of characters entered is zero, the 
value used for RptID in messages is an ObjectReference to the report's control block, that is, "<LDName>/
LLN0$BR$"BRCB01".

Buffered Report1 Name
Range: 0 to 32 VisibleString characters
Default: BRCB01

The entered value sets the report control block name value for Buffered Report1.

Buffered Report1 DatSet
Range: None, TT6DataSet1, TT6 DataSet2, …, TT3DataSet01, TT3DataSet02, …
Default: None

This setting selects the data set whose members' status is reported in Buffered Report1 messages using the UR Setup 
software designator for the data set. The IEC 61850 name of the data sets are configured in the Datasets panel, as 
described later.

An ObjectReference to the data set, which consists of the concatenation of the string "<LDName>/LLN0$" and the data 
set name, is used in the datSet field of report messages, and it can be used by the client to discriminate Buffered Report1 
messages from other messages.

Number

Buffered reports 30

Unbuffered reports 18



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-85

5

The performance of the report is determined by the performance of the selected dataset. When the selection is 
TT3DataSet01, TT3DataSet02, … it is possible that transient events can be missed.

To configure a DataSet, select it at the top of the window from the drop-down list, for example DataSet02 shown in the 
previous figure. In the lower part of the window, drag and drop configuration items to the right side. For example select 
the ST Ind001 stVal item and drag it to DataSet Member 1. Dataset members configured here affect other Report or 
TxGOOSE control blocks that use the same DataSet.

Buffered Report1 ConfRev
Range: 0 to 4294967295 in steps of 1
Default: 1

The entered value sets the confRev value in Buffered Report1 messages, and it can be used by clients to discriminate 
report messages of the expected configuration revision from messages of a different revision. The standard requires 
that confRev be incremented each time the members or the order of the members is changed, and each time the data 
set name is changed. The standard states that the value of 0 is reserved.

Buffered Report1 OptFlds
Range: The check box for each individual bit can be enabled or not (see figure)
Default: All bits enabled/ true

The OptFlds setting is bitstring that controls which of the optional fields are included in report messages. The figure 
shows the available option bits. To reduce message size, uncheck any fields that are not needed.

Figure 5-33: Options for buffered report messages (Edition 2)

Buffered Report1 BufTm
Range: 0 to 4294967295 in steps of 1
Default: 0 ms

The entered value sets the time interval in milliseconds for the buffering of events for inclusion in a single report.

Buffered Report1 TrgOps
Range: The check box for an individual bit can be enabled or not
Default: All bits enabled / true

The TrgOps setting is bitstring that controls which trigger conditions are monitored in this report. The options are as 
follows. Uncheck any trigger conditions that are not needed.

– data-change

– quality-change

– integrity

– general interrogation (IEC 61850 Edition 2)

Buffered Report1 IntgPd
Range: 0 to 4294967295 in steps of 1
Default: 0 ms

The entered value sets the period in milliseconds for generating Buffered Report1 integrity reports. An integrity report 
includes the values of all members of the referenced data set, whether a change has occurred or not.

Each unbuffered report has the following settings.



5-86 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

PRODUCT SETUP CHAPTER 5: SETTINGS

5

Unbuffered Report1 RptID
Range for Edition 2: 0 to 129 VisibleString characters
Range for Edition 1: 0 to 65 VisibleString characters
Default: empty string

The name of the report. The entered value sets the RptID value in Unbuffered Report1 messages, and it can be used by 
the client to discriminate Unbuffered Report1 messages from other messages. If the number of characters entered is 
zero, the value used for RptID in messages is an ObjectReference to the report's control block, that is, "<LDName>/
LLN0$RP$"URCB01".

Unbuffered Report1 Name
Range: 0 up to 32 VisibleString characters
Default: URCB01

The entered value sets the report control block name value for Unbuffered Report1.

Unbuffered Report1 DatSet
Range: None, TT6DataSet1, TT6 DataSet2, …, TT3DataSet01, TT3DataSet02, … 
Default: None

This setting selects the data set whose members' status is reported in Unbuffered Report1 messages using the UR Setup 
software designator for the data set. The IEC 61850 name of the data sets are configured in the Datasets panel, as 
described later.

An ObjectReference to the data set, which consists of the concatenation of the string "<LDName>/LLN0$" and the data 
set name, is used in the datSet field of report messages, and it can be used by the client to discriminate Unbuffered 
Report1 messages from other messages.

The performance of the report is determined by the performance of the selected dataset. When the selection is 
TT3DataSet01, TT3DataSet02, … it is possible that transient events can be missed.

Unbuffered Report1 ConfRev
Range: 0 to 4294967295 in steps of 1
Default: 1

The entered value sets the confRev value in Unbuffered Report1 messages, and it can be used by clients to discriminate 
report messages of the expected configuration revision from messages of a different revision. The standard requires 
that confRev be incremented each time the members or the order of the members is changed, and each time the data 
set name is changed. The standard states that the value of 0 is reserved.

Unbuffered Report1 OptFlds
Range: The check box for an individual bit can be enabled or not
Default: All bits enabled / true

The OptFlds setting is bitstring that controls which of the optional fields are included in report messages. The options are 
as follows. To reduce message size, uncheck any fields that are not needed.

– sequence-number

– report-time-stamp

– reason-for-inclusion

– data-set-name

– data-reference

– conf-revision

For IEC 61850 Edition 2, the OptFlds bits buffer-overflow and entryID also listed are not applicable to unbuffered reports 
even though the bits exist in the protocol. They are unchecked by default.

For IEC 61850 Edition 1, the entryID also listed is not applicable to unbuffered reports even though the bits exist in the 
protocol. It is unchecked by default.

Unbuffered Report1 BufTm
Range: 0 to 4294967295 in steps of 1
Default: 0 ms

The entered value sets the time interval in milliseconds for the buffering of events for inclusion into a single report.
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Unbuffered Report1 TrgOps
Range: The check box for an individual bit can be enabled or not
Default: All bits enabled / true

The TrgOps setting is bitstring that controls which trigger conditions are monitored in this report. The options are as 
follows. Uncheck any trigger conditions that are not needed.

– data-change

– quality-change

– integrity

– general interrogation (IEC 61850 Edition 2)

Unbuffered Report1 IntgPd
Range: 0 to 4294967295 in steps of 1
Default: 0 ms

The entered value sets the period in milliseconds for generating Unbuffered Report1 integrity reports. An integrity report 
includes the values of all members of the referenced data set, whether a change has occurred or not.

DataSets
Navigate to Settings > Product Setup > Communications > IEC 61850 > DataSets.

As mentioned in the preceding GOOSE and Reports sections, the members whose values are communicated by these 
services are itemized in an ordered list known as a data set. Each UR with the IEC 61850 option has 18 data sets (six fast 
and 12 slow). Each data set can contain as many as 64 members. Any data set can be used simultaneously by any number 
of TxGOOSE elements and/or by any number of Configurable Report elements. UR Setup software can configure any 
FlexLogic operands and any FlexAnalog operands as members.

Figure 5-34: IEC 61850 DataSets (Edition 2)
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UR Setup software requires data set members to be IEC 61850 data objects or data attributes with Functional Constraint 
ST or MX. Certain FlexLogic and FlexAnalog operands have factory-assigned data attributes as tabulated in the UR Family 
Communications Guide. All FlexLogic and FlexAnalog operands can be user-assigned to GGIO1 or GGIO4 data attributes, 
so that operands without factory-assigned data attributes can still have their values published. See the GGIO1 and GGIO4 
sections later for details.

Datasets used by TxGOOSE1, TxGOOSE2, and/or by reports also provide a chatter suppression service for their Boolean 
members. Oscillation in a value, also known as chatter, can be caused by errors in logic programming, inadequate 
hysteresis (deadband) on a threshold, or a failed station component. Chatter can flood a communications network with 
GOOSE messages, degrading response time for all users. If chatter is detected in a Boolean member, TxGOOSE suspends 
GOOSE event message triggering and report message triggering from that member for as long as the condition exists, and 
for a minimum period of one second. While sending is suspended, a self-test message identifying the specific data item 
detected as oscillating is activated.

For a summary of the panels in which the data sets are used, the path is Settings > Product Setup > Communications > 
IEC 61850 > DataSets > Summary.

For the settings, navigate to Settings > Product Setup > Communications > IEC 61850 > DataSets > TT6DataSet1 for the 
first data set.

Copy and paste functions are available when right-clicking a DataSet. They allow the target dataset to be configured 
based on its order code. If some dataset items are not supported, they are not pasted, and a warning message shows a list 
of dataset items that were not supported and not pasted. The DataSet name is not copied or pasted. In short, use this 
feature to copy a DataSet Member setting and paste it into another Member setting, a text file, or Word, as examples.

Figure 5-35: Member right-click

DataSet01 name
Range: 0 to 32 VisibleString characters
Default: DataSet01

The value entered sets the name of the data set, which is required to be unique within the UR for proper operation. The 
value entered sets the name of the data set, which is required to be unique within the UR for proper operation. Fast 
datasets start with TT6, and slow datasets start with TT3. Up to six fast datasets are allowed. Up to four fast GOOSE 
datasets are allowed.
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An ObjectReference to the data set consists of a string that is the concatenation of "<LDName>/LLN0$" and the 
DataSet01 name setting value. An ObjectReference to the data set is published in the datSet field of TxGOOSE messages, 
and it can be used by subscribers to discriminate the messages of that TxGOOSE from other GOOSE messages. An 
ObjectReference to the data set is optionally published in the DatSet field of Report messages. Valid characters are 
upper and lowercase letters, digits, and the underscore (_) character. The first character must be a letter.

DataSet01 shared by
Range: 0 to 32 VisibleString characters
Default: 

Names of all control blocks that use this DataSet. Read-only field.

DataSet01 Member1
Range: End of List or any instantiated 61850 data object or data attribute with Functional Constraint ST or MX
Default: End of List

This setting specifies the first member in TxGOOSE1 messages. There is a similar setting for each of the up to 64 
members that the UR allows in a Dataset. Only values of members before the first set to End of List are published.

Select the member from the drop-down list. Or right-click an entry to copy, paste, delete, or insert.

Product setup
Navigate to Settings > Product Setup > Communications > IEC 61850 > Product Setup.

Security

This setting applies to IEC 61850 Edition 2.

Navigate to Settings > Product Setup > Communications > IEC 61850 > Product Setup > Security.

Figure 5-36: IEC 61850 Security

SecGSAL1.SecDataClr.ctlModel 
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model that clients must use to clear security data via commands to 
SecGSAL1.SecDataClr. "sbo" here is select-before-operate.
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SecGSAL1.OpCntRs ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model that clients must use to clear security data via commands to SecGSAL1.OpCntRs. 
"sbo" here is select-before-operate.

Demand

Deadband parameters of measured values related to the Demand metering are configured here.

Energy

Deadband parameters of measured values related to the Energy metering are configured here.

Real Time Clock

This setting applies to IEC 61850 Edition 2.

Navigate to Settings > Product Setup > Communications > IEC 61850 > Product Setup > Real Time Clock.

Figure 5-37: IEC 61850 Real Time Clock

TmClkLTMS1.TmnsDelta.db
Range: 0.000 to 100.000 %
Default: 0.000 %

This setting is a deadband setting and is used by the relay to determine when to update the "mag" and "cVal" values 
from the associated "instMag" and "instCVal" values. The value shall represent the percentage of difference between 
maximum and minimum in units of 0.001%. The minimum and maximum values for TmnsDelta data object are 
-500000000 ns and 500000000 ns respectively and for example, a setting value of 0.002% results in the dead banded 
value of (500000000 - (-500000000)) * 0.002 / 100 = 20000 ns. The default setting value of 0.000% does not update the 
"mag" and "cVal" values.

Deadband settings
A deadband is a range in which no action occurs, usually expressed as a percentage.

The IEC 61850 panels contain hundreds of deadband settings, such as in the following panels: Product Setup > Real Time 
Clock, FlexLogic, Control Elements, and GGIO4. Each panel is not outlined here. The FlexLogic category applies to IEC 61850 
Edition 2.
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Deadband setting names all end either with "DB" or .db. As they all work the same way, but each on a different analog 
value, a single description applicable to all deadband settings is given here. The analog value that each deadband setting 
applies is usually obvious from the name of the setting. However, a tabulation of the analog values and their associated 
deadband setting can be found in the UR Family Communications Guide.

Figure 5-38: Deadband settings with .db suffix (Edition 2)

GOOSE, buffered report, and unbuffered report messages are for the most part transmitted only when there is a value 
change in one or more of their members. Most analog values continuously dither by an amount that is not significant. 
Were a report to be sent each time an insignificant analog value change occurred, then the communications network 
floods with GOOSE and report messages, degrading response time for all users.

To control this, a deadband setting is provided for each analog value. Also, in addition to the present actual value of each 
analog ("instMag" in the following figure), there is a deadbanded value ("mag" in the figure), which is updated with the 
present value only when the difference between the two exceeds the deadband setting (db in the figure). Changes to this 
deadbanded value trigger transmissions when included in GOOSE and report data sets.

Figure 5-39: Deadband settings

Deadband settings are entered in UR Setup software in units of percent of the difference between the "max." and "min." of 
the associated analog value. A zero deadband setting suppresses transmission triggering. The range of deadband settings 
is 0.000 to 100.000% in steps of 0.001. The default value is 0.000%.

GGIO4 elements have individual settings for "min." and "max." The min. and max. for FlxEIGAPC#.OpSig.db (FLEXELEMENT # 
OpSig) are -50 pu and +50 pu respectively. The min. value for all other quantities is 0. The max. values are as follows:

• Phase current — 46 x phase CT primary setting

• Neutral current — 46 x ground CT primary setting

• Ground current (sensitive ground CT) — 4.6 x sensitive ground CT primary setting

• Phase, phase-to-phase, and sequence voltage — 275 x phase VT ratio setting
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• Auxiliary voltage — 275 x auxiliary VT ration setting

• Power (real, reactive, apparent, 3-phase, and 1-phase) — 4 × phase CT primary setting × 1.5 × VT Secondary setting × 
VT ratio setting

• Energy (real or imaginary) — 4 × phase CT primary setting × 1.5 × VT Secondary setting × VT ratio setting x 1 hour

• Frequency — 90 Hz

• Frequency rate of change — 90 Hz/s

• Power factor — 2

• Angle — 360 degrees

Select the deadband settings from knowledge of the characteristics of the power system quantity measured and 
knowledge of the demands of the applications receiving the measurement via GOOSE or report such that changes of 
significance to the application are promptly reported, yet the network is not overly burdened with event messages.

Signal sources
Deadband parameters of measured values related to the signal sources are configured here.

Breakers
The UR breaker control and status monitoring elements have certain settings that configure how the IEC 61850 protocol 
interacts with these elements. These settings are described in this section. See the Breakers section in the System Setup 
section of this chapter for details on the operation of breaker control elements.

Navigate to Settings > Communications > IEC 61850 > System Setup > Breakers > Breaker 1 to access the settings that 
configure the IEC 61850 protocol interface with the first breaker control and status monitoring element. The settings and 
functionality for the others are similar.

Figure 5-40: IEC 61850 Breaker panel (Edition 2)

XCBR1 ST.LOC OPERAND
Range: any FlexLogic operand
Default: OFF

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that breaker 1 is selected for local 
control. While the selected operand is asserted, Bkr0XCBR1.Loc.stVal is true and IEC 61850 commands to BkrCSWI1.Pos 
and Bkr0XCBR1.Pos are not accepted, and a Negative Response (-Rsp) is issued with the REASON CODE of Blocked-by-
switching-hierarchy.
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XCBR1 SYNCCHECK CLS
Range: any FlexLogic operand
Default: ON

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that synchrocheck conditions are 
acceptable for closing breaker 1. If a SelectWithValue or Operate service with ctlVal true and with Check.SynchroCheck 
true is requested of either BkrCSWI1.Pos or Bkr0XCBR1.Pos and the selected operand is not asserted, a Negative 
Response (-Rsp) is issued with the REASON CODE of Blocked-by-synchrocheck.

XCBR1 INTERLOCK OPN
Range: any FlexLogic operand
Default: ON

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that interlocking conditions are not 
acceptable for opening breaker 1. While the selected operand is asserted, the value of BkrCILO.EnaOpn.stVal is false. If a 
SelectWithValue or Operate service with ctlVal false and with Check.Interlock-check true is requested of either 
BkrCSWI1.Pos or Bkr0XCBR1.Pos, and the selected operand is not activated, a Negative Response (-Rsp) is issued with 
the REASON CODE of Blocked-by-interlocking.

XCBR1 INTERLOCK CLS
Range: any FlexLogic operand
Default: ON

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that interlocking conditions are not 
acceptable for closing breaker 1. While the selected operand is asserted, the value of BkrCILO.EnaCls.stVal is false. If a 
SelectWithValue or Operate service with ctlVal true and with Check.Interlock-check true is requested of either 
BkrCSWI1.Pos or Bkr0XCBR1.Pos and the selected operand is not activated, a Negative Response (-Rsp) is issued with the 
REASON CODE of Blocked-by-interlocking.

XCBR1 Pos ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security, direct-with-enhanced-security, sbo-with-
enhanced-security
Default: sbo-with-enhanced-security

This setting selects the control model clients must use to successfully control the breaker 1 signals marked 
Bkr0XCBR1.PosOpn.ctlVal and Bkr0XCBR1.PosCls.ctlVal on the Breaker Control Logic (Sheet 1 of 2) diagram in the 
Settings > System Setup section later in this chapter. These signals force a breaker 1 three-phase trip or close control 
while the operand selected by setting XCBR1 ST.LOC OPERAND is not active.

"sbo" here is select-before-operate. Enhanced security means that the UR reports to the client the breaker 1 position at 
the end of the command sequence.

XCBR1 Pos sboTimeout
Range: 2 to 60 s in steps of 1 s
Default: 30 s

This setting specifies the maximum time between a select and an operate command to breaker 1 signals marked 
Bkr0XCBR1.PosOpn.ctlVal and Bkr0XCBR1.PosCls.ctlVal in order for the operand to be successful. This setting is only 
relevant when XCBR1 Pos ctlModel is sbo-with-normal-security or sbo-with-enhanced-security.

XCBR1 BlkOpn ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the breaker 1 signal marked 
Bkr0XCBR1.BlkOpn.ctlVal signal on the Breaker Control Logic (Sheet 1 of 2) diagram in the Settings > System Setup 
section later. This signal when true blocks breaker 1 trip control while the operand selected by setting XCBR1 ST.LOC 
OPERAND is not active.
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XCBR1 BlkCls ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the breaker 1 signal marked 
Bkr0XCBR1.BlkCls.ctlVal signal on the Breaker Control Logic (Sheet 1 of 2) diagram in the Settings > System Setup section 
later. This signal when true blocks breaker 1 close control while the operand selected by setting XCBR1 ST.LOC OPERAND 
is not active.

CSWI1 Pos ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security, direct-with-enhanced-security, sbo-with-
enhanced-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the breaker 1 signals marked 
BkrCSWI1.PosOpn.ctlVal and BkrCSWI1.PosCls.ctlVal on the Breaker Control Logic (Sheet 1 of 2) diagram in the Settings > 
System Setup section earlier. These signals force a breaker 1 three-phase trip or close control while the operand selected 
by setting XCBR1 ST.LOC OPERAND is not active.

CSWI1 Pos sboTimeout
Range: 2 to 60 s in steps of 1 s
Default: 30 s

This setting specifies the maximum time between a select and an operate command to breaker 1 via BkrCSWI1.Pos in 
order for the operand to be successful. This setting is only relevant when CSWI1 Pos ctlModel is sbo-with-normal-
security or sbo-with-enhanced-security.

CSWI1 Pos operTimeout
Range: 0.000 to 2.000 s in steps of 0.001s
Default: 0.100 s

This setting applies to IEC 61850 Edition 2.

This setting specifies the maximum time between an operate command to breaker 1 via BkrCSWI1.Pos until 
BkrCSWI1.Pos.stVal enters the commanded state. The command terminates if the commanded state is not reached in 
the set time.

Switches
The UR disconnect switch control and status monitoring elements have certain settings that configure how the IEC 61850 
protocol interacts with these elements. These settings are described in this section. See the Settings > System Setup > 
Disconnect Switches section later in this chapter for details on the operation of the disconnect switch control elements.

Navigate to Settings > Product Setup > Communications > IEC 61850 > System Setup > Switches > Switch 1 to access 
the settings that configure the IEC 61850 protocol interface with the first disconnect switch control and status monitoring 
element. The settings and functionality for the others are similar.
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Figure 5-41: Switch panel

Disc0XSWI1.InRef5.setSrcRef OPERAND
Range: any FlexLogic operand
Default: OFF

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that disconnect switch 1 is selected 
for local control. While the selected operand is asserted, Disc0XSWI1.Loc.stVal is true and IEC 61850 commands to 
DiscCSWI1.Pos and Disc0XSWI1.Pos are not accepted, and a Negative Response (-Rsp) is issued with the REASON CODE 
of Blocked-by-switching-hierarchy.

XSWI1 INTERLOCK OPN
Range: any FlexLogic operand
Default: ON

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that interlocking conditions are not 
acceptable for opening disconnect switch 1. While the selected operand is asserted, the value of DiscCILO.EnaOpn.stVal 
is false. If a SelectWithValue or Operate service with ctlVal false and with Check.Interlock-check true is requested of 
DiscCSWI1.Pos or Disc0XSWI1.Pos and the selected operand is not activated, a Negative Response (-Rsp) is issued with 
the REASON CODE of Blocked-by-interlocking.

XSWI1 INTERLOCK CLS
Range: any FlexLogic operand
Default: ON

This setting is used to select a FlexLogic operand that declares to IEC 61850 services that interlocking conditions are not 
acceptable for closing disconnect switch 1. While the selected operand is asserted, the value of DiscCILO.EnaCls.stVal is 
false. If a SelectWithValue or Operate service with ctlVal true and with Check.Interlock-check true is requested of 
DiscCSWI1.Pos or Disc0XSWI1.Pos and the selected operand is not activated, a Negative Response (-Rsp) is issued with 
the REASON CODE of Blocked-by-interlocking.

XSWI1 Pos ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security, direct-with-enhanced-security, sbo-with-
enhanced-security
Default: sbo-with-enhanced-security

This setting selects the control model that clients must use to successfully control the disconnect switch 1 signals 
marked Disc0XCBR1.PosOpn.ctlVal and Disc0XCBR1.PosCls.ctlVal on the Disconnect Switch Logic diagram in the Settings 
> System Setup section later. These signals force a disconnect switch trip or close control while the operand selected by 
setting XSWI1 ST.LOC OPERAND is not active.

"sbo" here is select-before-operate. Enhanced security means that the F60 reports to the client the disconnect switch 1 
position the end of the command sequence.
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XSWI1 Pos sboTimeout
Range: 2 to 60 s in steps of 1 s
Default: 30 s

This setting specifies the maximum time between a select and an operate command to disconnect switch 1 signals 
marked Disc0XCBR1.PosOpn.ctlVal and Disc0XCBR1.PosCls.ctlVal in order for the operand to be successful. This setting is 
only relevant when XSWI1 Pos ctlModel is sbo-with-normal-security or sbo-with-enhanced-security.

Disc0XSWI1 BlkOpn ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the disconnect switch 1 signal marked 
DiscCSWI1.BlkOpn.ctlVal signal on the Disconnect Switch Logic diagram in the Settings > System Setup section later. This 
signal when true blocks disconnect switch 1 trip control while the operand selected by setting XSWI1 ST.LOC OPERAND is 
not active.

Disc0XSWI1 BlkCls ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the disconnect switch 1 signal marked 
DiscCSWI1.BlkCls.ctlVal signal on the Disconnect Switch Logic diagram in the Settings > System Setup section later. This 
signal when true blocks disconnect switch 1 close control while the operand selected by setting XSWI1 ST.LOC OPERAND 
is not active.

Disc0CSWI1 Pos ctlModel
Range: status-only, direct-with-normal-security, sbo-with-normal-security, direct-with-enhanced-security, sbo-with-
enhanced-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the disconnect switch 1 signals marked 
DiscCSWI1.PosOpn.ctlVal and DiscCSWI1.PosCls.ctlVal on the Disconnect Switch Logic diagram in the Settings > System 
Setup section later. These signals force a disconnect switch trip or close control while the operand selected by setting 
XSWI1 ST.LOC OPERAND is not active.

Disc0CSWI1 Pos sboTimeout
Range: 2 to 60 s in steps of 1 s
Default: 30 s

This setting specifies the maximum time between a select and an operate command to disconnect switch 1 via 
BkrCSWI1.Pos in order for the operand to be successful. This setting is only relevant when CSWI1 Pos ctlModel is sbo-
with-normal-security or sbo-with-enhanced-security.

Disc0CSWI1 Pos operTimeout
Range: 0.000 to 65.535 s in steps of 0.001s
Default: 5.000 s

This setting specifies the maximum time between an operate command to disconnect switch 1 via BkrCSWI1.Pos until 
BkrCSWI1.Pos.stVal enters the commanded state. The command terminates if the commanded state is not reached in 
the set time.

Setting Groups
The UR implements a setting groups element as detailed in the Control Elements > Setting Groups section of this chapter. 
The active setting group and the setting group open for edits can be selected via MMS commands SelectActiveSG and 
SelectEditSG. The setting related to these IEC 61850 commands are described here.

Navigate to Settings > Product Setup > Communications > IEC 61850 > Control Elements > Setting Groups to access 
the setting that configures the IEC 61850 setting group commands.
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Figure 5-42: Setting Groups panel (Edition 2)

Initial Setting Group
Range: 1 to 6 in steps of 1
Default: 1

The entered value sets the initial value of the non-volatile register normally controlled by the service SelectActiveSG. This 
initialization occurs only on the UR reboot immediately following the receipt of a valid CID file.

This setting is not mapped into the IEC 61850 information model, but sets the value of SettingControl element attribute 
actSG in SCL files.

The Initial Setting Group value is initialized when Control Elements > Setting Groups > Control Mode is set to 
"IEC61850 Client." When Control Elements > Setting Groups > Control Mode is set to "Local," the Initial Setting Group 
value is ignored, and the priority scheme selects the Active setting group immediately after initialization.

Commands
The UR implements a number of clear records commands as detailed in the Commands and Targets chapter of this 
manual. Several of these commands also can be issued via IEC 61850. The settings related to these IEC 61850 commands 
are described here.

Navigate to Settings > Product Setup > Communications > IEC 61850 > Settings for Commands to access the settings 
that configure the IEC 61850 protocol interface for record clear commands.
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Figure 5-43: Commands panel (Edition 2)

FltRptRFLO1.RsStat.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the command CLEAR FAULT REPORTS. "sbo" 
here is select-before-operate. Enhanced security means that the F60 reports to the client the breaker 1 position at the 
end of the command sequence.

LLN0.EvtRcdClr.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the command CLEAR EVENT RECORDS.

LPHD1.RsStat.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the command CLEAR ALL RELAY RECORDS.

OscRDRE1.RcdTrg.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the command FORCE TRIGGER.

OscRDRE1.MemClr.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the command CLEAR OSCILLOGRAPHY.

DatLogRDRE1.MemClr.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control the command CLEAR DATA LOGGER.

CBArc0SCBR1.MemClr.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security
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DmdMtrMMTR1.RsStat.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

EnrMtrMMTR1.RsStat.ctlModel
Range: direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

GGIO1
GGIO1 is a UR feature that allows up to 128 UR FlexLogic operands to be user-mapped to IEC 61850 information model 
data attributes.

For the value of a FlexLogic operand to be read via MMS, included in TxGOOSE messages, or included in buffered/
unbuffered reports, the value must be assigned to a data attribute. GGIO1 allows those FlexLogic operands that have not 
yet been factory-assigned to a data attribute to be user-assigned to a generic data attribute, and thus have their values 
included in IEC 61850 communications.

Navigate to Settings > Product Setup > Communications > IEC 61850 > GGIO > GGIO1 to access the settings for GGIO1.

Figure 5-44: IEC 61850 GGIO1 panel (Edition 2)

GGIO1 INDICATION 1
Range: any FlexLogic operand
Default: OFF

This setting selects the FlexLogic operand whose value is mapped into the IEC 61850 data attribute 
<LDName>/GGIO1.Ind001.stVal. See the FlexLogic section in this chapter for a list of FlexLogic operands.

GGIO1 INDICATION 2
Range: any FlexLogic operand
Default: OFF

Selects the FlexLogic operand mapped to <LDName>/GGIO1.Ind002.stVal, and so on.

GGIO2
Virtual Inputs are controllable FlexLogic operands that can be controlled via IEC 61850 commands to GGIO2, by DNP, by 
Modbus, and by the UR front panel. The settings related to these IEC 61850 commands are described here.
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Navigate to Settings > Product Setup > Communications > IEC 61850 > GGIO > GGIO2 to access the settings that 
configure the IEC 61850 protocol interface for Virtual Input commands.

Figure 5-45: GGIO2 panel (Edition 2)

GGIO2 CF SPCSO 1 CTLMODEL
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

This setting selects the control model clients must use to successfully control Virtual Input 1. "sbo" here is select-before-
operate.

GGIO2 CF SPCSO 2 CTLMODEL
Range: status-only, direct-with-normal-security, sbo-with-normal-security
Default: direct-with-normal-security

Selects the control model for Virtual Input 2, and so on.

GGIO4
GGIO4 is a UR feature that allows up to 32 UR FlexAnalog operands to be user-mapped to an IEC 61850 information model 
data attribute.

For the value of a FlexAnalog operand to be read via MMS, included in TxGOOSE messages, or included in buffered/
unbuffered reports, the value must be assigned to a data attribute. GGIO4 allows those FlexAnalog operands that have not 
yet been factory-assigned to a data attribute to be user-assigned to a generic data attribute, and thus have their values 
included in IEC 61850 communications.

Navigate to Settings > Product Setup > Communications > IEC 61850 > GGIO > GGIO4 > GGIO4.AnIn1 to access the 
settings for the first GGIO4 value. The settings and functionality for the others are similar.
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Figure 5-46: GGIO4 panel (Edition 2)

ANALOG IN 1 VALUE
Range: any FlexAnalog operand
Default: OFF

This setting selects the FlexAnalog operand whose value is mapped into the IEC 61850 data attribute 
<LDName>/GGIO4.AnIn01.instMag.f. The value of the FlexAnalog operand is converted automatically to the format and 
scaling required by the standard, that is to say primary amperes, primary volts, and so on. See Appendix A for a list of 
FlexAnalog operands.

ANALOG IN 1 DB
Range: 0.000 to 100.000% in steps of 0.001
Default: 0.000%

This setting specifies the deadband for the ANALOG IN 1 VALUE. The deadband is used to determine when to update the 
deadbanded magnitude from the instantaneous magnitude. The deadband is a percentage of the difference between 
the "max." and "min." values. Here, the "max." and "min." are as specified by the settings ANALOG IN 1 MAX and ANALOG IN 
1 MIN.

See the Deadband Settings section earlier for a description of deadbanded values.

ANALOG IN 1 MIN
Range: -1000000000.000 to 1000000000.000 in steps of 0.001
Default: 0.000

This setting specifies the "min." value used in deadband calculations. The scaling of this setting is the same as used by 
<LDName>/GGIO4.AnIn01.instMag.f. This setting is stored as an IEEE 754 / IEC 60559 floating point number. Because of 
the large range of this setting, not all possible values can be stored. Some values are rounded to the closest possible 
floating point number.

ANALOG IN 1 MAX
Range: -1000000000.000 to 1000000000.000 in steps of 0.001
Default: 1000000.000

This setting specifies the "max." value used in deadband calculations. The scaling of this setting is the same as used by 
<LDName>/GGIO4.AnIn01.instMag.f. This setting is stored as an IEEE 754 / IEC 60559 floating point number. Because of 
the large range of this setting, not all possible values can be stored. Some values are rounded to the closest possible 
floating point number.
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File transfer by IEC 61850
The F60 supports file transfer by IEC 61850. The approach is as follows, using the SISCO AX-S4 61850 client software as an 
example.

1. In the AX-S4 61850 Explorer window, click the Tools menu and access the SISCO File Transfer Utility.

2. Select the Remote AR Name from the drop-down list. Available files appear in the File Specification area on the right 
side of the window.

3. With the Copy option active, select a file to transfer and click the Go button. The file is copied and displays in the Local 
list on the left side of the window.

4. Repeat the process to transfer any other files.

Figure 5-47: File transfer by IEC 61850

5.3.5.13  Web server HTTP protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  WEB SERVER HTTP PROTOCOL

The F60 contains an embedded web server and can display pages in a web browser. The web pages are organized as a 
series of menus that can be accessed starting at the F60 “Main Menu.” Web pages are read-only and are available 
showing DNP and IEC 60870-5-104 points lists, Modbus registers, event records, fault reports, and so on. First connect the 
F60 and a computer to an Ethernet network, then enter the IP address of the F60 Ethernet port in a web browser.

To close the port, set the port number to 0.

Any change takes effect when the F60 is restarted.

  WEB SERVER
  HTTP PROTOCOL  HTTP TCP PORT

NUMBER(80):    80
Range: 0 to 65535 in steps of 1



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-103

5

Figure 5-48: Example of UR web page showing event records

5.3.5.14  TFTP protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  TFTP PROTOCOL

The Trivial File Transfer Protocol (TFTP) can be used to transfer files from the F60 over a network. The F60 operates as a 
TFTP server. TFTP client software is available from various sources, including Microsoft Windows NT. The dir.txt file obtained 
from the F60 contains a list and description of all available files, for example event records and oscillography.

The "put" function is not for security reasons. You can enter a "get" command but not a "put" command.

TFTP MAIN UDP PORT NUMBER — To close the port, set the port number to 0. Any change takes effect when the F60 is 
restarted.

5.3.5.15  IEC 60870-5-104 protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IEC 60870-5-104 PROTOCOL

Do not set more than one protocol to the same TCP/UDP port number, as this results in unreliable operation of 
those protocols.

 TFTP PROTOCOL
  TFTP MAIN UDP PORT

NUMBER(69):    69
Range: 0 to 65535 in steps of 1

 TFTP DATA UDP PORT 1
NUMBER:    0

Range: 0 to 65535 in steps of 1

 TFTP DATA UDP PORT 2
NUMBER:    0

Range: 0 to 65535 in steps of 1

Do not set more than one protocol to the same TCP/UDP port number, as this results in unreliable operation of 
those protocols.

 IEC 60870-5-104
 PROTOCOL  IEC TCP PORT

NUMBER(2404): 2404
Range: 0 to 65535 in steps of 1

  IEC NETWORK
 CLIENT ADDRESSES

See below
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IEC 60870-5-104 is a transmission protocol for network access, specifically for communication between a control station 
and substation over a TCP/IP network.

The F60 supports the IEC 60870-5-104 protocol. This protocol is enabled when the SETTINGS  PRODUCT SETUP  
COMMUNICATIONS  PROTOCOL setting is set to IEC 60870-5-104. The F60 can be used as an IEC 60870-5-104 slave device 
connected to a maximum of two masters (usually either an RTU or a SCADA master station). Since the F60 maintains two 
sets of IEC 60870-5-104 data change buffers, ideally no more than two masters actively communicate with the F60 at one 
time.

The IEC ------- DEFAULT THRESHOLD settings are used to determine when to trigger spontaneous responses containing 
M_ME_NC_1 analog data. These settings group the F60 analog data into types: current, voltage, power, energy, and other. 
Each setting represents the default threshold value for all M_ME_NC_1 analog points of that type. For example, to trigger 
spontaneous responses from the F60 when any current values change by 15 A, the IEC CURRENT DEFAULT THRESHOLD 
setting is set to 15. Note that these settings are the default values of the deadbands. P_ME_NC_1 (parameter of measured 
value, short floating point value) points can be used to change threshold values, from the default, for each individual 
M_ME_NC_1 analog point. Whenever power is removed and re-applied to the F60, the default thresholds are in effect.

The IEC REDUNDANCY setting decides whether multiple client connections are accepted or not. If redundancy is set to Yes, 
two simultaneous connections can be active at any given time.

IEC TCP PORT NUMBER — To close the port, set the port number to 0. Any change takes effect when the F60 is restarted.

IEC COMMON ADDRESS OF ASDU — The change takes effect when the F60 is restarted.

IEC CYCLIC DATA PERIOD — The change takes effect when the F60 is restarted.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IEC 60870-5-104 PROTOCOL  IEC NETWORK CLIENT 
ADDRESSES

 IEC COMMON ADDRESS
OF ASDU: 0

Range: 0 to 65535 in steps of 1

 IEC CYCLIC DATA
PERIOD: 60 s

Range: 1 to 65535 s in steps of 1

 IEC CURRENT DEFAULT
THRESHOLD: 30000

Range: 0 to 65535 in steps of 1

 IEC VOLTAGE DEFAULT
THRESHOLD: 30000

Range: 0 to 65535 in steps of 1

 IEC POWER DEFAULT
THRESHOLD: 30000

Range: 0 to 65535 in steps of 1

 IEC ENERGY DEFAULT
THRESHOLD: 30000

Range: 0 to 65535 in steps of 1

 IEC PF DEFAULT
THRESHOLD: 1.00

Range: 0.00 to 1.00

 IEC OTHER DEFAULT
THRESHOLD: 30000

Range: 0 to 65535 in steps of 1

 IEC REDUNDANCY
ENABLED: No

Range: No, Yes

 IEC EVENT TIME BASE:
LOCAL

Range: Local, UTC

Do not set more than one protocol to the same TCP/UDP port number, as this results in unreliable operation of 
those protocols.

 IEC NETWORK
 CLIENT ADDRESSES  CLIENT ADDRESS 1:

0.0.0.0
Range: standard IPV4 address format
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The F60 can specify a maximum of five clients for its IEC 104 connections. These are IP addresses for the controllers to 
which the F60 can connect. A maximum of two simultaneous connections are supported at any given time.

5.3.5.16  EGD protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  EGD PROTOCOL

Ethernet Global Data (EGD) is a suite of protocols used for the real-time transfer of data for display and control purposes. 
The relay can be configured to ‘produce’ EGD data exchanges, and other devices can be configured to ‘consume’ EGD data 
exchanges. The number of produced exchanges (up to three), the data items in each exchange (up to 50), and the 
exchange production rate can be configured.

The relay supports one fast EGD exchange and two slow EGD exchanges. There are 20 data items in the fast-produced 
EGD exchange and 50 data items in each slow-produced exchange.

EGD cannot be used to transfer data between UR series relays. The relay supports EGD production only. An EGD exchange 
is not be transmitted unless the destination address is non-zero, and at least the first data item address is set to a valid 
Modbus register address. The default setting value of “0” is considered invalid.

Fast exchanges (50 to 1000 ms) are generally used in control schemes. The F60 has one fast exchange (exchange 1) and 
two slow exchanges (exchange 2 and 3).

The settings menu for the fast EGD exchange follows.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  EGD PROTOCOL FAST PROD EXCH 1 CONFIGURATION

The settings menu for the slow EGD exchanges follows.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  EGD PROTOCOL SLOW PROD EXCH 1(2) CONFIGURATION

 CLIENT ADDRESS 5:
0.0.0.0

Range: standard IPV4 address format

 EGD PROTOCOL
   FAST PROD EXCH 1

 CONFIGURATION
See below

  SLOW PROD EXCH 1
 CONFIGURATION

See below

  SLOW PROD EXCH 2
 CONFIGURATION

See below

The F60 is provided with optional Ethernet Global Data (EGD) communications capability. This feature is 
specified as a software option at the time of ordering. See the Order Codes section in chapter 2 for details.

 FAST PROD EXCH 1
 CONFIGURATION  EXCH 1 FUNCTION:

Disable
Range: Disable, Enable

 EXCH 1 DESTINATION:
0.0.0.0

Range: standard IP address

 EXCH 1 DATA RATE:
1000 ms

Range: 50 to 1000 ms in steps of 1

 EXCH 1 DATA ITEM 1:
0

Range: 0 to 65535 in steps of 1 (Modbus register 
address range)



 EXCH 1 DATA ITEM 20:
0

Range: 0 to 65535 in steps of 1 (Modbus register 
address range)

 SLOW PROD EXCH 1
 CONFIGURATION  EXCH 1 FUNCTION:

Disable
Range: Disable, Enable

 EXCH 1 DESTINATION:
0.0.0.0

Range: standard IP address
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Slow EGD exchanges (500 to 1000 ms) are generally used for the transfer and display of data items. The settings for the 
fast and slow exchanges are as follows.

EXCH 1 DESTINATION — This setting specifies the destination IP address of the produced EGD exchange. This is usually 
unicast or broadcast.

EXCH 1 DATA RATE — This setting specifies the rate at which this EGD exchange is transmitted. If the setting is 50 ms, the 
exchange data is updated and sent once every 50 ms. If the setting is 1000 ms, the exchange data is updated and sent 
once per second. EGD exchange 1 has a setting range of 50 to 1000 ms. Exchanges 2 and 3 have a setting range of 500 to 
1000 ms.

EXCH 1 DATA ITEM 1 to 20/50 — These settings specify the data items that are part of this EGD exchange. Almost any data 
from the F60 memory map can be configured to be included in an EGD exchange. The settings are the starting Modbus 
register address for the data item in decimal format. See the Modbus memory map in the UR Series Communications 
Guide for details. The Modbus memory map display shows addresses in hexadecimal format. Convert these hex values to 
decimal format before entering them as values for these setpoints.

To select a data item to be part of an exchange, it is only necessary to choose the starting Modbus address of the item. 
That is, for items occupying more than one Modbus register (for example, 32 bit integers and floating point values), only the 
first Modbus address is required. The EGD exchange configured with these settings contains the data items up to the first 
setting that contains a Modbus address with no data, or 0. That is, if the first three settings contain valid Modbus addresses 
and the fourth is 0, the produced EGD exchange contains three data items.

5.3.5.17  IEC 60870-5-103 protocol
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IEC 60870-5-103

IEC 60870-5-103 is a companion standard to the IEC 60870-5 suite of standards for transmission protocols. It defines 
messages and procedures for interoperability between protection equipment and devices of a control system in a 
substation for communicating on a serial line.

The IEC 60870-5-103 protocol is enabled when the SETTINGS  PRODUCT SETUP  COMMUNICATIONS  PROTOCOL setting 
is set to IEC 60870-5-103.

 EXCH 1 DATA RATE:
1000 ms

Range: 50 to 1000 ms in steps of 1

 EXCH 1 DATA ITEM 1:
0

Range: 0 to 65535 in steps of 1 (Modbus register 
address range)



 EXCH 1 DATA ITEM 50:
0

Range: 0 to 65535 in steps of 1 (Modbus register 
address range)

 IEC103
 PROTOCOL  IEC103 COMMON

ADDRESS OF ASDU: 0
Range: 0 to 254 in steps of 1

 IEC103 SYNC TIMEOUT:
1

Range: 1 to 1440 min in steps of 1

  IEC103 INPUTS
 BINARY

See below

  IEC103 INPUTS
 MEASURANDS

See below

  IEC103 COMMANDS


See below

The F60 is provided with optional IEC 60870-5-103 communications capability. This feature is specified as a 
software option at the time of ordering. See the Order Codes section in chapter 2 for details.
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The IEC 60870-5-103 is an unbalanced (master-slave) protocol for coded-bit serial communication, exchanging 
information with a control system. In the context of this protocol, the protection equipment is the slave and the control 
system is the master. The communication is based on a point-to-point principle. The master must be able to interpret the 
IEC 60870-5-103 communication messages.

The UR implementation of IEC 60870-5-103 consists of the following functions:

• Report binary inputs 

• Report analog values (measurands)

• Commands

• Time synchronization

The RS485 port supports IEC 60870-5-103.

The UR Family Communications Guide contains more information on the protocol.

IEC103 COMMON ADDRESS OF ASDU — This setting uniquely defines this F60 on the serial line. Select an ID between 0 and 
254. This ID does not need to be in sequential order for all stations that communicate with a controller, but it is 
recommended. Note that RS485 only allows a maximum of 32 slave stations on a communication line, so the entire range 
of 254 addresses is never exhausted.

IEC103 SYNC TIMEOUT — This setting defines the time that the F60 waits for a synchronization message. The F60 
synchronizes its clock using all available sources, with the source synching more frequently overwriting the time of the 
other sources. Since the synchronization message received from the IEC 60870-5-103 master is less frequent than IRIG-B, 
PTP, or SNTP, its time is overwritten by these three sources, if any of them is active. If the synchronization timeout occurs 
and none of IRIG-B, PTP, or SNTP is active, the F60 sets the invalid bit in the time stamp of a time-tagged message.

The settings for the remaining menus are outlined as follows.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IEC 60870-5-103  IEC103 INPUTS BINARY

 

The binary input points are mapped using elements from a list of possible FlexLogic operands. A maximum of 96 binary 
inputs (points) can be mapped this way.

The IEC 60870-5-103 point list always starts with point 0 and ends at the first "Off" value. Since the IEC 60870-5-103 point 
list must be in a continuous block, any points assigned after the first "Off" point are ignored.

 IEC103 INPUTS
 BINARY   POINT 0


See below

  POINT 1


See below



  POINT 95


See below 

 POINT 0
  POINT 0 FUN

0
Range: 0 to 255 in steps of 1

 POINT 0 INF
0

Range: 0 to 255 in steps of 1

 POINT 0 Input
Off

Range: FlexLogic operand



 POINT 95
  POINT 95 FUN

0
Range: 0 to 255 in steps of 1

 POINT 95 INF
0

Range: 0 to 255 in steps of 1

 POINT 95 Input
Off

Range: FlexLogic operand
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For each defined point, set appropriate values for the Function Type (FUN) and Information Number (INF), which form the 
Information Object Identifier field of the ASDU, as defined in IEC 60870-5-103.

The binary input points are sent as Class 1 data. They are sent either as a response to a general interrogation received 
from the controller or reported spontaneously. Spontaneous transmission occurs as a response to cyclic Class 2 requests. 
If the F60 wants to transmit Class 1 data at that time, it demands access for Class 1 data transmission (ACD=1 in the 
control field of the response).

For any change to take effect, restart the relay.

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IEC 60870-5-103  IEC103 INPUTS MEASURANDS

 IEC103 INPUTS
 MEASURANDS   ASDU 1


See below



  ASDU 4


 ASDU 1
  ASDU 1 TYP:

9
Range: 3 or 9

 ASDU 1 FUN:
0

Range: 0 to 255 in steps of 1

 ASDU 1 INF:
0

Range: 0 to 255 in steps of 1

 ASDU 1 SCAN TOUT:
0

Range: 0 to 1000 s in steps of 1

 ASDU 1 ANALOG 1
Off

Range: FlexAnalog parameter

 ASDU 1 ANALOG 1
FACTOR: 1.000

Range: 0.000 to 65.535 in steps of 0.001

 ASDU 1 ANALOG 1
OFFSET: 0

Range: -32768 to 32767 in steps of 1



 ASDU 1 ANALOG 9
Off

Range: FlexAnalog parameter

 ASDU 1 ANALOG 9 
FACTOR: 1.000

Range: 0.000 to 65.535 in steps of 0.001

 ASDU 1 ANALOG 9 
OFFSET: 0

Range: -32768 to 32767 in steps of 1


 ASDU 4
  ASDU 4 TYP:

9
Range: 3 or 9

 ASDU 4 FUN:
0

Range: 0 to 255 in steps of 1

 ASDU 4 INF:
0

Range: 0 to 255 in steps of 1

 ASDU 4 SCAN TOUT:
0

Range: 0 to 1000 s in steps of 1

 ASDU 4 ANALOG 1
Off

Range: FlexAnalog parameter
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The configuration menu allows a maximum of four ASDUs containing measurands.

Measurands are sent as a response to Class 2 requests, which are cyclic requests coming from the master.

TYPE IDENTIFICATION (TYP) — The configuration field TYP indicates how many measurands are present in the corresponding 
ASDU. Each ASDU can take either 4 or 9 measurands maximum, depending on the type identification (3 respectively 9). For 
any change to take effect, restart the relay.

FUNCTION TYPE (FUN) and INFORMATION NUMBER (INF) — These two fields form the Information Object Identifier of the ASDU 
as defined in IEC 60870-103. For any change to take effect, restart the relay.

SCAN TIMEOUT (SCAN TOUT) — This is the cyclic period used by the F60 to decide when a measurand ASDU is included in a 
response. The measurand is sent as response to a Class 2 request when the corresponding timeout expires. The default 
value 0 means 500 ms.

ANALOG # — This field contains the actual measurand to be sent in the response to the master. The measurands can be 
mapped using elements from a list of FlexAnalog operands. The measurands sent are voltage, current, power, power 
factor, and frequency. If any other FlexAnalog is chosen, the F60 sends 0 instead of its value. Note that the power is 
transmitted in KW, not W. Measurands are transmitted as ASDU 3 or ASDU 9 (type identification value set to measurands I, 
respectively measurands II).

Each IEC 60870-5-103 measurands list ends at the first unconfigured ("Off") value. Any measurand assigned after the first 
"Off" value is ignored.

At least one measurand per ASDU must be configured in order to configure the following ASDU. For example, the user can 
configure only one measurand for each ASDU, but the user is not allowed to skip ASDU 2 and configure measurands in 
ASDU 3.

For any change to take effect, restart the relay.

ANALOG # FACTOR and OFFSET — For each measurand included in the ASDU, a factor and offset also can be configured. The 
factor and offset allow for scaling to be performed on measurands. The final measurement sent to the IEC 60870-103 
master is then "a*x + b," where x is the measurand, a is the multiplying factor and b is the offset. The master has to perform 
the reversed operation in order to retrieve the actual value if such scaling is done. By default a = 1 and b = 0, so no scaling 
is done if these values are left at their defaults. Examples of when scaling is appropriate are as follows:

• If the measured value contains decimals and it is important to preserve the resolution. Since the format for 
transmitting the measurand does not permit decimals, a factor a>1 can be applied before transmission. For example, 
a frequency F=59.9Hz can be transmitted as Ft = 10 * F = 10 * 59.9 = 599. In this case a = 10, b = 0. The master receives 
599 and has to divide by 10 to retrieve the real value 59.9.

• If the measured value is larger than what fits in the format defined in IEC 103. The format defined in the standard 
allows for signed integers up to 4095. By offsetting, unsigned integers up to 4096 + 4095 = 8191 are supported. 
Scaling using factors <1 can be required in such cases. The calculation is outlined in the IEC 60870-5-103 chapter of 
the UR Family Communications Guide. Two examples follow, where you decide factors a and b.

Example 1: Nominal power Pn = 100 MW = 100000 KW (power is transmitted in KW)

Since P can be both positive and negative:

Transmitted power Pt = (4095/(Pn*2.4)) * P = (4095/(100000 * 2.4) ) * P 

=  0.017 * P

 ASDU 4 ANALOG 1
FACTOR: 1.000

Range: 0.000 to 65.535 in steps of 0.001

 ASDU 4 ANALOG 1
OFFSET: 0

Range: -32768 to 32767 in steps of 1



 ASDU 4 ANALOG 9
Off

Range: FlexAnalog parameter

 ASDU 4 ANALOG 9 
FACTOR: 1.000

Range: 0.000 to 65.535 in steps of 0.001

 ASDU 4 ANALOG 9 
OFFSET: 0

Range: -32768 to 32767 in steps of 1
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a = 0.017

b = 0

Pt = 0.017 * P

For a max power 100000 KW * 2.4 = 240000 KW, we transmit

Pt = 0.017 * 240000 = 4080

A value above 240 MW is indicated by overflow.

Example 2: Nominal voltage Vn = 500000 V 

Since RMS voltage V can be only positive:

Transmitted voltage Vt = (8191/(Vn*2.4)) * V - 4096 = 

= (8191/(500000 * 2.4) ) * V - 4096 = 0.0068 * V - 4096

a = 0.0068

Since the step is in increments of 0.001, we round it at:

a = 0.006

b = -4096

Vt = 0.006 * V - 4096

For max voltage 500000 V * 2.4 = 1200000 V, we transmit 

Vt = 0.006 * 1200000 - 4096 = 7200 - 4096 = 3104 

SETTINGS  PRODUCT SETUP  COMMUNICATIONS  IEC 60870-5-103  IEC103 COMMANDS

 IEC103 COMMANDS
   COMMAND 0


See below

  COMMAND 1




  COMMAND 31


 COMMAND 0
  COMMAND 0 FUN:

0
Range: 0 to 255 in steps of 1

 COMMAND 0 INF:
0

Range: 0 to 255 in steps of 1

 COMMAND 0 ON:
Off

Range: Virtual input

 COMMAND 0 OFF:
Off

Range: Virtual input


 COMMAND 31
  COMMAND 31 FUN:

0
Range: 0 to 255 in steps of 1

 COMMAND 31 INF:
0

Range: 0 to 255 in steps of 1

 COMMAND 31 ON:
Off

Range: Virtual input

 COMMAND 31 OFF:
Off

Range: Virtual input
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Commands are received as General Command (Type Identification 20). The user can configure the action to perform when 
an ASDU command comes.

A list of available mappings is provided on the F60. This includes 64 virtual inputs (see the following table). The ON and OFF 
for the same ASDU command can be mapped to different virtual inputs.

Each command is identified by the unique combination made by the function type (FUN) and information number (INF). If 
the master sends an ASDU command that does not have the FUN and INF of any configured command, the relay rejects it.

Table 5-12: Commands mapping table

For any change to take effect, restart the relay.

5.3.5.18  USB port
SETTINGS  PRODUCT SETUP  COMMUNICATIONS  USB 2.0

This setting enables/disables the USB port on the graphical front panel. When the port function is "Enabled," a standard 
USB serial cable allows a computer running the EnerVista UR Setup software to retrieve, display, and write settings either 
individually or collectively, to display status and actual values, to initiate controls, and to retrieve and display event records, 
oscillography records, data logger records, and disturbance records. Installation of the EnerVista software automatically 
installs the drivers required to use this USB port.

DNP is not available using the USB port on the graphical front panel.

5.3.6  Modbus user map
SETTINGS  PRODUCT SETUP  MODBUS USER MAP

The Modbus user map provides read-only access for up to 256 registers. To obtain a memory map value, enter the address 
in the ADDRESS line (converted from hex to decimal format). The corresponding value (if programmed) displays in the VALUE 
line. A value of “0” in subsequent register ADDRESS lines automatically returns values for the previous ADDRESS lines 
incremented by 1. An address value of “0” in the initial register means “none” and values of “0” display for all registers. 
Different ADDRESS values can be entered as required in any of the register positions.

The UR Family Communications Guide outlines the Modbus memory map. The map is also viewable in a web browser; 
enter the IP address of the F60 in a web browser and click the option.

Description  Value

Off 0

Virtual Input 1 1

Virtual Input 2 2

... ...

Virtual Input 64 64

 USB 2.0
  USB DEVICE PORT 

FUNCTION: Enabled
Range: Disabled, Enabled

This setting applies to the USB port on the graphical front panel.

 MODBUS USER MAP
  ADDRESS 1: 0

VALUE: 0
Range: 0 to 65535 in steps of 1



 ADDRESS 256: 0
VALUE: 0

Range: 0 to 65535 in steps of 1
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5.3.7  Real-time clock

5.3.7.1  Menu
SETTINGS  PRODUCT SETUP  REAL TIME CLOCK

The relay contains a real time clock (RTC) to create time stamps for communications protocols as well as for historical data, 
such as event records and oscillography. When the relay restarts, the RTC initializes from an onboard battery-backed 
clock, which has the same accuracy as an electronic watch, approximately ±1 minute per month (~23 ppm). Once the RTC 
is synchronized with the Precision Time Protocol (PTP), IRIG-B, or SNTP, its accuracy approaches that of the synchronizing 
time delivered to the relay. While the RTC is not synchronized via PTP or IRIG-B, or the relay determines that it has an offset 
possibly greater than 10 µs from the international time standard, the CLOCK UNSYNCHRONIZED FlexLogic operand is 
activated.

The SYNCHRONIZING SOURCE setting displays in the software when the relay includes the IEEE 1588 software option. The 
setting configures the priority sequence of the time synchronization source, to determine which of the available external 
time sources to use for time synchronization. A setting of None causes the RTC and the synchrophasor clock to free-run, 
and the clock can be changed from the front panel or from communications protocols. A setting of PP/IRIG-B/PTP/Other, 
IRIG-B/PP/PTP/Other, or PP/PTP/IRIG-B/Other causes the relay to track the first source named that is enabled and 
operational, or free-run if none of these are available. Here, PP means a time source that is strictly compliant with PP, PTP 
means a time source that is not strictly compliant with PP, and Other means any less precise source (SNTP, IEC 103, IEC 104, 
Modbus, or DNP). When a time source fails or recovers, the relay automatically transfers synchronization as required by 
this setting.

The PBM Clock setting causes the relay to use the time source from any non-HardFiber Process Bus Module clock. If the 
Process Bus Module PTP FUNCTION setting is enabled and PTP grandmaster is available in the process bus network, the 
Process Bus Module clock is synchronized to the PTP grandmaster, else the Process Bus Module clock free-runs. Note that 
the UR and merging unit are required to be synchronized to the same grandmaster over the Process Bus Module. 
Therefore, for the process bus application, it is strongly recommended to use this "PBM Clock" setting for clock 
synchronization. If the UR is acting as a PTP master over the process bus to synchronize corresponding merging units, this 
setting can be set to PP/IRIG B/PTP/Other, IRIG B/PP/PTP/Other, or PP/PTP/IRIG B/Other.

When the relay does not have the IEEE 1588 software option and this setting does not display, it uses IRIG-B when enabled 
and operational, then failing that SNTP when configured and operational, and otherwise it free-runs unless the clock is 
changed from the front panel or from communications protocols.

Setup for IRIG-B is illustrated in the Installation chapter.

For the Other protocols, whenever a time synchronization message is received through any of the active protocols, the F60 
clock updates. However, given that IEC 60870-5-103, IEC 60870-5-104, Modbus, and DNP are low-accuracy time 
synchronization methods, avoid their use for synchronization when better accuracy time protocols, such as IRIG-B and PTP, 
are active in the system. If IRIG-B or PTP is used to update the relay clock, the other protocols (such as SNTP) are not 
allowed to update, even if active.

See the COMMANDS  SET DATE AND TIME menu section of this manual to manually set the RTC.

 REAL TIME
 CLOCK  SYNCRONIZING SOURCE:

None
Range: None, PP/IRIG-B/PTP/Other, IRIG-B/PP/PTP/
Other, PP/PTP/IRIG-B/Other, PBM Clock

 REAL TIME CLOCK
EVENTS: Disabled

Range: Enabled, Disabled

 IRIG-B SIGNAL TYPE:
None

Range: None, DC Shift, Amplitude Modulated

  PRECISION TIME
 PROTOCOL (1588)

See below

  SNTP PROTOCOL


See below

  LOCAL TIME 


See below
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The REAL TIME CLOCK EVENTS setting allows changes to the date and/or time to be captured in the event record. The event 
records the RTC time before the adjustment. A Date/Time Changed event is generated when:

• The real time clock changed from SNTP/PTP/IRIG-B and the time difference is more than one second

• The real time clock changed from the front panel or via Modbus register. The relay always generates this event 
regardless of the time difference.

• The Daylight Saving Time (DST) setting gets enabled and the current relay time is already in the DST zone

• The real time clock enters or leaves DST

To enable IRIG-B synchronization, the input IRIG-B SIGNAL TYPE must be set to DC Shift or Amplitude Modulated. IRIG-B 
synchronization can be disabled by making this setting None.

Clocks can be synchronized locally among several relays using the computer time. When using a time source, such as IRIG-
B, the time is overwritten eventually by the time source. To synchronize clocks among UR devices:

1. In the EnerVista software, expand the main menu in the Online Window area and select the Synchronize Devices 
entry. The window opens. The software prompts to acknowledge any offline devices.

2. Click the Synchronize Devices button at the top of the window, and confirm the action at the prompt. The devices 
assume the time of the computer being used.

To configure and enable PTP and/or SNTP, or to set local time parameters (for example time zone, daylight savings), use the 
following sections.

5.3.7.2  Precision time protocol (1588)
SETTINGS  PRODUCT SETUP  REAL TIME CLOCK  PRECISION TIME PROTOCOL (1588)

SETTINGS  PRODUCT SETUP  REAL TIME CLOCK  PRECISION TIME PROTOCOL (1588)  PTP PORT 1(3)

The F60 supports the Precision Time Protocol (PTP) specified in IEEE Std 1588 2008 using the Power Profile (PP) specified in 
IEEE Std C37.238 2011. This enables the relay to synchronize to the international time standard over an Ethernet network 
that implements PP.

 PRECISION TIME
 PROTOCOL (1588)  STRICT POWER

PROFILE: Disabled
Range: Enabled, Disabled

 PTP DOMAIN NUMBER:
0

Range: 0 to 255

 PTP VLAN PRIORITY:
4

Range: 0 to 7

 PTP VLAN ID:
0

Range: 0 to 4095

  PTP PORT 1


See below

 PTP PORT 1
  PORT 1 PTP FUNCTION:

Disabled
Range: Enabled, Disabled

 PORT 1 PATH DELAY
ADDER: 0 ns

Range: 0 to 60000 ns in steps of 1

 PORT 1 PATH DELAY
ASYMMETRY: 0 ns

Range: –1000 to +1000 ns in steps of 1

The F60 is provided with optional Precision Time Protocol capability. This feature is specified as the IEEE 1588 
software option at the time of ordering. See the Order Codes section in chapter 2 for details.
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The relay can be configured to operate on some PTP networks that are not strictly PP. Time accuracy can be less than 
specified for a PP network. Tolerated deviations from strict PP include 1) missing declaration of PP compliance in the 
messages, 2) connection to a network device that does not support the PTP peer delay mechanism, 3) jitter substantially 
greater than 1 µs in received event messages, and 4) certain non-compliant announce and sync message update rates.

The relay implements PTP according to IEEE Std 1588 2008 and the equivalent IEC 61588:2009(E), sometimes referred to as 
version 2 PTP. It does not support the previous version of the standard (version 1).

PTP is a protocol that allows multiple clocks in a network to synchronize with one another. It permits synchronization 
accuracies better than 1 ns, but this requires that each and every component in the network achieve very high levels of 
accuracy and a very high baud rate, faster than normally used for relay communications. When operating over a generic 
Ethernet network, time error can amount to 1 ms or more. PP is a profile of PTP which specifies a limited subset of PTP 
suitable for use in power system protection, control, automation, and data communication applications, and thereby 
facilitates interoperability between different vendor’s clocks and switches. PP specifies a worst-case delivered time error of 
less than 1 µs over a 16-hop network.

In a PTP system and in a PP system, the clocks automatically organize themselves into a master-slave synchronization 
hierarchy with the “best” clock available making itself the "grandmaster" at the top of the hierarchy; all others make 
themselves “slaves” and track the grandmaster. Typically the grandmaster clock receives its time from GPS satellites or 
some other link to the international time standard. If the grandmaster fails, the next “best” clock available in the domain 
assumes the grandmaster role. When a clock on start-up discovers that it is “better” than the present grandmaster, it 
assumes the grandmaster role and the previous grandmaster reverts to slave. The F60 qualification mechanism accepts a 
potential master clock as a new grandmaster, when in a four-second interval it has received three announce messages 
from it, all better than the present grandmaster clock and better than any other announce in this interval.

Time messages issued by the grandmaster are delayed as they pass through the network both due to the finite speed of 
the signal in the interconnecting fiber or wire, and due to processing delays in the Ethernet switches. Each clock and switch 
implementing PP measures the propagation delay to each of its PP neighbors, and compensates for these delays in the 
time received. Each network device implementing PP measures the processing delay it introduces in each time message 
and compensates for this delay in the time it transmits. As a result, the time delivered to end-devices such as the UR are 
virtually identical to the grandmaster time. If one of the network devices in the hierarchy does not fully implement PP, the 
associated propagation delay and/or latency may not be compensated for, and the time received at the end-device can be 
in error by more than 100 µs.

See the preceding Real Time Clock section for a description of when time values received via PTP are used to update the 
relay’s real time clock.

The following settings are available for configuring the relay for PTP. The PTP menu displays only when the option was 
purchased.

STRICT POWER PROFILE — Power profile (IEEE Std C37.238 2011) requires that the relay only select a power profile compliant 
clock as a grandmaster, that the delivered time have worst-case error of ±1 µs, and that the peer delay mechanism be 
implemented. With the strict power profile setting enabled, the relay only selects as master the clocks displaying the 
IEEE_C37_238 identification codes. It uses a port only when the peer delay mechanism is operational. With the strict power 
profile setting disabled, the relay uses clocks without the power profile identification when no power profile clocks are 
present, and uses ports even if the peer delay mechanism is non-operational. This setting applies to all of the relay’s PTP 
capable ports.

PTP DOMAIN NUMBER — Set this setting to the domain number of the grandmaster-capable clock(s) to be synchronized to. A 
network can support multiple time distribution domains, each distinguished with a unique domain number. More 
commonly, there is a single domain using the default domain number zero.

This setting applies to all of the relay’s PTP capable ports.

PTP VLAN PRIORITY — This setting selects the value of the priority field in the 802.1Q VLAN tag in request messages issued 
by the relay’s peer delay mechanism. In compliance with PP the default VLAN priority is 4, but it is recommended that it be 
set to 7 in accordance with PTP. Depending on the characteristics of the device to which the relay is linked directly, VLAN 
Priority can have no effect.

This setting applies to all of the relay’s PTP capable ports.
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PTP VLAN ID — This setting selects the value of the ID field in the 802.1Q VLAN tag in request messages issued by the relay’s 
peer delay mechanism. It is provided in compliance with PP. As these messages have a destination address that indicates 
they are not to be bridged, their VLAN ID serves no function, and so can be left at its default value. Depending on the 
characteristics of the device to which the relay is linked directly, VLAN ID can have no effect. This setting applies to all of 
the relay’s PTP capable ports.

PORT 1 ... 3 FUNCTION — While this port setting is selected to disabled, PTP is disabled on this port. The relay does not 
generate or listen to PTP messages on this port.

PORT 1 ... 3 PATH DELAY ADDER — The time delivered by PTP is advanced by the time value in this setting prior to the time 
being used to synchronize the relay’s real time clock. This is to compensate to the extent practical for time delivery delays 
not compensated for in the network. In a fully compliant PP network, the peer delay and the processing delay mechanisms 
compensate for all the delays between the grandmaster and the relay. In such networks, make this setting zero.

In networks containing one or more switches and/or clocks that do not implement both of these mechanisms, not all 
delays are compensated, so the time of message arrival at the relay is later than the time indicated in the message. This 
setting can be used to approximately compensate for this delay. However, as the relay is not aware of network switching 
that dynamically changes the amount of uncompensated delay, there is no setting that always and completely corrects 
for uncompensated delay. A setting can be chosen that reduces the worst-case error to half of the range between 
minimum and maximum uncompensated delay, if these values are known.

PORT 1 ... 3 PATH DELAY ASSYMMETRY — This setting corresponds to “delayAsymmetry” in PTP, which is used by the peer delay 
mechanism to compensate for any difference in the propagation delay between the two directions of a link. Except in 
unusual cases, the two fibers are of essentially identical length and composition, so make this setting zero.

In unusual cases where the length of the link is different in different directions, set this setting to the number of 
nanoseconds the Ethernet propagation delay to the relay is longer than the mean of path propagation delays to and from 
the relay. For instance, if it is known say from the physical length of the fibers and the propagation speed in the fibers that 
the delay from the relay to the Ethernet switch it is connected to is 9000 ns and that the delay from the switch to the relay 
is 11000 ns, then the mean delay is 10000 ns, and the path delay asymmetry is 11000 - 10000 = +1000 ns.

5.3.7.3  SNTP protocol
SETTINGS  PRODUCT SETUP  REAL TIME CLOCK  SNTP PROTOCOL

The F60 supports the Simple Network Time Protocol specified in RFC-2030. With SNTP, the F60 can obtain clock time over 
an Ethernet network. The F60 acts as an SNTP client to receive time values from redundant SNTP/NTP servers, usually a 
dedicated product using a GPS receiver to provide an accurate time. One or two SNTP servers can be used; use of both 
servers for redundancy is recommended but not required.

To use SNTP, enable the function and set SNTP SERVER1 IP ADDR and/or SNTP SERVER2 IP ADDR to the SNTP/NTP server IP 
addresses. The F60 attempts to obtain time values from the SNTP SERVER1 SNTP/NTP server. If SERVER1 is not available/
reachable, the F60 switches to the SNTP SERVER2 to get the time value and vice versa.

Since many time values are obtained and averaged, it generally takes three to four minutes until the F60 clock is closely 
synchronized with the SNTP/NTP server. It can take up to 20 minutes for the F60 to signal an SNTP self-test error if the 
server is offline, depending on the number and SNTP server modes. Broadcast mode timeout is 10 minutes and unicast 
timeout is 80 seconds (corresponds to three unicast request retries).

SNTP FUNCTION — Enables or disables the SNTP feature on the F60.

 SNTP PROTOCOL
  SNTP FUNCTION:

Disabled
Range: Enabled, Disabled

 SNTP SERVER1 IP 
ADDR: 127.0.0.1

Range: standard IP address format

 SNTP SERVER2 IP
ADDR: 127.0.0.1

Range: standard IP address format

 SNTP SERVER1 UDP 
PORT: 123

Range: 0 to 65535 in steps of 1

 SNTP SERVER2 UDP
PORT: 123

Range: 0 to 65535 in steps of 1
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SNTP SERVER1 IP ADDR — The F60 uses the SERVER1 address to contact an SNTP/NTP server to obtain time values. When the 
SNTP FUNCTION setting is set to enabled or on startup if the setting is enabled, the F60 SNTP client requests SERVER1 for the 
time value. If the SERVER1 channel fails or is not reachable, the F60 switches to SERVER2 SNTP/NTP server.

If SERVER1 SNTP server is set to 127.0.0.1, the F60 considers the SERVER1 SNTP server to be unconfigured.

To use SERVER1 SNTP in broadcast mode, set the SNTP SERVER1 IP ADDR setting to "0.0.0.0" and SNTP FUNCTION to "Enabled." 
The F60 SNTP client then listens to SNTP messages sent to the "all ones" broadcast address for the subnet. The F60 waits 
up to 18 minutes (>1024 seconds) without receiving an SNTP broadcast message before switching to the alternate 
channel.

SNTP SERVER2 IP ADDR — The F60 uses this address to contact an SNTP/NTP server if SERVER1 channel fails or is not 
reachable. If SERVER2 SNTP server is set to 127.0.0.1, the F60 considers the SERVER2 SNTP server to be unconfigured.

To use SERVER2 SNTP in broadcast mode, set the SNTP SERVER2 IP ADDR setting to "0.0.0.0" and SNTP FUNCTION to "Enabled." 
The F60 SNTP client then listens to SNTP messages sent to the "all ones" broadcast address for the subnet. The F60 waits 
up to 18 minutes (>1024 seconds) without receiving an SNTP broadcast message before switching to the alternate 
channel.

SNTP SERVER1 UDP PORT — This setting is 123 for normal SNTP operation. If SERVER1 SNTP is not required, close the port by 
changing this setting to zero.

SNTP SERVER2 UDP PORT — This setting is 123 for normal SNTP operation. If SERVER2 SNTP is not required, close the port by 
changing this setting to zero.

5.3.7.4  Local time
SETTINGS  PRODUCT SETUP  REAL TIME CLOCK  LOCAL TIME

The F60 maintains two times: local time and Universal Coordinated Time (UTC). Local time can be provided by IRIG-B 
signals. UTC time is provided by SNTP servers.

Do not set more than one protocol to the same TCP/UDP port number, as this results in unreliable operation of 
those protocols.

If SERVER1 IP ADDR and UDP PORT settings match the SERVER2 IP ADDR and UDP PORT settings, the F60 considers only 
the SERVER1 SNTP server as being configured and an SNTP Failure error message generates. The failure message 
also displays when both servers are unavailable.

 LOCAL TIME
  LOCAL TIME OFFSET

FROM UTC: 0.0 hr
Range: –24.0 to 24.0 hr in steps of 0.5

 DAYLIGHT SAVINGS
TIME: Disabled

Range: Disabled, Enabled

 DST START MONTH:
January

Range: January to December (all months)

 DST START DAY:
Sunday

Range: Sunday to Saturday (all days of the week)

 DST START DAY
INSTANCE: First

Range: First, Second, Third, Fourth, Last

 DST START HOUR:
2:00

Range: 0:00 to 23:00 in steps of one hour

 DST STOP MONTH:
January

Range: January to December (all months)

 DST STOP DAY:
Sunday

Range: Sunday to Saturday (all days of the week)

 DST STOP DAY
INSTANCE: First

Range: First, Second, Third, Fourth, Last

 DST STOP HOUR:
2:00

Range: 0:00 to 23:00 in steps of one hour
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The real-time clock (RTC) and time stamps reported in historical records and communication protocols can be incorrect if 
the Local Time settings are not configured properly.

See the IRIG-B section in the Installation chapter for guidance on these settings when using an IRIG-B source that sets the 
IRIG-B control bits according to IEEE Std 1344-1995.

LOCAL TIME OFFSET FROM UTC — Used to specify the local time zone offset from UTC (Greenwich Mean Time) in hours. Time 
zones in the eastern hemisphere have positive values; time zones in the western hemisphere have negative values. A value 
of zero causes the relay to use UTC for local time. This setting has two uses. When the system RTC is synchronized with a 
communications protocol providing only local time or it is free-running, the offset setting is used to calculate UTC from the 
local time these provide. When the RTC is synchronized with a communications protocol providing only UTC (such as PTP or 
SNTP), the time offset setting is used to determine local time from the UTC provided. PTP 
ALTERNATE_TIME_OFFSET_INDICATOR TLVs are not used to calculate local time.

DAYLIGHT SAVINGS TIME and DST — Can be used to allow the relay to follow the DST rules of the local time zone. Note that 
when IRIG-B time synchronization is active, the local time in the IRIG-B signal contains any daylight savings time offset and 
so the DST settings are ignored.

5.3.8  Fault reports
SETTINGS  PRODUCT SETUP  FAULT REPORTS  FAULT REPORT 1(3)

The F60 relay supports one fault report and an associated fault locator per CT bank to a maximum of three. The signal 
source and trigger condition, as well as the characteristics of the line or feeder, are entered in this menu.

 FAULT REPORT 1
  FAULT REPORT 1

SOURCE: SRC 1
Range:  SRC 1, SRC 2, SRC 3, SRC 4

 FAULT REPORT 1 TRIG:
Off

Range:  FlexLogic operand

 FAULT REPORT 1 Z1
MAG: 3.00 

Range:  0.01 to 250.00 ohms in steps of 0.01

 FAULT REPORT 1 Z1
ANGLE: 75°

Range:  25 to 90° in steps of 1

 FAULT REPORT 1 Z0
MAG: 9.00 

Range:  0.01 to 650.00 ohms in steps of 0.01

 FAULT REPORT 1 Z0
ANGLE: 75°

Range:  25 to 90° in steps of 1

 FAULT REPORT 1 Z0M
MAG: 0.00 

Range:  0.00 to 650.00 ohms in steps of 0.01

 FAULT REPORT 1 Z0M
ANGLE: 75°

Range:  25 to 90° in steps of 1

 FAULT REPORT 1 LINE
LENGTH UNITS: km

Range:  km, miles

 FAULT REP 1 LENGTH
(km ): 100.0

Range:  0.0 to 2000.0 in steps of 0.1

 FAULT REPORT 1 VT
SUBSTITUTION: None

Range:  None, I0, V0

 FAULT REP 1 SYSTEM
Z0 MAG: 2.00 

Range:  0.01 to 650.00 ohms in steps of 0.01

 FAULT REP 1 SYSTEM
Z0 ANGLE: 75°

Range:  25 to 90° in steps of 1

 FAULT REPORT 1 Z0M
MAG: 0.00 

Range:  0.00 to 650.00 ohms in steps of 0.01
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The fault report stores data, in non-volatile memory, pertinent to an event when triggered. The captured data contained in 
the FaultReport.txt file includes:

• Fault report number

• Name of the relay, programmed by the user

• Firmware revision of the relay

• Date and time of trigger

• Name of trigger (specific operand)

• Line or feeder ID via the name of a configured signal source

• Active setting group at the time of trigger

• Pre-fault current and voltage phasors (two cycles before either a 50DD disturbance associated with fault report 
source or the trigger operate). Once a disturbance is detected, pre-fault phasors hold for three seconds waiting for the 
fault report trigger. If trigger does not occur within this time, the values are cleared to prepare for the next disturbance.

• Fault current and voltage phasors (one cycle after the trigger)

• Elements operated at the time of triggering

• Events — Nine before trigger and seven after trigger (only available via the relay web page)

• Fault duration times for each breaker (created by the breaker arcing current feature)

The captured data also includes the fault type, the distance to the fault location, distance to the fault location, fault loop 
impedance, as well as the reclose shot number (when applicable). To include fault duration times in the fault report, enable 
and configure the breaker arcing current feature for each of the breakers. Fault duration is reported on a per-phase basis.

The relay allows locating faults, including ground faults, from delta-connected VTs. In this case, the missing zero-sequence 
voltage is substituted either by the externally provided neutral voltage (broken delta VT) connected to the auxiliary voltage 
channel of a VT bank, or by the zero-sequence voltage approximated as a voltage drop developed by the zero-sequence 
current, and user-provided zero-sequence equivalent impedance of the system behind the relay.

The trigger can be any FlexLogic operand, but in most applications it is expected to be the same operand, usually a virtual 
output, that is used to drive an output relay to trip a breaker. To prevent the overwriting of fault events, do not use the 
disturbance detector to trigger a fault report. A FAULT RPT TRIG event is automatically created when the report is triggered.

If a number of protection elements are ORed to create a fault report trigger, the first operation of any element causing the 
OR gate output to become high triggers a fault report. However, If other elements operate during the fault and the first 
operated element has not been reset (the OR gate output is still high), the fault report is not triggered again. Considering 
the reset time of protection elements, there is very little chance that a fault report can be triggered twice in this manner. As 
the fault report must capture a usable amount of pre and post-fault data, it cannot be triggered faster than every 20 ms.

Each fault report is stored as a file; the relay capacity is 15 files. A 16th trigger overwrites the oldest file.

Individual fault report features store their files in the same memory space. The sixteenth report overwrites the first one 
regardless of which fault report feature produced the sixteenth and the first records.

The EnerVista software is required to view all captured data. The relay faceplate display can be used to view the date and 
time of trigger, the fault type, the distance location of the fault, and the reclose shot number.

The FAULT REPORT 1 SOURCE setting selects the source for input currents and voltages and disturbance detection. For the 
application of entirely parallel lines, the fault report can be programmed to apply compensation for the zero sequence 
mutual coupling between parallel lines when calculating fault resistance and fault loop impedance. If this compensation is 
required, the ground current (3I_0) from the parallel line must be connected to the ground input CT of the CT bank 
configured under the FAULT REPORT 1 SOURCE with the same polarity as the phase current input configured in the same 
source.

The FAULT 1 REPORT TRIG setting assigns the FlexLogic operand representing the protection element/elements requiring 
operational fault location calculations. The distance to fault calculations are initiated by this signal. The FAULT REPORT 1 Z1 
MAG, FAULT REPORT 1 Z0 MAG, and FAULT REPORT 1 Z0M MAG impedances are entered in secondary ohms.

For the application of entirely parallel lines, Z0M MAG/ANG is the mutual zero-sequence impedance for the whole line, 
required to compensate the calculation of fault resistance and fault loop impedance.
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The FAULT REPORT 1 VT SUBSTITUTION setting is set to “None” if the relay is fed from wye-connected VTs. If delta-connected 
VTs are used, and the relay is supplied with the neutral (3V0) voltage, this setting is set to “V0”. The method is still exact, as 
the fault locator combines the line-to-line voltage measurements with the neutral voltage measurement to re-create the 
line-to-ground voltages. See the ACTUAL VALUES  RECORDS  FAULT REPORTS menu for details. It is required to configure 
the delta and neutral voltages under the source indicated as input for the fault report. Also, the relay checks if the auxiliary 
signal configured is marked as “Vn” by the user (under VT setup) and inhibits the fault location if the auxiliary signal is 
labeled differently.

If the broken-delta neutral voltage is not available to the relay, an approximation is possible by assuming the missing zero-
sequence voltage to be an inverted voltage drop produced by the zero-sequence current and the user-specified 
equivalent zero-sequence system impedance behind the relay: V0 = –Z0  I0. In order to enable this mode of operation, the 
FAULT REPORT 1 VT SUBSTITUTION setting is set to “I0”.

The FAULT REP 1 SYSTEM Z0 MAG and FAULT REP 1 SYSTEM Z0 ANGLE settings are used only when the VT SUBSTITUTION setting 
value is “I0”. The magnitude is to be entered in secondary ohms. This impedance is an average system equivalent behind 
the relay. It can be calculated as zero-sequence Thevenin impedance at the local bus with the protected line/feeder 
disconnected. The method is accurate only if this setting matches perfectly the actual system impedance during the fault. 
If the system exhibits too much variability, this approach is questionable and the fault location results for single-line-to-
ground faults is trusted accordingly. Keep in mind that grounding points in the vicinity of the installation impact the system 
zero-sequence impedance (grounded loads, reactors, zig-zag transformers, shunt capacitor banks, and so on).

5.3.9  Oscillography

5.3.9.1  Menu
SETTINGS  PRODUCT SETUP  OSCILLOGRAPHY

Oscillography records contain waveforms captured at the sampling rate as well as other relay data at the point of trigger. 
Oscillography records are triggered by a programmable FlexLogic operand. Multiple oscillography records can be captured 
simultaneously.

To retrieve an Oscillography record from a relay:

1. If not yet set up for oscillography, configure settings under Settings > Product Setup > Oscillography in the EnerVista 
software.

2. Access Actual Values > Records > Oscillography in the EnerVista software.

3. In the window that opens, select the record number. The highest number is the most recent record (Newest Record 
Number).

4. Click the Read button to get the waveform. When available, waveforms are displayed graphically, and otherwise error 
messages display.

5. In the waveform window that opens, you can save the file, for example with the CFG extension.

 OSCILLOGRAPHY
  NUMBER OF RECORDS:

 5
Range: 1 to 64 in steps of 1

 TRIGGER MODE:
Automatic Overwrite

Range: Automatic Overwrite, Protected

 TRIGGER POSITION:
50%

Range: 0 to 100% in steps of 1

 TRIGGER SOURCE:
Off

Range: FlexLogic operand

 AC INPUT WAVEFORMS:
16 samples/cycle

Range: Off; 8, 16, 32, 64 samples/cycle

  DIGITAL CHANNELS


See below

  ANALOG CHANNELS


See below
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When EnerVista UR Setup creates a new settings file, a Smart defaults feature automatically enters a basic oscillography 
configuration. The basic configuration changes the factory default values to make the number of samples per cycle 32, 
adds a selection of digital and analog channels that are often of interest, and adds a FlexLogic equation to trigger 
oscillography. Review and update this basic configuration as required for the application at hand.

The NUMBER OF RECORDS is selectable, but the number of cycles captured in a single record varies considerably based on 
other factors, such as sample rate and the number of operational modules. There is a fixed amount of data storage for 
oscillography; the more data captured, the less the number of cycles captured per record. See the ACTUAL VALUES  
RECORDS  OSCILLOGRAPHY menu to view the number of cycles captured per record. The following table provides sample 
configurations with corresponding cycles/record. The minimum number of oscillographic records is three.

Table 5-13: Oscillography cycles/record example

TRIGGER MODE — A new record automatically overwrites an older record when TRIGGER MODE is set to “Automatic 
Overwrite.”

TRIGGER POSITION — Set this to a percentage of the total buffer size (for example, 10%, 50%, 75%, and so on). A trigger 
position of 25% consists of 25% pre- and 75% post-trigger data.

TRIGGER SOURCE — Always captured in oscillography and can be any FlexLogic parameter (element state, contact input, 
virtual output, and so on). The relay sampling rate is 64 samples per cycle.

AC INPUT WAVEFORMS — Determines the sampling rate at which AC input signals (that is, current and voltage) are stored. 
Reducing the sampling rate allows longer records to be stored. This setting has no effect on the internal sampling rate of 
the relay, which is always 64 samples per cycle. That is, it has no effect on the fundamental calculations of the device.

5.3.9.2  Digital channels
SETTINGS  PRODUCT SETUP  OSCILLOGRAPHY  DIGITAL CHANNELS

DIGITAL 1(63) CHANNEL — This setting selects the FlexLogic operand state recorded in an oscillography trace. The length of 
each oscillography trace depends in part on the number of parameters selected here. Parameters set to “Off” are ignored.

To populate quickly the rows in the Offline Window, use Ctrl C/V to copy/paste, or click then double-click a row to display a 
quick selection window.

Records CT/VTs Sample rate Digital 
channels

Analog 
channels

Cycles per
record

3 1 32 32 16 2399

3 1 64 32 16 1450

16 1 32 32 16 666

16 1 64 32 16 402

32 1 32 32 16 352

32 1 64 32 16 213

3 2 32 32 16 1516

3 2 64 32 16 851

16 2 32 32 16 421

When changes are made to the oscillography settings, all existing oscillography records are cleared.

 DIGITAL CHANNELS
  DIGITAL CHANNEL 1:

Off
Range: FlexLogic operand



 DIGITAL CHANNEL 63:
Off

Range: FlexLogic operand
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Figure 5-49: Quick selection window

5.3.9.3  Analog channels
SETTINGS  PRODUCT SETUP  OSCILLOGRAPHY  ANALOG CHANNELS

These settings select the metering actual value recorded in an oscillography trace. The length of each oscillography trace 
depends in part on the number of parameters selected here. Parameters set to “Off” are ignored. The parameters available 
in a given relay depend on

• the type of relay,

• the type and number of CT/VT hardware modules installed, and

• the type and number of analog input hardware modules installed

A list of all possible analog metering actual value parameters is presented in Appendix A: FlexAnalog Parameters. The 
parameter index number shown in any of the tables is used to expedite the selection of the parameter on the relay display. 
It can be time-consuming to scan through the list of parameters via the relay keypad and display — entering this number 
via the relay keypad causes the corresponding parameter to display.

All eight CT/VT module channels are stored in the oscillography file. The CT/VT module channels are named as follows:

<slot_letter><terminal_number>—<I or V><phase A, B, or C, or 4th input>

The fourth current input in a bank is called IG, and the fourth voltage input in a bank is called VX. For example, F2-IB 
designates the IB signal on terminal 2 of the CT/VT module in slot F.

If there are no CT/VT modules and analog input modules, no analog traces appear in the file; only the digital traces appear.

The source harmonic indices appear as oscillography analog channels numbered from 0 to 23. These correspond directly 
to the to the 2nd to 25th harmonics in the relay as follows:

Analog channel 0 2nd harmonic
Analog channel 1  3rd harmonic

...
Analog channel 23  25th harmonic

5.3.10  Data logger
SETTINGS  PRODUCT SETUP  DATA LOGGER

 ANALOG CHANNELS
  ANALOG CHANNEL 1:

Off
Range: Off, any FlexAnalog/actual value parameter
See Appendix A for list



 ANALOG CHANNEL 16:
Off

Range: Off, any FlexAnalog/actual value parameter
See Appendix A for list

 DATA LOGGER
  DATA LOGGER MODE:

Continuous
Range:  Continuous, Trigger

 DATA LOGGER TRIGGER:
Off

Range:  FlexLogic operand

 DATA LOGGER RATE:
60000 msec

Range:  15 to 3600000 ms in steps of 1
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The data logger samples and records up to 16 analog parameters at a user-defined sampling rate. This recorded data can 
be downloaded to EnerVista UR Setup and displayed with parameters on the vertical axis and time on the horizontal axis. 
All data is stored in non-volatile memory, so the information is retained when power to the relay is lost.

For a fixed sampling rate, the data logger can be configured with a few channels over a long period or a larger number of 
channels for a shorter period. The relay automatically partitions the available memory between the channels in use. The 
following table outlines examples of storage capacities for a system frequency of 60 Hz.

Table 5-14: Data logger storage capacity example

DATA LOGGER MODE — This setting configures the mode in which the data logger operates. When set to “Continuous,” the 
data logger actively records any configured channels at the rate as defined by the DATA LOGGER RATE. The data logger is 
idle in this mode when no channels are configured. When set to “Trigger,” the data logger records any configured channels 
at the instance of the rising edge of the DATA LOGGER TRIGGER source FlexLogic operand. The data logger ignores all 
subsequent triggers and continues to record data until the active record is full. Once the data logger is full, a CLEAR DATA 
LOGGER command is required to clear the data logger record before a new record can be started. Performing the CLEAR 
DATA LOGGER command also stops the current record and resets the data logger to be ready for the next trigger.

DATA LOGGER TRIGGER — This setting selects the signal used to trigger the start of a new data logger record. Any FlexLogic 
operand can be used as the trigger source. This setting only applies when the mode is set to “Trigger.”

DATA LOGGER RATE — This setting selects the time interval at which the actual value data is recorded.

DATA LOGGER CHNL 1(16) — This setting selects the metering actual value that is to be recorded in Channel 1(16) of the data 
log. The parameters available in a given relay are dependent on: the type of relay, the type and number of CT/VT hardware 
modules installed, and the type and number of Analog Input hardware modules installed. Upon startup, the relay 
automatically prepares the parameter list. A list of all possible analog metering actual value parameters is shown in 

 DATA LOGGER CHNL 1:
Off

Range:  Off, any FlexAnalog/actual value parameter
See Appendix A for list



 DATA LOGGER CHNL 16:
Off

Range:  Off, any FlexAnalog/actual value parameter
See Appendix A for list

 DATA LOGGER CONFIG:
0 CHNL x 0.0 DAYS

Range:  Not applicable - shows computed data only

Sampling rate Channels Days Storage capacity

15 ms 1 0.1 482 s

8 0.1 60 s

9 0.1 54 s

16 0.1 30 s

1000 ms 1 0.3 32729 s

8 0.1 4091 s

9 0.1 3637 s

16 0.1 2046 s

60000 ms 1 22.7 1963710 s

8 2.8 245460 s

9 2.5 218190 s

16 1.4 127230 s

3600000 ms 1 1362.1 117822600 s

8 170.2 14727600 s

9 151.3 13091400 s

Changing any setting affecting data logger operation clears data in the log.
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Appendix A: FlexAnalog Parameters. The parameter index number shown in any of the tables is used to expedite the 
selection of the parameter on the relay display. It can be time-consuming to scan through the list of parameters via the 
relay keypad/display—entering this number via the relay keypad causes the corresponding parameter to display.

DATA LOGGER CONFIG — This display presents the total amount of time that the Data Logger can record the channels not 
selected to “Off” without overwriting old data.

5.3.11  Demand
SETTINGS  PRODUCT SETUTP  DEMAND

The relay measures current demand on each phase, and three-phase demand for real, reactive, and apparent power. 
Current and Power methods can be chosen separately for the convenience of the user. Settings are provided to allow the 
user to emulate common electrical utility demand measuring techniques, for statistical or control purposes. If the CRNT 
DEMAND METHOD is set to "Block Interval" and the DEMAND TRIGGER is set to “Off,” Method 2 is used as follows. If DEMAND 
TRIGGER is assigned to any other FlexLogic operand, Method 2a is used as follows.

The relay can be set to calculate demand by any of the following three methods.

5.3.11.1  Calculation method 1: Thermal exponential
This method emulates the action of an analog peak-recording thermal demand meter. The relay measures the quantity 
(RMS current, real power, reactive power, or apparent power) on each phase every second and assumes that the circuit 
quantity remains at this value until updated by the next measurement. It calculates the 'thermal demand equivalent' 
based on the following equation:

Eq. 5-6

where

d = demand value after applying input quantity for time t (in minutes)
D = input quantity (constant)
k = 2.3 / thermal 90% response time

The figure shows the 90% thermal response time characteristic of 15 minutes. A setpoint establishes the time to reach 
90% of a steady-state value, just as the response time of an analog instrument. A steady state value applied for twice the 
response time indicates 99% of the value.

Figure 5-50: Thermal demand characteristic 

 DEMAND
  CRNT DEMAND METHOD:

Thermal Exponential
Range: Thermal Exponential, Block Interval, Rolling 
Demand

 POWER DEMAND METHOD:
Thermal Exponential

Range: Thermal Exponential, Block Interval, Rolling 
Demand

 DEMAND INTERVAL:
15 MIN

Range: 5, 10, 15, 20, 30, 60 minutes

 DEMAND TRIGGER:
Off

Range: FlexLogic operand
Note: for calculation using method 2a
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5.3.11.2  Calculation method 2: Block interval
This method calculates a linear average of the quantity (RMS current, real power, reactive power, or apparent power) over 
the programmed demand time interval, starting daily at 00:00:00 (that is, 12:00 am). The 1440 minutes per day is divided 
into the number of blocks as set by the programmed time interval. Each new value of demand becomes available at the 
end of each time interval.

5.3.11.3  Calculation method 2a: Block interval (with start demand interval logic trigger)
This method calculates a linear average of the quantity (RMS current, real power, reactive power, or apparent power) over 
the interval between successive Start Demand Interval logic input pulses. Each new value of demand becomes available at 
the end of each pulse. Assign a FlexLogic operand to the DEMAND TRIGGER setting to program the input for the new 
demand interval pulses.

5.3.11.4  Calculation method 3: Rolling demand
This method calculates a linear average of the quantity (RMS current, real power, reactive power, or apparent power) over 
the programmed demand time interval, in the same way as Block Interval. The value is updated every minute and 
indicates the demand over the time interval just preceding the time of update.

5.3.12  User-programmable LEDs

5.3.12.1  Menu - Enhanced and basic front panels
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE LEDS

5.3.12.2  Menu - Graphical front panel
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE LEDS

If no trigger is assigned in the DEMAND TRIGGER setting and the CRNT DEMAND METHOD is "Block Interval," use 
calculation method 2. If a trigger is assigned, the maximum allowed time between two trigger signals is 60 minutes. 
If no trigger signal appears within 60 minutes, demand calculations are performed and available, and the algorithm 
resets and starts the new cycle of calculations. The minimum required time for trigger contact closure is 20 µs.

 USER-PROGRAMMABLE
 LEDS   LED TEST

 
See below

  TRIP & ALARM LEDS
 

See page 5-127

  USER-PROGRAMMABLE
 LED 1

See page 5-127



  USER-PROGRAMMABLE
 LED 48

 USER-PROGRAMMABLE
 LEDS   LED TEST

 
See below

  TRIP & ALARM LEDS
 

See page 5-127

  EVENT CAUSE LED 1
 

See page 5-128



  EVENT CAUSE LED 9
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The LEDs can be customized to illuminate when a selected FlexLogic operand is in the logic 1 state. The trip and alarm 
LEDs can also be customized in a similar manner. To ensure correct functionality of all LEDs, an LED test feature is also 
provided.

5.3.12.3  LED test
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE LEDS  LED TEST

When enabled, the LED test can be initiated from any digital input or user-programmable condition, such as a user-
programmable pushbutton. The control operand is configured under the LED TEST CONTROL setting. The test covers all 
LEDs, including the LEDs of the optional user-programmable pushbuttons.

For the enhanced and basic front panels, the test consists of the following three stages:

1. All 62 LEDs on the relay are illuminated. This is a quick test to verify if any of the LEDs is “burned.” This stage lasts as 
long as the control input is on, up to a maximum of one minute. After one minute, the test ends.

2. All the LEDs are turned off, and then one LED at a time turns on for one second, then back off. The test routine starts at 
the top left panel, moving from the top to bottom of each LED column. This test checks for hardware failures that lead 
to more than one LED being turned on from a single logic point. This stage can be interrupted at any time.

3. All the LEDs are turned on. One LED at a time turns off for one second, then back on. The test routine starts at the top 
left panel moving from top to bottom of each column of the LEDs. This test checks for hardware failures that lead to 
more than one LED being turned off from a single logic point. This stage can be interrupted at any time.

For the graphical front panel, the test consists of the following stages:

1. All 22 LEDs on the relay are illuminated. This is a quick test to verify if any of the LEDs is "burned." This stage lasts as 
long as the control input is on, up to a maximum of one minute. After one minute, the test ends.

2. All the LEDs are turned off, and then one LED at a time turns on with the orange color for one second, then back off. 
The test routine starts at the top left panel, moving from the top to bottom for all 14 LEDs. Then the eight pushbutton 
LEDs are tested in the same manner. This test checks for hardware failures that lead to more than one LED being 
turned on from a single logic point. This stage can be interrupted at any time.

3. All the LEDs are turned on with the orange color. One LED at a time turns off for one second, then back on. The test 
routine starts at the top left panel moving from top to bottom for all 14 LEDs. Then the eight pushbutton LEDs are 
tested in the same manner. This test checks for hardware failures that lead to more than one LED being turned off 
from a single logic point. This stage can be interrupted at any time.

4. Additionally, stages 2 and 3 are repeated twice for the five device status LEDs and nine event cause LEDs, one time 
with green color on and the other with red color on.

When testing is in progress, the LEDs are controlled by the test sequence, rather than the protection, control, and 
monitoring features. However, the LED control mechanism accepts all the changes to LED states generated by the relay 
and stores the actual LED states (on or off) in memory. When the test completes, the LEDs reflect the actual state resulting 
from relay response during testing. The reset pushbutton does not clear any targets when the LED Test is in progress.

A dedicated FlexLogic operand, LED TEST IN PROGRESS, is set for the duration of the test. When the test sequence is initiated, 
the LED TEST INITIATED event is stored in the event recorder.

The entire test procedure is user-controlled. In particular, stage 1 can last as long as necessary, and stages 2 and 3 can be 
interrupted. The test responds to the position and rising edges of the control input defined by the LED TEST CONTROL 
setting. The control pulses must last at least 250 ms to take effect. The following diagram explains how the test is 
executed.

 LED TEST
  LED TEST FUNCTION:

Disabled
Range: Disabled, Enabled

 LED TEST CONTROL:
Off

Range: FlexLogic operand
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Figure 5-51: LED test sequence 

Application example 1
Assume one needs to check if any of the LEDs is “burned” through user-programmable pushbutton 1. Apply the following 
settings.

Configure user-programmable pushbutton 1 by making the following entries in the SETTINGS  PRODUCT SETUP  USER-
PROGRAMMABLE PUSHBUTTONS  USER PUSHBUTTON 1 menu. (The option does not display when not purchased.)

PUSHBUTTON 1 FUNCTION: “Self-reset”
PUSHBTN 1 DROP-OUT TIME: “0.10 s”

Configure the LED test to recognize user-programmable pushbutton 1 by making the following entries in the SETTINGS  
PRODUCT SETUP  USER-PROGRAMMABLE LEDS  LED TEST menu:

LED TEST FUNCTION: “Enabled”
LED TEST CONTROL: “PUSHBUTTON 1 ON”

The test is initiated when the user-programmable pushbutton 1 is pressed. Keep the pushbutton pressed for as long as the 
LEDs are being visually inspected. When finished, release the pushbutton. The relay then automatically starts stage 2. At 
this point, test can be cancelled by pressing the pushbutton.

Application example 2
Assume one needs to check if any LEDs are “burned” as well as exercise one LED at a time to check for other failures. This 
is to be performed via user-programmable pushbutton 1.

After applying the settings in application example 1, hold down the pushbutton as long as necessary to test all LEDs. When 
finished, release the pushbutton so that the relay then automatically starts stage 2. When stage 2 is completed, stage 3 
starts automatically. The test can be cancelled at any time by pressing the pushbutton.
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5.3.12.4  Trip and alarm LEDs
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE LEDS  TRIP & ALARMS LEDS

The trip and alarm LEDs are in the first LED column (enhanced and graphical front panels) and on LED panel 1 (basic front 
panel). Each LED can be programmed to turn on when the selected FlexLogic operand is in the logic 1 state.

5.3.12.5  User-programmable LED 1(48)
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE LEDS  USER-PROGRAMMABLE LED 1(48)

For the enhanced and basic front panels, there are 48 amber LEDs across the relay LED panels. Each of these indicators 
can be programmed to illuminate when the selected FlexLogic operand is in the logic 1 state.

For the basic front panel, the LEDs are located as follows:

• LED Panel 2 — User-programmable LEDs 1 through 24

• LED Panel 3 — User programmable LEDs 25 through 48

For the enhanced front panel, the LEDs are located as follows:

• LED column 2 — User-programmable LEDs 1 through 12

• LED column 3 — User-programmable LEDs 13 through 24

• LED column 4 — User-programmable LEDs 25 through 36

• LED column 5 — User-programmable LEDs 37 through 48

See the LED Indicators section in chapter 4 for information on the location of these indexed LEDs.

The user-programmable LED settings select the FlexLogic operands that control the LEDs. If the LED 1 TYPE setting is “Self-
Reset” (the default setting), the LED illumination tracks the state of the selected LED operand. If the LED 1 TYPE setting is 
“Latched,” the LED, once lit, remains so until reset by the front panel RESET button, from a remote device via a 
communications channel, or from any programmed operand, even if the LED operand state de-asserts.

Table 5-15: Recommended settings for user-programmable LEDs

 TRIP & ALARM LEDS
  TRIP LED INPUT:

Off
Range: FlexLogic operand

 ALARM LED INPUT:
Off

Range: FlexLogic operand

 USER-PROGRAMMABLE
 LED 1  LED 1 OPERAND:

Off
Range: FlexLogic operand

 LED 1 TYPE:
Self-Reset

Range: Self-Reset, Latched

Setting Parameter Setting Parameter

LED 1 operand SETTING GROUP ACT 1 LED 13 operand Off

LED 2 operand SETTING GROUP ACT 2 LED 14 operand BREAKER 2 OPEN

LED 3 operand SETTING GROUP ACT 3 LED 15 operand BREAKER 2 CLOSED

LED 4 operand SETTING GROUP ACT 4 LED 16 operand BREAKER 2 TROUBLE

LED 5 operand SETTING GROUP ACT 5 LED 17 operand SYNC 1 SYNC OP

LED 6 operand SETTING GROUP ACT 6 LED 18 operand SYNC 2 SYNC OP

LED 7 operand Off LED 19 operand Off

LED 8 operand Off LED 20 operand Off

LED 9 operand BREAKER 1 OPEN LED 21 operand AR ENABLED

LED 10 operand BREAKER 1 CLOSED LED 22 operand AR DISABLED

LED 11 operand BREAKER 1 TROUBLE LED 23 operand AR RIP

LED 12 operand Off LED 24 operand AR LO
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See the figure in the Setting Groups section of the Control Elements section later in this chapter for an example of group 
activation.

5.3.12.6  Event cause LED 1(9)
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE LEDS  EVENT CAUSE LED 1(9)

For the graphical front panel, the event cause LED settings select the FlexLogic operands that control the LEDs.

LED 1 TYPE — If set to "Self-Reset," the LED illumination tracks the state of the selected LED operand. If set to "Latched," the 
LED, once lit, remains so even the LED operand state already de-asserts, until reset by the front panel RESET button, from a 
remote device via a communications channel, or from any programmed operand.

The table outlines default input operand and output operands for each event cause LED.

Table 5-16: Default input and output operand for event cause LEDs

5.3.13  User-programmable self-tests
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE SELF TESTS

 EVENT CAUSE
 LED 1  LED 1 OPERAND:

LED PICKUP
Range: FlexLogic operand

 LED 1 COLOR:
Green

Range: Red, Green, Orange

 LED 1 TYPE:
Self-Reset

Range: Self-Reset, Latched

LED Default input operand Output operand Default color

Event Cause LED 1 LED PICKUP EVENT CAUSE LED 1 Green

Event Cause LED 2 LED VOLTAGE EVENT CAUSE LED 2 Orange

Event Cause LED 3 LED CURRENT EVENT CAUSE LED 3 Orange

Event Cause LED 4 LED FREQUENCY EVENT CAUSE LED 4 Orange

Event Cause LED 5 LED OTHER EVENT CAUSE LED 5 Orange

Event Cause LED 6 LED PHASE A EVENT CAUSE LED 6 Orange

Event Cause LED 7 LED PHASE B EVENT CAUSE LED 7 Orange

Event Cause LED 8 LED PHASE C EVENT CAUSE LED 8 Orange

Event Cause LED 9 LED NEUTRAL/GROUND EVENT CAUSE LED 9 Orange

 USER-PROGRAMMABLE
 SELF TESTS  DIRECT RING BREAK

FUNCTION: Enabled
Range: Disabled, Enabled. Valid for units equipped 
with Direct Input/Output module.

 DIRECT DEVICE OFF
FUNCTION: Enabled

Range: Disabled, Enabled. Valid for units equipped 
with Direct Input/Output module.

 RxGOOSE OFF
FUNCTION: Enabled

Range: Disabled, Enabled

 FIRST ETHERNET FAIL
FUNCTION: Disabled

Range: Disabled, Enabled

 SEC. ETHERNET FAIL
FUNCTION: Disabled

Range: Disabled, Enabled

 THIRD ETHERNET FAIL
FUNCTION: Disabled

Range: Disabled, Enabled

 SFP MODULE FAIL
FUNCTION: Disabled

Range: Disabled, Enabled

 BATTERY FAIL
FUNCTION: Enabled

Range: Disabled, Enabled
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All major self-test alarms are reported automatically with their corresponding FlexLogic operands, events, and targets.

This settings menu allows enabling and disabling of most minor self-test alarms.

When in the Disabled mode, minor alarms do not assert a FlexLogic operand, write to the event recorder, or display target 
messages. Moreover, they do not trigger the ANY MINOR ALARM or ANY SELF-TEST messages. When in Enabled mode, 
minor alarms continue to function along with other major and minor alarms. See the Relay Self-tests section in chapter 7 
for information on major and minor self-test alarms.

When using the graphical front panel and setting annunciator alarms, the function needs to be enabled here too, else the 
alarm is not triggered.

PB SFP MODUL # FAIL FUNCTION — For order code H85, ports 2a, 2b, 4a, 4b are not available.

5.3.14  Control pushbuttons
SETTINGS  PRODUCT SETUP  CONTROL PUSHBUTTONS  CONTROL PUSHBUTTON 1(7)

This feature is supported with enhanced and basic front panels.

There are three standard control pushbuttons, labelled USER 1, USER 2, and USER 3, on the basic and enhanced front 
panels. These are user-programmable and can be used for various applications such as performing an LED test, switching 
setting groups, and invoking and scrolling though user-programmable displays.

Firmware revisions 3.2x and older use these three pushbuttons for manual breaker control. This functionality has been 
retained—if the breaker control feature is configured to use the three pushbuttons, they cannot be used as user-
programmable control pushbuttons.

The location of the control pushbuttons are shown in the following figures.

 SNTP FAIL
FUNCTION: Enabled

Range: Disabled, Enabled

 IRIG-B FAIL
FUNCTION: Enabled

Range: Disabled, Enabled

 PTP FAIL
FUNCTION: Enabled

Range: Disabled, Enabled

 SV STREAM TROUBLE
FUNCTION: Enabled

Range: Disabled, Enabled

 PB ETH PORT 1a FAIL
FUNCTION: Disabled

Range: Disabled, Enabled



 PB ETH PORT Port 4b FAIL
FUNCTION: Disabled

Range: Disabled, Enabled

 PB SFP MODUL 1a FAIL
FUNCTION: Disabled

Range: Disabled, Enabled



 PB SFP MODUL 4b FAIL
FUNCTION: Disabled

Range: Disabled, Enabled

 CONTROL
 PUSHBUTTON 1  CONTROL PUSHBUTTN 1 ID

CTRL PB 1
Range: up to 20 alphanumeric characters

 CONTROL PUSHBUTTON 1
FUNCTION: Disabled

Range: Disabled, Enabled

 CONTROL PUSHBUTTON 1
EVENTS: Disabled

Range: Disabled, Enabled
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Figure 5-52: Control pushbuttons (enhanced front panel)  

An additional four control pushbuttons are included on the basic front panel when the F60 is ordered with the 12 user-
programmable pushbutton option.

Figure 5-53: Control pushbuttons (basic front panel) 

Control pushbuttons are not typically used for critical operations and are not protected by the control password. However, 
by supervising their output operands, the user can dynamically enable or disable control pushbuttons for security reasons.

Each control pushbutton asserts its own FlexLogic operand. Each operand need to be configured appropriately to perform 
the required function. Each operand remains asserted as long as the pushbutton is pressed and resets when the 
pushbutton is released. A dropout delay of 100 ms is incorporated to ensure fast pushbutton manipulation is recognized 
by various features that can use control pushbuttons as inputs.

An event is logged in the event record (as per user setting) when a control pushbutton is pressed. No event is logged when 
the pushbutton is released. The front panel keys (including control keys) cannot be operated simultaneously—a given key 
must be released before the next one can be pressed.

The control pushbuttons become user-programmable only if the breaker control feature is not configured for manual 
control via the USER 1 through 3 pushbuttons as shown. If configured for manual control, breaker control typically uses the 
larger, optional user-programmable pushbuttons, making the control pushbuttons available for other user applications.

Control pushbuttons

842813A1.CDR

842733A2.CDR
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Figure 5-54: Control pushbutton logic 

5.3.15  User-programmable pushbuttons
SETTINGS  PRODUCT SETUP  USER-PROGRAMMABLE PUSHBUTTONS  USER PUSHBUTTON 1(16)

 USER PUSHBUTTON 1
  PUSHBUTTON 1

FUNCTION: Disabled
Range: Self-Reset, Latched, Disabled

 PUSHBTN 1 ID TEXT:
USER PB 1

Range: up to 20 alphanumeric characters

 PUSHBTN 1 ON TEXT:
PUSHBTN 1 ON

Range: up to 20 alphanumeric characters

 PUSHBTN 1 OFF TEXT:
PUSHBTN 1 OFF

Range: up to 20 alphanumeric characters

 PUSHBTN 1 HOLD:
0.1 s

Range: 0.0 to 10.0 s in steps of 0.1

 PUSHBTN 1 SET:
Off

Range: FlexLogic operand

 PUSHBTN 1 RESET:
Off

Range: FlexLogic operand

 PUSHBTN 1 AUTORST:
Disabled

Range: Disabled, Enabled

 PUSHBTN 1 AUTORST
DELAY: 1.0 s

Range: 0.2 to 600.0 s in steps of 0.1

 PUSHBTN 1 REMOTE:
Off

Range: FlexLogic operand

 PUSHBTN 1 LOCAL:
Off

Range: FlexLogic operand

 PUSHBTN 1 DROP-OUT
TIME: 0.00 s

Range: 0 to 60.00 s in steps of 0.05

 PUSHBTN 1 LED CTL:
Off

Range: FlexLogic operand

 PUSHBTN 1 MESSAGE:
Disabled

Range: Disabled, Normal, High Priority

 PUSHBUTTON 1
EVENTS: Disabled

Range: Disabled, Enabled

842010A2.CDR
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User-programmable pushbuttons provide an easy and error-free method of entering digital state (on, off) information. The 
number depends on the front panel ordered.

• Enhanced horizontal front panel — 16 user-programmable pushbuttons

• Enhanced vertical front panel — 6 user-programmable pushbuttons

• Basic horizontal front panel — 12 user-programmable pushbuttons

• Graphical front panel — 16 user-programmable pushbuttons (eight physical pushbuttons, eight graphical interface 
pushbuttons)

The digital state can be entered locally (by directly pressing the front panel pushbutton or optional graphical front panel 
interface) or remotely (via FlexLogic operands) into FlexLogic equations, protection elements, and control elements. Typical 
applications include breaker control, autorecloser blocking, and setting groups changes. For example, set pushbuttons 1 to 
5 to select settings groups 1 to 5, or set pushbutton 1 to clear event records. The user-programmable pushbuttons are 
under the control level of password protection.

Example

To clear event records using pushbutton 1, set Settings > Product Setup > Clear Relay Records > Clear Event Records to 
FlexLogic operand PUSHBUTTON 1 ON. Then program the pushbutton by setting Settings > Product Setup > User-
Programmable Pushbuttons > Pushbutton 1 Function to "Self-reset." For a graphical front panel, to use a side 
pushbutton 9 to 16 to clear the event records, it also needs to be programmed in a single-line diagram.

The figures show user-configurable pushbuttons for the front panels.

Figure 5-55: User-programmable pushbuttons (enhanced front panel) 

Figure 5-56: User-programmable pushbuttons (basic front panel) 

The F60 is provided with this optional feature, specified as an option at the time of ordering. Using the order 
code for your device, see the order codes in chapter 2 for details.

User-programmable pushbuttons require a front panel with that option. If the front panel was ordered separately, 
update the EnerVista software under Maintenance > Change Front Panel.
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Figure 5-57: User-programmable pushbuttons (graphical front panel) 

Front panel pushbuttons and LEDs can be custom labelled as outlined in the Front Panel Labelling section in the previous 
chapter.

Each pushbutton asserts its own “On” and “Off” FlexLogic operands (for example, PUSHBUTTON 1 ON and PUSHBUTTON 1 OFF). 
These operands are available for each pushbutton and are used to program specific actions. If any pushbutton is active, 
the ANY PB ON operand is asserted.

Each pushbutton has an associated LED indicator. By default, this indicator displays the present status of the 
corresponding pushbutton (on or off). However, each LED indicator can be assigned to any FlexLogic operand through the 
PUSHBTN 1 LED CTL setting.

The activation and deactivation of user-programmable pushbuttons depends on whether latched or self-reset mode is 
programmed.

• Latched mode — In latched mode, a pushbutton can be set (activated) by asserting the operand assigned to the 
PUSHBTN 1 SET setting, by directly pressing the associated front panel pushbutton, or with the graphical front panel 
interface. The state of each pushbutton is stored in non-volatile memory and maintained through a loss of control 
power.

The pushbutton is reset (deactivated) in latched mode by asserting the operand assigned to the PUSHBTN 1 RESET 
setting, by directly pressing the active front panel pushbutton, or with the graphical front panel interface.

It can also be programmed to reset automatically through the PUSHBTN 1 AUTORST and PUSHBTN 1 AUTORST DELAY 
settings. These settings enable the autoreset timer and specify the associated time delay. The autoreset timer can be 
used in select-before-operate (SBO) breaker control applications, where the command type (close/open) or breaker 
location (feeder number) must be selected prior to command execution. The selection must reset automatically if 
control is not executed within a specified time period.

• Self-reset mode — In self-reset mode, a user-programmable pushbutton can be set (activated) by asserting the 
operand assigned to the PUSHBTN 1 SET setting, by pressing the front panel pushbutton, or by the graphical front panel 
interface. A pushbutton remains active for the time it is pressed physically or pressed in the graphical front panel 
interface, plus the dropout time specified in the PUSHBTN 1 DROP-OUT TIME setting. If the pushbutton is activated via 
FlexLogic, the pulse duration is specified by the PUSHBTN 1 DROP-OUT TIME only. The time the operand assigned to the 
PUSHBTN 1 SET setting remains On has no effect on the pulse duration.

The pulse duration of the remote set or local front panel pushbutton must be at least 50 ms to operate the 
pushbutton. This allows the user-programmable pushbuttons to properly operate during power cycling events and 
various system disturbances that can cause transient assertion of the operating signals.



5-134 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

PRODUCT SETUP CHAPTER 5: SETTINGS

5

The local and remote operation of each user-programmable pushbutton can be inhibited through the PUSHBTN 1 LOCAL 
and PUSHBTN 1 REMOTE settings. If local inhibit is applied, the pushbutton ignores set and reset commands executed 
through the front panel pushbuttons. If remote inhibit is applied, the pushbutton ignores set and reset commands 
executed through FlexLogic operands.

The inhibit functions are not applied to the autoreset feature. The inhibit function can be used in SBO control operations to 
prevent user-programmable pushbutton activation and ensuring “one-at-a-time” select operation.

The inhibit functions can also be used to prevent pushbutton activation from the accidental pressing of the front panel 
pushbuttons. The separate inhibit of the local and remote operation simplifies the implementation of local/remote control 
supervision.

Pushbutton states can be logged by the event recorder. User-defined messages can also be associated with each 
pushbutton and displayed on basic and enhanced front panels when the user-programmable pushbutton is activated, and 
when in the latched mode when the user-programmable pushbutton is deactivated. With the graphical front panel 
interface, instead of messages, the status of user-programmable pushbuttons can display on a single-line diagram and 
can also display in annunciator page windows and in actual values page cells.

For the graphical front panel, the pushbuttons 1 to 8 are linked to the eight physical pushbuttons, and pushbuttons 9 to 16 
are mapped to the graphical interface pushbuttons. To set the buttons for pushbuttons 9 to 16, access Settings > Product 
Setup > Graphical Panel > Single Line Diagram Editor, click the PB symbol in the toolbox, then configure pushbuttons 9 to 
16.

PUSHBUTTON 1 FUNCTION — This setting selects the mode of the pushbutton (Self-Reset, Latched, Disabled). If set to 
“Disabled,” the pushbutton is not active and the corresponding FlexLogic operands (both “On” and “Off”) are de-asserted. If 
set to "Latched," the pushbutton remains on until reset.

PUSHBTN 1 ID TEXT — This setting specifies the top 20-character line of the user-programmable pushbutton message and is 
intended to provide ID information of the pushbutton. For example, the text displays in the Event Record. See the User-
definable Displays section in this chapter for instructions on how to enter alphanumeric characters from the keypad. On a 
graphical front panel, this setting instead controls the label of the user-programmable pushbutton component on single-
line diagrams.

PUSHBTN 1 ON TEXT — This setting specifies the bottom 20-character line of the user-programmable pushbutton message 
and is displayed when the pushbutton is in the “on” position. See the User-definable Displays section for instructions on 
entering alphanumeric characters from the keypad. On a graphical front panel, this setting instead controls the on status 
text of the user-programmable pushbutton component on single-line diagrams. This setting is not applied to the physical 
pushbuttons on the graphical front panel.

PUSHBTN 1 OFF TEXT — This setting specifies the bottom 20-character line of the user-programmable pushbutton message 
and displays when the pushbutton is deactivated and the PUSHBUTTON 1 FUNCTION is “Latched.” A message does not 
display when the PUSHBUTTON 1 FUNCTION is “Self-reset” as the pushbutton operand status is implied to be “Off” upon its 
release. The length of the “Off” message is configured with the PRODUCT SETUP  DISPLAY PROPERTIES  FLASH MESSAGE 
TIME setting. On a graphical front panel, this setting instead controls the off status text of the user-programmable 
pushbutton component on single-line diagrams. This setting is not applied to the physical pushbuttons on the graphical 
front panel.

PUSHBTN 1 HOLD — This setting specifies the time required for a front panel pushbutton to be pressed before it is deemed 
active. This timer is reset upon release of the pushbutton. Note that user-programmable pushbutton operation requires the 
front panel pushbutton to be pressed a minimum of 50 ms. This minimum time is required prior to activating the user-
programmable pushbutton hold timer.

PUSHBTN 1 SET — This setting assigns the FlexLogic operand serving to activate the user-programmable pushbutton 
element. The duration of the incoming set signal must be at least 50 ms.

PUSHBTN 1 RESET — This setting assigns the FlexLogic operand serving to deactivate the user-programmable pushbutton 
element. This setting is applicable only if the user-programmable pushbutton is in "Latched" mode.

PUSHBTN 1 AUTORST — This setting enables the user-programmable pushbutton autoreset feature. This setting is applicable 
only if the pushbutton is in “Latched” mode.

PUSHBTN 1 AUTORST DELAY — This setting specifies the time delay for automatic reset of the pushbutton when in "Latched" 
mode.



CHAPTER 5: SETTINGS PRODUCT SETUP

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-135

5

PUSHBTN 1 REMOTE — This setting assigns the FlexLogic operand serving to inhibit user-programmable pushbutton 
operation from the operand assigned to the PUSHBTN 1 SET or PUSHBTN 1 RESET settings.

PUSHBTN 1 LOCAL — This setting assigns the FlexLogic operand serving to inhibit user-programmable pushbutton operation 
from the front panel pushbuttons. This inhibit functionality is not applicable to pushbutton autoreset.

PUSHBTN 1 DROP-OUT TIME — This setting applies only to “Self-Reset” mode and specifies the duration of the user-
programmable pushbutton active status after the front panel pushbutton or graphical front panel interface pushbutton 
has been released. When activated remotely, this setting specifies the entire activation time of the pushbutton; the length 
of time the operand selected by PUSHBTN 1 SET remains on has no effect on the pulse duration.

PUSHBTN 1 LED CTL — This setting assigns the FlexLogic operand serving to drive the front panel pushbutton LED. If this 
setting is “Off,” then LED operation is directly linked to the PUSHBUTTON 1 ON operand. This setting is not applied to 
Pushbuttons 9 to 16 on the graphical front panel, where the label background shows the orange glow color for the "on" 
state. 

PUSHBTN 1 MESSAGE — This setting controls the behavior of the user-programmable pushbutton on message that is 
programmed in the PUSHBTN 1 ID and PUSHBTN 1 ON TEXT settings, and the behavior of the user-programmable pushbutton 
off message that is programmed in the PUSHBTN 1 ID and PUSHBTN 1 OFF TEXT settings. This settings has no effect on the 
graphical front panel.

When set to "Disabled," user-programmable pushbutton messages do not display. Otherwise the on message displays 
when the user-programmable pushbutton becomes activated, and if in the "Latched" mode the off message displays when 
the user-programmable pushbutton becomes deactivated.

When set to "Normal," the duration the message displays is as specified by the FLASH MESSAGE TIME setting.

When set to "High Priority," the duration of the off message is as specified by the FLASH MESSAGE TIME setting, but the on 
message is displayed as long as the user-programmable pushbutton is activated. While activated, target and other 
messages are suppressed. To allow front panel keypad operation, when a keypad button is pressed the message is 
suppressed for 10 seconds.

PUSHBUTTON 1 EVENTS — If this setting is enabled, each user-programmable pushbutton state change is logged as an 
event into the event recorder.

The figures show the user-programmable pushbutton logic.
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Figure 5-58: User-programmable pushbutton logic (Sheet 1 of 2) 
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Figure 5-59: User-programmable pushbutton logic (Sheet 2 of 2) 

5.3.16  Flex state parameters
SETTINGS  PRODUCT SETUP  FLEX STATE PARAMETERS

This feature provides a mechanism where any of 256 selected FlexLogic operand states can be used for efficient 
monitoring. The feature allows user-customized access to the FlexLogic operand states in the relay. The state bits are 
packed so that 16 states are readable in a single Modbus register. The state bits can be configured so that all states of 
interest are available in a minimum number of Modbus registers.

The state bits can be read out in the “Flex States” register array beginning at Modbus address 0900h. Sixteen states are 
packed into each register, with the lowest-numbered state in the lowest-order bit. Sixteen registers accommodate the 256 
state bits.

 FLEX STATE
 PARAMETERS  PARAMETER 1:

Off
Range: FlexLogic operand



 PARAMETER 256:
Off

Range: FlexLogic operand
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5.3.17  User-definable displays

5.3.17.1  Menu
SETTINGS  PRODUCT SETUP  USER-DEFINABLE DISPLAYS

This feature is supported with enhanced and basic front panels.

This menu provides a mechanism for manually creating up to 16 user-defined information displays in a convenient 
viewing sequence in the USER DISPLAY menu (between the TARGETS and ACTUAL VALUES top-level menus). The sub-menus 
facilitate text entry and Modbus register data pointer options for defining the user display content.

This feature is not supported with the optional graphical front panel.

Once programmed, the user-definable displays can be viewed in two ways.

• Keypad — Use the MENU key to select the USER DISPLAY menu item to access the first user-definable display (note that 
only the programmed screens are displayed). The screens can be scrolled using the up and down arrow keys. The 
display disappears after the default message time-out period specified by the PRODUCT SETUP  DISPLAY PROPERTIES 
 DEFAULT MESSAGE TIMEOUT setting.

• User-programmable control input — The user-definable displays also respond to the INVOKE AND SCROLL setting. Any 
FlexLogic operand (in particular, the user-programmable pushbutton operands), can be used to navigate the 
programmed displays.

On the rising edge of the configured operand (such as when the pushbutton is pressed), the displays are invoked by 
showing the last user-definable display shown during the previous activity. From this moment onward, the operand 
acts exactly as the down key and allows scrolling through the configured displays. The last display wraps up to the 
first one. The INVOKE AND SCROLL input and the down arrow key operate concurrently.

When the default timer expires (set by the DEFAULT MESSAGE TIMEOUT setting), the relay starts to cycle through the user 
displays. The next activity of the INVOKE AND SCROLL input stops the cycling at the currently displayed user display, not 
at the first user-defined display. The INVOKE AND SCROLL pulses must last for at least 250 ms to take effect.

5.3.17.2  User display 1(16)
SETTINGS  PRODUCT SETUP  USER-DEFINABLE DISPLAYS  USER DISPLAY 1(16)

Any existing system display can be automatically copied into an available user display by selecting the existing display and 
pressing the ENTER key. The display then prompts with ADD TO USER DISPLAY LIST? After selecting “Yes,” a message 
indicates that the selected display has been added to the user display list. When this type of entry occurs, the sub-menus 
are automatically configured with the proper content—this content can be edited subsequently.

 USER-DEFINABLE
 DISPLAYS  INVOKE AND SCROLL:

Off
Range: FlexLogic operand

  USER DISPLAY 1
 

See below



  USER DISPLAY 16
 

 USER DISPLAY 1
  DISP 1 TOP LINE: Range: up to 20 alphanumeric characters

 DISP 1 BOTTOM LINE: Range: up to 20 alphanumeric characters

 DISP 1 ITEM 1:
0

Range: 0 to 65535 in steps of 1



 DISP 1 ITEM 5:
0

Range: 0 to 65535 in steps of 1
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This menu is used to enter user-defined text and user-selected Modbus-registered data fields into the particular user 
display. Each user display consists of two 20-character lines (top and bottom). The tilde (~) character is used to mark the 
start of a data field – the length of the data field needs to be accounted for. Up to five separate data fields can be entered 
in a user display – the nth tilde (~) refers to the nth item.

A user display can be entered from the front panel keypad or the EnerVista interface (preferred for convenience). The 
following procedure shows how to enter text characters in the top and bottom lines from the front panel keypad:

1. Select the line to be edited.

2. Press the decimal key to enter text edit mode.

3. Use either VALUE key to scroll through the characters. A space is selected like a character.

4. Press the decimal key to advance the cursor to the next position.

5. Repeat step 3 and continue entering characters until the desired text is displayed.

6. The HELP key can be pressed at any time for context sensitive help information.

7. Press the ENTER key to store the new settings.

To enter a numerical value for any of the five items (the decimal form of the selected Modbus address) from the front panel 
keypad, use the number keypad. Use the value of “0” for any items not being used. Use the HELP key at any selected 
system display (setting, actual value, or command) which has a Modbus address, to view the hexadecimal form of the 
Modbus address, then manually convert it to decimal form before entering it (EnerVista usage conveniently facilitates this 
conversion).

Use the MENU key to go to the user displays menu to view the user-defined content. The current user displays show in 
sequence, changing every four seconds. While viewing a user display, press the ENTER key and then select the ‘Yes” option 
to remove the display from the user display list. Use the MENU key again to exit the user displays menu.

An example of user display setup and result is shown as follows.

 

If the parameters for the top line and the bottom line items have the same units, then the unit is displayed on the bottom 
line only. The units are only displayed on both lines if the units specified both the top and bottom line items are different.

 USER DISPLAY 1
  DISP 1 TOP LINE:

Current X ~ A
Shows user-defined text with first tilde marker

 DISP 1 BOTTOM LINE:
Current Y ~ A

Shows user-defined text with second tilde marker

 DISP 1 ITEM 1:
6016

Shows decimal form of user-selected Modbus register 
address, corresponding to first tilde marker

 DISP 1 ITEM 2:
6357

Shows decimal form of user-selected Modbus register 
address, corresponding to second tilde marker

 DISP 1 ITEM 3:
0

This item is not being used. There is no corresponding 
tilde marker in top or bottom lines.

 DISP 1 ITEM 4:
0

This item is not being used. There is no corresponding 
tilde marker in top or bottom lines.

 DISP 1 ITEM 5:
0

This item is not being used. There is no corresponding 
tilde marker in top or bottom lines.

 USER DISPLAYS  Current X 0.850
Current Y 0.327 A

Shows the resultant display content
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5.3.18  Direct inputs and outputs

5.3.18.1  Menu
SETTINGS  PRODUCT SETUP  DIRECT I/O

Direct inputs and outputs exchange status information (inputs and outputs) between UR-series relays connected directly 
via type 7 digital communications cards. The mechanism is very similar to IEC 61850 GOOSE, except that communications 
takes place over a non-switchable isolated network and is optimized for speed. On type 7 cards that support two channels, 
direct output messages are sent from both channels simultaneously. This effectively sends direct output messages both 
ways around a ring configuration. On type 7 cards that support one channel, direct output messages are sent only in one 
direction. Messages are resent (forwarded) when it is determined that the message did not originate at the receiver.

Direct Inputs and Outputs are initiated automatically and start running once at least one Direct Output in the given UR is 
set to anything but Off.

Direct output message timing is similar to GOOSE message timing. Integrity messages (with no state changes) are sent at 
least every 1000 ms. Messages with state changes are sent within the main pass scanning the inputs and asserting the 
outputs unless the communication channel bandwidth has been exceeded. Two self-tests are performed and signaled by 
the following FlexLogic operands:

• DIRECT RING BREAK (direct input/output ring break) — Indicates that direct output messages sent from a UR-series relay 
are not being received back by the relay

• DIRECT DEVICE 1 OFF to DIRECT DEVICE 16 OFF (direct device offline) — Indicate that direct output messages from at least 
one direct device are not being received

 DIRECT I/O
  DIRECT OUTPUTS

DEVICE ID: 1
Range: 1 to 16 in steps of 1

 DIRECT I/O CH1 RING
CONFIGURATION: Yes

Range: Yes, No

 DIRECT I/O CH2 RING
CONFIGURATION: Yes

Range: Yes, No

 DIRECT I/O DATA
RATE: 64 kbps

Range: 64 kbps, 128 kbps

 DIRECT I/O CHANNEL
CROSSOVER: Disabled

Range: Disabled, Enabled

  CRC ALARM CH1
 

See page 5-145

  CRC ALARM CH2
 

  UNRETURNED
 MESSAGES ALARM CH1

See page 5-146

  UNRETURNED
 MESSAGES ALARM CH2

This option is available when an Inter-Relay Communications card is specified at the time of ordering (see the 
Order Code tables). With the option, direct inputs/outputs display by default. When you enable the 
teleprotection feature, direct I/O is not visible.

Teleprotection inputs/outputs and direct inputs/outputs are mutually exclusive. As such, they cannot be used 
simultaneously. Once teleprotection inputs and outputs are enabled, direct inputs and outputs are disabled, and 
vice versa.
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Direct input and output settings are similar to remote input and output settings. The equivalent of the remote device name 
strings for direct inputs and outputs is the DIRECT OUTPUT DEVICE ID setting, which identifies the relay in all direct output 
messages. All UR-series IEDs in a ring need to have unique numbers assigned. The IED ID is used to identify the sender of 
the direct input and output message.

If the direct input and output scheme is configured to operate in a ring (DIRECT I/O CH1 RING CONFIGURATION or DIRECT I/O 
CH2 RING CONFIGURATION is “Yes”), all direct output messages are received back. If not, the direct input/output ring break 
self-test is triggered. The self-test error is signaled by the DIRECT RING BREAK FlexLogic operand.

Select the DIRECT I/O DATA RATE to match the data capabilities of the communications channel. All IEDs communicating 
over direct inputs and outputs must be set to the same data rate. UR-series IEDs equipped with dual-channel 
communications cards apply the same data rate to both channels. Delivery time for direct input and output messages is 
approximately 0.2 of a power system cycle at 128 kbps and 0.4 of a power system cycle at 64 kbps, per each "bridge."

Table 5-17: Direct input and output data rates

The DIRECT I/O CHANNEL CROSSOVER setting applies to a F60 with dual-channel communication cards and allows crossing 
over messages from channel 1 to channel 2. This places all UR-series IEDs into one direct input and output network 
regardless of the physical media of the two communication channels.

The following application examples illustrate the basic concepts for direct input and output configuration. See the Inputs 
and Outputs section in this chapter for information on configuring FlexLogic operands (flags, bits) to be exchanged.

Example 1: Extending the input/output capabilities of a UR-series relay
Consider an application that requires additional quantities of contact inputs or output contacts or lines of programmable 
logic that exceed the capabilities of a single UR-series chassis. The problem is solved by adding an extra UR-series IED, 
such as the C30, to satisfy the additional input and output and programmable logic requirements. The two IEDs are 
connected via single-channel digital communication cards as shown in the figure.

Module Supported data rates

2A, 2B 64 kbps

2E, 2F 64 kbps

2G, 2H 128 kbps

2I, 2J 64 kbps, 128 kbps

72, 73 64 kbps, 128 kbps

74, 75 64 kbps

76, 77 64 kbps

7A, 7B, 7C, 7D 64 kbps, 128 kbps

7E, 7F, 7G 64 kbps

7H, 7I, 7J, 7K 64 kbps, 128 kbps

7L, 7M, 7N, 7P, 7Q 64 kbps

7R, 7S 64 kbps

7T, 7W 64 kbps

The G.703 modules are fixed at 64 kbps. The DIRECT I/O DATA RATE setting is not applicable to these modules.
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Figure 5-60: Input and output extension via direct inputs and outputs 

In this application, apply the following settings. For UR-series IED 1:
DIRECT OUTPUT DEVICE ID: “1”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O DATA RATE: “128 kbps”

For UR-series IED 2:
DIRECT OUTPUT DEVICE ID: “2”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O DATA RATE: “128 kbps”

The message delivery time is about 0.2 of power cycle in both ways (at 128 kbps); that is, from device 1 to device 2, and 
from device 2 to device 1. Different communications cards can be selected by the user for this back-to-back connection 
(for example: fiber, G.703, or RS422).

Example 2: Interlocking busbar protection
A simple interlocking busbar protection scheme could be accomplished by sending a blocking signal from downstream 
devices, say 2, 3, and 4, to the upstream device that monitors a single incomer of the busbar, as shown.

Figure 5-61: Sample interlocking busbar protection scheme 

For increased reliability, a dual-ring configuration (shown as follows) is recommended for this application.

Figure 5-62: Interlocking bus protection scheme via direct inputs/outputs 
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In this application, apply the following settings. For UR-series IED 1:
DIRECT OUTPUT DEVICE ID: “1”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 2:
DIRECT OUTPUT DEVICE ID: “2”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 3:
DIRECT OUTPUT DEVICE ID: “3”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 4:
DIRECT OUTPUT DEVICE ID: “4”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

Message delivery time is approximately 0.2 of power system cycle (at 128 kbps) times number of ‘bridges’ between the 
origin and destination. Dual-ring configuration effectively reduces the maximum ‘communications distance’ by a factor of 
two.

In this configuration the following delivery times are expected (at 128 kbps) if both rings are healthy:
IED 1 to IED 2: 0.2 of power system cycle
IED 1 to IED 3: 0.4 of power system cycle
IED 1 to IED 4: 0.2 of power system cycle
IED 2 to IED 3: 0.2 of power system cycle
IED 2 to IED 4: 0.4 of power system cycle
IED 3 to IED 4: 0.2 of power system cycle

If one ring is broken (say TX2-RX2) the delivery times are as follows:
IED 1 to IED 2: 0.2 of power system cycle
IED 1 to IED 3: 0.4 of power system cycle
IED 1 to IED 4: 0.6 of power system cycle
IED 2 to IED 3: 0.2 of power system cycle
IED 2 to IED 4: 0.4 of power system cycle
IED 3 to IED 4: 0.2 of power system cycle

A coordinating timer for this bus protection scheme could be selected to cover the worst case scenario (0.4 of a power 
system cycle). Upon detecting a broken ring, the coordination time is adaptively increased to 0.6 of a power system cycle. 
The complete application requires addressing a number of issues, such as failure of both the communications rings, failure 
or out-of-service conditions of one of the relays, and so on. Self-monitoring flags of the direct inputs and outputs feature 
primarily are used to address these concerns.

Example 3: Pilot-aided schemes
Consider the three-terminal line protection application shown.
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Figure 5-63: Three-terminal line application 

A permissive pilot-aided scheme can be implemented in a two-ring configuration, shown as follows (IEDs 1 and 2 
constitute a first ring, while IEDs 2 and 3 constitute a second ring).

Figure 5-64: Single-channel open loop configuration 

In this application, apply the following settings. For UR-series IED 1:
DIRECT OUTPUT DEVICE ID: “1”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 2:
DIRECT OUTPUT DEVICE ID: “2”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 3:
DIRECT OUTPUT DEVICE ID: “3”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

In this configuration the following delivery times are expected (at 128 kbps):
IED 1 to IED 2: 0.2 of power system cycle
IED 1 to IED 3: 0.5 of power system cycle
IED 2 to IED 3: 0.2 of power system cycle

In this scheme, IEDs 1 and 3 do not communicate directly. IED 2 must be configured to forward the messages as explained 
in the Inputs and Outputs section. Implement a blocking pilot-aided scheme with more security and, ideally, faster 
message delivery time. This is accomplished using a dual-ring configuration as shown here.
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Figure 5-65: Dual-channel closed loop (dual-ring) configuration 

In this application, apply the following settings. For UR-series IED 1:
DIRECT OUTPUT DEVICE ID: “1”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 2:
DIRECT OUTPUT DEVICE ID: “2”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

For UR-series IED 3:
DIRECT OUTPUT DEVICE ID: “3”
DIRECT I/O CH1 RING CONFIGURATION: “Yes”
DIRECT I/O CH2 RING CONFIGURATION: “Yes”

In this configuration the following delivery times are expected (at 128 kbps) if both the rings are healthy:
IED 1 to IED 2: 0.2 of power system cycle
IED 1 to IED 3: 0.2 of power system cycle
IED 2 to IED 3: 0.2 of power system cycle

The two communications configurations can be applied to both permissive and blocking schemes. Take speed, reliability, 
and cost into account when selecting the required architecture.

5.3.18.2  CRC alarm CH1(2)
SETTINGS  PRODUCT SETUP  DIRECT I/O  CRC ALARM CH1(2)

The F60 checks integrity of the incoming direct input and output messages using a 32-bit CRC. The CRC alarm function is 
available for monitoring the communication medium noise by tracking the rate of messages failing the CRC check. The 
monitoring function counts all incoming messages, including messages that failed the CRC check. A separate counter 
adds up messages that failed the CRC check. When the failed CRC counter reaches the user-defined level specified by the 
CRC ALARM CH1 THRESHOLD setting within the user-defined message count CRC ALARM 1 CH1 COUNT, the DIR IO CH1 CRC 
ALARM FlexLogic operand is set.

When the total message counter reaches the user-defined maximum specified by the CRC ALARM CH1 MESSAGE COUNT 
setting, both the counters reset and the monitoring process is restarted.

 CRC ALARM CH1
  CRC ALARM CH1

FUNCTION: Disabled
Range: Enabled, Disabled

 CRC ALARM CH1
MESSAGE COUNT: 600

Range: 100 to 10000 in steps of 1

 CRC ALARM CH1
THRESHOLD: 10

Range: 1 to 1000 in steps of 1

 CRC ALARM CH1
EVENTS: Disabled

Range: Enabled, Disabled
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Configure the operand to drive an output contact, user-programmable LED, or selected communication-based output. 
Latching and acknowledging conditions—if required—are programmed accordingly.

The CRC alarm function is available on a per-channel basis. The total number of direct input and output messages that 
failed the CRC check is available as the ACTUAL VALUES  STATUS  DIRECT INPUTS  CRC FAIL COUNT CH1 actual value.

• Message count and length of the monitoring window — To monitor communications integrity, the relay sends 1 
message per second (at 64 kbps) or 2 messages per second (at 128 kbps) even if there is no change in the direct 
outputs. For example, setting the CRC ALARM CH1 MESSAGE COUNT to “10000,” corresponds a time window of about 160 
minutes at 64 kbps and 80 minutes at 128 kbps. If the messages are sent faster as a result of direct outputs activity, 
the monitoring time interval shortens. Take this into account when determining the CRC ALARM CH1 MESSAGE COUNT 
setting. For example, if the requirement is a maximum monitoring time interval of 10 minutes at 64 kbps, then the CRC 
ALARM CH1 MESSAGE COUNT is set to 10  60  1 = 600.

• Correlation of failed CRC and bit error rate (BER) — The CRC check can fail if one or more bits in a packet are 
corrupted. Therefore, an exact correlation between the CRC fail rate and the BER is not possible. Under certain 
assumptions an approximation can be made as follows. A direct input and output packet containing 20 bytes results 
in 160 bits of data being sent and therefore, a transmission of 63 packets is equivalent to 10,000 bits. A BER of 10–4 
implies 1 bit error for every 10000 bits sent or received. Assuming the best case of only 1 bit error in a failed packet, 
having 1 failed packet for every 63 received is about equal to a BER of 10–4.

5.3.18.3  Unreturned messages alarm CH1(2)
SETTINGS  PRODUCT SETUP  DIRECT I/O  UNRETURNED MESSAGES ALARM CH1(2)

The F60 checks integrity of the direct input and output communication ring by counting unreturned messages. In the ring 
configuration, all messages originating at a given device should return within a pre-defined period of time. The unreturned 
messages alarm function is available for monitoring the integrity of the communication ring by tracking the rate of 
unreturned messages. This function counts all the outgoing messages and a separate counter adds the messages have 
failed to return. When the unreturned messages counter reaches the user-definable level specified by the UNRET MSGS 
ALARM CH1 THRESHOLD setting and within the user-defined message count UNRET MSGS ALARM CH1 COUNT, the DIR IO CH1 
UNRET ALM FlexLogic operand is set.

When the total message counter reaches the user-defined maximum specified by the UNRET MSGS ALARM CH1 MESSAGE 
COUNT setting, both the counters reset and the monitoring process is restarted.

Configure the operand to drive an output contact, user-programmable LED, or selected communication-based output. 
Latching and acknowledging conditions, if required, are programmed accordingly.

The unreturned messages alarm function is available on a per-channel basis and is active only in the ring configuration. 
The total number of unreturned input and output messages is available as the ACTUAL VALUES  STATUS  DIRECT INPUTS 
 UNRETURNED MSG COUNT CH1 actual value.

5.3.19  Teleprotection
SETTINGS  PRODUCT SETUP  TELEPROTECTION

 UNRETURNED
 MESSAGES ALARM CH1  UNRET MSGS ALARM CH1

FUNCTION: Disabled
Range: Enabled, Disabled

 UNRET MSGS ALARM CH1
MESSAGE COUNT: 600

Range: 100 to 10000 in steps of 1

 UNRET MSGS ALARM CH1
THRESHOLD: 10

Range: 1 to 1000 in steps of 1

 UNRET MSGS ALARM CH1
EVENTS: Disabled

Range: Enabled, Disabled

 TELEPROTECTION
  TELEPROTECTION

FUNCTION: Disabled
Range: Disabled, Enabled

 NUMBER OF TERMINALS:
2

Range: 2, 3
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Digital teleprotection transfers protection commands between two or three relays in a secure, fast, dependable, and 
deterministic way. Possible applications are permissive or blocking pilot schemes and direct transfer trip (DTT). 
Teleprotection can be applied over any analog or digital channels and any communications media, such as direct fiber, 
copper wires, optical networks, or microwave radio links. A mixture of communication media is possible.

Once teleprotection is enabled and the teleprotection input/outputs are configured, data packets are transmitted 
continuously every 1/4 cycle (3/8 cycle if using C37.94 modules) from peer-to-peer. Security of communication channel 
data is achieved by using CRC-32 on the data packet.

NUMBER OF TERMINALS — Specifies whether the teleprotection system operates between two peers or three peers.

NUMBER OF CHANNELS — Specifies how many channels are used. If the NUMBER OF TERMINALS is “3” (three-terminal system), 
set the NUMBER OF CHANNELS to “2.” For a two-terminal system, the NUMBER OF CHANNELS can set to “1” or “2” (redundant 
channels).

LOCAL RELAY ID NUMBER, TERMINAL 1 RELAY ID NUMBER, and TERMINAL 2 RELAY ID NUMBER — In installations that use 
multiplexers or modems, it is desirable to ensure that the data used by the relays protecting a given line is from the correct 
relays. The teleprotection function performs this check by reading the message ID sent by transmitting relays and 
comparing it to the programmed ID in the receiving relay. This check is also used to block inputs if inadvertently set to 
loopback mode or data is being received from a wrong relay by checking the ID on a received channel. If an incorrect ID is 
found on a channel during normal operation, the TELEPROT CH1 ID FAIL or TELEPROT CH2 ID FAIL FlexLogic operand is set, 
driving the event with the same name and blocking the teleprotection inputs. For commissioning purposes, the result of 
channel identification is also shown in the STATUS  CHANNEL TESTS  VALIDITY OF CHANNEL CONFIGURATION actual 
value. The default value of “0” for the LOCAL RELAY ID NUMBER indicates that relay ID is not to be checked. On two- terminals 
two-channel systems, the same LOCAL RELAY ID NUMBER is transmitted over both channels; as such, only the TERMINAL 1 ID 
NUMBER has to be programmed on the receiving end.

5.3.20  Installation
SETTINGS  PRODUCT SETUP  INSTALLATION

RELAY SETTINGS — To safeguard against the installation of a relay without any entered settings, the unit does not allow 
signaling of any output relay until RELAY SETTINGS is set to "Programmed." This setting is "Not Programmed" by default. The 
UNIT NOT PROGRAMMED self-test error message displays until the relay is put into the "Programmed" state.

RELAY NAME — This setting allows the user to uniquely identify a relay. This name appears on generated reports.

 NUMBER OF COMM
CHANNELS: 1

Range: 1, 2

 LOCAL RELAY ID
NUMBER: 0

Range: 0 to 63 in steps of 1

 TERMINAL 1 RELAY ID
NUMBER: 0

Range: 0 to 63 in steps of 1

 TERMINAL 2 RELAY ID
NUMBER: 0

Range: 0 to 63 in steps of 1

This option is available when an Inter-Relay Communications card is specified at the time of ordering (see the 
Order Code tables). With the option, direct inputs/outputs display by default. When you enable the 
teleprotection feature, direct I/O is not visible.

Teleprotection inputs/outputs and direct inputs/outputs are mutually exclusive. As such, they cannot be used 
simultaneously. Once teleprotection inputs and outputs are enabled, direct inputs and outputs are blocked, and 
vice versa.

 INSTALLATION
  RELAY SETTINGS:

Not Programmed
Range: Not Programmed, Programmed

 RELAY NAME:
Relay-1

Range: up to 20 alphanumeric characters
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5.4  Remote resources

5.4.1  Remote resources configuration
When the F60 is ordered with a process card module as a part of HardFiber system, an additional Remote Resources 
menu tree is available in the EnerVista software to allow configuration of the HardFiber system.

Figure 5-66: Remote Resources configuration menu

The remote resources settings configure a F60 with a Process Bus Module to work with HardFiber Bricks. Remote resources 
configuration is only available through the EnerVista software, and is not available through the F60 front panel. A Brick 
provides eight AC measurements, along with contact inputs, DC analog inputs, and contact outputs, to be the remote 
interface to field equipment such as circuit breakers and transformers. The F60 with a Process Bus Module has access to 
all of the capabilities of up to eight Bricks. Remote resources settings configure the point-to-point connection between 
specific fiber optic ports on the F60 process card and specific Brick. The relay is then configured to measure specific 
currents, voltages and contact inputs from those Bricks, and to control specific outputs.

The configuration process for remote resources is straightforward and consists of the following steps.

• Configure the field units. This establishes the point-to-point connection between a specific port on the relay Process 
Bus Module, and a specific digital core on a specific Brick. This is a necessary first step in configuring a process bus 
relay.

• Configure the AC banks. This sets the primary and secondary quantities and connections for currents and voltages. AC 
bank configuration also provides a provision for redundant measurements for currents and voltages, a powerful 
reliability improvement possible with process bus.

• Configure signal sources. This functionality of the F60 has not changed other than the requirement to use currents 
and voltages established by AC bank configuration under the remote resources menu.

• Configure field contact inputs, field contact outputs, RTDs, and transducers as required for the application's 
functionality. These inputs and outputs are the physical interface to circuit breakers, transformers, and other 
equipment. They replace the traditional contact inputs and outputs located at the relay to virtually eliminate copper 
wiring.

• Configure shared inputs and outputs as required for the application's functionality. Shared inputs and outputs are 
distinct binary channels that provide high-speed protection quality signaling between relays through a Brick.

For additional information on how to configure a relay with a Process Bus Module, see the HardFiber Process Bus System 
Instruction Manual.
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5.5  System setup

5.5.1  AC inputs

5.5.1.1  Current banks
SETTINGS  SYSTEM SETUP  AC INPUTS  CURRENT BANK F1(M5)

Because energy parameters are accumulated, record these values and then reset immediately prior to changing CT 
characteristics.

Two banks of phase and ground CTs can be set, where the current banks are denoted in the following format (X represents 
the module slot position letter):

Xa, where X = {F, M} and a = {1, 5}

See the Introduction to AC Sources section at the beginning of this chapter for details.

These settings are critical for all features that have settings dependent on current measurements. When the relay is 
ordered, the CT module must be specified to include a standard or sensitive ground input. As the phase CTs are connected 
in wye (star), the calculated phasor sum of the three phase currents (IA + IB + IC = neutral current = 3Io) is used as the input 
for the neutral overcurrent elements. In addition, a zero-sequence (core balance) CT which senses current in all of the 
circuit primary conductors, or a CT in a neutral grounding conductor can also be used. For this configuration, the ground 
CT primary rating must be entered. To detect low level ground fault currents, the sensitive ground input can be used. In this 
case, the sensitive ground CT primary rating must be entered. See chapter 3 for more details on CT connections.

Enter the rated CT primary current values. For both 1000:5 and 1000:1 CTs, the entry would be 1000. For correct operation, 
the CT secondary rating must match the setting (which must also correspond to the specific CT connections used).

The following example illustrates how multiple CT inputs (current banks) are summed as one source current. Given the 
following current banks:

• F1: CT bank with 500:1 ratio

• F5: CT bank with 1000:1 ratio

• M1: CT bank with 800:1 ratio

The following rule applies:

SRC 1 = F1 + F5 + M1 Eq. 5-7

1 pu is the highest primary current. In this case, 1000 is entered and the secondary current from the 500:1 and 800:1 ratio 
CTs are adjusted to that created by a 1000:1 CT before summation. If a protection element is set up to act on SRC 1 
currents, then a pickup level of 1 pu operates on 1000 A primary.

The same rule applies for current sums from CTs with different secondary taps (5 A and 1 A).

5.5.1.2  Voltage banks
SETTINGS  SYSTEM SETUP  AC INPUTS  VOLTAGE BANK F5(M5)

 CURRENT BANK F1
  PHASE CT F1

PRIMARY: 1 A
Range: 1 to 65000 A in steps of 1

 PHASE CT F1
SECONDARY: 1 A

Range: 1 A, 5 A

 GROUND CT F1
PRIMARY: 1 A

Range: 1 to 65000 A in steps of 1

 GROUND CT F1
SECONDARY: 1 A

Range: 1 A, 5 A

 VOLTAGE BANK F5
  PHASE VT F5

CONNECTION: Wye
Range: Wye, Delta
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Because energy parameters are accumulated, these values should be recorded and then reset immediately prior to 
changing VT characteristics.

One bank of phase/auxiliary VTs can be set, where voltage banks are denoted in the following format (X represents the 
module slot position letter):

Xa, where X = {F, M} and a = {5}

See the Introduction to AC Sources section at the beginning of this chapter for details.

With VTs installed, the relay can perform voltage measurements as well as power calculations. Enter the PHASE VT F5 
CONNECTION made to the system as “Wye” or “Delta.” An open-delta source VT connection is entered as “Delta.”

5.5.2  Power system
SETTINGS  SYSTEM SETUP  POWER SYSTEM

The power system NOMINAL FREQUENCY value is used as a default to set the digital sampling rate if the system frequency 
cannot be measured from available signals. This can happen if the signals are not present or are heavily distorted. Before 
reverting to the nominal frequency, the frequency tracking algorithm holds the last valid frequency measurement for a 
safe period of time while waiting for the signals to reappear or for the distortions to decay. When using a Process Bus 
Module and SV streams, the SV streams need to be defaulted before changing this setting, under Settings > Process Bus 
Module > SV Stream Config. After changing the NOMINAL FREQUENCY, restart the relay using Maintenance > Reboot Relay 
Command.

 PHASE VT F5
SECONDARY: 66.4 V

Range: 25.0 to 240.0 V in steps of 0.1

 PHASE VT F5
RATIO: 1.00 :1

Range: 1.00 to 24000.00 in steps of 0.01

 AUXILIARY VT F5
CONNECTION: Vag

Range: Vn, Vag, Vbg, Vcg, Vab, Vbc, Vca

 AUXILIARY VT F5
SECONDARY: 66.4 V

Range: 25.0 to 240.0 V in steps of 0.1

 AUXILIARY VT F5
RATIO: 1.00 :1

Range: 1.00 to 24000.00 in steps of 0.01

The nominal PHASE VT F5 SECONDARY voltage setting is the voltage across the relay input terminals when nominal 
voltage is applied to the VT primary.
For example, on a system with a 13.8 kV nominal primary voltage and with a 14400:120 volt VT in a delta 
connection, the secondary voltage is 115; that is, (13800 / 14400) × 120. For a wye connection, the voltage value 
entered must be the phase to neutral voltage, which is 115  = 66.4.

On a 14.4 kV system with a delta connection and a VT primary to secondary turns ratio of 14400:120, the voltage 
value entered is 120; that is, 14400 / 120.

If the PHASE VT F5 CONNECTION is set to “Delta”, the relay does not calculate voltage harmonics.

 POWER SYSTEM
  NOMINAL FREQUENCY:

60 Hz
Range: 25 to 60 Hz in steps of 1

 PHASE ROTATION:
ABC

Range: ABC, ACB

 FREQUENCY AND PHASE
REFERENCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 FREQUENCYTRACKING:
Enabled

Range: Disabled, Enabled

3
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The phase sequence of the power system is required to properly calculate sequence components and power parameters. 
The PHASE ROTATION setting matches the power system phase sequence and informs the relay of the actual system phase 
sequence, either ABC or ACB. CT and VT inputs on the relay, labelled as A, B, and C, must be connected to system phases A, 
B, and C for correct operation.

The FREQUENCY AND PHASE REFERENCE setting determines which signal source is used (and hence which AC signal) for 
phase angle reference. The AC signal used is prioritized based on the AC inputs configured for the signal source. Phase 
voltages takes precedence, followed by auxiliary voltage, then phase currents, and finally ground current.

For three phase selection, phase A is used for angle referencing (VANGLE REF = VA), while Clarke transformation of the phase 
signals is used for frequency metering and tracking (VFREQUENCY = (2VA - VB - VC) / 3) for better performance during fault, 
open pole, and VT and CT fail conditions.

The phase reference and frequency tracking AC signals are selected based upon the source configuration, regardless of 
whether or not a particular signal is actually applied to the relay.

Phase angle of the reference signal always displays zero degrees and all other phase angles are relative to this signal. If the 
pre-selected reference signal is not measurable at a given time, the phase angles are not referenced.

The phase angle referencing is done via a phase locked loop, which can synchronize independent UR-series relays if they 
have the same AC signal reference. This results in very precise correlation of phase angle indications between different UR-
series relays.

FREQUENCY TRACKING is set to “Disabled” only in unusual circumstances; consult GE Grid Solutions for special variable-
frequency applications.

5.5.3  Signal sources
SETTINGS  SYSTEM SETUP  SIGNAL SOURCES  SOURCE 1(4)

Identical menus are available for each source. The "SRC 1" text can be replaced by with a user-defined name appropriate 
for the associated source.

The first letter in the source identifier represents the module slot position. The number directly following this letter 
represents either the first bank of four channels (1, 2, 3, 4) called “1” or the second bank of four channels (5, 6, 7, 8) called 
“5” in a particular CT/VT module. See the Introduction to AC Sources section at the beginning of this chapter for details.

It is possible to select the sum of all CT combinations. The first channel displayed is the CT to which all others are referred. 
For example, the selection “F1+F5” indicates the sum of each phase from channels “F1” and “F5,” scaled to whichever CT 
has the higher ratio. Selecting “None” hides the associated actual values.

The approach used to configure the AC sources consists of several steps; first step is to specify the information about each 
CT and VT input. For CT inputs, this is the nominal primary and secondary current. For VTs, this is the connection type, ratio 
and nominal secondary voltage. Once the inputs have been specified, the configuration for each source is entered, 
including specifying which CTs are summed together.

The frequency tracking feature functions only when the F60 is in the “Programmed” mode. If the F60 is “Not 
Programmed,” then metering values are available but can exhibit significant errors.

 SOURCE 1
  SOURCE 1 NAME:

SRC 1
Range: up to 20 alphanumeric characters

 SOURCE 1 PHASE CT:
None

Range: None, F1,... up to any 6 CTs. Only Phase CT 
inputs are displayed.

 SOURCE 1 GROUND CT:
None

Range: None, F1,... up to any 6 CTs. Only Ground CT 
inputs are displayed.

 SOURCE 1 PHASE VT:
None

Range: None, F5, M5
Only phase voltage inputs are displayed

 SOURCE 1 AUX VT:
None

Range: None, F5, M5
Only auxiliary voltage inputs are displayed
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5.5.3.1  User selection of AC parameters for comparator elements
CT/VT modules automatically calculate all current and voltage parameters from the available inputs. Users must select the 
specific input parameters to be measured by every element in the relevant settings menu. The internal design of the 
element specifies which type of parameter to use and provides a setting for source selection. In elements where the 
parameter can be either fundamental or RMS magnitude, such as phase time overcurrent, two settings are provided. One 
setting specifies the source, the second setting selects between fundamental phasor and RMS.

5.5.3.2  AC input actual values
The calculated parameters associated with the configured voltage and current inputs are displayed in the current and 
voltage sections of actual values. Only the phasor quantities associated with the actual AC physical input channels display 
here. All parameters contained within a configured source are displayed in the sources section of the actual values.

5.5.3.3  Disturbance detectors (internal)
The disturbance detector (ANSI 50DD) element is a sensitive current disturbance detector that detects any disturbance on 
the protected system. The 50DD function is used directly in some elements in the relay, for example VT Fuse Failure 
detector or Fault Report. It can also be used to supervise current-based elements to prevent maloperation as a result of 
the wrong settings or external CT wiring problem. A disturbance detector is provided for each source.

The 50DD function responds to the changes in magnitude of the sequence currents. The disturbance detector logic is as 
follows.

Figure 5-67: Disturbance detector logic 

When the F60 is equipped with a type 8Z CT/VT module for high impedance fault detection, do not assign the CT 
bank of this module to a source that is used by any conventional protection element. The type 8Z module CT bank 
is used solely by the high impedance fault detection algorithm.

827092A3.CDR
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The disturbance detector responds to the change in currents of twice the current cut-off level. The default cut-off threshold 
is 0.02 pu; thus by default the disturbance detector responds to a change of 0.04 pu. The metering sensitivity setting 
(PRODUCT SETUP  DISPLAY PROPERTIES  CURRENT CUT-OFF LEVEL) controls the sensitivity of the disturbance detector 
accordingly.

5.5.3.4  Example for use of sources
An example of the use of sources is shown in the following figure. A relay can have the following hardware configuration:

This configuration can be used on a two-winding transformer, with one winding connected into a breaker-and-a-half 
system. The following figure shows the arrangement of sources used to provide the functions required in this application, 
and the CT/VT inputs that are used to provide the data.

Figure 5-68: Example of use of sources 

Increasing slot position letter -->

UR CT/VT module 1 CT/VT module 2 CT/VT module 3

B30, B90, C70, F35, N60, T35 8 CTs 4 CTs, 4 VTs 4 CTs, 4 VTs

C60, D60, G30, G60, L30, L90, M60, T60 CTs VTs not applicable

Y LV D HV AUX

SRC 1 SRC 2 SRC 3

Phase CT M1 F1+F5 None

Ground CT M1 None None

Phase VT M5 None None

Aux VT None None U1
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5.5.4  Breakers
SETTINGS  SYSTEM SETUP  BREAKERS  BREAKER 1(4)

 BREAKER 1
  BREAKER 1

FUNCTION: Disabled
Range: Disabled, Enabled

 BREAKER1 PUSH BUTTON
CONTROL: Disabled

Range: Disabled, Enabled

 BREAKER 1 TAGGING:
Disabled

Range: Disabled, Enabled

 BREAKER 1
SUBSTITUTN: Disabled

Range: Disabled, Enabled

 BREAKER 1 BYPASS:
Disabled

Range: Disabled, Enabled

 BREAKER 1 AR BLOCK:
Disabled

Range: Disabled, Enabled

 BREAKER 1 NAME:
Bkr 1

Range: up to six alphanumeric characters

 BREAKER 1 MODE:
3-Pole

Range: 3-Pole, 1-Pole

 BREAKER 1 OPEN:
Off

Range: FlexLogic operand

 BREAKER 1 BLK OPEN:
Off

Range: FlexLogic operand

 BREAKER 1 CLOSE:
Off

Range: FlexLogic operand

 BREAKER 1 BLK CLOSE:
Off

Range: FlexLogic operand

 BREAKER1 A/3P CLSD:
Off

Range: FlexLogic operand

 BREAKER1 A/3P OPND:
Off

Range: FlexLogic operand

 BREAKER 1 B CLOSED:
Off

Range: FlexLogic operand

 BREAKER 1 B OPENED:
Off

Range: FlexLogic operand

 BREAKER 1 C CLOSED:
Off

Range: FlexLogic operand

 BREAKER 1 C OPENED:
Off

Range: FlexLogic operand

 BREAKER 1 TOPERATE:
70 ms

Range: 0 to 65535 s in steps of 1

 BREAKER 1 EXT ALARM:
Off

Range: FlexLogic operand

 BREAKER 1 ALARM
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 MANUAL CLOSE RECAL1
TIME: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BREAKER 1 OPEN
SEAL-IN: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001
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The breaker control element contains the auxiliary logic for status and serves as the interface for opening and closing of a 
circuit breaker from protection, autoreclose, SCADA, or through the front panel interface. The breaker control element can 
be used to create interlocking functionality. For greater security in determination of the breaker position, both the 52/a and 
52/b auxiliary contacts are used with reporting of the discrepancy between them.

To use this element, configure the contact outputs that trip and close the breaker to use FlexLogic operands BREAKER 1 OFF 
CMD (or BREAKER 1 TRIP A/B/C in the case of single-pole tripping) and BREAKER 1 ON CMD, and configure the breaker control 
element inputs as described here.

A description of the operation of the breaker control and status monitoring features from the front panel is provided in 
chapter 4.

The following settings are available for each breaker control element.

BREAKER 1 FUNCTION — This setting enables and disables the operation of the breaker 1 control feature.

BREAKER1 PUSH BUTTON CONTROL — Set to “Enable” to allow front panel pushbutton open/close control operations.

BREAKER1 TAGGING — Set to "Enable" to allow the graphical front panel to tag breaker 1. When tagged, the following 
operations are disabled: pushbutton open/close, IEC 61850 open/close, and close command initiated by BREAKER 1 CLOSE 
setting. The trip command issued by the Trip Out element or BREAKER 1 OPEN setting is not affected.

BREAKER1 SUBSTITUTN — Set to "Enable" to allow the graphical front panel to substitute breaker 1 status. When substituted, 
breaker 1 control open/close status is forced to the substituted value.

BREAKER1 BYPASS — Set to "Enable" to allow the graphical front panel to bypass breaker 1 interlocking. When asserted, 
BREAKER 1 BLK OPEN and BREAKER 1 BLK CLOSE settings are bypassed.

BREAKER1 AR BLOCK —Set to "Enable" to generate an operand to block the Autoreclose element.

The Autoreclose element is not automatically inhibited by BLOCK AR from the front panel. If the autoreclose scheme needs 
to be inhibited, set setting AR BLOCK in the corresponding autoreclose element with the BREAKER 1 BLK RCLS operand.

BREAKER 1 NAME — Assign a user-defined name (up to six characters) to the breaker. This name is used in flash messages 
related to breaker 1.

BREAKER 1 MODE — Selects “3-Pole” mode, where all breaker poles are operated simultaneously, or “1-Pole” mode where all 
breaker poles are operated either independently or simultaneously.

BREAKER 1 OPEN — Selects an operand that when activated, and unless blocked, initiates the Breaker 1 open and individual 
phase trip commands.

BREAKER 1 BLK OPEN — Selects an operand that prevents initiation of Breaker 1 open and individual phase trip commands. 
This setting can be used for blocking circuit breaker tripping for instance when breaker monitoring detects conditions such 
as low SF6 gas density during which breaker opening can cause damage.

BREAKER 1 CLOSE — Selects an operand that when activated, and unless blocked, initiates the Breaker 1 close commands.

BREAKER 1 BLK CLOSE — Selects an operand that prevents initiation of Breaker 1 close commands. This setting can be used 
for blocking circuit breaker closing, for instance to prevent closing into a closed ground switch.

BREAKER1 A/3P CLSD — Selects an operand, usually a contact input connected to a breaker auxiliary position tracking 
mechanism. This input is for a normally-open 52/a status input that creates a logic 1 when the breaker is closed. If the 
BREAKER 1 MODE setting is selected as "3-Pole," this setting selects a single 52/a input as the operand used to track the 
breaker open or closed position. If the mode is selected as "1-Pole," the input mentioned is used to track phase A and the 
BREAKER 1 B and BREAKER 1 C settings select operands to track phases B and C, respectively.

BREAKER1 A/3P OPND — Selects an operand, usually a contact input, that is for a normally-closed 52/b status input that 
creates a logic 1 when the breaker is open. If a separate 52/b contact input is not available, then the inverted 52/a status 
signal or the inverted BREAKER 1 CLOSED status signal can be used.

 BREAKER 1 OUT OF SV:
Off

Range: FlexLogic operand

 BREAKER 1 RACKED-IN:
Off

Range: FlexLogic operand

 BREAKER 1 EVENTS:
Disabled

Range: Disabled, Enabled
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BREAKER 1 B CLOSED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the breaker phase B closed position as outlined for phase A.

BREAKER 1 B OPENED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the breaker phase B opened position as outlined for phase A.

BREAKER 1 C CLOSED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the breaker phase C closed position as outlined for phase A.

BREAKER 1 C OPENED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the breaker phase C opened position as outlined for phase A.

BREAKER 1 TOPERATE — This setting specifies the required interval to overcome transient disagreement between the 52/a 
and 52/b auxiliary contacts during breaker operation. If transient disagreement still exists after this time has expired, the 
BREAKER 1 BAD STATUS FlexLogic operand is asserted for alarm or blocking purposes.

BREAKER 1 EXT ALARM — This setting selects an operand, usually an external contact input connected to a breaker alarm 
reporting contact. While the selected operand is active, the BREAKER 1 TROUBLE operand is activated.

BREAKER 1 ALARM DELAY — This setting specifies the delay interval during which a disagreement of status among the three-
pole position tracking operands does not declare a pole disagreement. This allows for non-simultaneous operation of the 
poles.

BREAKER 1 OPEN SEAL-IN — This setting specifies the seal-in time of the three-pole open command initiated by either the 
Trip Out element or a manual open command to the circuit breaker.

MANUAL CLOSE RECAL1 TIME — This setting specifies the seal-in time of the close commands due to an operator-initiated 
manual close command to the circuit breaker.

BREAKER 1 OUT OF SV — Selects an operand indicating that breaker 1 is out-of-service.

BREAKER 1 RACKED-IN — This setting selects a contact input to show whether the breaker is racked-in or racked-out. The 
racked-in or racked-out status is used to indicate dynamically the status of breaker symbol, only applied in the single-line 
diagram in the graphical front panel. If this setting is set to Off, the racked status is not considered.
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Figure 5-69: Dual breaker control logic (Sheet 1 of 3) 
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Figure 5-70: Dual breaker control logic (Sheet 2 of 3) 
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Figure 5-71: Dual breaker / graphical front panel control logic (Sheet 3 of 3) 

The breaker element has direct hard-coded connections to the IEC 61850 model as shown in the logic diagram. This allows 
remote open/close operation of each breaker, using either CSWI or XCBR IEC 61850 logical nodes. IEC 61850 select-before-
operate functionality, local/remote switch functionality, along with blocking of open/close commands are provided. Note 
that the dwell time for the IEC 61850 trip and close commands shown is one protection pass only. To maintain the close/
open command for a certain time, do so by setting the seal-in timers BREAKER 1 OPEN SEAL-IN and MANUAL CLOSE RECAL1 
TIME, on the contact outputs using the "Seal-in" setting, in the Trip Output element, and/or in FlexLogic.

5.5.5  Disconnect switch control
SETTINGS  SYSTEM SETUP  SWITCHES  SWITCH 1(16)

 SWITCH 1
  SWITCH 1

FUNCTION: Disabled
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The disconnect switch control element contains the auxiliary logic for status and serves as the interface for opening and 
closing of disconnect switches from SCADA or through the front panel interface. The disconnect switch control element 
can be used to create interlocking functionality. For greater security in determination of the switch pole position, both the 
89/a and 89/b auxiliary contacts are used with reporting of the discrepancy between them.

To use this element, configure the contact outputs that open and close the disconnect switch to use FlexLogic operands 
SWITCH 1 OFF CMD and SWITCH 1 ON CMD, and configure the disconnect switch control element's inputs as outlined here.

SWITCH 1 FUNCTION — This setting enables and disables operation of the disconnect switch element.

SWITCH 1 NAME — Assign a user-defined name (up to six characters) to the disconnect switch. This name is used in flash 
messages related to disconnect switch 1.

SWITCH 1 MODE — This setting selects “3-Pole” mode, where disconnect switch poles have a single common auxiliary 
switch, or “1-Pole” mode where each disconnect switch pole has its own auxiliary switch.

 SWITCH 1 BLK OPEN:
Off

Range: FlexLogic operand

 SWITCH 1 CLOSE:
Off

Range: FlexLogic operand

 SWITCH 1 BLK CLOSE:
Off

Range: FlexLogic operand

 SWTCH 1 A/3P CLSD:
Off

Range: FlexLogic operand

 SWTCH 1 A/3P OPND:
Off

Range: FlexLogic operand

 SWITCH 1 B CLOSED:
Off

Range: FlexLogic operand

 SWITCH 1 B OPENED:
Off

Range: FlexLogic operand

 SWITCH 1 C CLOSED:
Off

Range: FlexLogic operand

 SWITCH 1 C OPENED:
Off

Range: FlexLogic operand

 SWITCH1 PUSH BUTTON
CONTROL: Disabled

Range: Disabled, Enabled

 SWITCH 1 TAGGING:
Disabled

Range: Disabled, Enabled

 SWITCH 1 SUBSTITUTN:
Disabled

Range: Disabled, Enabled

 SWITCH 1 BYPASS:
Disabled

Range: Disabled, Enabled

 SWITCH 1 OPEN
SEAL-IN: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 SWITCH 1 CLOSE
SEAL-IN: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 SWITCH 1 TOPERATE:
70 ms

Range: 0 to 65535 ms in steps of 1

 SWITCH 1 ALARM
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 SWITCH 1 EVENTS:
Disabled

Range: Disabled, Enabled
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SWITCH 1 OPEN — This setting selects an operand that when activated, and unless blocked, initiates the disconnect switch 1 
open command.

SWITCH 1 BLK OPEN — This setting selects an operand that prevents initiation of the disconnect switch 1 command. This 
setting can be used to block the disconnect switch from opening, for instance when switchyard monitoring indicates that 
current exceeding the switch's interrupting rating can be flowing through the switch.

SWITCH 1 CLOSE — This setting selects an operand that when activated, and unless blocked, initiates the disconnect switch 
1 close command.

SWITCH 1 BLK CLOSE — This setting selects an operand that prevents initiation of disconnect switch 1 close commands. This 
setting can be used to block the disconnect switch from closing, for instance to prevent closing into a closed ground 
switch.

SWTCH 1A/3P CLSD — This setting selects an operand, usually a contact input connected to a disconnect switch auxiliary 
position tracking mechanism. This input is for a normally-open 89/a status input that creates a logic 1 when the 
disconnect switch is closed. If the SWITCH 1 MODE setting is selected as “3-Pole,” this setting selects a single 89/a input as 
the operand used to track the disconnect switch open or closed position. If the mode is selected as “1-Pole,” the input 
mentioned is used to track phase A and the SWITCH 1 B and SWITCH 1 C settings select operands to track phases B and 
C, respectively.

SWTCH 1 A/3P OPND — This setting selects an operand, usually a contact input, that is for a normally-closed 89/b status 
input that creates a logic 1 when the disconnect switch is open. If a separate 89/b contact input is not available, then an 
inverted 89/a status signal can be used.

SWITCH 1 B CLOSED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the disconnect switch phase B closed position as outlined for phase A.

SWITCH 1 B OPENED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the disconnect switch phase B opened position as outlined for phase A.

SWITCH 1 C CLOSED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the disconnect switch phase C closed position as outlined for phase A.

SWITCH 1 C OPENED — If the mode is selected as three-pole, this setting has no function. If the mode is selected as single-
pole, this input is used to track the disconnect switch phase C opened position as outlined for phase A.

SWITCH 1 PUSH BUTTON CONTROL — Set to "Enable" to allow front panel pushbutton open/close control operations.

SWITCH 1 TAGGING — Set to "Enable" to allow the graphical front panel to tag switch 1. When tagged, the following 
operations are disabled:

• Pushbutton Open/Close

• IEC 61850 Open/Close

• Open command initiated by SWITCH 1 OPEN setting

• Close command initiated by SWITCH 1 CLOSE setting

SWITCH 1 SUBSTITUTN — Set to "Enable" to allow the graphical front panel to substitute switch 1 status. When substituted, 
switch 1 control open/close status is forced to the substituted value.

SWITCH 1 BYPASS —Set to "Enable" to allow the graphical front panel to bypass switch 1 interlocking. When asserted, 
SWITCH 1 BLK OPEN and SWITCH 1 BLK CLOSE settings are bypassed.

SWITCH 1 OPEN SEAL-IN — This setting specifies the seal-in time of the open command due to an operator-initiated manual 
open command to the disconnect switch.

SWITCH 1 CLOSE SEAL-IN — This setting specifies the seal-in time of the close command due to an operator-initiated manual 
close command to the disconnect switch.

SWITCH 1 TOPERATE — This setting specifies the required interval to overcome transient disagreement between the 89/a 
and 89/b auxiliary contacts during disconnect switch operation. If transient disagreement still exists after this time has 
expired, the SWITCH 1 BAD STATUS FlexLogic operand is asserted for alarm or blocking purposes.

SWITCH 1 ALARM DELAY — This setting specifies the delay interval during which a disagreement of status among the pole 
position tracking operands do not declare a pole disagreement. This allows for non-simultaneous operation of the poles.
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The switch element has direct hard-coded connections to the IEC 61850 model as shown in the logic diagrams. This allows 
remote open/close operation of each switch, using either CSWI or XSWI IEC 61850 logical nodes. IEC 61850 select-before-
operate functionality, local/remote switch functionality, along with blocking open/close commands are provided. Note that 
the dwell time for the IEC 61850 trip and close commands shown is one protection pass only. To maintain close/open 
command for a certain time, do so using the seal-in timers SWITCH 1 OPEN SEAL-IN and SWITCH 1 CLOSE SEAL-IN, on the 
contact outputs using the "Seal-in" setting, or in FlexLogic.

Figure 5-72: Disconnect switch control logic (sheet 1 of 3) 

IEC 61850 functionality is permitted when the F60 is in “Programmed” mode and not in local control mode.
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Figure 5-73: Disconnect switch control status logic (sheet 2 of 3) 
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Figure 5-74: Disconnect switch control graphical front panel logic (sheet 3 of 3) 

5.5.6  FlexCurves

5.5.6.1  Settings
SETTINGS  SYSTEM SETUP  FLEXCURVES  FLEXCURE A(D)

FlexCurves A through D have settings for entering times to reset and operate at the following pickup levels: 0.00 to 0.98 
and 1.03 to 20.00. This data is converted into two continuous curves by linear interpolation between data points. To enter 
a custom FlexCurve, enter the reset and operate times (using the VALUE keys) for each selected pickup point (using the 
MESSAGE up/down keys) for the required protection curve (A, B, C, or D).
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Range: 0 to 65535 ms in steps of 1
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Table 5-18: FlexCurve table

5.5.6.2  FlexCurve configuration with EnerVista software
The EnerVista software allows for easy configuration and management of FlexCurves and their associated data points. 
Prospective FlexCurves can be configured from a selection of standard curves to provide the best approximate fit, then 
specific data points can be edited afterwards. Alternately, curve data can be imported from a specified file (.csv format) by 
selecting the EnerVista Import Data From setting (Settings > System Setup > FlexCurves > FlexCurve).

Curves and data can be exported, viewed, and cleared by clicking the appropriate buttons. FlexCurves are customized by 
editing the operating time (ms) values at pre-defined per-unit current multiples. Note that the pickup multiples start at zero 
(implying the "reset time"), operating time below pickup, and operating time above pickup.

5.5.6.3  Recloser curve editing
Recloser curve selection is special in that recloser curves can be shaped into a composite curve with a minimum response 
time and a fixed time above a specified pickup multiples. There are 41 recloser curve types supported. These definite 
operating times are useful to coordinate operating times, typically at higher currents and where upstream and 
downstream protective devices have different operating characteristics. The recloser curve configuration window shown 
here appears when the Initialize From setting in the EnerVista software is set to “Recloser Curve” and the Initialize 
FlexCurve button is clicked.

Reset Time
ms

Reset Time
ms

Operate Time
ms

Operate Time
ms

Operate Time
ms

Operate Time
ms

0.00 0.68 1.03 2.9 4.9 10.5

0.05 0.70 1.05 3.0 5.0 11.0

0.10 0.72 1.1 3.1 5.1 11.5

0.15 0.74 1.2 3.2 5.2 12.0

0.20 0.76 1.3 3.3 5.3 12.5

0.25 0.78 1.4 3.4 5.4 13.0

0.30 0.80 1.5 3.5 5.5 13.5

0.35 0.82 1.6 3.6 5.6 14.0

0.40 0.84 1.7 3.7 5.7 14.5

0.45 0.86 1.8 3.8 5.8 15.0

0.48 0.88 1.9 3.9 5.9 15.5

0.50 0.90 2.0 4.0 6.0 16.0

0.52 0.91 2.1 4.1 6.5 16.5

0.54 0.92 2.2 4.2 7.0 17.0

0.56 0.93 2.3 4.3 7.5 17.5

0.58 0.94 2.4 4.4 8.0 18.0

0.60 0.95 2.5 4.5 8.5 18.5

0.62 0.96 2.6 4.6 9.0 19.0

0.64 0.97 2.7 4.7 9.5 19.5

0.66 0.98 2.8 4.8 10.0 20.0

The relay using a given FlexCurve applies linear approximation for times between the user-entered points. Take 
care when setting the two points that are close to the multiple of pickup of 1; that is, 0.98 pu and 1.03 pu. It is 
recommended to set the two times to a similar value, otherwise the linear approximation can result in undesired 
behavior for the operating quantity that is close to 1.00 pu.
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Figure 5-75: Recloser curve initialization 

5.5.6.4  Example
A composite curve can be created from the GE_111 standard with MRT = 200 ms and HCT initially disabled and then 
enabled at eight times pickup with an operating time of 30 ms. At approximately four times pickup, the curve operating 
time is equal to the MRT and from then onwards the operating time remains at 200 ms.

Figure 5-76: Composite recloser curve with HCT disabled 

With the HCT feature enabled, the operating time reduces to 30 ms for pickup multiples exceeding eight times pickup.

The Multiplier and Adder settings only affect the curve portion of the characteristic and not the MRT and HCT 
settings. The HCT settings override the MRT settings for multiples of pickup greater than the HCT ratio.

842721A1.CDR

Multiplier: Scales (multiplies) the curve operating times

Addr: Adds the time specified in this field (in ms) to each
operating time value.curve

Minimum Response Time (MRT): If enabled, the MRT setting
defines the shortest operating time even if the curve suggests
a shorter time at higher current multiples. A composite operating
characteristic is effectively defined. For current multiples lower
than the intersection point, the curve dictates the operating time;
otherwise, the MRT does. An information message appears
when attempting to apply an MRT shorter than the minimum
curve time.

High Current Time:

HCT Ratio
HCT

Allows the user to set a pickup multiple
from which point onwards the operating time is fixed. This is
normally only required at higher current levels. The
defines the high current pickup multiple; the defines the
operating time.

842719A1.CDR
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Figure 5-77: Composite recloser curve with HCT enabled 

5.5.6.5  Standard recloser curves
The following graphs display standard recloser curves available for the F60.

Figure 5-78: Recloser curves GE101 to GE106 

Configuring a composite curve with an increase in operating time at increased pickup multiples is not allowed. If 
this is attempted, the EnerVista software generates an error message and discards the proposed changes.
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Figure 5-79: Recloser curves GE113, GE120, GE138, and GE142 

Figure 5-80: Recloser curves GE134, GE137, GE140, GE151, and GE201 
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Figure 5-81: Recloser curves GE131, GE141, GE152, and GE200 

Figure 5-82: Recloser curves GE133, GE161, GE162, GE163, GE164, and GE165 
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Figure 5-83: Recloser curves GE116, GE117, GE118, GE132, GE136, and GE139 

Figure 5-84: Recloser curves GE107, GE111, GE112, GE114, GE115, GE121, and GE122 
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Figure 5-85: Recloser curves GE119, GE135, and GE202 

5.5.7  Phasor Measurement Unit

5.5.7.1  Menu
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT

5.5.7.2  UR synchrophasor implementation
Phasors are used in protection relays. When these phasors are referenced to a common time base, they are referred to as 
synchrophasors. A vastly improved method for tracking power system dynamic phenomena for power system monitoring, 
protection, operation, and control can be realized when synchrophasors from different locations within the power system 
are networked to a central location.

The F60 offers PMU features over two communication standards, IEC 61850-90-5 and IEEE C37.118. The figure shows 
complete synchrophasor implementation.

 PHASOR MEASUREMENT
 UNIT   PHASOR MEASUREMENT

 UNIT 1
See below

  PMU AGGREGATOR 1
 

See page 5-188

  IEC 90-5 MSVCB
 CONFIGURATION

See page 5-190

The F60 is provided with an optional Phasor Measurement Unit (PMU) feature. This feature is specified as a 
software option at the time of ordering. The number of PMUs available also depends on this option. Using the 
order code for your device, see the order codes in chapter 2 for details.
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Figure 5-86: Synchrophasor implementation

5.5.7.3  UR implementation of IEC 61850-90-5
Synchrophasor data as measured and calculated by PMUs is used to assess the condition of the electrical power network. 
The IEEE C37.118 standards define synchrophasors and related message formats to transmit synchrophasor data. 
Synchrophasor streaming via IEEE C37.118 has proven to work but the need to have a communication mechanism that is 
compliant with the concept of IEC 61850 has led to the development of IEC 61850-90-5. The IEC 61850-90-5 technical 
report defines the packet structure for multicast routing of streamed Sampled Value (SV) known as R-SV.

UR firmware versions 7.0 and above have a 90-5 based R-SV implementation equivalent in structure and configuration to 
that of the existing IEEE C37.118 implementation of firmware version 6.0, that is, synchrophasor data at rates up to 60 Hz 
for metering and 120 Hz for protection class synchrophasors. The following two figures depict the general data flow for the 
generation of synchrophasor data for IEC 61850-90-5. In the first figure, when IEC 61850-90-5 is selected all real and 
virtual sources are available for the IEC 61850-90-5 PMUs.

The number of PMUs and aggregators vary by product, as outlined in the table.

Table 5-19: PMU implementation by UR device

The figure shows an example of an N60 using four Logical Device PMUs (Logical Device 2 through 5) and four aggregators. 
The control blocks for the aggregators are located in LD1. A 64 character LDName setting is provided.

UR device Number of PMUS Number of aggregators Comment

N60 1, 2, 4, or 6 1 with 1 PMU
2 with 2 or 4 PMUs
4 with 6 PMUs

Number of PMUs is ordered using software options

C60 2 2

D60, F60, G60, L30, L90, T60 1 1
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Figure 5-87: N60 example for four logical device PMUs 

Depending on the applied filter, the synchrophasors that are produced by PMUs are classified as either P (protection) or M 
(Measurement) class synchrophasors. Synchrophasors available within the UR that have no filtering applied are classified 
as NONE, which within the standard is classified as PRES OR UNKNOWN under the Calculation Method - ClcMth. Each 
Logical Device PMU supports one MxxMMXU, MxxMSQI, PxxxMMXU , PxxxMSQI, NxxMMXU, and one NxxMSQI logical node.

Figure 5-88: Logical nodes supported in each logical device 

The following is a summary of LNs that are in each Logical Device (LD2 through LD7):

• PxxxMMXU1  ClcMth = P-Class (Note Vaux is mapped to Vneut of MMXU) 

• PxxxMSQI1 ClcMth = P-CLASS 

• MxxMMXU1  ClcMth = M-Class (Note Vaux is mapped to Vneut of MMXU)

• MxxMSQI1  ClcMth = M-CLASS 

• NxxMMXU1  ClcMth = M-Class (Note Vaux is mapped to Vneut of MMXU)

Precise time input to the relay from the international time standard, via either IRIG-B or PTP, is vital for correct 
synchrophasor measurement and reporting. For IRIG-B, a DC level shift IRIG-B receiver must be used for the PMU to 
output proper synchrophasor values.
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• NxxMSQI1  ClcMth = M-CLASS 

• GGIO1, which contains 16 digital status indication points and 16 analog points. The Analog GGIO values are selectable 
from any FlexAnalog value in the UR.

When the first PMU from any LD is mapped into an aggregator, the aggregator inherits the Sample Rate (SmpRate) and 
IEEE C37.118 Class (P or M) of that PMU. The value of the SmpRate DO in the Report Control Block is set based on the value 
of the Sample Rate in the PMU. The Class of the Dataset are mapped into the MSVID of the Dataset (see text that follows for 
the overall name of the MSVID). If other PMUs are mapped into the same aggregator with different Sample Rates or from 
different classes, then a Self-Test error (DatSetErr) is set and dataset transmission is blocked.

A setting value — MSVID — is created with a maximum input range of 56 characters (=64 less 6 for the IDCode less 2 for the 
Class).

The value of MSVID in the dataset is a concatenation of the aggregator IDCode and the MSVID setting value in the format: 
MSVID-AggregatorIDCode-CLASS where CLASS is P, M, or N (for None) – depending on the Class of the first PMU included in 
the Aggregator.

The UR also supports the option to apply no filtering to the synchrophasors. If no filtering is applied (PMU Class = None), 
according to the standard, the ClcMth attribute is PRES. The semantic of the ClcMth used is not carried in the individual DO 
and so it is recommended that one of letters of the prefix on the instantiated LNs be set to “P” or “M” accordingly in order 
to differentiate. For firmware versions 7.0 and later, only FCDA data is supported. The PMU Implementation by UR Device 
table earlier indicates the maximum size of each PMU data set for version 7.2 and later using FCDA data (non-structured 
data).

5.5.7.4  Example: Protection synchrophasors data set with reporting rate 60 frames/second
This example gives the protection synchrophasors data set with a reporting rate of 60 frames per second (P60MMXU1). See 
the figure earlier, Logical Nodes Supported in Each Logical Device. This data or list of items, as shown in the following 
figure, is not available to the UR setup program but is available to be mapped by the user into a selected aggregator or 
aggregators dataset. The logical device name (LDName) of each PMU LD is a 64 character user setting. The IEEE C37.118 
STN and IDCode is to be mapped as a concatenated value in the (d)escription field of LPL CDC of the NamPlt DO in LLN0. 
The mapping is implemented as STN-IDCode (text string).

From each PMU, the user selects the phasor information of interest that is mapped into the selected aggregator datset(s). 
For version 7.0 and later, only FCDA data is supported.

The Synchro Logical Nodes in an LD report at the same rate as set in the PMUn Basic Configuration setting. This is 
reflected in the instantiation of the Data Object – SmpRate in the msvcb## of LLN0 in the LD1. SmpRate is a Read 
Only Integer Status (INS).

Synchrophasor Rectangular Format and Integer data types are NOT supported in IEC 61850-90-5 (only supported 
with IEEE C37.118) and not to set — GGIO1 that contains 16 digital status indication points — aggregated as a 16 bit 
bitstring and 16 analog points. The Analog GGIO values are selectable from any FlexAnalog value in the UR. For 
firmware versions 7.0 and later, the description fields for the phasors, analog, and digital channels are populated 
with the 16 character name field provided within the Basic Configuration menu. Additionally, the names of the 16 
binary points are implemented as numbered descriptions — d1, d2, d3, and so on. The number of descriptions are 
equal to the number of bits configured in the 16 bit digital status word.

All bitstrings less than or equal to 32 bits in length map into a 32 bit bitstring in an IEC 61850-90-5 dataset.

The Value of the Nominal Frequency of the chassis is instantiated as a DO in LPHD of LD1. The value is named 
HzNom and is an Integer Status (INS).
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Figure 5-89: Data set created from user-selected internal items 

5.5.7.5  Example: Creation of different data sets
The aggregators allow the aggregation of phasors from multiple PMUs (with the same reporting rate) into a single custom 
data set to optimize bandwidth when streaming.

Figure 5-90: Example of aggregator data sets 
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5.5.7.6  Configuration example: CFG-2 based configuration (using IEC 61850-90-5)
The F60 is expected to send the CFG-2 file (IEEE C37.118 config. file) upon request from the upstream synchrophasor 
devices (for example, P30) without stopping R-SV multicasting, as shown in the following figure. The primary domain 
controller (PDC) does not need to use a stop/start data stream command if the UR protocol is set to IEC 61850-90-5 prior to 
requesting the configuration via CFG-2 (IEEE C37.118 config. file). The CFG-2 request from the P30 can be on TCP/IP or 
UDP/IP, however, R-SV data streaming is only UDP multicasts (not TCP).

Figure 5-91: CFG-2 based configuration solution

5.5.7.7  Modification of SYNC word in CFG-2 for TR 90-5 data sets
In the CFG-2 file, all relevant information about the data being streamed is included. However, this file does not include the 
fact that it describes a 90-5 dataset or the number of Application Service Data Units (datasets).  In order to communicate 
this information via the CFG-2 file for a given aggregator, when the aggregator is set to 90-5, the version number of the 
CFG-2 file (found in bits 0-3 of the frame SYNC word, which is set presently to 2) is set as follows:

5.5.7.8  Settings
The PMU settings are organized as follows.

SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1

Value (decimal) Number of ASDUs

 11  1

 12  2

 13  3

 14  4

 PHASOR MEASUREMENT
 UNIT 1   PMU 1 BASIC

 CONFIGURATION
See below

  PMU 1
 CALIBRATION

See page 5-180

  PMU 1
 TRIGGERING

See page 5-181

  PMU 1
 RECORDING

See page 5-188
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5.5.7.9  Basic configuration
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  BASIC CONFIGURATION  PMU 1

 PMU 1 BASIC
 CONFIGURATION  PMU 1

FUNCTION: Disabled
Range:  Enabled, Disabled

 PMU 1 IDCODE:
1

Range:  1 to 65534 in steps of 1

 PMU 1 STN:
GE-UR-PMU

Range:  32-character ASCII string truncated to 16 
characters if mapped into C37.118 Default: GE-UR-PMU

 PMU 1 SIGNAL SOURCE:
SRC 1

Range:  available signal sources

 PMU 1 CLASS:
M-CLASS

Range:  None, M-CLASS, P-CLASS 

 PMU 1 FORMAT:
Integer

Range:  Integer, Floating-point

 PMU 1 STYLE:
Polar

Range:  Polar, Rectangular

 PMU 1 RATE:
10/sec

Range: 1, 2, 4, 5, 10, 12, 15,20, 25, 30,50, 60, 100, 120 
/sec

 PMU 1 f & df/dt
FILTER: None

Range: None, 10Hz/s <10Hz, 10Hz/s <20Hz, 20Hz/s 
<10Hz, 20Hz/s <20Hz

  C37.118 PMU 1
 CONFIGURATION

See below

 PMU 1 PHS- 1:
Off

Range:  available synchrophasor values



 PMU 1 PHS-14:
Off

Range:  available synchrophasor values

 PMU 1 PHS- 1:
NM: GE-UR-PMU-PHS 1

Range:  16-character ASCII string



 PMU 1 PHS-14:
NM: GE-UR-PMU-PHS 14

Range:  16-character ASCII string

 PMU 1 A-CH- 1:
Off

Range:  available FlexAnalog values



 PMU 1 A-CH-8:
Off

Range:  available FlexAnalog values

 PMU 1 A-CH- 1:
NM: AnalogChannel 1

Range:  16-character ASCII string



 PMU 1 A-CH-8:
NM: AnalogChannel 8

Range:  16-character ASCII string

 PMU 1 D-CH- 1:
Off

Range:  available FlexLogic operands



 PMU 1 D-CH-16:
Off

Range:  available FlexLogic operands
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This section contains basic Phasor Measurement Unit (PMU) data, such as functions, source settings, and names.

PMU 1 FUNCTION — This setting enables the LOGICAL Device PMU 1 functionality. Use this setting to permanently enable or 
disable the feature.

PMU 1 IDCODE — This setting assigns a numerical ID to the PMU. It corresponds to the IDCODE field of the data, 
configuration, header, and command frames of the IEEE C37.118 protocol. The PMU uses this value when sending data, 
configuration, and header frames; and it responds to this value when receiving the command frame. This is used when 
only data from one PMU is present.

PMU 1 STN — This setting assigns an alphanumeric ID to the PMU station. It corresponds to the STN field of the 
configuration frame of the IEEE C37.118 protocol. This value is a 16-character ASCII string as per the IEEE C37.118 
standard.

PMU 1 SIGNAL SOURCE — This setting specifies one of the available F60 signal sources for processing in the PMU. Any 
combination of voltages and currents can be configured as a source. The current channels can be configured as sums of 
physically connected currents. This facilitates PMU applications in breaker-and-a-half, ring-bus, and similar arrangements. 
The PMU feature calculates voltage phasors for actual voltage (A, B, C, and auxiliary) and current (A, B, C, and ground) 
channels of the source, as well as symmetrical components (0, 1, and 2) of both voltages and currents. When configuring 
communication and recording features of the PMU, the user can select, from the above superset, the content to be sent 
out or recorded. When one source is selected by one PMU, it cannot be selected by another PMU.

PMU 1 CLASS (Range P, M, None) — This setting selects the synchrophasor class. A reporting rate of 100 or 120 can only be 
selected for class P synchrophasors and if the system frequency is 50 or 60 Hz, respectively.

PMU 1 NETWORK REPORTING FORMAT — This setting selects between reporting synchrophasors as 16-bit integer or 32-bit 
IEEE floating point numbers. This setting complies with bit-1 of the FORMAT field of the C37.118 configuration frame. Note 
that this setting applies to synchrophasors only; the user-selectable FlexAnalog channels are always transmitted as 16-bit 
integer values.

PMU 1 NETWORK REPORTING STYLE — This setting selects between reporting synchrophasors in rectangular (real and 
imaginary) or in polar (magnitude and angle) coordinates. This setting complies with bit-0 of the FORMAT field of the 
C37.118 configuration frame.

PMU 1 RATE — This setting specifies the reporting rate for the network (Ethernet) port. This value applies to all PMU streams 
of the device that are assigned to transmit over this aggregator. For a system frequency of 60 Hz (50 Hz), the F60 generates 
a reporting mismatch message if the selected rate is not set as 10 Hz, 12 Hz, 15 Hz, 20 Hz, 30 Hz, 60 Hz, or 120 Hz (or 10 Hz, 
25 Hz, 50 Hz, or 100 Hz when the system frequency is 50 Hz) when entered via the keypad or software; and the F60 stops 
the transmission of reports. Note that 4 Hz is not allowed for an M-class 50 Hz system.

PMU 1 f & df/dt FILTER — This setting allows applying post-filtering to the frequency and rate-of-change of-frequency to 
avoid reporting erroneous values, which can possibly happen during fault, switching, and other system disturbances. For 
example, choosing 20Hz/s <10Hz setting ensures that if rate-of-change of-frequency between current reporting instance 
and previous one exceeds 20Hz/s or frequency deviation from the nominal frequency exceeds 10Hz, then new frequency 
and rate-of-change of-frequency value are invalidated. If this happens, the previous valid value of the frequency is 
maintained and rate-of-change of-frequency value is forced to 0 at this reporting instance.

 PMU 1 D-CH- 1
NM: Dig Channel 1

Range:  16-character ASCII string



 PMU 1 D-CH-16
NM: Dig Channel 16

Range:  16-character ASCII string

 PMU 1 D-CH- 1
NORMAL STATE: Off

Range:  Off, On



 PMU 1 D-CH-16:
NORMAL STATE: Off

Range:  Off, On

  90-5 PMU 1
 CONFIGURATION

See below
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PMU 1 PHS-1 to PMU 1 PHS-14 — These settings specify synchrophasors to be transmitted from the superset of all 
synchronized measurements. The table outlines available synchrophasor values.

Table 5-20: Synchrophaser settings

These settings allow for optimizing the frame size and maximizing transmission channel usage, depending on a given 
application. Select “Off” to suppress transmission of a given value.

PMU 1 PHS-1 NM to PMU 1 PHS-14 NM — These settings allow for custom naming of the synchrophasor channels. Sixteen-
character ASCII strings are allowed as in the CHNAM field of the configuration frame. These names are typically based on 
station, bus, or breaker names.

PMU 1 A-CH-1 to PMU 1 A-CH-16 — These settings specify any analog data measured by the relay to be included as a user-
selectable analog channel of the data frame. Up to eight analog channels can be configured to send any FlexAnalog value 
from the relay. Examples include frequency, rate of frequency change, active and reactive power, per phase or three-phase 
power, power factor, temperature via RTD inputs, and THD. The configured analog values are sampled concurrently with 
the synchrophasor instant and sent as 32-bit floating-point values scaled to Engineering units.

PMU 1 A-CH-1 NM to PMU 1 A-CH-16 NM — These settings allow for custom naming of the analog channels. Sixteen-character 
ASCII strings are allowed as in the CHNAM field of the configuration frame.

PMU 1 D-CH-1 to PMU 1 D-CH-16 — These settings specify any digital flag measured by the relay to be included as a user-
selectable digital channel of the data frame. Up to 16 digital channels can be configured to send any FlexLogic operand 
from the relay. The configured digital flags are sampled concurrently with the synchrophasor instant. These values are 
mapped into a two-byte integer number, with byte 1 LSB corresponding to the digital channel 1 and byte 2 MSB 
corresponding to digital channel 16.

PMU 1 D-CH-1 NM to PMU 1 D-CH-16 NM — These settings allow for custom naming of the digital channels. Sixteen-character 
ASCII strings are allowed as in the CHNAM field of the configuration frame.

PMU 1 D-CH-1 NORMAL STATE to PMU 1 D-CH-16 NORMAL STATE — These settings allow for specifying a normal state for each 
digital channel. These states are transmitted in configuration frames to the data concentrator.

C37.118 PMU 1 configuration
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  BASIC CONFIGURATION  PMU 1  PMU 1 BASIC 
CONFIGURATION  C37.118 PMU 1 CONFIGURATION

Selection Meaning

Va First voltage channel, either Va or Vab

Vb Second voltage channel, either Vb or Vbc

Vc Third voltage channel, either Vc or Vca

Vx Fourth voltage channel

Ia Phase A current, physical channel or summation as per the source settings

Ib Phase B current, physical channel or summation as per the source settings

Ic Phase C current, physical channel or summation as per the source settings

Ig Fourth current channel, physical or summation as per the source settings

V1 Positive-sequence voltage, referenced to Va

V2 Negative-sequence voltage, referenced to Va

V0 Zero-sequence voltage

I1 Positive-sequence current, referenced to Ia

I2 Negative-sequence current, referenced to Ia

I0 Zero-sequence current

 C37.118 PMU 1
 CONFIGURATION  PMU 1 FORMAT:

Integer
Range:  Integer, Floating-point

 PMU 1 STYLE:
Polar

Range:  Polar, Rectangular
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PMU 1 FORMAT — This setting selects whether synchrophasors are reported as 16-bit integers or 32-bit IEEE floating point 
numbers. This setting complies with bit-1 of the FORMAT field of the IEEE C37.118 configuration frame. This setting applies 
to synchrophasors only; user-selectable FlexAnalog channels are always transmitted as 16-bit integer values.

PMU 1 STYLE — This setting selects whether synchrophasors are reported in rectangular (real and imaginary) coordinates or 
in polar (magnitude and angle) coordinates. This setting complies with bit-0 of the FORMAT field of the IEEE C37.118 
configuration frame.

IEC 61850–90–5 PMU 1 configuration
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  BASIC CONFIGURATION  PMU 1  PMU 1 BASIC 
CONFIGURATION  90-5 PMU 1 CONFIGURATION

PMU1 LDINST — A user-defined visible string (maximum 64 char ASCII test) to assign Logical Device (LD) Inst for a PMU 
logical device.

5.5.7.10  PMU calibration
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
CALIBRATION

With 90-5 PMU, the FORMAT and STYLE are Floating-point and Polar respectively, as specified in the IEC 61850-90-5 
technical report.

 90-5 PMU 1
 CONFIGURATION  PMU 1 LDINST:

PMU1
Range:  64 char ASCII text

As per IEC 61850-6 standard specification, the PMU LD Name is the concatenated combination (to total 64 
characters) of IED Name (specified in IEC 61850 Server Settings) appended with PMU X LDINST string.

 PMU 1
 CALIBRATION  PMU 1 VA CALIBRATION

ANGLE: 0.00°
Range:  –5.00 to 5.00° in steps of 0.05

 PMU 1 VA CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 VB CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05

 PMU 1 VB CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 VC CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05

 PMU 1 VC CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 VX CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05

 PMU 1 VX CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 IA CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05

 PMU 1 IA CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 IB CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05
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This menu contains user angle and magnitude calibration data for the Phasor Measurement Unit (PMU). This data is 
combined with the factory adjustments to shift the phasors for better accuracy.

PMU 1 VA... IG CALIBRATION ANGLE — These settings recognize applications with protection class voltage and current 
sources, and they allow the user to calibrate each channel (four voltages and four currents) individually to offset errors 
introduced by VTs, CTs, and cabling. The setting values are effectively added to the measured angles. Therefore, enter a 
positive correction when the secondary signal lags the true signal and a negative value when the secondary signal leads 
the true signal.

PMU 1 VA... IG CALIBRATION MAGNITUDE — These settings recognize applications with protection class voltage and current 
sources, and they allow the user to calibrate each channel (four voltages and four currents) individually to offset errors 
introduced by VTs, CTs. The setting values are effectively a multiplier of the measured magnitudes. Therefore, entering a 
multiplier greater than 100% of the secondary signal increases the true signal, and a multiplier less than 100% value of the 
secondary signal reduces the true signal.

PMU 1 SEQ VOLT SHIFT ANGLE — This setting allows correcting positive- and negative-sequence voltages for vector groups of 
power transformers located between the PMU voltage point and the reference node. This angle is effectively added to the 
positive-sequence voltage angle and subtracted from the negative-sequence voltage angle. Note that:

• When this setting is not “0°”, the phase and sequence voltages do not agree. Unlike sequence voltages, the phase 
voltages cannot be corrected in a general case and therefore are reported as measured.

• When receiving synchrophasor data at multiple locations, with possibly different reference nodes, it can be more 
beneficial to allow the central locations to perform the compensation of sequence voltages.

• This setting applies to PMU data only. The F60 calculates symmetrical voltages independently for protection and 
control purposes without applying this correction.

• When connected to line-to-line voltages, the PMU calculates symmetrical voltages with the reference to the AG 
voltage and not to the physically connected AB voltage (see the Metering Conventions section in Chapter 6).

PMU 1 SEQ CURR SHIFT ANGLE — This setting allows correcting positive and negative-sequence currents for vector groups of 
power transformers located between the PMU current point and the reference node. The setting has the same meaning for 
currents as the PMU 1 SEQ VOLT SHIFT ANGLE setting has for voltages. Normally, the two correcting angles are set identically, 
except rare applications when the voltage and current measuring points are located at different windings of a power 
transformer.

5.5.7.11  PMU triggering overview
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING

 PMU 1 IB CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 IC CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05

 PMU 1 IC CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 IG CALIBRATION
ANGLE: 0.00°

Range: –5.00 to 5.00° in steps of 0.05

 PMU 1 IG CALIBRATION
MAG: 100.0%

Range: 95.0 to 105.0 in steps of 0.1%

 PMU 1 SEQ VOLT SHIFT
ANGLE: 0°

Range: –180 to 180° in steps of 30

 PMU 1 SEQ CURR SHIFT
ANGLE: 0°

Range: –180 to 180° in steps of 30

 PMU 1
 TRIGGERING   PMU 1 USER

 TRIGGER
See below
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Each Phasor Measurement Unit (PMU) contains five triggering mechanisms to facilitate triggering of the associated PMU 
recorder, or cross-triggering of other PMUs in the system. They are

• Overfrequency and underfrequency

• Overvoltage and undervoltage

• Overcurrent

• Overpower

• High rate of change of frequency

The pre-configured triggers can be augmented with a user-specified condition built freely using programmable logic of the 
relay. The entire triggering logic is refreshed once every two power system cycles.

All five triggering functions and the user-definable condition are consolidated (ORed) and connected to the PMU recorder. 
Each trigger can be programmed to log its operation into the event recorder and to signal its operation via targets. The five 
triggers drive the STAT bits of the data frame to inform the destination of the synchrophasor data regarding the cause of 
trigger. The following convention is adopted to drive bits 11, 3, 2, 1, and 0 of the STAT word.

Figure 5-92: STAT bits logic 

The trigger reset (drop-off) timer is available for all five triggering functions (FREQ, ROCOF, VOLT, CURR, POWER) in individual 
trigger settings under the TRIGGER DPO TIME setting. This asserts individual trigger operand and overall PMU x TRIGGERED 
operand with stat bits 3 and 11 for a fixed interval defined by this setting. If it is required that PMU x TRIGGERED operand with 
stat bits 3 and 11 stay longer than the individual reset timer, then use the PMU x USER TRIGGER setting assigned with 
appropriate elements and FlexLogic. In short, in case of USER TRIGGER, the drop-off time needs to be implemented using 
FlexLogic.

5.5.7.12  User triggering
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING  PMU 1 USER TRIGGER

The user trigger allows customized triggering logic to be constructed from FlexLogic. The entire triggering logic is refreshed 
every two power system cycles.

  PMU 1 FREQUENCY
 TRIGGER

See page 5-183

  PMU 1 VOLTAGE
 TRIGGER

See page 5-184

  PMU 1 CURRENT
 TRIGGER

See page 5-185

  PMU 1 POWER
 TRIGGER

See page 5-185

  PMU 1 df/dt
 TRIGGER

See page 5-187

 PMU 1 USER
 TRIGGER  PMU 1 USER TRIGGER:

Off
Range: FlexLogic operand
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5.5.7.13  Frequency triggering
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING  PMU 1 FREQUENCY TRIGGER

The trigger responds to the frequency signal of the Phasor Measurement Unit (PMU) source. The frequency is calculated 
from among phase voltages, auxiliary voltage, phase currents, and ground current, in this hierarchy, depending on the 
source configuration as per F60 standards. This element requires that the frequency be above the minimum measurable 
value. If the frequency is below this value, such as when the circuit is de-energized, the trigger drops out.

PMU 1 FREQ TRIGGER LOW-FREQ — Specifies the low threshold for the abnormal frequency trigger. The comparator applies a 
0.02 Hz hysteresis.

PMU 1 FREQ TRIGGER HIGH-FREQ — Specifies the high threshold for the abnormal frequency trigger. The comparator applies 
a 0.02 Hz hysteresis.

PMU 1 FREQ TRIGGER PKP TIME — Use to filter out spurious conditions and avoid unnecessary triggering of the recorder.

PMU 1 FREQ TRIGGER DPO TIME — Use to extend the trigger after the situation returns to normal. This setting is of importance 
when using the recorder in the forced mode (recording as long as the triggering condition is asserted).

Figure 5-93: Frequency trigger logic 

 PMU 1 FREQUENCY
 TRIGGER  PMU 1 FREQ TRIGGER

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU 1 FREQ TRIGGER
LOW-FREQ: 49.00 Hz

Range: 20.00 to 70.00 Hz in steps of 0.01

 PMU 1 FREQ TRIGGER
HIGH-FREQ: 61.00 Hz

Range: 20.00 to 70.00 Hz in steps of 0.01

 PMU 1 FREQ TRIGGER
PKP TIME: 0.10 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 FREQ TRIGGER
DPO TIME: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 FREQ TRIG BLK:
Off

Range: FlexLogic operand

 PMU 1 FREQ TRIGGER
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PMU 1 FREQ TRIGGER
EVENTS: Disabled

Range: Enabled, Disabled
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5.5.7.14  Voltage triggering
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING  PMU 1 VOLTAGE TRIGGER

This element responds to abnormal voltage. Separate thresholds are provided for low and high voltage. In terms of 
signaling its operation, the element does not differentiate between the undervoltage and overvoltage events. The trigger 
responds to the phase voltage signal of the Phasor Measurement Unit (PMU) source. All voltage channels (A, B, and C or AB, 
BC, and CA) are processed independently and can trigger the recorder. A minimum voltage supervision of 0.1 pu is 
implemented to prevent pickup on a de-energized circuit, similarly to the undervoltage protection element.

PMU 1 VOLT TRIGGER LOW-VOLT — Specifies the low threshold for the abnormal voltage trigger, in per-unit of the PMU 
source. 1 pu is a nominal voltage value defined as the nominal secondary voltage times VT ratio. The comparator applies a 
1% hysteresis.

PMU 1 VOLT TRIGGER HIGH-VOLT — Specifies the high threshold for the abnormal voltage trigger, in per-unit of the PMU 
source. 1 pu is a nominal voltage value defined as the nominal secondary voltage times VT ratio. The comparator applies a 
1% hysteresis.

PMU 1 VOLT TRIGGER PKP TIME — Use to filter out spurious conditions and avoid unnecessary triggering of the recorder.

PMU 1 VOLT TRIGGER DPO TIME — Use to extend the trigger after the situation returns to normal. This setting is of importance 
when using the recorder in the forced mode (recording as long as the triggering condition is asserted).

Figure 5-94: Voltage trigger logic 

 PMU 1 VOLTAGE
 TRIGGER  PMU 1 VOLT TRIGGER

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU 1 VOLT TRIGGER
LOW-VOLT: 0.800 pu

Range: 0.250 to 1.250 pu in steps of 0.001

 PMU 1 VOLT TRIGGER
HIGH-VOLT: 1.200 pu

Range: 0.750 to 1.750 pu in steps of 0.001

 PMU 1 VOLT TRIGGER
PKP TIME: 0.10 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 VOLT TRIGGER
DPO TIME: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 VOLT TRIG BLK:
Off

Range: FlexLogic operand

 PMU 1 VOLT TRIGGER
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PMU 1 VOLT TRIGGER
EVENTS: Disabled

Range: Enabled, Disabled
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5.5.7.15  Current triggering
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING  PMU 1 CURRENT TRIGGER

This element responds to elevated current. The trigger responds to the phase current signal of the Phasor Measurement 
Unit (PMU) source. All current channel (A, B, and C) are processed independently and can trigger the recorder.

PMU 1 CURR TRIGGER PICKUP — Specifies the pickup threshold for the overcurrent trigger, in per unit of the PMU source. A 
value of 1 pu is a nominal primary current. The comparator applies a 3% hysteresis.

PMU 1 CURR TRIGGER PKP TIME — Use to filter out spurious conditions and avoid unnecessary triggering of the recorder.

PMU 1 CURR TRIGGER DPO TIME — Use to extend the trigger after the situation returns to normal. This setting is of 
importance when using the recorder in the forced mode (recording as long as the triggering condition is asserted).

Figure 5-95: Current trigger logic 

5.5.7.16  Power triggering
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING  PMU 1 POWER TRIGGER

 PMU 1 CURRENT
 TRIGGER  PMU 1 CURR TRIGGER

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU 1 CURR TRIGGER
PICKUP: 1.800 pu

Range: 0.100 to 30.000 pu in steps of 0.001

 PMU 1 CURR TRIGGER
PKP TIME: 0.10 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 CURR TRIGGER
DPO TIME: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 CURR TRIG BLK:
Off

Range: FlexLogic operand

 PMU 1 CURR TRIGGER
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PMU 1 CURR TRIGGER
EVENTS: Disabled

Range: Enabled, Disabled

 PMU 1 POWER
 TRIGGER  PMU 1 POWER TRIGGER

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU 1 POWER TRIGGER
ACTIVE: 1.250 pu

Range: 0.250 to 3.000 pu in steps of 0.001

 PMU 1 POWER TRIGGER
REACTIVE: 1.250 pu

Range: 0.250 to 3.000 pu in steps of 0.001

 PMU 1 POWER TRIGGER
APPARENT: 1.250 pu

Range: 0.250 to 3.000 pu in steps of 0.001
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This element responds to abnormal power. Separate thresholds are provided for active, reactive, and apparent powers. In 
terms of signaling its operation, the element does not differentiate among the three types of power. The trigger responds 
to the single-phase and three-phase power signals of the Phasor Measurement Unit (PMU) source.

PMU 1 POWER TRIGGER ACTIVE — Specifies the pickup threshold for the active power of the source. For single-phase power, 
1 pu is a product of 1 pu voltage and 1 pu current, or the product of nominal secondary voltage, the VT ratio and the 
nominal primary current. For the three-phase power, 1 pu is three times that for a single-phase power. The comparator 
applies a 3% hysteresis.

PMU 1 POWER TRIGGER REACTIVE — Specifies the pickup threshold for the reactive power of the source. For single-phase 
power, 1 pu is a product of 1 pu voltage and 1 pu current, or the product of nominal secondary voltage, the VT ratio and 
the nominal primary current. For the three-phase power, 1 pu is three times that for a single-phase power. The comparator 
applies a 3% hysteresis.

PMU 1 POWER TRIGGER APPARENT — Specifies the pickup threshold for the apparent power of the source. For single-phase 
power, 1 pu is a product of 1 pu voltage and 1 pu current, or the product of nominal secondary voltage, the VT ratio and 
the nominal primary current. For the three-phase power, 1 pu is three times that for a single-phase power. The comparator 
applies a 3% hysteresis.

PMU 1 POWER TRIGGER PKP TIME — Use to filter out spurious conditions and avoid unnecessary triggering of the recorder.

PMU 1 POWER TRIGGER DPO TIME — Use to extend the trigger after the situation returns to normal. This setting is of 
particular importance when using the recorder in the forced mode (recording as long as the triggering condition is 
asserted).

Figure 5-96: Power trigger logic 

 PMU 1 POWER TRIGGER
PKP TIME: 0.10 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 POWER TRIGGER
DPO TIME: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 PWR TRIG BLK:
Off

Range: FlexLogic operand

 PMU 1 POWER TRIGGER
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PMU 1 POWER TRIGGER
EVENTS: Disabled

Range: Enabled, Disabled
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5.5.7.17  df/dt triggering
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  PMU 1 
TRIGGERING  PMU 1 df/dt TRIGGER

This element responds to frequency rate of change. Separate thresholds are provided for rising and dropping frequency. 
The trigger responds to the rate of change of frequency (df/dt) of the Phasor Measurement Unit (PMU) source.

PMU 1 df/dt TRIGGER RAISE — Specifies the pickup threshold for the rate of change of frequency in the raising direction 
(positive df/dt). The comparator applies a 4% hysteresis.

PMU 1 df/dt TRIGGER FALL — Specifies the pickup threshold for the rate of change of frequency in the falling direction 
(negative df/dt). The comparator applies a 4% hysteresis.

PMU 1 df/dt TRIGGER PKP TIME — Use to filter out spurious conditions and avoid unnecessary triggering of the recorder.

PMU 1 df/dt TRIGGER DPO TIME — Use to extend the trigger after the situation returns to normal. This setting is of importance 
when using the recorder in the forced mode (recording as long as the triggering condition is asserted).

Figure 5-97: Rate of change of frequency trigger logic 

 PMU 1 df/dt
 TRIGGER  PMU 1 df/dt TRIGGER

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU 1 df/dt TRIGGER
RAISE: 0.25 Hz/s

Range: 0.10 to 15.00 Hz/s in steps of 0.01

 PMU 1 df/dt TRIGGER
FALL: 0.25 Hz/s

Range: 0.10 to 15.00 Hz/s in steps of 0.01

 PMU 1 df/dt TRIGGER
PKP TIME: 0.10 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 df/dt TRIGGER
DPO TIME: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PMU 1 df/dt TRG BLK:
Off

Range: FlexLogic operand

 PMU 1 df/dt TRIGGER
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PMU 1 df/dt TRIGGER
EVENTS: Disabled

Range: Enabled, Disabled

SETTINGS

PMU 1 df/dt TRIGGER

FUNCTION:

Enabled = 1

PMU 1 df/dt TRG BLK:

Off = 0

SETTING

PMU 1 SIGNAL

SOURCE:

ROCOF, df/dt

A
N

D

SETTINGS

PMU 1 df/dt TRIGGER RAISE:

PMU 1 df/dt TRIGGER FALL:

df/dt > RAISE

OR

–df/dt > FALL

RUN

SETTINGS

PMU 1 df/dt TRIGGER PKP TIME:

PMU 1 df/dt TRIGGER DPO TIME:

t
PKP

t
DPO

FLEXLOGIC OPERAND

PMU 1 ROCOF TRIGGER

FLEXLOGIC OPERANDS

PMU 1 VOLT TRIGGER

PMU 1 CURR TRIGGER

PMU 1 POWER TRIGGER

PMU 1 FREQ TRIGGER

SETTING

PMU 1 USER TRIGGER:

Off = 0

O
R

FLEXLOGIC OPERAND

PMU 1 TRIGGERED

to STAT bits of
the data frame

847000A1.CDR
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5.5.7.18  PMU recording
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PHASOR MEASUREMENT UNIT 1  RECORDING 
PMU 1

PMU 1 FUNCTION — This setting enables or disables the recorder for PMU 1. The rate is fixed at the reporting rate set within 
the aggregator (that is, Aggregator 1).

PMU 1 NO OF TIMED RECORDS — Specifies the number of timed records that are available for a given logical PMU 1. The 
length of each record is equal to the available memory divided by the content size and number of records. As the number 
of records is increased, the available storage for each record is reduced. The relay supports a maximum of 128 records in 
either timed or forced mode.

PMU 1 TRIGGER MODE — Specifies what happens when the recorder uses its entire available memory storage. With 
“Automatic Overwrite,” the last record is erased to facilitate new recording, when triggered. Under the “Protected” 
selection, the recorder stops creating new records when the entire memory is used up by the old uncleared records.

PMU 1 TIMED TRIGGER POSITION — Specifies the amount of pre-trigger data as a percent of the entire record. This setting 
applies only to the timed mode of recording.

5.5.7.19  Aggregator
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PMU AGGREGATOR 1

PMU AGGREGATOR1 PROTOCOL — Selects if the IEEE C37.118 or IEC 61850-90-5 technical report is used. Because one 
protocol is supported at a time in a device, this setting applies to all PMU aggregators.

PMU AGGREGATOR1 IDCODE — Numeric identifier of the Aggregator / PDC function. In an IEEE C37.118 output stream, this 
identifies the ID of the aggregator, which is only used if there is more than 1 PMU mapped into an aggregator.

PMU AGGREGATOR1 PMU1 — If set to “Yes,” aggregator 1 includes the PMU1 data set in the reporting data stream. 
AGGREGATOR1 does not include PMU1 data set in the report if set to “No.”

 PMU 1
 RECORDING  PMU 1 FUNCTION:

Disabled
Range: Enabled, Disabled

 PMU 1 NO OF TIMED
RECORDS: 10

Range: 2 to 128 in steps of 1

 PMU 1 TRIGGER MODE:
Automatic Overwrite

Range: Automatic Overwrite, Protected

 PMU 1 TIMED TRIGGER
POSITION: 10%

Range: 1 to 50% in steps of 1

 PMU AGGREGATOR 1
  PMU AGGREGATOR 1

PROTOCOL: NONE
Range: NONE, 37.118, 90-5

 PMU AGGREGATOR 1
IDCODE: 1

Range: 1 to 65534 in steps of 1

 PMU AGGREGATOR 1
INCLUDE PMU1: No

Range: No, Yes

  C37.118 AGGR 1
 CONFIGURATION

See below

  90-5 AGGR 1 
 CONFIGURATION

See below

When the protocol selection is set via the software or keypad, all aggregators whose protocol is not set to None are 
set to the last protocol saved (that is, IEEE C37.118 or IEC 61850-90-5) to any aggregators, as both IEEE C37.118 and 
IEC 61850-90-5 simultaneous streaming is not possible.
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SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PMU AGGREGATOR 1  C37.118 AGGR 1 
CONFIGURATION

PMU AGGREGATOR 1 TCP PORT — Selects the TCP port number to be used by this aggregator for network reporting. All ports, 
even those of unused aggregators, must be valid and unique to avoid port number collisions.

PMU AGGREGATOR 1 UDP PORT — Selects the UDP port number to be used by this aggregator for network reporting. All ports, 
even those of unused aggregators, must be valid and unique to avoid port number collisions.

PMU AGGREGATOR 1 PDC CONTROL — The synchrophasor standard allows for user-defined controls originating at the PDC, to 
be executed on the PMU. The control is accomplished via an extended command frame. The relay decodes the first word 
of the extended field, EXTFRAME, to drive 16 dedicated FlexLogic operands. Each aggregator supports 16 FlexLogic 
operands, as shown in the table. The operands are asserted for five seconds following reception of the command frame. If 
the new command frame arrives within the five-second period, the FlexLogic operands are updated, and the five-second 
timer restarts. This setting enables or disables the control. When enabled, all 16 operands for each aggregator are active; 
when disabled, all 16 operands for each aggregator remain reset.

Table 5-21: FlexLogic operands supported by aggregator

SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  PMU AGGREGATOR 1  90-5 AGGR 1 
CONFIGURATION

Only PMUs with same reporting rate can be assigned to the same PMU AGGREGATOR.

 C37.118 AGGR 1
 CONFIGURATION  PMU AGGREGATOR 1

TCP PORT: 4712
Range: 0 to 65534

 PMU AGGREGATOR 1:
UDP PORT: 4713

Range: 0 to 65534

 PMU AGGREGATOR 1:
PDC CONTROL: Disabled

Range: Disabled, Enabled

Operand type Operand syntax Operand description

ELEMENT:
Synchrophasor, phasor data, 
concentrator

AGTR1 PDC CNTRL 1 Phasor data concentrator asserts control bit 1, as 
received via the network

as above AGTR1 PDC CNTRL 2 Phasor data concentrator asserts control bit 2 as 
received via the network

as above AGTR1 PDC CNTRL 3 Phasor data concentrator asserts control bit 3 as 
received via the network


as above AGTR1 PDC CNTRL 16 Phasor data concentrator asserts control bit 16, as 

received via the network

as above AGTR2 PDC CNTRL 1 Phasor data concentrator asserts control bit 1 as 
received via the network

as above AGTR2 PDC CNTRL 2 Phasor data concentrator asserts control bit 2 as 
received via the network

as above AGTR2 PDC CNTRL 3 Phasor data concentrator asserts control bit 3 as 
received via the network


as above AGTR1 PDC CNTRL 16 Phasor data concentrator asserts control bit 16, as 

received via the network

 90-5 AGGR 1
 CONFIGURATION  PMU AGGREGATOR 1

NAME: 
Range: 56-character ASCII text (blank by default)

 PMU AGGREGATOR 1
PORT: 1

Range: 1, 2, 3
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PMU AGGREGATOR 1 NAME — A user-defined visible string of characters (maximum 56) to identify the source of the stream. 
This value, concatenated with the Aggregator IDCode and Aggregator Class of Service, is mapped into the IEC 61850 
MSVID filed in the output stream. The field allows 65 characters, but uses the first 56 characters.

AGGREGATOR 1: PHYSICAL PORT — This setting determines the physical ports through which the synchrophasor traffic is 
transmitted. The range is 1, 2, 3.

PMU AGGREGATOR 1: UDP PORT — This setting selects the UDP port number that is used by this dataset for network reporting. 
A default setting value for IEC 6150-90-5 is provided.

PMU AGGREGATOR 1: NUMBER OF ASDUs — This setting sets the number of Application Service Data Units (ASDUs) from 1 
through to 4.

Table 5-22: Number of ASDUs

5.5.7.20  Control blocks
SETTINGS  SYSTEM SETUP  PHASOR MEASUREMENT UNIT  90–5 R-SV CB 1  CONFIGURATION

R-SV CB1 SVENA — The SV Stream Control is set by either toggling an assigned FlexLogic operand or a remote client write, to 
start and stop the streaming of R-SV frames. If remote client control is disabled, a negative response is provided to the 
client in response to a write attempt. A FlexLogic operand (SvEna) is provided for each Aggregator that reflects the state of 
the SvEna control where “1”= Enabled and “0”=Disabled. The figure shows the logic for setting the SvEna control bit.

 PMU AGGREGATOR 1
UDP PORT: 102

Range: 0 to 65534 in steps of 1

 PMU AGGREGATOR 1
NUMBER OF ASDUs: 1

Range: 1 to 4

Settings for 
ASDU

Transmission

1 ASDU at T0 (current values)

2 ASDU at T-1 (previous values) + ASDU at T0 (current values)

3 ASDU at T-2 (previous values) + ASDU at T-1 (previous values) + ASDU at T0 (current values)

4 ASDU at T-3 (previous values) + ASDU at T-2 (previous values) + ASDU at T-1 (previous values) + ASDU at T0 (current values) 

 90-5 R-SV CB 1
 CONFIGURATION  R-SV CB1 SVENA:

Off
Range: FlexLogic operand

 R-SV CB1 CLIENT CTRL: 
Off

Range: FlexLogic operand

 R-SV CB1 SVENA DFLT:
Off

Range: FlexLogic operand

 R-SV CB1 CONFREV:
1

Range: 1 to 4294967295

 R-SV CB1 PRIORITY:
4

Range: 0 to 7

 R-SV CB1 CSCP CLASS:
Expedited Forwarding

Range: None, Expedited Forwarding

 R-SV CB1 VLAN ID:
0

Range: 0 to 4095

 R-SV CB1 APPID:
0

Range: 0 to 16383

 R-SV CB1 DEST IP:
224.0.0.0

Range: 0 to 255.255.255.255

 R-SV CB1 SECURITY:
0

Range: 0 to 2
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Figure 5-98: Logic for setting SvEna control bit 

R-SV CB1 CLIENT CONTRL — This setting determines if a client can write to the reserve bit. When the assigned FlexLogic 
operand is a logic 1 state, remote clients can write to both the reserve bit and the SvEna bit. When the FlexLogic operand 
is a logic 0 state, the remote client writes to the reserve bit, the SvEna is rejected by the UR, and a negative response with 
the appropriate Service Error is returned to the client.

R-SV CB1 SVENA DFLT — This setting sets the default state of the stream (On or Off) on power-up or restart.

R-SV CB1 CONFREV — The relay increments the Configuration revision every time the configuration is changed. This setting 
allows the user to reset the configuration back to 1 or a value from 1 to 4294967295.

R-SV CB1 PRIORITY — A value from 0 through 7. The default value is 4.

R-SV CB1 DSCP CLASS — The value represents the IPv4 Differentiated Services (formerly called TypeOfService) value. The 
default value is set for Expedited Forwarding (101110B (46 or 2EH). This value provides priority routing, when supported in 
the routers.

R-SV CB1 VLAN ID — A range of values limited from 0 to 4095.

R-SV CB1 APPID — This setting allows the selection of a specific application ID for each sending device.

R-SV CB1 DEST IP — This is the destination multicast IP address that is entered in Standard IPV4 address format. The valid 
range for IPv4 is from 224.0.0.0 to 239.255.255.255. The UR does not test the address entered.

R-SV CB1 SECURITY — This setting selects the level of security and authentication used, as outlined in the following table, 
and is in the form of an enumeration as per standard. The range is 0 to 2.

Table 5-23: Security

Shaded settings in the table are not supported in firmware 7.0.

Enumeration Authentication Encryption

0 No No

1 Yes No

2 Yes Yes
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5.6  Process Bus Module

The UR provides a digital process bus by use of a Process Bus Module. A digital process bus enables digital transmission of 
data between the switchyard and relays in a control house using communication cables instead of hard-wired 
connections.

The Process Bus Module supports the IEC 61850-9-2LE and IEC 61869 protocols, switched networks, and two redundancy 
protocols (Parallel Redundancy Protocol and High-Availability Seamless Redundancy). The module is used to transfer data 
streams in protection and control networks, including dataset samples referred to as sampled values (SVs), with the 
stability of redundancy.

A Process Bus Module with order code 85, 86, or 87 is distinct from the HardFiber Process Bus Module with order code 81. 
This section does not apply to the HardFiber module.

Configuration includes that for redundancy and synchronization of time-clock sources because data transfer occurs 
among multiple devices.

5.6.1  Parallel Redundancy Protocol (PRP)
PRP enables seamless switchover and zero recovery time during a single network failure in substation automation 
networks. It ensures that critical data, such as GOOSE and sampled value (SV) data, are transmitted without delay in case 
of local area network (LAN) defects. In other words, with PRP functionality, the Process Bus Module can be connected to 
redundant LANs and work with zero recovery time.

PRP is supported to the IEC 62439-3:2012 standard, Clause 4.

The figure shows that PRP achieves redundancy by using a combination of frame and LAN duplication. Identical frames, 
here labeled frames A and B, are sent on two independent networks that connect source and destination. The frames carry 
GOOSE or supervisory data. Under normal circumstances, both frames reach the destination and one of them is sent up 
the stack to the destination application, while the other frame is discarded. If an error occurs in one of the networks and 
traffic is prevented from flowing on that path, connectivity is provided by the other network to ensure continuous 
communication. When designing this network care was taken to ensure that there is no single point of failure in the two 
LANs, such as a common power supply, as such scenarios can bring down simultaneously both LANs.

This feature requires a Process Bus Module (order code 85, 86, or 87).

Software options are not required for redundancy, such as High-Availability Seamless Redundancy.

Process Bus GOOSE requires IEC 61850 and IEEE 1588 software options.



CHAPTER 5: SETTINGS PROCESS BUS MODULE

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-193

5

Figure 5-99: PRP redundant network example 

PRP implements redundancy in the nodes rather than in the network by using specialized nodes called Doubly Attached 
Nodes Running PRP (DANP) for handling the duplicated frames. The figure shows an example. Each DANP node has two 
ports that are connected to the two independent LANs with similar (but not necessarily identical) topology. A source DANP 
sends identical frames over both LANs and a destination DANP receives both frames from the two LANs within a certain 
time period, consumes the first frame, and discards the duplicate frame.

Each UR device in this example implements PRP on ports 1a and 1b of the Process Bus Module. Both URs require a Process 
Bus Module. Ports 1a and 1b act as DANP in the PRP network. With two ports required, Process Bus Modules with order 
code 85, 86, or 87 can be used. While this example shows a UR as receiving the frames, the receiver can be a merging unit 
or UR.

A device with only one port, such as a printer or computer, is called a Singly Attached Node (SAN). It is a node with non-
redundant network adapters. A SAN can communicate with other SANs and DANPs on the same LAN. When a SAN is 
attached to a redundant LAN by a Redundancy Box (RedBox) device, the SAN can communicate with all DANPs and SANs 
in both LANs. In other words, if redundancy for a SAN is required, the SAN is connected to both LANs through a RedBox.

A merging unit (MU), such as the GE MU320, is an interface between analog and digital worlds. With an MU, the analog 
signals from the CTs and VTs in the yard are converted to digital signals and transmitted via the sampled value (SV) 
network communication protocol.

The bridges shown are network switches that connect devices participating in the PRP network and otherwise do not have 
an active role in PRP.

5.6.2  High-availability seamless redundancy (HSR)
Similar to PRP, High-Availability Seamless Redundancy (HSR) enables seamless switchover and zero recovery time during a 
single network failure in substation automation networks. It ensures that critical data, such as GOOSE and SV data, are 
transmitted without delay in case of LAN defects.

HSR is supported to IEC 62439-3, Clause 5. SV data can be received from merging units meeting IEC 61869-9.
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RedBox Gateway
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HSR is used in network topology with rings and rings of rings. All nodes in the ring are doubly attached. The figure shows an 
example. The Doubly Attached Node with HSR (DANH) is a node that has two ports interconnected by full-duplex links and 
participates in the HSR ring. The source node receives a frame from its upper layer, inserts an HSR tag to identify 
duplicates, and sends it over its two ports in different directions, shown by the red and blue arrows. In a normal, fault-free 
state, the identical frames reach the destination DANH within a certain interval, the destination DANH removes the HSR 
tag, sends the first frame up the stack to the destination application and discards the second frame. If an error occurs in 
one of the network nodes and traffic cannot flow on that path, connectivity is provided through the other direction and 
ensures continuous communication.

Figure 5-100: HSR single-ring configuration example  

A Singly Attached Node, or SAN, such as a computer or printer, is a node with non-redundant network adapters. It uses a 
redundancy box (RedBox) to connect to the ring.

A merging unit (MU), such as the GE MU320, is an interface between analog and digital worlds. With an MU, the analog 
signals from the CTs and VTs in the yard are converted to digital signals and transmitted via the sampled value (SV) 
network communication protocol.

A UR with the Process Bus Module implements either single or dual HSR capability. It supports hierarchical ring topologies, 
such as connected rings, mesh topology, and an HSR ring in a PRP network.

In single HSR configuration, ports 1a and 1b of the Process Bus Module act as DANH, and any other ports on the Process 
Bus Module are disabled. Point-to-point configuration is not available. For single HSR, Process Bus Module 85, 86, or 87 can 
be used.
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In dual HSR configuration, the UR to connect to two independent HSR rings. Ports 1a and 1b form one DANH node, and 
ports 3a and 3b form the second DANH node. Any other ports on the module are disabled. Traffic from HSR-1 ring is not 
forwarded to the HSR-2 ring and vice versa. The UR does not facilitate any message communication between the two 
independent HSR rings. In dual HSR, with four ports required, a Process Bus Module with order code 86 or 87 can be used.

While the UR does not provide RedBox functionality, an HSR ring can be connected to a PRP network using two RedBoxes, 
one for each redundant LAN of the PRP network. The RedBoxes are configured to handle PRP frames on the interlinks and 
HSR frames on the HSR ring. As per the IEC 62439-3:2016 standard, up to seven PRP networks can be connected to the 
same HSR ring.

While the UR does not provide QuadBox functionality, a QuadBox can be added to interconnect two HSR rings, which is 
beneficial when traffic on a single ring exceeds the ring’s capability.

Figure 5-101: Dual HSR, double-ring configuration example 

5.6.3  General
These settings are available in the software only. The path is Settings > Process Bus Module > General.

UR DANH (Source)

HSR Ring 2HSR Ring 1
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Figure 5-102: Process Bus Module network settings (PRP example shown)

Restart the relay after changing these settings, under Maintenance > Reboot Relay Command.

Network Config
Range: INDEPENDENT, PRP, HSR, Dual HSR
Default: INDEPENDENT

This setting specifies the network configuration and redundancy for the Process Bus Module.

If set to INDEPENDENT, all ports on the Process Bus Module are enabled, and the Process Bus Module can be connected 
directly to merging units (MUs) or to a switch without redundancy. To enable and disable individual ports on the Process 
Bus Module in a point-to-point (PPP) network, use the Port x Function settings.

If set to PRP or HSR, ports 1a and 1b are enabled. The Port 1a Function and Port 1b Function settings change.

If set to Dual HSR, ports 1a and 1b are enabled for one HSR ring, and when using a Process Bus Module with order codes 
86 or 87 then ports 3a and 3b are enabled for another HSR ring. The Port x Function settings change.

PRP Supv Mcst Addr
Range: 01 15 4E 00 01 00 to 01 15 4E 00 01 FF
Default: 01 15 4E 00 01 00

This setting changes the multicast address used by the Parallel Redundancy Protocol (PRP) supervision frames. 
Configure all DANP devices in the PRP network with the same multicast address for the network supervision to operate 
properly. This setting is editable when the Network Config setting is set to PRP.

HSR-1 Supv Mcst Addr
Range: 01 15 4E 00 01 00 to 01 15 4E 00 01 FF
Default: 01 15 4E 00 01 00

This setting changes the multicast address used by High-Availability Seamless Redundancy ring one (HSR-1 ports 1a and 
1b) supervision frames, for single HSR configuration. Configure all DANH devices in the HSR network with the same 
multicast address for the network supervision to operate properly. This setting is editable when the Network Config 
setting is set to HSR or Dual HSR.

HSR-2 Supv Mcst Addr
Range: 01 15 4E 00 01 00 to 01 15 4E 00 01 FF
Default: 01 15 4E 00 01 01

This setting changes the multicast address used by the HSR-2 (ports 3a and 3b) supervision frames for the second DANH 
in a Dual HSR configuration. Configure all DANH devices in the HSR network with the same multicast address for the 
network supervision to operate properly. This setting is editable when the Network Config setting is set to Dual HSR.
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Port 1a to 4b Function
Range: Disabled, Enabled
Default: Disabled

These settings manually enable and disable Process Bus Module Ethernet ports. Typically, Process Bus Module ports are 
order-code dependent, and the INDEPENDENT network configuration enables all the ports by default, changing the 
settings shown here. These settings allow individual ports to be enabled and disabled. For example, to connect only a 
few of the ports, other ports can be disabled to avoid a PBEthPort-# Offline self-test error.

The fields active depend on order code and Network Config setting. For order codes 85 and 86, ports 1a, 1b, 3a, and 3b 
are available to be turned on or off. For order code 87, all eight ports are available to be turned on or off.

When a port is disabled, all transmitting and receiving traffic on the port is blocked.

Relay restart is not required when changing these port function fields.

SV Delay Alarm
Range: 1.0 ms to 10.0 ms in steps of 0.1 ms
Default: 6.0 ms

The sampled value (SV) frames can arrive with a delay from the MUs, which can be due to the MU performance or 
different network path delays. This setting specifies the maximum delay expected between the time a sample is taken at 
the MU and the time of arrival of that SV message, where sampling time is estimated based on the UR Process Bus 
Module clock and the sampling rate. If the calculated frame delay is more than this setting value, the RxSV# Delay Alarm 
FlexLogic operand asserts. The setting value needs to be calibrated and set at the commissioning time for the given 
network topology. An alarm in runtime indicates the network performance is degrading over the time. In short, this 
setting specifies how long the UR waits to declare that a sample is delayed. Protection is not blocked by this setting.

SmpSynch Check
Range: Global, Local, Any
Default: Global

This setting is a time synchronization check. It specifies the time synchronization source of an SV stream (SmpSynch 
attribute value in an SV message header) expected by the UR Process Bus Module.

Set it to Global to accept all the SV streams with SmpSynch indicating a Global (2) value. The time synchronization source 
of the UR and the MU must be the same clock and strongly recommended to be Global. A stream with a SmpSynch value 
other than Global (2) is rejected.

Set it to Local or Any for testing purposes when a time source is not available. That is, the UR is not protecting or 
controlling online power equipment in service.

When set to Local, all SV streams with SmpSynch indicating a Local (1) or Global (2) area clock are accepted.

When set to Any, any SmpSynch value in the range of 0 to 254 is acceptable (0 to 127 for UR 7.80), and streams outside 
the range are rejected.

If the Process Bus Module is using a time reference from the reference stream (specified by the SV Sync Stream setting), 
the reference stream shall qualify for the above checks and if the rest of the streams report SmpSynch value other than 
the reference, the corresponding RxSV# SynChk Fail operand is set and the stream is discarded.

Quality Check
Range: Reject Questionable, Accept Questionable
Default: Reject Questionable

Flags are used to assess quality of sampled value data to ensure protection. This setting specifies how the sampled 
values are processed by the UR when the associated q.validity is set to Questionable.

When set to Reject Questionable, the questionable data is treated the same as Invalid and the frame is rejected. Only 
Good quality data is accepted.

The UR is expected to be synchronized to the same time source as the MUs. Therefore, this setting must be Global 
when the UR is in service. The SmpSynch in the SV subscriber UR needs to be exactly the same as the MUs that are 
SV publishers. If the same time source is not used, this can cause undesired operation of the protection and control 
functions. For testing and non-operational cases, set the UR to Local or Any.
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Set it to Accept Questionable only if it is absolutely known that questionable quality from a MU is not compromising the 
quality of the data for various applications. When set to Accept Questionable, the Good and Questionable quality data 
are accepted.

Anti-Aliasing Filter
Range: Disabled, Enabled
Default: Enabled

This setting activates or deactivates the anti-aliasing filter, which conditions the sampled values from the Process Bus 
Module network.

The default value of Enabled is recommended, unless all the subscribed MUs use the Anti-Aliasing Filter for signal 
conditioning. When Enabled, the device applies a low-pass-filter and cuts-off all the harmonics above the 5th order 
harmonics. The protection and control functions utilize up to the 5th harmonics, beyond which the metering accuracy of 
harmonics and THD cannot be ensured.

Set the filter to Disabled only if harmonics and THD measurement accuracy are required and the performance and 
accuracy of the UR is tested with the MU.

SV  Sync Stream
Range: Disabled, AC Bank 1 Phase, AC Bank 1 Phase Only
Default: Disabled

In order for the F60 to successfully subscribe to multiple SV streams, the Process Bus Module needs to be synchronized 
either from a master clock (PTP on Process Bus Module, PTP on main CPU, or IRIG-B) or from a reference stream’s clock 
(1PPS signal generated based on the reference stream SmpCnt). 

If the Process Bus Module looses the clock synchronization from the master clock for three seconds, the configured 
reference SV stream is used as the time source for the Process Bus Module and the rest of the subscribed merging unit 
streams are checked if they are synchronized to the same master clock as that of the reference stream.

This setting specifies the SV stream that the F60 uses for time reference in case time synchronization fails. When set to 
either AC Bank 1 Phase or AC Bank 2 Phase, the respective AC Bank's current active stream (referred to as the reference 
stream) is used as the time reference. If the Process Bus Module loses the clock synchronization from master clock for a 
period of three seconds and SV Sync Stream is set to "AC Bank 1 Phase," configured reference SV stream (referred to as 
reference stream) is used as the time source for the Process Bus Module and the rest of the subscribed merging unit 
streams are checked if they are synchronized to the same master clock as that of reference stream. AC Bank 1 Phase 
sets synchronization of the sample value from either from PTP PPS from the main CPU or the sampled value stream itself. 
When both are available, the PTP PPS has higher priority.

If SV Sync Stream is set to "AC Bank 1 Phase Only," the Process Bus Module clock does not use or switch to the master 
clock and exclusively uses the stream as time source. In other words, AC Bank 1 Phase Only allows synchronization from 
the sampled value stream only.

See the Crosschecking setting description later for information on the current active stream used by the AC bank. 

When synchronized to a reference stream, the Process Bus Module checks if the rest of the active streams used by the 
configured AC banks are synchronized to the same master clock. SV streams that do not have the same SmpSynch 
value as the reference SV stream are discarded. 

When set to Disabled, if the Process Bus Module looses time synchronization, protection functions are blocked. It is 
strongly recommended to configure this SV Sync Stream setting to the critical AC bank’s phase, for protection 
availability when time synchronization fails.

When set to AC Bank 1 Phase or AC Bank 1 Phase Only, the Process Bus Module uses the respective bank's current active 
stream as the time source when the time synchronization fails. During this condition, all the MU streams required to be 
synchronized use the same clock and the SmpSynch value shall match the reference stream. As the Process Bus Module 
clock synchronizes to the stream, a stream delay alarm indicates that the relative time difference between the stream 
and the reference stream is exceeding the configured SV delay alarm setting value. The alarm is never raised for the 
reference stream.

While the Process Bus Module is synchronized to a reference SV stream, 87L function in L90 and PMU synchrophasor 
functionalities are blocked.
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While the Process Bus Module is synchronized to a reference stream, if the corresponding AC Bank is switched to an 
alternate channel (new reference stream), protection is blocked for three seconds to allow stabilization of a pulse per 
second (PPS) generated by the new reference stream.

If the reference stream is lost or rejected or if the reference stream has SmpSynch value "0," the rest of the frames are 
discarded. If the reference RxSV# is in disabled state, the behavior is the same as "Time Sync Source" set to Disabled.

When the Process Bus Module receives a time signal from a master clock for four continuous seconds, the Process Bus 
Module clock switches back to the master clock, unless SV Sync Stream is set to "AC Bank 1 Phase Only." While 
switching, if the deviation between one PPS signal generated by the reference SV stream and master clock is more than 
16 micro seconds, protection functions are blocked for approximately two power cycles to avoid false tripping due to 
measurement errors.

5.6.4  Time synchronization
This function is not supported at this time.

5.6.5  SV Stream Config
The UR platform can subscribe up to eight sampled value (SV) streams. Up to six banks and up to six sources can be used 
for protection.

Reception of a sampled value (RxSV) can be enabled in the IEC 61850-9-2LE or IEC 61869-9/13 format.

These settings are available in the software only. They also can be configured in the software using a CID file.

The path is Settings > Process Bus Module > SV Stream Config. If a message displays that the data cannot be opened, it 
can mean that access timed out; try again.

Figure 5-103: Sampled values settings window
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Figure 5-104: Another example of sampled values configuration

The configuration window is explained as follows:

• The four areas of the window (RxSV Streams, Advanced Config, AC Banks, and Sources) collapse and expand by 
clicking their buttons

• With EC 61869-9, the Advanced Config fields populate and are read-only when importing a file

• Rules are enforced and the configuration cannot be saved until the rules are followed. For example, Neutral Origin 1 
and Neutral Origin 2 cannot be mapped to the same SV stream. See the troubleshooting section that follows.

• The window is configured based on the separate areas and not based on columns. For example, stream RxSV1 is 
configured in the SV Messages area of the window, not the first column in the entire window. Or for example, Source1 
in the first column can be configured to use AC Bank B2 in the second column.

• The following example shows that Source1 is set to map to AC Bank B2, which is mapped to the first stream (RxSV1) 
and its available VT1 phase voltage and VT2 neutral voltage.
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Figure 5-105: Understanding SV configuration

An example of the configuration process is as follows:

1. Configure SV streams by importing an MU CID file. This populates the SV Messages part of the window.

2. Configure the Sources fields.

3. Map the AC Bank fields to the RxSV stream fields.

4. Troubleshoot using the messages displayed during configuration and/or upon save so that the rules are followed. 
Saving frequently during configuration helps to deal with issues early.

5. Restart the relay for the changes to take effect.

The table outlines mapping examples using CT channels. VT channels are similar.

Table 5-24: CT configuration mapping examples

Scenario AC Bank configuration Advanced Config configuration

No CT signal in the SV stream --- ---

One neutral Neutral Origin 1 = RxSV1-CT1/NTR CT1-N maps to AC1

Two neutrals Neutral Origin 1 = RxSV1-CT1/NTR
Neutral Origin 2 = RxSV2-CT2/NTR

CT1-N maps to AC1
CT2-N maps to AC2

Three phases Phase Origin 1 = RxSV1-CT1/PHS CT1-A, B, C map to AC1, 2, 3
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Figure 5-106: Example three phases, one neutral, then three phases and one neutral

Three phases followed by one neutral Phase Origin 1 = RxSV1-CT1/PHS
Neutral Origin 1 = RxSV1-CT1/NTR

CT1-A, B, C, N map to AC1, 2, 3, 4

One neutral followed by three phases Neutral Origin 1 = RxSV1-CT1/NTR
Phase Origin 1 = RxSV1-CT2/PHS

CT1-N maps to AC1
CT2-A, B, C map to AC2, 3, 4

One neutral followed by three phases, then 
followed by one neutral

Neutral Origin 1 = RxSV1-CT1/NTR
Phase Origin 1 = RxSV1-CT2/PHS
Neutral Origin 2 = RxSV2-CT2/NTR

CT1-N maps to AC1
CT2-A, B, C, N map to AC2, 3, 4, 5

Three phases followed by one neutral, then 
another neutral

Phase Origin 1 = RxSV1-CT1/PHS
Neutral Origin 1 = RxSV1-CT1/NTR
Neutral Origin 2 = RxSV2-CT2/NTR

CT1-A, B, C, N map to AC1, 2, 3, 4
CT2-N maps to AC5

Two three-phases Phase Origin 1 = RxSV1-CT1/PHS
Phase Origin 2 = RxSV2-CT2/PHS

CT1-A, B, C map to AC1, 2, 3
CT2-A, B, C map to AC4, 5, 6

Three phases followed by one neutral, then 
another three phases

Phase Origin 1 = RxSV1-CT1/PHS
Neutral Origin 1 = RxSV1-CT1/NTR
Phase Origin 2 = RxSV2-CT2/PHS

CT1-A, B, C, N map to AC1, 2, 3, 4
CT2-A, B, C map to AC5, 6, 7

Three phases followed by another three phases, 
then one neutral

Phase Origin 1 = RxSV1-CT1/PHS
Phase Origin 2 = RxSV2-CT2/PHS
Neutral Origin 2 = RxSV2-CT2/NTR

CT1-A, B, C map to AC1, 2, 3
CT2-A, B, C, N map to AC4, 5, 6, 7

Three phases, one neutral, then another three 
phases and one neutral.
See the following figure.

Phase Origin 1 = RxSV1-CT1/PHS
Neutral Origin 1 = RxSV1-CT1/NTR
Phase Origin 2 = RxSV2-CT2/PHS
Neutral Origin 2 = RxSV2-CT2/NTR

CT1-A, B, C, N map to AC1, 2, 3, 4
CT2-A, B, C, N map to AC5, 6, 7, 8

Scenario AC Bank configuration Advanced Config configuration
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5.6.5.1  Logic
The logic diagram follows.

Figure 5-107: SV stream logic diagram 

SV streams are accepted based on the following settings that need to match the MU:

• SmpSynch Check — Time synchronization check outlined earlier in the General section

• Quality Check — Outlined earlier

• svID — Multicast Sampled Value Identification of a stream

• Dst MAC — Destination Media Access Control address on the header of the SV message

• ConfRev — When the configuration revision is non-zero, the UR accepts the frame when it matches its configured 
value

Each qualified SV stream (that is, with matching svID, Dst MAC, and ConfRev) that is mapped to any of the AC Banks is 
checked for the SV delay, matching Sim bit, time synchronization source, and quality checks.

When four samples in 1/8th of power cycle duration fail any of these checks, a corresponding FlexLogic operand is 
asserted, with a drop-out timer of one protection pass. The drop-out timer is retriggered each time that the check fails.

The RxSV# Lost FlexLogic operand is set when consecutive 160 samples are lost, and the stream is declared lost.

The RxSV# Off FlexLogic operand is set when the "Miss Sample Algorithm" fails (for example, due to temporary loss of stream 
or stream rejected due to any condition check failure) or the stream is lost, with a drop-out time of 17 protection pass. 
Every miss sample algorithm fail condition for that RxSV# stream retriggers the drop-out timer for the RxSV# Off operand.
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5.6.5.2  Message troubleshooting
Examples for messages displayed are as follows:

• The SvID attribute of RxSV1 is empty — Type a name for the stream in the svID field

• The number of channels being selected for CT2-N...exceed the total allowable 7 CT channels — Set the CT2-N field to 
None, or increase the CT Channels field to 8

• The number of channels being selected for CT inputs...exceeds the total allowable 4 CT channels — The CT Channels 
field is set at 4 and there are entries in the CT2-A/B/C/N fields. Set the latter fields to None or increase the number of 
channels.

• The selected ’RxSV3’ stream is disabled. Configure stream before assigning to AC Bank Phase Origin — Enable the 
RxSV3 stream in its SV Stream field

• The AC Bank 2 assigned to Source 1 is not configured — B2 is set in a Source1 field at the bottom of the window. In the 
AC BANKS area of the window, go to the B2 column, and set one of the fields.

• The AC Bank 2 is a Voltage channel and is assigned to Phase CT of Source 1 — In the Source area of the window, 
change the B2 assignment from Phase CT to VT

• The AC Bank x assigned...is not configured.., — Configure the AC Banks section in the software window before setting 
the field

• The CT channels set of the selected ’RxSV1-CT1’ are not configured — In the Advanced Config section, set the CT fields

5.6.5.3  SV simulation processing
When received SV frames have Sim Bit TRUE, the frame is ignored unless Settings > Simulation > GOOSE&SV > Accept Sim 
GOOSE&SV is set to Enabled. When Enabled

• Once subscribed SV messages with simulation bit TRUE are accepted, subscribed SV messages with simulation bit 
FALSE are ignored and the received SV messages with the simulation bit TRUE are used in place of the actual SV 
messages

• When a SV frame is received with simulation bit TRUE, the FlexLogic operand for the corresponding stream is set 
"RxSV# SimBit On"

• If SV messages with simulation bit TRUE are not received, the RxSv# continues to use the actual SV frames

5.6.5.4  Settings
 The following settings are available.

SV Stream
Range: Disabled, IEC 61850-9-2LE r2-1, IEC 61869-9 ed1.0
Default: Disabled

This setting enables an SV stream and selects the SV frame format, or protocol.

When set to IEC 61850-9-2LE, the UR assumes that the received SV frame references to datasets that comply with IEC 
61850-9-2LE, Table 6: Dataset (PhsMeas1).

When set to IEC 61869-9, the UR assumes that the dataset rules comply with IEC 61869-9 ed1.0 and that the number of 
Application-layer Service Data Units (ASDUs) are user-configurable.

When set to Disabled, the rest of the RxSV# setting fields are read-only default values.

svID
Range: 1 up to 129 Visible String characters
Default: empty string

svID refers to the name of the sampled value packet. The svID field of incoming SV messages must exactly match this 
value for the message to be accepted as a valid RxSV# message. The svID field of the sampled value frame must be 
unique within the system/substation.
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Dst MAC
Range: any valid multicast MAC (12-digit hexadecimal number)
Default: 01-0C-CD-04-00-00

Only received SV messages having a destination Media Access Control (MAC) address equal to this value are accepted as 
valid RxSV# messages.

ConfRev
Range: 0 to 4294967295 in steps of 1
Default: 0

ConfRev refers to configuration revision, which is a count of configuration changes in the SV control block. If the value 
entered here is non-zero, the ConfRev field of incoming SV messages must match this value for the message to be 
accepted as a valid RxSV# message. If the entered value is zero, RxSV# does not check the value received in the ConfRev 
field.

Stream Status

This is an LED status indicator for the corresponding reception of SV streams (RxSV#).

A green LED reflects the RxSV# On FlexLogic operand, meaning that the SV stream is online.

A red LED reflects the RxSV# Off FlexLogic operand, meaning that the SV stream is offline.

An orange LED reflects the RxSV# Lost FlexLogic operand, meaning that the SV stream is completely lost and no SVs are 
received.

When the EnerVista UR Setup software is not online or the stream is disabled, the LED is greyed-out with Not Available, 
or "-NA-" status.

Advanced Configuration

Click the button to display or hide the fields.

These are settings to import an MU CID file and/or support IEC 61869-9 based SV streams, as per Table 902 on Standard 
sample rates. IEC 61869-9 allows flexibility on numbers of current and voltage channels. It can be in one of these 
sequences: A, B, C, N or A, AB, B, BC, C, CA, N. The UR supports up to eight CT channels and up to eight VT channels and 
one or two ASDUs for protection applications. The following settings are active when the SV Stream field is set to IEC 
61869-9, and they also depend on the MU Variant Code.

MU SCL Import

Use this feature to configure SV streams by importing an MU CID file. The setting file comparison with IEC 61869-9-2LE 
configuration is not available. The IEC 61850 Merge feature with IEC 61869-9-2LE is not available.

Upon clicking the Import button and selecting a .cid file, a window appears from which to select the stream to import.

Figure 5-108: Selecting a stream to import from a merging unit CID file

Rules for accepting a CID file include

• The same remote channel cannot be mapped to more than one AC bank channel

• An AC bank channel cannot be mapped to more than one remote channel

• For each AC bank, there are three phase inputs from the same SV control block and all three inputs are configured
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• Phase 1 and Phase 2 inputs are not from the same SV control block

• Phase 1 and Phase 2 aux inputs are not from the same SV control block

• A configured Phase consumes three analog channels and Aux consumes one analog channel, with a maximum of 24 
channels

SvCBRef
Range: 0 up to 129 alphanumeric, underscore, slash, and period characters, beginning with an alpha character
Default: empty string

This field is read-only. When imported, the MU SCL file populates this field. The value is an ObjectReference to the 
publishing control block in the format:

<LDName>/LLN0.<SvCBName>

where <LDName> is the function-related name, if any, of the logical device containing the publishing control block, 
otherwise the product-related name of that logical device, and <SvCBName> is the name of the publishing control block.

When RxSV# is configured manually, the field is empty.

CT Channels
Range: 0 to 8
Default: 4

This setting specifies the number of CT channels available in the subscribed RxSV# message from the publisher MU. The 
CT-1 fields reflect the number selected here. The number of current quantities matches the number specified by the 
Variant Code of the MU.

Typically, a CT channel includes four current channels (three phase-ground currents and one ground/neutral/earth 
current). A current channel is the combination of the current sample value attribute (AmpSv.instMag.i) and the 
subsequent quality attribute (AmpSv.q).

If CT Channels is 4, CT1-A/B/C/N are supported for the stream.

If CT Channels is 8, CT2-A/B/C/N also are supported for the stream.

If CT Channels is 0, no CT channels display for AC input selection.

This setting is read-only and fixed at 4 when an SV Stream is set to IEC 61850-9-2LE.

If a message displays that "the number of channels being selected for CT inputs...exceeds the total allowable 4 CT 
channels," it means that the CT Channels field is set at 4 and there are entries in the CT2-A/B/C/N fields. Set the latter 
fields to None or increase the number of channels.

VT Channels
Range: 0 to 8
Default: 4

This setting specifies the number of VT channels in the subscribed RxSV# message from the publisher MU. Typically, VT 
channels include four voltage channels (three phase-ground voltages and auxiliary voltage). This setting specifies the 
number of voltage channels in the subscribed RxSV# message. The voltage channel is the combination of voltage 
sample value attribute (VolSv.instMag.i) and the corresponding quality attribute (VolSv.q). The VT-1 fields reflect the 
number selected here. The number of voltage quantities matches the number specified by the Variant Code of the 
dataset.

If VT Channels is 4, VT1-A/B/C/N are supported for the stream.

If VT Channels is 8, VT2-A/B/C/ also are supported for the stream.

If VT Channels is 0, no VT channels display for AC input selection.

This setting is read-only and fixed at 4 when an SV Stream is set to IEC 61850-9-2LE.

If a message displays that "the number of channels being selected for VI inputs...exceeds the total allowable 2 VT 
channels," it means that the VT Channels field is set at 2 and there are more than two entries in the VT1-A/B/C/N fields. 
The number of configured VT1 fields needs to match the VT Channels field.
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ASDUs
Range: 1, 2
Default: 1

This setting specifies the number of Application-layer Service Data Units (ASDUs) concatenated in one Application 
Protocol Data Unit (APDU) in the subscribed RxSV# message. When concatenating several ASDUs into one frame, the 
ASDU with the oldest samples is the first one in the frame.

This setting is read-only and set at the default when an SV Stream is set to IEC 61850-9-2LE.

Variant Code

The EnerVista software auto-populates the Variant Code for the RxSV# message based on the settings Sample Rate, the 
number of ASDUs, the number of CT Channels, and the number of VT Channels configured. 

For example, F4800S2I8U0 describes sampled values with 4800 samples per second, two ASDU (samples) per message, 
8 currents, and no voltages.

As another example, F4800S1I8U4 means sampled values with 4800 samples per second, 1 ASDU per message, 8 CT 
channels, and 4 VT channels.

This field is read-only as per IEC 61869-9: 2016, Clause-6.903.2.

CT1-A/B/C
Range: None, AC1 to AC16
Default: AC1/AC2/AC3

This setting specifies the sequence of Analog Channel (per phase) that is mapped to the CT-1 of the corresponding 
stream. An origin to CT Phase input defines the physical measurement input to the CT bank by mapping specific AC 
inputs from that merging unit (or SV message).

The fields are active when the SV Stream field is set to IEC 61869-9. The CT1 phases are available if the number of CT 
Channels is 4 or below. CT2 is added if CT Channels is 5 or higher.

The fields are set to the defaults and are read-only when the SV Stream field is set to IEC 61850-9-2LE.

CT1- N
Range: None, AC1 to AC16
Default: AC4

This setting specifies the Analog Channel that is mapped to the CT ground/neutral input. An origin to CT1-N input 
defines the physical measurement input to the CT bank by mapping specific AC inputs from that MU (or SV message). If 
the MU does not publish any CT1-N inputs, configure the setting as None.

In the EnerVista software, the CT Aux input setting only populates the current channels of that RxSV#.

This CT Aux input setting is active when the SV Stream field is set to IEC 61869-9.

This CT Aux input setting is set to AC4 and is read-only when the SV Stream is set to IEC 61850-9-2LE.

VT1-A/B/C
Range: None, AC1 to AC16
Default: AC5/AC6/AC7

This setting specifies the Analog Channel (per phase) that is mapped to the VT1- phase inputs. An origin to VT Phase 
input defines the physical measurement input to the VT bank by mapping specific AC inputs from that MU (or SV 
message). If the MU does not publish any VT channels, configure the setting as None.

The VT1 phase fields are active when the SV Stream field is set to IEC 61869-9. The VT1 phases are available if the 
number of VT Channels is 4 or below. VT2 is added if VT Channels is 5 or higher.

The fields are set to the defaults and are read-only when the SV Stream field is set to IEC 61850-9-2LE.

VT1-N
Range: None, AC1 to AC16
Default: AC8

This setting specifies the Analog Channel that is mapped to the VT Aux/neutral input. An origin to VT input defines the 
physical measurement input to the VT bank by mapping specific AC inputs from that MU (or SV message). If the MU does 
not publish any VT1-N inputs, configure the setting as None.
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In the EnerVista software, the VT Aux input setting only populates the voltage channels of that RxSV#.

The VT1-N input setting is active when the SV Stream field is set to IEC 61869-9.

The VT1-N input setting is set to the default and is read-only when the SV Stream field is set to IEC 61850-9-2LE.

AC BANKS

The UR platform supports up to six AC Banks. They can be CT or VT banks (similar to SETTINGS  SYSTEM SETUP  AC 
INPUTS  CURRENT/VOLTAGE BANK). In addition, bank level redundancy (that is, Origin-1 and Origin-2) is supported using 
crosschecking of each channel signal received from two different SV streams that are connected to the same electrical 
point on the primary power system. A maximum 24 channels can be configured to the AC Banks.

Click the button to display or hide the fields.

The following settings are available for each AC bank.

For changes in this section, restart the relay, for example using Maintenance > Reboot Relay Command.

Phase Origin 1, 2
Range: None, RxSV1-CT1/PHS, RxSV1-VT1/PHS to RxSV8-CT1/PHS, RxSV8-VT1/PHS
Default: None

Either Phase CT or VT channels can be assigned to a bank.

An origin to an AC bank defines the physical measurement input to the bank by mapping specific AC inputs from a 
specific MU to the bank.

The UR Process Bus Module provides for the reliability of AC values for protection, metering, and oscillography by 
allowing duplicate origins of AC data. An origin is considered unavailable when set to None. If origin 1 is available, the 
relay uses the values from origin 1 for protection, metering, and oscillography. Otherwise if origin 2 is available, the relay 
uses the values from origin 2. If both origins are unavailable, then the bank AC values are forced to zero to prevent 
ambiguity of measurement.

See the Crosschecking setting for information regarding automatic protection blocking possibilities on loss of one or 
both origins.

The two-phase origins in an AC bank must be of the same type and connected to the same electrical point in the primary 
power system. The two origins must be two currents with the same CT settings, or two voltages with the same VT 
settings. The current/voltage type of the phase and auxiliary origins must also match on each AC bank. It is intended 
that the origin AC inputs measure the same primary quantity with the same ratio. The same ratio and connection 
settings are applied to both origins.

Neutral Origin 1, 2
Range: None, RxSV1-CT1/NTR, RxSV1-VT1/ NTR to RxSV8-CT1/NTR, RxSV8-VT1/ NTR
Default: None

These settings specify the field units that are the origins of the auxiliary input IN or VN. Duplicate auxiliary origins are 
supported in the same way as phase origins.

The two auxiliary origins in an AC bank must be of the same type. The two origins must be two currents with the same CT 
secondary setting, or two voltages. The current/voltage type of the phase and auxiliary origins also must match on each 
AC bank. It is intended that the origin AC inputs measure the same primary quantity with the same ratio. The same ratio 
and connection settings are applied to both origins.

Crosschecking
Range: None, Depend Origin-1 Pref, Depend Origin-2 Pref
Default: None

The crosschecking feature allows application-level redundancy by checking between two independent SV streams from 
the same electrical connection of the instrument transformers. In addition to the network redundancy provided by PRP/
HSR, the UR Process Bus Module allows the relay to communicate with redundant merging units.

When set to None, crosschecking is disabled. Use this on a non-protection-critical AC bank, such as one used for a 
synchrocheck voltage. GE strongly recommends setting it to None when redundancy is not supported at the merging 
unit level; otherwise the "ACBank# Orig1(2) In Use" operand status is inaccurate.
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Origin preference is supported in case of discrepancy in dependability mode. This allows testing (secondary injection) or 
replacement of an MU that is configured to non-preferred origin without affecting protection functions since these 
functions are using a preferred origin stream when online. As such, dependability with Origin-1 preference allows 
continued use of Origin-1 in case of discrepancy between both online origin stream sampled values. Similarly, 
dependability with Origin-2 preference allows continued use of Origin-2 in case of discrepancy between both online 
origin stream sampled values.

The table shows how the Crosschecking setting, the availability of AC bank origins, and discrepancy checks determine 
whether protection is blocked. Blocked here means only protection elements. It does not inhibit metering, actual values, 
oscillography, or other functions. 

When set to Depend Origin-1 Pref, the protection is blocked if there is no good signal from both the Origin-1 and Origin-2 
sources. When both the merging unit sources are good, the preference is given always for Origin-1. When the preferred 
MU sources fails, the alternate MU source is used for protection and measurement.

When set to Depend Origin-2 Pref, the protection is blocked if there is no good signal from both the Origin-1 and Origin-2 
sources. When both the merging unit sources are good, the preference is given always for Origin-2. When the preferred 
MU sources fails, the alternate MU source is used for protection and measurement.

Table 5-25: Crosschecking and protection behavior

Each Phase Origin setting consumes three phase channels Ia/Va, Ib/Vb, or Ic/Vc, and a Neutral Origin setting consumes 
one ground or Aux Channel In/Vn, which means that

• An AC Bank with Phase Origin1 and Neutral Origin1 settings configured consumes four channels

• An AC Bank with both Phase Origin 1 and Phase Origin 2 and both Neutral Origin 1 and Neutral Origin 2 settings 
configured consumes eight channels

A maximum of 24 channels can be configured to the AC Banks.

Phase/Ground CT Primary
Range: 1 to 65000 A insteps of 1
Default: 1

Enter the rated CT primary current value in Amperes. For 1000:5 and 1000:1 CTs, enter 1000.

Phase/Ground CT Secondary
Range: 1A, 5A
Default: 1A

Enter the rated CT secondary current value in Amperes. For correct operation, the CT secondary rating must match the 
setting (that must also correspond to the specific CT connections used).

While switching from a preferred to non-preferred channel, the protection functions are delayed for two cycles. 
While switching back to a preferred channel, the protection functions are delayed for one cycle.

Crosschecking 
setting

Origin-1 RxSV stream 
status

Origin-2 RxSV 
stream status

Discrepancy check Protection operation

None Not relevant Not relevant No check Normal

Depend Origin-1 
Pref

Not mapped Not mapped No check Normal

Online Online OK / discrepant Normal using Origin-1 stream

Online Offline No check Normal using Origin-1 stream

Offline Online No check Normal using Origin-2 stream

Offline Offline No check Blocked

Depend Origin-2 
Pref

Not mapped Not mapped No check Normal

Online Online OK / discrepant Normal using Origin-2 stream

Online Offline No check Normal using Origin-1 stream

Offline Online No check Normal using Origin-2 stream

Offline Offline No check Blocked
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SOURCES
Click the button to display or hide the fields.

Name
Range: up to 20 alphanumeric characters
Default: SRC 1

This setting specifies an alphanumeric name for the source.

Phase CT
Range: None, B1, B2, B3, B4, B5, B6, B1+B2, ... B1+B2+B3+B4+B5+B6
Default: None

This setting selects the phase CTs of an AC bank or the sum of the phase CTs of multiple AC banks to be the phase 
current of the source. That is, it select the AC Banks section above in the window.

If you see the message "the AC Bank x assigned...is not configured..," it means that you need to configure the AC Banks 
section in the software window before setting this field. The AC Bank selected can match the Origins fields and Sources, 
such as a Phase CT set at B1 with Phase Origin 1 RxSV1-CT1/PHS and source SRC1. Another example is to use Phase CT 
set at B2 with Phase Origin 1 RxSV2-CT1/PHS and source SRC2.

Ground CT
Range: None, B1, B2, B3, B4, B5, B6, B1+B2, ... B1+B2+B3+B4+B5+B6
Default: None

This setting selects the ground CTs of an AC bank or the sum of the ground CTs of multiple AC banks to be the ground 
current of the source. That is, it selects the AC Banks section above in the window.

Phase VT
Range: None, B1, B2, B3, B4, B5, B6
Default: None

This setting selects the phase VTs of an AC bank to be the phase voltages of the source.

Aux VT
Range: None, B1, B2, B3, B4, B5, B6
Default: None

This setting selects the auxiliary VT input of an AC bank to be the auxiliary voltage of the source.

5.7  FlexLogic

5.7.1  FlexLogic operands
For flexibility, the arrangement of internal digital logic combines fixed and user-programmed parameters. Logic upon 
which individual features are designed is fixed, and all other logic, from contact input signals through elements or 
combinations of elements to contact outputs, is variable. The user has complete control of all variable logic through 
FlexLogic. In general, the system receives analog and digital inputs that it uses to produce analog and digital outputs. The 
figure shows major subsystems of a generic UR-series relay involved in this process.
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Figure 5-109: UR architecture overview 

The states of all digital signals used in the F60 are represented by flags (or FlexLogic operands, which are described later in 
this section). A digital “1” is represented by a set flag. Any external contact change-of-state can be used to block an 
element from operating, as an input to a control feature in a FlexLogic equation, or to operate a contact output. The state 
of the contact input can be displayed locally or viewed remotely via the communications facilities provided. If a simple 
scheme where a contact input is used to block an element is wanted, this selection is made when programming the 
element. This capability also applies to the other features that set flags: elements, virtual inputs, remote inputs, schemes, 
and human operators.

If more complex logic than shown in the figure is required, it is implemented via FlexLogic. For example, to have the closed 
state of contact input H7a and the operated state of the phase undervoltage element block the operation of the phase 
time overcurrent element, the two control input states are programmed in a FlexLogic equation. This equation ANDs the 
two control inputs to produce a virtual output that is then selected when programming the phase time overcurrent to be 
used as a blocking input. Virtual outputs can only be created by FlexLogic equations.

Traditionally, protective relay logic has been relatively limited. Any unusual applications involving interlocks, blocking, or 
supervisory functions had to be hard-wired using contact inputs and outputs. FlexLogic minimizes the requirement for 
auxiliary components and wiring while making more complex schemes possible.

The logic that determines the interaction of inputs, elements, schemes, and outputs is field-programmable through the use 
of logic equations that are sequentially processed. The use of virtual inputs and outputs in addition to hardware is 
available internally and on the communication ports for other relays to use (distributed FlexLogic).

FlexLogic allows users to customize the relay through a series of equations that consist of operators and operands. The 
operands are the states of inputs, elements, schemes, and outputs. The operators are logic gates, timers, and latches (with 
set and reset inputs). A system of sequential operations allows any combination of operands to be assigned as inputs to 
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specified operators to create an output. The final output of an equation is a numbered register called a virtual output. 
Virtual outputs can be used as an input operand in any equation, including the equation that generates the output, as a 
seal-in or other type of feedback.

A FlexLogic equation consists of parameters that are either operands or operators. Operands have a logic state of 1 or 0. 
Operators provide a defined function, such as an AND gate or a Timer. Each equation defines the combinations of 
parameters to be used to set a Virtual Output flag. Evaluation of an equation results in either a 1 (=ON, or flag set) or 0 
(=OFF, or flag not set). Each equation is evaluated at least four times every power system cycle.

Some types of operands are present in the relay in multiple instances, for example contact and remote inputs. These types 
of operands are grouped together (for presentation purposes only) on the front panel display. The table lists characteristics 
of the different types of operands.

Table 5-26: F60 FlexLogic operand types

The following table lists the operands available for the relay. The operands can be viewed online by entering the IP address 
of the relay in a web browser and accessing the Device Information Menu.

Operand type State Example of format Characteristics
[Input Is ‘1’ (= ON) if...]

Contact Input On Cont Ip On Voltage is applied presently to the input (external contact 
closed)

Off Cont Ip Off Voltage is not applied presently to the input (external 
contact open)

Contact Output
(type Form-A contact 
only)

Contact Closed Cont Op 1 Closed Contact output is closed

Current On Cont Op 1 Ion Current is flowing through the contact

Voltage On Cont Op 1 VOn Voltage exists across the contact

Voltage Off Cont Op 1 VOff Voltage does not exist across the contact

Direct Input On DIRECT INPUT 1 On The direct input is presently in the ON state

Element
(Analog)

Pickup PHASE TOC1 PKP The tested parameter is presently above the pickup setting 
of an element that responds to rising values or below the 
pickup setting of an element that responds to falling values

Dropout PHASE TOC1 DPO This operand is the logical inverse of the above PKP 
operand

Operate PHASE TOC1 OP The tested parameter has been above/below the pickup 
setting of the element for the programmed delay time, or 
has been at logic 1 and is now at logic 0 but the reset timer 
has not finished timing

Block PHASE TOC1 BLK The output of the comparator is set to the block function

Element
(Digital)

Pickup Dig Element 1 PKP The input operand is at logic 1

Dropout Dig Element 1 DPO This operand is the logical inverse of the above PKP 
operand

Operate Dig Element 1 OP The input operand has been at logic 1 for the programmed 
pickup delay time, or has been at logic 1 for this period and 
is now at logic 0 but the reset timer has not finished timing

Element
(Digital Counter)

Higher than Counter 1 HI The number of pulses counted is above the set number

Equal to Counter 1 EQL The number of pulses counted is equal to the set number

Lower than Counter 1 LO The number of pulses counted is below the set number

Fixed On On Logic 1

Off Off Logic 0

RxGOOSE Boolean On RxGOOSE Boolean 1 On The RxGOOSE Boolean is presently in the ON state

Virtual Input On Virt Ip 1 On The virtual input is presently in the ON state

Virtual Output On Virt Op 1 On The virtual output is presently in the set state (that is, 
evaluation of the equation that produces this virtual output 
results in a "1")
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Table 5-27: F60 FlexLogic operands

Operand type Operand syntax Operand description

ANNUNCIATOR
Graphical front panel

ANY ANCTR ABNORMAL

ANY ANCTR ALARMED

On for one second when any annunciator window state changes from 
normal to abnormal
On while any annunciator window state is abnormal

CONTROL 
PUSHBUTTONS
Enhanced and basic 
front panels

CONTROL PUSHBTN 1 ON
CONTROL PUSHBTN 2 ON
CONTROL PUSHBTN 3 ON
CONTROL PUSHBTN 4 ON
CONTROL PUSHBTN 5 ON
CONTROL PUSHBTN 6 ON
CONTROL PUSHBTN 7 ON

Control pushbutton 1 is being pressed
Control pushbutton 2 is being pressed
Control pushbutton 3 is being pressed
Control pushbutton 4 is being pressed
Control pushbutton 5 is being pressed
Control pushbutton 6 is being pressed
Control pushbutton 7 is being pressed

CYBERSENTRY ROLE ADMIN ACT
ROLE SUPERVISOR ACT
ROLE ENGINEER ACT
ROLE OPERATOR ACT
ROLE OBSERVER ACT
AUTHENTICATION FAIL
UNAUTH FW ATTEMPT
UNAUTH SETTING WRITE

Administrator role is active and is set to true when that is the case
Supervisor role is active and is set to true when that is the case
Engineer role is active and is set to true when that is the case
Operator role is active and is set to true when that is the case
Observer role is active and is set to true when that is the case
Operand set for Failed Authentication self-test and alarm
Operand set for firmware lock self-test and alarm
Operand set for settings lock self-test and alarm

DIRECT DEVICES DIRECT DEVICE 1On


DIRECT DEVICE 16On
DIRECT DEVICE 1Off


DIRECT DEVICE 16Off

Flag is set, logic=1


Flag is set, logic=1
Flag is set, logic=1


Flag is set, logic=1

DIRECT INPUT/
OUTPUT CHANNEL 
MONITORING

DIR IO CH1 CRC ALARM

DIR IO CH2 CRC ALARM

DIR IO CH1 UNRET ALM

DIR IO CH2 UNRET ALM

The rate of direct input messages received on channel 1 and failing the CRC 
exceeded the user-specified level
The rate of direct input messages received on channel 2 and failing the CRC 
exceeded the user-specified level
The rate of returned direct input/output messages on channel 1 exceeded 
the user-specified level (ring configurations only)
The rate of returned direct input/output messages on channel 2 exceeded 
the user-specified level (ring configurations only)

ELEMENT:
Autoreclose
(per CT bank)

AR1 ENABLED
AR1 RIP
AR1 LO
AR1 BLK FROM MAN CLS
AR1 CLOSE
AR1 SHOT CNT=0
AR1 SHOT CNT=1
AR1 SHOT CNT=2
AR1 SHOT CNT=3
AR1 SHOT CNT=4
AR1 DISABLED

Autoreclose 1 is enabled
Autoreclose 1 is in progress
Autoreclose 1 is locked out
Autoreclose 1 is temporarily disabled
Autoreclose 1 close command is issued
Autoreclose 1 shot count is 0
Autoreclose 1 shot count is 1
Autoreclose 1 shot count is 2
Autoreclose 1 shot count is 3
Autoreclose 1 shot count is 4
Autoreclose 1 is disabled

AR2 to 4 Same set of operands as shown for AR1

ELEMENT:
Auxiliary overvoltage

AUX OV1 PKP
AUX OV1 DPO
AUX OV1 OP

Auxiliary overvoltage element has picked up
Auxiliary overvoltage element has dropped out
Auxiliary overvoltage element has operated

AUX OV2 Same set of operands as shown for AUX OV1

ELEMENT:
Auxiliary 
undervoltage

AUX UV1 PKP
AUX UV1 DPO
AUX UV1 OP

Auxiliary undervoltage element has picked up
Auxiliary undervoltage element has dropped out
Auxiliary undervoltage element has operated

AUX UV2 to 3 Same set of operands as shown for AUX UV1
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ELEMENT:
Breaker flashover

BKR 1 FLSHOVR PKP A
BKR 1 FLSHOVR PKP B
BKR 1 FLSHOVR PKP C
BKR 1 FLSHOVR PKP
BKR 1 FLSHOVR OP A
BKR 1 FLSHOVR OP B
BKR 1 FLSHOVR OP C
BKR 1 FLSHOVR OP
BKR 1 FLSHOVR DPO A
BKR 1 FLSHOVR DPO B
BKR 1 FLSHOVR DPO C
BKR 1 FLSHOVR DPO

Breaker 1 flashover element phase A has picked up
Breaker 1 flashover element phase B has picked up
Breaker 1 flashover element phase C has picked up
Breaker 1 flashover element has picked up
Breaker 1 flashover element phase A has operated
Breaker 1 flashover element phase B has operated
Breaker 1 flashover element phase C has operated
Breaker 1 flashover element has operated
Breaker 1 flashover element phase A has dropped out
Breaker 1 flashover element phase B has dropped out
Breaker 1 flashover element phase C has dropped out
Breaker 1 flashover element has dropped out

BKR 2 FLSHOVR Same set of operands as shown for BKR 1 FLSHOVR

ELEMENT:
Breaker arcing

BKR ARC 1 OP
BKR ARC 1 DPO
BKR ARC 1 MAX OP
BKR ARC 1 MAX DPO
BKR ARC 2 OP
BKR ARC 2 DPO
BKR ARC 2 MAX OP
BKR ARC 2 MAX DPO

Breaker arcing current 1 has operated
Breaker arcing current 1 has dropped out
Breaker arcing current 1 max interrupting current has operated
Breaker arcing current 1 max interrupting current has dropped out
Breaker arcing current 2 has operated
Breaker arcing current 2 has dropped out
Breaker arcing current 2 max interrupting current has operated
Breaker arcing current 2 max interrupting current has dropped out

ELEMENT:
Breaker failure

BKR FAIL 1 RETRIPA
BKR FAIL 1 RETRIPB
BKR FAIL 1 RETRIPC
BKR FAIL 1 RETRIP
BKR FAIL 1 T1 OP
BKR FAIL 1 T2 OP
BKR FAIL 1 T3 OP
BKR FAIL 1 TRIP OP

Breaker failure 1 re-trip phase A (only for 1-pole schemes)
Breaker failure 1 re-trip phase B (only for 1-pole schemes)
Breaker failure 1 re-trip phase C (only for 1-pole schemes)
Breaker failure 1 re-trip 3-phase
Breaker failure 1 timer 1 is operated
Breaker failure 1 timer 2 is operated
Breaker failure 1 timer 3 is operated
Breaker failure 1 trip is operated

BKR FAIL 2 to 4 Same set of operands as shown for BKR FAIL 1

ELEMENT:
Breaker restrike

BRK RESTRIKE 1 OP
BRK RESTRIKE 1 OP A
BRK RESTRIKE 1 OP B
BRK RESTRIKE 1 OP C

Breaker restrike detected in any phase of the breaker control 1 element
Breaker restrike detected in phase A of the breaker control 1 element
Breaker restrike detected in phase B of the breaker control 1 element
Breaker restrike detected in phase C of the breaker control 1 element

Operand type Operand syntax Operand description
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ELEMENT:
Breaker control

BREAKER 1 OFF CMD
BREAKER 1 ON CMD
BREAKER 1 A BAD ST

BREAKER 1 A INTERM

BREAKER 1 A CLSD
BREAKER 1 A OPEN
BREAKER 1 B BAD ST

BREAKER 1 B INTERM

BREAKER 1 B CLSD
BREAKER 1 B OPEN
BREAKER 1 C BAD ST

BREAKER 1 C INTERM

BREAKER 1 C CLSD
BREAKER 1 C OPEN
BREAKER 1 BAD STATUS
BREAKER 1 CLOSED
BREAKER 1 OPEN
BREAKER 1 DISCREP
BREAKER 1 TROUBLE
BREAKER 1 MNL OPEN
BREAKER 1 MNL CLS
BREAKER 1 TRIP A
BREAKER 1 TRIP B
BREAKER 1 TRIP C
BREAKER 1 ANY P OPEN
BREAKER 1 ONE P OPEN
BREAKER 1 OOS
BREAKER 1 TAG ON
BREAKER 1 TAG OFF
BREAKER 1 SUBD CLSD
BREAKER 1 SUBD OPEN
BREAKER 1 BYPASS ON
BREAKER 1 BYPASS OFF
BREAKER 1 BLK RCLS
BREAKER 1 ENA RCLS

Breaker 1 3-pole open command/trip initiated
Breaker 1 close command initiated
Breaker 1 phase A bad status is detected (discrepancy between the 52/a and 
52/b contacts)
Breaker 1 phase A intermediate status is detected (transition from one 
position to another)
Breaker 1 phase A is closed
Breaker 1 phase A is open
Breaker 1 phase B bad status is detected (discrepancy between the 52/a and 
52/b contacts)
Breaker 1 phase B intermediate status is detected (transition from one 
position to another)
Breaker 1 phase B is closed
Breaker 1 phase B is open
Breaker 1 phase C bad status is detected (discrepancy between the 52/a and 
52/b contacts)
Breaker 1 phase C intermediate status is detected (transition from one 
position to another)
Breaker 1 phase C is closed
Breaker 1 phase C is open
Breaker 1 bad status is detected on any pole
Breaker 1 is closed
Breaker 1 is open
Breaker 1 has discrepancy
Breaker 1 trouble alarm
Breaker 1 manual open
Breaker 1 manual close
Breaker 1 trip phase A command
Breaker 1 trip phase B command
Breaker 1 trip phase C command
At least one pole of breaker 1 is open
Only one pole of breaker 1 is open
Breaker 1 is out of service
Breaker 1 tagged so manual trip and close and autoreclose are blocked
Breaker 1 not tagged 
Breaker 1 status manually substituted to closed
Breaker 1 status manually substituted to open
Breaker 1 control interlocking is manually bypassed
Breaker 1 control interlocking is not manually bypassed
Breaker 1 command to manually block autoreclose
Breaker 1 command to manually enable autoreclose

BREAKER 2 to 4 Same set of operands as shown for BREAKER 1

ELEMENT:
Broken conductor

BROKEN CONDUCT 1 OP
BROKEN CONDUCT 1 PKP

Asserted when the broken conductor 1 element operates
Asserted when the broken conductor 1 element picks up

BROKEN CONDUCT 2 Same set of operands as shown for BROKEN CONDUCTOR 1

ELEMENT:
Cold load pickup

COLD LOAD 1 OP Cold load pickup element 1 has operated

COLD LOAD 2 Same set of operands as shown for COLD LOAD 1

ELEMENT:
CT fail

CT FAIL 1 PKP
CT FAIL 1 OP

CT fail has picked up
CT fail has dropped out

CT FAIL 2 to 4 Same set of operands as per CT FAIL 1

ELEMENT:
Digital counters

Counter 1 HI
Counter 1 EQL
Counter 1 LO

Digital counter 1 output is ‘more than’ comparison value
Digital counter 1 output is ‘equal to’ comparison value
Digital counter 1 output is ‘less than’ comparison value

Counter 2 to 8 Same set of operands as shown for Counter 1

ELEMENT:
Directional 
comparison blocking 
scheme (DCB3)

DCB3 TX INIT
DCB3 TX STOP
DCB3 OP

Directional blocking signal is initiated
Directional blocking scheme de-asserts transmit signal
Directional blocking scheme has operated

Operand type Operand syntax Operand description
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ELEMENT:
Digital elements

Dig Element 1 PKP
Dig Element 1 OP
Dig Element 1 DPO

Digital Element 1 is picked up
Digital Element 1 is operated
Digital Element 1 is dropped out

Dig Element 2 to 48 Same set of operands as shown for Dig Element 1

ELEMENT:
Sensitive directional 
power

DIR POWER 1 STG1 PKP
DIR POWER 1 STG2 PKP
DIR POWER 1 STG1 DPO
DIR POWER 1 STG2 DPO
DIR POWER 1 STG1 OP
DIR POWER 1 STG2 OP
DIR POWER 1 PKP
DIR POWER 1 DPO
DIR POWER 1 OP

Stage 1 of the directional power element 1 has picked up
Stage 2 of the directional power element 1 has picked up
Stage 1 of the directional power element 1 has dropped out
Stage 2 of the directional power element 1 has dropped out
Stage 1 of the directional power element 1 has operated
Stage 2 of the directional power element 1 has operated
The directional power element has picked up
The directional power element has dropped out
The directional power element has operated

DIR POWER 2 Same set of operands as DIR POWER 1

ELEMENT:
Frequency rate of 
change

FREQ RATE 1 PKP
FREQ RATE 1 DPO
FREQ RATE 1 OP

The frequency rate of change 1 element has picked up
The frequency rate of change 1 element has dropped out
The frequency rate of change 1 element has operated

FREQ RATE 2 to 4 Same set of operands as shown for FREQ RATE 1

ELEMENT:
FlexElements

FxE 1 PKP
FxE 1 OP
FxE 1 DPO

FlexElement 1 has picked up
FlexElement 1 has operated
FlexElement 1 has dropped out

FxE 2 to 8 Same set of operands as shown for FxE 1

ELEMENT:
Ground 
instantaneous 
overcurrent

GROUND IOC1 PKP
GROUND IOC1 OP
GROUND IOC1 DPO

Ground instantaneous overcurrent 1 has picked up
Ground instantaneous overcurrent 1 has operated
Ground instantaneous overcurrent 1 has dropped out

GROUND IOC2 to 6 Same set of operands as shown for GROUND IOC 1

ELEMENT:
Ground time 
overcurrent

GROUND TOC1 PKP
GROUND TOC1 OP
GROUND TOC1 DPO

Ground time overcurrent 1 has picked up
Ground time overcurrent 1 has operated
Ground time overcurrent 1 has dropped out

GROUND TOC2 to 4 Same set of operands as shown for GROUND TOC1

ELEMENT:
High impedance fault 
detection
(Hi-Z)

HI-Z ARC DETECTED
HI-Z ARC DETECTED-A
HI-Z ARC DETECTED-B
HI-Z ARC DETECTED-C
HI-Z ARC DETECTED-N
HI-Z ARC DETECTED DPO
HI-Z ARMED
HI-Z DISARMED
HI-Z DOWNED COND
HI-Z DOWNED COND-A
HI-Z DOWNED COND-B
HI-Z DOWNED COND-C
HI-Z DOWNED COND-N
HI-Z ARC SUSPECTED
HI-Z ARC SUSPECTED-A
HI-Z ARC SUSPECTED-B
HI-Z ARC SUSPECTED-C
HI-Z ARC SUSPECTED-N
HI-Z IOC A
HI-Z IOC B
HI-Z IOC C
HI-Z LOSS OF LOAD-A
HI-Z LOSS OF LOAD-B
HI-Z LOSS OF LOAD-C

The high impedance fault detection element has operated
The high impedance fault detection phase A element has operated
The high impedance fault detection phase B element has operated
The high impedance fault detection phase C element has operated
The high impedance fault detection neutral element has operated
No arcing has been detected
The high impedance fault detection element is in the armed state
The high impedance fault detection element is in the disarmed state
The high impedance fault downed conductor element has operated
The high impedance fault downed conductor phase A element has operated
The high impedance fault downed conductor phase B element has operated
The high impedance fault downed conductor phase C element has operated
The high impedance fault downed conductor neutral element has operated
The high impedance fault detection arcing suspected element has operated
The high impedance fault arcing suspected phase A element has operated
The high impedance fault arcing suspected phase B element has operated
The high impedance fault arcing suspected phase C element has operated
The high impedance fault arcing suspected neutral element has operated
The high impedance instantaneous overcurrent A element has operated
The high impedance instantaneous overcurrent B element has operated
The high impedance instantaneous overcurrent C element has operated
The high impedance fault phase A loss of load element has operated
The high impedance fault phase B loss of load element has operated
The high impedance fault phase C loss of load element has operated

ELEMENT:
Incipient cable fault 
detection

INCIPNT FLT 1 OP
INCIPNT FLT 1 OP A
INCIPNT FLT 1 OP B
INCIPNT FLT 1 OP C
INCIPNT FLT 1 PKP
INCIPNT FLT 1 PKP A
INCIPNT FLT 1 PKP B
INCIPNT FLT 1 PKP C

Asserted when incipient cable fault detector 1 operates in any phase
Asserted when incipient cable fault detector 1 operates in phase A
Asserted when incipient cable fault detector 1 operates in phase B
Asserted when incipient cable fault detector 1 operates in phase C
Asserted when incipient cable fault detector 1 picks up in any phase
Asserted when incipient cable fault detector 1 picks up in phase A
Asserted when incipient cable fault detector 1 picks up in phase B
Asserted when incipient cable fault detector 1 picks up in phase C

Operand type Operand syntax Operand description
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INCIPNT FLT 2 Same set of operands as shown for INCIPNT FLT 1

ELEMENT:
Non-volatile latches

LATCH 1 ON
LATCH 1 OFF

Non-volatile latch 1 is ON (Logic = 1)
Non-volatile latch 1 is OFF (Logic = 0)

LATCH 2 to 16 Same set of operands as shown for LATCH 1

ELEMENT:
Load encroachment

LOAD ENCHR PKP
LOAD ENCHR OP
LOAD ENCHR DPO

Load encroachment has picked up
Load encroachment has operated
Load encroachment has dropped out

ELEMENT:
Negative-sequence 
directional 
overcurrent

NEG SEQ DIR OC1 FWD
NEG SEQ DIR OC1 REV
NEG SEQ DIR OC2 FWD
NEG SEQ DIR OC2 REV

Negative-sequence directional overcurrent 1 forward has operated
Negative-sequence directional overcurrent 1 reverse has operated
Negative-sequence directional overcurrent 2 forward has operated
Negative-sequence directional overcurrent 2 reverse has operated

ELEMENT:
Negative-sequence 
instantaneous 
overcurrent

NEG SEQ IOC1 PKP
NEG SEQ IOC1 OP
NEG SEQ IOC1 DPO

Negative-sequence instantaneous overcurrent 1 has picked up
Negative-sequence instantaneous overcurrent 1 has operated
Negative-sequence instantaneous overcurrent 1 has dropped out

NEG SEQ IOC2 Same set of operands as shown for NEG SEQ IOC1

ELEMENT:
Negative-sequence 
overvoltage

NEG SEQ OV1 PKP
NEG SEQ OV1 DPO
NEG SEQ OV1 OP

Negative-sequence overvoltage element has picked up
Negative-sequence overvoltage element has dropped out
Negative-sequence overvoltage element has operated

NEG SEQ OV2 to 3 Same set of operands as shown for NEG SEQ OV1

ELEMENT:
Negative-sequence 
time overcurrent

NEG SEQ TOC1 PKP
NEG SEQ TOC1 OP
NEG SEQ TOC1 DPO

Negative-sequence time overcurrent 1 has picked up
Negative-sequence time overcurrent 1 has operated
Negative-sequence time overcurrent 1 has dropped out

NEG SEQ TOC2 Same set of operands as shown for NEG SEQ TOC1

ELEMENT:
Neutral 
instantaneous 
overcurrent

NEUTRAL IOC1 PKP
NEUTRAL IOC1 OP
NEUTRAL IOC1 DPO

Neutral instantaneous overcurrent 1 has picked up
Neutral instantaneous overcurrent 1 has operated
Neutral instantaneous overcurrent 1 has dropped out

NEUTRAL IOC2 to 8 Same set of operands as shown for NEUTRAL IOC1

ELEMENT:
Neutral overvoltage

NEUTRAL OV1 PKP
NEUTRAL OV1 DPO
NEUTRAL OV1 OP

Neutral overvoltage element 1 has picked up
Neutral overvoltage element 1 has dropped out
Neutral overvoltage element 1 has operated

NEUTRAL OV2 to 3 Same set of operands as shown for NEUTRAL OV1

ELEMENT:
Neutral time 
overcurrent

NEUTRAL TOC1 PKP
NEUTRAL TOC1 OP
NEUTRAL TOC1 DPO

Neutral time overcurrent 1 has picked up
Neutral time overcurrent 1 has operated
Neutral time overcurrent 1 has dropped out

NEUTRAL TOC2 to 6 Same set of operands as shown for NEUTRAL TOC1

ELEMENT:
Neutral directional 
overcurrent

NTRL DIR OC1 FWD
NTRL DIR OC1 REV

Neutral directional overcurrent 1 forward has operated
Neutral directional overcurrent 1 reverse has operated

NTRL DIR OC2 Same set of operands as shown for NTRL DIR OC1

ELEMENT:
Overfrequency

OVERFREQ 1 PKP
OVERFREQ 1 OP
OVERFREQ 1 DPO

Overfrequency 1 has picked up
Overfrequency 1 has operated
Overfrequency 1 has dropped out

OVERFREQ 2 to 4 Same set of operands as shown for OVERFREQ 1

ELEMENT:
Synchrophasor 
phasor data 
concentrator

PDC NETWORK CNTRL 1
PDC NETWORK CNTRL 2


PDC NETWORK CNTRL 16

Phasor data concentrator asserts control bit 1 as received via the network
Phasor data concentrator asserts control bit 2 as received via the network


Phasor data concentrator asserts control bit 16 as received via the network

ELEMENT:
Phase directional 
overcurrent

PH DIR1 BLK A
PH DIR1 BLK B
PH DIR1 BLK C
PH DIR1 BLK

Phase A directional 1 block
Phase B directional 1 block
Phase C directional 1 block
Phase directional 1 block

PH DIR2 Same set of operands as shown for PH DIR1

Operand type Operand syntax Operand description
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ELEMENT:
Phase instantaneous 
overcurrent

PHASE IOC1 PKP
PHASE IOC1 OP
PHASE IOC1 DPO
PHASE IOC1 PKP A
PHASE IOC1 PKP B
PHASE IOC1 PKP C
PHASE IOC1 OP A
PHASE IOC1 OP B
PHASE IOC1 OP C
PHASE IOC1 DPO A
PHASE IOC1 DPO B
PHASE IOC1 DPO C

At least one phase of phase instantaneous overcurrent 1 has picked up
At least one phase of phase instantaneous overcurrent 1 has operated
All phases of phase instantaneous overcurrent 1 have dropped out
Phase A of phase instantaneous overcurrent 1 has picked up
Phase B of phase instantaneous overcurrent 1 has picked up
Phase C of phase instantaneous overcurrent 1 has picked up
Phase A of phase instantaneous overcurrent 1 has operated
Phase B of phase instantaneous overcurrent 1 has operated
Phase C of phase instantaneous overcurrent 1 has operated
Phase A of phase instantaneous overcurrent 1 has dropped out
Phase B of phase instantaneous overcurrent 1 has dropped out
Phase C of phase instantaneous overcurrent 1 has dropped out

PHASE IOC2 to 8 Same set of operands as shown for PHASE IOC1

ELEMENT:
Phase overvoltage

PHASE OV1 PKP
PHASE OV1 OP
PHASE OV1 DPO
PHASE OV1 PKP A
PHASE OV1 PKP B
PHASE OV1 PKP C
PHASE OV1 OP A
PHASE OV1 OP B
PHASE OV1 OP C
PHASE OV1 DPO A
PHASE OV1 DPO B
PHASE OV1 DPO C

At least one phase of overvoltage 1 has picked up
At least one phase of overvoltage 1 has operated
All phases of overvoltage 1 have dropped out
Phase A of overvoltage 1 has picked up
Phase B of overvoltage 1 has picked up
Phase C of overvoltage 1 has picked up
Phase A of overvoltage 1 has operated
Phase B of overvoltage 1 has operated
Phase C of overvoltage 1 has operated
Phase A of overvoltage 1 has dropped out
Phase B of overvoltage 1 has dropped out
Phase C of overvoltage 1 has dropped out

PHASE OV2 to 3 Same set of operands as shown for PHASE OV1

ELEMENT:
Phase time 
overcurrent

PHASE TOC1 PKP
PHASE TOC1 OP
PHASE TOC1 DPO
PHASE TOC1 PKP A
PHASE TOC1 PKP B
PHASE TOC1 PKP C
PHASE TOC1 OP A
PHASE TOC1 OP B
PHASE TOC1 OP C
PHASE TOC1 DPO A
PHASE TOC1 DPO B
PHASE TOC1 DPO C

At least one phase of phase time overcurrent 1 has picked up
At least one phase of phase time overcurrent 1 has operated
All phases of phase time overcurrent 1 have dropped out
Phase A of phase time overcurrent 1 has picked up
Phase B of phase time overcurrent 1 has picked up
Phase C of phase time overcurrent 1 has picked up
Phase A of phase time overcurrent 1 has operated
Phase B of phase time overcurrent 1 has operated
Phase C of phase time overcurrent 1 has operated
Phase A of phase time overcurrent 1 has dropped out
Phase B of phase time overcurrent 1 has dropped out
Phase C of phase time overcurrent 1 has dropped out

PHASE TOC2 to 6 Same set of operands as shown for PHASE TOC1

ELEMENT:
Phase undervoltage

PHASE UV1 PKP
PHASE UV1 OP
PHASE UV1 DPO
PHASE UV1 PKP A
PHASE UV1 PKP B
PHASE UV1 PKP C
PHASE UV1 OP A
PHASE UV1 OP B
PHASE UV1 OP C
PHASE UV1 DPO A
PHASE UV1 DPO B
PHASE UV1 DPO C

At least one phase of phase undervoltage 1 has picked up
At least one phase of phase undervoltage 1 has operated
All phases of phase undervoltage 1 have dropped out
Phase A of phase undervoltage 1 has picked up
Phase B of phase undervoltage 1 has picked up
Phase C of phase undervoltage 1 has picked up
Phase A of phase undervoltage 1 has operated
Phase B of phase undervoltage 1 has operated
Phase C of phase undervoltage 1 has operated
Phase A of phase undervoltage 1 has dropped out
Phase B of phase undervoltage 1 has dropped out
Phase C of phase undervoltage 1 has dropped out

PHASE UV2 to 3 Same set of operands as shown for PHASE UV1

ELEMENT:
Synchrophasor 
Phasor Measurement 
Unit (PMU)

PMU Agg 1 SvEng On
PMU 1 CURR TRIGGER
PMU 1 FREQ TRIGGER
PMU 1 POWER TRIGGER
PMU 1 ROCOF TRIGGER

PMU 1 VOLT TRIGGER
PMU 1 TRIGGERED

SvEng data item in associated control block is on
Overcurrent trigger of phasor measurement unit 1 has operated
Abnormal frequency trigger of phasor measurement unit 1 has operated
Overpower trigger of phasor measurement unit 1 has operated
Rate of change of frequency trigger of phasor measurement unit 1 has 
operated
Abnormal voltage trigger of phasor measurement unit 1 has operated
Phasor measurement unit 1 triggered; no events or targets are generated by 
this operand

Operand type Operand syntax Operand description
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ELEMENT:
Synchrophasor one-
shot

PMU ONE-SHOT EXPIRED

PMU ONE-SHOT OP

PMU ONE-SHOT PENDING

Indicates the one-shot operation has been executed, and the present time is 
at least 30 seconds past the scheduled one-shot time
Indicates the one-shot operation and remains asserted for 30 seconds 
afterwards
Indicates the one-shot operation is pending; that is, the present time is before 
the scheduled one-shot time

ELEMENT:
POTT3
(Permissive 
overreach transfer 
trip three pole)

POTT3 OP
POTT3 TX

Permissive over-reaching transfer trip has operated
Permissive over-reaching transfer trip signal sent

ELEMENT:
Restricted ground 
fault

RESTD GND FT1 PKP
RESTD GND FT1 OP
RESTD GND FT1 DPO

Restricted ground fault 1 has picked up
Restricted ground fault 1 has operated
Restricted ground fault 1 has dropped out

RESTD GND FT2 to 4 Same set of operands as shown for RESTD GND FT1

ELEMENT:
Selector switch

SELECTOR 1 POS Y
SELECTOR 1 BIT 0
SELECTOR 1 BIT 1
SELECTOR 1 BIT 2
SELECTOR 1 STP ALARM

SELECTOR 1 BIT ALARM

SELECTOR 1 ALARM
SELECTOR 1 PWR ALARM

Selector switch 1 is in Position Y (mutually exclusive operands)
First bit of the 3-bit word encoding position of selector 1
Second bit of the 3-bit word encoding position of selector 1
Third bit of the 3-bit word encoding position of selector 1
Position of selector 1 has been pre-selected with the stepping up control 
input but not acknowledged
Position of selector 1 has been pre-selected with the 3-bit control input but 
not acknowledged
Position of selector 1 has been pre-selected but not acknowledged
Position of selector switch 1 is undetermined or restored from memory when 
the relay powers up and synchronizes to the three-bit input

SELECTOR 2 Same set of operands as shown for SELECTOR 1

ELEMENT:
Setting group

SETTING GROUP ACT 1
SETTING GROUP ACT 2
SETTING GROUP ACT 3
SETTING GROUP ACT 4
SETTING GROUP ACT 5
SETTING GROUP ACT 6

Setting group 1 is active
Setting group 2 is active
Setting group 3 is active
Setting group 4 is active
Setting group 5 is active
Setting group 6 is active

ELEMENT:
Disturbance detector

SRC1 50DD OP
SRC2 50DD OP
SRC3 50DD OP
SRC4 50DD OP

Source 1 disturbance detector has operated
Source 2 disturbance detector has operated
Source 3 disturbance detector has operated
Source 4 disturbance detector has operated

ELEMENT:
VTFF (Voltage 
transformer fuse 
failure)

SRC1 VT FF OP
SRC1 VT FF DPO
SRC1 VT FF VOL LOSS
SRC1 VT FF ALARM

Source 1 VT fuse failure detector has operated
Source 1 VT fuse failure detector has dropped out
Source 1 has lost voltage signals (V2 below 10% and V1 below 5% of nominal)
Source 1 has triggered a VT fuse failure alarm

SRC1 VT NEU WIRE OPEN Source 1 VT neutral wire open detected. When the VT is connected in Delta, 
do not enable this function because there is no neutral wire for Delta 
connected VT.

SRC2 VT FUSE FAIL to SRC4 Same set of operands as shown for SRC1 VT FF

Operand type Operand syntax Operand description
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ELEMENT:
Disconnect switch

SWITCH 1 OFF CMD
SWITCH 1 ON CMD
SWITCH 1 CLOSED
SWITCH 1 OPEN
SWITCH 1 DISCREP
SWITCH 1 TROUBLE
SWITCH 1 A CLSD
SWITCH 1 A OPEN
SWITCH 1 A BAD ST

SWITCH 1 A INTERM

SWITCH 1 B CLSD
SWITCH 1 B OPEN
SWITCH 1 B BAD ST

SWITCH 1 B INTERM

SWITCH 1 C CLSD
SWITCH 1 C OPEN
SWITCH 1 C BAD ST

SWITCH 1 C INTERM

SWITCH 1 BAD STATUS
SWITCH 1 TAG ON
SWITCH 1 TAG OFF
SWITCH 1 SUBD CLSD
SWITCH 1 SUBD OPEN
SWITCH 1 BYPASS ON
SWITCH 1 BYPASS OFF

Disconnect switch 1 open command initiated
Disconnect switch 1 close command initiated
Disconnect switch 1 is closed
Disconnect switch 1 is open
Disconnect switch 1 has discrepancy
Disconnect switch 1 trouble alarm
Disconnect switch 1 phase A is closed
Disconnect switch 1 phase A is open
Disconnect switch 1 phase A bad status is detected (discrepancy between 
the 89/a and 89/b contacts)
Disconnect switch 1 phase A intermediate status is detected (transition from 
one position to another)
Disconnect switch 1 phase B is closed
Disconnect switch 1 phase B is open
Disconnect switch 1 phase B bad status is detected (discrepancy between 
the 89/a and 89/b contacts)
Disconnect switch 1 phase B intermediate status is detected (transition from 
one position to another)
Disconnect switch 1 phase C is closed
Disconnect switch 1 phase C is open
Disconnect switch 1 phase C bad status is detected (discrepancy between 
the 89/a and 89/b contacts)
Disconnect switch 1 phase C intermediate status is detected (transition from 
one position to another)
Disconnect switch 1 bad status is detected on any pole
Switch 1 tagged so manual trip and close is blocked
Switch 1 not tagged
Switch 1 status manually substituted to closed
Switch 1 status manually substituted to open
Switch 1 control interlocking is bypassed manually
Switch 1 control interlocking is not bypassed manually

SWITCH 2 to 16 Same set of operands as shown for SWITCH 1

ELEMENT:
Synchrocheck

SYNC1 DEAD S OP
SYNC1 DEAD S DPO
SYNC1 SYNC OP
SYNC1 SYNC DPO
SYNC1 CLS OP
SYNC1 CLS DPO
SYNC1 V1 ABOVE MIN
SYNC1 V1 BELOW MAX
SYNC1 V2 ABOVE MIN
SYNC1 V2 BELOW MAX
SYNC1 S-CLOSE OP
SYNC1 S-CLOSE OP DPO
SYNC1 S-CLOSE ARMD

Synchrocheck 1 dead source has operated
Synchrocheck 1 dead source has dropped out
Synchrocheck 1 in synchronization has operated
Synchrocheck 1 in synchronization has dropped out
Synchrocheck 1 close has operated
Synchrocheck 1 close has dropped out
Synchrocheck 1 V1 is above the minimum live voltage
Synchrocheck 1 V1 is below the maximum dead voltage
Synchrocheck 1 V2 is above the minimum live voltage
Synchrocheck 1 V2 is below the maximum dead voltage
Synchrocheck 1 S-CLOSE has operated
Synchrocheck 1 S-CLOSE has dropped out
Synchrocheck 1 S-CLOSE has been armed

SYNC 2 to 4 Same set of operands as shown for SYNC 1

ELEMENT:
Teleprotection 
channel tests

TELEPRO CH1 FAIL
TELEPRO CH2 FAIL
TELEPRO CH1 ID FAIL
TELEPRO CH2 ID FAIL
TELEPRO CH1 CRC FAIL
TELEPRO CH2 CRC FAIL
TELEPRO CH1 PKT LOST
TELEPRO CH2 PKT LOST

Channel 1 failed
Channel 2 failed
The ID check for a peer relay on channel 1 has failed
The ID check for a peer relay on channel 2 has failed
CRC detected packet corruption on channel 1
CRC detected packet corruption on channel 2
CRC detected lost packet on channel 1
CRC detected lost packet on channel 2

ELEMENT:
Teleprotection 
inputs/outputs

TELEPRO INPUT 1-1 On


TELEPRO INPUT 1-16 On
TELEPRO INPUT 2-1 On


TELEPRO INPUT 2-16 On

Flag is set, Logic =1


Flag is set, Logic =1
Flag is set, Logic =1


Flag is set, Logic =1

ELEMENT:
Thermal overload 
protection

THERMAL PROT 1 PKP
THERMAL PROT 1 OP

Thermal overload protection 1 picked up
Thermal overload protection 1 operated

THERMAL PROT 2 Same set of operands as shown for THERMAL PROT 1

ELEMENT:
Trip bus

TRIP BUS 1 PKP
TRIP BUS 1 OP

Asserted when the trip bus 1 element picks up
Asserted when the trip bus 1 element operates

Operand type Operand syntax Operand description



CHAPTER 5: SETTINGS FLEXLOGIC

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-221

5

TRIP BUS 2 to 6 Same set of operands as shown for TRIP BUS 1

ELEMENT:
Underfrequency

UNDERFREQ 1 PKP
UNDERFREQ 1 OP
UNDERFREQ 1 DPO

Underfrequency 1 has picked up
Underfrequency 1 has operated
Underfrequency 1 has dropped out

UNDERFREQ 2 to 6 Same set of operands as shown for UNDERFREQ 1

ELEMENT:
Wattmetric zero-
sequence directional

WATTMETRIC 1 PKP
WATTMETRIC 1 OP

Wattmetric directional element 1 has picked up
Wattmetric directional element 1 has operated

WATTMETRIC 2 Same set of operands as per WATTMETRIC 1

FIXED OPERANDS Off Logic = 0. Does nothing and can be used as a delimiter in an equation list; 
used as ‘Disable’ by other features.

On Logic = 1. Can be used as a test setting.

INPUTS/OUTPUTS:
Contact inputs

Cont Ip 1 On
Cont Ip 2 On


Cont Ip 1 Off
Cont Ip 2 Off


Cont Ip 120 On
Cont Ip 120 Off

(does not appear unless ordered)
(does not appear unless ordered)


(does not appear unless ordered)
(does not appear unless ordered)


(does not appear unless ordered)
(does not appear unless ordered)

INPUTS/OUTPUTS:
Contact outputs, 
current
(from detector on 
form-A output only)

Cont Op 1  IOn
Cont Op 2  IOn


Cont Op 72  IOn

(does not appear unless ordered)
(does not appear unless ordered)


(does not appear unless ordered)

INPUTS/OUTPUTS:
Contact outputs, 
voltage
(from detector on 
form-A output only)

Cont Op 1 VOn
Cont Op 2  VOn


Cont Op 72  VOn

(does not appear unless ordered)
(does not appear unless ordered)


(does not appear unless ordered)

Cont Op 1  VOff
Cont Op 2  VOff


Cont Op 72  VOff

(does not appear unless ordered)
(does not appear unless ordered)


(does not appear unless ordered)

INPUTS/OUTPUTS:
Direct inputs

DIRECT INPUT 1 On


DIRECT INPUT 32 On

Flag is set, logic=1


Flag is set, logic=1

INPUTS/OUTPUTS:
RxGOOSE DPS

RxG DPS 1 BAD
RxG DPS 1 INTERM

RxG DPS 1 OFF
RxG DPS 1 ON

Asserted while the RxGOOSE double-point status input is in the bad state
Asserted while the RxGOOSE double-point status input is in the intermediate 
state
Asserted while the RxGOOSE double-point status input is off
Asserted while the RxGOOSE double-point status input is on

RxG DPS 2 to 5 Same set of operands as per RxG DPS 1

INPUTS/OUTPUTS:
RxGOOSE Booleans

RxG Bool 1 On
RxG Bool 2 On
RxG Bool 3 On


RxG Bool 256 On

Flag is set, logic=1
Flag is set, logic=1
Flag is set, logic=1


Flag is set, logic=1

INPUTS/OUTPUTS:
Virtual inputs

Virt Ip 1 On
Virt Ip 2 On
Virt Ip 3 On


Virt Ip 64 On

Flag is set, logic=1
Flag is set, logic=1
Flag is set, logic=1


Flag is set, logic=1

INPUTS/OUTPUTS:
Virtual outputs

Virt Op 1  On
Virt Op 2  On
Virt Op 3  On


Virt Op 96  On

Flag is set, logic=1
Flag is set, logic=1
Flag is set, logic=1


Flag is set, logic=1

Operand type Operand syntax Operand description
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LED INDICATORS:
Enhanced and basic 
front panels

LED IN SERVICE
LED TROUBLE
LED TEST MODE
LED TRIP
LED ALARM
LED PICKUP
LED VOLTAGE
LED CURRENT
LED FREQUENCY
LED OTHER
LED PHASE A
LED PHASE B
LED PHASE C
LED NEUTRAL/GROUND

Asserted when the front panel IN SERVICE LED is on
Asserted when the front panel TROUBLE LED is on
Asserted when the front panel TEST MODE LED is on
Asserted when the front panel TRIP LED is on
Asserted when the front panel ALARM LED is on
Asserted when an element picks up and to turn PICKUP LED on
Asserted when a voltage element involved and to turn VOLTAGE LED on 
Asserted when a current element involved and to turn CURRENT LED on
Asserted when a frequency element involved and to turn FREQUENCY LED on
Asserted when a composite element involved and to turn OTHER LED on
Asserted when phase A involved and to turn PHASE A LED on
Asserted when phase B involved and to turn PHASE B LED on
Asserted when phase C involved and to turn PHASE C LED on
Asserted when a neutral or ground element involved and to turn NEUTRAL/
GROUND LED on

LED INDICATORS:
Graphical front panel

LED IN SERVICE
LED TROUBLE
LED TEST MODE
LED TRIP
LED ALARM
LED PICKUP

LED VOLTAGE

LED CURRENT

LED FREQUENCY

LED OTHER

LED PHASE A
LED PHASE B
LED PHASE C
LED NEUTRAL/GROUND

Asserted when the front panel IN SERVICE LED is on
Asserted when the front panel TROUBLE LED is on
Asserted when the front panel TEST MODE LED is on
Asserted when the front panel TRIP LED is on
Asserted when the front panel ALARM LED is on
Asserted when an element picks up and to turn Event Cause LED 1 on by 
default
Asserted when a voltage element involved and to turn Event Cause LED 2 on 
by default 
Asserted when a current element involved and to turn Event Cause LED 3 on 
by default
Asserted when a frequency element involved and to turn Event Cause LED 4 
on by default
Asserted when a composite element involved and to turn Event Cause LED 5 
on by default
Asserted when phase A involved and to turn Event Cause LED 6 on by default
Asserted when phase B involved and to turn Event Cause LED 7 on by default
Asserted when phase C involved and to turn Event Cause LED 8 on by default
Asserted when a neutral or ground element involved and to turn Event Cause 
LED 9 on by default

LED INDICATORS:
LED test

LED TEST IN PROGRESS An LED test has been initiated and has not finished

LED INDICATORS:
User-programmable 
LEDs
Enhanced and basic 
front panels

LED USER 1 Asserted when user-programmable LED 1 is on

LED USER 2 to 48 The operand above is available for user-programmable LEDs 2 through 48

LED INDICATORS:
User-programmable 
LEDs
Graphical front panel

EVENT CAUSE LED 1 Asserted when event cause LED 1 is on

EVENT CAUSE LED 2 to 9 Same operand as EVENT CAUSE LED 1

PASSWORD 
SECURITY

ACCESS LOC SETG OFF
ACCESS LOC SETG ON
ACCESS LOC CMND OFF
ACCESS LOC CMND ON
ACCESS REM SETG OFF
ACCESS REM SETG ON
ACCESS REM CMND OFF
ACCESS REM CMND ON
UNAUTHORIZED ACCESS

Asserted when local setting access is disabled
Asserted when local setting access is enabled
Asserted when local command access is disabled
Asserted when local command access is enabled
Asserted when remote setting access is disabled
Asserted when remote setting access is enabled
Asserted when remote command access is disabled
Asserted when remote command access is enabled
Asserted when a password entry fails while accessing a password protected 
level of the F60

Operand type Operand syntax Operand description
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PROCESS BUS 
MODULE
(order code 85, 86, 
87)

PBEthPort-1 Offline
Stream Time Syncd
RxSV1 On
RxSV1 Off

RxSV1 Lost
RxSV1 Delay Alarm
RxSV1 SimBit On

RxSV1 SynChk Fail
RxSV1 QualChk Fail
RxSV1 Delayed Processing
RxSV1 Processing Fail
ACBank1 Orig1 in Use
ACBank1 Orig2 in Use

Process Bus Module port 1 failure
Process Bus Module clock is synchronized to reference SV stream
RxSV1 stream is online (messages are received and accepted)
RxSV1 stream is offline (SV are received but not accepted or SV frames are 
not received)
RxSV1 stream is completely lost (SV stream frames are not received)
RxSV1 stream message that delay exceeds the configured delay
RxSV1 messages are received with simulation bit TRUE, while "Accept Sim 
GOOSE&SV" setting is Enabled
RxSV1 message that the synchronization source check failed
RxSV1 message that at least one channel quality check failed
Analog data from RxSV# stream is delayed in oscillography record
No frame received from RxSV# stream or received sample processing 
ACBank1 is using Origin1 SV stream
ACBank1 is using Origin2 SV stream

RxGOOSE RxGOOSE 1 On


RxGOOSE 64 On

Flag is set, logic=1


Flag is set, logic=1

RxGOOSE 1 Off


RxGOOSE 64 Off

Flag is set, logic=1


Flag is set, logic=1

<RxGOOSE Boolean1 ID> On
<RxGOOSE DPS1 ID> Bad
<RxGOOSE DPS1 ID> Interm
<RxGOOSE DPS1 ID> Off
<RxGOOSE DPS1 ID> On

Replace bracketed text with RxGOOSE Boolean1 status of "true"
Replace bracketed text with RxGOOSE DPS1 status of "bad-state"
Replace bracketed text with RxGOOSE DPS1 status is "intermediate-state"
Replace bracketed text with RxGOOSE DPS1 status is "off"
Replace bracketed text with RxGOOSE DPS1 status is "on"

RESETTING RESET OP
RESET OP (COMMS)
RESET OP (OPERAND)

RESET OP (PUSHBUTTON)
RESET ANCTR OP
RESET ANCTR OP(OPRD)

RESET ANCTR OP(MNUL)

Reset command is operated (set by all three operands below)
Communications source of the reset command
Operand (assigned in the INPUTS/OUTPUTS  RESETTING menu) source of 
the reset command
Reset key (pushbutton) source of the reset command
Reset annunciator command is operated (set by any operands below)
Reset operand (assigned in INPUTS/OUTPUTS  RESETTING 
ANNUNCIATOR menu) source of the reset annunciator command
Reset manual (pushbutton or EnerVista software) source of the reset 
annunciator command

Operand type Operand syntax Operand description
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Some operands can be re-named. These are the names of the breakers in the breaker control feature, the ID (identification) 
of contact inputs and outputs, the ID of virtual inputs, and the ID of virtual outputs. If the user changes the default name or 
ID of any of these operands, the assigned name appears in the relay list of operands. The default names are shown in the 
FlexLogic operands table.

The characteristics of the logic gates are tabulated in the following table, and the operators available in FlexLogic are 
listed in the FlexLogic operators table.

Table 5-28: FlexLogic gate characteristics

SELF-DIAGNOSTICS
(See Relay Self-tests 
descriptions in 
Chapter 7: 
Commands and 
Targets)

ANY MAJOR ERROR
ANY MINOR ERROR
ANY SELF-TESTS
BATTERY FAIL

CLOCK UNSYNCHRONIZED
DIRECT DEVICE OFF
DIRECT RING BREAK
EQUIPMENT MISMATCH
FLEXLOGIC ERR TOKEN
IRIG-B FAILURE
LATCHING OUT ERROR
MAINTENANCE ALERT
FIRST ETHERNET FAIL
PROCESS BUS FAILURE
PTP FAILURE
RxGOOSE OFF
RRTD COMM FAIL
SECOND ETHERNET FAIL
THIRD ETHERNET FAIL
SNTP FAILURE
SYSTEM EXCEPTION
TEMP MONITOR
UNIT NOT PROGRAMMED

SETTING CHANGED

PROCESS BUS PTP FAILURE
CLOCK MISMATCH

PB CLOCK UNSYNCHRONIZED

Any of the major self-test errors generated (major error)
Any of the minor self-test errors generated (minor error)
Any self-test errors generated (generic, any error)
The battery is weak or not functioning. Replace as outlined in the 
Maintenance chapter.
Relay is not synchronized to the international time standard
A direct device is configured but not connected
The Direct I/O settings is for a connection that is not in a ring
The configuration of modules does not match the stored order code
A FlexLogic equation is incorrect
"Bad IRIG-B Signal" self-test. See Chapter 7: Commands and Targets.
A difference is detected between the desired and actual latch contact state
A subset of the minor self-test errors generated, see Chapter 7
Link failure detected. See description in Chapter 7: Commands and Targets.
See description in Chapter 7: Commands and Targets
"Bad PTP Signal" self-test as described in Chapter 7
One or more GOOSE messages are not being received
See description in Chapter 7: Commands and Targets
See description in Chapter 7: Commands and Targets
See description in Chapter 7: Commands and Targets
SNTP server is not responding
See description in Chapter 7: Commands and Targets
Monitors ambient temperature and maximum operating temperature
The product SETUP > INSTALLATION > RELAYS SETTINGS setting is not 
programmed
Any device settings changed over any available interface; operand is 
asserted for at least one second and then self-reset
No grandmaster clock available on any of the Process Bus Module ports
Process Bus Module and main CPU clocks are independently free-running 
and the clocks are deviating more than 100 micro seconds. Resets when the 
deviation is below 100 micro seconds.
Process Bus Module clock is free-running, that is, when both PTP 
grandmaster clock on Process Bus Module and one pulse per second (PPS) 
from main CPU are not available. Resets when any of the references is 
available.

SIMULATION TxGOOSE SIM ON
RxGOOSE SIM ON

Sim bit enabled in all Tx GOOSE
GOOSE messages with Sim bit set are accepted

TEMPERATURE 
MONITOR

TEMP MONITOR Asserted while the ambient temperature is greater than the maximum 
operating temperature (80°C)

USER-
PROGRAMMABLE 
PUSHBUTTONS

PUSHBUTTON 1 ON
PUSHBUTTON 1 OFF
ANY PB ON

Pushbutton number 1 is in the “On” position
Pushbutton number 1 is in the “Off” position
Any of 12 pushbuttons is in the “On” position

PUSHBUTTON 2 to 6, 12, or 16 
depending on front panel

Same set of operands as PUSHBUTTON 1

Gates Number of inputs Output is ‘1’ (= ON) if...

NOT 1 input is ‘0’

OR 2 to 16 any input is ‘1’

AND 2 to 16 all inputs are ‘1’

NOR 2 to 16 all inputs are ‘0’

NAND 2 to 16 any input is ‘0’

XOR 2 only one input is ‘1’

Operand type Operand syntax Operand description
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Table 5-29: FlexLogic operators

5.7.2  FlexLogic rules
When forming a FlexLogic equation, the sequence in the linear array of parameters must follow these general rules:

1. Operands must precede the operator that uses the operands as inputs.

2. Operators have only one output. The output of an operator must be used to create a virtual output if it is to be used as 
an input to two or more operators.

3. Assigning the output of an operator to a virtual output terminates the equation.

4. A timer operator (for example, "TIMER 1") or virtual output assignment (for example, " = Virt Op 1") can be used once 
only. If this rule is broken, a syntax error is declared.

5.7.3  FlexLogic evaluation
Each equation is evaluated in the ascending order in which the parameters have been entered.

Type Syntax Description Notes

Editor INSERT Insert a parameter in an equation list

DELETE Delete a parameter from an equation list

End END The first END encountered signifies the last entry in 
the list of processed FlexLogic parameters

One-shot POSITIVE ONE SHOT One shot that responds to a positive going edge A ‘one shot’ refers to a single input gate that 
generates a pulse in response to an edge on 
the input. The output from a ‘one shot’ is 
True (positive) for only one pass through the 
FlexLogic equation. There is a maximum of 
64 ‘one shots.’

NEGATIVE ONE SHOT One shot that responds to a negative going edge

DUAL ONE SHOT One shot that responds to both the positive and 
negative going edges

Logic
gate

NOT Logical NOT Operates on the previous parameter

OR(2)


OR(16)

2 input OR gate


16 input OR gate

Operates on the 2 previous parameters


Operates on the 16 previous parameters

AND(2)


AND(16)

2 input AND gate


16 input AND gate

Operates on the 2 previous parameters


Operates on the 16 previous parameters

NOR(2)


NOR(16)

2 input NOR gate


16 input NOR gate

Operates on the 2 previous parameters


Operates on the 16 previous parameters

NAND(2)


NAND(16)

2 input NAND gate


16 input NAND gate

Operates on the 2 previous parameters


Operates on the 16 previous parameters

XOR(2) 2 input Exclusive OR gate Operates on the 2 previous parameters

LATCH (S,R) Latch (set, reset): reset-dominant The parameter preceding LATCH(S,R) is the 
reset input. The parameter preceding the 
reset input is the set input.

Timer TIMER 1


TIMER 32

Timer set with FlexLogic timer 1 settings


Timer set with FlexLogic timer 32 settings

The timer is started by the preceding 
parameter. The output of the timer is 
TIMER #.

Assign 
virtual
output

= Virt Op 1


= Virt Op 96

Assigns previous FlexLogic operand to virtual 
output 1


Assigns previous FlexLogic operand to virtual 
output 96

The virtual output is set by the preceding 
parameter
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5.7.4  FlexLogic example
This section provides an example of logic implementation for a typical application. The sequence of steps is important to 
minimize the work to develop the relay settings. Note that the example in the following figure demonstrates the procedure, 
not to solve a specific application situation.

Note that there is also a graphical interface with which to draw logic and populate FlexLogic equation entries. See the 
Engineer content at the end of the previous chapter.

In the example, it is assumed that logic has already been programmed to produce virtual outputs 1 and 2, and is only a 
part of the full set of equations used. When using FlexLogic, it is important to make a note of each virtual output used; a 
virtual output designation (1 to 96) can be assigned only once.

Figure 5-110: Logic example 

1. Inspect the example logic diagram to determine if the required logic can be implemented with the FlexLogic 
operators. If this is not possible, the logic must be altered until this condition is satisfied. Once done, count the inputs 
to each gate to verify that the number of inputs does not exceed the FlexLogic limits, which is unlikely but possible. If 
the number of inputs is too high, subdivide the inputs into multiple gates to produce an equivalent. For example, if 25 
inputs to an AND gate are required, connect Inputs 1 through 16 to AND(16), 17 through 25 to AND(9), and the outputs 
from these two gates to AND(2).

Inspect each operator between the initial operands and final virtual outputs to determine if the output from the 
operator is used as an input to more than one following operator. If so, the operator output must be assigned as a 
virtual output.

For the example shown, the output of the AND gate is used as an input to both OR#1 and Timer 1, and must therefore 
be made a virtual output and assigned the next available number (that is, Virtual Output 3). The final output must also 
be assigned to a virtual output as virtual output 4, which is programmed in the contact output section to operate relay 
H1 (that is, contact output H1).

Therefore, the required logic can be implemented with two FlexLogic equations with outputs of virtual output 3 and 
virtual output 4, shown as follows.

FlexLogic provides built-in latches that by definition have a memory action, remaining in the set state after the set 
input has been asserted. These built-in latches are reset dominant, meaning that if logical "1" is applied to both set 
and reset entries simultaneously, then the output of the latch is logical "0." However, they are volatile, meaning that 
they reset upon removal of control power.
When making changes to FlexLogic entries in the settings, all FlexLogic equations are re-compiled whenever any 
new FlexLogic entry value is entered, and as a result of the re-compile all latches are reset automatically.

To implement FlexLogic using a graphical user interface, see the FlexLogic Design and Monitoring using Engineer 
section in the previous chapter.
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Figure 5-111: Logic example with virtual outputs 

2. Prepare a logic diagram for the equation to produce virtual output 3, as this output is used as an operand in the virtual 
output 4 equation (create the equation for every output that is used as an operand first, so that when these operands 
are required they already have been evaluated and assigned to a specific virtual output). The logic for virtual output 3 
is shown as follows with the final output assigned.

Figure 5-112: Logic for virtual output 3 

3. Prepare a logic diagram for virtual output 4, replacing the logic ahead of virtual output 3 with a symbol identified as 
virtual output 3, shown as follows.

Figure 5-113: Logic for virtual output 4 

4. Program the FlexLogic equation for virtual output 3 by translating the logic into available FlexLogic parameters. The 
equation is formed one parameter at a time until the required logic is complete. It is generally easier to start at the 
output end of the equation and work back towards the input, as shown in the following steps. It is also recommended 
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to list operator inputs from bottom to top. For demonstration, the final outputs are arbitrarily identified as parameter 
99, and each preceding parameter decremented by one in turn. Until accustomed to using FlexLogic, it is suggested 
that a worksheet with a series of cells marked with the arbitrary parameter numbers be prepared shown as follows.

Figure 5-114: FlexLogic worksheet 

5. Following the procedure outlined, start with parameter 99, as follows:

– 99: The final output of the equation is virtual output 3, which is created by the operator "= Virt Op n". This 
parameter is therefore "= Virt Op 3".

– 98: The gate preceding the output is an AND, which in this case requires two inputs. The operator for this gate is a 
2-input AND so the parameter is “AND(2)”. Note that FlexLogic rules require that the number of inputs to most 
types of operators must be specified to identify the operands for the gate. As the 2-input AND operates on the 
two operands preceding it, these inputs must be specified, starting with the lower.

– 97: This lower input to the AND gate must be passed through an inverter (the NOT operator) so the next 
parameter is “NOT”. The NOT operator acts upon the operand immediately preceding it, so specify the inverter 
input next.

– 96: The input to the NOT gate is to be contact input H1c. The ON state of a contact input can be programmed to 
be set when the contact is either open or closed. Assume for this example that the state is to be ON for a closed 
contact. The operand is therefore “Cont Ip H1c On”.

– 95: The last step in the procedure is to specify the upper input to the AND gate, the operated state of digital 
element 2. This operand is "DIG ELEM 2 OP".

Writing the parameters in numerical order forms the equation for virtual output 3:
[95] DIG ELEM 2 OP

[96] Cont Ip H1c On
[97] NOT

[98] AND(2)

[99] = Virt Op 3

It is now possible to check that this selection of parameters produces the required logic by converting the set of 
parameters into a logic diagram. The result of this process is shown in the figure, which is compared to the logic for 
virtual output 3 diagram as a check.

01

02

03

04

05

97

98

99

.....

827029A1.VSD
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Figure 5-115: FlexLogic equation for virtual output 3 

6. Repeating the process described for virtual output 3, select the FlexLogic parameters for Virtual Output 4.

– 99: The final output of the equation is virtual output 4, which is parameter “= Virt Op 4".

– 98: The operator preceding the output is timer 2, which is operand “TIMER 2". Note that the settings required for 
the timer are established in the timer programming section.

– 97: The operator preceding timer 2 is OR #2, a 3-input OR, which is parameter “OR(3)”.

– 96: The lowest input to OR #2 is operand “Cont Ip H1c On”.

– 95: The center input to OR #2 is operand “TIMER 1".

– 94: The input to timer 1 is operand “Virt Op 3 On".

– 93: The upper input to OR #2 is operand “LATCH (S,R)”.

– 92: There are two inputs to a latch, and the input immediately preceding the latch reset is OR #1, a 4-input OR, 
which is parameter “OR(4)”.

– 91: The lowest input to OR #1 is operand “Virt Op 3 On".

– 90: The input just above the lowest input to OR #1 is operand “XOR(2)”.

– 89: The lower input to the XOR is operand “DIG ELEM 1 PKP”.

– 88: The upper input to the XOR is operand “Virt Ip 1 On".

– 87: The input just below the upper input to OR #1 is operand “Virt Op 2 On".

– 86: The upper input to OR #1 is operand “Virt Op 1 On".

– 85: The last parameter is used to set the latch, and is operand “Virt Op 4 On".

The equation for virtual output 4 is:
[85] Virt Op 4 On

[86] Virt Op 1 On
[87] Virt Op 2 On

[88] Virt Ip 1 On

[89] DIG ELEM 1 PKP
[90] XOR(2)

[91] Virt Op 3 On

[92] OR(4)
[93] LATCH (S,R)

[94] Virt Op 3 On

[95] TIMER 1
[96] Cont Ip H1c On

[97] OR(3)

[98] TIMER 2
[99] = Virt Op 4

Now check that the selection of parameters produce the required logic by converting the set of parameters into a 
logic diagram. The result is shown in the figure, which is compared to the logic for virtual output 4 diagram as a check.
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Figure 5-116: FlexLogic equation for virtual output 4 

7. Now write the complete FlexLogic expression required to implement the logic, making an effort to assemble the 
equation in an order where Virtual Outputs that are used as inputs to operators are created before needed. In cases 
where a lot of processing is required to perform logic, this can be difficult to achieve, but in most cases does not cause 
problems as all logic is calculated at least four times per power frequency cycle. The possibility of a problem caused by 
sequential processing emphasizes the necessity to test the performance of FlexLogic before it is placed in service.

In the following equation, virtual output 3 is used as an input to both latch 1 and timer 1 as arranged in the following 
order:

DIG ELEM 2 OP
Cont Ip H1c On

NOT

AND(2)
= Virt Op 3

Virt Op 4 On

Virt Op 1 On
Virt Op 2 On

Virt Ip 1 On

DIG ELEM 1 PKP
XOR(2)

Virt Op 3 On

OR(4)
LATCH (S,R)

Virt Op 3 On

TIMER 1
Cont Ip H1c On

OR(3)

TIMER 2

= Virt Op 4
END

In this expression, the virtual output 4 input to the four-input OR is listed before it is created. This is typical of a form of 
feedback, in this case, used to create a seal-in effect with the latch, and is correct.

8. Always test the logic after it is loaded into the relay, in the same way as has been used in the past. Testing can be 
simplified by placing an "END" operator within the overall set of FlexLogic equations. The equations are evaluated up 
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to the first "END" operator.

The "On" and "Off" operands can be placed in an equation to establish a known set of conditions for test purposes, and 
the "INSERT" and "DELETE" commands can be used to modify equations.

5.7.5  FlexLogic equation editor
SETTINGS  FLEXLOGIC  FLEXLOGIC EQUATION EDITOR

There are 1,024 FlexLogic entries available, numbered from 1 to 1024, with default END entry settings. If a "Disabled" 
element is selected as a FlexLogic entry, the associated state flag is never set to ‘1’. Press the +/– key when editing 
FlexLogic equations to quickly scan through the major parameter types.

5.7.6  FlexLogic timers
SETTINGS  FLEXLOGIC  FLEXLOGIC TIMERS  FLEXLOGIC TIMER 1(32)

There are 32 identical FlexLogic timers available. These timers are used as operators for FlexLogic equations.

TIMER 1 TYPE — Selects the time measurement unit.

TIMER 1 PICKUP DELAY — Sets the time delay to pickup. If a pickup delay is not required, set this function to "0."

TIMER 1 DROPOUT DELAY — Sets the time delay to dropout. If a dropout delay is not required, set this function to "0."

5.7.7  FlexElements
SETTINGS  FLEXLOGIC  FLEXELEMENTS  FLEXELEMENT 1(8)

 FLEXLOGIC
 EQUATION EDITOR  FLEXLOGIC ENTRY 1:

END
Range: FlexLogic operands



 FLEXLOGIC ENTRY 1024:
END

Range: FlexLogic operands

 FLEXLOGIC
 TIMER 1  TIMER 1

TYPE: millisecond
Range: millisecond, second, minute

 TIMER 1 PICKUP
DELAY: 0

Range: 0 to 60000 in steps of 1

 TIMER 1 DROPOUT
DELAY: 0

Range: 0 to 60000 in steps of 1

 FLEXELEMENT 1
  FLEXELEMENT 1

FUNCTION: Disabled
Range: Disabled, Enabled

 FLEXELEMENT 1 NAME:
FxE 1

Range: up to six alphanumeric characters

 FLEXELEMENT 1 +IN:
Off

Range: Off, any analog actual value parameter

 FLEXELEMENT 1 -IN:
Off

Range: Off, any analog actual value parameter

 FLEXELEMENT 1 INPUT
MODE: SIGNED

Range: SIGNED, ABSOLUTE

 FLEXELEMENT 1 COMP
MODE: LEVEL

Range: LEVEL, DELTA

 FLEXELEMENT 1
DIRECTION: OVER

Range: OVER, UNDER
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A FlexElement is a universal comparator used to monitor any analog actual value calculated by the relay or a net 
difference of any two analog actual values of the same type. The effective operating signal can be treated as a signed 
number or its absolute value can be used.

FlexElements run every half power cycle (every four protection passes).

The element can be programmed to respond either to a signal level or to a rate-of-change (delta) over a pre-defined period 
of time. The output operand is asserted when the operating signal is higher than a threshold or lower than a threshold, as 
per your choice.

Figure 5-117: FlexElement logic 

 FLEXELEMENT 1
PICKUP: 1.000 pu

Range: –90.000 to 90.000 pu in steps of 0.001

 FLEXELEMENT 1
HYSTERESIS: 3.0%

Range: 0.1 to 50.0% in steps of 0.1

 FLEXELEMENT 1 dt
UNIT: Milliseconds

Range: Milliseconds, Seconds, Minutes

 FLEXELEMENT 1 dt:
20

Range: 20 to 86400 in steps of 1

 FLEXELEMENT 1 PKP
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 FLEXELEMENT 1 RST
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 FLEXELEMENT 1 BLK:
Off

Range: FlexLogic operand

 FLEXELEMENT 1
TARGET: Self-reset

Range: Self-reset, Disabled, Latched

 FLEXELEMENT 1
EVENTS: Disabled

Range: Disabled, Enabled
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FLEXELEMENT 1 +IN — This setting specifies the first (non-inverted) input to the FlexElement. Zero is assumed as the input if 
this setting is set to “Off.” For proper operation of the element, at least one input must be selected. Otherwise, the element 
does not assert its output operands.

FLEXELEMENT 1 –IN — Specifies the second (inverted) input to the FlexElement. Zero is assumed as the input if this setting is 
set to “Off.” For proper operation of the element, at least one input must be selected. Otherwise, the element does not 
assert its output operands. This input is used to invert the signal if needed for convenience, or to make the element 
respond to a differential signal, such as for a top-bottom oil temperature differential alarm. The element does not operate 
if the two input signals are of different types, for example if one tries to use active power and phase angle to build the 
effective operating signal.

The element responds directly to the differential signal if the FLEXELEMENT 1 INPUT MODE setting is set to “Signed” The 
element responds to the absolute value of the differential signal if this setting is set to “Absolute.” Sample applications for 
the “Absolute” setting include monitoring the angular difference between two phasors with a symmetrical limit angle in 
both directions, monitoring power regardless of its direction, or monitoring a trend.

The element responds directly to its operating signal—as defined by the FLEXELEMENT 1 +IN, FLEXELEMENT 1 –IN and 
FLEXELEMENT 1 INPUT MODE settings—if the FLEXELEMENT 1 COMP MODE setting is set to “Level.” The element responds to the 
rate of change of its operating signal if the FLEXELEMENT 1 COMP MODE setting is set to “Delta.” In this case, the 
FLEXELEMENT 1 dt UNIT and FLEXELEMENT 1 dt settings specify how the rate of change is derived.

FLEXELEMENT 1 DIRECTION — Enables the relay to respond to either high or low values of the operating signal. The following 
figure explains the application of the FLEXELEMENT 1 DIRECTION, FLEXELEMENT 1 PICKUP, and FLEXELEMENT 1 HYSTERESIS 
settings.

Figure 5-118: FlexElement direction, pickup, and hysteresis 

In conjunction with the FLEXELEMENT 1 INPUT MODE setting, the element can be programmed to provide two extra 
characteristics, as shown in the following figure.

FlexElement 1 OpSig

FLEXELEMENT 1 PKP

FLEXELEMENT

DIRECTION = Over

P
IC

K
U

P

HYSTERESIS = % of PICKUP

FlexElement 1 OpSig

FLEXELEMENT 1 PKP

FLEXELEMENT

DIRECTION = Under

P
IC

K
U

P

HYSTERESIS = % of PICKUP

842705A1.CDR
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Figure 5-119: FlexElement input mode setting 

FLEXELEMENT 1 PICKUP — This setting specifies the operating threshold for the effective operating signal of the element. If 
set to “Over,” the element picks up when the operating signal exceeds the FLEXELEMENT 1 PICKUP value. If set to “Under,” the 
element picks up when the operating signal falls below the FLEXELEMENT 1 PICKUP value.

FLEXELEMENT 1 HYSTERESIS — This setting controls the element dropout. Notice that both the operating signal and the 
pickup threshold can be negative, facilitating applications such as reverse power alarm protection. The FlexElement can be 
programmed to work with all analog actual values measured by the relay. The FLEXELEMENT 1 PICKUP setting is entered in 
per-unit values using the following definitions of the base units.

Table 5-30: FlexElement base units

Unit Description

BREAKER ACC ARCING AMPS
(Brk X Acc Arc Amp A, B, and C)

BASE = 2000 kA2  cycle

BREAKER ARCING AMPS
(Brk X Arc Amp A, B, and C)

BASE = 1 kA2  cycle

842706A2.CDR

FlexElement 1 OpSig

FLEXELEMENT 1 PKP

FLEXELEMENT

DIRECTION = Over;

FLEXELEMENT INPUT

MODE = Signed;

FlexElement 1 OpSig

FLEXELEMENT 1 PKP

FLEXELEMENT

DIRECTION = Over;

FLEXELEMENT INPUT

MODE = Absolute;

FlexElement 1 OpSig

FLEXELEMENT 1 PKP

FLEXELEMENT

DIRECTION = Under;

FLEXELEMENT INPUT

MODE = Signed;

FlexElement 1 OpSig

FLEXELEMENT 1 PKP

FLEXELEMENT

DIRECTION = Under;

FLEXELEMENT INPUT

MODE = Absolute;
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FLEXELEMENT 1 HYSTERESIS — This setting defines the pickup–dropout relation of the element by specifying the width of the 
hysteresis loop as a percentage of the pickup value as shown in the FlexElement Direction, Pickup, and Hysteresis diagram.

FLEXELEMENT 1 dt UNIT — Specifies the time unit for the setting FLEXELEMENT 1 dt. This setting is applicable only if 
FLEXELEMENT 1 COMP MODE is set to “Delta.”

FLEXELEMENT 1 dt — Specifies duration of the time interval for the rate of change mode of operation. This setting is 
applicable only if FLEXELEMENT 1 COMP MODE is set to “Delta.”

FLEXELEMENT 1 PKP DELAY — Specifies the pickup delay of the element.

FLEXELEMENT 1 RST DELAY — Specifies the reset delay of the element.

5.7.8  Non-volatile latches
SETTINGS  FLEXLOGIC  NON-VOLATILE LATCHES  LATCH 1(16)

DCmA BASE = maximum value of the DCMA INPUT MAX setting for the two transducers configured 
under the +IN and –IN inputs

DELTA TIME BASE = 1 µs

FAULT LOCATION BASE = Line Length as specified in Fault Report

FREQUENCY fBASE = 1 Hz

FREQUENCY RATE OF CHANGE df/dtBASE = 1 Hz/s

PHASE ANGLE BASE = 360 degrees (see the UR angle referencing convention)

POWER FACTOR PFBASE = 1.00

RTDs BASE = 100°C

SENSITIVE DIR POWER
(Sns Dir Power)

PBASE = maximum value of 3  VBASE  IBASE for the +IN and –IN inputs of the sources configured 
for the sensitive power directional element(s).

SOURCE CURRENT IBASE = maximum nominal primary RMS value of the +IN and –IN inputs

SOURCE ENERGY
(Positive and Negative Watthours, 
Positive and Negative Varhours)

EBASE = 10000 MWh or MVAh, respectively

SOURCE POWER PBASE = maximum value of VBASE  IBASE for the +IN and –IN inputs

SOURCE THD & HARMONICS BASE = 1%

SOURCE VOLTAGE VBASE = maximum nominal primary RMS value of the +IN and –IN inputs

SYNCHROCHECK
(Max Delta Volts)

VBASE = maximum primary RMS value of all the sources related to the +IN and –IN inputs

 LATCH 1
  LATCH 1

FUNCTION: Disabled
Range: Disabled, Enabled

 LATCH 1 ID:
NV Latch 1

Range: up to 20 alphanumeric characters

 LATCH 1 TYPE:
Reset Dominant

Range: Reset Dominant, Set Dominant

 LATCH 1 SET:
Off

Range: FlexLogic operand

 LATCH 1 RESET:
Off

Range: FlexLogic operand

 LATCH 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 LATCH 1
EVENTS: Disabled

Range: Disabled, Enabled

Unit Description
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The non-volatile latches provide a permanent logical flag that is stored safely and do not reset upon restart after the relay 
is powered down. Typical applications include sustaining operator commands or permanently blocking relay functions, 
such as Autorecloser, until a deliberate interface action resets the latch.

LATCH 1 TYPE — This setting characterizes Latch 1 to be Set- or Reset-dominant.

LATCH 1 SET — If asserted, the specified FlexLogic operands 'sets' Latch 1.

LATCH 1 RESET — If asserted, the specified FlexLogic operand 'resets' Latch 1.

Figure 5-120: Non-volatile latch operation table (N = 1 to 16) and logic  

5.8  Grouped elements

5.8.1  Overview
Each protection element can be assigned up to six sets of settings with designations 1 to 6. The performance of these 
elements is defined by the active setting group at a given time. Multiple setting groups allow the user to conveniently 
change protection settings for different operating situations (for example, altered power system configuration or season of 
the year). The active setting group can be preset or selected in the SETTING GROUPS menu (see the Control Elements section 
later in this chapter). See also the Introduction to Elements section at the beginning of this chapter.

5.8.2  Setting group 1
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)

Latch n type Latch n 
set

Latch n 
reset

Latch n 
on

Latch n 
off

Reset 
Dominant

ON OFF ON OFF

OFF OFF Previous 
State

Previous 
State

ON ON OFF ON

OFF ON OFF ON

Set 
Dominant

ON OFF ON OFF

ON ON ON OFF

OFF OFF Previous 
State

Previous 
State

OFF ON OFF ON

 SETTING GROUP 1
   LOAD ENCROACHMENT

 
See below
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Each of the six setting group menus is identical. Setting group 1 (the default active group) is active automatically when no 
other group is active.

If the device incorrectly switches to group 1 after power cycling, upgrade the firmware to version 7.31 or later to correct 
this issue.

5.8.3  Load encroachment
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  LOAD ENCROACHMENT

The load encroachment element responds to the positive-sequence voltage and current and applies a characteristic as 
shown in the figure.

  PHASE CURRENT
 

See page 5-239

  NEUTRAL CURRENT
 

See page 5-251

  WATTMETRIC
 GROUND FAULT

See page 5-259

  GROUND CURRENT
 

See page 5-263

  NEGATIVE SEQUENCE
 CURRENT

See page 5-271

  BREAKER FAILURE
 

See page 5-276

  VOLTAGE ELEMENTS
 

See page 5-286

  POWER
 

See page 5-293

 LOAD ENCROACHMENT
  LOAD ENCROACHMENT

FUNCTION: Disabled
Range: Disabled, Enabled

 LOAD ENCROACHMENT
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 LOAD ENCROACHMENT
MIN VOLT: 0.250 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 LOAD ENCROACHMENT
REACH: 1.00 

Range: 0.02 to 250.00 ohms in steps of 0.01

 LOAD ENCROACHMENT
ANGLE: 30°

Range: 5 to 50° in steps of 1

 LOAD ENCROACHMENT
PKP DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 LOAD ENCROACHMENT
RST DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 LOAD ENCRMNT BLK:
Off

Range: FlexLogic operand

 LOAD ENCROACHMENT
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 LOAD ENCROACHMENT
EVENTS: Disabled

Range: Disabled, Enabled
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Figure 5-121: Load encroachment characteristic 

The element operates if the positive-sequence voltage is above a settable level and asserts its output signal that can be 
used to block selected protection elements, such as distance or phase overcurrent. The following figure shows an effect of 
the load encroachment characteristics used to block the quadrilateral distance element.

Figure 5-122: Load encroachment applied to distance element 

LOAD ENCROACHMENT MIN VOLT — This setting specifies the minimum positive-sequence voltage required for operation of 
the element. When the voltage is below this threshold, a blocking signal is not asserted by the element. When selecting 
this setting, remember that the F60 measures the phase-to-ground sequence voltages regardless of the VT connection.

The nominal VT secondary voltage as specified with the SYSTEM SETUP  AC INPUTS  VOLTAGE BANK X5  PHASE VT 
SECONDARY setting is the per-unit base for this setting.

LOAD ENCROACHMENT REACH — This setting specifies the resistive reach of the element as shown in the Load 
Encroachment Characteristic diagram. Enter this setting in secondary ohms and calculate it as the positive-sequence 
resistance seen by the relay under maximum load conditions and unity power factor.

LOAD ENCROACHMENT ANGLE — This setting specifies the size of the blocking region as shown on the Load Encroachment 
Characteristic diagram and applies to the positive-sequence impedance.

837731A1.CDR

X

R
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Figure 5-123: Load encroachment logic 

5.8.4  Phase current

5.8.4.1  Menu
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  PHASE CURRENT

5.8.4.2  Inverse TOC curve characteristics
The inverse time overcurrent curves used by the time overcurrent elements are the IEEE, IEC, GE Type IAC, and I2t standard 
curve shapes. This allows for simplified coordination with downstream devices.

If none of these curve shapes is adequate, FlexCurves can be used to customize the inverse time curve characteristics. The 
definite time curve is also an option that can be appropriate if only simple protection is required.

Table 5-31: Overcurrent curve types

 PHASE CURRENT
   PHASE TOC1

 
See page 5-245



  PHASE TOC6
 

  PHASE IOC1
 

See page 5-247



  PHASE IOC8
 

  PHASE
 DIRECTIONAL 1

See page 5-248

  PHASE
 DIRECTIONAL 2

IEEE IEC GE type IAC Other

IEEE Extremely Inverse IEC Curve A (BS142) IAC Extremely Inverse I2t

IEEE Very Inverse IEC Curve B (BS142) IAC Very Inverse FlexCurves A, B, C, and D

IEEE Moderately Inverse IEC Curve C (BS142) IAC Inverse Recloser Curves

IEC Short Inverse IAC Short Inverse Definite Time
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A time dial multiplier setting allows selection of a multiple of the base curve shape (where the time dial multiplier = 1) with 
the curve shape (CURVE) setting. Unlike the electromechanical time dial equivalent, operate times are directly proportional 
to the time multiplier (TD MULTIPLIER) setting value. For example, all times for a multiplier of 10 are 10 times the multiplier 1 
or base curve values. Setting the multiplier to zero results in an instantaneous response to all current levels above pickup.

Time overcurrent time calculations are made with an internal energy capacity memory variable. When this variable 
indicates that the energy capacity has reached 100%, a time overcurrent element operates. If less than 100% energy 
capacity is accumulated in this variable and the current falls below the dropout threshold of 97 to 98% of the pickup value, 
the variable must be reduced. Two methods of this resetting operation are available: “Instantaneous” and “Timed.” The 
“Instantaneous” selection is intended for applications with other relays, such as most static relays, which set the energy 
capacity directly to zero when the current falls below the reset threshold. The “Timed” selection can be used where the 
relay must coordinate with electromechanical relays.

IEEE curves
The IEEE time overcurrent curve shapes conform to industry standards and the IEEE C37.112-1996 curve classifications for 
extremely, very, and moderately inverse curves. The IEEE curves are derived from the operate and reset time equations.

Eq. 5-8

where

T = operate time (in seconds)
TDM = Multiplier setting
I = input current
Ipickup = Pickup Current setting
A, B, p = constants defined in the table
TRESET = reset time in seconds (assuming energy capacity is 100% and RESET is “Timed”)
tr = characteristic constant defined in the table

Table 5-32: IEEE inverse time curve constants

Table 5-33: IEEE curve trip times (in seconds)

IEEE curve shape A B p tr

IEEE Extremely Inverse 28.2 0.1217 2.0000 29.1

IEEE Very Inverse 19.61 0.491 2.0000 21.6

IEEE Moderately Inverse 0.0515 0.1140 0.02000 4.85

Multiplier
(TDM)

Current ( I / Ipickup)

1.5 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0

IEEE Extremely Inverse

0.5 11.341 4.761 1.823 1.001 0.648 0.464 0.355 0.285 0.237 0.203

1.0 22.682 9.522 3.647 2.002 1.297 0.927 0.709 0.569 0.474 0.407

2.0 45.363 19.043 7.293 4.003 2.593 1.855 1.418 1.139 0.948 0.813

4.0 90.727 38.087 14.587 8.007 5.187 3.710 2.837 2.277 1.897 1.626

6.0 136.090 57.130 21.880 12.010 7.780 5.564 4.255 3.416 2.845 2.439

8.0 181.454 76.174 29.174 16.014 10.374 7.419 5.674 4.555 3.794 3.252

10.0 226.817 95.217 36.467 20.017 12.967 9.274 7.092 5.693 4.742 4.065

IEEE Very Inverse

0.5 8.090 3.514 1.471 0.899 0.654 0.526 0.450 0.401 0.368 0.345

1.0 16.179 7.028 2.942 1.798 1.308 1.051 0.900 0.802 0.736 0.689

2.0 32.358 14.055 5.885 3.597 2.616 2.103 1.799 1.605 1.472 1.378

, T TDM
A

I
Ipickup
--------------

p
1–

------------------------------- B+
= TRESET TDM

tr

1 I
Ipickup
--------------

2
–

--------------------------------
=
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IEC curves
For European applications, the relay offers three standard curves defined in IEC 255-4 and British standard BS142. These 
are defined as IEC Curve A, IEC Curve B, and IEC Curve C. The IEC curves are derived by the operate and reset time 
equations.

Eq. 5-9

where

T = operate time (in seconds)
TDM = Multiplier setting
I = input current
Ipickup = Pickup Current setting
K, E = constants defined in the table
tr = characteristic constant defined in the table
TRESET = reset time in seconds (assuming energy capacity is 100% and RESET is “Timed”)

Table 5-34: IEC (BS) inverse time curve constants

Table 5-35: IEC curve trip times (in seconds)

4.0 64.716 28.111 11.769 7.193 5.232 4.205 3.598 3.209 2.945 2.756

6.0 97.074 42.166 17.654 10.790 7.849 6.308 5.397 4.814 4.417 4.134

8.0 129.432 56.221 23.538 14.387 10.465 8.410 7.196 6.418 5.889 5.513

10.0 161.790 70.277 29.423 17.983 13.081 10.513 8.995 8.023 7.361 6.891

IEEE Moderately Inverse

0.5 3.220 1.902 1.216 0.973 0.844 0.763 0.706 0.663 0.630 0.603

1.0 6.439 3.803 2.432 1.946 1.688 1.526 1.412 1.327 1.260 1.207

2.0 12.878 7.606 4.864 3.892 3.377 3.051 2.823 2.653 2.521 2.414

4.0 25.756 15.213 9.729 7.783 6.753 6.102 5.647 5.307 5.041 4.827

6.0 38.634 22.819 14.593 11.675 10.130 9.153 8.470 7.960 7.562 7.241

8.0 51.512 30.426 19.458 15.567 13.507 12.204 11.294 10.614 10.083 9.654

10.0 64.390 38.032 24.322 19.458 16.883 15.255 14.117 13.267 12.604 12.068

IEC (BS) curve shape K E tr

IEC Curve A (BS142) 0.140 0.020 9.7

IEC Curve B (BS142) 13.500 1.000 43.2

IEC Curve C (BS142) 80.000 2.000 58.2

IEC Short Inverse 0.050 0.040 0.500

Multiplier
(TDM)

Current ( I / Ipickup)

1.5 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0

IEC Curve A

0.05 0.860 0.501 0.315 0.249 0.214 0.192 0.176 0.165 0.156 0.149

0.10 1.719 1.003 0.630 0.498 0.428 0.384 0.353 0.330 0.312 0.297

0.20 3.439 2.006 1.260 0.996 0.856 0.767 0.706 0.659 0.623 0.594

0.40 6.878 4.012 2.521 1.992 1.712 1.535 1.411 1.319 1.247 1.188

0.60 10.317 6.017 3.781 2.988 2.568 2.302 2.117 1.978 1.870 1.782

0.80 13.755 8.023 5.042 3.984 3.424 3.070 2.822 2.637 2.493 2.376

Multiplier
(TDM)

Current ( I / Ipickup)

1.5 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0

, T TDM
K

I Ipickup
E 1–

-----------------------------------
= TRESET TDM

tr

1 I Ipickup
2

–
-----------------------------------

=
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IAC curves
The curves for the General Electric type IAC relay family are derived from the formulae:

Eq. 5-10

where

T = operate time (in seconds)
TDM = Multiplier setting
I = Input current
Ipkp = Pickup Current setting
A to E = constants defined in the table
tr = characteristic constant defined in the table
TRESET = reset time in seconds (assuming energy capacity is 100% and RESET is “Timed”)

Table 5-36: GE type IAC inverse time curve constants

1.00 17.194 10.029 6.302 4.980 4.280 3.837 3.528 3.297 3.116 2.971

IEC Curve B

0.05 1.350 0.675 0.338 0.225 0.169 0.135 0.113 0.096 0.084 0.075

0.10 2.700 1.350 0.675 0.450 0.338 0.270 0.225 0.193 0.169 0.150

0.20 5.400 2.700 1.350 0.900 0.675 0.540 0.450 0.386 0.338 0.300

0.40 10.800 5.400 2.700 1.800 1.350 1.080 0.900 0.771 0.675 0.600

0.60 16.200 8.100 4.050 2.700 2.025 1.620 1.350 1.157 1.013 0.900

0.80 21.600 10.800 5.400 3.600 2.700 2.160 1.800 1.543 1.350 1.200

1.00 27.000 13.500 6.750 4.500 3.375 2.700 2.250 1.929 1.688 1.500

IEC Curve C

0.05 3.200 1.333 0.500 0.267 0.167 0.114 0.083 0.063 0.050 0.040

0.10 6.400 2.667 1.000 0.533 0.333 0.229 0.167 0.127 0.100 0.081

0.20 12.800 5.333 2.000 1.067 0.667 0.457 0.333 0.254 0.200 0.162

0.40 25.600 10.667 4.000 2.133 1.333 0.914 0.667 0.508 0.400 0.323

0.60 38.400 16.000 6.000 3.200 2.000 1.371 1.000 0.762 0.600 0.485

0.80 51.200 21.333 8.000 4.267 2.667 1.829 1.333 1.016 0.800 0.646

1.00 64.000 26.667 10.000 5.333 3.333 2.286 1.667 1.270 1.000 0.808

IEC Short Inverse

0.05 0.153 0.089 0.056 0.044 0.038 0.034 0.031 0.029 0.027 0.026

0.10 0.306 0.178 0.111 0.088 0.075 0.067 0.062 0.058 0.054 0.052

0.20 0.612 0.356 0.223 0.175 0.150 0.135 0.124 0.115 0.109 0.104

0.40 1.223 0.711 0.445 0.351 0.301 0.269 0.247 0.231 0.218 0.207

0.60 1.835 1.067 0.668 0.526 0.451 0.404 0.371 0.346 0.327 0.311

0.80 2.446 1.423 0.890 0.702 0.602 0.538 0.494 0.461 0.435 0.415

1.00 3.058 1.778 1.113 0.877 0.752 0.673 0.618 0.576 0.544 0.518

IAC curve shape A B C D E tr

IAC Extreme Inverse 0.0040 0.6379 0.6200 1.7872 0.2461 6.008

IAC Very Inverse 0.0900 0.7955 0.1000 –1.2885 7.9586 4.678

IAC Inverse 0.2078 0.8630 0.8000 –0.4180 0.1947 0.990

Multiplier
(TDM)

Current ( I / Ipickup)

1.5 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0

, T TDM A
B

I Ipkp C–
---------------------------

D

I Ipkp C–
2

---------------------------------
E

I Ipkp C–
3

---------------------------------+ + += TRESET TDM
tr

1 I Ipkp
2

–
-----------------------------=
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Table 5-37: GE type IAC curve trip times

I2t curves
The I2t curves are derived as follows:

Eq. 5-11

where

IAC Short Inverse 0.0428 0.0609 0.6200 –0.0010 0.0221 0.222

Multiplier
(TDM)

Current ( I / Ipickup)

1.5 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0

IAC Extremely Inverse

0.5 1.699 0.749 0.303 0.178 0.123 0.093 0.074 0.062 0.053 0.046

1.0 3.398 1.498 0.606 0.356 0.246 0.186 0.149 0.124 0.106 0.093

2.0 6.796 2.997 1.212 0.711 0.491 0.372 0.298 0.248 0.212 0.185

4.0 13.591 5.993 2.423 1.422 0.983 0.744 0.595 0.495 0.424 0.370

6.0 20.387 8.990 3.635 2.133 1.474 1.115 0.893 0.743 0.636 0.556

8.0 27.183 11.987 4.846 2.844 1.966 1.487 1.191 0.991 0.848 0.741

10.0 33.979 14.983 6.058 3.555 2.457 1.859 1.488 1.239 1.060 0.926

IAC Very Inverse

0.5 1.451 0.656 0.269 0.172 0.133 0.113 0.101 0.093 0.087 0.083

1.0 2.901 1.312 0.537 0.343 0.266 0.227 0.202 0.186 0.174 0.165

2.0 5.802 2.624 1.075 0.687 0.533 0.453 0.405 0.372 0.349 0.331

4.0 11.605 5.248 2.150 1.374 1.065 0.906 0.810 0.745 0.698 0.662

6.0 17.407 7.872 3.225 2.061 1.598 1.359 1.215 1.117 1.046 0.992

8.0 23.209 10.497 4.299 2.747 2.131 1.813 1.620 1.490 1.395 1.323

10.0 29.012 13.121 5.374 3.434 2.663 2.266 2.025 1.862 1.744 1.654

IAC Inverse

0.5 0.578 0.375 0.266 0.221 0.196 0.180 0.168 0.160 0.154 0.148

1.0 1.155 0.749 0.532 0.443 0.392 0.360 0.337 0.320 0.307 0.297

2.0 2.310 1.499 1.064 0.885 0.784 0.719 0.674 0.640 0.614 0.594

4.0 4.621 2.997 2.128 1.770 1.569 1.439 1.348 1.280 1.229 1.188

6.0 6.931 4.496 3.192 2.656 2.353 2.158 2.022 1.921 1.843 1.781

8.0 9.242 5.995 4.256 3.541 3.138 2.878 2.695 2.561 2.457 2.375

10.0 11.552 7.494 5.320 4.426 3.922 3.597 3.369 3.201 3.072 2.969

IAC Short Inverse

0.5 0.072 0.047 0.035 0.031 0.028 0.027 0.026 0.026 0.025 0.025

1.0 0.143 0.095 0.070 0.061 0.057 0.054 0.052 0.051 0.050 0.049

2.0 0.286 0.190 0.140 0.123 0.114 0.108 0.105 0.102 0.100 0.099

4.0 0.573 0.379 0.279 0.245 0.228 0.217 0.210 0.204 0.200 0.197

6.0 0.859 0.569 0.419 0.368 0.341 0.325 0.314 0.307 0.301 0.296

8.0 1.145 0.759 0.559 0.490 0.455 0.434 0.419 0.409 0.401 0.394

10.0 1.431 0.948 0.699 0.613 0.569 0.542 0.524 0.511 0.501 0.493

IAC curve shape A B C D E tr

, T TDM
100
I

Ipickup
--------------

2
-----------------------

= TRESET TDM
100
I

Ipickup
--------------

2–
-------------------------

=
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T = Operate time (in seconds)
TDM = Multiplier setting
I = Input current
Ipickup = Pickup Current setting
TRESET = reset time in seconds (assuming energy capacity is 100% and RESET is “Timed”)

Table 5-38: I2t curve trip times

FlexCurves
FlexCurves are described in the FlexCurves section later in this chapter. The curve shapes for the FlexCurves are derived 
from the formulae:

Eq. 5-12

Eq. 5-13

where

T = operate time (in seconds)
TDM = Multiplier setting
I = Input Current
Ipickup = Pickup Current setting
TRESET = Reset Time in seconds (assuming energy capacity is 100% and RESET: Timed) 

Definite time curve
The Definite Time curve shape operates as soon as the pickup level is exceeded for a specified period of time. The base 
definite time curve delay is in seconds. The curve multiplier of 0.00 to 600.00 makes this delay adjustable from 
instantaneous to 600.00 seconds in steps of 10 ms. The definite time curve shapes are defined as follows:

Eq. 5-14

Eq. 5-15

where

T = Operate Time (in seconds)
TDM = Multiplier setting
I = Input Current
Ipickup = Pickup Current setting
TRESET = Reset Time in seconds (assuming energy capacity is 100% and RESET: Timed)

Multiplier
(TDM)

Current ( I / Ipickup)

1.5 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0

0.01 0.44 0.25 0.11 0.06 0.04 0.03 0.02 0.02 0.01 0.01

0.10 4.44 2.50 1.11 0.63 0.40 0.28 0.20 0.16 0.12 0.10

1.00 44.44 25.00 11.11 6.25 4.00 2.78 2.04 1.56 1.23 1.00

10.00 444.44 250.00 111.11 62.50 40.00 27.78 20.41 15.63 12.35 10.00

100.00 4444.4 2500.0 1111.1 625.00 400.00 277.78 204.08 156.25 123.46 100.00

600.00 26666.7 15000.0 6666.7 3750.0 2400.0 1666.7 1224.5 937.50 740.74 600.00

T TDM FlexCurve Time at I
Ipickup
--------------=    when I

Ipickup
-------------- 1.00

TRESET TDM FlexCurve Time at I
Ipickup
--------------    when I

Ipickup
-------------- 0.98=

T TDM  in seconds, when I Ipickup>=

TRESET TDM  in seconds=
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Recloser curves
The F60 uses the FlexCurve feature to facilitate programming of 41 recloser curves. See the FlexCurves settings section 
earlier in this chapter for details.

5.8.4.3  Phase time overcurrent (ANSI 51P, IEC PTOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  PHASE CURRENT  PHASE TOC1(6)

The phase time overcurrent element can provide a specified time-delay operating characteristic versus the applied current 
or be used as a simple definite time element. The phase current input quantities can be programmed as fundamental 
phasor magnitude or total waveform RMS magnitude as required by the application.

Two methods of resetting operation are available: “Timed” and “Instantaneous” (see the Inverse TOC Curve Characteristics 
section earlier for details on curve setup, trip times, and reset operation). When the element is blocked, the time 
accumulator resets according to the reset characteristic. For example, if the element reset characteristic is set to 
“Instantaneous” and the element is blocked, the time accumulator clears immediately.

The PHASE TOC1 PICKUP setting can be reduced dynamically by a voltage restraint feature (when enabled). This is 
accomplished via the multipliers (Mvr) corresponding to the phase-phase voltages of the voltage restraint characteristic 
curve (see the figure); the pickup level is calculated as Mvr times the PHASE TOC1 PICKUP setting. If the voltage restraint 
feature is disabled, the pickup level always remains at the setting value.

 PHASE TOC 1
  PHASE TOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 PHASE TOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 PHASE TOC1
INPUT: Phasor

Range: Phasor, RMS

 PHASE TOC1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 PHASE TOC1
CURVE: IEEE Mod Inv

Range: see Overcurrent Curve Types table

 PHASE TOC1
TD MULTIPLIER: 1.00

Range: 0.00 to 600.00 in steps of 0.01

 PHASE TOC1
RESET: Instantaneous

Range: Instantaneous, Timed

 PHASE TOC1 VOLTAGE
RESTRAINT: Disabled

Range: Disabled, Enabled

 PHASE TOC1 BLOCK A:
Off

Range: FlexLogic operand

 PHASE TOC1 BLOCK B:
Off

Range: FlexLogic operand

 PHASE TOC1 BLOCK C:
Off

Range: FlexLogic operand

 PHASE TOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PHASE TOC1
EVENTS: Disabled

Range: Disabled, Enabled



5-246 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

GROUPED ELEMENTS CHAPTER 5: SETTINGS

5

Figure 5-124: Phase time overcurrent voltage restraint characteristic 

FUNCTION — This setting enables and disables the phase time overcurrent protection element.

SIGNAL SOURCE — Selects the signal source for the phase time overcurrent protection element.

INPUT — Selects how phase current input quantities are interpreted by the F60. Inputs can be selected as fundamental 
phasor magnitudes or total waveform RMS magnitudes as required by the application.

PICKUP — Specifies the phase time overcurrent pickup level in per-unit values.

CURVE — Selects the time inverse overcurrent curve style.

TD MULTIPLIER — Specifies a multiple of the base curve shape specified by the CURVE setting. Programming this value to 
zero results in an instantaneous response to all current levels above pickup.

RESET — The “Instantaneous” reset method is intended for applications with other relays, such as most static relays, which 
set the energy capacity directly to zero when the current falls below the reset threshold. The “Timed” reset method can be 
used where the relay must coordinate with electromechanical relays.

VOLTAGE RESTRAINT — Enables and disables the phase time overcurrent voltage restraint feature.

BLOCK A — Assertion of the operand assigned to this setting blocks phase A of the phase time overcurrent element.

EVENTS — Enables and disables the logging of phase time overcurrent events in the sequence of events recorder.
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Figure 5-125: Phase time overcurrent 1 logic 

5.8.4.4  Phase instantaneous overcurrent (ANSI 50P, IEC PIOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  PHASE CURRENT  PHASE IOC 1(8)

 PHASE IOC 1
  PHASE IOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 PHASE IOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 PHASE IOC1
PICKUP: 1.000 pu

Range: 0.005 to 30.000 pu in steps of 0.001

 PHASE IOC1 PICKUP
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PHASE IOC1 RESET
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PHASE IOC1 BLOCK A:
Off

Range: FlexLogic operand



 PHASE IOC1 BLOCK C:
Off

Range: FlexLogic operand

 PHASE IOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PHASE IOC1
EVENTS: Disabled

Range: Disabled, Enabled
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The phase instantaneous overcurrent element can be used as an instantaneous element with no intentional delay or as a 
definite time element. The input current is the fundamental phasor magnitude. For timing curves, see the publication 
Instantaneous Overcurrent (IOC) Element Response to Saturated Waveforms in UR Series Relays (GET-8400A).

FUNCTION — This setting enables and disables the phase instantaneous overcurrent protection element.

SOURCE — Selects the signal source for the phase instantaneous overcurrent protection element.

PICKUP — Specifies the phase instantaneous overcurrent pickup level in per-unit values.

DELAY —Delays the assertion of the PHASE IOC OP operands. It is used to achieve timing coordination with other elements 
and relays.

RESET DELAY — Specifies a delay for the reset of the phase instantaneous overcurrent element between the operate output 
state and the return to logic 0 after the input passes outside the defined pickup range. This setting is used to ensure that 
the relay output contacts are closed long enough to ensure reception by downstream equipment.

BLOCK A — Assertion of the operand assigned to this setting block’s phase A of the phase instantaneous overcurrent 
element.

EVENTS — Enables and disables the logging of phase instantaneous overcurrent events in the sequence of events recorder.

Figure 5-126: Phase instantaneous overcurrent 1 logic 

5.8.4.5  Phase directional overcurrent (ANSI 67P, IEC PDOC/PTOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  PHASE CURRENT  PHASE DIRECTIONAL 1(2)

 PHASE 
 DIRECTIONAL 1  PHASE DIR 1

FUNCTION: Disabled
Range: Disabled, Enabled

 PHASE DIR 1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 PHASE DIR 1 BLOCK:
Off

Range: FlexLogic operand

 PHASE DIR 1
ECA: 30°

Range: 0 to 359° in steps of 1

 PHASE DIR POL V1
THRESHOLD: 0.700 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 PHASE DIR 1 BLOCK
WHEN V MEM EXP: No

Range: No, Yes

 PHASE DIR 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

http://store.gedigitalenergy.com/FAQ/Documents/B30/GET-8400.pdf
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The phase directional elements (one for each of phases A, B, and C) determine the phase current flow direction for steady 
state and fault conditions and can be used to control the operation of the phase overcurrent elements via the BLOCK inputs 
of these elements.

Figure 5-127: Phase A directional polarization 

This element is intended to apply a block signal to an overcurrent element to prevent an operation when current is flowing 
in a particular direction. The direction of current flow is determined by measuring the phase angle between the current 
from the phase CTs and the line-line voltage from the VTs, based on the 90° or quadrature connection. If there is a 
requirement to supervise overcurrent elements for flows in opposite directions, such as can happen through a bus-tie 
breaker, two phase directional elements should be programmed with opposite element characteristic angle (ECA) settings.

To increase security for three phase faults very close to the VTs used to measure the polarizing voltage, a voltage memory 
feature is incorporated. This feature stores the polarizing voltage the moment before the voltage collapses, and uses it to 
determine direction. The voltage memory remains valid for one second after the voltage has collapsed.

The main component of the phase directional element is the phase angle comparator with two inputs: the operating signal 
(phase current) and the polarizing signal (the line voltage, shifted in the leading direction by the characteristic angle, ECA).

The table shows the operating and polarizing signals used for phase directional control.

 PHASE DIR 1
EVENTS: Disabled

Range: Disabled, Enabled

The TARGET setting is not user-selectable and forced to "Disabled". If Targets are required from directional 
elements, it can be achieved by assigning directional element output to a digital element, where targets selection 
can be used as required.
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Table 5-39: Operating and polarizing signals

Mode of operation
• When the function is “Disabled” or the operating current is below 5%  CT nominal, the element output is logic “0” 

• When the function is “Enabled,” the operating current is above 5%  CT nominal, and the polarizing voltage is above 
the PRODUCT SETUP  DISPLAY PROPERTIES  VOLTAGE CUT-OFF LEVEL value, the element output is dependent on the 
phase angle between the operating and polarizing signals:

– The element output is logic “0” when the operating current is within polarizing voltage ±90°

– For all other angles, the element output is logic “1”

• Once the voltage memory has expired, the phase overcurrent elements under directional control can be set to block or 
trip on overcurrent as follows:

– When BLOCK WHEN V MEM EXP is set to “Yes,” the directional element blocks the operation of any phase 
overcurrent element under directional control when voltage memory expires

– When BLOCK WHEN V MEM EXP is set to “No,” the directional element allows tripping of phase overcurrent elements 
under directional control when voltage memory expires

In all cases, directional blocking is permitted to resume when the polarizing voltage becomes greater than the polarizing 
voltage threshold.

Settings
PHASE DIR 1 FUNCTION — This setting enables and disables the phase directional overcurrent protection element.

PHASE DIR 1 SIGNAL SOURCE — This setting is used to select the source for the operating and polarizing signals. The 
operating current for the phase directional element is the phase current for the selected current source. The polarizing 
voltage is the line voltage from the phase VTs, based on the 90° or quadrature connection and shifted in the leading 
direction by the element characteristic angle (ECA).

PHASE DIR 1 BLOCK — Assertion of the operand assigned to this setting blocks operation of the phase directional 
overcurrent element.

PHASE DIR 1 ECA — This setting specifies the element characteristic angle, that is, the angle by which the polarizing voltage 
is shifted in the leading direction to achieve dependable operation. In the design of the UR-series elements, a block is 
applied to an element by asserting logic 1 at the blocking input. Program the phase directional overcurrent element using 
this setting so that the output is logic 1 for current in the non-tripping direction.

PHASE DIR 1 POL V THRESHOLD — This setting is used to establish the minimum level of voltage for which the phase angle 
measurement is reliable. The setting is based on VT accuracy.

PHASE DIR 1 BLOCK WHEN V MEM EXP — This setting is used to select the required operation upon expiration of voltage 
memory. When set to "Yes," the directional element blocks the operation of any phase overcurrent element under 
directional control, when voltage memory expires. When set to "No," the directional element allows tripping of phase 
overcurrent elements under directional control.

PHASE DIR 1 EVENTS — This setting enables and disables the logging of phase directional overcurrent events in the 
sequence of events recorder.

Phase Operating signal Polarizing signal Vpol

ABC phase sequence ACB phase sequence

A angle of IA angle of VBC  (1ECA) angle of VCB  (1ECA)

B angle of IB angle of VCA  (1ECA) angle of VAC  (1ECA)

C angle of IC angle of VAB  (1ECA) angle of VBA  (1ECA)



CHAPTER 5: SETTINGS GROUPED ELEMENTS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-251

5

Figure 5-128: Phase directional logic 

5.8.5  Neutral current

5.8.5.1  Menu
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEUTRAL CURRENT

The phase directional element responds to the forward load current. In the case of a following reverse fault, the 
element needs some time—in the order of 8 ms—to establish a blocking signal. Some protection elements, such as 
instantaneous overcurrent, respond to reverse faults before the blocking signal is established. Therefore, a 
coordination time of at least 10 ms must be added to all the instantaneous protection elements under the 
supervision of the phase directional element. If current reversal is of concern, a longer delay—in the order of 20 
ms—is needed.

 NEUTRAL CURRENT
   NEUTRAL TOC 1


See below



  NEUTRAL TOC 6


  NEUTRAL IOC 1


See page 5-253



  NEUTRAL IOC 8
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5.8.5.2  Neutral time overcurrent (ANSI 51N, IEC PTOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEUTRAL CURRENT  NEUTRAL TOC1(6)

The neutral time overcurrent element can provide a desired time-delay operating characteristic versus the applied current 
or be used as a simple definite time element. The neutral current input value is a quantity calculated as 3Io from the phase 
currents and can be programmed as fundamental phasor magnitude or total waveform RMS magnitude as required by the 
application.

Two methods of resetting operation are available: “Timed” and “Instantaneous” (see the Inverse TOC Curve Characteristics 
section for details on curve setup, trip times, and reset operation). When the element is blocked, the time accumulator 
resets according to the reset characteristic. For example, if the element reset characteristic is set to “Instantaneous” and 
the element is blocked, the time accumulator clears immediately.

NEUTRAL TOC1 FUNCTION — This setting enables and disables the neutral time overcurrent protection element.

NEUTRAL TOC1 SIGNAL SOURCE — This setting selects the signal source for the neutral time overcurrent protection element.

NEUTRAL TOC1 INPUT — This setting selects how neutral current input quantities are interpreted by the F60. Inputs can be 
selected as fundamental phasor magnitudes or total waveform RMS magnitudes as required by the application.

NEUTRAL TOC1 PICKUP — This setting specifies the neutral time overcurrent pickup level in per-unit values.

NEUTRAL TOC1 CURVE — This setting selects the inverse time overcurrent curve style.

NEUTRAL TOC1 TD MULTIPLIER — This setting specifies a multiple of the base curve shape specified by the CURVE setting. 
Programming this value to zero results in an instantaneous response to all current levels above pickup.

NEUTRAL TOC1 RESET — The “Instantaneous” reset method is intended for applications with other relays, such as most static 
relays, which set the energy capacity directly to zero when the current falls below the reset threshold. The “Timed” reset 
method can be used where the relay must coordinate with electromechanical relays.

NEUTRAL TOC1 BLOCK — Assertion of the operand assigned to this setting blocks operation of the neutral time overcurrent 
element.

  NEUTRAL
 DIRECTIONAL OC1

See page 5-254

  NEUTRAL
 DIRECTIONAL OC2

 NEUTRAL TOC 1
  NEUTRAL TOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEUTRAL TOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEUTRAL TOC1
INPUT: Phasor

Range: Phasor, RMS

 NEUTRAL TOC1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 NEUTRAL TOC1
CURVE: IEEE Mod Inv

Range: see Overcurrent Curve Types table

 NEUTRAL TOC1
TD MULTIPLIER: 1.00

Range: 0.00 to 600.00 in steps of 0.01

 NEUTRAL TOC1
RESET: Instantaneous

Range: Instantaneous, Timed

 NEUTRAL TOC1 BLOCK:
Off

Range: FlexLogic operand

 NEUTRAL TOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 NEUTRAL TOC1
EVENTS: Disabled

Range: Disabled, Enabled
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NEUTRAL TOC1 EVENTS — This setting enables and disables the logging of neutral time overcurrent events in the sequence 
of events recorder.

Figure 5-129: Neutral time overcurrent 1 logic 

5.8.5.3  Neutral instantaneous overcurrent (ANSI 50N, IEC PIOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEUTRAL CURRENT  NEUTRAL IOC1(8)

The neutral instantaneous overcurrent element can be used as an instantaneous function with no intentional delay or as a 
definite time function. The element essentially responds to the magnitude of a neutral current fundamental frequency 
phasor calculated from the phase currents. A positive-sequence restraint is applied for better performance. A small portion 
(6.25%) of the positive-sequence current magnitude is subtracted from the zero-sequence current magnitude when 
forming the operating quantity of the element as follows:

Iop = 3 x (|I_0| - K x |I_1|) where K = 1/16 Eq. 5-16

The positive-sequence restraint allows for more sensitive settings by counterbalancing spurious zero-sequence currents 
resulting from:

• System unbalances under heavy load conditions

• Transformation errors of current transformers (CTs) during double-line and three-phase faults

• Switch-off transients during double-line and three-phase faults

 NEUTRAL IOC 1
  NEUTRAL IOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEUTRAL IOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEUTRAL IOC1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 NEUTRAL IOC1 PICKUP
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEUTRAL IOC1 RESET
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEUTRAL IOC1 BLOCK:
Off

Range: FlexLogic operand

 NEUTRAL IOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 NEUTRAL IOC1
EVENTS: Disabled

Range: Disabled, Enabled

SETTING
NEUTRAL TOC1
FUNCTION:
Enabled = 1

SETTING
NEUTRAL TOC1
SOURCE:
IN

NEUTRAL TOC1
BLOCK:
Off = 0

NEUTRAL TOC1
CURVE:
NEUTRAL TOC1
TD MULTIPLIER:
NEUTRAL TOC 1
RESET:

SETTINGS

SETTING

IN PICKUP

I

t

NEUTRAL TOC1
PICKUP:

RUN

827034A4.VSD

FLEXLOGIC OPERANDS

NEUTRAL TOC1 DPO 
NEUTRAL TOC1 OP 

NEUTRAL TOC1
INPUT:

AND
NEUTRAL TOC1 PKP 
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The positive-sequence restraint must be considered when testing for pickup accuracy and response time (multiple of 
pickup). The operating quantity depends on how test currents are injected into the relay (single-phase injection):

Eq. 5-17

NEUTRAL IOC1 FUNCTION — This setting enables and disables the neutral instantaneous overcurrent protection element.

NEUTRAL IOC1 SIGNAL SOURCE — This setting selects the signal source for the neutral instantaneous overcurrent protection 
element.

NEUTRAL IOC1 PICKUP — This setting specifies the neutral instantaneous overcurrent pickup level in per-unit values.

NEUTRAL IOC1 PICKUP DELAY — This setting delays the assertion of the NEUTRAL IOC OP operands. It is used to achieve timing 
coordination with other elements and relays.

NEUTRAL IOC1 RESET DELAY — This setting specifies a delay for the reset of the neutral instantaneous overcurrent element 
between the operate output state and the return to logic 0 after the input passes outside the defined pickup range. This 
setting is used to ensure that the relay output contacts are closed long enough to ensure reception by downstream 
equipment.a

NEUTRAL IOC1 BLOCK — Assertion of the operand assigned to this setting blocks operation of the neutral instantaneous 
overcurrent element.

NEUTRAL IOC1 EVENTS — This setting enables and disables the logging of neutral instantaneous overcurrent events in the 
sequence of events recorder.

Figure 5-130: Neutral IOC1 logic 

5.8.5.4  Neutral directional overcurrent (ANSI 67N, IEC PDEF/PTOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEUTRAL CURRENT  NEUTRAL DIRECTIONAL 
OC1(2)

 NEUTRAL
 DIRECTIONAL OC1  NEUTRAL DIR OC1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEUTRAL DIR OC 1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEUTRAL DIR OC1
POLARIZING: Voltage

Range: Voltage, Current, Dual, Dual-V, Dual-I

 NEUTRAL DIR OC1 POL
VOLT: Calculated V0

Range: Calculated V0, Measured VX

 NEUTRAL DIR OC1 OP
CURR: Calculated 3I0

Range: Calculated 3I0, Measured IG

 NEUTRAL DIR OC1 POS-
SEQ RESTRAINT: 0.063

Range: 0.000 to 0.500 in steps of 0.001

Iop
1
3
--- 3 K– Iinjected=
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The neutral directional overcurrent element provides both forward and reverse fault direction indications for the NEUTRAL 
DIR OC1 FWD and NEUTRAL DIR OC1 REV operands, respectively. The output operand is asserted if the magnitude of the 
operating current is above a pickup level (overcurrent unit) and the fault direction is seen as forward or reverse, 
respectively (directional unit).

The overcurrent unit responds to the magnitude of a fundamental frequency phasor of either the neutral current 
calculated from the phase currents or the ground current. There are separate pickup settings for the forward-looking and 
reverse-looking functions. If set to use the calculated 3I_0, the element applies a positive-sequence restraint for better 
performance: a small user-programmable portion of the positive-sequence current magnitude is subtracted from the 
zero-sequence current magnitude when forming the operating quantity.

Iop = 3 x (|I_0| - K x |I_1|) Eq. 5-18

The positive-sequence restraint allows for more sensitive settings by counterbalancing spurious zero-sequence currents 
resulting from

• System unbalances under heavy load conditions

• Transformation errors of current transformers (CTs) during double-line and three-phase faults

• Switch-off transients during double-line and three-phase faults

The positive-sequence restraint must be considered when testing for pickup accuracy and response time (multiple of 
pickup). The operating quantity depends on the way the test currents are injected into the relay (single-phase injection: 
Iop = (1 – K)  Iinjected ; three-phase pure zero-sequence injection: Iop = 3  Iinjected.

The positive-sequence restraint is removed for low currents. If the positive-sequence current is below 0.8 pu, the restraint is 
removed by changing the constant K to zero. This facilitates better response to high-resistance faults when the unbalance 
is very small and there is no danger of excessive CT errors as the current is low.

The directional unit uses the zero-sequence current (I_0) or ground current (IG) for fault direction discrimination and can 
be programmed to use either zero-sequence voltage (“Calculated V0” or “Measured VX”), ground current (IG), or both for 
polarizing. The zero-sequence current (I_0) must be greater than the PRODUCT SETUP  DISPLAY PROPERTIES  CURRENT 
CUT-OFF LEVEL setting value and IG must be greater than 0.05 pu to be validated as the operating quantity for directional 
current. The following tables define the neutral directional overcurrent element. V_0 is the zero-sequence voltage, I_0 is 
the zero-sequence current, ECA is the element characteristic angle, and IG is the ground current.

 NEUTRAL DIR OC1
OFFSET: 0.00 

Range: 0.00 to 250.00  in steps of 0.01

 NEUTRAL DIR OC1 FWD
ECA: 75° Lag

Range: –90 to 90° in steps of 1

 NEUTRAL DIR OC1 FWD
LIMIT ANGLE: 90°

Range: 40 to 90° in steps of 1

 NEUTRAL DIR OC1 FWD
PICKUP: 0.050 pu

Range: 0.006 to 30.000 pu in steps of 0.001

 NEUTRAL DIR OC1 REV
LIMIT ANGLE: 90°

Range: 40 to 90° in steps of 1

 NEUTRAL DIR OC1 REV
PICKUP: 0.050 pu

Range: 0.006 to 30.000 pu in steps of 0.001

 NEUTRAL DIR OC1 BLK:
Off

Range: FlexLogic operand

 NEUTRAL DIR OC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 NEUTRAL DIR OC1
EVENTS: Disabled

Range: Disabled, Enabled
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Table 5-40: Quantities for "calculated 3I0" configuration

Table 5-41: Quantities for "measured IG" configuration

where

ECA = element characteristic angle
IG = ground current
Z_offset is the offset impedance, for which magnitude is the OFFSET setting and angle is the FWD ECA

When NEUTRAL DIR OC1 POL VOLT is set to “Measured VX,” one-third of this voltage is used in place of V_0. The following 
figure explains the usage of the voltage polarized directional unit of the element.

The figure shows the voltage-polarized phase angle comparator characteristics for a phase A to ground fault, with:

• ECA = 90° (element characteristic angle = centerline of operating characteristic)

• FWD LA = 80° (forward limit angle = the ± angular limit with the ECA for operation)

• REV LA = 80° (reverse limit angle = the ± angular limit with the ECA for operation)

The element incorporates a current reversal logic. If the reverse direction is indicated for at least 1.25 of a power system 
cycle, the prospective forward indication is delayed by 1.5 of a power system cycle. The element is designed to emulate an 
electromechanical directional device. Larger operating and polarizing signals results in faster directional discrimination 
bringing more security to the element operation.

The forward-looking function is designed to be more secure as compared to the reverse-looking function, and therefore is 
to be used for the tripping direction. The reverse-looking function is designed to be faster as compared to the forward-
looking function and is to be used for the blocking direction. This allows for better protection coordination.

Take the bias into account when using the neutral directional overcurrent element to directionalize other protection 
elements.

Directional unit Overcurrent unit

Polarizing mode Direction Compared phasors

Voltage Forward –V_0 + Z_offset  I_0 I_0  1ECA Iop = 3  (|I_0| – K  |I_1|) if |I1| > 0.8 pu
Iop = 3  (|I_0|) if |I1|  0.8 puReverse –V_0 + Z_offset  I_0 –I_0  1ECA

Current Forward IG I_0

Reverse IG –I_0

Dual, Dual-V, Dual-I Forward –V_0 + Z_offset  I_0 I_0  1ECA

or

IG I_0

Reverse –V_0 + Z_offset  I_0 –I_0  1ECA

or

IG –I_0

Directional unit Overcurrent unit

Polarizing mode Direction Compared phasors

Voltage Forward –V_0 + Z_offset  IG/3 IG  1ECA Iop = |IG|

Reverse –V_0 + Z_offset  IG/3 –IG  1ECA

V_0 1
3
--- VAG VBG VCG+ + zero sequence voltage= =

I_0 1
3
--- IN 1

3
--- IA IB IC+ + zero sequence current= = =
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Figure 5-131: Neutral directional voltage-polarized characteristics 

NEUTRAL DIR OC1 POLARIZING — This setting selects the polarizing mode for the directional unit.

• If “Voltage” polarizing is selected, the element uses the zero-sequence voltage angle for polarization. The user can use 
either the zero-sequence voltage V_0 calculated from the phase voltages, or the zero-sequence voltage supplied 
externally as the auxiliary voltage V_X, both from the NEUTRAL DIR OC1 SOURCE.

The calculated V_0 can be used as polarizing voltage only if the voltage transformers are connected in Wye. The 
auxiliary voltage can be used as the polarizing voltage provided SYSTEM SETUP  AC INPUTS  VOLTAGE BANK  
AUXILIARY VT CONNECTION is set to “Vn” and the auxiliary voltage is connected to a zero-sequence voltage source 
(such as broken delta connected secondary of VTs).

The zero-sequence voltage V_0 must be greater than 0.02 pu to be validated for use as a polarizing signal. 
Additionally, when offset impedance is applied and zero-sequence current is above 0.2 pu, compensated zero-
sequence voltage -V_0 + Z_offset x I_0 has to be above 0.02 pu in order to discriminate fault direction; otherwise 
when zero-sequence current is less than 0.2 pu, -V_0 is then used as the polarizing signal. If the polarizing signal is 
invalid, neither forward nor reverse indication is given.

• If “Current” polarizing is selected, the element uses the ground current angle connected externally and configured 
under NEUTRAL OC1 SOURCE for polarization. The ground CT must be connected between the ground and neutral point 
of an adequate local source of ground current. The ground current must be greater than 0.05 pu to be validated as a 
polarizing signal. If the polarizing signal is not valid, neither forward nor reverse indication is given. In addition, the 
zero-sequence current (I_0) must be greater than the PRODUCT SETUP  DISPLAY PROPERTIES  CURRENT CUT-OFF 
LEVEL setting value.

For a choice of current polarizing, it is recommended that the polarizing signal be analyzed to ensure that a known 
direction is maintained irrespective of the fault location. For example, if using an autotransformer neutral current as a 
polarizing source, ensure that a reversal of the ground current does not occur for a high-side fault. Assume that the 

827805A1.CDR
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low-side system impedance is minimal when checking for this condition. A similar situation arises for a wye/delta/wye 
transformer, where current in one transformer winding neutral can reverse when faults on both sides of the 
transformer are considered.

• If “Dual” polarizing is selected, the element performs both directional comparisons as described. A given direction is 
confirmed if either voltage or current comparators indicate so. If a conflicting (simultaneous forward and reverse) 
indication occurs, the forward direction overrides the reverse direction.

• If "Dual-V" polarizing is selected, "Voltage" polarizing is performed and "Current" polarizing is ignored if the voltage 
polarizing signal is valid; otherwise "Current" polarizing is performed if the current polarizing signal is valid. If neither of 
them is valid, neither forward nor reverse indication is given.

• If "Dual-I" polarizing is selected, "Current" polarizing is performed and "Voltage" polarizing is ignored if the current 
polarizing signal is valid; otherwise "Voltage" polarizing is performed if the voltage polarizing signal is valid. If neither of 
them is valid, neither forward nor reverse indication is given.

NEUTRAL DIR OC1 POL VOLT — Selects the polarizing voltage used by the directional unit when "Voltage," "Dual," "Dual-V," or 
"Dual-I" polarizing mode is set. The polarizing voltage can be programmed to be either the zero-sequence voltage 
calculated from the phase voltages ("Calculated V0") or supplied externally as an auxiliary voltage ("Measured VX").

NEUTRAL DIR OC1 OP CURR — This setting indicates whether the 3I_0 current calculated from the phase currents, or the 
ground current is used by this protection. This setting acts as a switch between the neutral and ground modes of operation 
(ANSI devices 67N and 67G). If set to “Calculated 3I0,” the element uses the phase currents and applies the positive-
sequence restraint. If set to “Measured IG,” the element uses ground current supplied to the ground CT of the CT bank 
configured as NEUTRAL DIR OC1 SOURCE. If this setting is “Measured IG,” then the NEUTRAL DIR OC1 POLARIZING setting must 
be “Voltage”, as it is not possible to use the ground current as an operating and polarizing signal simultaneously. IG current 
has to be above 0.05 ps to be used as operate quantity.

NEUTRAL DIR OC1 POS-SEQ RESTRAINT — This setting controls the amount of the positive-sequence restraint. Set it to 0.063 
for backward compatibility with firmware revision 3.40 and older. Set it to zero to remove the restraint. Set it higher if large 
system unbalances or poor CT performance are expected.

NEUTRAL DIR OC1 OFFSET — This setting specifies the offset impedance used by this protection. The primary application for 
the offset impedance is to guarantee correct identification of fault direction on series compensated lines. In regular 
applications, the offset impedance ensures proper operation even if the zero-sequence voltage at the relaying point is very 
small. If this is the intent, the offset impedance is not to be larger than the zero-sequence impedance of the protected 
circuit. Practically, it shall be several times smaller. Enter the offset impedance in secondary ohms.

NEUTRAL DIR OC1 FWD ECA — This setting defines the characteristic angle (ECA) for the forward direction in the "Voltage" 
polarizing mode. The "Current" polarizing mode uses a fixed ECA of 0°. The ECA in the reverse direction is the angle set for 
the forward direction shifted by 180°.

NEUTRAL DIR OC1 FWD LIMIT ANGLE — This setting defines a symmetrical (in both directions from the ECA) limit angle for the 
forward direction.

NEUTRAL DIR OC1 FWD PICKUP — This setting defines the pickup level for the overcurrent unit of the element in the forward 
direction. When selecting this setting, keep in mind that the design uses a positive-sequence restraint technique for the 
“Calculated 3I0” mode of operation.

NEUTRAL DIR OC1 REV LIMIT ANGLE — This setting defines a symmetrical (in both directions from the ECA) limit angle for the 
reverse direction.

NEUTRAL DIR OC1 REV PICKUP — This setting defines the pickup level for the overcurrent unit of the element in the reverse 
direction. When selecting this setting, keep in mind that the design uses a positive-sequence restraint technique for the 
“Calculated 3I0” mode of operation.
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Figure 5-132: Neutral directional overcurrent logic 

5.8.6  Wattmetric ground fault

5.8.6.1  Wattmetric zero-sequence directional (ANSI 32N, IEC PSDE)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  WATTMETRIC...  WATTMETRIC GROUND FAULT 1(2)

 WATTMETRIC
 GROUND FAULT 1  WATTMETRIC GND FLT 1

FUNCTION: Disabled
Range: Disabled, Enabled

 WATTMETRIC GND FLT 1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 WATTMETRIC GND FLT 1
VOLT: Calculated VN

Range: Calculated VN, Measured VX

 WATTMETRIC GND FLT 1
OV PKP: 0.20 pu

Range: 0.02 to 3.00 pu in steps of 0.01

 WATTMETRIC GND FLT 1
CURR: Calculated IN

Range: Calculated IN, Measured IG

 WATTMETRIC GND FLT 1
OC PKP: 0.060 pu

Range: 0.002 to 30.000 pu in steps of 0.001
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The wattmetric zero-sequence directional element responds to power derived from zero-sequence voltage and current in 
a direction specified by the element characteristic angle. The angle can be set within all four quadrants, and the power can 
be active or reactive. Therefore, the element can be used to sense either forward or reverse ground faults in either 
inductive, capacitive, or resistive networks. The inverse time characteristic allows time coordination of elements across the 
network.

Typical applications include ground fault protection in solidly grounded transmission networks, grounded/ungrounded/
resistor-grounded/resonant-grounded distribution networks, or for directionalizing other non-directional ground elements.

WATTMETRIC GND FLT 1 VOLT — The element uses neutral voltage (that is, three times the zero-sequence voltage). This 
setting allows selecting between the internally calculated neutral voltage or the externally supplied voltage (broken delta 
VT connected to the auxiliary channel bank of the relay). When the latter selection is made, the auxiliary channel must be 
identified by the user as a neutral voltage under the VT bank settings. This element operates when the auxiliary voltage is 
configured as neutral.

WATTMETRIC GND FLT 1 OV PKP — This setting specifies the minimum zero sequence voltage supervising the directional 
power measurement. Set this threshold higher than possible unbalance during normal operation of the system. Typically, 
this setting is at 0.1 to 0.2 pu for the ungrounded or resonant grounded systems and at 0.05 to 0.1 pu for solidly or resistor-
grounded systems. When using externally supplied voltage via the auxiliary voltage channel, 1 pu is the nominal voltage of 
this channel as per VT bank settings. When using internally calculated neutral voltage, 1 pu is the nominal phase to ground 
voltage as per the VT bank settings.

WATTMETRIC GND FLT 1 CURR — The element responds to the neutral current (that is, three times zero-sequence current), 
either calculated internally from the phase currents or supplied externally via the ground CT input from more accurate 
sources such as the core balanced CT. This setting allows selecting the source of the operating current.

WATTMETRIC GND FLT 1 OC PKP — This setting specifies the current supervision level for the measurement of the zero-
sequence power.

WATTMETRIC GND FLT 1 OC PKP DEL — This setting specifies delay for the overcurrent portion of this element. The delay 
applies to the WATTMETRIC 1 PKP operand driven from the overcurrent condition.

WATTMETRIC GND FLT 1 PWR PKP — This setting specifies the operating point of the element. A value of 1 pu is a product of 
the 1 pu voltage as specified for the overvoltage condition of this element, and 1 pu current as specified for the 
overcurrent condition of this element.

 WATTMETRIC GND FLT 1
OC PKP DEL: 0.20 s

Range: 0.00 to 600.00 s in steps of 0.01

 WATTMETRIC GND FLT 1
PWR PKP: 0.100 pu

Range: 0.001 to 1.200 pu in steps of 0.001

 WATTMETRIC GND FLT 1
REF PWR: 0.500 pu

Range: 0.001 to 1.200 pu in steps of 0.001

 WATTMETRIC GND FLT 1
ECA: 0° Lag

Range: 0 to 360° Lag in steps of 1

 WATTMETRIC GND FLT 1
PWR PKP DEL: 0.20 s

Range: 0.00 to 600.00 s in steps of 0.01

 WATTMETRIC GND FLT 1
CURVE: Definite Time

Range: Definite Time, Inverse, FlexCurves A through 
D

 WATTMETRIC GND FLT 1
MULTIPLIER: 1.00 s

Range: 0.01 to 2.00 s in steps of 0.01

 WATT GND FLT 1 BLK:
Off

Range: FlexLogic operand

 WATTMETRIC GND FLT 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 WATTMETRIC GND FLT 1
EVENTS: Disabled

Range: Disabled, Enabled
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WATTMETRIC GND FLT 1 REF PWR — This setting is used to calculate the inverse time characteristic delay (defined by Sref in 
the following equations). A value of 1 pu represents the product of a 1 pu voltage (as specified in the overvoltage condition 
for this element) and a 1 pu current (as specified in the overcurrent condition for this element.

WATTMETRIC GND FLT 1 ECA — This setting adjusts the maximum torque angle of the element. The operating power is 
calculated as:

S_op = Re(Vn(In x 1ECA)*) Eq. 5-19

where

* indicates complex conjugate

By varying the element characteristic angle (ECA), the element can be made to respond to forward or reverse direction in 
inductive, resistive, or capacitive networks as shown in the Wattmetric Characteristic Angle Response diagram.

WATTMETRIC GND FLT 1 PWR PKP DEL — This setting defines a definite time delay before the inverse time characteristic is 
activated. If the curve selection is set as “Definite Time”, the element operates after this security time delay. If the curve 
selection is “Inverse” or one of the FlexCurves, the element uses both the definite and inverse time timers simultaneously. 
The definite time timer, specified by this setting, is used and when expires it releases the inverse time timer for operation 
(torque control).

WATTMETRIC GND FLT 1 CURVE — Choose one of three methods to delay the operate signal once all conditions are met to 
discriminate fault direction.

The “Definite Time” selection allows for a fixed time delay defined by the WATTMETRIC GND FLT 1 PWR PKP DEL setting.

The “Inverse” selection allows for inverse time characteristics delay defined by the following formula:

Eq. 5-20

where

m is a multiplier defined by the multiplier setting
Sref is the multiplier setting
Sop is the operating power at the time

This timer starts after the definite time timer expires.

The four FlexCurves allow for custom user-programmable time characteristics. When working with FlexCurves, the 
element uses the operate to pickup ratio, and the multiplier setting is not applied:

Eq. 5-21

Again, the FlexCurve timer starts after the definite time timer expires.

t m
Sref

Sop
--------=

t FlexCurve
Sop
Sref
--------=
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Figure 5-133: Wattmetric characteristic angle response 

WATTMETRIC GND FLT 1 MULTIPLIER — This setting is applicable if the WATTMETRIC GND FLT 1 CURVE is set to Inverse and 
defines the multiplier factor for the inverse time delay.
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Figure 5-134: Wattmetric zero-sequence directional logic 

5.8.7  Ground current

5.8.7.1  Menu
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  GROUND CURRENT

 GROUND CURRENT
   GROUND TOC1


See below
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For information on the Ground Time Overcurrent curves, see the Inverse Time Overcurrent Characteristics section earlier.

5.8.7.2  Ground time overcurrent (ANSI 50G, IEC PIOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  GROUND CURRENT  GROUND TOC1(4)

This element can provide a required time-delay operating characteristic versus the applied current or be used as a simple 
definite time element. The ground current input value is the quantity measured by the ground input CT and is the 
fundamental phasor or RMS magnitude. Two methods of resetting operation are available: “Timed” and “Instantaneous” 
(see the Inverse TOC Curve Characteristics section for details). When the element is blocked, the time accumulator resets 
according to the reset characteristic. For example, if the element reset characteristic is set to “Instantaneous” and the 
element is blocked, the time accumulator clears immediately.

GROUND TOC1 FUNCTION — This setting enables and disables the ground time overcurrent protection element.

GROUND TOC1 SIGNAL SOURCE — This setting selects the signal source for the ground time overcurrent protection element.

GROUND TOC1 INPUT — This setting selects how ground current input quantities are interpreted by the F60. Inputs can be 
selected as fundamental phasor magnitudes or total waveform RMS magnitudes as required by the application.

GROUND TOC1 PICKUP — This setting specifies the ground time overcurrent pickup level in per-unit values.

  GROUND TOC4


  GROUND IOC1


See page 5-265



  GROUND IOC6


  RESTRICTED GROUND
 FAULT 1

See page 5-266



  RESTRICTED GROUND
 FAULT 4

 GROUND TOC1
  GROUND TOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 GROUND TOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 GROUND TOC1
INPUT: Phasor

Range: Phasor, RMS

 GROUND TOC1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 GROUND TOC1
CURVE: IEEE Mod Inv

Range: see the Overcurrent Curve Types table

 GROUND TOC1
TD MULTIPLIER: 1.00

Range: 0.00 to 600.00 in steps of 0.01

 GROUND TOC1
RESET: Instantaneous

Range: Instantaneous, Timed

 GROUND TOC1 BLOCK:
Off

Range: FlexLogic operand

 GROUND TOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 GROUND TOC1
EVENTS: Disabled

Range: Disabled, Enabled
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GROUND TOC1 CURVE — This setting selects the inverse time overcurrent curve style.

GROUND TOC1 TD MULTIPLIER — This setting specifies a multiple of the base curve shape specified by the CURVE setting. 
Programming this value to zero results in an instantaneous response to all current levels above pickup.

GROUND TOC1 RESET — The “Instantaneous” reset method is intended for applications with other relays, such as most static 
relays, which set the energy capacity directly to zero when the current falls below the reset threshold. The “Timed” reset 
method can be used where the relay must coordinate with electromechanical relays.

GROUND TOC1 BLOCK — Assertion of the operand assigned to this setting blocks operation of the ground time overcurrent 
element.

GROUND TOC1 EVENTS — This setting enables and disables the logging of ground time overcurrent events in the sequence 
of events recorder.

Figure 5-135: Ground TOC1 logic 

5.8.7.3  Ground instantaneous overcurrent (ANSI 50G, IEC PIOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  GROUND CURRENT   GROUND IOC1(6)

These elements measure the current that is connected to the ground channel of a CT/VT module. The conversion 
range of a standard channel is from 0.02 to 46 times the CT rating.

This channel can be also equipped with a sensitive input. The conversion range of a sensitive channel is from 0.002 
to 4.6 times the CT rating.

 GROUND IOC1
  GROUND IOC 1

FUNCTION: Disabled
Range: Disabled, Enabled

 GROUND IOC 1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 GROUND IOC 1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 GROUND IOC 1 PICKUP
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 GROUND IOC 1 RESET
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 GROUND IOC 1 BLOCK:
Off

Range: FlexLogic operand

SETTING
GROUND TOC1
FUNCTION:
Enabled = 1

SETTING
GROUND TOC1
SOURCE:
IG

GROUND TOC1
BLOCK:
Off = 0

FLEXLOGIC OPERANDS

GROUND TOC1 DPO 
GROUND TOC1 OP 

GROUND TOC1
CURVE:
GROUND TOC1
TD MULTIPLIER:
GROUND TOC 1
RESET:

SETTINGS

SETTING

IG PICKUP

I

t

GROUND TOC1
PICKUP:

RUN

827036A4.VSD

GROUND TOC1
INPUT:

AND
GROUND TOC1 PKP 
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The ground instantaneous overcurrent element can be used as an instantaneous element with no intentional delay or as a 
definite time element. The ground current input is the quantity measured by the ground input CT and is the fundamental 
phasor magnitude.

Figure 5-136: Ground IOC1 logic 

5.8.7.4  Restricted ground fault (ANSI 87RGF, IEC PNDF)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  GROUND CURRENT   RESTRICTED GROUND FAULT 
1(4)

 GROUND IOC 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 GROUND IOC 1
EVENTS: Disabled

Range: Disabled, Enabled

These elements measure the current that is connected to the ground channel of a CT/VT module. The conversion 
range of a standard channel is from 0.02 to 46 times the CT rating.

This channel can be equipped with a standard or sensitive input. The conversion range of a sensitive channel is 
from 0.002 to 4.6 times the CT rating.

 RESTRICTED GROUND
 FAULT 1  RESTD GND FT1

FUNCTION: Disabled
Range: Disabled, Enabled

 RESTD GND FT1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 RESTD GND FT1
PICKUP: 0.080 pu

Range: 0.005 to 30.000 pu in steps of 0.001

 RESTD GND FT1
SLOPE: 40%

Range: 0 to 100% in steps of 1

 RESTD GND FT1 PICKUP
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 RESTD GND FT1 RESET
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 RESTD GND FT1 BLOCK:
Off

Range: FlexLogic operand

 RESTD GND FT1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

SETTING
GROUND IOC1
FUNCTION:
Enabled = 1

SETTING
GROUND IOC1
SOURCE:
IG

GROUND IOC1
BLOCK:
Off = 0

FLEXLOGIC OPERANDS

GROUND IOIC DPO
GROUND IOC1 OP

SETTING

SETTING

IG PICKUP

GROUND IOC1
PICKUP:

RUN

GROUND IOC1 PICKUP
DELAY:

SETTINGS

GROUND IOC1 RESET
DELAY:

tPKP

tRST

827037A5.VSD

AND

GROUND IOC1 PKP
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Restricted ground fault (RGF) protection provides sensitive ground fault detection for low-magnitude fault currents, 
primarily faults close to the neutral point of a wye-connected winding. An internal ground fault on an impedance grounded 
wye winding produces a fault current dependent on the ground impedance value and the fault position on the winding 
with respect to the neutral point. The resultant primary current is negligible for faults on the lower 30% of the winding 
since the fault voltage is not the system voltage, but rather the result of the transformation ratio between the primary 
windings and the percentage of shorted turns on the secondary. Therefore, the resultant differential currents can be below 
the slope threshold of the main differential element and the fault can go undetected. Application of the restricted ground 
fault protection extends the coverage towards the neutral point (see the following figure).

Figure 5-137: RGF and percent differential zones of protection 

This protection is often applied to transformers having impedance-grounded wye windings. The element can also be 
applied to the stator winding of a generator having the neutral point grounded with a CT installed in the grounding path, or 
the ground current obtained by external summation of the neutral-side stator CTs. The following figure shows the basic 
application and wiring rules.

 RESTD GND FT1
EVENTS: Disabled

Range: Disabled, Enabled
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Figure 5-138: Typical applications of RGF protection 

The relay incorporates low-impedance restricted ground fault protection. This low-impedance form of protection faces 
potential stability problems. An external phase-to-phase fault is an ultimate case. Ideally, there is neither ground (IG) nor 
neutral (IN = IA + IB + IC) current present. If one or more of the phase CTs saturate, a spurious neutral current is seen by the 
relay. This is similar to a single infeed situation and can be mistaken for an internal fault. Similar difficulties occur in a 
breaker-and-a-half application of the restricted ground fault, where any through fault with a weak infeed from the winding 
itself can cause problems.

The UR uses a novel definition of the restraining signal to cope with the above stability problems while providing fast and 
sensitive protection. Even with the improved definition of the restraining signal, the breaker-and-a-half application of the 
restricted ground fault must be approached with care, and is not recommended unless the settings are carefully selected 
to avoid maloperation due to CT saturation.

The differential current is produced as an unbalance current between the ground current of the neutral CT (IG) and the 
neutral current derived from the phase CTs (IN = IA + IB + IC):

Igd = |IG + IN| = |IG + IA + IB + IC| Eq. 5-22

The relay automatically matches the CT ratios between the phase and ground CTs by re-scaling the ground CT to the 
phase CT level. The restraining signal ensures stability of protection during CT saturation conditions and is produced as a 
maximum value between three components related to zero, negative, and positive-sequence currents of the three phase 
CTs as follows:

Irest = max(IR0, IR1, IR2) Eq. 5-23

The zero-sequence component of the restraining signal (IR0) is meant to provide maximum restraint during external 
ground faults, and therefore is calculated as a vectorial difference of the ground and neutral currents:

IR0 = |IG - IN| = |IG - (IA +IB +IC)| Eq. 5-24
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The equation above brings an advantage of generating the restraining signal of twice the external ground fault current, 
while reducing the restraint below the internal ground fault current. The negative-sequence component of the restraining 
signal (IR2) is meant to provide maximum restraint during external phase-to-phase faults and is calculated as follows:

IR2 = |I_2|  or  IR2 = 3 x |I_2| Eq. 5-25

Following complete de-energization of the windings (all three phase currents below 5% of nominal for at least five cycles), 
the relay uses a multiplier of 1 in preparation for the next energization. The multiplier of 3 is used during normal operation; 
that is, two cycles after the winding has been energized. The lower multiplier is used to ensure better sensitivity when 
energizing a faulty winding.

The positive-sequence component of the restraining signal (IR1) is meant to provide restraint during symmetrical 
conditions, either symmetrical faults or load, and is calculated according to the following algorithm:

1 If |I_1| > 2 pu of phase CT, then
2 If |I_1| > |I_0|, then IR1 = 3 x (|I_1| - |I_0|)
3 else IR1 = 0
4 else IR1 = |I_1|/8

Under load-level currents (below 200% of nominal), the positive-sequence restraint is set to 1/8th of the positive-sequence 
current (line 4). This is to ensure maximum sensitivity during low-current faults under full load conditions. Under fault-level 
currents (above 200% of nominal), the positive-sequence restraint is removed if the zero-sequence component is greater 
than the positive-sequence (line 3), or set at the net difference of the two (line 2).

The raw restraining signal (Irest) is further post-filtered for better performance during external faults with heavy CT 
saturation and for better switch-off transient control:

Igr(k) = max(Irest(k),  x Igr(k - 1)) Eq. 5-26

where

k represents a present sample
k – 1 represents the previous sample
 is a factory constant (  1)

The equation above introduces a decaying memory to the restraining signal. Should the raw restraining signal (Irest) 
disappear or drop significantly, such as when an external fault gets cleared or a CT saturates heavily, the actual 
restraining signal (Igr(k)) does not reduce instantly but keeps decaying decreasing its value by 50% each 15.5 power 
system cycles.

Having the differential and restraining signals developed, the element applies a single slope differential characteristic with 
a minimum pickup as shown in the following logic diagram.

Figure 5-139: Restricted ground fault logic 
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The following examples explain how the restraining signal is created for maximum sensitivity and security. These examples 
clarify the operating principle and provide guidance for testing of the element.

Example 1: External single-line-to-ground fault
Given the following inputs: IA = 1 pu 0°, IB = 0, IC = 0, and IG = 1 pu180°

The relay calculates the following values:

Igd = 0, , and Igr = 2 pu

The restraining signal is twice the fault current. This gives extra margin if the phase or neutral CT saturates.

Example 2: External high-current SLG fault
Given the following inputs: IA = 10 pu 0°, IB = 0, IC = 0, and IG = 10 pu –180°

The relay calculates the following values:

Igd = 0, , and Igr = 20 pu

Example 3: External high-current three-phase symmetrical fault
Given the following inputs: IA = 10 pu 0°, IB = 10 pu –120°, IC = 10 pu 120°, and IG = 0 pu

The relay calculates the following values:

Igd = 0, , and Igr = 10 pu

Example 4: Internal low-current single-line-to-ground fault under full load
Given the following inputs: IA = 1.10 pu 0°, IB = 1.0 pu –120°, IC = 1.0 pu 120°, and IG = 0.05 pu 0°

The relay calculates the following values:
I_0 = 0.033 pu 0°, I_2 = 0.033 pu 0°, and I_1 = 1.033 pu 0°
Igd = abs(3  0.0333 + 0.05) = 0.15 pu, IR0 = abs(3  0.033 – (0.05)) = 0.05 pu, IR2 = 3  0.033 = 0.10 pu,
IR1 = 1.033 / 8 = 0.1292 pu, and Igr = 0.1292 pu

Despite very low fault current level, the differential current is above 100% of the restraining current.

Example 5: Internal low-current, high-load single-line-to-ground fault with no feed from the ground
Given the following inputs: IA = 1.10 pu 0°, IB = 1.0 pu –120°, IC = 1.0 pu 120°, and IG = 0.0 pu 0°

The relay calculates the following values:
I_0 = 0.033 pu 0°, I_2 = 0.033 pu 0°, and I_1 = 1.033 pu 0°
Igd = abs(3  0.0333 + 0.0) = 0.10 pu, IR0 = abs(3  0.033 – (0.0)) = 0.10 pu, IR2 = 3  0.033 = 0.10 pu,
IR1 = 1.033 / 8 = 0.1292 pu, and Igr = 0.1292 pu

Despite very low fault current level the differential current is above 75% of the restraining current.

Example 6: Internal high-current single-line-to-ground fault with no feed from the ground
Given the following inputs: IA = 10 pu 0°, IB = 0 pu, IC = 0 pu, and IG = 0 pu

The relay calculates the following values:
I_0 = 3.3 pu 0°, I_2 = 3.3 pu 0°, and I_1 = 3.3 pu 0°

, , IR0 abs 3 1
3
-- 1–– 2 pu= = IR2 3 1

3
-- 1 pu= = IR1 1 3

8
--------- 0.042 pu= =

, , IR0 abs 3 1
3
-- 10–– 20 pu= = IR2 3 10

3
----- 10 pu= = IR1 3 10

3
----- 10

3
-----– 0= =

, , IR0 abs 3 0 0– 0 pu= = IR2 3 0 0 pu= = IR1 3 10
3

----- 0– 10 pu= =
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Igd = abs(3  3.3 + 0.0) = 10 pu, IR0 = abs(3  3.3 – (0.0)) = 10 pu, IR2 = 3  3.3 = 10 pu, IR1 = 3  (3.33 – 3.33) = 0 pu, and 
Igr = 10 pu

The differential current is 100% of the restraining current.

5.8.8  Negative sequence current

5.8.8.1  Menu
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEGATIVE SEQUENCE CURRENT

The F60 provides two negative-sequence time overcurrent elements, two negative-sequence instantaneous overcurrent 
elements, and two negative-sequence directional overcurrent elements. For information on the negative sequence time 
overcurrent curves, see the Inverse TOC Curve Characteristics section earlier.

5.8.8.2  Negative sequence time overcurrent (ANSI 51Q, IEC PTOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEGATIVE SEQUENCE CURRENT  NEG SEQ TOC1(2)

The negative-sequence time overcurrent element can be used to determine and clear unbalance in the system. The input 
for calculating negative-sequence current is the fundamental phasor value.

 NEGATIVE SEQUENC
 CURRENT   NEG SEQ TOC1

 
See below

  NEG SEQ TOC2
 

  NEG SEQ IOC1
 

See page 5-272

  NEG SEQ IOC2
 

  NEG SEQ DIR OC1
 

See page 5-273

  NEG SEQ DIR OC2
 

 NEG SEQ TOC1
  NEG SEQ TOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEG SEQ TOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEG SEQ TOC1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 NEG SEQ TOC1
CURVE: IEEE Mod Inv

Range: see Overcurrent Curve Types table

 NEG SEQ TOC1
TD MULTIPLIER: 1.00

Range: 0.00 to 600.00 in steps of 0.01

 NEG SEQ TOC1
RESET: Instantaneous

Range: Instantaneous, Timed

 NEG SEQ TOC1 BLOCK:
Off

Range: FlexLogic operand

 NEG SEQ TOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 NEG SEQ TOC1
EVENTS: Disabled

Range: Disabled, Enabled
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Two methods of resetting operation are available; “Timed” and “Instantaneous” (see the Inverse TOC Curve Characteristics 
section earlier for details on curve setup, trip times and reset operation). When the element is blocked, the time 
accumulator resets according to the reset characteristic. For example, if the element reset characteristic is set to 
“Instantaneous” and the element is blocked, the time accumulator clears immediately.

Figure 5-140: Negative sequence TOC1 logic 

5.8.8.3  Negative sequence instantaneous overcurrent (ANSI 50Q, IEC PIOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEGATIVE SEQUENCE CURRENT  NEG SEQ OC1(2)

The negative-sequence instantaneous overcurrent element can be used as an instantaneous function with no intentional 
delay or as a definite time function. The element responds to the negative-sequence current fundamental frequency 
phasor magnitude (calculated from the phase currents) and applies a positive-sequence restraint for better performance: 
a small portion (12.5%) of the positive-sequence current magnitude is subtracted from the negative-sequence current 
magnitude when forming the operating quantity.

Iop = |I_2| - K x |I_1| where K = 1/8 Eq. 5-27

The positive-sequence restraint allows for more sensitive settings by counterbalancing spurious negative-sequence 
currents resulting from

• System unbalances under heavy load conditions

 NEG SEQ IOC1
  NEG SEQ IOC1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEG SEQ IOC1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEG SEQ IOC1
PICKUP: 1.000 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 NEG SEQ IOC1 PICKUP
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEG SEQ IOC1 RESET
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEG SEQ IOC1 BLOCK:
Off

Range: FlexLogic operand

 NEG SEQ IOC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 NEG SEQ IOC1
EVENTS: Disabled

Range: Disabled, Enabled
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• Transformation errors of current transformers (CTs) during three-phase faults

• Fault inception and switch-off transients during three-phase faults

The positive-sequence restraint must be considered when testing for pickup accuracy and response time (multiple of 
pickup). The operating quantity depends on how the test currents are injected into the relay (single-phase injection: 
Iop = 0.2917 x Iinjected; three-phase injection, opposite rotation: Iop = Iinjected).

Figure 5-141: Negative sequence IOC1 logic 

5.8.8.4  Negative sequence directional overcurrent (ANSI 67Q, IEC PDEF/PTOC)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  NEGATIVE SEQUENCE CURRENT  NEG SEQ DIR 
OC1(2)

 NEG SEQ DIR OC1
  NEG SEQ DIR OC1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEG SEQ DIR OC1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEG SEQ DIR OC1
OFFSET: 0.00 

Range: 0.00 to 250.00 ohms in steps of 0.01

 NEG SEQ DIR OC1
TYPE: Neg Sequence

Range: Neg Sequence, Zero Sequence

 NEG SEQ DIR OC1 POS-
SEQ RESTRAINT: 0.063

Range: 0.000 to 0.500 in steps of 0.001

 NEG SEQ DIR OC1 FWD
ECA: 75° Lag

Range: 0 to 90° Lag in steps of 1

 NEG SEQ DIR OC1 FWD
LIMIT ANGLE: 90°

Range: 40 to 90° in steps of 1

 NEG SEQ DIR OC1 FWD
PICKUP: 0.050 pu

Range: 0.015 to 30.000 pu in steps of 0.005

 NEG SEQ DIR OC1 REV
LIMIT ANGLE: 90°

Range: 40 to 90° in steps of 1

 NEG SEQ DIR OC1 REV
PICKUP: 0.050 pu

Range: 0.015 to 30.000 pu in steps of 0.005

 NEG SEQ DIR OC1 BLK:
Off

Range: FlexLogic operand

 NEG SEQ DIR OC1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 NEG SEQ DIR OC1
EVENTS: Disabled

Range: Disabled, Enabled
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There are two negative-sequence directional overcurrent protection elements available. The element provides both 
forward and reverse fault direction indications through its output operands NEG SEQ DIR OC1 FWD and NEG SEQ DIR OC1 REV, 
respectively. The output operand is asserted if the magnitude of the operating current is above a pickup level (overcurrent 
unit) and the fault direction is seen as forward or reverse, respectively (directional unit).

The overcurrent unit of the element essentially responds to the magnitude of a fundamental frequency phasor of either the 
negative-sequence or neutral current as per user selection.

A positive-sequence restraint is applied for better performance: a small user-programmable portion of the positive-
sequence current magnitude is subtracted from the negative or zero-sequence current magnitude, respectively, when 
forming the element operating quantity.

Iop = |I_2| - K x |I_1|  or  Iop = 3 x (|I_0| - K x |I_1|) Eq. 5-28

The positive-sequence restraint allows for more sensitive settings by counterbalancing spurious negative-sequence and 
zero-sequence currents resulting from

• System unbalances under heavy load conditions

• Transformation errors of current transformers (CTs)

• Fault inception and switch-off transients

The positive-sequence restraint must be considered when testing for pickup accuracy and response time (multiple of 
pickup). The positive-sequence restraint is removed for low currents. If the positive-sequence current is less than 0.8 pu, 
then the restraint is removed by changing the constant K to zero. This results in better response to high-resistance faults 
when the unbalance is very small and there is no danger of excessive CT errors, since the current is low.

The operating quantity depends on the way the test currents are injected into the F60. For single phase injection

• Iop = ⅓  (1 – K)  Iinjected for I_2 mode

• Iop = (1 – K)  Iinjected for I_0 mode if I_1 > 0.8 pu

The directional unit uses the negative-sequence current (I_2) and negative-sequence voltage (V_2).

The following tables define the negative-sequence directional overcurrent element.

Table 5-42: Negative-sequence directional overcurrent unit

Table 5-43: Negative-sequence directional unit

Z_offset is the offset impedance, for which magnitude is the OFFSET setting and angle is the FWD ECA.

The negative-sequence voltage must be greater than 0.02 pu to be validated for use as a polarizing signal. Additionally, 
when offset impedance is applied and negative-sequence current is above 0.2 pu, compensated negative-sequence 
voltage -V_2 + Z_offset x I_2 has to be above 0.02 pu in order to discriminate fault direction; otherwise when negative-
sequence current is less than 0.2 pu, -V_2 is then used as the polarizing signal. If the polarizing signal is not validated, 
neither forward nor reverse indication is given. The following figure explains the usage of the voltage polarized directional 
unit of the element. It shows the phase angle comparator characteristics for a phase A to ground fault, with settings of

ECA = 75° (element characteristic angle = centerline of operating characteristic)
FWD LA = 80° (forward limit angle = ± the angular limit with the ECA for operation)
REV LA = 80° (reverse limit angle = ± the angular limit with the ECA for operation)

The element incorporates a current reversal logic: if the reverse direction is indicated for at least 1.25 of a power system 
cycle, the prospective forward indication is delayed by 1.5 of a power system cycle. The element emulates an 
electromechanical directional device. Larger operating and polarizing signals result in faster directional discrimination, 
bringing more security to the element operation.

Mode Operating current

Negative-sequence Iop = |I_2| – K  I_1|

Zero-sequence Iop = 3  (|I_0| – K  |I_1|) if |I_1| > 0.8 pu
Iop = 3  |I_0| if |I_1| ≤ 0.8 pu

Direction Compared phasors

Forward –V_2 + Z_offset  I_2 I_2  1ECA

Reverse –V_2 + Z_offset  I_2 –(I_2  1ECA)
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Figure 5-142: Negative-sequence directional characteristic 

The forward-looking function is designed to be more secure compared to the reverse-looking function, so use the forward-
looking function for the tripping direction. The reverse-looking function is faster compared to the forward-looking function, 
so use the reverse-looking function for the blocking direction. This allows for better protection coordination. Take this bias 
into account when using the negative-sequence directional overcurrent element to directionalize other protection 
elements. The negative-sequence current must be greater than the PRODUCT SETUP  DISPLAY PROPERTIES CURRENT 
CUT-OFF LEVEL setting value.

Settings
NEG SEQ DIR OC1 OFFSET — Specifies the offset impedance used by this protection. The primary application for the offset 
impedance is to guarantee correct identification of fault direction on series compensated lines (see the Application of 
Settings chapter for information on how to calculate this setting). In regular applications, the offset impedance ensures 
proper operation even if the negative-sequence voltage at the relaying point is very small. If this is the intent, the offset 
impedance shall not be larger than the negative-sequence impedance of the protected circuit. Practically, it is several 
times smaller. Enter the offset impedance in secondary ohms.

NEG SEQ DIR OC1 TYPE — Selects the operating mode for the overcurrent unit of the element. The choices are “Neg 
Sequence” and “Zero Sequence.” In some applications it is advantageous to use a directional negative-sequence 
overcurrent function instead of a directional zero-sequence overcurrent function as inter-circuit mutual effects are 
minimized.

NEG SEQ DIR OC1 POS-SEQ RESTRAINT — Controls the positive-sequence restraint. Set it to 0.063 (in “Zero Sequence” mode) 
or 0.125 (in “Neg Sequence” mode) for backward compatibility with revisions 3.40 and earlier. Set it to zero to remove the 
restraint. Set it higher if large system unbalances or poor CT performance are expected.

NEG SEQ DIR OC1 FWD ECA — Select the element characteristic angle (ECA) for the forward direction. The element 
characteristic angle in the reverse direction is the angle set for the forward direction shifted by 180°.
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NEG SEQ DIR OC1 FWD LIMIT ANGLE — Defines a symmetrical limit angle (in both directions from the ECA) for the forward 
direction.

NEG SEQ DIR OC1 FWD PICKUP — Defines the pickup level for the overcurrent unit in the forward direction. This pickup 
threshold applies to zero-sequence or negative-sequence current based on the NEG SEQ DIR OC1 TYPE setting. When 
specifying this setting, keep in mind that the design uses a positive-sequence restraint technique.

NEG SEQ DIR OC1 REV LIMIT ANGLE — Defines a symmetrical limit angle (in both directions from the ECA) for the reverse 
direction.

NEG SEQ DIR OC1 REV PICKUP — Defines the pickup level for the overcurrent unit in the reverse direction. This pickup 
threshold applies to zero-sequence or negative-sequence current based on the NEG SEQ DIR OC1 TYPE setting. When 
selecting this setting, keep in mind that the design uses a positive-sequence restraint technique.

Figure 5-143: Negative-sequence directional OC1 logic 

5.8.9  Breaker failure (ANSI 50BF)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  BREAKER FAILURE  BREAKER FAILURE 1(4) 

 BREAKER FAILURE 1
  BF1 FUNCTION:

Disabled
Range: Disabled, Enabled

 BF1 MODE:
3-Pole

Range: 3-Pole, 1-Pole

 BF1 SOURCE:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 BF1 USE AMP SUPV:
Yes

Range: Yes, No

 BF1 USE SEAL-IN:
Yes

Range: Yes, No 

 BF1 3-POLE INITIATE:
Off

Range: FlexLogic operand
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 BF1 BLOCK:
Off

Range: FlexLogic operand

 BF1 RETRIP PICKUP
DELAY: 0.033 s

Range: 0.000 to 65.535 s in steps of 0.001

 BF1 PH AMP SUPV
PICKUP: 1.050 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 BF1 N AMP SUPV
PICKUP: 1.050 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 BF1 USE TIMER 1:
Yes

Range: Yes, No

 BF1 TIMER 1 PICKUP
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BF1 USE TIMER 2:
Yes

Range: Yes, No

 BF1 TIMER 2 PICKUP
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BF1 USE TIMER 3:
Yes

Range: Yes, No

 BF1 TIMER 3 PICKUP
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BF1 BKR POS1 A/3P:
Off

Range: FlexLogic operand

 BF1 BKR POS2 A/3P:
Off

Range: FlexLogic operand

 BF1 BREAKER TEST ON:
Off

Range: FlexLogic operand

 BF1 PH AMP HISET
PICKUP: 1.050 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 BF1 N AMP HISET
PICKUP: 1.050 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 BF1 PH AMP LOSET
PICKUP: 1.050 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 BF1 N AMP LOSET
PICKUP: 1.050 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 BF1 LOSET TIME
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BF1 TRIP DROPOUT
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BF1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 BF1 EVENTS:
Disabled

Range: Disabled, Enabled

 BF1 PH A INITIATE:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes

 BF1 PH B INITIATE:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes

 BF1 PH C INITIATE:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes
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In general, a breaker failure scheme determines that a breaker signaled to trip has not cleared a fault within a definite 
time, so further tripping action must be performed. Tripping from the breaker failure scheme should trip all breakers, both 
local and remote, that can supply current to the faulted zone. Usually operation of a breaker failure element causes 
clearing of a larger section of the power system than the initial trip. Because breaker failure can result in tripping a large 
number of breakers and this affects system safety and stability, a very high level of security is required.

Two schemes are provided: one for three-pole tripping only (identified by the name “3BF”) and one for three pole plus 
single-pole operation (identified by the name “1BF”). The philosophy used in these schemes is identical. The operation of a 
breaker failure element includes three stages: initiation, determination of a breaker failure condition, and output.

Initiation stage
A FlexLogic operand representing the protection trip signal initially sent to the breaker must be selected to initiate the 
scheme. The initiating signal is sealed-in if primary fault detection can reset before the breaker failure timers have finished 
timing. The seal-in is supervised by current level, so it is reset when the fault is cleared. If desired, an incomplete sequence 
seal-in reset can be implemented by using the initiating operand to also initiate a FlexLogic timer, set longer than any 
breaker failure timer, whose output operand is selected to block the breaker failure scheme.

Schemes can be initiated either directly or with current level supervision. It is particularly important in any application to 
decide if a current-supervised initiate is to be used. The use of a current-supervised initiate results in the breaker failure 
element not being initiated for a breaker that has very little or no current flowing through it, which can be the case for 
transformer faults. For those situations where it is required to maintain breaker fail coverage for fault levels below the BF1 
PH AMP SUPV PICKUP or the BF1 N AMP SUPV PICKUP setting, do not use a current supervised initiate. Utilize this feature for 
those situations where coordinating margins can be reduced when high speed reclosing is used. Thus, if this choice is 
made, fault levels must always be above the supervision pickup levels for dependable operation of the breaker fail scheme. 
This can also occur in breaker-and-a-half or ring bus configurations where the first breaker closes into a fault; the 
protection trips and attempts to initiate breaker failure for the second breaker, which is in the process of closing, but does 
not yet have current flowing through it.

When the scheme is initiated, it sends a trip signal after a pickup delay to the breaker initially signaled to trip (this feature is 
usually described as re-trip). This reduces the possibility of widespread tripping that results from a declaration of a failed 
breaker.

Determination of a breaker failure condition
The schemes determine a breaker failure condition via three paths. Each of these paths is equipped with a time delay, after 
which a failed breaker is declared and trip signals are sent to all breakers required to clear the zone. The delayed paths are 
associated with breaker failure timers 1, 2, and 3, which are intended to have delays increasing with increasing timer 
numbers. These delayed paths are individually enabled to allow for maximum flexibility.

Timer 1 logic (early path) is supervised by a fast-operating breaker auxiliary contact. If the breaker is still closed (as 
indicated by the auxiliary contact) and fault current is detected after the delay interval, an output is issued. Operation of 
the breaker auxiliary switch indicates that the breaker has mechanically operated. The continued presence of current 
indicates that the breaker has failed to interrupt the circuit.

Timer 2 logic (main path) is not supervised by a breaker auxiliary contact. If fault current is detected after the delay 
interval, an output is issued. This path is intended to detect a breaker that opens mechanically but fails to interrupt fault 
current; the logic therefore does not use a breaker auxiliary contact.

 BF1 BKR POS1 B:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes

 BF1 BKR POS1 C:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes

 BF1 BKR POS2 B:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes

 BF1 BKR POS2 C:
Off

Range: FlexLogic operand
Valid only for 1-Pole breaker failure schemes



CHAPTER 5: SETTINGS GROUPED ELEMENTS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-279

5

The timer 1 and 2 paths provide two levels of current supervision, high-set and low-set, that allow the supervision level to 
change from a current which flows before a breaker inserts an opening resistor into the faulted circuit to a lower level after 
resistor insertion. The high-set detector is enabled after timeout of timer 1 or 2, along with a timer that enables the low-set 
detector after its delay interval. The delay interval between high-set and low-set is the expected breaker opening time. 
Both current detectors provide a fast operating time for currents at small multiples of the pickup value. The overcurrent 
detectors are required to operate after the breaker failure delay interval to eliminate the need for very fast resetting 
overcurrent detectors.

Timer 3 logic (slow path) is supervised by a breaker auxiliary contact and a control switch contact used to indicate that the 
breaker is in or out-of-service, disabling this path when the breaker is out-of-service for maintenance. There is no current 
level check in this logic as it is intended to detect low magnitude faults and it is therefore the slowest to operate.

Output
The outputs from the schemes are:

• FlexLogic operands that report on the operation of portions of the scheme

• FlexLogic operand used to re-trip the protected breaker

• FlexLogic operands that initiate tripping required to clear the faulted zone. The trip output can be sealed-in for an 
adjustable period.

• Target message indicating a failed breaker has been declared

• Illumination of the front panel Trip LED (and the Phase A, B, or C LED, if applicable)

Main path sequence

Figure 5-144: Breaker failure main path sequence 

The current supervision elements reset in less than 0.7 of a power cycle for any multiple of pickup current as shown in the 
following figure.

PROTECTION OPERATION BREAKER INTERRUPTING TIME

CALCULATED CURRENT MAGNITUDE

ACTUAL CURRENT MAGNITUDE
FAILED INTERRUPTION

CORRECT INTERRUPTION

Rampdown

(ASSUMED 1.5 cycles)

INITIATE (1/8 cycle)
BREAKER FAILURE TIMER No. 2 (±1/8 cycle)

BREAKER FAILURE CURRENT DETECTOR PICKUP (1/8 cycle)

BREAKER FAILURE OUTPUT RELAY PICKUP (1/4 cycle)

FAULT
OCCURS

1 2 3 4 5 6 7 8 9 10 110

0

0

AMP

(ASSUMED 3 cycles)

cycles

827083A6.CDR

MARGIN
(Assumed 2 Cycles)

BACKUP BREAKER OPERATING TIME
(Assumed 3 Cycles)
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Figure 5-145: Breaker failure overcurrent supervision reset time 

Settings
BF1 MODE — This setting is used to select the breaker failure operating mode: single or three pole.

BF1 USE AMP SUPV — If set to "Yes," the element is initiated if current flowing through the breaker is above the supervision 
pickup level.

BF1 USE SEAL-IN — If set to "Yes," the element is sealed-in if current flowing through the breaker is above the supervision 
pickup level.

BF1 3-POLE INITIATE — This setting selects the FlexLogic operand that initiates three-pole tripping of the breaker.

BF1 RETRIP PICKUP DELAY — This setting specifies a pickup delay for the re-trip command. Set this delay longer than the 
possible spurious contact input activation duration due to transients or temporary DC grounds, taking into account the 
contact input de-bounce time to avoid re-trip operation for such transients.

BF1 PH AMP SUPV PICKUP — This setting is used to set the phase current initiation and seal-in supervision level. Generally this 
setting detects the lowest expected fault current on the protected breaker. It can be set as low as necessary (lower than 
breaker resistor current or lower than load current)—high-set and low-set current supervision guarantee correct operation.

BF1 N AMP SUPV PICKUP — This setting is used to set the neutral current initiate and seal-in supervision level. Generally this 
setting detects the lowest expected fault current on the protected breaker. Neutral current supervision is used only in the 
three phase scheme to provide increased sensitivity. This setting is valid only for three-pole tripping schemes.

BF1 USE TIMER 1 — If set to "Yes," the early path is operational.

BF1 TIMER 1 PICKUP DELAY — Timer 1 is set to the shortest time required for breaker auxiliary contact Status-1 to open, from 
the time the initial trip signal is applied to the breaker trip circuit, plus a safety margin.

BF1 USE TIMER 2 — If set to "Yes," the main path is operational.

BF1 TIMER 2 PICKUP DELAY — Timer 2 is set to the expected opening time of the breaker, plus a safety margin. This safety 
margin was historically intended to allow for measuring and timing errors in the breaker failure scheme equipment. In 
microprocessor relays this time is not significant. In F60 relays, which use a Fourier transform, the calculated current 
magnitude ramps-down to zero one power frequency cycle after the current is interrupted, and this lag needs to be 
included in the overall margin duration, as it occurs after current interruption. The Breaker Failure Main Path Sequence 
figure that follows shows a margin of two cycles; this interval is considered the minimum appropriate for most 
applications.

Note that in bulk oil circuit breakers, the interrupting time for currents less than 25% of the interrupting rating can be 
significantly longer than the normal interrupting time.

BF1 USE TIMER 3 — If set to "Yes," the Slow Path is operational.
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BF1 TIMER 3 PICKUP DELAY — Timer 3 is set to the same interval as timer 2, plus an increased safety margin. Because this 
path is intended to operate only for low level faults, the delay can be in the order of 300 to 500 ms.

BF1 BKR POS1 A/3P — This setting selects the FlexLogic operand that represents the protected breaker early-type auxiliary 
switch contact (52/a). When using the single-pole breaker failure scheme, this operand represents the protected breaker 
early-type auxiliary switch contact on pole A. This is normally a non-multiplied form-A contact. The contact can even be 
adjusted to have the shortest possible operating time.

BF1 BKR POS2 A/3P — This setting selects the FlexLogic operand that represents the breaker normal-type auxiliary switch 
contact (52/a). When using the single-pole breaker failure scheme, this operand represents the protected breaker auxiliary 
switch contact on pole A. This can be a multiplied contact.

BF1 BREAKER TEST ON — This setting is used to select the FlexLogic operand that represents the breaker in-service/out-of-
service switch set to the out-of-service position.

BF1 PH AMP HISET PICKUP — This setting sets the phase current output supervision level. Generally this setting is to detect 
the lowest expected fault current on the protected breaker, before a breaker opening resistor is inserted. 

BF1 N AMP HISET PICKUP — This setting sets the neutral current output supervision level. Generally this setting is to detect 
the lowest expected fault current on the protected breaker, before a breaker opening resistor is inserted. Neutral current 
supervision is used only in the three pole scheme to provide increased sensitivity. This setting is valid only for three-pole 
breaker failure schemes.

BF1 PH AMP LOSET PICKUP — This setting sets the phase current output supervision level. Generally this setting is to detect 
the lowest expected fault current on the protected breaker, after a breaker opening resistor is inserted (approximately 90% 
of the resistor current).

BF1 N AMP LOSET PICKUP — This setting sets the neutral current output supervision level. Generally this setting is to detect 
the lowest expected fault current on the protected breaker, after a breaker opening resistor is inserted (approximately 90% 
of the resistor current). This setting is valid only for three-pole breaker failure schemes.

BF1 LOSET TIME DELAY — Sets the pickup delay for current detection after opening resistor insertion. 

BF1 TRIP DROPOUT DELAY — This setting is used to set the period of time for which the trip output is sealed-in. This timer 
must be coordinated with the automatic reclosing scheme of the failed breaker, to which the breaker failure element sends 
a cancel reclosure signal. Reclosure of a remote breaker can also be prevented by holding a transfer trip signal on longer 
than the reclaim time.

BF1 PH A INITIATE / BF1 PH B INITIATE / BF 1 PH C INITIATE — These settings select the FlexLogic operand to initiate phase A, B, 
or C single-pole tripping of the breaker and the phase A, B, or C portion of the scheme, accordingly. This setting is only valid 
for single-pole breaker failure schemes.

BF1 BKR POS1 B / BF1 BKR POS 1 C — These settings select the FlexLogic operand to represents the protected breaker 
early-type auxiliary switch contact on poles B or C, accordingly. This contact is normally a non-multiplied Form-A contact. 
The contact can even be adjusted to have the shortest possible operating time. This setting is valid only for single-pole 
breaker failure schemes.

BF1 BKR POS2 B — Selects the FlexLogic operand that represents the protected breaker normal-type auxiliary switch 
contact on pole B (52/a). This can be a multiplied contact. This setting is valid only for single-pole breaker failure schemes.

BF1 BKR POS2 C — This setting selects the FlexLogic operand that represents the protected breaker normal-type auxiliary 
switch contact on pole C (52/a). This can be a multiplied contact. For single-pole operation, the scheme has the same 
overall general concept except that it provides re-tripping of each single pole of the protected breaker. The approach 
shown in the following single pole tripping diagram uses the initiating information to determine which pole is supposed to 
trip. The logic is segregated on a per-pole basis. The overcurrent detectors have ganged settings. This setting is valid only 
for single-pole breaker failure schemes.

Upon operation of the breaker failure element for a single pole trip command, a three-pole trip command needs to be 
given via output operand BKR FAIL 1 TRIP OP.
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Figure 5-146: Single-pole breaker failure initiate logic 
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Figure 5-147: Single-pole breaker failure, timers logic 



5-284 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

GROUPED ELEMENTS CHAPTER 5: SETTINGS

5

Figure 5-148: Three-pole breaker failure, initiate logic 
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Figure 5-149: Three-pole breaker failure, timers logic 
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5.8.10  Voltage elements

5.8.10.1  Menu
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS

These protection elements can be used for a variety of applications, such as

• Undervoltage protection — For voltage sensitive loads, such as induction motors, a drop in voltage increases the 
drawn current, which can cause dangerous overheating in the motor. The undervoltage protection feature can be 
used to either cause a trip or generate an alarm when the voltage drops below a specified voltage setting for a 
specified time delay.

• Permissive functions — The undervoltage feature can be used to block the functioning of external devices by 
operating an output relay when the voltage falls below the specified voltage setting. The undervoltage feature can 
also be used to block the functioning of other elements through the block feature of those elements.

• Source transfer schemes — In the event of an undervoltage, a transfer signal can be generated to transfer a load 
from its normal source to a standby or emergency power source.

The undervoltage elements can be programmed to have a definite time delay characteristic. The definite time curve 
operates when the voltage drops below the pickup level for a specified period of time. The time delay is adjustable from 0 
to 600.00 seconds in steps of 0.01. The undervoltage elements can also be programmed to have an inverse time delay 
characteristic.

 VOLTAGE ELEMENTS
   PHASE

 UNDERVOLTAGE1
See below



  PHASE
 UNDERVOLTAGE3

  PHASE
 OVERVOLTAGE1

See page 5-288



  PHASE
 OVERVOLTAGE3

  NEUTRAL OV1
 

See page 5-289



  NEUTRAL OV3
 

  NEG SEQ OV 1
 

See page 5-290



  NEG SEQ OV 3
 

  AUXILIARY UV1
 

See page 5-291



  AUXILIARY UV3
 

  AUXILIARY OV1
 

See page 5-292

  AUXILIARY OV2
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The undervoltage delay setting defines the family of curves shown as follows.

Eq. 5-29

where

T = operating time
D = undervoltage delay setting (D = 0.00 operates instantaneously)
V = secondary voltage applied to the relay
Vpickup = pickup level

Figure 5-150: Inverse time undervoltage curves 

At 0% of pickup, the operating time equals the PHASE UNDERVOLTAGE DELAY setting.

5.8.10.2  Phase undervoltage (ANSI 27P, IEC PTUV)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS  PHASE UNDERVOLTAGE1(3)

 PHASE
 UNDERVOLTAGE1  PHASE UV1

FUNCTION: Disabled
Range: Disabled, Enabled

 PHASE UV1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 PHASE UV1 MODE:
Phase to Ground

Range: Phase to Ground, Phase to Phase

 PHASE UV1
PICKUP: 1.000 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 PHASE UV1
CURVE: Definite Time

Range: Definite Time, Inverse Time

 PHASE UV1
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PHASE UV1 MINIMUM
VOLTAGE: 0.100 pu

Range: 0.000 to 3.000 pu in steps of 0.001

 PHASE UV1 BLOCK:
Off

Range: FlexLogic operand

T D

1 V
Vpickup
----------------–

------------------------------=
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This element is used to give a time-delay operating characteristic versus the applied fundamental voltage (phase-to-
ground or phase-to-phase for wye VT connection, or phase-to-phase for delta VT connection) or as a definite time 
element. The element resets instantaneously if the applied voltage exceeds the dropout voltage. The delay setting selects 
the minimum operating time of the phase undervoltage. The minimum voltage setting selects the operating voltage below 
which the element is blocked (a setting of “0” allows a dead source to be considered a fault condition).

Figure 5-151: Phase undervoltage1 logic 

5.8.10.3  Phase overvoltage (ANSI 59P, IEC PTOV)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS  PHASE OVERVOLTAGE1(3)

 PHASE UV1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PHASE UV1
EVENTS: Disabled

Range: Disabled, Enabled

 PHASE
 OVERVOLTAGE1  PHASE OV1

FUNCTION: Disabled
Range: Disabled, Enabled

 PHASE OV1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 PHASE OV1
PICKUP: 1.000 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 PHASE OV1 PICKUP
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PHASE OV1 RESET
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 PHASE OV1 BLOCK:
Off

Range: FlexLogic Operand

 PHASE OV1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 PHASE OV1
EVENTS: Disabled

Range: Disabled, Enabled
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There are three phase overvoltage elements available. A phase overvoltage element is used as an instantaneous element 
with no intentional time delay or as a definite time element. The input voltage is the phase-to-phase voltage, either 
measured directly from delta-connected VTs or as calculated from phase-to-ground (wye) connected VTs. The figure 
shows specific voltages to be used for each phase.

Figure 5-152: Phase overvoltage logic 

5.8.10.4  Neutral overvoltage (ANSI 59N, IEC PTOV)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS   NEUTRAL OV1(3)

If the source VT is wye-connected, then the phase overvoltage pickup condition is V >  x Pickup for VAB, VBC, and 
VCA.

 NEUTRAL OV1
  NEUTRAL OV1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEUTRAL OV1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEUTRAL OV1 PICKUP:
0.300 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 NEUTRAL OV1 CURVE:
Definite Time

Range: Definite Time, FlexCurve A, FlexCurve B,
FlexCurve C

 NEUTRAL OV1 PICKUP:
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEUTRAL OV1 RESET:
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEUTRAL OV1 BLOCK:
Off

Range: FlexLogic operand

 NEUTRAL OV1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 NEUTRAL OV1 EVENTS:
Disabled

Range: Disabled, Enabled

3
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There are three neutral overvoltage elements available. The neutral overvoltage element can be used to detect 
asymmetrical system voltage condition due to a ground fault or to the loss of one or two phases of the source. The 
element responds to the system neutral voltage (3V_0), calculated from the phase voltages. The nominal secondary 
voltage of the phase voltage channels entered under SETTINGS  SYSTEM SETUP  AC INPUTS  VOLTAGE BANK  PHASE 
VT SECONDARY is the p.u. base used when setting the pickup level.

The neutral overvoltage element can provide a time-delayed operating characteristic versus the applied voltage (initialized 
from FlexCurves A, B, or C) or be used as a definite time element. The NEUTRAL OV1 PICKUP DELAY setting applies only if the 
NEUTRAL OV1 CURVE setting is “Definite Time.” The source assigned to this element must be configured for a phase VT.

VT errors and normal voltage unbalance must be considered when setting this element. This function requires the VTs to 
be wye-connected.

Figure 5-153: Neutral overvoltage1 logic 

5.8.10.5  Negative sequence overvoltage (ANSI 59Q, IEC PTOV)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS  NEG SEQ OV 1(3)

There are three negative-sequence overvoltage elements available.

Use the negative-sequence overvoltage element to detect loss of one or two phases of the source, a reversed phase 
sequence of voltage, or a non-symmetrical system voltage condition.

 NEG SEQ OV 1
  NEG SEQ OV 1

FUNCTION: Disabled
Range: Disabled, Enabled

 NEG SEQ OV 1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 NEG SEQ OV 1 PICKUP:
0.300 pu

Range: 0.004 to 1.250 pu in steps of 0.001

 NEG SEQ OV 1 PICKUP
DELAY: 0.50 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEG SEQ OV 1 RESET
DELAY: 0.50 s

Range: 0.00 to 600.00 s in steps of 0.01

 NEG SEQ OV 1 BLOCK:
Off

Range: FlexLogic operand

 NEG SEQ OV 1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 NEG SEQ OV 1 EVENTS:
Disabled

Range: Disabled, Enabled
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Figure 5-154: Negative-sequence overvoltage logic 

5.8.10.6  Auxiliary undervoltage (ANSI 27X, IEC PTUV)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS  AUXILIARY UV1(3)

This element monitors undervoltage conditions of the auxiliary voltage.

The AUX UV1 PICKUP selects the voltage level at which the time undervoltage element starts timing. The nominal secondary 
voltage of the auxiliary voltage channel entered under SETTINGS  SYSTEM SETUP  AC INPUTS  VOLTAGE BANK X5  
AUXILIARY VT X5 SECONDARY is the per-unit base used when setting the pickup level.

The AUX UV1 DELAY setting selects the minimum operating time of the auxiliary undervoltage element. 

Both AUX UV1 PICKUP and AUX UV1 DELAY settings establish the operating curve of the undervoltage element. The auxiliary 
undervoltage element can be programmed to use either definite time delay or inverse time delay characteristics. The 
operating characteristics and equations for both definite and inverse time delay are as for the phase undervoltage 
element.

The element resets instantaneously. The minimum voltage setting selects the operating voltage below which the element 
is blocked.

 AUXILIARY UV1
  AUX UV1

FUNCTION: Disabled
Range: Disabled, Enabled

 AUX UV1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 AUX UV1 PICKUP:
0.700 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 AUX UV1 CURVE:
Definite Time

Range: Definite Time, Inverse Time

 AUX UV1 DELAY:
1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 AUX UV1 MINIMUM:
VOLTAGE: 0.100 pu

Range: 0.000 to 3.000 pu in steps of 0.001

 AUX UV1 BLOCK:
Off

Range: FlexLogic operand

 AUX UV1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 AUX UV1 EVENTS:
Disabled

Range: Disabled, Enabled
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Figure 5-155: Auxiliary undervoltage logic 

5.8.10.7  Auxiliary overvoltage (ANSI 59X, IEC PTOV)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  VOLTAGE ELEMENTS  AUXILIARY OV1(2)

This element is intended for monitoring overvoltage conditions of the auxiliary voltage. The nominal secondary voltage of 
the auxiliary voltage channel entered under SYSTEM SETUP  AC INPUTS  VOLTAGE BANK X5  AUXILIARY VT X5 
SECONDARY is the per-unit (pu) base used when setting the pickup level.

A typical application for this element is monitoring the zero-sequence voltage (3V_0) supplied from an open-corner-delta 
VT connection.

 AUXILIARY OV1
  AUX OV1

FUNCTION: Disabled
Range: Disabled, Enabled

 AUX OV1 SIGNAL
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 AUX OV1 PICKUP:
0.300 pu

Range: 0.004 to 3.000 pu in steps of 0.001

 AUX OV1 PICKUP
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 AUX OV1 RESET
DELAY: 1.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 AUX OV1 BLOCK:
Off

Range: FlexLogic operand

 AUX OV1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 AUX OV1 EVENTS:
Disabled

Range: Disabled, Enabled
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Figure 5-156: Auxiliary overvoltage logic 

5.8.11  Sensitive directional power (ANSI 32)
SETTINGS  GROUPED ELEMENTS  SETTING GROUP 1(6)  POWER  SENSITIVE DIRECTIONAL POWER  
DIRECTIONAL POWER 1(2)

The sensitive directional power element responds to three-phase directional power and is designed for reverse power and 
low forward power applications for synchronous machines or interconnections involving co-generation. The relay 
measures the three-phase power from either a full set of wye-connected VTs or a full set of delta-connected VTs. In the 
latter case, the two-wattmeter method is used. See the UR-series Metering Conventions section in chapter 6 for details 
regarding the active and reactive powers used by the sensitive directional power element.

The element has an adjustable characteristic angle and minimum operating power as shown in the Directional Power 
Characteristic diagram that follows. The element responds to the following condition:

P cos θ + Q sin θ > SMIN Eq. 5-30

where

 DIRECTIONAL
 POWER 1  DIR POWER 1

FUNCTION: Disabled
Range: Disabled, Enabled

 DIR POWER 1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 DIR POWER 1
RCA: 0°

Range: 0 to 359° in steps of 1

 DIR POWER 1
CALIBRATION: 0.00°

Range: 0 to 0.95° in steps of 0.05

 DIR POWER 1 STG1
SMIN: 0.100 pu

Range: –1.200 to 1.200 pu in steps of 0.001

 DIR POWER 1 STG1
DELAY: 0.50 s

Range: 0.00 to 600.00 s in steps of 0.01

 DIR POWER 1 STG2
SMIN: 0.100 pu

Range: –1.200 to 1.200 pu in steps of 0.001

 DIR POWER 1 STG2
DELAY: 20.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 DIR POWER 1 BLK:
Off

Range: FlexLogic operand

 DIR POWER 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 DIR POWER 1
EVENTS: Disabled

Range: Disabled, Enabled
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P and Q are active and reactive powers as measured per the UR metering convention
 is a sum of the element characteristic (DIR POWER 1 RCA) and calibration (DIR POWER 1 CALIBRATION) angles
SMIN is the minimum operating power

The operating quantity is displayed in the ACTUAL VALUES  METERING  SENSITIVE DIRECTIONAL POWER 1(2) actual value. 
The element has two independent (as to the pickup and delay settings) stages for alarm and trip, respectively.

Figure 5-157: Directional power characteristic 

By making the characteristic angle adjustable and providing for both negative and positive values of the minimum 
operating power, a variety of operating characteristics can be achieved as presented in the following figure. For example, 
section (a) in the figure shows settings for reverse power, while section (b) shows settings for low forward power 
applications.
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Figure 5-158: Directional power element sample applications 

DIR POWER 1 RCA — Specifies the relay characteristic angle (RCA) for the sensitive directional power function. Application of 
this setting is threefold:

• It allows the element to respond to active or reactive power in any direction (active overpower/underpower, and so on)

• Together with a precise calibration angle, it allows compensation for any CT and VT angular errors to permit more 
sensitive settings

• It allows for required direction in situations when the voltage signal is taken from behind a delta-wye connected 
power transformer and the phase angle compensation is required

For example, the active overpower characteristic is achieved by setting DIR POWER 1 RCA to “0°,” reactive overpower by 
setting DIR POWER 1 RCA to “90°,” active underpower by setting DIR POWER 1 RCA to “180°,” and reactive underpower by 
setting DIR POWER 1 RCA to “270°.”
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DIR POWER 1 CALIBRATION — This setting allows the relay characteristic angle to change in steps of 0.05°. This is useful 
when a small difference in VT and CT angular errors is to be compensated to permit more sensitive settings. This setting 
virtually enables calibration of the directional power function in terms of the angular error of applied VTs and CTs. The 
element responds to the sum of the DIR POWER 1 RCA and DIR POWER 1 CALIBRATION settings.

DIR POWER 1 STG1 SMIN — This setting specifies the minimum power as defined along the relay characteristic angle (RCA) 
for the stage 1 of the element. The positive values imply a shift towards the operate region along the RCA line; the negative 
values imply a shift towards the restrain region along the RCA line. See the Directional Power Sample Applications figure 
for details. Together with the RCA, this setting enables a wide range of operating characteristics. This setting applies to 
three-phase power and is entered in per-unit (pu) values. The base quantity is 3 x VT pu base x CT pu base.

For example, a setting of 2% for a 200 MW machine is 0.02  200 MW = 4 MW. If 13.8kV is line voltage and 10 kA is a 
primary CT current, the source pu quantity is 239 MVA, and thus, SMIN needs to be set at 4 MW / 239 MVA = 0.0167 pu  
0.017 pu. If the reverse power application is considered, RCA = 180° and SMIN = 0.017 pu.

The element drops out if the magnitude of the positive-sequence current becomes virtually zero, that is, it drops below the 
cutoff level.

DIR POWER 1 STG1 DELAY — This setting specifies a time delay for stage 1. For reverse power or low forward power 
applications for a synchronous machine, stage 1 is typically applied for alarming and stage 2 for tripping.

Figure 5-159: Sensitive directional power logic 

5.9  Control elements

5.9.1  Overview
Control elements are used for control rather than protection. See the Introduction to Elements section at the beginning of 
this chapter for information.

5.9.2  Trip bus
SETTINGS  CONTROL ELEMENTS  TRIP BUS  TRIP BUS 1(6)

 TRIP BUS 1
  TRIP BUS 1

FUNCTION: Disabled
Range: Enabled, Disabled
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The trip bus element allows aggregating outputs of protection and control elements without using FlexLogic and assigning 
them a simple and effective manner. Each trip bus can be assigned for either trip or alarm actions. Simple trip conditioning 
such as latch, delay, and seal-in delay are available.

The easiest way to assign element outputs to a trip bus is through the EnerVista software under Settings > Protection 
Summary. Navigate to a specific protection or control protection element and check the bus box by hovering over the 
blank check box and selecting an option that displays. Once the required element is selected for a specific bus, a list of 
element operate-type operands are displayed and can be assigned to a trip bus. If more than one operate-type operand is 
required, it can be assigned directly from the trip bus menu.

Figure 5-160: Trip bus fields in the protection summary

The following settings are available.

TRIP BUS 1 BLOCK — The trip bus output is blocked when the operand assigned to this setting is asserted.

TRIP BUS 1 PICKUP DELAY — This setting specifies a time delay to produce an output depending on how output is used.

 TRIP BUS 1 BLOCK:
Off

Range: FlexLogic operand

 TRIP BUS 1 PICKUP
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 TRIP BUS 1 RESET
DELAY: 0.00 s

Range: 0.00 to 600.00 s in steps of 0.01

 TRIP BUS 1 INPUT 1
Off

Range: FlexLogic operand



 TRIP BUS 1 INPUT 16
Off

Range: FlexLogic operand

 TRIP BUS 1
LATCHING: Disabled

Range: Enabled, Disabled

 TRIP BUS 1 RESET:
Off

Range: FlexLogic operand

 TRIP BUS 1:
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 TRIP BUS 1
EVENTS: Disabled

Range: Enabled, Disabled



5-298 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

CONTROL ELEMENTS CHAPTER 5: SETTINGS

5

TRIP BUS 1 RESET DELAY — This setting specifies a time delay to reset an output command. Set the time delay long enough 
to allow the breaker or contactor to perform a required action.

TRIP BUS 1 INPUT 1 to TRIP BUS 1 INPUT 16 — These settings select a FlexLogic operand to be assigned as an input to the trip 
bus.

TRIP BUS 1 LATCHING — This setting enables or disables latching of the trip bus output. This is typically used when lockout is 
required or user acknowledgement of the relay response is required.

TRIP BUS 1 RESET — The trip bus output is reset when the operand assigned to this setting is asserted. Note that the RESET OP 
operand is pre-wired to the reset gate of the latch, As such, a reset command from the front panel interface or via 
communications resets the trip bus output.

Figure 5-161: Trip bus logic 

5.9.3  Setting groups
SETTINGS  CONTROL ELEMENTS  SETTING GROUPS

 SETTING GROUPS
  FUNCTION: Enabled Range: Disabled, Enabled

 Control Mode:
Local

Range: Local, IEC61850 Client

 Block:
Off

Range: FlexLogic operand

 GROUP 2 ACTIVATE ON:
Off

Range: FlexLogic operand



 GROUP 6 ACTIVATE ON:
Off

Range: FlexLogic operand

 GROUP 1 NAME: Range: up to 16 alphanumeric characters
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The setting groups menu controls the activation and deactivation of up to six groups of settings in the GROUPED ELEMENTS 
settings menu. The active setting group can be indicated on the front display of the F60 by configuring User-
Programmable LEDs to display the state of the SETTING GROUP ACT FlexLogic operands.

FUNCTION — When Enabled, allows setting groups other than group 1 (the default active group) to be activated. When 
Disabled, the default setting group is forced active. When changed from Disabled to Enabled, it resets the active setting 
group to 1 independent of the Control Mode setting.

Control Mode — This setting displays when IEC 61850 is used by the F60. It selects the active setting group selection control 
mode. When set to "Local," active setting group selection is based on the FlexLogic operand states selected by GROUP 
ACTIVATE ON settings and the SelectActiveSG request from an IEC 61850 client generates a negative response. When set to 
"IEC61850 Client," the SelectActiveSG request from an IEC 61850 client selects the active setting group and the FlexLogic 
operand states of the GROUP ACTIVATE ON settings are ignored/not used.

The logic diagram shows the active setting group selection behavior based on the Control Mode setting.

When the Control Mode is "Local," the priority scheme makes active the highest numbered group selected by the GROUP 
ACTIVATE ON settings. The most recent active group selection is preserved while the F60 is powered down or reset.

When the Control Mode is "IEC61850 Client," the SelectActiveSG selection has an initial value that can be set on a CID file 
download by the IEC 61850 setting Initial Setting Group. See the Settings > Product Setup > Communications > IEC 61850 
protocol > Setting Groups section earlier for details. The most recent SelectActiveSG selection is preserved while the F60 is 
powered down or reset. If it becomes necessary to cancel the SelectActiveSG selection without using a SelectActiveSG 
service request, change the FUNCTION setting to Disabled. This resets the SelectActiveSG selection to 1.

When the Control Mode is changed, the current active setting group selection is preserved.

Figure 5-162: Logic diagram for Control Mode setting  

 GROUP 6 NAME: Range: up to 16 alphanumeric characters

 SETTING GROUP
EVENTS: Disabled

Range: Disabled, Enabled

Active setting group selection can be made either by IEC 61850 MMS SelectActiveSG service or Local by the 
FlexLogic operand states selected by GROUP # ACTIVATE ON settings. Simultaneous setting group control is not 
permissible.

SETTINGS
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SETTINGS
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SETTINGS
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= Local / IEC61850 Client
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RUN
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From IEC 61850 client
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= FlexLogic operand
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Block — Prevents the active setting group from changing when the selected FlexLogic operand is "On." This can be useful in 
applications where it is undesirable to change the settings under certain conditions, such as during a control sequence.

GROUP 2 ACTIVATE ON to GROUP 6 ACTIVATE ON — Selects a FlexLogic operand which, when set, makes the particular setting 
group active for use by any grouped element. A priority scheme ensures that only one group is active at a given time — the 
highest-numbered group that is activated by its ACTIVATE ON parameter takes priority over the lower-numbered groups. 
There is no activate on setting for group 1 (the default active group), because group 1 automatically becomes active if no 
other group is active.

The settings are read-only with default values when the Control Mode setting is set to "IEC61850 Client."

A setting group selection can also be made by the IEC 61850 MMS service SelectActiveSG to the control block @Master/
LLN0.SGCB. An active group selection can be done either by SelectActiveSG service from a IEC 61850 client or by GROUP 
ACTIVATE ON settings, but mixed operation is not allowed.

An initial setting group value is initialized to the GROUP ACTIVATE ON setting value on F60 reboot immediately following the 
receipt of a valid CID file.

SETTING GROUP 1 NAME to SETTING GROUP 6 NAME — Allows the user to assign a name to each of the six settings groups. 
Once programmed, this name appears on the second line of the GROUPED ELEMENTS  SETTING GROUP 1(6) menu display.

The relay can be set up via a FlexLogic equation to receive requests to activate or de-activate a particular non-default 
settings group. The following FlexLogic equation (see the following figure) illustrates requests via remote communications 
(for example, VIRTUAL INPUT 1 ON) or from a local contact input (for example, CONTACT IP 1 ON) to initiate the use of a 
particular settings group, and requests from several overcurrent pickup measuring elements to inhibit the use of the 
particular settings group. The assigned VIRTUAL OUTPUT 1 operand is used to control the “On” state of a particular settings 
group.

Figure 5-163: Example of FlexLogic control of a setting group 

5.9.4  Selector switch
SETTINGS  CONTROL ELEMENTS  SELECTOR SWITCH  SELECTOR SWITCH 1(2)

 SELECTOR SWITCH 1
  SELECTOR 1 FUNCTION:

Disabled
Range: Disabled, Enabled

 SELECTOR 1 FULL
RANGE: 7

Range: 1 to 7 in steps of 1

 SELECTOR 1 TIME-OUT:
5.0 s

Range: 3.0 to 60.0 s in steps of 0.1

 SELECTOR 1 STEP-UP:
Off

Range: FlexLogic operand

10

1 VIRT IP 1 ON (VI1)

2 CONT IP 1 ON (H5A)

3

OR (2)

OR (2)

4 PHASE TOC1 PKP

5 NOT

6 PHASE TOC2 PKP

7 NOT

8

AND (3)

AND (3)

9

= VIRT OP 1 (VO1)

= VIRT OP 1 (VO1)

END
842789A1.CDR
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The selector switch element is intended to replace a mechanical selector switch. Typical applications include setting group 
control or control of multiple logic sub-circuits in user-programmable logic.

The element provides for two control inputs. The step-up control allows stepping through selector position one step at a 
time with each pulse of the control input, such as a user-programmable pushbutton. The three-bit control input allows 
setting the selector to the position defined by a three-bit word.

The element allows pre-selecting a new position without applying it. The pre-selected position gets applied either after 
time-out or upon acknowledgement via separate inputs (user setting). The selector position is stored in non-volatile 
memory. Upon power-up, either the previous position is restored or the relay synchronizes to the current three-bit word 
(user setting). Basic alarm functionality alerts the user under abnormal conditions; for example, the three-bit control input 
being out of range.

A selector switch runs every two power cycles.

SELECTOR 1 FULL RANGE — This setting defines the upper position of the selector. When stepping up through available 
positions of the selector, the upper position wraps up to the lower position (position 1). When using a direct three-bit control 
word for programming the selector to a desired position, the change would take place only if the control word is within the 
range of 1 to the SELECTOR FULL RANGE. If the control word is outside the range, an alarm is established by setting the 
SELECTOR ALARM FlexLogic operand for three seconds.

SELECTOR 1 TIME-OUT — This setting defines the time-out period for the selector. This value is used by the relay in the 
following two ways. When the SELECTOR STEP-UP MODE is “Time-out,” the setting specifies the required period of inactivity 
of the control input after which the pre-selected position is automatically applied. When the SELECTOR STEP-UP MODE is 
“Acknowledge,” the setting specifies the period of time for the acknowledging input to appear. The timer is re-started by 
any activity of the control input. The acknowledging input must come before the SELECTOR 1 TIME-OUT timer expires; 
otherwise, the change does not take place and an alarm is set.

SELECTOR 1 STEP-UP — This setting specifies a control input for the selector switch. The switch is shifted to a new position at 
each rising edge of this signal. The position changes incrementally, wrapping up from the last (SELECTOR 1 FULL RANGE) to 
the first (position 1). Consecutive pulses of this control operand must not occur faster than every 50 ms. After each rising 
edge of the assigned operand, the time-out timer is restarted and the SELECTOR SWITCH 1: POS Z CHNG INITIATED target 
message is displayed, where Z the pre-selected position. The message is displayed for the time specified by the FLASH 
MESSAGE TIME setting. The pre-selected position is applied after the selector times out (“Time-out” mode), or when the 

 SELECTOR 1 STEP-UP
MODE: Time-out

Range: Time-out, Acknowledge

 SELECTOR 1 ACK:
Off

Range: FlexLogic operand

 SELECTOR 1 3BIT A0:
Off

Range: FlexLogic operand

 SELECTOR 1 3BIT A1:
Off

Range: FlexLogic operand

 SELECTOR 1 3BIT A2:
Off

Range: FlexLogic operand

 SELECTOR 1 3BIT
MODE: Time-out

Range: Time-out, Acknowledge

 SELECTOR 1 3BIT ACK:
Off

Range: FlexLogic operand

 SELECTOR 1 POWER-UP
MODE: Restore

Range: Restore, Synchronize, Sync/Restore

 SELECTOR 1 TARGETS:
Self-reset

Range: Self-reset, Latched, Disabled

 SELECTOR 1 EVENTS:
Disabled

Range: Disabled, Enabled
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acknowledging signal appears before the element times out (“Acknowledge” mode). When the new position is applied, the 
relay displays the SELECTOR SWITCH 1: POSITION Z IN USE message. Typically, a user-programmable pushbutton is 
configured as the stepping up control input.

SELECTOR 1 STEP-UP MODE — This setting defines the selector mode of operation. When set to “Time-out,” the selector 
changes its position after a pre-defined period of inactivity at the control input. The change is automatic and does not 
require any explicit confirmation of the intent to change the selector's position. When set to “Acknowledge,” the selector 
changes its position only after the intent is confirmed through a separate acknowledging signal. If the acknowledging 
signal does not appear within a pre-defined period of time, the selector does not accept the change and an alarm is 
established by setting the SELECTOR STP ALARM output FlexLogic operand for three seconds.

SELECTOR 1 ACK — This setting specifies an acknowledging input for the stepping up control input. The pre-selected 
position is applied on the rising edge of the assigned operand. This setting is active only under “Acknowledge” mode of 
operation. The acknowledging signal must appear within the time defined by the SELECTOR 1 TIME-OUT setting after the last 
activity of the control input. A user-programmable pushbutton is typically configured as the acknowledging input.

SELECTOR 1 3BIT A0, A1, and A2 — These settings specify a three-bit control input of the selector. The three-bit control word 
pre-selects the position using the following encoding convention:

The “rest” position (0, 0, 0) does not generate an action and is intended for situations when the device generating the three-
bit control word is having a problem. When SELECTOR 1 3BIT MODE is “Time-out,” the pre-selected position is applied in 
SELECTOR 1 TIME-OUT seconds after the last activity of the three-bit input. When SELECTOR 1 3BIT MODE is “Acknowledge,” 
the pre-selected position is applied on the rising edge of the SELECTOR 1 3BIT ACK acknowledging input.

The stepping up control input (SELECTOR 1 STEP-UP) and the three-bit control inputs (SELECTOR 1 3BIT A0 through A2) lock-out 
mutually: once the stepping up sequence is initiated, the three-bit control input is inactive; once the three-bit control 
sequence is initiated, the stepping up input is inactive.

SELECTOR 1 3BIT MODE — This setting defines the selector mode of operation. When set to “Time-out,” the selector changes 
its position after a pre-defined period of inactivity at the control input. The change is automatic and does not require 
explicit confirmation to change the selector position. When set to “Acknowledge,” the selector changes its position only 
after confirmation via a separate acknowledging signal. If the acknowledging signal does not appear within a pre-defined 
period of time, the selector rejects the change and an alarm established by invoking the SELECTOR BIT ALARM FlexLogic 
operand for three seconds.

SELECTOR 1 3BIT ACK — This setting specifies an acknowledging input for the three-bit control input. The pre-selected 
position is applied on the rising edge of the assigned FlexLogic operand. This setting is active only under the 
“Acknowledge” mode of operation. The acknowledging signal must appear within the time defined by the SELECTOR TIME-
OUT setting after the last activity of the three-bit control inputs. Note that the stepping up control input and three-bit 
control input have independent acknowledging signals (SELECTOR 1 ACK and SELECTOR 1 3BIT ACK, accordingly).

SELECTOR 1 POWER-UP MODE — This setting specifies the element behavior on power up of the relay.

When set to “Restore,” the last position of the selector (stored in the non-volatile memory) is restored after powering up the 
relay. If the position restored from memory is out of range, position 0 (no output operand selected) is applied and an alarm 
is set (SELECTOR 1 PWR ALARM).

A2 A1 A0 Position

0 0 0 rest

0 0 1 1

0 1 0 2

0 1 1 3

1 0 0 4

1 0 1 5

1 1 0 6

1 1 1 7
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When set to “Synchronize,” the selector switch acts as follows. For two power cycles, the selector applies position 0 to the 
switch and activates SELECTOR 1 PWR ALARM. After two power cycles expire, the selector synchronizes to the position 
dictated by the three-bit control input. This operation does not wait for time-out or the acknowledging input. When the 
synchronization attempt is unsuccessful (that is, the three-bit input is not available (0,0,0) or out of range), then the selector 
switch output is set to position 0 (no output operand selected) and an alarm is established (SELECTOR 1 PWR ALARM).

The operation of “Synch/Restore” mode is similar to the “Synchronize” mode. The only difference is that after an 
unsuccessful synchronization attempt, the switch attempts to restore the position stored in the relay memory. The “Synch/
Restore” mode is useful for applications where the selector switch is employed to change the setting group in redundant 
(two relay) protection schemes.

SELECTOR 1 EVENTS — If enabled, the following events are logged:

The following figures illustrate the operation of the selector switch. In these diagrams, “T” represents a time-out setting.

Event name Description

SELECTOR 1 POS Z Selector 1 changed its position to Z

SELECTOR 1 STP ALARM The selector position pre-selected via the stepping up control input has not been confirmed before the 
time out

SELECTOR 1 BIT ALARM The selector position pre-selected via the three-bit control input has not been confirmed before the time 
out
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Figure 5-164: Time-out mode 



CHAPTER 5: SETTINGS CONTROL ELEMENTS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-305

5

Figure 5-165: Acknowledge mode 

Application example
Consider an application where the selector switch is used to control setting groups 1 through 4 in the relay. The setting 
groups are to be controlled from both user-programmable pushbutton 1 and from an external device via contact inputs 1 
through 3. The active setting group is to be available as an encoded three-bit word to the external device and SCADA via 
output contacts 1 through 3. The pre-selected setting group is to be applied automatically after five seconds of inactivity 
of the control inputs. When the relay powers up, it is to synchronize the setting group to the three-bit control input.
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Make the following changes to setting group control in the SETTINGS  CONTROL ELEMENTS  SETTING GROUPS menu:
FUNCTION: “Enabled”
Block: “Off”
GROUP 2 ACTIVATE ON: “SELECTOR 1 POS 2"
GROUP 3 ACTIVATE ON: “SELECTOR 1 POS 3"
GROUP 4 ACTIVATE ON: “SELECTOR 1 POS 4"
GROUP 5 ACTIVATE ON: “Off”
GROUP 6 ACTIVATE ON: “Off”

Make the following changes to selector switch element in the SETTINGS  CONTROL ELEMENTS  SELECTOR SWITCH  
SELECTOR SWITCH 1 menu to assign control to user programmable pushbutton 1 and contact inputs 1 through 3:

SELECTOR 1 FUNCTION: “Enabled”
SELECTOR 1 FULL-RANGE: “4”
SELECTOR 1 STEP-UP MODE: “Time-out”
SELECTOR 1 TIME-OUT: “5.0 s”
SELECTOR 1 STEP-UP: “PUSHBUTTON 1 ON”
SELECTOR 1 ACK: “Off”
SELECTOR 1 3BIT A0: “CONT IP 1 ON”
SELECTOR 1 3BIT A1: “CONT IP 2 ON”
SELECTOR 1 3BIT A2: “CONT IP 3 ON”
SELECTOR 1 3BIT MODE: “Time-out”
SELECTOR 1 3BIT ACK: “Off”
SELECTOR 1 POWER-UP MODE: “Synchronize”

Now, assign the contact output operation (assume the H6E module) to the selector switch element by making the following 
changes in the SETTINGS  INPUTS/OUTPUTS  CONTACT OUTPUTS menu:

OUTPUT H1 OPERATE: “SELECTOR 1 BIT 0"
OUTPUT H2 OPERATE: “SELECTOR 1 BIT 1"
OUTPUT H3 OPERATE: “SELECTOR 1 BIT 2"

Finally, assign configure user-programmable pushbutton 1 by making the following changes in the SETTINGS  PRODUCT 
SETUP  USER-PROGRAMMABLE PUSHBUTTONS  USER PUSHBUTTON 1 menu:

PUSHBUTTON 1 FUNCTION: “Self-reset”
PUSHBUTTON 1 DROP-OUT TIME: “0.10 s”

The figure shows the logic for the selector switch.
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Figure 5-166: Selector switch logic 

5.9.5  Underfrequency (ANSI 81U)
SETTINGS  CONTROL ELEMENTS  UNDERFREQUENCY  UNDERFREQUENCY 1(6)

There are six identical underfrequency elements, numbered 1 through 6.

 UNDERFREQUENCY 1
  UNDFREQ 1 FUNCTION:
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DELAY : 2.000 s

Range: 0.000 to 65.535 s in steps of 0.001
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Self-reset
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Disabled

Range: Disabled, Enabled
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The steady-state frequency of a power system is a certain indicator of the existing balance between the generated power 
and the load. Whenever this balance is disrupted through the loss of an important generating unit or the isolation of part 
of the system from the rest of the system, the effect is a reduction in frequency. If the control systems of the system 
generators do not respond fast enough, the system can collapse. A reliable method to quickly restore the balance between 
load and generation is to automatically disconnect selected loads, based on the actual system frequency. This technique, 
called “load-shedding,” maintains system integrity and minimize widespread outages. After the frequency returns to 
normal, the load can be restored automatically or manually.

UNDERFREQ 1 SOURCE — This setting is used to select the source for the signal to be measured. The element first checks for 
a live phase voltage available from the selected source. If voltage is not available, the element attempts to use a phase 
current. If neither voltage nor current is available, the element does not operate, as it does not measure a parameter 
below the minimum voltage/current setting.

UNDERFREQ 1 MIN VOLT/AMP — Selects the minimum per unit voltage or current level required to allow the underfrequency 
element to operate. This threshold is used to prevent an incorrect operation because there is no signal to measure.

UNDERFREQ 1 PICKUP — Selects the level at which the underfrequency element is to pickup. For example, if the system 
frequency is 60 Hz and the load shedding is required at 59.5 Hz, the setting is 59.50 Hz.

Figure 5-167: Underfrequency logic 

5.9.6  Overfrequency (ANSI 81O)
SETTINGS  CONTROL ELEMENTS  OVERFREQUENCY  OVERFREQUENCY 1(4)

There are four overfrequency elements, numbered 1 through 4.

A frequency calculation for a given source is made on the input of a voltage or current channel, depending on which is 
available. The channels are searched for the signal input in the following order: voltage channel A, auxiliary voltage 
channel, current channel A, and ground current channel. The first available signal is used for frequency calculation.

 OVERFREQUENCY 1
  OVERFREQ 1 FUNCTION:

Disabled
Range: Disabled, Enabled

 OVERFREQ 1 BLOCK:
Off

Range: FlexLogic operand

 OVERFREQ 1 SOURCE:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 OVERFREQ 1 PICKUP:
60.50 Hz

Range: 20.00 to 65.00 Hz in steps of 0.01

 OVERFREQ 1 PICKUP
DELAY: 0.500 s

Range: 0.000 to 65.535 s in steps of 0.001

 OVERFREQ 1 RESET
DELAY : 0.500 s

Range: 0.000 to 65.535 s in steps of 0.001

 OVERFREQ 1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 OVERFREQ 1 EVENTS:
Disabled

Range: Disabled, Enabled
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The steady-state frequency of a power system is an indicator of the existing balance between the generated power and 
the load. Whenever this balance is disrupted through the disconnection of significant load or the isolation of a part of the 
system that has a surplus of generation, the effect is an increase in frequency. If the control systems of the generators do 
not respond fast enough, to quickly ramp the turbine speed back to normal, the overspeed can lead to the turbine trip. The 
overfrequency element can be used to control the turbine frequency ramp down at a generating location. This element 
can also be used for feeder reclosing as part of the "after load shedding restoration."

The OVERFREQ 1 SOURCE setting selects the source for the signal to be measured.

The OVERFREQ 1 PICKUP setting selects the level at which the overfrequency element is to pickup.

Figure 5-168: Overfrequency logic 

5.9.7  Frequency rate of change (ANSI 81R)
SETTINGS  CONTROL ELEMENTS  FREQUENCY RATE OF CHANGE  FREQUENCY RATE OF CHANGE 1(4)

 FREQUENCY RATE
 OF CHANGE 1  FREQ RATE 1

FUNCTION: Disabled
Range: Disabled, Enabled

 FREQ RATE 1 SOURCE:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 FREQ RATE 1 TREND:
Increasing

Range: Increasing, Decreasing, Bi-directional

 FREQ RATE 1 PICKUP:
0.50 Hz/sec

Range: 0.10 to 15.00 Hz/sec in steps of 0.01

 FREQ RATE 1 OV SUPV
PICKUP: 0.700 pu

Range: 0.100 to 3.000 pu in steps of 0.001

 FREQ RATE 1 OC SUPV
PICKUP: 0.200 pu

Range: 0.020 to 30.000 pu in steps of 0.001

 FREQ RATE 1 MIN
FREQUENCY: 45.00 Hz

Range: 20.00 to 80.00 Hz in steps of 0.01

 FREQ RATE 1 MAX
FREQUENCY: 65.00 Hz

Range: 20.00 to 80.00 Hz in steps of 0.01

 FREQ RATE 1 PICKUP
DELAY: 0.000 s

Range: 0 to 65.535 s in steps of 0.001

 FREQ RATE 1 RESET
DELAY: 0.000 s

Range: 0 to 65.535 s in steps of 0.001

 FREQ RATE 1 BLOCK:
Off

Range: FlexLogic operand
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The element responds to rate of change of frequency with voltage, current and frequency supervision.

FREQ RATE 1 TREND — This setting configures the element to respond to increasing or decreasing frequency, or to frequency 
change in either direction.

FREQ RATE 1 PICKUP — This setting specifies an intended df/dt pickup threshold. For applications monitoring a decreasing 
trend, set FREQ RATE 1 TREND to “Decreasing” and specify the pickup threshold accordingly. The operating condition is: 
-df/dt > Pickup.

For applications monitoring an increasing trend, set FREQ RATE 1 TREND to “Increasing” and specify the pickup threshold 
accordingly. The operating condition is: df/dt > Pickup.

For applications monitoring rate of change of frequency in any direction set FREQ RATE 1 TREND to “Bi-Directional” and 
specify the pickup threshold accordingly. The operating condition is: abs (df/dt) > Pickup.

FREQ RATE 1 OV SUPV PICKUP — This setting defines the minimum voltage level required for operation of the element. The 
supervising function responds to the positive-sequence voltage. Use overvoltage supervision to prevent operation under 
specific system conditions, such as faults.

FREQ RATE 1 OC SUPV PICKUP — This setting defines minimum current level required for operation of the element. The 
supervising function responds to the positive-sequence current. Typical application includes load shedding. Set the pickup 
threshold to 0.020 if no overcurrent supervision is required.

FREQ RATE 1 MIN FREQUENCY — This setting defines the minimum frequency level required for operation of the element. The 
setting can be used to effectively block the feature based on frequency. For example, if the intent is to monitor an 
increasing trend but only if the frequency is already above certain level, set this setting to the required frequency level.

FREQ RATE 1 MAX FREQUENCY — This setting defines the maximum frequency level required for operation of the element. 
The setting can be used to effectively block the feature based on frequency. For example, if the intent is to monitor a 
decreasing trend but only if the frequency is already below a certain level (such as for load shedding), set this setting to the 
required frequency level.

Figure 5-169: Frequency rate of change logic 
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5.9.8  Synchrocheck (ANSI 25)
SETTINGS  CONTROL ELEMENTS  SYNCHROCHECK  SYNCHROCHECK 1(4)

The synchronism check function supervises the paralleling of two parts of a system that are to be joined by the closure of 
a circuit breaker. The synchrocheck elements are typically used at locations where the two parts of the system are 
interconnected through at least one other point in the system.

 SYNCHROCHECK 1
  SYNCHK1 FUNCTION:

Disabled
Range: Disabled, Enabled

 SYNCHK1 BLOCK:
Off

Range: FlexLogic operand

 SYNCHK1 V1 SOURCE:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 SYNCHK1 V2 SOURCE:
SRC 2

Range: SRC 1, SRC 2, SRC 3, SRC 4

 SYNCHK1 MAX VOLT
DIFF: 10000 V

Range: 0 to 400000 V in steps of 1

 SYNCHK1 MAX ANGLE
DIFF: 30°

Range: 0 to 100° in steps of 1

 SYNCHK1 MAX FREQ
DIFF: 1.00 Hz

Range: 0.00 to 2.00 Hz in steps of 0.01

 SYNCHK1 MAX FREQ
HYSTERESIS: 0.06 Hz

Range: 0.00 to 0.10 Hz in steps of 0.01

 SYNCHK1 SYNC CLOSE:
Off

Range: FlexLogic operand

 SYNCHK1 S-CLS MAX
dF: 0.50 Hz

Range: 0.10 to 2.00 Hz in steps of 0.01

 SYNCHK1 S-CLS MIN
dF: 0.10 Hz

Range: 0.00 to 1.00 Hz in steps of 0.01

 SYNCHK1 S-CLS BRK
TIME: 0.035 s

Range: 0.000 to 0.500 s in steps of 0.001

 SYNCHK1 V2 MAG CORR
FACTOR: 1.00

Range: 0.10 to 10.00 in steps of 0.01

 SYNCHK1 V2 ANGLE
SHIFT: 0

Range: -180 to +180 degrees in steps of 1

 SYNCHK1 DEAD SOURCE
SELECT: LV1 and DV2

Range: None, LV1 and DV2, DV1 and LV2, DV1 or DV2, 
DV1 Xor DV2, DV1 and DV2

 SYNCHK1 DEAD V1
MAX VOLT: 0.30 pu

Range: 0.04 to 1.25 pu in steps of 0.01

 SYNCHK1 DEAD V2
MAX VOLT: 0.30 pu

Range: 0.04 to 1.25 pu in steps of 0.01

 SYNCHK1 LIVE V1
MIN VOLT: 0.70 pu

Range: 0.04 to 1.25 pu in steps of 0.01

 SYNCHK1 LIVE V2
MIN VOLT: 0.70 pu

Range: 0.04 to 1.25 pu in steps of 0.01

 SYNCHK1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 SYNCHK1 EVENTS:
Disabled

Range: Disabled, Enabled
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Synchrocheck verifies that the voltages (V1 and V2) on the two sides of the supervised circuit breaker are within set limits 
of magnitude, angle, and frequency differences. The time that the two voltages remain within the admissible angle 
difference is determined by the setting of the phase angle difference  and the frequency difference F (slip frequency). It 
can be defined as the time it takes the voltage phasor V1 or V2 to traverse an angle equal to 2   at a frequency equal 
to the frequency difference F. This time is calculated by:

Eq. 5-31

where

is phase angle difference in degrees
F is frequency difference in Hz

If one or both sources are de-energized, the synchrocheck programming can allow for closing of the circuit breaker using 
undervoltage control to bypass the synchrocheck measurements (dead source function).

SYNCHK1 V1 SOURCE — This setting selects the source for voltage V1 (see the Notes section that follows).

SYNCHK1 V2 SOURCE — Selects the source for voltage V2, which must not be the same as used for the V1 (see Notes).

SYNCHK1 MAX VOLT DIFF — Selects the maximum primary voltage difference in volts between the two sources. A primary 
voltage magnitude difference between the two input voltages below this value is within the permissible limit for 
synchronism.

SYNCHK1 MAX ANGLE DIFF — Selects the maximum angular difference in degrees between the two sources. An angular 
difference between the two input voltage phasors below this value is within the permissible limit for synchronism.

SYNCHK1 MAX FREQ HYSTERESIS — Specifies the required hysteresis for the maximum frequency difference condition. The 
condition becomes satisfied when the frequency difference becomes lower than SYNCHK1 MAX FREQ DIFF. Once the 
Synchrocheck element has operated, the frequency difference must increase above the SYNCHK1 MAX FREQ DIFF + SYNCHK1 
MAX FREQ HYSTERESIS sum to drop out (assuming the other two conditions, voltage and angle, remain satisfied).

SYNCHK1 SYNC CLOSE — Enables the dynamic mode of synchrocheck. When it is enabled, the location of where the present 
V2 vector will be arriving to synchronize (shown as V2' in the figures here) with breaker close time being taken into account 
will be predicted based on the measured slip frequency so that breaker close command can be issued in advance to 
ensure the synchronism at the time when the breaker is actually closed.

Figure 5-170: Synchrocheck plot for slip > 0 (slip = F2-F1) 
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Figure 5-171: Synchrocheck plot for slip < 0 (slip = F2-F1) 

SYNCHK1 S-CLS MAX dF — Specifies the maximum slip frequency allowed in Hz in the dynamic mode. The dynamic mode is 
disarmed when the slip frequency exceeds this setting.

SYNCHK1 S-CLS MIN dF — Specifies the minimum slip frequency allowed in Hz in the dynamic mode. The dynamic mode is 
disarmed when the slip frequency drops below this setting.

SYNCHK1 S-CLS BRK TIME — Specifies the breaker closing time in seconds.

SYNCHK1 V2 MAG CORR FACTOR — Specifies the magnitude correction factor of source V2. This setting is used for V2 
magnitude compensation so that V2 magnitude can be directly compared with V1 magnitude. For example, when V1 and 
V2 are taken from 2 different windings of the transformer and at different voltage levels, the magnitude compensation 
must be performed before starting magnitude comparison in synchrocheck element.

SYNCHK1 V2 ANGLE SHIFT — Specifies the angle of source V2 that needs to be shifted so that V2 angle can be directly 
compared with V1 angle. For example, when V1 and V2 are taken from two different windings of the transformer and with 
different angle shift due to winding connections, the angle shift compensation must be performed before starting angle 
comparison in synchrocheck element.

SYNCHK1 DEAD SOURCE SELECT — Selects the combination of dead and live sources that bypass the synchronism check 
function and permit the breaker to be closed when one or both of the two voltages (V1 or/and V2) are below the maximum 
voltage threshold. A dead or live source is declared by monitoring the voltage level. Six options are available:

None — Dead Source function is disabled
LV1 and DV2 — Live V1 and Dead V2
DV1 and LV2 — Dead V1 and Live V2
DV1 or DV2 — Dead V1 or Dead V2
DV1 Xor DV2 — Dead V1 exclusive-or Dead V2 (one source is Dead and the other is Live)
DV1 and DV2 — Dead V1 and Dead V2

SYNCHK1 DEAD V1 MAX VOLT — Establishes a maximum voltage magnitude for V1 in 1 ‘pu’. Below this magnitude, the V1 
voltage input used for synchrocheck is considered “Dead” or de-energized.

SYNCHK1 DEAD V2 MAX VOLT — Establishes a maximum voltage magnitude for V2 in ‘pu’. Below this magnitude, the V2 
voltage input used for synchrocheck is considered “Dead” or de-energized.

SYNCHK1 LIVE V1 MIN VOLT — Establishes a minimum voltage magnitude for V1 in ‘pu’. Above this magnitude, the V1 voltage 
input used for synchrocheck is considered “Live” or energized.

SYNCHK1 LIVE V2 MIN VOLT — This setting establishes a minimum voltage magnitude for V2 in ‘pu’. Above this magnitude, 
the V2 voltage input used for synchrocheck is considered “Live” or energized.

Notes on the synchrocheck function

1. The selected sources for synchrocheck inputs V1 and V2 (which must not be the same source) can include both a 
three-phase and an auxiliary voltage. The relay automatically selects the specific voltages to be used by the 
synchrocheck element in accordance with the following table.
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The voltages V1 and V2 are matched automatically so that the corresponding voltages from the two sources are used 
to measure conditions. A phase to phase voltage is used if available in both sources; if one or both of the Sources have 
only an auxiliary voltage, this voltage is used. For example, if an auxiliary voltage is programmed to VAG, the 
synchrocheck element automatically selects VAG from the other source. If the comparison is required on a specific 
voltage, the user can externally connect that specific voltage to auxiliary voltage terminals and then use this "Auxiliary 
Voltage" to check the synchronism conditions.
If using a single CT/VT module with both phase voltages and an auxiliary voltage, ensure that only the auxiliary 
voltage is programmed in one of the sources to be used for synchrocheck. An exception is that synchronism cannot 
be checked between Delta connected phase VTs and a Wye connected auxiliary voltage.

2. The relay measures frequency and Volts/Hz from an input on a given source with priorities as established by the 
configuration of input channels to the source. The relay uses the phase channel of a three-phase set of voltages if 
programmed as part of that source. The relay uses the auxiliary voltage channel only if that channel is programmed 
as part of the Source and a three-phase set is not.

Number V1 or V2 (source Y) V2 or V1 (source Z) Auto-selected combination Auto-selected 
voltageSource Y Source Z

1 Phase VTs and 
Auxiliary VT

Phase VTs and 
Auxiliary VT

Phase Phase VAB

2 Phase VTs and 
Auxiliary VT

Phase VT Phase Phase VAB

3 Phase VT Phase VT Phase Phase VAB

4 Phase VT and Auxiliary 
VT

Auxiliary VT Phase Auxiliary V auxiliary
(as set for source Z)

5 Auxiliary VT Auxiliary VT Auxiliary Auxiliary V auxiliary
(as set for selected 
sources)
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Figure 5-172: Synchrocheck logic 
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5.9.9  Autoreclose (ANSI 79)
SETTINGS  CONTROL ELEMENTS  AUTORECLOSE  AUTORECLOSE 1(4)

 AUTORECLOSE 1
  AR1 FUNCTION:

Disabled
Range: Disabled, Enabled

 AR1 INITIATE:
Off

Range: FlexLogic operand

 AR1 BLOCK:
Off

Range: FlexLogic operand

 AR1 MAX NUMBER OF
SHOTS: 1

Range: 1, 2, 3, 4

 AR1 REDUCE MAX TO 1:
Off

Range: FlexLogic operand

 AR1 REDUCE MAX TO 2:
Off

Range: FlexLogic operand

 AR1 REDUCE MAX TO 3:
Off

Range: FlexLogic operand

 AR1 MANUAL CLOSE:
Off

Range: FlexLogic operand

 AR1 MNL RST FRM LO:
Off

Range: FlexLogic operand

 AR1 RESET LOCKOUT IF
BREAKER CLOSED: Off

Range: Off, On

 AR1 RESET LOCKOUT ON
MANUAL CLOSE: Off

Range: Off, On

 AR1 BKR CLOSED:
Off

Range: FlexLogic operand

 AR1 BKR OPEN:
Off

Range: FlexLogic operand

 AR1 BLK TIME UPON
MNL CLS: 10.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 DEAD TIME 1:
1.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 DEAD TIME 2:
2.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 DEAD TIME 3:
3.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 DEAD TIME 4:
4.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 ADD DELAY 1:
Off

Range: FlexLogic operand

 AR1 DELAY 1:
0.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 ADD DELAY 2:
Off

Range: FlexLogic operand

 AR1 DELAY 2:
0.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 RESET LOCKOUT
DELAY: 60.000

Range: 0.00 to 655.35 s in steps of 0.01
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The maximum number of autoreclosure elements available is equal to the number of installed CT banks.

The autoreclosure feature is intended for use with transmission and distribution lines, in three-pole tripping schemes for 
single breaker applications. Up to four selectable reclosures "shots" are possible prior to locking out. Each shot has an 
independently settable dead time. The protection settings can be changed between shots if required, using FlexLogic. 
Logic inputs are available for disabling or blocking the scheme.

Faceplate panel LEDs indicate the state of the autoreclose scheme as follows:

• Reclose Enabled — The scheme is enabled and can reclose if initiated

• Reclose Disabled — The scheme is disabled

• Reclose In Progress — An autoreclosure has been initiated but the breaker has not yet been signaled to close

• Reclose Locked Out — The scheme has generated the maximum number of breaker closures allowed and, as the fault 
persists, does not close the breaker again; known as "Lockout." The scheme can also be sent in "Lockout" when the 
incomplete sequence timer times out or when a block signal occurs while in "reclose in progress." The scheme must be 
reset from Lockout in order to perform reclose for further faults.

The reclosure scheme is considered enabled when all of the following conditions are true:

• The AR1 FUNCTION is set to “Enabled”

• The scheme is not in the "Lockout" state

• The "Block" input is not asserted

• The AR1 BLK TIME UPON MNL CLS timer is not active

The autoreclose scheme is initiated by a trip signal from any selected protection feature operand. The scheme is initiated 
provided the circuit breaker is in the closed state before protection operation.

The reclose-in-progress (RIP) is set when a reclosing cycle begins following a reclose initiate signal. Once the cycle is 
successfully initiated, the RIP signal seals-in and the scheme continues through its sequence until one of the following 
conditions is satisfied:

• The close signal is issued when the dead timer times out, or

• The scheme goes to lockout

While RIP is active, the scheme checks that the breaker is open and the shot number is below the limit, and then begins 
measuring the dead time.

Each of the four possible shots has an independently settable dead time. Two additional timers can be used to increase the 
initial set dead times 1 to 4 by a delay equal to AR1 DELAY 1 or AR1 DELAY 2 or the sum of these two delays depending on the 
selected settings. This offers enhanced setting flexibility using FlexLogic operands to turn the two additional timers “on” 
and “off.” These operands can possibly include AR1 SHOT CNT =n, SETTING GROUP ACT 1, and so on. The autoreclose provides 
up to maximum 4 selectable shots. Maximum number of shots can be dynamically modified through the settings AR1 
REDUCE MAX TO 1 (2, 3), using the appropriate FlexLogic operand.

Scheme lockout blocks all phases of the reclosing cycle, preventing automatic reclosure, if any of the following occurs:

• The maximum shot number was reached

• A "Block" input is in effect (for instance, Breaker Failure or bus differential protection operated)

• The "Incomplete Sequence" timer times out

 AR1 RESET TIME:
60.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 INCOMPLETE SEQ
TIME: 5.000 s

Range: 0.00 to 655.35 s in steps of 0.01

 AR1 EVENTS:
Disabled

Range: Disabled, Enabled

The F60 is provided with this optional feature, specified as an option at the time of ordering. Using the order 
code for your device, see the order codes in chapter 2 for details.
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The recloser is latched in the Lockout state until a "reset from lockout" signal is asserted, either from a manual close of the 
breaker or from a manual reset command (local or remote). The reset from lockout can be accomplished by operator 
command, by manually closing the breaker, or whenever the breaker has been closed and stays closed for a preset time.

After the dead time elapses, the scheme issues the close signal. The close signal is latched until the breaker closes or the 
scheme goes to Lockout.

A reset timer output resets the recloser following a successful reclosure sequence. The reset time is based on the breaker 
"reclaim time," which is the minimum time required between successive reclose sequences.

5.9.9.1  Settings
AR1 INITIATE — Selects the FlexLogic operand that initiates the scheme, typically the trip signal from protection.

AR1 BLOCK — Selects the FlexLogic operand that blocks the autoreclosure initiate (it can be from the breaker failure, bus 
differential protection, and so on).

AR1 MAX NUMBER OF SHOTS — Specifies the number of reclosures that can be attempted before reclosure goes to “Lockout” 
because the fault is permanent.

AR1 REDUCE MAX TO 1(3) — Selects the FlexLogic operand that changes the maximum number of shots from the initial 
setting to 1, 2, or 3, respectively.

AR1 MANUAL CLOSE — Selects the logic input set when the breaker is manually closed.

AR1 MNL RST FRM LO — Selects the FlexLogic operand that resets the autoreclosure from Lockout condition. Typically this is 
a manual reset from lockout, local or remote.

AR1 RESET LOCKOUT IF BREAKER CLOSED — This setting allows the autoreclose scheme to reset from Lockout if the breaker 
has been manually closed and stays closed for a preset time. In order for this setting to be effective, disable the next 
setting (AR1 RESET LOCKOUT ON MANUAL CLOSE).

AR1 RESET LOCKOUT ON MANUAL CLOSE — This setting allows the autoreclose scheme to reset from Lockout when the 
breaker is manually closed regardless if the breaker remains closed or not. This setting overrides the previous setting (AR1 
RESET LOCKOUT IF BREAKER CLOSED).

AR1 BLK TIME UPON MNL CLS — The autoreclose scheme can be disabled for a programmable time delay after the 
associated circuit breaker is manually closed. This prevents reclosing onto a fault after a manual close. This delay must be 
longer than the slowest expected trip from any protection not blocked after manual closing. If no overcurrent trips occur 
after a manual close and this time expires, the autoreclose scheme is enabled.

AR1 DEAD TIME 1 to AR1 DEAD TIME 4 — These are the intentional delays before first, second, third, and fourth breaker 
automatic reclosures (1st, 2nd, and 3rd shots), respectively. Set them longer than the estimated deionizing time following a 
three pole trip.

AR1 ADD DELAY 1 — This setting selects the FlexLogic operand that introduces an additional delay (Delay 1) to the initial set 
Dead Time (1 to 4). When this setting is “Off,” Delay 1 is by-passed.

AR1 DELAY 1 — This setting establishes the extent of the additional dead time Delay 1.

AR1 ADD DELAY 2 — This setting selects the FlexLogic operand that introduces an additional delay (Delay 2) to the initial set 
Dead Time (1 to 4). When this setting is “Off”, Delay 2 is by-passed.

AR1 DELAY 2 — This setting establishes the extent of the additional dead time Delay 2.

AR1 RESET LOCKOUT DELAY — This setting establishes how long the breaker stays closed after a manual close command, in 
order for the autorecloser to reset from Lockout.

AR1 RESET TIME — A reset timer output resets the recloser following a successful reclosure sequence. The setting is based 
on the breaker "reclaim time," which is the minimum time required between successive reclose sequences.

AR1 INCOMPLETE SEQ TIME — This timer defines the maximum time interval allowed for a single reclose shot. It is started 
whenever a reclosure is initiated and is active when the scheme is in the "reclose-in-progress" state. If all conditions 
allowing a breaker closure are not satisfied when this time expires, the scheme goes to Lockout.

This timer must be set to a delay less than the reset timer.
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Figure 5-173: Autorecloser logic (Sheet 1 of 2) 
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Figure 5-174: Autorecloser logic (Sheet 2 of 2) 
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Figure 5-175: Single shot autoreclosing sequence - permanent fault 
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5.9.10  Digital elements
SETTINGS  CONTROL ELEMENTS  DIGITAL ELEMENTS  DIGITAL ELEMENT 1(48)

There are 48 identical digital elements available, numbered 1 to 48. A digital element can monitor any FlexLogic operand 
and present a target message and/or enable events recording depending on the output operand state. The digital element 
settings include a name to be referenced in any target message, a blocking input from any selected FlexLogic operand, 
and a timer for pickup and reset delays for the output operand.

DIGITAL ELEMENT 1 INPUT — Selects a FlexLogic operand to be monitored by the digital element.

DIGITAL ELEMENT 1 PICKUP DELAY — Sets the required time delay from element pickup to element operation. If a pickup delay 
is not required, set to "0," To avoid nuisance alarms, set the delay greater than the operating time of the breaker.

DIGITAL ELEMENT 1 RESET DELAY — Sets the time delay to reset. If a reset delay is not required, set to “0.”

DIGITAL ELEMENT 1 PICKUP LED — This setting enables or disabled the digital element pickup LED. When set to “Disabled,” the 
operation of the pickup LED is blocked.

 DIGITAL ELEMENT 1
  DIGITAL ELEMENT 1

FUNCTION: Disabled
Range: Disabled, Enabled

 DIG ELEM 1 NAME:
Dig Element 1

Range: up to 16 alphanumeric characters

 DIG ELEM 1 INPUT:
Off

Range: FlexLogic operand

 DIG ELEM 1 PICKUP
DELAY: 0.000 s

Range: 0.000 to 999999.999 s in steps of 0.001

 DIG ELEM 1 RESET
DELAY: 0.000 s

Range: 0.000 to 999999.999 s in steps of 0.001

 DIGITAL ELEMENT 1
PICKUP LED: Enabled

Range: Disabled, Enabled

 DIG ELEM 1 BLOCK:
Off

Range: FlexLogic operand

 DIGITAL ELEMENT 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 DIGITAL ELEMENT 1
EVENTS: Disabled

Range: Disabled, Enabled

Digital elements run once per power system cycle.
As such they can easily fail to react to an input signal or a block signal with a duration less than one power system 
cycle. This also means that digital element output can react up to one power system cycle later than the pickup 
and reset delay settings indicate.

Do not use digital elements with transient signals, such as communications commands. Do not use digital 
elements where random delays of up to one cycle cannot be tolerated, such as in high speed protection.
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Figure 5-176: Digital element logic 

Circuit monitoring applications
Some versions of the digital input modules include an active voltage monitor circuit connected across form-A contacts. 
The voltage monitor circuit limits the trickle current through the output circuit (see technical specifications for form-A).

As long as the current through the voltage monitor is above a threshold (see technical specifications for form-A), the Cont 
Op 1 VOn FlexLogic operand is set (for contact input 1—corresponding operands exist for each contact output). If the output 
circuit has a high resistance or the DC current is interrupted, the trickle current drops below the threshold and the Cont Op 1 
VOff FlexLogic operand is set. Consequently, the state of these operands can be used as indicators of the integrity of the 
circuits in which form-A contacts are inserted.

Example 1: Breaker trip circuit integrity monitoring
In many applications it is desired to monitor the breaker trip circuit integrity so that problems can be detected before a trip 
operation is required. The circuit is considered to be healthy when the voltage monitor connected across the trip output 
contact detects a low level of current, well below the operating current of the breaker trip coil. If the circuit presents a high 
resistance, the trickle current falls below the monitor threshold, and an alarm is declared.

In most breaker control circuits, the trip coil is connected in series with a breaker auxiliary contact that is open when the 
breaker is open (see figure). To prevent unwanted alarms in this situation, the trip circuit monitoring logic must include the 
breaker position.

Figure 5-177: Trip circuit example 1 

SETTING
DIGITAL ELEMENT 01
FUNCTION:
Enabled = 1

DIGITAL ELEMENT 01
BLOCK:
Off = 0

FLEXLOGIC OPERANDS
DIG ELEM 01 DPO
DIG ELEM 01 PKP

SETTING

827042A2.VSD

DIGITAL ELEMENT 01
INPUT:
Off = 0

SETTING

INPUT = 1 

RUN tPKP

tRST

DIGITAL ELEMENT 01
PICKUP DELAY:

SETTINGS

DIGITAL ELEMENT 01 
RESET DELAY:

AND

SETTING
DIGITAL ELEMENT 01 
NAME:

DIG ELEM 01 OP
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Assume the output contact H1 is a trip contact. Using the contact output settings, this output is given an ID name; for 
example, “Cont Op 1." Assume a 52a breaker auxiliary contact is connected to contact input H7a to monitor breaker status. 
Using the contact input settings, this input is given an ID name, for example, “Cont Ip 1," and is set “On” when the breaker is 
closed. The settings to use digital element 1 to monitor the breaker trip circuit are indicated (EnerVista example shown).

Example 2: Breaker trip circuit integrity monitoring
If it is required to monitor the trip circuit continuously, independent of the breaker position (open or closed), a method to 
maintain the monitoring current flow through the trip circuit when the breaker is open must be provided (as shown in the 
following figure). This can be achieved by connecting a suitable resistor (see figure) across the auxiliary contact in the trip 
circuit. In this case, it is not required to supervise the monitoring circuit with the breaker position – the BLOCK setting is 
selected to “Off.” In this case, the settings are as follows (EnerVista example shown).
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Figure 5-178: Trip circuit example 2 

5.9.11  Digital counters
SETTINGS  CONTROL ELEMENTS  DIGITAL COUNTERS  COUNTER 1(8)

There are eight identical digital counters, numbered from 1 to 8. A digital counter counts the number of state transitions 
from Logic 0 to Logic 1. The counter is used to count operations such as the pickups of an element, the changes of state of 
an external contact (for example, breaker auxiliary switch), or pulses from a watt-hour meter.

The wiring connection for two examples above is applicable to both form-A contacts with voltage monitoring and 
solid-state contact with voltage monitoring.

 COUNTER 1
  COUNTER 1

FUNCTION: Disabled
Range: Disabled, Enabled

 COUNTER 1 NAME:
Counter 1

Range: up to 12 alphanumeric characters

 COUNTER 1 UNITS: Range: up to six alphanumeric characters

 COUNTER 1 PRESET:
0

Range: –2,147,483,648 to +2,147,483,647

 COUNTER 1 COMPARE:
0

Range: –2,147,483,648 to +2,147,483,647

 COUNTER 1 UP:
Off

Range: FlexLogic operand

 COUNTER 1 DOWN:
Off

Range: FlexLogic operand

 COUNTER 1 BLOCK:
Off

Range: FlexLogic operand

 CNT1 SET TO PRESET:
Off

Range: FlexLogic operand

 COUNTER 1 RESET:
Off

Range: FlexLogic operand

 COUNT1 FREEZE/RESET:
Off

Range: FlexLogic operand

 COUNT1 FREEZE/COUNT:
Off

Range: FlexLogic operand
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COUNTER 1 UNITS — Assigns a label to identify the unit of measure pertaining to the digital transitions to be counted. The 
units label appears in the corresponding actual values status.

COUNTER 1 PRESET — Sets the count to a required preset value before counting operations begin, as in the case where a 
substitute relay is to be installed in place of an in-service relay, or while the counter is running.

COUNTER 1 COMPARE — Sets the value to which the accumulated count value is compared. Three FlexLogic output 
operands are provided to indicate if the present value is ‘more than (HI)’, ‘equal to (EQL)’, or ‘less than (LO)’ the set value.

COUNTER 1 UP — Selects the FlexLogic operand for incrementing the counter. If an enabled UP input is received when the 
accumulated value is at the limit of +2,147,483,647 counts, the counter rolls over to –2,147,483,648.

COUNTER 1 DOWN — Selects the FlexLogic operand for decrementing the counter. If an enabled DOWN input is received 
when the accumulated value is at the limit of –2,147,483,648 counts, the counter rolls over to +2,147,483,647.

COUNTER 1 BLOCK — Selects the FlexLogic operand for blocking the counting operation. All counter operands are blocked.

CNT1 SET TO PRESET — Selects the FlexLogic operand used to set the count to the preset value. The counter sets to the 
preset value in the following situations:

• When the counter is enabled and the CNT1 SET TO PRESET operand has the value 1 (when the counter is enabled and 
CNT1 SET TO PRESET operand is 0, the counter sets to 0)

• When the counter is running and the CNT1 SET TO PRESET operand changes the state from 0 to 1 (CNT1 SET TO PRESET 
changing from 1 to 0 while the counter is running has no effect on the count)

• When a reset or reset/freeze command is sent to the counter and the CNT1 SET TO PRESET operand has the value 1 
(when a reset or reset/freeze command is sent to the counter and the CNT1 SET TO PRESET operand has the value 0, the 
counter sets to 0)

COUNTER 1 RESET — Selects the FlexLogic operand for setting the count to either “0” or the preset value depending on the 
state of the CNT1 SET TO PRESET operand.

COUNTER 1 FREEZE/RESET — Selects the FlexLogic operand for capturing (freezing) the accumulated count value into a 
separate register with the date and time of the operation, and resetting the count to “0.”

COUNTER 1 FREEZE/COUNT — Selects the FlexLogic operand for capturing (freezing) the accumulated count value into a 
separate register with the date and time of the operation, and continuing counting. The present accumulated value and 
captured frozen value with the associated date/time stamp are available as actual values. If control power is interrupted, 
the accumulated and frozen values are saved into non-volatile memory during the power-down operation.
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Figure 5-179: Digital counter logic 

5.10  Monitoring elements

5.10.0.1  Menu
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS

 MONITORING
 ELEMENTS   HI-Z

 
See below

  BREAKER 1
 ARCING CURRENT

See page 5-333

  BREAKER 2
 ARCING CURRENT

  BREAKER
 FLASHOVER 1

See page 5-337

  BREAKER
 FLASHOVER 2

  BREAKER RESTRIKE 1
 

See page 5-342



  BREAKER RESTRIKE 3
 

  CT FAILURE
 DETECTOR 1

See page 5-344
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5.10.0.2  High-impedance fault detection
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  HI-Z

  CT FAILURE
 DETECTOR 1

  INCIPIENT FAULT 1
 

See page 5-346

  INCIPIENT FAULT 2
 

  VT FUSE FAILURE 1
 

See page 5-348



  VT FUSE FAILURE 4
 

  THERMAL OVERLOAD
 PROTECTION

See page 5-350

  BROKEN CONDUCTOR
 

See page 5-353

 HI-Z
  HI-Z FUNCTION:

Disabled
Range: Disabled, Enabled

 HI-Z SOURCE:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 HI-Z ARCING
SENSITIVITY: 5

Range: 1 to 10 in steps of 1

 HI-Z ARCING DET SOE
RESET TIME: 0.0 s

Range: 0.0 to 6000.0 s in steps of 0.1

 HI-Z PHASE EVENT
COUNT: 30

Range: 10 to 250 in steps of 1

 HI-Z GROUND EVENT
COUNT: 30

Range: 10 to 500 in steps of 1

 HI-Z EVENT COUNT
TIME: 15 min

Range: 5 to 180 min. in steps of 1

 HI-Z OC PROTECTION
COORD TIMEOUT: 15 s

Range: 10 to 200 s in steps of 1

 HI-Z PHASE OC MIN
PICKUP: 1.50 pu

Range: 0.01 to 10.00 pu in steps of 0.01

 HI-Z NEUTRAL OC MIN
PICKUP: 1.00 pu

Range: 0.01 to 10.00 pu in steps of 0.01

 HI-Z PHASE RATE OF
CHANGE: 150 A/2cycle

Range: 1 to 999 A/2cycle in steps of 1

 HI-Z NEUTRAL RATE OF
CHANGE: 150 A/2cycle

Range: 1 to 999 A/2cycle in steps of 1

 HI-Z LOSS OF LOAD
THRESHOLD: 15%

Range: 5 to 100% in steps of 1

 HI-Z 3-PHASE EVENT
THRESHOLD: 25 A

Range: 1 to 1000 A in steps of 1

 HI-Z VOLTAGE SUPV
THRESHOLD: 5%

Range: 0 (off) to 100% in steps of 1
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Some faults in overhead distribution feeders are characterized by low fault current due to high ground resistance. If the 
fault current is in the order of expected unbalance load or less, it cannot be reliably detected by overcurrent protection. 
These faults are classified as high-impedance (Hi-Z) faults. Since a Hi-Z fault is not accompanied by excessive current, it is 
generally not dangerous to the electrical installation except for some damage to the overhead conductor at the fault 
location. However, an undetected Hi-Z fault is a risk to people and property as well as having a potential to evolve into a 
full-blown fault.

The following event types are associated with Hi-Z faults. It is assumed that for all cases that ground is involved.

• High impedance fault — A fault with fault impedance sufficiently high such that it is not detected by overcurrent 
protection

• High impedance, downed conductor fault — A high impedance fault for which the primary conductor is no longer 
intact on pole top insulators, but instead is in contact with earth or a grounded object

• Arcing fault — Any high impedance fault which exhibits arcing

Combinations of these events are possible: for example, an arcing high impedance, downed conductor fault. The Hi-Z 
element is intended to detect high impedance faults that arc and to differentiate those that are downed conductors from 
those that are not. It should be noted that no known technology can detect all Hi-Z faults.

The Hi-Z element was primarily designed for solidly grounded systems. The similar Hi-Z element in the DFM200 relay has 
been tested with some success on impedance grounded systems as well. However, there are no guarantees of certain 
operation of the high impedance fault detection element on non-solidly grounded systems.

The Hi-Z data collection consists of RMS Data Capture and Hi-Z Data capture:

• RMS Data Capture — The RMS data captures are triggered by two-cycle Hi-Z overcurrent conditions, loss of load 
conditions, and high arc confidence conditions. Captures triggered by loss of load and high arc confidence conditions 
are saved to a temporary capture table, and deleted if the event does not result in an Arcing or Downed Conductor 
condition. The relay maintains a history of four captures and utilizes a combination of age, priority and access for 
determining which capture to save.

The RMS data capture contains the two-cycle RMS values for the voltage and current for each of the phases and 
current for the neutral channel. The capture frequency is half the system frequency. Each capture contains 1800 
points.

• High-Z Data Capture — Hi-Z Data Captures are triggered and maintained in an identical manner as RMS Data 
Captures. The relay maintains four captures of 300 records each. The capture frequency is 1 Hz and the data collected 
is defined in the following two tables.

Table 5-44: Hi-Z specific data

 HI-Z VOLTAGE SUPV
DELAY: 60 cycles

Range: 0 to 300 cycles in steps of 2

 HI-Z EVEN HARMONIC
RESTRAINT: 20%

Range: 0 to 100% in steps of 1

 HI-Z TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 HI-Z EVENTS:
Disabled

Range: Disabled, Enabled

# Name Description

0 EadCounts Total number of EAD counts for the phase

1 ArcConfidence ArcConfidence for the phase

2 AccumArcConf Accumulated ArcConfidence for the phase

3 RmsCurrent The 2-cycle RMS current for the phase

4 HighROC Flag indicating a high rate of change was detected

5 IOC Flag indicating an instantaneous 2-cycle overcurrent was detected

6 LossOfLoad Flag indicating a loss of load was detected

7 EadZeroed Flag indicating that this phase’s EAD table was cleared

8 HighZArmed Flag indicating that this phase is armed for a high-Z detection
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Table 5-45: Hi-Z capture data

The algorithm is in “Normal” state when it detects no abnormal activity on the power system. While in the “Normal” state, 
any one of several power system events (a high output of the Expert Arc Detector, a significant loss of load, or a Hi-Z 
overcurrent) cause the algorithm to move to the “Coordination Timeout” state, where it remains for the time specified by 
the OC Protection Coord Timeout setting. Following this interval, the algorithm moves into its “Armed” state. The criteria for 
detecting arcing or a downed conductor are:

• The Expert Arc Detector Algorithm's output reaches a high level enough times, and

• Its high level was last reached when the algorithm's state was “Armed”

The “Arcing Sensitivity” setting determines what level constitutes a “high” output from the Expert Arc Detector Algorithm, 
and the number that constitutes what “enough times” means. If these criteria are met, the algorithm temporarily moves to 
either the “Arcing” state or the “Downed Conductor” state, the difference being determined by whether or not there was a 
significant, precipitous loss of load (as determined by the LOSS OF LOAD THRESHOLD setting) or a Hi-Z overcurrent (as 
determined by the PHASE OC MIN PICKUP and NEUTRAL OC MIN PICKUP settings). If either of these caused the algorithm to 
move from its “Normal” state to its “Coordination Timeout” state, then the algorithm moves to the “Downed Conductor” 
state temporarily. Otherwise, it temporarily moves to the “Arcing” state. After pulsing either of these outputs, the 
algorithm's state returns to “Normal”. Also, if two minutes pass without high levels from the Expert Arc Detector Algorithm 
while the algorithm is in its Armed state, then it moves from the “Armed” state directly back to the “Normal” state.

9 VoltageDip Flag indicating that a voltage dip was detected on this phase

10 HighEad Flag indicating that a high arc confidence occurred on this phase

11 ArcBurst Flag indicating that an arc burst was identified on this phase

12 VDisturbanceCc Cycle-to-cycle voltage disturbance

13 VDisturbanceAbs Absolute voltage disturbance

14 HarmonicRestraint Harmonic Restraint

# Name Description

1 StatusMask Bit-mask of the algorithm state (16 bits)
BIT_ARCING
BIT_DOWNED_COND
BIT_ARC_TREND
BIT_PHASE_A

BIT_PHASE_B
BIT_PHASE_C
BIT_PHASE_N
BIT_IOC_A

BIT_IOC_B
BIT_IOC_C
BIT_IOC_N
BIT_LOL_A

BIT_LOL_B
BIT_LOL_C
BIT_I_DISTURBANCE
BIT_V_DISTURBANCE

2 AlgorithmState Present value of the High-Z output state machine: Normal = 0, Coordination Timeout = 1, 
Armed = 2, Arcing = 5, Downed Conductor = 9

3 EadZeroedFlag Flag indicating the EAD table was cleared

4 SpectralFlag Flag indicating the Spectral algorithm has found a match

5 ThreePhaseFlag Flag indicating a three phase event was detected

6 PhaseInfo[4] Phase specific information for the three phase currents and the neutral (see table below)

# Name Description
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Two FlexLogic operands, HI-Z ARMED and HI-Z DISARMED, are created to represent the armed state of the Hi-Z element. The 
HI-Z ARMED operand is on when the algorithm is in the armed state, whereas the HI-Z DISARMED operand is on when the 
algorithm is not in the armed state. When the algorithm is armed, this also includes the arcing and downed conductor 
states. When the algorithm is disarmed, this also includes the normal and coordination timeout states (as defined by 
Modbus format F187 as described in the Modbus memory map in the UR Series Communications Guide).

The Hi-Z settings are as follows.

HI-Z SOURCE — Selects the source for the RMS currents and voltages used in Hi-Z algorithms. The source should include 
currents from the 8F/8G CT module and appropriate voltages. If the source does not include voltages, Voltage Supervision 
is disabled.

HI-Z ARCING SENSITIVITY — Establishes the belief-in-arcing confidence level at which the Hi-Z element recognizes arcing 
and the number of times the algorithm must conform its belief in arcing before it produces an output. The range is 1 to 10, 
where 10 is the most sensitive and 1 is the least sensitive setting.

A higher setting is suitable for a very quiet, well-behaved power system. An initial setting of 5 is suggested if the user has 
no previous experience with the Hi-Z element.

HI-Z ARCING DET SOE RESET TIME — An ARCING DETECTED event is created upon the detection of arcing by the expert arc 
detector algorithm. This setting defines the amount of time to hold creation of any new arcing detected events. Any 
subsequent arcing detection during this time restarts the hold timer. An ARCING DETECTED DPO event is generated upon 
the expiration of this reset time. The state of the expert arc detector algorithm is unaffected by this timer. The HI-Z ARC 
DETECTED DPO operand is set to “On” when the ARCING DETECTED DPO event is created, and remains on until an ARCING 
DETECTED event is created.

HI-Z PHASE EVENT COUNT — Specifies how many individual belief-in-arcing indications for a phase current must be counted 
in a specified time period before it is determined that an arcing-suspected event exists. These belief-in-arcing indications 
are detected by arc detection algorithms (energy and randomness) for a specific set of non-fundamental frequency 
component energies. This setting affects only the Hi-Z Arcing Suspected outputs.

HI-Z GROUND EVENT COUNT — Specifies how many individual belief-in-arcing indications for a ground/neutral current must 
be counted in a specified time period before it is determined that an arcing-suspected event exists. These belief-in-arcing 
indications are detected by arc detection algorithms (energy and randomness) for a specific set of non-fundamental 
frequency component energies. This setting affects only the Hi-Z Arcing Suspected outputs.

HI-Z EVENT COUNT TIME — Specifies the time (in minutes) over which the relay monitors long-term, sporadic, arcing events 
for determination of an arcing-suspected event. This setting affects only the Hi-Z Arcing Suspected outputs.

HI-Z OC PROTECTION COORD TIMEOUT — Coordinates between the Hi-Z element and conventional feeder overcurrent 
protection. A downed conductor or an arcing, intact conductor is not indicated before the expiration of this timeout, which 
begins when the Hi-Z element detects a trigger condition (such as loss of load, high rate of change, overcurrent, breaker 
open, or high belief-in-arcing confidence). Note that this is a minimum operating time; the actual operating time depends 
on the fault characteristics and is likely significantly longer than this setting.

Set the value such that the conventional feeder overcurrent protection is given an opportunity to operate before the 
timeout expires. It is recommended that this timeout value not exceed 30 seconds, because arcing fault current often 
diminishes as the fault progresses, making the fault more difficult to detect with increasing time. After the timeout has 
expired, at least one additional arc burst must occur in order for the Hi-Z element to proceed with its analysis.

HI-Z PHASE OC MIN PICKUP — Phase overcurrent minimum pickup indicates the level at which the Hi-Z element considers a 
phase current to be an overcurrent condition. The Hi-Z detection algorithms ignore all data as long as an overcurrent 
condition exists on the system, because it is assumed that conventional feeder overcurrent protection clears an 
overcurrent fault. It is recommended that this setting be above the maximum load current.

HI-Z NEUTRAL OC MIN PICKUP — Neutral overcurrent minimum pickup indicates the level at which the Hi-Z element 
considers a neutral current to be an overcurrent condition. The Hi-Z detection algorithms ignore all data as long as an 
overcurrent condition exists on the system, because it is assumed that conventional feeder overcurrent protection clears 
an overcurrent fault. It is recommended that this setting is above the maximum 3Io (residual) current due to unbalanced 
loading.
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HI-Z PHASE RATE OF CHANGE — Establishes a threshold for determining when a high rate-of-change event occurs on a 
phase RMS current. An extremely high rate of change is not characteristic of most high impedance faults; it is more 
indicative of a low impedance fault or of the inrush of breaker closing. The inrush current produces substantial variations in 
the harmonics used by the high impedance algorithms. Therefore these algorithms ignore all data for several seconds 
following a high rate-of-change event that exceeds this setting.

The RMS currents in the Hi-Z algorithms are calculated over a two-cycle time window. The rate-of-change is calculated as 
the difference between two consecutive two-cycle RMS readings. The recommended setting is 150 A per two-cycle 
interval. The setting is given in primary amperes.

HI-Z NEUTRAL RATE OF CHANGE — Establishes a threshold for determining when a high rate-of-change event occurs on a 
neutral RMS current. An extremely high rate of change is not characteristic of most high impedance faults; it is more 
indicative of a breaker closing, causing associated inrush. The inrush current produces substantial variations in the 
harmonics used by the high impedance algorithms. Therefore, these algorithms ignore all data for several seconds 
following a high rate-of-change event exceeding this setting.

The RMS currents in the Hi-Z algorithms are calculated over a two-cycle time window. The rate-of-change is calculated as 
the difference between two consecutive two-cycle RMS readings. The recommended setting is 150 A per two-cycle 
interval. The setting is given in primary amperes.

HI-Z LOSS OF LOAD THRESHOLD — Establishes the loss of load level used as an indication of a downed conductor. A Loss of 
Load flag is set if the Hi-Z algorithms detect a percentage drop in phase current between two successive two-cycle RMS 
values that equals or exceeds the Loss of Load Threshold. The amount the phase current must decrease between 
successive two-cycle RMS values is based on this setting times the recent average phase current level. The range is 5 to 
100%; 5% being the most sensitive.

HI-Z 3-PHASE EVENT THRESHOLD — Establishes the level at which the Hi-Z element characterizes a sudden three-phase 
current increase as a three-phase event. The Hi-Z detection algorithms ignore the data generated by a large three-phase 
event. The recommended setting is 25 A (primary).

HI-Z VOLTAGE SUPV THRESHOLD — In the event that a fault simultaneously occurs on two adjacent feeders (line voltage from 
the same bus), the drop in line voltage causes a subsequent drop in load current. This function blocks the Loss of Load flag 
from being set while the voltage is depressed. Thus, if the voltage level drops by a percentage greater than this threshold in 
successive two-cycle RMS samples, the Loss of Load flag is blocked. If the setting is “0”, the voltage supervision function is 
disabled.

HI-Z VOLTAGE SUPV DELAY — This setting adds time delay to the voltage supervision function. Specifically, the Loss of Load 
flag continues to be blocked for the number of cycles specified by this setting.

HI-Z EVEN HARMONIC RESTRAINT — This setting determines the level of the even harmonic at which the setting of the 
overcurrent flags is inhibited. The even harmonic content is evaluated on each phase current as a percentage of that 
phase's RMS current. The intent is to inhibit the setting of the overcurrent flags if the overcurrent is simply a surge caused 
by cold-load pickup or other inrush event.

IMPORTANT NOTE REGARDING INSTALLATION — The F60 Hi-Z algorithm is adaptive in nature. The algorithm’s 
internal thresholds gradually adapt to background “noise” on circuits with a moderate to high level of transient 
activity. For the first three to five days after installation (or after being out-of-service for a significant period), the 
F60 can identify some of this noise as arcing. Take this into account when responding to alarms during these 
operating periods.
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Figure 5-180: Hi-Z logic 

5.10.0.3  Breaker arcing current
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  BREAKER 1(4) ARCING CURRENT

 BREAKER 1
 ARCING CURRENT  BKR 1 ARC AMP

FUNCTION: Disabled
Range: Disabled, Enabled

 BKR 1 ARC AMP
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4
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There is one breaker arcing current element available per CT bank, with a minimum of two elements. This element 
calculates an estimate of the per-phase wear on the breaker contacts by measuring and integrating the current squared 
passing through the breaker contacts as an arc. These per-phase values are added to accumulated totals for each phase 
and compared to a programmed threshold value. When the threshold is exceeded in any phase, the relay can set an 
output operand to “1.” The accumulated value for each phase can be displayed as an actual value.

The operation of the scheme is shown in the following logic diagram. The same output operand that is selected to operate 
the output relay used to trip the breaker, indicating a tripping sequence has begun, is used to initiate this feature. A time 
delay is introduced between initiation and the starting of integration to prevent integration of current flow through the 
breaker before the contacts have parted. This interval includes the operating time of the output relay, any other auxiliary 
relays, and the breaker mechanism. For maximum measurement accuracy, measure the interval between change-of-state 
of the operand (from 0 to 1) and contact separation for the specific installation. Integration of the measured current 
continues for 100 ms, which is expected to include the total arcing period.

The feature is programmed to perform fault duration calculations. Fault duration is defined as a time between operation of 
the disturbance detector occurring before initiation of this feature, and reset of an internal low-set overcurrent function. 
Correction is implemented to account for a non-zero reset time of the overcurrent function.

Breaker arcing currents and fault duration values are available under the ACTUAL VALUES  RECORDS  MAINTENANCE  
BREAKER 1(4) menus.

BKR 1 ARC AMP INT-A(C) — Select the same output operands that are configured to operate the output relays used to trip the 
breaker. In three-pole tripping applications, configure the same operand to initiate arcing current calculations for poles A, 
B, and C of the breaker. In single-pole tripping applications, configure per-pole tripping operands to initiate the calculations 
for the poles that are actually tripped.

BKR 1 ARC AMP DELAY — This setting is used to program the delay interval between the time the tripping sequence is 
initiated and the time the breaker contacts are expected to part, starting the integration of the measured current.

BKR 1 ARC AMP LIMIT — Selects the threshold value above which the output operand is set.

BKR 1 CLR ARC AMPS — Selects a FLexLogic Operand to clear the accumulated I2t values (kA2-cycle), reset fault duration 
items (breaker operating time), clear ARCING AMPS (kA2-cycle) and AMP MAX (kA) values of the last event.

BKR 1 INTERUPTION RATING — This setting specifies the maximum symmetrical interruption rating of the circuit breaker.

 BKR 1 ARC AMP INT-A:
Off

Range: FlexLogic operand



 BKR 1 ARC AMP INT-C:
Off

Range: FlexLogic operand

 BKR 1 ARC AMP
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BKR 1 ARC AMP LIMIT:
1000 kA2-cyc

Range: 0 to 50000 kA2-cycle in steps of 1

 BKR 1 INTERRUPTION
RATING: 31.5 kA

Range: 0.0 to 100.0 kA in steps of 0.1

 BKR 1 CLR ARC AMPS:
Off

Range: FlexLogic operand

 BKR 1 ARC AMP BLOCK:
Off

Range: FlexLogic operand

 BKR 1 ARC AMP
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 BKR 1 ARC AMP
EVENTS: Disabled

Range: Disabled, Enabled
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Figure 5-181: Arcing current measurement 
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Figure 5-182: Breaker arcing current logic 
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5.10.0.4  Breaker flashover
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  BREAKER FLASHOVER 1(2)

The detection of the breaker flashover is based on the following conditions:

• Breaker open,

• Voltage difference drop, and

• Measured flashover current through the breaker

Furthermore, the scheme is applicable for cases where either one or two sets of three-phase voltages are available across 
the breaker.

Three VT breaker flashover application
When only one set of VTs is available across the breaker, set the BRK 1 FLSHOVR SIDE 2 SRC setting to “None.” To detect an 
open breaker condition in this application, the scheme checks if the per-phase voltages were recovered (picked up), the 
status of the breaker is open (contact input indicating the breaker status is off), and no flashover current is flowing. A 
contact showing the breaker status must be provided to the relay. The voltage difference is not considered as a condition 
for open breaker in this part of the logic.

 BREAKER
 FLASHOVER 1  BRK 1 FLSHOVR

FUNCTION: Disabled
Range: Disabled, Enabled

 BRK 1 FLSHOVR SIDE 1
SRC: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 BRK 1 FLSHOVR SIDE 2
SRC: None

Range: None, SRC 1, SRC 2, SRC 3, SRC 4

 BRK 1 STATUS CLSD A:
Off

Range: FlexLogic operand



 BRK 1 STATUS CLSD C:
Off

Range: FlexLogic operand

 BRK 1 FLSHOVR V PKP:
0.850 pu

Range: 0.004 to 1.500 pu in steps of 0.001

 BRK 1 FLSHOVR DIFF V
PKP: 1000 V

Range: 0 to 100000 V in steps of 1

 BRK 1 FLSHOVR AMP
PKP: 0.600 pu

Range: 0.020 to 1.500 pu in steps of 0.001

 BRK 1 FLSHOVR PKP
DELAY: 0.100 s

Range: 0.000 to 65.535 s in steps of 0.001

 BRK 1 FLSHOVR SPV A:
Off

Range: FlexLogic operand



 BRK 1 FLSHOVR SPV C:
Off

Range: FlexLogic operand

 BRK 1 FLSHOVR BLOCK:
Off

Range: FlexLogic operand

 BRK 1 FLSHOVR
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 BRK 1 FLSHOVR
EVENTS: Disabled

Range: Disabled, Enabled
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The flashover detection resets if the current drops back to zero, the breaker closes, or the selected FlexLogic operand for 
supervision changes to high. Using supervision through the BRK 1 FLSHOVR SPV A, BRK 1 FLSHOVR SPV B, and BRK 1 FLSHOVR 
SPV c settings is recommended by selecting a trip operand that does not allow the flashover element to pickup prior to the 
trip.

The flashover detection can be used for external alarm, re-tripping the breaker, or energizing the lockout relay.

Consider the following configuration: 

The source 1 (SRC1) phase currents are feeder CTs and phase voltages are bus VTs, and Contact Input 1 is set as Breaker 
52a contact. The conditions prior to flashover detection are:

• 52a status = 0

• VAg, VBg, or VCg is greater than the pickup setting

• IA, IB, IC = 0; no current flows through the breaker

• VA is greater than pickup (not applicable in this scheme)

The conditions at flashover detection are:

• 52a status = 0

• IA, IB, or IC is greater than the pickup current flowing through the breaker

• VA is greater than pickup (not applicable in this scheme)

Six VT breaker flashover application
The per-phase voltage difference approaches zero when the breaker is closed. This is well below any typical minimum 
pickup voltage. Select the level of the BRK 1 FLSHOVR DIFF V PKP setting to be less than the voltage difference measured 
across the breaker when the close or open breaker resistors are left in service. Prior to flashover, the voltage difference is 
larger than BRK 1 FLSHOVR DIFF V PKP. This applies to either the difference between two live voltages per phase or when the 
voltage from one side of the breaker has dropped to zero (line de-energized), at least one per-phase voltage is larger than 
the BRK 1 FLSHOVR V PKP setting, and no current flows through the breaker poles. During breaker flashover, the per-phase 
voltages from both sides of the breaker drops below the pickup value defined by the BRK 1 FLSHOVR V PKP setting, the 
voltage difference drops below the pickup setting, and flashover current is detected. These flashover conditions initiate 
FlexLogic pickup operands and start the BRK 1 FLSHOVR PKP DELAY timer.

This application does not require detection of breaker status via a 52a contact, as it uses a voltage difference larger than 
the BRK 1 FLSHOVR DIFF V PKP setting. However, monitoring the breaker contact ensures scheme stability.

Voltages must be present prior to flashover conditions. If the three VTs are placed after the breaker on the line (or 
feeder), and the downstream breaker is open, the measured voltage is zero and the flashover element is not 
initiated.
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Consider the following configuration: 

The source 1 (SRC1) phase currents are CTs and phase voltages are bus VTs. The source 2 (SRC2) phase voltages are line 
VTs. Contact input 1 is set as the breaker 52a contact (optional).

The conditions prior to flashover detection are:

• VA is greater than pickup

• IA, IB, IC = 0; no current flows through the breaker

• 52a status = 0 (optional)

The conditions at flashover detection are:

• VA is less than pickup

• VAg, VBg, or VCg is lower than the pickup setting

• IA, IB, or IC is greater than the pickup current flowing through the breaker

• 52a status = 0 (optional)

Settings
BRK 1 FLSHOVR SIDE 1 SRC — This setting specifies a signal source used to provide three-phase voltages and three-phase 
currents from one side of the current breaker. The source selected as a setting and must be configured with breaker phase 
voltages and currents, even if only three VTs are available across the breaker.

BRK 1 FLSHOVR SIDE 2 SRC — This setting specifies a signal source used to provide another set of three phase voltages 
whenever six VTs are available across the breaker.

BRK 1 STATUS CLSD A to BRK 1 STATUS CLSD C — These settings specify FlexLogic operands to indicate the open status of the 
breaker. A separate FlexLogic operand can be selected to detect individual breaker pole status and provide flashover 
detection. The recommended setting is 52a breaker contact or another operand defining the breaker poles open status.

BRK 1 FLSHOVR V PKP — This setting specifies a pickup level for the phase voltages from both sides of the breaker. If six VTs 
are available, opening the breaker leads to two possible combinations – live voltages from only one side of the breaker, or 
live voltages from both sides of the breaker. Either case sets the scheme for flashover detection upon detection of voltage 
above the selected value. Set BRK FLSHOVR V PKP to 85 to 90% of the nominal voltage.

BRK 1 FLSHOVR DIFF V PKP — This setting specifies a pickup level for the phase voltage difference when two VTs per phase 
are available across the breaker. The pickup voltage difference should be below the monitored voltage difference when 
close or open breaker resistors are left in service. The setting is selected as primary volts difference between the sources.

BRK 1 FLSHOVR AMP PKP — This setting specifies the normal load current which can flow through the breaker. Depending on 
the flashover protection application, the flashover current can vary from levels of the charging current when the line is de-
energized (all line breakers open), to well above the maximum line (feeder) load (line/feeder connected to load).

The element operates only when phase-to-ground voltages are connected to relay terminals. The flashover 
element does not operate if delta voltages are applied.
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BRK 1 FLSHOVR SPV A to BRK 1 FLSHOVR SPV C — These settings specify FlexLogic operands (per breaker pole) that supervise 
the operation of the element per phase. Supervision can be provided by operation of other protection elements, breaker 
failure, and close and trip commands. A six-cycle time delay applies after the selected FlexLogic operand resets.

BRK FLSHOVR PKP DELAY — This setting specifies the time delay to operate after a pickup condition is detected.
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Figure 5-183: Breaker flashover logic 
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5.10.0.5  Breaker restrike
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  BREAKER RESTRIKE 1(3)

One breaker restrike element is provided for each DSP in the F60.

According to IEEE standard C37.100 entitled IEEE Standard Definitions for Power Switchgear, restrike is defined as “a 
resumption of current between the contacts of a switching device during an opening operation after an interval of zero 
current of ¼ cycle at normal frequency or longer.”

Figure 5-184: Typical restrike waveform and detection flag 

The breaker restrike algorithm responds to a successful interruption of the phase current following a declaration of 
capacitor bank offline as per the breaker pole indication. If a high-frequency or system frequency current with a 
magnitude greater than the threshold is resumed at least ¼ of a cycle later than the phase current interruption, then a 

 BREAKER RESTRIKE 1
  BREAKER RESTRIKE 1

FUNCTION: Disabled
Range: Disabled, Enabled

 BRK RESTRIKE 1
BLOCK: Off

Range: FlexLogic operand

 BREAKER RESTRIKE 1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 BREAKER RESTRIKE 1
PICKUP: 0.500 pu

Range: 0.10 to 2.00 pu in steps of 0.01

 BREAKER RESTRIKE 1
RST DELAY: 0.100 s

Range: 0.000 to 65.535 s in steps of 0.001

 BREAKER RESTRIKE 1
HF DETECT: Enabled

Range: Disabled, Enabled

 BRK RSTR 1 BRK OPEN:
Off

Range: FlexLogic operand

 BRK RSTR 1 OPEN CMD:
Off

Range: FlexLogic operand

 BRK RSTR 1 CLS CMD:
Off

Range: FlexLogic operand

 BREAKER RESTRIKE 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 BREAKER RESTRIKE 1
EVENTS: Disabled

Range: Disabled, Enabled
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breaker restrike condition is declared in the corresponding phase and the BRK RESTRIKE 1 OP operand asserts for a short 
period of time. The user can add counters and other logic to facilitate the decision making process as to the appropriate 
actions upon detecting a single restrike or a series of consecutive restrikes.

A restrike event (FlexLogic operand) is declared if all of the following hold:

• The current is initially interrupted

• The breaker status is open

• An elevated high frequency current condition occurs (if the BREAKER RESTRIKE 1 HF DETECT setting is Enabled, otherwise 
the condition is bypassed), and 

• The current subsequently drops out again

The algorithm is illustrated in the following state machine diagram.

Figure 5-185: Algorithm illustration of state machine to detect restrike 

In this way, a distinction is made between a self-extinguishing restrike and permanent breaker failure condition. The latter 
can be detected by the breaker failure function or a regular instantaneous overcurrent element. Also, a fast succession of 
restrikes is picked up by breaker failure or instantaneous overcurrent protection.

The following settings are available for each element.

BREAKER RESTRIKE 1 FUNCTION — Enables and disables operation of the breaker restrike detection element.

BRK RESTRIKE 1 BLOCK — Blocks operation of the breaker restrike detection element.

BREAKER RESTRIKE 1 SOURCE — Selects the source of the current for this element. This source must have a valid CT bank 
assigned.

BREAKER RESTRIKE 1 PICKUP — Specifies the pickup level of the overcurrent detector in per-unit values of CT nominal 
current.

BREAKER RESTRIKE 1 RST DELAY — Specifies the reset delay for this element. When set to “0 ms,” then FlexLogic operand is 
picked up for only 1/8th of the power cycle.
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BREAKER RESTRIKE 1 HF DETECT — Enables/disables high-frequency (HF) pattern detection when breaker restrike occurs. 
High-frequency pattern is typical for capacitor bank, cables, and long transmission lines applications.

BRK RSTR 1 BRK OPEN — Assigns a FlexLogic operand indicating the open position of the breaker. It must be logic “1” when 
the breaker is open. It is important to assign either 52 contact with this setting or breaker close command with BRK RSTR 1 
CLS CMD setting to give clear indication to the relay about breaker status.

BRK RSTR 1 OPEN CMD — Assigns a FlexLogic operand indicating a breaker open command. It must be logic “1” when the 
breaker is opened, either manually or from protection logic.

BRK RSTR 1 CLS CMD — Assigns a FlexLogic operand indicating a breaker close command. It must be logic “1” when the 
breaker is closed.

Figure 5-186: Breaker restrike logic 

5.10.0.6  CT failure detector
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  CT FAILURE DETECTOR 1(4)

 CT FAILURE
 DETECTOR 1  CT FAIL 1 FUNCTION:

Disabled
Range: Disabled, Enabled

 CT FAIL 1 BLOCK:
Off

Range: FlexLogic operand

 CT FAIL 1 3I0 INP 1:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 CT FAIL 1 3I0 INP 1
PKP: 0.2 pu

Range: 0.1 to 2.0 pu in steps of 0.1

 CT FAIL 1 3I0 INP 2:
SRC 2

Range: SRC 1, SRC 2, SRC 3, SRC 4

 CT FAIL 1 3I0 INP 2
PKP: 0.2 pu

Range: 0.1 to 2.0 pu in steps of 0.1

 CT FAIL 1 3V0 INPUT:
SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 CT FAIL 1 3V0 INPUT
PKP: 0.20 pu

Range: 0.04 to 2.00 pu in steps of 0.01

 CT FAIL 1 PICKUP
DELAY: 1.000 s

Range: 0.000 to 65.535 s in steps of 0.001
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The CT failure function detects problems with system current transformers used to supply current to the relay. This logic 
detects the presence of a zero-sequence current at the supervised source of current without a simultaneous zero-
sequence current at another source, zero-sequence voltage, or some protection element condition.

The CT failure logic (see later) is based on the presence of the zero-sequence current in the supervised CT source and the 
absence of one of three or all of the three following conditions:

• Zero-sequence current at different source current (can be different set of CTs or different CT core of the same CT)

• Zero-sequence voltage at the assigned source

• Appropriate protection element or remote signal

Settings are described as follows.

CT FAIL 1 FUNCTION — Enables or disables operation of the CT failure element.

CT FAIL 1 BLOCK — Selects a FlexLogic operand to block operation of the element during some condition (for example, an 
open pole in process of the single pole tripping-reclosing). Local signals or remote signals representing operation of some 
remote current protection elements via communication channels can also be chosen.

CT FAIL 1 3I0 INPUT 1 — Selects the current source for input 1. The most critical protection element should also be assigned 
to the same source.

CT FAIL 1 3I0 INPUT 1 PICKUP — Selects the 3I_0 pickup value for input 1 (the main supervised CT source).

CT FAIL 1 3I0 INPUT 2 — Selects the current source for input 2. Input 2 should use a different set of CTs or a different CT core 
of the same CT. If 3I_0 does not exist at source 2, then a CT failure is declared.

CT FAIL 1 3I0 INPUT 2 PICKUP — Selects the 3I_0 pickup value for input 2 (different CT input) of the relay.

CT FAIL 1 3V0 INPUT — Selects the voltage source.

CT FAIL 1 3V0 INPUT PICKUP — Specifies the pickup value for the 3V_0 source.

CT FAIL 1 PICKUP DELAY — Specifies the pickup delay of the CT failure element.

 CT FAIL 1 TARGET:
Self-reset

Range: Self-reset, Latched, Disabled

 CT FAIL 1 EVENTS:
Disabled

Range: Disabled, Enabled
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Figure 5-187: CT failure detector logic 

5.10.0.7  Incipient fault detector
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  INCIPIENT FAULT 1(2)

There are two incipient cable fault detection elements in the relay.

 INCIPIENT FAULT 1
  INCIPIENT FAULT 1

FUNCTION: Disabled
Range: Disabled, Enabled

 INCIPNT FLT 1 BLOCK:
Off

Range: FlexLogic operand

 INCIPIENT FAULT 1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 INCIPIENT FAULT 1
PICKUP: 0.50 pu

Range: 0.10 to 10.00 pu in steps of 0.01

 INCIPNT FLT 1 MODE:
Number of counts

Range: Number of counts, Counts per window

 INCIPIENT FLT 1 TRIP
COUNTS NUMBER: 2

Range: 1 to 10 in steps of 1

 INCIPNT FLT 1 DETECT
WINDOW: 10.00 s

Range: 0.00 to 1000.00 s in steps of 0.01

 INCIPIENT FAULT 1
RESET DELAY: 0.100 s

Range: 0.000 to 65.535 s in steps of 0.001

 INCIPIENT FAULT 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 INCIPIENT FAULT 1
EVENTS: Disabled

Range: Disabled, Enabled
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Before a permanent cable fault occurs, there are usually signs of degrading insulation manifesting itself as a short, mostly 
half-cycle spikes asserting at the phase voltage peak. Due to shortness of such spikes, they are not usually detected by the 
instantaneous protection of the feeder, which operates on the RMS or fundamental component of the phase current with a 
relatively high pickup.

The number of detected incipient faults in each phase is counted and available in the ACTUAL VALUES  STATUS  
INCIPIENT FAULT menus. The counters can be reset with the COMMANDS  CLEAR RECORDS  CLEAR INCIPENT FAULT 
COUNTERS command.

The figure illustrates a recorded field case of an incipient phase B fault. The top portion of the figure shows the raw A, B, 
and C currents. The bottom portion shows the neutral current (blue) and reveals the fault period from under the load and 
the superimposed phase B current (red). The superimposed current shows two fault current blips as the data slides through 
the two-cycle memory window. During the actual fault, the neutral current and the superimposed phase B currents closely 
correspond, confirming the incipient fault hypothesis and identifying the affected phase.

Figure 5-188: Illustration of the incipient fault detector algorithm 

The following settings are available for each incipient cable fault detector.

INCIPIENT FAULT 1 FUNCTION — This setting enables and disables operation of the incipient fault detection element.

INCIPNT FLT 1 BLOCK — Blocks operation of the incipient cable fault detector element. Assertion of the FlexLogic operand 
assigned to this setting blocks operation.

INCIPIENT FAULT 1 SOURCE — Selects a current source for the incipient cable fault detector element. This source must be 
assigned a valid CT bank.

INCIPIENT FAULT 1 PICKUP — Specifies the pickup level of the overcurrent detector in per-unit values of the CT nominal 
current.

Changes to any of the incipient cable fault detector settings resets of the number of the incipient faults detected to 
zero.

To provide a clear timing indication when the incipient fault occurred, the incipient fault event is time-stamped with 
the time the fault actually occurred. However, the FlexLogic operand is asserted four cycles later, when the incipient 
fault pattern is confirmed and therefore detected.
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INCIPNT FLT 1 MODE — There are two modes of operation available for the incipient cable fault detector element. In the 
“Number of counts” mode, a trip is initiated only after the selected number of faults is detected. In the “Counts per window” 
mode, a trip is initiated only after the selected number of faults is detected within the time specified by the INCIPNT FLT 1 
DETECT WINDOW setting.

INCIPIENT FLT 1 TRIP COUNTS NUMBER — Selects the number of faults required to initiate a trip.

INCIPNT FLT 1 DETECT WINDOW — Specifies a time window for “Counts per window” mode of operation.

INCIPIENT FAULT 1 RESET DELAY — Specifies a reset time for the output after the trip is initiated.

Figure 5-189: Incipient cable fault detector logic 

5.10.0.8  VT fuse failure
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  VT FUSE FAILURE 1(4)

Every signal source includes a fuse failure scheme.

The VT fuse failure detector is used to raise an alarm and/or block elements that operate incorrectly for a full or partial loss 
of AC potential caused by one or more blown fuses. Some elements that can be blocked (via the BLOCK input) are distance, 
voltage restrained overcurrent, and directional current.

There are two classes of fuse failure that occur:

• Class A — Loss of one or two phases

• Class B — Loss of all three phases

Different means of detection are required for each class. An indication of class A failures is a significant level of negative-
sequence voltage, whereas an indication of class B failures is when positive sequence current is present and there is an 
insignificant amount of positive sequence voltage. Also, a rapid decrease in the phase voltages magnitude from a healthy 

 VT FUSE FAILURE 1
  VT FUSE FAILURE 1

FUNCTION: Disabled
Range: Disabled, Enabled

 VT FUSE FAILURE 1
ALARM DELAY: 1.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 NEUTRAL WIRE OPEN 1
DETECTION: Disabled

Range: Disabled, Enabled

 NEUTRAL WIRE OPEN 1
3 HARM PKP: 0.100 pu

Range: 0.004 to 3.000 pu in steps of 0.001

Detection logic

SETTING

= Enabled

= Disabled

INCIPIENT FAULT 1 FUNCTION

SETTING

= OFF

INCIPIENT FAULT 1 BLOCK

SETTING

= IA

= IB

INCIPIENT FAULT 1 SOURCE

= IC

= IN

AND

SETTING

INCIPIENT FAULT 1
PICKUP

RUN

– > PICKUP

where is 2 cycles old

Imag ´I

I

mag

mag´

SETTINGS

INCIPNT FLT 1 DETECT
WINDOW

RUN

INCIPIENT FLT 1 TRIP
COUNTS NUMBER

INCIPNT FLT 1 MODE

TWINDOW

SETTINGS

INCIPIENT FAULT 1
RESET DELAY

0

TRST

0

TRST

0

TRST

FLEXLOGIC OPERANDS

INCIPNT FLT 1 OP A
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FLEXLOGIC OPERANDS
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ACTUAL VALUES
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COMMAND
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COUNTERS
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voltage level without disturbance in current can indicate VT fuse fail conditions. These noted indications of fuse failure can 
also be present when faults are present on the system, so a means of detecting faults and inhibiting fuse failure 
declarations during these events is provided.

Once the fuse failure condition is declared, it is sealed-in until the cause that generated it disappears.

An additional condition is introduced to inhibit a fuse failure declaration when the monitored circuit is de-energized; 
positive-sequence voltage and current are both below threshold levels.

VT FUSE FAILURE 1 FUNCTION — Enables and disables the fuse failure feature for Source 1 VT Fuse Fail.

NEUTRAL WIRE OPEN 1 DETECTION — Enables and disables the VT neutral wire open detection function. When the VT is 
connected in Delta, do not enable this function because there is no neutral wire for Delta connected VT.

NEUTRAL WIRE OPEN 1 3 HRAM PKP — Specifies the pickup level of 3rd harmonic of 3V0 signal for the NEUTRAL WIRE OPEN 
DETECTION logic to pick up.

Base voltage for this element is PHASE VT SECONDARY setting in the case of WYE VTs and (PHASE VT SECONDARY)/  in case 
of DELTA VTs. The setting is found under SETTINGS  SYSTEM SETUP  AC INPUTS  VOLTAGE BANK  PHASE VT SECONDARY.

Figure 5-190: VT fuse fail logic 
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5.10.0.9  Thermal overload protection (ANSI 49)
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  THERMAL OVERLOAD PROTECTION  
THERMAL PROTECTION 1(2)

The thermal overload protection element corresponds to the IEC 255-8 standard and is used to detect thermal overload 
conditions in protected power system elements. Choosing an appropriate time constant element can be used to protect 
different elements of the power system. The cold curve characteristic is applied when the estimated Ip current is less than 
10% of the base current. If Ip current is greater or equal than 10% than the base current, then the hot curve characteristic 
is applied. Ip current is estimated with a fixed time constant for both cooling and heating that reaches to the final value in 
two seconds on a step change (either step up or step down) signal.

The IEC255-8 cold curve is defined as follows:

Eq. 5-32

The IEC255-8 hot curve is defined as follows:

Eq. 5-33

where

top = time to operate
τop = thermal protection trip time constant
I = measured overload RMS current
Ip = measured load RMS current before overload occurs
k = IEC 255-8 k-factor applied to IB, defining maximum permissible current above nominal current
IB = protected element base (nominal) current

To ensure element accuracy for high overcurrent conditions, the maximum value of I/(k x IB) is limited to 8, even when 
realistically it is exceeding this value.

 THERMAL
 PROTECTION 1  THERMAL PROTECTION 1

FUNCTION: Disabled
Range: Disabled, Enabled

 THERMAL PROTECTION 1
SOURCE: SRC1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 THERMAL PROTECTION 1
BASE CURR: 0.80 pu

Range: 0.20 to 3.00 pu in steps of 0.01

 THERMAL PROTECTION 1
k FACTOR: 1.10

Range: 1.00 to 1.20 in steps of 0.05

 THERM PROT 1 TRIP
TIME CONST: 45 min

Range: 0 to 1000 min. in steps of 1

 THERM PROT 1 RESET
TIME CONST: 45 min

Range: 0 to 1000 min. in steps of 1

 THERM PROT 1 MINIM
RESET TIME: 20 min

Range: 0 to 1000 min. in steps of 1

 THERM PROT 1 RESET:
Off

Range: FlexLogic operand

 THERM PROT 1 BLOCK:
Off

Range: FlexLogic operand

 THERMAL PROTECTION 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 THERMAL PROTECTION 1
EVENTS: Disabled

Range: Disabled, Enabled

top op
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The reset time of the thermal overload protection element is also time delayed using following formula:

Eq. 5-34

where

τrst = thermal protection trip time constant
Tmin = a minimum reset time setting

Figure 5-191: IEC 255-8 sample operate and reset curves 

The thermal overload protection element estimates accumulated thermal energy E using the following equations 
calculated each power cycle. When current is greater than the pickup level, In > k × IB, element starts increasing the 
thermal energy:

Eq. 5-35

trst rst
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When current is less than the dropout level, In > 0.97 × k × IB, the element starts decreasing the thermal energy:

Eq. 5-36

where

∆t is the power cycle duration
n is the power cycle index
top(In) is the trip time calculated at index n as per the IEC255-8 cold curve or hot curve equations
trst(In) is the reset time calculated at index n as per the reset time equation
In is the measured overload RMS current at index n
En is the accumulated energy at index n
En – 1 is the accumulated energy at index n – 1

The thermal overload protection element removes the THERMAL PROT 1 OP output operand when E < 0.05. In case of 
emergency, the thermal memory and THERMAL PROT 1 OP output operand can be reset using THERM PROT 1 RESET setting. All 
calculations are performed per phase. If the accumulated energy reaches value 1 in any phase, the thermal overload 
protection element operates and only resets when energy is less than 0.05 in all three phases.

Table 5-46: Typical time constants

The figure shows the logic for the thermal overload protection element.

Figure 5-192: Thermal overload protection logic 

Protected equipment Time constant Minimum reset time

Capacitor bank 10 minutes 30 minutes

Overhead line 10 minutes 20 minutes

Air-core reactor 40 minutes 30 minutes

Busbar 60 minutes 20 minutes

Underground cable 20 to 60 minutes 60 minutes

En En 1–
t

trst In
--------------–=
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5.10.0.10  Broken conductor detection
SETTINGS  CONTROL ELEMENTS  MONITORING ELEMENTS  BROKEN CONDUCTOR 1(2)

The broken conductor function detects a transmission line broken conductor condition or a single-pole breaker 
malfunction condition by checking the phase current input signals and the I_2 / I_1 ratio. The intent is to detect a single-
phase broken conductor only. As such, two-phase or three-phase broken conductors cannot be detected.

To distinguish between single-phase disappearance and system disturbance in all three phases (such as load change and 
switching), the broken conductor element monitors the change in all three phase currents at the present instance and at 
four cycles previous. It also monitors changes in the I_2 / I_1 ratio, I_1 minimum, and I_1 maximum.

Do not use the broken conductor function to respond to fault transients and single-pole tripping/reclosing conditions. 
Therefore, program the time delay to a sufficient length to ensure coordination with the breaker dead time of the recloser 
function.

BROKEN CONDUCTOR 1 FUNCTION — This setting enables and disables the broken conductor function.

BROKEN CONDUCTOR 1 SOURCE — Selects a signal source used to provide three-phase current inputs to this function.

BROKEN CONDUCTOR 1 I2/I1 RATIO — This setting specifies the ratio of negative-sequence current to positive-sequence 
current. When one phase conductor is broken, the I_2 / I_1 ratio with a balanced remaining two phases is 50%. So 
normally you this setting below 50% (for example, to 30%).

BROKEN CONDUCTOR 1 I1 MIN — This setting specifies the minimum positive-sequence current supervision level. Ensure this 
setting is programmed to a sufficient level to prevent I_2 / I_1 from erratic pickup due to a low I_1 signal. However, do not 
set this setting too high, since the broken conductor condition cannot be detected under light load conditions when I_1 is 
less than the value specified by this setting.

BROKEN CONDUCTOR 1 I1 MAX — This setting specifies the maximum I_1 level allowed for the broken conductor function to 
operate. When I_1 exceeds this setting, this it is considered a fault. In order for this function to not respond to any fault 
conditions, set this setting to less than the maximum load current.

BROKEN CONDUCTOR 1 PKP DELAY — This setting specifies the pickup time delay for this function to operate after assertion 
of the broken conductor pickup FlexLogic operand.

 BROKEN CONDUCTOR 1
  BROKEN CONDUCTOR 1

FUNCTION: Disabled
Range: Disabled, Enabled

 BROKEN CONDUCTOR 1
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 BROKEN CONDUCTOR 1
I2/I1 RATIO: 20%

Range: 20.0% to 100.0% in steps of 0.1%

 BROKEN CONDUCTOR 1
I1 MIN: 0.10 pu

Range: 0.05 to 1.00 pu in steps of 0.01

 BROKEN CONDUCTOR 1
I1 MAX: 1.50 pu

Range: 0.05 to 5.00 pu in steps of 0.01

 BROKEN CONDUCTOR 1
PKP DELAY: 20.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 BROKEN CONDCT 1 BLK:
Off

Range: FlexLogic operand

 BROKEN CONDUCTOR 1
TARGET: Self-reset

Range: Self-reset, Latched, Disabled

 BROKEN CONDUCTOR 1
EVENTS: Disabled

Range: Disabled, Enabled
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Figure 5-193: Broken conductor detection logic 
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5.10.1  Cold load pickup
SETTINGS  CONTROL ELEMENTS  COLD LOAD PICKUP  COLD LOAD PICKUP 1(2)

Cold load is the restoration of current into the system after being off. A cold load condition can be caused by a prolonged 
outage of the load, by opening of the circuit breaker, or by a loss of supply even if the breaker remains closed. Upon the 
return of the source, the circuit experiences inrush current into connected transformers, accelerating currents into motors, 
and simultaneous demand from many other loads because the normal load diversity has been lost.

This feature can be used to change protection element settings when (by changing to another settings group) a cold load 
condition is expected to occur. During the cold load condition, the current level can be above the pickup setting of some 
protection elements, so this feature can be used to prevent the tripping that is otherwise caused by the normal settings.

Without historical data on a particular feeder, some utilities assume an initial cold load current of about 500% of normal 
load, decaying to 300% after 1 second, 200% after 2 seconds, and 150% after 3 seconds.

Figure 5-194: Typical cold load pickup characteristics 

There are two methods to initiate operation of this feature.

The first initiation method is automatic response to a loss of the source to the feeder, by detecting that all phase currents 
have declined to zero for some time. When zero current on all phases has been detected, a timer starts. This timer is set to 
an interval after which it is expected the normal load diversity has been lost, so setting groups are not changed for short 
duration outages. After the delay interval, the output operand is set.

The second initiation method is automatic response to an event that sets an operand, such as an operator-initiated virtual 
input. This second method of initiation sets the output operand immediately.

Both initiating inputs can be inhibited by a blocking input. Once cold load pickup is in operation, the output operand 
remains set until at least one phase of the load has returned to a level above 2% of CT nominal for the interval 
programmed by the ON-LOAD TIME BEFORE RESET setting has expired. The reset delay interval is intended to be set to a 
period until the feeder load has decayed to normal levels, after which other features can be used to switch setting groups.

 COLD LOAD PICKUP 1
  COLD LOAD 1

FUNCTION: Disabled
Range: Disabled, Enabled

 COLD LOAD 1 PICKUP
SOURCE: SRC 1

Range: SRC 1, SRC 2, SRC 3, SRC 4

 COLD LOAD 1 INIT:
Off

Range: FlexLogic operand

 COLD LOAD 1 BLK:
Off

Range: FlexLogic operand

 OUTAGE TIME BEFORE
COLD LOAD1: 1000 s

Range: 0 to 1000 s in steps of 1

 ON-LOAD TIME BEFORE
RESET1: 100.000

Range: 0.000 to 1000 000.000 s in steps of 0.001
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Figure 5-195: Cold load pickup logic 

5.10.2  Pilot schemes
SETTINGS  CONTROL ELEMENTS  PILOT SCHEMES

5.10.2.1  Permissive over-reaching transfer trip (POTT3)
SETTINGS  CONTROL ELEMENTS  PILOT SCHEMES  POTT3 SCHEME

 PILOT SCHEMES
   POTT3 SCHEME

 
See below

  DCB3 SCHEME
 

See page 5-358

 POTT3 SCHEME
  POTT3 SCHEME

FUNCTION: Disabled
Range: Disabled, Enabled

 POTT3 SCHEME BLOCK:
Off

Range: FlexLogic operand

 POTT3 PERMISSIVE
ECHO: Disabled

Range: Disabled, Enabled

 POTT3 RX PICKUP
DELAY: 0.000 s

Range: 0.000 to 65.535 s in steps of 0.001

 TRANS BLOCK PICKUP
DELAY: 0.020 s

Range: 0.000 to 65.535 s in steps of 0.001

 TRANS BLOCK RESET
DELAY: 0.090 s

Range: 0.000 to 65.535 s in steps of 0.001

 ECHO DURATION:
0.100 s

Range: 0.000 to 65.535 s in steps of 0.001

 ECHO LOCKOUT:
0.250 s

Range: 0.000 to 65.535 s in steps of 0.001
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This scheme is for two-terminal line applications only. It uses over-reaching directional protection elements (such as 
directional overcurrent functions) to essentially compare the direction to a fault at both the ends of the line. The Line End 
Open input field needs to be properly set to indicate line-end-open (LEO) / weak-infeed conditions.

POTT3 SCHEME BLOCK — This setting allows any FlexLogic operand to be assigned to block the scheme. Contact inputs from 
a pilot cut-out switch are used typically for this purpose.

POTT3 PERMISSIVE ECHO — If this setting is set to "Enabled," the scheme sends a permissive echo signal to the remote end(s). 
The echo is sent only once and then the logic locks out for the time specified by the ECHO LOCKOUT. The duration of the 
echo pulse is settable as ECHO DURATION.

POTT3 RX PICKUP DELAY — This setting enables the relay to cope with spurious receive signals. Set the delay longer than the 
longest spurious TX signal that can be received simultaneously with the protection function pickup specified in POTT3 DIR 
FWD1-3 fields. The selected delay increases the response time of the scheme.

TRANS BLOCK PICKUP DELAY — This setting defines a transient blocking mechanism embedded in the POTT3 scheme to cope 
with exposure of the directional overcurrent function. Upon receiving the POTT3 RX signal, the transient blocking 
mechanism allows the RX signal to be passed and aligned with the DIR FWD1-3 indication for a period of time set by TRANS 
BLOCK PICKUP DELAY. After that the ground directional overcurrent path is virtually disabled for the time specified as TRANS 
BLOCK RESET DELAY.

Set this TRANS BLOCK PICKUP DELAY long enough to give the selected directional overcurrent function time to operate, but 
not longer than the fastest possible operation time of the protection system that can create current reversal conditions 
within the reach of the selected directional overcurrent function.

TRANS BLOCK RESET DELAY — This setting defines a transient blocking mechanism embedded in the POTT3 scheme to cope 
with exposure of the directional overcurrent function to current reversal conditions (see the TRANS BLOCK PICKUP DELAY). Set 
this delay long enough to cope with transient conditions including not only current reversals but also spurious negative- 
and zero-sequence currents occurring during breaker operations.

ECHO DURATION — This setting defines the guaranteed and exact duration of the echo pulse. The duration does not depend 
on the duration and shape of the received RX signal. This setting enables the relay to avoid a permanent lock-up of the 
transmit/receive loop.

ECHO LOCKOUT — This setting defines the lockout period for the echo logic after sending the echo pulse.

LINE END OPEN PICKUP DELAY — This setting defines the pickup delay of the line end open conditions. The validated line end 
open condition is a requirement for the POTT3 scheme to return a received echo signal (if the echo feature is enabled).

POTT3 LINE END OPEN — This setting allows the user to select the FlexLogic operand to represent the Line End Open 
condition, such as breaker open status, or under voltage and under current conditions.

 LINE END OPEN PICKUP
DELAY: 0.050 s

Range: 0.000 to 65.535 s in steps of 0.001

 LINE END OPEN:
Off

Range: FlexLogic operand

 POTT3 SEAL-IN
DELAY: 0.400 s

Range: 0.000 to 65.535 s in steps of 0.001

 POTT3 DIR FWD1:
Off

Range: FlexLogic operand

 POTT3 DIR FWD2:
Off

Range: FlexLogic operand

 POTT3 DIR FWD3:
Off

Range: FlexLogic operand

 POTT3 RX:
Off

Range: FlexLogic operand

 POTT3 SCHEME TARGET:
Self-Reset

Range: Self-Reset, Latched, Disabled

 POTT3 SCHEME EVENTS:
Disabled

Range: Disabled, Enabled
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POTT3 SEAL-IN DELAY — The output FlexLogic operand (POTT3 OP) is produced according to the POTT3 scheme logic. A seal-
in time delay is applied to this operand for coping with noisy communication channels. The POTT SEAL-IN DELAY defines a 
minimum guaranteed duration of the POTT3 OP pulse.

POTT3 DIR FWD1-3 — This setting defines the FlexLogic operand of a protection element to identify forward faults on the 
protected line, and thus, for initiating operation of the scheme. Good directional integrity is the key requirement for an 
over-reaching forward-looking protection element.

Even though any FlexLogic operand can be used as DIR FWD, enabling the user to combine responses of various 
protection elements or to apply extra conditions through FlexLogic equations, DIR FWD entries are primarily meant to be 
the output operand from the Negative-Sequence Directional FWD IOC and Neutral Directional FWD IOC.

POTT3 RX — This setting selects the FlexLogic operands to represent the permission receive signals for the scheme. Contact 
inputs interfacing with a signaling system(s) are used typically.

Figure 5-196: POTT3 scheme logic 

5.10.2.2  Directional comparison blocking 3 (DCB3)
SETTINGS  CONTROL ELEMENTS  PILOT SCHEMES  DCB3 SCHEME

 BLOCKING3 SCHEME
  DCB3 SCHEME

FUNCTION: Disabled
Range: Disabled, Enabled
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FLEXLOGIC OPERAND
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SETTING
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POTT3 TX

POTT3 OP

POTT3 PERMISSIVE ECHO:

Disabled = 0

Disabled = 0

837044A1.vsd

Off = 0

SETTING

SETTINGS

SETTING

SETTING

POTT3 RX PICKUP DELAY:

TRANS BLOCK PICKUP
DELAY:

LINE END OPEN PICKUP
DELAY:

TRANS BLOCK RESET
DELAY:

POTT3 SEAL-IN DELAY:

AND

AND

OR

AND

AND

AND

0

t R S T

0

t R S T
t PKP

t PKP

t PKP

0

Echo duration and 
lockout logic

SETTING

POTT3 SCHEME BLOCK:

OFF = 0

SETTING

POTT3 DIR FWD1:

Off = 0

OROff = 0

Off = 0

AND

POTT3 DIR FWD2:

POTT3 DIR FWD3:

POTT3 LINE END OPEN: 

Off = 0

SETTING
100ms

0

AND

AND

SETTING

0

ECHO LOCKOUT

SETTING

0

ECHO DURATION



CHAPTER 5: SETTINGS MONITORING ELEMENTS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-359

5

The scheme compares the direction to a fault at all terminals of the line. Unlike the permissive schemes, the absence of a 
blocking signal permits operation of the scheme. Consequently, the scheme is biased toward dependability and requires 
an "on/off" type of signaling.

The scheme generates output operands (DIR BLOCK TX INIT and DIR BLOCK TX STOP) that control the transmission of signals to 
the remote end(s). When used with telecommunications facilities, assign the output operands to operate output contacts 
connected to key the transmitter at the interface.

DCB3 SCHEME BLOCK — This setting allows any FlexLogic operand to be assigned to block the scheme. Contact inputs from 
a pilot cut-out switch are used typically for this purpose.

DCB3 RX CO-ORD PKP DELAY — This setting defines a delay for the forward-looking protection elements used by the scheme 
for coordination with the blocking response from the remote end(s). In this setting, include both the response time of the 
protection elements used to establish a blocking signal and the total transmission time of that signal including the relay 
communications equipment interfacing and the communications channel itself.

TRANS BLOCK PICKUP DELAY — This setting defines a transient blocking mechanism embedded in the blocking scheme for 
coping with the exposure of directional overcurrent function to current reversal conditions.

The transient blocking logic applies to the send path only. Identifying the fault as a reverse fault establishes the blocking 
signal. If the reverse fault condition prevails for TRANS BLOCK PICKUP DELAY, the blocking operation is extended by the 
transient blocking timer for TRANS BLOCK RESET DELAY. This allows riding through current reversal conditions. However, if 

 DCB3 SCHEME BLOCK:
Off

Range: FlexLogic operand

 DCB3 RX CO-ORD PKP
DELAY: 0.010 s

Range: 0.000 to 65.535 s in steps of 0.001

 TRANS BLOCK PICKUP
DELAY: 0.030 s

Range: 0.000 to 65.535 s in steps of 0.001

 TRANS BLOCK RESET
DELAY: 0.090 s

Range: 0.000 to 65.535 s in steps of 0.001

 DCB3 SCHEME SEAL-IN
DELAY: 0.010 s

Range: 0.000 to 65.535 s in steps of 0.001

 DCB3 SCHME DIR FWD1:
Off

Range: FlexLogic operand

 DCB3 SCHME DIR FWD2:
Off

Range: FlexLogic operand

 DCB3 SCHME DIR FWD3:
Off

Range: FlexLogic operand

 DCB3 SCHME DIR REV1:
Off

Range: FlexLogic operand

 DCB3 SCHME DIR REV2:
Off

Range: FlexLogic operand

 DCB3 SCHME DIR REV3:
Off

Range: FlexLogic operand

 DCB3 FORCE TX STOP1:
Off

Range: FlexLogic operand

 DCB3 FORCE TX STOP2:
Off

Range: FlexLogic operand

 DCB3 RX:
Off

Range: FlexLogic operand

 DCB3 SCHEME TARGET:
Self-Reset

Range: Self-Reset, Latched, Disabled

 DCB3 SCHEME EVENTS:
Disabled

Range: Disabled, Enabled
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internal faults on the protected line are identified, the blocking action can be removed through FORCE TX STOP1-2 inputs. 
This is done to cope with evolving faults when an external fault is followed by an internal fault. Do not set the TRANS BLOCK 
PICKUP DELAY longer than the fastest possible trip time for faults on an adjacent line so that the extended blocking action 
can be established. Take into account the pickup time of the reverse-looking elements of the scheme. Do not set the delay 
too short, in order to avoid locking up a spurious reverse fault indication that can occur during internal fault conditions.

TRANS BLOCK RESET DELAY — This setting defines a transient blocking mechanism embedded in the blocking scheme for 
coping with the exposure of the overreaching protection functions to current reversal conditions (see also the TRANS BLOCK 
PICKUP DELAY). Set this delay long enough to cope with transient conditions including not only current reversals but also 
spurious negative and zero-sequence currents occurring during breaker operations. 

DCB3 SEAL-IN DELAY — The output FlexLogic operand (DCB3 OP) is produced according to the Blocking scheme logic. The 
DCB3 SEAL-IN DELAY defines a minimum guaranteed duration of the DCB3 OP pulse. 

DCB3 DIR FWD1-3 — This setting defines the FlexLogic operand of a protection element to identify forward faults on the 
protected line, and thus, for initiating operation of the scheme. Good directional integrity is the key requirement for an 
over-reaching forward-looking protection element.

Even though any FlexLogic operand can be used as DIR FWD, enabling the user to combine responses of various 
protection elements or to apply extra conditions through FlexLogic equations, DIR FWD entries are primarily meant to be 
the output operand from the Negative-Sequence Directional FWD IOC, Neutral Directional FWD IOC, and the forward-
looking distance over-reaching elements.

DCB3 DIR REV1-3 — This setting defines the FlexLogic operand of a protection element to identify reverse faults, and thus, to 
initiate the blocking signal. Reverse-looking directional overcurrent protection elements or reverse-looking distance 
elements can be used as DIR REV.

Even though any FlexLogic operand can be used as DIR REV, enabling the user to combine responses of various protection 
elements or to apply extra conditions through FlexLogic equations, DIR REV entries are primarily meant to be the output 
operand from the Negative-Sequence Directional REV IOC, Neutral Directional REV IOC, non-directional IOC, or reverse-
looking distance elements.

The selected protection element (or elements in combination) need to be coordinated with the selection of DIR FWD. For all 
the forward external faults seen by an element used as DIR FWD at one end of the line, the reverse-looking element used 
as DIR REV at the other end needs to pick up and provide a blocking signal.

DCB3 FORCE TX STOP1-2 — This setting defines the FlexLogic operand of a protection element that is used to identify internal 
faults on the protected line, and thus, to stop the blocking signal. Typically, forward-looking under-reach protection 
elements are used as FORCE TX STOP.

DCB3 RX — This setting selects the FlexLogic operands to represent the receive signals for the scheme. Contact inputs 
interfacing with a signaling system(s) are used typically.
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Figure 5-197: DCB3 scheme logic 

5.11  Inputs/outputs

5.11.1  Contact inputs
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A contact inputs and outputs are digital signals associated with connections to hard-wired contacts. Wet and dry contacts 
are supported.

The contact inputs menu contains configuration settings for each contact input as well as voltage thresholds for each 
group of four contact inputs. Upon startup, the relay processor determines (from an assessment of the installed modules) 
which contact inputs are available and then display settings for only those inputs.

An alphanumeric ID can be assigned to a contact input for diagnostic, setting, and event recording purposes. The CONTACT 
IP X On (Logic 1) FlexLogic operand corresponds to contact input “X” being closed, while CONTACT IP X Off corresponds to 
contact input “X” being open. The CONTACT INPUT DEBNCE TIME defines the time required for the contact to overcome 
‘contact bouncing’ conditions. As this time differs for different contact types and manufacturers, set it as a maximum 
contact debounce time (per manufacturer specifications) plus some margin to ensure proper operation. If CONTACT INPUT 
EVENTS is set to “Enabled,” every change in the contact input state triggers an event.

A raw status is scanned for all Contact Inputs synchronously at the constant rate of 0.5 ms as shown in the following 
figure. The DC input voltage is compared to a user-settable threshold. A new contact input state must be maintained for a 
user-settable debounce time in order for the F60 to validate the new contact state. In the following figure, the debounce 
time is set at 2.5 ms; thus the 6th sample in a row validates the change of state (mark no. 1 in the diagram). Once validated 
(de-bounced), the contact input asserts a corresponding FlexLogic operand and logs an event as per user setting.

A time stamp of the first sample in the sequence that validates the new state is used when logging the change of the 
contact input into the Event Recorder (mark no. 2 in the figure).

Protection and control elements, as well as FlexLogic equations and timers, are executed eight times in a power system 
cycle. The protection pass duration is controlled by the frequency tracking mechanism. The FlexLogic operand reflecting 
the debounced state of the contact is updated at the protection pass following the validation (marks no. 3 and 4 on the 
figure that follows). The update is performed at the beginning of the protection pass so all protection and control functions, 
as well as FlexLogic equations, are fed with the updated states of the contact inputs.

The FlexLogic operand response time to the contact input change is equal to the debounce time setting plus up to one 
protection pass (variable and depending on system frequency if frequency tracking enabled). If the change of state occurs 
just after a protection pass, the recognition is delayed until the subsequent protection pass; that is, by the entire duration 
of the protection pass. If the change occurs just prior to a protection pass, the state is recognized immediately. Statistically 
a delay of half the protection pass is expected. Owing to the 0.5 ms scan rate, the time resolution for the input contact is 
below 1 ms.

For example, eight protection passes per cycle on a 60 Hz system correspond to a protection pass every 2.1 ms. With a 
contact debounce time setting of 3.0 ms, the FlexLogic operand-assert time limits are: 3.0 + 0.0 = 3.0 ms and 3.0 + 2.1 = 5.1 
ms. These time limits depend on how soon the protection pass runs after the debouncing time.

Regardless of the contact debounce time setting, the contact input event is time-stamped with a 1 s accuracy using the 
time of the first scan corresponding to the new state (mark no. 2 shown). Therefore, the time stamp reflects a change in the 
DC voltage across the contact input terminals that was not accidental as it was subsequently validated using the 
debounce timer. Keep in mind that the associated FlexLogic operand is asserted/de-asserted later, after validating the 
change.

The debounce algorithm is symmetrical: the same procedure and debounce time are used to filter the LOW-HIGH (marks 
no.1, 2, 3, and 4 in the figure) and HIGH-LOW (marks no. 5, 6, 7, and 8) transitions.

 Ips H5a,H5c,H6a,H6c
THRESHOLD: 33 Vdc

Range: 17, 33, 84, 166 Vdc

 Ips H7a,H7c,H8a,H8c
THRESHOLD: 33 Vdc

Range: 17, 33, 84, 166 Vdc



 Ips xxx,xxx,xxx,xxx
THRESHOLD: 33 Vdc

Range: 17, 33, 84, 166 Vdc
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Figure 5-198: Input contact debouncing mechanism and time stamp sample timing 

Contact inputs are isolated in groups of four to allow connection of wet contacts from different voltage sources for each 
group. The CONTACT INPUT THRESHOLDS determine the minimum voltage required to detect a closed contact input. This 
value is selected according to the following criteria: 17 for 24 V sources, 33 for 48 V sources, 84 for 110 to 125 V sources 
and 166 for 250 V sources.

For example, to use contact input H5a as a status input from the breaker 52b contact to seal-in the trip relay and record it 
in the Event Records menu, make the following settings changes:

CONTACT INPUT H5a ID: "Breaker Closed (52b)"
CONTACT INPUT H5a EVENTS: "Enabled"

Note that the 52b contact is closed when the breaker is open and open when the breaker is closed.

5.11.2  Virtual inputs
SETTINGS  INPUTS/OUTPUTS  VIRTUAL INPUTS  VIRTUAL INPUT 1(64)

The virtual inputs and outputs are digital signals associated with UR-series internal logic signals. Virtual inputs include 
signals generated by the local user interface. The virtual outputs are outputs of FlexLogic equations used to customize the 
device. Virtual outputs can also serve as virtual inputs to FlexLogic equations.

 VIRTUAL INPUT 1
  VIRTUAL INPUT 1

FUNCTION: Disabled
Range: Disabled, Enabled

 VIRTUAL INPUT 1 ID:
Virt Ip 1

Range: up to 20 alphanumeric characters

 VIRTUAL INPUT 1
TYPE: Latched

Range: Self-Reset, Latched

 VIRTUAL INPUT 1
EVENTS: Disabled

Range: Disabled, Enabled
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There are 64 virtual inputs that can be individually programmed to respond to input signals from the keypad (via the 
COMMANDS menu) and communications protocols. All virtual input operands are defaulted to “Off” (logic 0) unless the 
appropriate input signal is received.

If the VIRTUAL INPUT x FUNCTION is to “Disabled,” the input is forced to off (logic 0) regardless of any attempt to alter the 
input. If set to “Enabled,” the input operates as shown on the logic diagram and generates output FlexLogic operands in 
response to received input signals and the applied settings.

There are two types of operation: self-reset and latched. If VIRTUAL INPUT x type is “Self-Reset,” when the input signal 
transits from off to on, the output operand is set to on for only one evaluation of the FlexLogic equations and then return to 
off. If set to “Latched,” the virtual input sets the state of the output operand to the same state as the most recent received 
input.

The self-reset operating mode generates the output operand for a single evaluation of the FlexLogic equations. If the 
operand is to be used anywhere other than internally in a FlexLogic equation, it likely needs to be lengthened in time. A 
FlexLogic timer with a delayed reset can perform this function.

Figure 5-199: Virtual inputs logic 

5.11.3  Contact outputs

5.11.3.1  Digital outputs
SETTINGS  INPUTS/OUTPUTS  CONTACT OUTPUTS  CONTACT OUTPUT H1

A contact inputs and outputs are digital signals associated with connections to hard-wired contacts. Wet and dry contacts 
are supported.

Upon startup of the relay, the main processor determines from an assessment of the modules installed in the chassis 
which contact outputs are available and then presents the settings for only these outputs. Where the contact input is non-
latching, the settings are as shown.

An ID can be assigned to each contact output. The signal that can OPERATE a contact output can be any FlexLogic 
operand (virtual output, element state, contact input, or virtual input). An additional FlexLogic operand can be used to 
SEAL-IN the relay. Any change of state of a contact output can be logged as an Event if programmed to do so.

 CONTACT OUTPUT H1
  CONTACT OUTPUT H1 ID

Cont Op 1
Range: up to 20 alphanumeric characters

 OUTPUT H1 OPERATE:
Off

Range: FlexLogic operand

 OUTPUT H1 SEAL-IN:
Off

Range: FlexLogic operand

 CONTACT OUTPUT H1
EVENTS: Enabled

Range: Disabled, Enabled
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For example, the trip circuit current is monitored by providing a current threshold detector in series with some Form-A 
contacts (see the trip circuit example in the Digital Elements section). The monitor sets a flag (see the specifications for 
Form-A). The name of the FlexLogic operand set by the monitor, consists of the output relay designation, followed by the 
name of the flag; for example, Cont OP 1  IOn.

In most breaker control circuits, the trip coil is connected in series with a breaker auxiliary contact used to interrupt current 
flow after the breaker has tripped, to prevent damage to the less robust initiating contact. This can be done by monitoring 
an auxiliary contact on the breaker which opens when the breaker has tripped, but this scheme is subject to incorrect 
operation caused by differences in timing between breaker auxiliary contact change-of-state and interruption of current in 
the trip circuit. The most dependable protection of the initiating contact is provided by directly measuring current in the 
tripping circuit, and using this parameter to control resetting of the initiating relay. This scheme is often called trip seal-in.

This can be realized using the Cont OP 1  IOn FlexLogic operand to seal-in the contact output as follows:
CONTACT OUTPUT H1 ID: “Cont Op 1"
OUTPUT H1 OPERATE: any suitable FlexLogic operand
OUTPUT H1 SEAL-IN: “Cont Op 1 IOn”
CONTACT OUTPUT H1 EVENTS: “Enabled”

Figure 5-200: Contact input/output module type 6A contact 1 logic 

5.11.3.2  Latching outputs
SETTINGS  INPUTS/OUTPUTS  CONTACT OUTPUTS  CONTACT OUTPUT H1a

The latching output contacts are mechanically bi-stable and controlled by two separate (open and close) coils. As such 
they retain their position even if the relay is not powered up. The relay recognizes all latching output contact cards and 
populates the setting menu accordingly. On power up, the relay reads positions of the latching contacts from the hardware 
before executing any other functions of the relay (such as protection and control features or FlexLogic).

The latching output modules, either as part of the relay or as individual modules, are shipped from the factory with all 
latching contacts open. It is highly recommended to double-check the programming and positions of the latching contacts 
when replacing a module.

Since the relay asserts the output contact and reads back its position, it is possible to incorporate self-monitoring 
capabilities for the latching outputs. If any latching outputs exhibits a discrepancy, the LATCHING OUTPUT ERROR self-test 
error is declared. The error is signaled by the LATCHING OUT ERROR FlexLogic operand, event, and target message.

 CONTACT OUTPUT H1a
  OUTPUT H1a ID

L-Cont Op 1
Range: up to 20 alphanumeric characters

 OUTPUT H1a OPERATE:
Off

Range: FlexLogic operand

 OUTPUT H1a RESET:
Off

Range: FlexLogic operand

 OUTPUT H1a TYPE:
Operate-dominant

Range: Operate-dominant, Reset-dominant

 OUTPUT H1a EVENTS:
Disabled

Range: Disabled, Enabled

FLEXLOGIC OPERAND
Cont Op 1 Closed

SETTING

= On
CONTACT OUTPUT H1 SEAL-IN

OR

SETTING

= On
CONTACT OUTPUT H1 OPERATE

AND H1a

Cont Op 1 Ion
Cont Op 1 Von
Cont Op 1 Voff

H1b

H1c

859743A1.vsd
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OUTPUT H1a OPERATE — This setting specifies a FlexLogic operand to operate the ‘close coil’ of the contact. The relay seals-
in this input to safely close the contact. Once the contact is closed and the RESET input is logic 0 (off), any activity of the 
OPERATE input, such as subsequent chattering, does not have any effect. With both the OPERATE and RESET inputs active 
(logic 1), the response of the latching contact is specified by the OUTPUT H1a TYPE setting.

OUTPUT H1a RESET — This setting specifies a FlexLogic operand to operate the ‘trip coil’ of the contact. The relay seals-in 
this input to safely open the contact. Once the contact is opened and the OPERATE input is logic 0 (off), any activity of the 
RESET input, such as subsequent chattering, does not have any effect. With both the OPERATE and RESET inputs active (logic 
1), the response of the latching contact is specified by the OUTPUT H1a TYPE setting.

OUTPUT H1a TYPE — This setting specifies the contact response under conflicting control inputs; that is, when both the 
OPERATE and RESET signals are applied. With both control inputs applied simultaneously, the contact closes if set to 
“Operate-dominant” and opens if set to “Reset-dominant.”

Figure 5-201: Contact input/output module type 4L contact 1 logic 

Application example 1
A latching output contact H1a is to be controlled from two user-programmable pushbuttons (buttons number 1 and 2). The 
following settings are applied.

Program the Latching Outputs by making the following changes in the SETTINGS  INPUTS/OUTPUTS  CONTACT 
OUTPUTS  CONTACT OUTPUT H1a menu (assuming an H4L module):

OUTPUT H1a OPERATE: “PUSHBUTTON 1 ON”
OUTPUT H1a RESET: “PUSHBUTTON 2 ON”

Program the pushbuttons by making the following changes in the PRODUCT SETUP  USER-PROGRAMMABLE PUSHBUTTONS 
 USER PUSHBUTTON 1 and USER PUSHBUTTON 2 menus:

PUSHBUTTON 1 FUNCTION: “Self-reset”
PUSHBTN 1 DROP-OUT TIME: “0.00 s”
PUSHBUTTON 2 FUNCTION: “Self-reset”
PUSHBTN 2 DROP-OUT TIME: “0.00 s”

Application example 2
A relay, having two latching contacts H1a and H1c, is to be programmed. The H1a contact is to be a Type-a contact, while 
the H1c contact is to be a Type-b contact (Type-a means closed after exercising the operate input; Type-b means closed 
after exercising the reset input). The relay is to be controlled from virtual outputs: VO1 to operate and VO2 to reset.

Program the Latching Outputs by making the following changes in the SETTINGS  INPUTS/OUTPUTS  CONTACT 
OUTPUTS  CONTACT OUTPUT H1a and CONTACT OUTPUT H1c menus (assuming an H4L module):

OUTPUT H1a OPERATE: “VO1”
OUTPUT H1a RESET: “VO2”
OUTPUT H1c OPERATE: “VO2”
OUTPUT H1c RESET: “VO1”

FLEXLOGIC OPERAND
Cont Op 1 Closed

SETTING

= Operate-dominant
CONTACT OUTPUT H1a TYPE

SETTING

= On
CONTACT OUTPUT H1a 
OPERATE

AND

SETTING

= On
CONTACT OUTPUT H1a RESET

= Reset-dominant

Non-volatile,
Set-dominant

Latch

S

R

Non-volatile,
Set-dominant

Latch

S

R

H1a

H1b

AND

Close

Open

OR

OR

On

859744A1.vsd
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Since the two physical contacts in this example are mechanically separated and have individual control inputs, they do not 
operate at exactly the same time. A discrepancy in the range of a fraction of a maximum operating time can occur. 
Therefore, a pair of contacts programmed to be a multi-contact relay do not guarantee any specific sequence of operation 
(such as make before break). If required, the sequence of operation must be programmed explicitly by delaying some of the 
control inputs as shown in the next application example.

Application example 3
A make before break functionality must be added to the preceding example. An overlap of 20 ms is required to implement 
this functionality.

Write the following FlexLogic equation (EnerVista example shown).

Set both timers (Timer 1 and Timer 2) to 20 ms pickup and 0 ms dropout.

Program the Latching Outputs by making the following changes in the SETTINGS  INPUTS/OUTPUTS  CONTACT 
OUTPUTS  CONTACT OUTPUT H1a and CONTACT OUTPUT H1c menus (assuming an H4L module):

OUTPUT H1a OPERATE: “VO1”
OUTPUT H1a RESET: “VO4”
OUTPUT H1c OPERATE: “VO2”
OUTPUT H1c RESET: “VO3”

Application example 4
A latching contact H1a is to be controlled from a single virtual output VO1. The contact is to remain closed as long as VO1 
is high, and is to remain opened when VO1 is low. Program the relay as follows.

Write the following FlexLogic equation (EnerVista example shown).

Program the Latching Outputs by making the following changes in the SETTINGS  INPUTS/OUTPUTS  CONTACT 
OUTPUTS  CONTACT OUTPUT H1a menu (assuming an H4L module):

OUTPUT H1a OPERATE: “VO1”
OUTPUT H1a RESET: “VO2”
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5.11.4  Virtual outputs
SETTINGS  INPUTS/OUTPUTS  VIRTUAL OUTPUTS  VIRTUAL OUTPUT 1(96)

The virtual inputs and outputs are digital signals associated with UR-series internal logic signals. Virtual inputs include 
signals generated by the local user interface. The virtual outputs are outputs of FlexLogic equations used to customize the 
device. Virtual outputs can also serve as virtual inputs to FlexLogic equations.

There are 96 virtual outputs that can be assigned using FlexLogic. If not assigned, the output is forced to ‘OFF’ (Logic 0). An 
ID also can be assigned to each virtual output. Virtual outputs are resolved in each pass through the evaluation of the 
FlexLogic equations. Any change of state of a virtual output can be logged as an event if programmed to do so.

For example, if Virtual Output 1 is the trip signal from FlexLogic and the trip relay is used to signal events, the settings is 
programmed as follows:

VIRTUAL OUTPUT 1 ID: "Trip"
VIRTUAL OUTPUT 1 EVENTS: "Disabled"

5.11.5  Resetting

5.11.5.1  Enhanced and basic front panels
SETTINGS  INPUTS/OUTPUTS  RESETTING

5.11.5.2  Graphical front panel
SETTINGS  INPUTS/OUTPUTS  RESETTING

Some events can be programmed to latch the front panel LED event indicators, target messages, and/or graphical front 
panel annunciator windows. Once set, the latching mechanism holds the latched indicators, messages, or windows in the 
set state after the initiating condition has cleared until a RESET command is received to return these latches (not including 
FlexLogic latches) to the reset state where the initiating condition has cleared. The RESET command can be sent from the 
front panel RESET button, a remote device via a communications channel, or any selected operand. The Modbus execute 
function 05h with operation code 1 command is also available to perform the same function as the front panel RESET key.

RESET OPERAND — The three sources of RESET commands each activates the RESET OP FlexLogic operand. Each individual 
source of a RESET command also activates its individual operand RESET OP (PUSHBUTTON), RESET OP (COMMS), or RESET OP 
(OPERAND) to identify the source of the command. Each of these three operands generates an event in the event record 
when activated. The RESET OPERAND setting here selects the operand that activates the RESET OP (OPERAND) operand.

RESET ANNUNCIATOR — Used to select a FlexLogic operand that when activated acknowledges/resets all annunciator 
windows on the graphical front panel. The other methods to acknowledge/reset annunciator windows include:

• On the displayed page, press the RESET pushbutton with none of the annunciator windows selected to acknowledge/
reset all annunciator windows on that page

• To acknowledge/reset a specific annunciator window, use the Up, Down, Left and Right pushbuttons to select the 
window, and press the RESET or ENTER pushbutton

 VIRTUAL OUTPUT 1
  VIRTUAL OUTPUT 1 ID

Virt Op 1
Range: up to 20 alphanumeric characters

 VIRTUAL OUTPUT 1
EVENTS: Disabled

Range: Disabled, Enabled

 RESETTING
  RESET OPERAND:

Off
Range: FlexLogic operand

 RESETTING
  RESET OPERAND:

Off
Range: FlexLogic operand

 RESET ANNUNCIATOR:
Off

Range: FlexLogic operand
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• All annunciator windows can be reset remotely by programming a Virtual Input (for example Virtual Input 1) as the 
input to the RESET ANNUNCIATOR setting. Then the Modbus execute function 05h with operation code 1000h command 
(or function 10h with address 400h) is used to set the state of Virtual Input 1.

For the RESET ANNUNCIATOR setting, the RESET ANCTR OP FlexLogic operand is activated by the two sources of RESET 
command, operand source and manual source. Each individual source of a RESET ANNUNCIATOR command also activates 
its individual operand RESET OP (OPRD) or RESET ANCTR OP (MNUL) to identify the source of the command. Each of these two 
operands generates an event in the event record when activated. The setting here selects the operand that activates the 
RESET ANCTR OP (OPRD) operand. The RESET pushbutton on the front panel or the reset command from the software 
activates the RESET ANCTR OP (MNUL) operand.

5.11.6  Direct inputs and outputs

5.11.6.1  Direct inputs
SETTINGS  INPUTS/OUTPUTS  DIRECT INPUTS  DIRECT INPUT 1(32)

These settings specify how the direct input information is processed.

DIRECT INPUT 1 NAME — This setting allows the user to assign a descriptive name to the direct input.

DIRECT INPUT 1 DEVICE ID — Represents the source of direct input 1. The specified direct input is driven by the device 
identified here.

DIRECT INPUT 1 BIT NUMBER — The bit number to extract the state for direct input 1. Direct Input 1 is driven by the bit 
identified as DIRECT INPUT 1 BIT NUMBER. This corresponds to the direct output number of the sending device.

DIRECT INPUT 1 DEFAULT STATE — Represents the state of the direct input when the associated direct device is offline. The 
following choices are available:

• On — Defaults the input to Logic 1

• Off — Defaults the input to Logic 0

• Latest/On — Freezes the input in case of lost communications. When the latest state is not known, such as after relay 
power-up but before the first communication exchange, the input defaults to Logic 1. When communication resumes, 
the input becomes fully operational.

• Latest/Off — Freezes the input in case of lost communications. When the latest state is not known, such as after relay 
power-up but before the first communication exchange, the input defaults to Logic 0. When communication resumes, 
the input becomes fully operational.

5.11.6.2  Direct outputs
SETTINGS  INPUTS/OUTPUTS  DIRECT OUTPUTS  DIRECT OUTPUT 1(32)

 DIRECT INPUT 1
  DIRECT INPUT 1

NAME: Dir Ip 1
Range: up to 12 alphanumeric characters

 DIRECT INPUT 1
DEVICE ID: 0

Range: 0 to 16

 DIRECT INPUT 1
BIT NUMBER: 0

Range: 0 to 32

 DIRECT INPUT 1
DEFAULT: Off

Range: On, Off, Latest/On, Latest/Off

 DIRECT INPUT 1
EVENTS: Disabled

Range: Enabled, Disabled

 DIRECT OUTPUT 1
  DIRECT OUT 1 NAME:

Dir Out 1
Range: up to 12 alphanumeric characters

 DIRECT OUT 1 OPERAND:
Off

Range: FlexLogic operand
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DIRECT OUT 1 NAME — This setting allows the user to assign a descriptive name to the direct output.

DIR OUT 1 OPERAND — This sets the FlexLogic operand that determines the state of this direct output.

5.11.6.3  Application examples
The examples introduced in the earlier Direct Inputs and Outputs section (part of the Product Setup section) are continued 
here to illustrate usage of the direct inputs and outputs.

Example 1: Extending input/output capabilities of a UR relay
Consider an application that requires additional quantities of contact inputs or output contacts or lines of programmable 
logic that exceed the capabilities of a single UR-series chassis. The problem is solved by adding an extra UR-series IED, 
such as the C30, to satisfy the additional inputs/outputs and programmable logic requirements. The figure shows that two 
IEDs are connected via single-channel digital communication cards.

Figure 5-202: Input and output extension via direct inputs and outputs 

Assume that contact input 1 from UR IED 2 is to be used by UR IED 1. The following settings are applied (Direct Input 5 and 
bit number 12 are used, as an example).

UR IED 1:
DIRECT INPUT 5 DEVICE ID = “2”
DIRECT INPUT 5 BIT NUMBER = “12”

UR IED 2:
DIRECT OUT 12 OPERAND = “Cont Ip 1 On”

The Cont Ip 1 On operand of UR IED 2 is now available in UR IED 1 as DIRECT INPUT 5 ON.

Example 2: Interlocking busbar protection
A simple interlocking busbar protection scheme can be accomplished by sending a blocking signal from downstream 
devices, say 2, 3 and 4, to the upstream device that monitors a single incomer of the busbar, as shown in the figure.

 DIRECT OUTPUT 1
EVENTS: Disabled

Range: Enabled, Disabled
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Figure 5-203: Sample interlocking busbar protection scheme 

Assume that Phase Instantaneous Overcurrent 1 is used by Devices 2, 3, and 4 to block Device 1. If not blocked, Device 1 
trips the bus upon detecting a fault and applying a short coordination time delay.

The following settings are applied (assume Bit 3 is used by all 3 devices to send the blocking signal and Direct Inputs 7, 8, 
and 9 are used by the receiving device to monitor the three blocking signals).

UR IED 2:
DIRECT OUT 3 OPERAND: "PHASE IOC1 OP"

UR IED 3:
DIRECT OUT 3 OPERAND: "PHASE IOC1 OP"

UR IED 4:
DIRECT OUT 3 OPERAND: "PHASE IOC1 OP"

UR IED 1:
DIRECT INPUT 7 DEVICE ID: "2"
DIRECT INPUT 7 BIT NUMBER: "3"
DIRECT INPUT 7 DEFAULT STATE: select "On" for security, select "Off" for dependability

DIRECT INPUT 8 DEVICE ID: "3"
DIRECT INPUT 8 BIT NUMBER: "3"
DIRECT INPUT 8 DEFAULT STATE: select "On" for security, select "Off" for dependability

DIRECT INPUT 9 DEVICE ID: "4"
DIRECT INPUT 9 BIT NUMBER: "3"
DIRECT INPUT 9 DEFAULT STATE: select "On" for security, select "Off" for dependability

Now the three blocking signals are available in UR IED 1 as DIRECT INPUT 7 ON, DIRECT INPUT 8 ON, and DIRECT INPUT 9 ON. Upon 
losing communications or a device, the scheme is inclined to block (if any default state is set to “On”), or to trip the bus on 
any overcurrent condition (all default states set to “Off”).

Example 3: Pilot-aided schemes
Consider a three-terminal line protection application shown in the following figure.
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Figure 5-204: Three-terminal line application 

Assume the Hybrid Permissive Overreaching Transfer Trip (Hybrid POTT) scheme is applied using the architecture shown as 
follows. The scheme output operand HYB POTT TX1 is used to key the permission.

Figure 5-205: Single-channel open-loop configuration 

In this architecture, Devices 1 and 3 do not communicate directly. Therefore, Device 2 must act as a "bridge." The following 
settings are applied:

UR IEC 1:
DIRECT OUT 2 OPERAND: "HYB POTT TX1"
DIRECT INPUT 5 DEVICE ID: "2"
DIRECT INPUT 5 BIT NUMBER: "2" (this is a message from IED 2)
DIRECT INPUT 6 DEVICE ID: "2"
DIRECT INPUT 6 BIT NUMBER: "4" (effectively, this is a message from IED 3)

UR IED 3:
DIRECT OUT 2 OPERAND: "HYB POTT TX1"
DIRECT INPUT 5 DEVICE ID: "2"
DIRECT INPUT 5 BIT NUMBER: "2" (this is a message from IED 2)
DIRECT INPUT 6 DEVICE ID: "2"
DIRECT INPUT 6 BIT NUMBER: "3" (effectively, this is a message from IED 1)

UR IED 2:
DIRECT INPUT 5 DEVICE ID: "1"
DIRECT INPUT 5 BIT NUMBER: "2"
DIRECT INPUT 6 DEVICE ID: "3"
DIRECT INPUT 6 BIT NUMBER: "2"
DIRECT OUT 2 OPERAND: "HYB POTT TX1"
DIRECT OUT 3 OPERAND: "DIRECT INPUT 5" (forward a message from 1 to 3)
DIRECT OUT 4 OPERAND: "DIRECT INPUT 6" (forward a message from 3 to 1)

The figure shows the signal flow among the three IEDs.
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Figure 5-206: Signal flow for direct input and output 

In three-terminal applications, both the remote terminals must grant permission to trip. Therefore, at each terminal, direct 
inputs 5 and 6 are ANDed in FlexLogic and the resulting operand configured as the permission to trip (HYB POTT RX1 
setting).

5.11.7  Teleprotection

5.11.7.1  Overview
The relay provides 16 teleprotection inputs on communications channel 1 (numbered 1-1 through 1-16) and 16 
teleprotection inputs on communications channel 2 (on two-terminals two-channel and three-terminal systems only, 
numbered 2-1 through 2-16). The remote relay connected to channels 1 and 2 of the local relay is programmed by 
assigning FlexLogic operands to be sent via the selected communications channel. This allows the user to create 
distributed protection and control schemes via dedicated communications channels. Some examples are directional 
comparison pilot schemes and direct transfer tripping. Note that failures of communications channels affect 
teleprotection functionality. The teleprotection function must be enabled to utilize the inputs.

5.11.7.2  Teleprotection inputs
SETTINGS  INPUTS/OUTPUTS  TELEPROTECTION  TELEPROT INPUTS

Setting the TELEPROT INPUT ~~ DEFAULT setting to “On” defaults the input to logic 1 when the channel fails. A value of “Off” 
defaults the input to logic 0 when the channel fails.

The “Latest/On” and “Latest/Off” values freeze the input in case of lost communications. If the latest state is not known, 
such as after relay power-up but before the first communication exchange, then the input defaults to logic 1 for “Latest/
On” and logic 0 for “Latest/Off.”

 TELEPROT INPUTS
  TELEPROT INPUT 1-1

DEFAULT: Off
Range: Off, On, Latest/Off, Latest/On



 TELEPROT INPUT 1-16
DEFAULT: Off

Range: Off, On, Latest/Off, Latest/On

 TELEPROT INPUT 2-1
DEFAULT: Off

Range: Off, On, Latest/Off, Latest/On



 TELEPROT INPUT 2-16
DEFAULT: Off

Range: Off, On, Latest/Off, Latest/On
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5.11.7.3  Teleprotection outputs
SETTINGS  INPUTS/OUTPUTS  TELEPROTECTION  TELEPROT OUTPUTS

As the following figure demonstrates, processing of the teleprotection inputs/outputs is dependent on the number of 
communication channels and terminals. On two-terminal two-channel systems, they are processed continuously on each 
channel and mapped separately per channel. Therefore, to achieve redundancy, the user must assign the same operand 
on both channels (teleprotection outputs at the sending end or corresponding teleprotection inputs at the receiving end). 
On three-terminal two-channel systems, redundancy is achieved by programming signal re-transmittal in the case of 
channel failure between any pair of relays.

Figure 5-207: Teleprotection input/output processing 

 TELEPROT OUTPUTS
  TELEPROT OUTPUT 1-1:

Off
Range: FlexLogic operand



 TELEPROT OUTPUT 1-16:
Off

Range: FlexLogic operand

 TELEPROT OUTPUT 2-1:
Off

Range: FlexLogic operand



 TELEPROT OUTPUT 2-16:
Off

Range: FlexLogic operand
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5.12  Transducer inputs/outputs

5.12.1  DCmA inputs
SETTINGS  TRANSDUCER I/O  DCMA INPUTS  DCMA INPUT H1(W8)

Hardware and software are provided to receive signals from external transducers and to convert these signals into a 
digital format for use as required. The relay accepts inputs in the range of –1 to +20 mA DC, suitable for use with most 
common transducer output ranges; all inputs are assumed to be linear over the complete range. Hardware details are 
contained in chapter 3.

Before the DCmA input signal can be used, the value of the signal measured by the relay must be converted to the range 
and quantity of the external transducer primary input parameter, such as DC voltage or temperature. The relay simplifies 
this process by internally scaling the output from the external transducer and displaying the actual primary parameter.

DCmA input channels are arranged in a manner similar to CT and VT channels. Configure the individual channels with the 
settings shown here.

The channels are arranged in sub-modules of two channels, numbered from 1 through 8 from top to bottom. On power-up, 
the relay automatically generates configuration settings for every channel, based on the order code, in the same general 
manner that is used for CTs and VTs. Each channel is assigned a slot letter followed by the row number, 1 through 8 
inclusive, which is used as the channel number. The relay generates an actual value for each available input channel.

Settings are generated automatically for every channel available in the specific relay as shown above for the first channel 
of a type 5F transducer module installed in slot H.

The function of the channel can be “Enabled” or “Disabled.” If “Disabled,” no actual values are created for the channel. An 
alphanumeric “ID” is assigned to each channel; this ID is included in the channel actual value, along with the programmed 
units associated with the parameter measured by the transducer, such as volts, °C, megawatts, and so on. This ID is also 
used to reference the channel as the input parameter to features designed to measure this type of parameter. The DCMA 
INPUT H1 RANGE setting specifies the mA DC range of the transducer connected to the input channel.

The DCMA INPUT H1 MIN VALUE and DCMA INPUT H1 MAX VALUE settings are used to program the span of the transducer in 
primary units. For example, a temperature transducer might have a span from 0 to 250 °C; in this case the DCMA INPUT H1 
MIN VALUE value is “0” and the DCMA INPUT H1 MAX VALUE value is “250.” Another example is a watts transducer with a span 
from –20 to +180 MW; in this case the DCMA INPUT H1 MIN VALUE value is “–20” and the DCMA INPUT H1 MAX VALUE value is 
“180.” Intermediate values between the minimum and maximum values are scaled linearly.

 DCMA INPUT H1
  DCMA INPUT H1

FUNCTION: Disabled
Range: Disabled, Enabled

 DCMA INPUT H1 ID:
DCMA Ip 1

Range: up to 20 alphanumeric characters

 DCMA INPUT H1
UNITS: A

Range: six alphanumeric characters

 DCMA INPUT H1
RANGE: 0 to -1 mA

Range: 0 to –1 mA, 0 to +1 mA, –1 to +1 mA, 0 to 5 
mA, 0 to 10mA, 0 to 20 mA, 4 to 20 m

 DCMA INPUT H1 MIN
VALUE: 0.000

Range: –9999.999 to +9999.999 in steps of 0.001

 DCMA INPUT H1 MAX
VALUE: 0.000

Range: –9999.999 to +9999.999 in steps of 0.001

The F60 is provided with optional DCmA capability. This feature is specified as an option at the time of 
ordering. See the Order Codes section in chapter 2 for details.
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5.12.2  RTD inputs
SETTINGS  TRANSDUCER I/O  RTD INPUTS  RTD INPUT H1(W8)

Hardware and software is provided to receive signals from external resistance temperature detectors and convert these 
signals into a digital format for use as required. These channels are intended to be connected to any of the RTD types in 
common use. Specific hardware details are contained in chapter 3.

RTD input channels are arranged in a manner similar to CT and VT channels. The user configures individual channels with 
the settings shown here.

The channels are arranged in sub-modules of two channels, numbered from 1 through 8 from top to bottom. On power-up, 
the relay automatically generates configuration settings for every channel, based on the order code, in the same general 
manner that is used for CTs and VTs. Each channel is assigned a slot letter followed by the row number, 1 through 8 
inclusive, which is used as the channel number. The relay generates an actual value for each available input channel.

Settings are automatically generated for every channel available in the specific relay as shown above for the first channel 
of a type 5C transducer module installed in the first available slot.

The function of the channel can be either “Enabled” or “Disabled.” If “Disabled,” there is not an actual value created for the 
channel. An alphanumeric ID is assigned to the channel; this ID is included in the channel actual values. It is also used to 
reference the channel as the input parameter to features designed to measure this type of parameter. Selecting the type of 
RTD connected to the channel configures the channel.

Actions based on RTD overtemperature, such as trips or alarms, are done in conjunction with the FlexElements feature. In 
FlexElements, the operate level is scaled to a base of 100°C. For example, a trip level of 150°C is achieved by setting the 
operate level at 1.5 pu. FlexElement operands are available to FlexLogic for further interlocking or to operate an output 
contact directly.

See the following table for reference temperature values for each RTD type.

 RTD INPUT H1
  RTD INPUT H1

FUNCTION: Disabled
Range: Disabled, Enabled

 RTD INPUT H1 ID:
RTD Ip 1

Range: up to 20 alphanumeric characters

 RTD INPUT H1 TYPE:
100Ω Platinum

Range: 100Ω Nickel, 10Ω Copper, 100Ω Platinum, 
120Ω Nickel
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Table 5-47: RTD temperature vs. resistance

5.12.3  DCmA outputs
SETTINGS  TRANSDUCER I/O  DCMA OUTPUTS  DCMA OUTPUT H1(W8)

Temperature Resistance (in ohms)

°C °F 100 Ω Pt 
(DIN 43760)

120 Ω Ni 100 Ω Ni 10 Ω Cu

–50 –58 80.31 86.17 71.81 7.10

–40 –40 84.27 92.76 77.30 7.49

–30 –22 88.22 99.41 82.84 7.88

–20 –4 92.16 106.15 88.45 8.26

–10 14 96.09 113.00 94.17 8.65

0 32 100.00 120.00 100.00 9.04

10 50 103.90 127.17 105.97 9.42

20 68 107.79 134.52 112.10 9.81

30 86 111.67 142.06 118.38 10.19

40 104 115.54 149.79 124.82 10.58

50 122 119.39 157.74 131.45 10.97

60 140 123.24 165.90 138.25 11.35

70 158 127.07 174.25 145.20 11.74

80 176 130.89 182.84 152.37 12.12

90 194 134.70 191.64 159.70 12.51

100 212 138.50 200.64 167.20 12.90

110 230 142.29 209.85 174.87 13.28

120 248 146.06 219.29 182.75 13.67

130 266 149.82 228.96 190.80 14.06

140 284 153.58 238.85 199.04 14.44

150 302 157.32 248.95 207.45 14.83

160 320 161.04 259.30 216.08 15.22

170 338 164.76 269.91 224.92 15.61

180 356 168.47 280.77 233.97 16.00

190 374 172.46 291.96 243.30 16.39

200 392 175.84 303.46 252.88 16.78

210 410 179.51 315.31 262.76 17.17

220 428 183.17 327.54 272.94 17.56

230 446 186.82 340.14 283.45 17.95

240 464 190.45 353.14 294.28 18.34

250 482 194.08 366.53 305.44 18.73

 DCMA OUTPUT H1
  DCMA OUTPUT H1

SOURCE: Off
Range: Off, any analog actual value parameter

 DCMA OUTPUT H1
RANGE: –1 to 1 mA

Range: –1 to 1 mA, 0 to 1 mA, 4 to 20 mA

 DCMA OUTPUT H1
MIN VAL: 0.000 pu

Range: –90.000 to 90.000 pu in steps of 0.001

 DCMA OUTPUT H1
MAX VAL: 1.000 pu

Range: –90.000 to 90.000 pu in steps of 0.001
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Hardware and software is provided to generate DCmA signals that allow interfacing with external equipment. Hardware 
details are contained in chapter 3. The DCmA output channels are arranged in a manner similar to transducer input or CT 
and VT channels. The user configures individual channels with the settings as follows.

The channels are arranged in sub-modules of two channels, numbered 1 through 8 from top to bottom. On power-up, the 
relay automatically generates configuration settings for every channel, based on the order code, in the same manner used 
for CTs and VTs. Each channel is assigned a slot letter followed by the row number, 1 through 8 inclusive, which is used as 
the channel number.

Both the output range and a signal driving a given output are user-programmable via the following settings menu (an 
example for channel M5 is shown).

The relay checks the driving signal (x in equations below) for the minimum and maximum limits, and subsequently re-
scales so the limits defined as MIN VAL and MAX VAL match the output range of the hardware defined as RANGE. The 
following equation is applied:

Eq. 5-37

where

x is a driving signal specified by the SOURCE setting
Imin and Imax are defined by the RANGE setting
k is a scaling constant calculated as:

Eq. 5-38

The feature is intentionally inhibited if the MAX VAL and MIN VAL settings are entered incorrectly, for example when MAX VAL 
– MIN VAL < 0.1 pu. The resulting characteristic is illustrated in the following figure.

Figure 5-208: DCmA output characteristic 

Settings
DCMA OUTPUT H1 SOURCE — This setting specifies an internal analog value to drive the analog output. Actual values 
(FlexAnalog parameters) such as power, current amplitude, voltage amplitude, power factor, etc. can be configured as 
sources driving DCmA outputs. See Appendix A for a list of FlexAnalog parameters.

DCMA OUTPUT H1 RANGE — This setting allows selection of the output range. Each DCmA channel can be set independently 
to work with different ranges. The three most commonly used output ranges are available.

Iout

Imin   if x MIN VAL<

Imax   if x MAX VAL>

k x MIN VAL– Imin+    otherwise

=

k
Imax Imin–

MAX VAL MIN VAL–
--------------------------------------------=
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DCMA OUTPUT H1 MIN VAL — This setting allows setting the minimum limit for the signal that drives the output. This setting 
is used to control the mapping between an internal analog value and the output current. The setting is entered in per-unit 
values. The base units are defined in the same manner as the FlexElement base units.

DCMA OUTPUT H1 MAX VAL — This setting allows setting the maximum limit for the signal that drives the output. This setting 
is used to control the mapping between an internal analog value and the output current. The setting is entered in per-unit 
values. The base units are defined in the same manner as the FlexElement base units.

Three application examples follow.

Example: Power monitoring
A three phase active power on a 13.8 kV system measured via UR-series relay source 1 is to be monitored by the DCmA H1 
output of the range of –1 to 1 mA. The following settings are applied on the relay: CT ratio = 1200:5, VT secondary 115, VT 
connection is delta, and VT ratio = 120. The nominal current is 800 A primary and the nominal power factor is 0.90. The 
power is to be monitored in both importing and exporting directions and allow for 20% overload compared to the nominal.

The nominal three-phase power is:

Eq. 5-39

The three-phase power with 20% overload margin is:

Eq. 5-40

The base unit for power (refer to the FlexElements section in this chapter for additional details) is:

Eq. 5-41

The minimum and maximum power values to be monitored (in pu) are:

Eq. 5-42

The following settings are entered:
DCMA OUTPUT H1 SOURCE: “SRC 1 P”
DCMA OUTPUT H1 RANGE: “–1 to 1 mA”
DCMA OUTPUT H1 MIN VAl: “–1.247 pu”
DCMA OUTPUT H1 MAX VAL: “1.247 pu”

With the above settings, the output will represent the power with the scale of 1 mA per 20.65 MW. The worst-case error for 
this application can be calculated by superimposing the following two sources of error:

• ±0.5% of the full scale for the analog output module, or ±0.005 x (1-(-1)) x 20.65 MW = ±0.207 MW

• ±1% of reading error for the active power at power factor of 0.9

For example at the reading of 20 MW, the worst-case error is 0.01  20 MW + 0.207 MW = 0.407 MW.

Example: Current monitoring
The phase A current (true RMS value) is to be monitored via the H2 current output working with the range from 4 to 20 mA. 
The CT ratio is 5000:5 and the maximum load current is 4200 A. The current is to be monitored from 0 A upwards, allowing 
for 50% overload.

The phase current with the 50% overload margin is:

Eq. 5-43

The DCMA OUTPUT H1 MIN VAL and DCMA OUTPUT H1 MAX VAL settings are ignored for power factor base units (i.e. if 
the DCMA OUTPUT H1 SOURCE is set to FlexAnalog value based on power factor measurement).

P 3 13.8 kV 0.8 kA 0.9 17.21 MW= =

Pmax 1.2 17.21 MW 20.65 MW= =

PBASE 115 V 120 1.2 kA 16.56 MW= =

minimum power 20.65 MW–
16.56 MW

-------------------------- 1.247 pu,     maximum power 20.65 MW
16.56 MW
----------------------- 1.247 pu= =–= =

Imax 1.5 4.2 kA 6.3 kA= =
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The base unit for current (see the FlexElements section in this chapter for additional details) is:

Eq. 5-44

The minimum and maximum power values to be monitored (in pu) are:

Eq. 5-45

The following settings are entered:
DCMA OUTPUT H2 SOURCE: “SRC 1 Ia RMS”
DCMA OUTPUT H2 RANGE: “4 to 20 mA”
DCMA OUTPUT H2 MIN VAL: “0.000 pu”
DCMA OUTPUT H2 MAX VAL: “1.260 pu”

The worst-case error for this application can be calculated by superimposing the following two sources of error:

• ±0.5% of the full scale for the analog output module, or ±0.005 x (20 - 4) x 6.3 kA = ±0.504 kA

• ±0.25% of reading or ±0.1% of rated (whichever is greater) for currents between 0.1 and 2.0 of nominal

For example, at the reading of 4.2 kA, the worst-case error is max(0.0025  4.2 kA, 0.001  5 kA) + 0.504 kA = 0.515 kA.

Example: Voltage monitoring
A positive-sequence voltage on a 400 kV system measured via source 2 is to be monitored by the DCmA H3 output with a 
range of 0 to 1 mA. The VT secondary setting is 66.4 V, the VT ratio setting is 6024, and the VT connection setting is “Delta.” 
The voltage is to be monitored in the range from 70% to 110% of nominal.

The minimum and maximum positive-sequence voltages to be monitored are:

Eq. 5-46

The base unit for voltage (see the FlexElements section in this chapter for additional details) is:

Eq. 5-47

The minimum and maximum voltage values to be monitored (in pu) are:

Eq. 5-48

The following settings are entered:
DCMA OUTPUT H3 SOURCE: “SRC 2 V_1 mag”
DCMA OUTPUT H3 RANGE: “0 to 1 mA”
DCMA OUTPUT H3 MIN VAL: “0.404 pu”
DCMA OUTPUT H3 MAX VAL: “0.635 pu”

The limit settings differ from the expected 0.7 pu and 1.1 pu because the relay calculates the positive-sequence quantities 
scaled to the phase-to-ground voltages, even if the VTs are connected in “Delta” (see the Metering Conventions section in 
chapter 6), while at the same time the VT nominal voltage is 1 pu for the settings. Consequently the settings required in this 
example differ from naturally expected by the factor of .

The worst-case error for this application could be calculated by superimposing the following two sources of error:

• ±0.5% of the full scale for the analog output module, or ± 0.005 x (1-0) x 254.03 kV = ±1.27 kV

• ±0.5% of reading

For example, under nominal conditions, the positive-sequence reads 230.94 kV and the worst-case error is 
0.005  230.94 kV + 1.27 kV = 2.42 kV.

IBASE 5 kA=

minimum current 0 kA
5 kA
---------- 0 pu,     maximum current 6.3 kA

5 kA
-------------- 1.26 pu= == =

Vmin 0.7 400 kV
3

---------------- 161.66 kV,     Vmax 1.1 400 kV
3

---------------- 254.03 kV= == =

VBASE 0.0664 kV 6024 400 kV= =

minimum voltage 161.66 kV
400 kV

----------------------- 0.404 pu,     maximum voltage 254.03 kV
400 kV

----------------------- 0.635 pu= == =

3



CHAPTER 5: SETTINGS TESTING

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 5-381

5

5.13  Testing

5.13.1  Test mode function
SETTINGS  TESTING  TEST MODE FUNCTION

The F60 provides a test facility to verify the functionality of contact inputs and outputs, some communication functions 
and the Phasor Measurement Unit (PMU, where applicable), using simulated conditions. It is accessible in the software and 
graphical front panel.

The TEST MODE FUNCTION can be in one of three states: Disabled, Isolated, or Forcible. In UR 7.7 and later, as outlined in the 
Simulation section that follows, the UR test mode and GOOSE simulation mode are Isolated, and they no longer depend on 
the UR TEST MODE FUNCTION.

The Disabled mode is intended for normal in service operation; the relay protection, control, and communication function 
is normal. Test features are disabled, except channel tests and Phasor Measurement Unit tests remain usable when 
provided.

The Isolated mode is intended to allow the relay to be quickly placed in a state where the relay cannot negatively impact 
the power system or other parts of the substation automation system. This is to allow changing settings, loading new 
firmware, changing hardware modules, and changing communication connections. As far as practical all relay output 
signals are blocked. Contact outputs are de-energized, latching outputs are frozen. Commands to HardFiber Bricks are 
blocked. GOOSE transmissions have their "simulation" flag (also known as "test" flag) set, which results in the messages not 
being accepted by compliant receiving devices that do not have a "Sim" data attribute set. The quality attribute of values 
that can be output via IEC 61850 MMS services are set to "invalid," which results in the values not being used for 
operational purposes by compliant receiving devices. Direct I/O channel tests and PMU tests are usable on applicable 
models.

The Forcible mode is intended for testing involving forcing relay operation by test signal injection and verifying correct 
relay output. This mode is also for tests to verify the relay outputs (both contact and communications) have the intended 
impact on specific power system devices or on specific other substation automation devices. Contact outputs can be 
selectively enabled or forced as described in the following two sections. Shared outputs to Bricks have their test mode flag 
raised, which results in their value only being accepted by relays also in forcible mode. GOOSE transmissions have the 
"simulation" flag set, which results in these only being accepted by other devices that have their "Sim" data attribute set. 
The "Sim" data attribute in the relay is set, so that if GOOSE messages are received with the "simulation" flag set, these are 
used in place of the normal messages. The quality attribute of values that are output via IEC 61850 MMS services are set to 
"valid" + "test," which signals that the values are not to be used for operational purposes.

Otherwise, the UR remains fully operational while in the Forcible test mode, allowing for various testing procedures. In 
particular, the protection and control elements, and FlexLogic function normally. Other than the IEC 61850 protocol, 
communications based inputs and outputs remain fully operational. The test procedure must take this into account. Direct 
I/O channel tests and PMU tests are usable on applicable models.

The test mode can be selected through the front panel, EnerVista UR Setup software, or IEC 61850 control to LLN0.Mod.  
LLN0.Mod.ctlVal "on" selects Disabled, "test/blocked" selects Isolated, and "test" selects Forcible. The TEST MODE FUNCTION 
setting can only be changed by a direct user command. Following a restart, power up, settings upload, or firmware 
upgrade, the test mode remains at the last programmed value. This allows a UR that has been placed in isolated mode to 
remain isolated during testing and maintenance activities.

5.13.2  Test mode forcing
SETTINGS  TESTING  TEST MODE FORCING

 TESTING
  TEST MODE

FUNCTION: Disabled
Range: Disabled, Isolated, Forcible

 TESTING
  TEST MODE FORCING:

On
Range:  FlexLogic operand
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When in Forcible mode, the operand selected by the TEST MODE FORCING setting dictates further response of the F60 to 
testing conditions, as described in the following two sections.

The test mode state is indicated on the relay front panel by a combination of the Test Mode LED indicator, the In-Service 
LED indicator, and by the critical fail relay, as shown in the following table.

Table 5-48: Test mode operation

5.13.3  Phasor Measurement Unit test values
SETTINGS  TESTING  PMU TEST VALUES  PMU 1 TEST VALUES

TEST MODE 
FUNCTION

In-service 
LED

Test mode 
LED

Critical fail 
relay

TEST MODE 
FORCING

Contact input and output behavior

Disabled Unaffected Off Normal No effect Normal

Isolated Off On De-energized No effect Contact outputs disabled

Forcible Off Flashing De-energized Off Normal

On Controlled by forcing features

On restart, the TEST MODE FORCING setting and the force contact input and force contact output settings revert to 
their default states.

 PMU 1
 TEST VALUES  PMU 1 TEST

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU 1 VA TEST
MAGNITUDE: 500.00 kV

Range: 0.00 to 700.00 kV in steps of 0.01

 PMU 1 VA TEST
ANGLE: 0.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 VB TEST
MAGNITUDE: 500.00 kV

Range: 0.00 to 700.00 kV in steps of 0.01

 PMU 1 VB TEST
ANGLE: –120.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 VC TEST
MAGNITUDE: 500.00 kV

Range: 0.00 to 700.00 kV in steps of 0.01

 PMU 1 VC TEST
ANGLE: 120.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 VX TEST
MAGNITUDE: 500.00 kV

Range: 0.00 to 700.00 kV in steps of 0.01

 PMU 1 VX TEST
ANGLE: 0.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 IA TEST
MAGNITUDE: 1.000 kA

Range: 0.000 to 9.999 kA in steps of 0.001

 PMU 1 IA TEST
ANGLE: –10.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 IB TEST
MAGNITUDE: 1.000 kA

Range: 0.000 to 9.999 kA in steps of 0.001

 PMU 1 IB TEST
ANGLE: –130.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 IC TEST
MAGNITUDE: 1.000 kA

Range: 0.000 to 9.999 kA in steps of 0.001
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The relay must be in test mode to use the PMU test mode. That is, the TESTING  TEST MODE FUNCTION setting must be 
“Enabled,” and the TESTING  TEST MODE INITIATE initiating signal must be “On.”

During the PMU test mode, the physical channels (VA, VB, VC, VX, IA, IB, IC, and IG), frequency, and rate of change of 
frequency are substituted with user values, while the symmetrical components are calculated from the physical channels. 
The test values are not explicitly marked in the outgoing data frames. When required, it is recommended to use the user-
programmable digital channels to signal the IEEE C37.118 client that test values are being sent in place of the real 
measurements.

The UR Synchrophasor Implementation defines a test mode that sends a pre-defined set of synchrophasors out over the 
communication channel when the test mode function setting is enabled. In test mode, the following actions take place:

• The Data Invalid / Test Mode bit (bit 15 in the STAT word) is set

• The Sim bit in all output datasets is set

5.13.4  Force contact inputs
SETTINGS  TESTING  FORCE CONTACT INPUTS

The force contact inputs feature provides a method of performing checks on the function of all contact inputs.

While in Forcible test mode, the relay contact inputs can be pre-programmed to respond in the following ways:

• If set to “Normal,” the input remains fully operational. It is controlled by the voltage across its input terminals and can 
be turned on and off by external circuitry. Select this value if a given input must be operational during the test. This 
includes, for example, an input initiating the test, or being a part of a user pre-programmed test sequence.

• If set to “Open,” the input is forced to report as opened (Logic 0) while the operand selected by TEST MODE FORCING 
setting is On, regardless of the voltage across the input terminals. While the selected operand is Off, the input behaves 
as it does when in service.

• If set to “Closed,” the input is forced to report as closed (Logic 1) while the operand selected by TEST MODE FORCING 
setting is On regardless of the voltage across the input terminals. While the selected operand is Off, the input behaves 
as it does when in service.

 PMU 1 IC TEST
ANGLE: 110.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 IG TEST
MAGNITUDE: 0.000 kA

Range: 0.000 to 9.999 kA in steps of 0.001

 PMU 1 IG TEST
ANGLE: 0.00°

Range: –180.00 to 180.00° in steps of 0.05

 PMU 1 TEST
FREQUENCY: 60.000 Hz

Range: 20.000 to 70.000 Hz in steps of 0.001

 PMU 1 TEST
df/dt: 0.00 Hz/s

Range: –10.00 to 10.00 Hz/s in steps of 0.01

 FORCE CONTACT
 INPUTS  FORCE Cont Ip 1

: Normal
Range: Normal, Open, Closed

 FORCE Cont Ip 2
: Normal

Range: Normal, Open, Closed



 FORCE Cont Ip xx
: Normal

Range: Normal, Open, Closed

On restart, the TEST MODE FORCING setting and the force contact input and force contact output settings revert to 
their default states.
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5.13.5  Force contact outputs
SETTINGS  TESTING  FORCE CONTACT OUTPUTS

The force contact outputs feature provides a method of performing checks on the function of all contact outputs.

While in Forcible test mode, the relay contact outputs can be pre-programmed to respond in the following ways:

• If set to “Normal,” the contact output remains fully operational. It operates when its control operand is logic 1 and 
resets when its control operand is logic 0.

• If set to “Energized,” the output closes and remains closed while the operand selected by the TEST MODE FORCING 
setting is On, regardless of the status of the operand configured to control the output contact. While the selected 
operand is Off, the output behaves as it does when in service.

• If set to “De-energized,” the output opens and remains opened while the operand selected by the TEST MODE FORCING 
setting is On, regardless of the status of the operand configured to control the output contact. While the selected 
operand is Off, the output behaves as it does when in service.

• If set to “Freeze,” the output retains its position at the instant before the TEST MODE FUNCTION was Forcible and the 
operand selected by the TEST MODE FORCING setting was On, regardless of later changes in the status of the operand 
configured to control the output contact. While the selected operand is Off, the output behaves as it does when in 
service.

5.14  Simulation

5.14.1  GOOSE & SV
SETTINGS  SIMULATION  GOOSE & SV

Prior to UR 7.7, when the UR TEST MODE FUNCTION is set to "Isolated" or "Forcible," the sim bit in the header of all 
transmitted GOOSE messages is set to "TRUE," so that the UR plays the simulator role during the testing and 
commissioning phases. The "Sim" data attribute in the relay is set (<MasterLD>/LPHD1.Sim.stVal = TRUE), so that if GOOSE 
messages are received with the "simulation" flag set, these are used in place of the normal messages. The quality attribute 
values that are transmitted via GOOSE services are set to "valid" + "test."

 FORCE CONTACT
 OUTPUTS  FORCE Cont Op 1

: Normal
Range: Normal, Energized, De-energized, Freeze

 FORCE Cont Op 2
: Normal

Range: Normal, Energized, De-energized, Freeze



 FORCE Cont Op xx
: Normal

Range: Normal, Energized, De-energized, Freeze

On restart, the TEST MODE FORCING setting and the force contact input and force contact output settings revert to 
their default states.

 GOOSE & SV
  Tx GOOSE Sim Mode:

Disabled
Range: Enabled, Disabled

 Sim q.Validity:
NONE

Range: NONE, QUESTIONABLE, INVALID, GOOD

 Sim q.Test:
NONE

Range: NONE, FALSE, TRUE

 Accept Sim GOOSE&SV:
Disabled

Range: Enabled, Disabled
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In UR 7.7 and later, the UR test mode and GOOSE simulation mode are isolated. The sim bit in the transmitted GOOSE 
messages and the relay "Sim" attribute (<MasterLD>/LPHD1.Sim.stVal) are controlled via new Modbus settings and MMS 
control requests. They no longer depend on the UR TEST MODE FUNCTION.

The settings also display in the software when the F60 is set to IEC 61850 Edition 2. When using IEC 61850 Edition 1, the 
settings are read-only. The fields that include SV apply to products with a Process Bus Module with order code 85, 86, or 87.

Tx GOOSE Sim Mode — When set to Disabled, the sim bit in all transmitted GOOSE messages are set to FALSE. When set to 
Enabled, the sim bit in all transmitted GOOSE messages are set to TRUE. This setting also is accessible from IEC 61850 
client control to <MasterLD>/LPHD1.TxGoSim.

Sim q.Validity — This setting simulates the validity bits of the quality attribute values included in all transmitted GOOSE 
messages. This setting is used when Tx GOOSE SimMode is set to Enabled. When this setting is set to None, the q.Validity bits 
are set based on the logical node behavior value. When set to any other value, the q.Validity bits of quality attributes 
included in all transmitted GOOSE messages are set to the selected value.

Sim q.Test — This setting simulates the Test bit of the quality attribute values included in all transmitted GOOSE messages. 
This setting is used when Tx GOOSE Sim Mode is set to Enabled. When this setting is set to None, the q.Test bit is set based on 
the relay TEST MODE FUNCTION. When set to any other value, the q.Test bit of quality attributes included in all transmitted 
GOOSE messages is set to the selected value.

Accept Sim GOOSE & SV — This setting controls whether the simulated GOOSE messages and SVs are accepted by the relay 
or not. This is how you replace and test a device when it fails and its connected merging units are in service. When set to 
Disabled, the relay "Sim" attribute (<MasterLD>/LPHD1.Sim.stVal) is set to False and the GOOSE and SV messages received 
with simulation flag set are ignored. When set to Enabled, the relay "Sim" attribute (<MasterLD>/LPHD1.Sim.stVal) is set to 
True, so that if GOOSE and/or SV messages are received with the "simulation" flag set to True, these are used in place of the 
normal messages. This setting also is accessible from an IEC 61850 client to be controlled via <MasterLD>/LPHD1.Sim.
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F60 Feeder Protection System

Chapter 6: Actual values

Actual values

This chapter outlines viewing of data on the front panel, software, and/or web browser.

6.1  Actual Values menu

 ACTUAL VALUES
 FRONT PANEL   

 
Access in EnerVista
See page 6-4


 ACTUAL VALUES
 STATUS   CONTACT INPUTS

 
See page 6-5

   VIRTUAL INPUTS
 

See page 6-5

  RxGOOSE BOOLEANS
 

See page 6-5

  RxGOOSE DPS
 

See page 6-6

  TELEPROTECTION
 INPUTS

See page 6-6

  CONTACT OUTPUTS
 

See page 6-6

  VIRTUAL OUTPUTS
 

See page 6-7

  AUTORECLOSE
 

See page 6-8

  RxGOOSE STATUS
 

See page 6-7

  RxGOOSE
 STATISTICS

See page 6-7

  DIGITAL COUNTERS
 

See page 6-8
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  SELECTOR SWITCHES
 

See page 6-8

  FLEX STATES
 

See page 6-8

  ETHERNET
 

See page 6-9

  REAL TIME CLOCK
 SYNCHRONIZING

See page 6-9

  HIZ STATUS
 

See page 6-10

  DIRECT INPUTS
 

See page 6-10

  DIRECT DEVICES
 STATUS

See page 6-11

  EGD PROTOCOL
 STATUS

See page 6-11

  TELEPROT CH TESTS
 

See page 6-11

  INCIPIENT FAULT
 

See page 6-12

  COMM STATUS
 REMAINING CONNECT

See page 6-12

  PRP STATUS
 

See page 6-13

  TxGOOSE STATUS
 

See page 6-13

   PROTOCOL
 

See page 6-14

 ACTUAL VALUES
 METERING   SOURCE SRC 1

 
See page 6-18

 

  SOURCE SRC 4
 

  SENSITIVE
 DIRECTIONAL POWER

See page 6-24

  SYNCHROCHECK
 

See page 6-24

  TRACKING FREQUENCY
 

See page 6-25

  FREQUENCY RATE
 OF CHANGE

See page 6-25

  FLEXELEMENTS
 

See page 6-25

  RxGOOSE Analogs
 

See page 6-26

  WATTMETRIC
 GROUND FAULT 1

See page 6-26
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For status reporting, ‘On’ represents Logic 1 and ‘Off’ represents Logic 0.

  WATTMETRIC
 GROUND FAULT 2

  PHASOR MEASUREMENT
 UNIT

See page 6-26

  PMU AGGREGATOR
 

See page 6-27

  RESTRICTED GROUND
 FAULT CURRENTS

See page 6-27

  TRANSDUCER I/O
 DCMA INPUTS

See page 6-27

   TRANSDUCER I/O
 RTD INPUTS

See page 6-27

 ACTUAL VALUES
 REMOTE RESOURCES   FIELD UNIT U1

 ID: U 1
See page 6-28



   FIELD UNIT U8
 ID: U 8

 ACTUAL VALUES
 PB MODULE   GENERAL STATUS

 
See page 6-28

   RxSV Status
 

See page 6-29

   TIME SYNC
 

See page 6-29

 ACTUAL VALUES
 RECORDS   FAULT REPORT

 
See page 6-30

   EVENT RECORDS
 

See page 6-31

  OSCILLOGRAPHY
 

See page 6-33

  DATA LOGGER
 

See page 6-33

  PMU
 RECORDS

See page 6-34

  MAINTENANCE
 

See page 6-34

   HIZ RECORDS
 

See page 6-35

 ACTUAL VALUES
 PRODUCT INFO   MODEL INFORMATION

 
See page 6-36

  FIRMWARE REVISIONS
 

See page 6-36



6-4 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

FRONT PANEL CHAPTER 6: ACTUAL VALUES

6

6.2  Front panel

6.2.1  Enhanced and basic front panels
The front panel can be viewed and used in the EnerVista software, for example to view an error message displayed on the 
front panel.

To view the front panel in EnerVista software:

1. Click Actual Values > Front Panel.

Figure 6-1: Front panel use in the software (C60 shown)

6.2.2  Graphical front panel

Annunciator alarms can be acknowledged and reset, and LEDs and pushbuttons can be viewed.

To view alarms for the graphical front panel in EnerVista:

1. Access Actual Values > Graphical Panel > Annunciator Panel. Alarms are listed, allowing remote acknowledgement/
reset.

2. Click the Acknowledge or Reset button for an alarm.

The graphical front panel is a hardware option.
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Figure 6-2: Annunciator alarms displayed in the software)

To view LEDs and pushbuttons on the graphical front panel in EnerVista:

1. Access Actual Values > Graphical Panel > LEDs or Pushbuttons. The window displays.

6.3  Status

6.3.1  Contact inputs
ACTUAL VALUES  STATUS  CONTACT INPUTS

The present status of the contact inputs is shown here. The first line of a message display indicates the ID of the contact 
input. For example, ‘Cont Ip 1’ refers to the contact input in terms of the default name-array index. The second line of the 
display indicates the logic state of the contact input.

6.3.2  Virtual inputs
ACTUAL VALUES  STATUS  VIRTUAL INPUTS

The present status of the 64 virtual inputs is shown here. The first line of a message display indicates the ID of the virtual 
input. For example, ‘Virt Ip 1’ refers to the virtual input in terms of the default name. The second line of the display indicates 
the logic state of the virtual input.

6.3.3  RxGOOSE boolean inputs
ACTUAL VALUES  STATUS  RxGOOSE BOOLEANS

 CONTACT INPUTS
  Cont Ip 1

Off
Range: On, Off



 Cont Ip xx
Off

Range: On, Off

 VIRTUAL INPUTS
  Virt Ip 1

Off
Range: On, Off




Virt Ip 64
Off

Range: On, Off

 RxGOOSE BOOLEANS
  RxGOOSE BOOLEAN 1

STATUS: Off
Range: On, Off



 RxGOOSE BOOLEAN 256
STATUS: Off

Range: On, Off
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6.3.4  RxGOOSE DPS inputs
ACTUAL VALUES  STATUS  RxGOOSE DPS

6.3.5  Teleprotection inputs
ACTUAL VALUES  STATUS  TELEPROTECTION INPUTS

The present state of teleprotection inputs from communication channels 1 and 2 are shown here. The state displayed is 
that of corresponding remote output unless the channel is declared failed.

6.3.6  Contact outputs
ACTUAL VALUES  STATUS  CONTACT OUTPUTS

The present state of the contact outputs is shown here. The first line of a message display indicates the ID of the contact 
output. For example, ‘Cont Op 1’ refers to the contact output in terms of the default name-array index. The second line of 
the display indicates the logic state of the contact output.

For form-A contact outputs, the state of the voltage and current detectors is displayed as Off, VOff, IOff, On, IOn, and VOn. 
For form-C contact outputs, the state is displayed as Off or On.

The F60 is provided with optional IEC 61850 capability. This feature is specified as a software option at the time 
of ordering. See the Order Codes section of chapter 2 for details.

 RxGOOSE DPS
  RxGOOSE DPS 1

Status: Intermediate
Range: On, Off, Intermediate, Bad



 RxGOOSE DPS 16
Status: Intermediate

Range: On, Off, Intermediate, Bad

The F60 is provided with optional IEC 61850 capability. This feature is specified as a software option at the time 
of ordering. See the Order Codes section of chapter 2 for details.

 TELEPROTECTION
 INPUTS  TELEPROTECTION

INPUT 1-1: Off
Range: On, Off



 TELEPROTECTION
INPUT 1-16: Off

Range: On, Off

 TELEPROTECTION
INPUT 2-1: Off

Range: On, Off




TELEPROTECTION
INPUT 2-16: Off

Range: On, Off

 CONTACT OUTPUTS
  Cont Op 1

Off
Range: On, Off, VOff, VOn, IOn, IOff



 Cont Op xx
Off

Range: On, Off, VOff, VOn, IOn, IOff
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6.3.7  Virtual outputs
ACTUAL VALUES  STATUS  VIRTUAL OUTPUTS

The present state of up to 96 virtual outputs is shown here. The first line of a message display indicates the ID of the virtual 
output. For example, ‘Virt Op 1’ refers to the virtual output in terms of the default name-array index. The second line of the 
display indicates the logic state of the virtual output, as calculated by the FlexLogic equation for that output.

6.3.8  RxGOOSE status
ACTUAL VALUES  STATUS  RxGOOSE STATUS

The All RxGOOSE Online actual value does not consider RxGOOSE that are not configured or are not used by any RxGOOSE 
Input.

6.3.9  RxGOOSE statistics
ACTUAL VALUES  STATUS  RxGOOSE STATISTICS  RxGOOSE 1(64)

stNum — State number. The most recently received value in GOOSE message field stNum. The publisher increments stNum 
each time that the state of one or more of the GOOSE message members is sent with a revised value.

sqNum — Sequence number. The most recently received value in GOOSE message field sqNum. The publisher sets sqNum 
to zero each time the state of one or more of the GOOSE message members is sent with a new value, and it increments it 
whenever a GOOSE message is resent without any member value change.

 VIRTUAL OUTPUTS
  Virt Op 1

Off
Range: On, Off



 Virt Op 96
Off

Range: On, Off

 RxGOOSE
 STATUS  All RxGOOSE Online:

Yes
Range: Yes, No

 RxGOOSE 1 Status:
Offline

Range: Online, Offline



 RxGOOSE 64 Status:
Offline

Range: Online, Offline

The F60 is provided with optional IEC 61850 capability. This feature is specified as a software option at the time 
of ordering. See the Order Codes section of chapter 2 for details.

 RxGOOSE 1
  RxGOOSE 1

stNum:                         0
Range: 0 up to 4,294,967,295

 RxGOOSE 1
sqNum:                        0

Range: 0 up to 4,294,967,295

 R-RxGOOSE 1
IGMP:                        Off

Range: On, Off

The F60 is provided with optional IEC 61850 capability. This feature is specified as a software option at the time 
of ordering. See the Order Codes section of chapter 2 for details.
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IGMP — Multicast (SSM and ASM) modes of R-GOOSE reception require that the F60 device subscribe to a multicast group 
over the Internet Group Management Protocol (IGMP) enabled network. R-RxGOOSE## IGMP status On indicates that IGMP 
negotiation with a network device (for example a router) was successful. In the case where setting R-RxGOOSE1 DST IP is 
configured to a multicast address and this status indicates Off, R-GOOSE reception cannot be successful, and therefore 
communication network diagnosis needs to be carried out. This status is relevant to R-GOOSE reception when configured 
for SSM or ASM reception modes. It is not relevant for GOOSE or for R-GOOSE in unicast reception mode.

6.3.10  Autoreclose
ACTUAL VALUES  STATUS  AUTORECLOSE  AUTORECLOSE 1(4)

This menu displays the reclosure shot count.

6.3.11  Digital counters
ACTUAL VALUES  STATUS  DIGITAL COUNTERS  DIGITAL COUNTERS Counter 1(8)

The present status of the eight digital counters displays here. The status of each counter, with the user-defined counter 
name, includes the accumulated and frozen counts (the count units label also appears). Also included, is the date and time 
stamp for the frozen count. The COUNTER 1 MICROS value refers to the microsecond portion of the time stamp.

6.3.12  Selector switches
ACTUAL VALUES  STATUS  SELECTOR SWITCHES

The display shows both the current position and the full range. The current position only (an integer from 0 through 7) is the 
actual value.

6.3.13  Flex States
ACTUAL VALUES  STATUS  FLEX STATES

There are 256 FlexStateTM bits available. The second line value indicates the state of the given FlexState bit.

 AUTORECLOSE 1
  AUTORECLOSE 1

SHOT COUNT: 0
Range: 0, 1, 2, 3, 4

 DIGITAL COUNTERS
 Counter 1  Counter 1 ACCUM:

0

 Counter 1  FROZEN:
0

 Counter 1 FROZEN:
1970/01/01 00:00:00

Range: YYYY/MM/DD HH:MM:SS

 Counter 1  MICROS:
0

Range: 0 to 4294967295 in steps of 1

 SELECTOR SWITCHES
  SELECTOR SWITCH 1

POSITION: 0/7
Range: Current Position / 7

 SELECTOR SWITCH 2
POSITION: 0/7

Range: Current Position / 7

 FLEX STATES
  PARAM 1: Off

Off
Range: On, Off



 PARAM 256: Off
Off

Range: On, Off
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6.3.14  Ethernet
ACTUAL VALUES  STATUS  ETHERNET

These values indicate the status of the first, second, and third Ethernet ports.

6.3.15  Real time clock synchronizing
ACTUAL VALUES  STATUS  REAL TIME CLOCK SYNCHRONIZING

RTC SYNC SOURCE actual value is the time synchronizing source the relay is using at present. Possible sources are Port 1 PTP 
Clock to Port 8 PTP Clock, CPU Clock, SV Sync Stream, and None. An actual value displays when the relay includes the IEEE 
1588 software option.

The GRANDMASTER ID is the grandmasterIdentity code being received from the present PTP grandmaster, if any. When the 
relay is not using any PTP grandmaster, this actual value is zero. The grandmasterIdentity code is specified by PTP to be 
globally unique, so one can always know which clock is grandmaster in a system with multiple grandmaster-capable 
clocks.

ACCURACY is the estimated maximum time error at present in the RTC, considering the quality information imbedded in the 
received time signal. The value 999,999,999 indicates that the magnitude of the estimated error is one second or more, or 
that the error cannot be estimated.

PORT 1…3 PTP STATE is the present state of the port’s PTP clock. The PTP clock state is:

• Disabled if the port’s function setting is Disabled

• No Signal if enabled but no signal from an active master has been found and selected

• Calibrating if an active master has been selected but lock is not at present established

• Synch’d (No Pdelay) if the port is synchronized, but the peer delay mechanism is non-operational

• Synchronized if synchronized

 ETHERNET
  ETHERNET PRI LINK

STATUS: Fail
Range: Fail, OK

 ETHERNET SEC LINK
STATUS: OK

Range: Fail, OK

 ETHERNET TER LINK
STATUS: Fail

Range: Fail, OK

 REAL TIME CLOCK
 SYNCHRONIZING  RTC SYNC SOURCE:

None
Range: see below

 GRANDMASTER ID:
0X0000000000000000

Range: any 8 octet value

 ACCURACY:
999999999 ns

Range: 0 to 999,999,999 ns

 PORT 1 PTP STATE:
No Signal

Range: Disabled, No Signal, Calibrating, Synch’d (No 
Pdelay), Synchronized

 PORT 2 PTP STATE:
No Signal

Range: Disabled, No Signal, Calibrating, Synch’d (No 
Pdelay), Synchronized

 PORT 3 PTP STATE:
No Signal

Range: Disabled, No Signal, Calibrating, Synch’d (No 
Pdelay), Synchronized

 PTP - IRIG-B DELTA:
500000000 ns

Range: -500,000,000 to +500,000,000 ns

This item displays in the software when the product includes an IEEE 1588 software option.
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PTP - IRIG-B DELTA is the time difference, measured in nanoseconds, between the fractional seconds portion of the time 
being received via PTP and that being received via IRIG-B. A positive value indicates that PTP time is fast compared to IRIG-
B time.

6.3.16  Hi-Z status
ACTUAL VALUES  STATUS  HIZ STATUS

The current status of high-impedance fault detection element displayS here. The arc fault detection confidence also 
displays.

6.3.17  Direct inputs
ACTUAL VALUES  STATUS  DIRECT INPUTS

The AVERAGE MSG RETURN TIME is the time taken for direct output messages to return to the sender in a direct input/output 
ring configuration (this value is not applicable for non-ring configurations). This is a rolling average calculated for the last 
ten messages. There are two return times for dual-channel communications modules.

The UNRETURNED MSG COUNT values (one per communications channel) count the direct output messages that do not 
make the trip around the communications ring. The CRC FAIL COUNT values (one per communications channel) count the 
direct output messages that have been received but fail the CRC check. High values for either of these counts can indicate 
on a problem with wiring, the communication channel, or one or more relays. The UNRETURNED MSG COUNT and CRC FAIL 
COUNT values can be cleared using the CLEAR DIRECT I/O COUNTERS command.

The DIRECT INPUT 1 to DIRECT INPUT (32) values represent the state of each direct input.

 HIZ STATUS
  HIZ STATUS:

NORMAL
Range: Normal, Coordination Timeout, Armed, 
Arcing, Down Conductor

 ARC CONFIDENCE A:100
B:100 C:100 N:100 %

 DIRECT INPUTS
  AVERAGE MSG RETURN

TIME CH1: 0 ms

 UNRETURNED MSG
COUNT CH1: 0

 CRC FAIL COUNT
CH1: 0

 AVERAGE MSG RETURN
TIME CH2: 0 ms

 UNRETURNED MSG
COUNT CH2: 0

 CRC FAIL COUNT
CH2: 0

 DIRECT INPUT 1:
On



 DIRECT INPUT 32:
On
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6.3.18  Direct devices status
ACTUAL VALUES  STATUS  DIRECT DEVICES STATUS

These actual values represent the state of direct devices 1 through 16.

6.3.19  EGD protocol status

6.3.19.1  Fast exchange
ACTUAL VALUES  STATUS  EGD PROTOCOL STATUS  PRODUCER STATUS  FAST EXCHANGE 1

These values provide information for debugging an Ethernet Global Data (EGD) network. The EGD signature and packet size 
for the fast EGD exchange display.

6.3.19.2  Slow exchange
ACTUAL VALUES  STATUS  EGD PROTOCOL STATUS  PRODUCER STATUS  SLOW EXCHANGE 1(2)

These values provide information for debugging an EGD network. The EGD signature and packet size for the slow EGD 
exchanges display.

6.3.20  Teleprotection channel tests
ACTUAL VALUES  STATUS  TELEPROT CH TESTS

The status information for two channels is shown here.

 DIRECT DEVICES
 STATUS  DIRECT DEVICE 1

STATUS: Offline
Range: Offline, Online



 DIRECT DEVICE 16
STATUS: Offline

Range: Offline, Online

 FAST EXCHANGE 1
  FAST EXCHANGE 1

SIGNATURE: 0

 FAST EXCHANGE 1
DATA LENGTH: 0

 SLOW EXCHANGE 1
  SLOW EXCHANGE 1

SIGNATURE: 0

 SLOW EXCHANGE 1
DATA LENGTH: 0

 TELEPROT CH TESTS
  CHANNEL 1

STATUS: n/a
Range: n/a, FAIL, OK

 CHANNEL 1 LOST
PACKETS: 1

Range: 1 to 65535 in steps of 1

 CHANNEL 2
STATUS: n/a

Range: n/a, FAIL, OK

 CHANNEL 2 LOST
PACKETS: 1

Range: 1 to 65535 in steps of 1

 VALIDITY OF CHANNEL
CONFIGURATION: FAIL

Range: n/a, FAIL, OK
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CHANNEL 1 STATUS — This represents the receiver status of each channel. If the value is “OK,” teleprotection is enabled and 
data is being received from the remote terminal; If the value is “FAIL,” teleprotection enabled and data is not being received 
from the remote terminal. If “n/a,” teleprotection is disabled.

CHANNEL 1 LOST PACKETS — Data is transmitted to the remote terminals in data packets at a rate of two packets per cycle. 
The number of lost packets represents data packets lost in transmission; this count can be reset to 0 through the 
COMMANDS  CLEAR RECORDS menu.

VALIDITY OF CHANNEL CONFIGURATION — This value displays the current state of the communications channel identification 
check, and hence validity. If a remote relay ID does not match the programmed ID at the local relay, the “FAIL” message 
displays. The “N/A” value appears if the local relay ID is set to a default value of “0,” the channel is failed, or if the 
teleprotection inputs/outputs are not enabled.

6.3.21  Incipient fault detector
ACTUAL VALUES  STATUS  INCIPIENT FAULT  INCIPIENT FAULT 1(2)

The number of detected incipient faults for each incipient fault element are displayed here for each phase. These values 
can be reset to zero with the COMMANDS  CLEAR RECORDS  CLEAR INCIPENT FAULT COUNTERS command.

6.3.22  Remaining connection status
ACTUAL VALUES  STATUS  COMM STATUS REMAINING CONNECT

These values specify the remaining number of TCP connections still available for each protocol. The display depends on the 
options applicable to your device. Each time a connection is used, the remaining number of connections decrements. 
When released, the remaining number of connections increments. If no connection is made over the specific protocol, the 
number equals the maximum number available for the specific protocol.

For example, the maximum number of Modbus TCP connections is 4. Once an EnerVista session is opened on a computer 
connected to the UR over Ethernet, the Modbus TCP status shows 3. If the EnerVista application is closed, the Modbus TCP 
status shows 4.

For the graphical front panel, the remaining connections refer to TCP connections only.

MMS TCP — The number of IEC 61850 connections remaining.

 INCIPIENT FAULT 1
  INCIPIENT FAULT 1

PH A FAULTS: 0
Range: 0 to 65535 in steps of 1

 INCIPIENT FAULT 1
PH B FAULTS: 0

Range: 0 to 65535 in steps of 1

 INCIPIENT FAULT 1
PH C FAULTS: 0

Range: 0 to 65535 in steps of 1

 COMM STATUS 
 REMAINING CONNECT  MMS TCP (max 5)

5
Range: 0 to 5

 MODBUS TCP (max 4)
4

Range: 0 to 4

 DNP TCP (max 2)
2

Range: 0 to 2

 IEC-104 TCP (max 2)
2

Range: 0 to 2

 PMU TCP
1

Range: 1 to 4

 SFTP (max 4)
4

Range: 0 to 4
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PMU TCP — The maximum number of PMU TCP connections matches the number of aggregators. The maximum number of 
aggregators for the N60 is 4. The maximum number for the C60 is 2. The maximum number is 1 for other products with a 
PMU. The remaining number of aggregators displays here.

6.3.23  Parallel Redundancy Protocol (PRP)
The Parallel Redundancy Protocol (PRP) defines a redundancy protocol for high availability in substation automation 
networks.

ACTUAL VALUES  STATUS  PRP STATUS

Total Received Port A is a counter for total messages received (either from DANPs or from SANs) on Port A.

Total Received Port B is a counter for total messages received (either from DANPs or from SANs) on Port B.

Total Errors is a counter for total messages received with an error (bad port code, frame length too short).

Mismatches Port A is a counter for total messages received with an error on Port A (PRP frame, but port received through 
and LAN ID in the frame do not match).

Mismatches Port B is a counter for total messages received with an error on Port B (PRP frame, but port received through 
and LAN ID in the frame do not match).

6.3.24  TxGOOSE status
ACTUAL VALUES  STATUS  TxGOOSE STATUS

This status is relevant to R-GOOSE reception when configured for SSM or ASM reception modes. It is not relevant for GOOSE 
or for R-GOOSE in unicast reception mode.

ARP — The unicast mode of R-GOOSE transmission requires Address Resolution Protocol (ARP) for the resolution of the 
network layer address into the MAC layer address. R-TxGOOSE## ARP status On indicates that ARP responses are being 
received and the destination MAC address for R-GOOSE transmissions has been obtained. This status remains Off if 

 PRP STATUS
  Total Rx Port A:

0
Range: 0 to 4G, blank if PRP disabled

 Total Rx Port B:
0

Range: 0 to 4G, blank if PRP disabled

 Mismatches Port A:
0

Range: 0 to 4G, blank if PRP disabled

 Mismatches Port B:
0

Range: 0 to 4G, blank if PRP disabled

 Total Errors:
0

Range: 0 to 4G, blank if PRP disabled

The F60 is provided with optional PRP capability. This feature is specified as a software option at the time of 
ordering. See the Order Codes section in chapter 2 for details.

 TxGOOSE STATUS
  R-TxGOOSE 1

ARP:                         Off
Range: On, Off



 R-TxGOOSE 16
ARP:                         Off

Range: On, Off

The F60 is provided with optional IEC 61850 capability. This feature is specified as a software option at the time 
of ordering. See the Order Codes section of chapter 2 for details.
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TxGOOSE## is not configured for R-GOOSE. It also remains Off if setting R-TxGOOSE1 DST IP is set to a multicast address. In 
the case where setting R-TxGOOSE1 DST IP is configured with a unicast address and this status indicates Off, TxGOOSE## 
transmission will be off, and therefore communication network diagnosis needs to be carried out.

This status is only applicable for R-GOOSE transmission with setting R-TxGOOSE1 DST IP set to a unicast IP address. It is not 
applicable for GOOSE or for R-GOOSE when setting R-TxGOOSE1 DST IP is multicast.

6.3.25  Protocol
ACTUAL VALUES  STATUS  PROTOCOL

Displays the IEC 61850 edition currently being used, as set under Settings > Product Setup > Communications > Protocol 
> IEC61850 SCL Edition. This value displays only on the front panel.

6.4  Metering

6.4.1  Metering conventions

6.4.1.1  UR convention for measuring power and energy
The figure illustrates the conventions established for use in UR devices.

 PROTOCOL
  IEC61850 EDITION:

Edition2
Range: Edition1, Edition2

The F60 is provided with optional IEC 61850 capability. This feature is specified as a software option at the time 
of ordering. See the Order Codes section of chapter 2 for details.
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Figure 6-3: Flow direction of signed values for watts and VARs 

6.4.1.2  UR convention for measuring phase angles
All phasors calculated by URs and used for protection, control and metering functions are rotating phasors that maintain 
the correct phase angle relationships with each other at all times.

For display and oscillography purposes, all phasor angles in a given relay are referred to an AC input channel pre-selected 
by the SETTINGS  SYSTEM SETUP  POWER SYSTEM  FREQUENCY AND PHASE REFERENCE setting. This setting defines a 
particular AC signal source to be used as the reference.
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The relay first determines if any “Phase VT” bank is indicated in the source. If it is, voltage channel VA of that bank is used 
as the angle reference. Otherwise, the relay determines if any “Aux VT” bank is indicated; if it is, the auxiliary voltage 
channel of that bank is used as the angle reference. If neither of the two conditions is satisfied, then two more steps of this 
hierarchical procedure to determine the reference signal include “Phase CT” bank and “Ground CT” bank.

If the AC signal pre-selected by the relay upon configuration is not measurable, the phase angles are not referenced. The 
phase angles are assigned as positive in the leading direction, and are presented as negative in the lagging direction, to 
more closely align with power system metering conventions. The figure illustrates this.

Figure 6-4: UR phase angle measurement convention 

6.4.1.3  UR convention for symmetrical components
The URs calculate voltage symmetrical components for the power system phase A line-to-neutral voltage, and 
symmetrical components of the currents for the power system phase A current. Owing to the above definition, phase 
angle relations between the symmetrical currents and voltages stay the same irrespective of the connection of instrument 
transformers. This is important for setting directional protection elements that use symmetrical voltages.

For display and oscillography purposes the phase angles of symmetrical components are referenced to a common 
reference as described in the previous sub-section.

WYE-connected instrument transformers

The above equations apply to currents as well.

• ABC phase rotation: • ACB phase rotation:

V_0 1
3
-- VAG VBG VCG+ +=

V_1 1
3
-- VAG aVBG a2VCG+ +=

V_2 1
3
-- VAG a2VBG aVCG+ +=

V_0 1
3
-- VAG VBG VCG+ +=

V_1 1
3
-- VAG a2VBG aVCG+ +=

V_2 1
3
-- VAG aVBG a2VCG+ +=
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DELTA-connected instrument transformers

The zero-sequence voltage is not measurable under the Delta connection of instrument transformers and is defaulted to 
zero. The table below shows an example of symmetrical components calculations for the ABC phase rotation.

Table 6-1: Symmetrical components calculation example

*  The power system voltages are phase-referenced – for simplicity – to VAG and VAB, respectively. This, however, is a 
relative matter. It is important to remember that the F60 displays are always referenced as specified under SETTINGS  
SYSTEM SETUP  POWER SYSTEM  FREQUENCY AND PHASE REFERENCE.

The example above is illustrated in the following figure.

Figure 6-5: Measurement convention for symmetrical components 

• ABC phase rotation: • ACB phase rotation:

SYSTEM VOLTAGES, sec. V * VT conn. relay INPUTS, sec. V SYMM. COMP, sec. V

VAG VBG VCG VAB VBC VCA F5ac F6ac F7ac V0 V1 V2

13.9
0°

76.2
–125°

79.7
–250°

84.9
–313°

138.3
–97°

85.4
–241°

WYE 13.9
0°

76.2
–125°

79.7
–250°

19.5
–192°

56.5
–7°

23.3
–187°

UNKNOWN (only V1 and V2 
can be determined)

84.9
0°

138.3
–144°

85.4
–288°

DELTA 84.9
0°

138.3
–144°

85.4
–288°

N/A 56.5
–54°

23.3
–234°

V_0 N/A=

V_1 1 30–

3 3
------------------ VAB aVBC a2VCA+ +=

V_2 1 30
3 3

--------------- VAB a2VBC aVCA+ +=

V_0 N/A=

V_1 1 30
3 3

--------------- VAB a2VBC aVCA+ +=

V_2 1 30–

3 3
------------------ VAB aVBC a2VCA+ +=
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6.4.2  Sources

6.4.2.1  Menu
ACTUAL VALUES  METERING  SOURCE SRC 1

This menu displays the metered values available for each source.

Metered values presented for each source depend on the phase and auxiliary VTs and phase and ground CTs assignments 
for this particular source. For example, if no phase VT is assigned to this source, then any voltage, energy, and power 
values are unavailable.

6.4.2.2  Phase current metering
ACTUAL VALUES  METERING  SOURCE SRC 1  PHASE CURRENT

 SOURCE SRC 1
   PHASE CURRENT

 SRC 1
See below

  GROUND CURRENT
 SRC 1

See page 6-19

  PHASE VOLTAGE
 SRC 1

See page 6-19

  AUXILIARY VOLTAGE
 SRC 1

See page 6-20

  POWER
 SRC 1

See page 6-20

  ENERGY
 SRC 1

See page 6-21

  DEMAND
 SRC 1

See page 6-21

  FREQUENCY
 SRC 1

See page 6-22

  CURRENT HARMONICS
 SRC 1

See page 6-23

  VOLTAGE HARMONICS
 SRC 1

See page 6-23

 PHASE CURRENT 
 SRC 1  SRC 1 RMS Ia: 0.000

b: 0.000 c: 0.000 A

 SRC 1 RMS Ia:
0.000 A

 SRC 1 RMS Ib:
0.000 A

 SRC 1 RMS Ic:
0.000 A

 SRC 1 RMS In:
0.000 A

 SRC 1 PHASOR Ia:
0.000 A 0.0°

 SRC 1 PHASOR Ib:
0.000 A 0.0°

 SRC 1 PHASOR Ic:
0.000 A 0.0°
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The metered phase current values are displayed in this menu. The "SRC 1" text gets replaced by whatever name was 
programmed by the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES).

6.4.2.3  Ground current metering
ACTUAL VALUES  METERING  SOURCE SRC 1  GROUND CURRENT

The metered ground current values are displayed in this menu. The "SRC 1" text is replaced by the name programmed by 
the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES).

6.4.2.4  Phase voltage metering
ACTUAL VALUES  METERING  SOURCE SRC 1  PHASE VOLTAGE

 SRC 1 PHASOR In:
0.000 A 0.0°

 SRC 1 ZERO SEQ I0:
0.000 A 0.0°

 SRC 1 POS SEQ I1:
0.000 A 0.0°

 SRC 1 NEG SEQ I2:
0.000 A 0.0°

 GROUND CURRENT 
 SRC 1  SRC 1 RMS Ig:

0.000 A

 SRC 1 PHASOR Ig:
0.000 A 0.0°

 SRC 1 PHASOR Igd:
0.000 A 0.0°

 PHASE VOLTAGE 
 SRC 1  SRC 1 RMS Vag:

0.00 V

 SRC 1 RMS Vbg:
0.00 V

 SRC 1 RMS Vcg:
0.00 V

 SRC 1 PHASOR Vag:
0.000 V 0.0°

 SRC 1 PHASOR Vbg:
0.000 V 0.0°

 SRC 1 PHASOR Vcg:
0.000 V 0.0°

 SRC 1 RMS Vab:
0.00 V

 SRC 1 RMS Vbc:
0.00 V

 SRC 1 RMS Vca:
0.00 V

 SRC 1 PHASOR Vab:
0.000 V 0.0°

 SRC 1 PHASOR Vbc:
0.000 V 0.0°
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The metered phase voltage values are displayed in this menu. The "SRC 1" text is replaced by the name programmed by 
the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES).

6.4.2.5  Auxiliary voltage metering
ACTUAL VALUES  METERING  SOURCE SRC 1  AUXILIARY VOLTAGE

The metered auxiliary voltage values are displayed in this menu. The "SRC 1" text is replaced by the name programmed by 
the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES).

6.4.2.6  Power metering
ACTUAL VALUES  METERING  SOURCE SRC 1  POWER

 SRC 1 PHASOR Vca:
0.000 V 0.0°

 SRC 1 ZERO SEQ V0:
0.000 V 0.0°

 SRC 1 POS SEQ V1:
0.000 V 0.0°

 SRC 1 NEG SEQ V2:
0.000 V 0.0°

 AUXILIARY VOLTAGE 
 SRC 1  SRC 1 RMS Vx:

0.00 V

 SRC 1 PHASOR Vx:
0.000 V 0.0°

 POWER
 SRC 1  SRC 1 REAL POWER

3: 0.000 W

 SRC 1 REAL POWER
a: 0.000 W

 SRC 1 REAL POWER
b: 0.000 W

 SRC 1 REAL POWER
c: 0.000 W

 SRC 1 REACTIVE PWR
3: 0.000 var

 SRC 1 REACTIVE PWR
a: 0.000 var

 SRC 1 REACTIVE PWR
b: 0.000 var

 SRC 1 REACTIVE PWR
c: 0.000 var

 SRC 1 APPARENT PWR
3: 0.000 VA

 SRC 1 APPARENT PWR
a: 0.000 VA

 SRC 1 APPARENT PWR
b: 0.000 VA

 SRC 1 APPARENT PWR
c: 0.000 VA
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This menu displays metered values for real, reactive, and apparent power, as well as power factor. The "SRC 1" text is 
replaced by the name programmed by the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL 
SOURCES).

When VTs are configured in wye, the F60 calculates power in each phase and three-phase power is measured as

S = VA x ÎA + VB x ÎB + VC x ÎC Eq. 6-1

When VTs are configured in delta, the F60 does not calculate power in each phase and three-phase power is measured as

S = VAB x ÎA + VCB x ÎC Eq. 6-2

where

S is the apparent power

VA, VB, VC, IA, IB, IC are phase voltage and phase current phasors

VAB and VCB are phase-to-phase voltage phasors

Î is the conjugate of I

6.4.2.7  Energy metering
ACTUAL VALUES  METERING  SOURCE SRC 1  ENERGY

This menu displays metered values for real and reactive energy. The "SRC 1" text is replaced by the name programmed by 
the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES). Because energy values are 
accumulated, record them and then reset them immediately prior to changing CT or VT characteristics.

6.4.2.8  Demand metering
ACTUAL VALUES  METERING  SOURCE SRC 1  DEMAND

 SRC 1 POWER FACTOR
3: 1.000

 SRC 1 POWER FACTOR
a: 1.000

 SRC 1 POWER FACTOR
b: 1.000

 SRC 1 POWER FACTOR
c: 1.000

 ENERGY
 SRC 1  SRC 1 POS WATTHOUR:

0.000 Wh

 SRC 1 NEG WATTHOUR:
0.000 Wh

 SRC 1 POS VARHOUR:
0.000 varh

 SRC 1 NEG VARHOUR:
0.000 varh

 DEMAND
 SRC 1  SRC 1 DMD IA:

0.000 A

 SRC 1 DMD IA MAX:
0.000 A

 SRC 1 DMD IA DATE:
2001/07/31 16:30:07

 SRC 1 DMD IB:
0.000 A
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This menu displays metered values for current and power demand. The "SRC 1" text is replaced by the name programmed 
by the user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES).

The relay measures (absolute values only) the source demand on each phase and average three phase demand for real, 
reactive, and apparent power. These parameters can be monitored to reduce supplier demand penalties or for statistical 
metering purposes. Demand calculations are based on the measurement type selected in the SETTINGS  PRODUCT SETUP 
 DEMAND menu. For each quantity, the relay displays the demand over the most recent demand time interval, the 
maximum demand since the last maximum demand reset, and the time and date stamp of this maximum demand value. 
Maximum demand quantities can be reset to zero with the CLEAR RECORDS  CLEAR DEMAND RECORDS command.

6.4.2.9  Frequency metering
ACTUAL VALUES  METERING  SOURCE SRC 1  FREQUENCY

The metered frequency values are displayed in this menu. The "SRC 1" text is replaced by the name programmed by the 
user for the associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES).

SOURCE FREQUENCY is measured via software-implemented zero-crossing detection of an AC signal. The signal is either a 
Clarke transformation of three-phase voltages or currents, auxiliary voltage, or ground current as per source configuration 
(see the SYSTEM SETUP  POWER SYSTEM settings). The signal used for frequency estimation is low-pass filtered. The final 
frequency measurement is passed through a validation filter that eliminates false readings due to signal distortions and 
transients.

 SRC 1 DMD IB MAX:
0.000 A

 SRC 1 DMD IB DATE:
2001/07/31 16:30:07

 SRC 1 DMD IC:
0.000 A

 SRC 1 DMD IC MAX:
0.000 A

 SRC 1 DMD IC DATE:
2001/07/31 16:30:07

 SRC 1 DMD W:
0.000 W

 SRC 1 DMD W MAX:
0.000 W

 SRC 1 DMD W DATE:
2001/07/31 16:30:07

 SRC 1 DMD VAR:
0.000 var

 SRC 1 DMD VAR MAX:
0.000 var

 SRC 1 DMD VAR DATE:
2001/07/31 16:30:07

 SRC 1 DMD VA:
0.000 VA

 SRC 1 DMD VA MAX:
0.000 VA

 SRC 1 DMD VA DATE:
2001/07/31 16:30:07

 FREQUENCY 
 SRC 1  SRC 1 FREQUENCY:

0.00 Hz
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6.4.2.10  Current harmonics and THD metering
ACTUAL VALUES  METERING  SOURCE SRC 1  CURRENT HARMONICS

This menu displays metered current harmonics values. The "SRC 1" text is replaced by the name was programmed for the 
associated source (see SETTINGS  SYSTEM SETUP  SIGNAL SOURCES). Current harmonics are measured for each source 
for the total harmonic distortion (THD) and 2nd to 25th harmonics per phase.

6.4.2.11  Voltage harmonics and THD metering
ACTUAL VALUES  METERING  SOURCE SRC 1  VOLTAGE HARMONICS

This menu displays metered voltage harmonics values. The “SRC 1” text is replaced by the programmed name for the 
associated source (see the SETTINGS  SYSTEM SETUP  SIGNAL SOURCES menu).

To extract the 2nd to 25th voltage harmonics, each harmonic is computed on a per-phase basis, where:

N = 64 is the number of samples per cycle
0 = 2f is the angular frequency based on the system frequency (50 or 60 Hz)
k = 1, 2,..., N – 1 is the index over one cycle for the Fast Fourier Transform (FFT)
m is the last sample number for the sliding window
h = 1, 2,..., 25 is the harmonic number

The short-time Fourier transform is applied to the unfiltered signal:

Eq. 6-3

The harmonics are a percentage of the fundamental signal obtained as a ratio of harmonic amplitude to fundamental 
amplitude multiplied by 100%. The total harmonic distortion (THD) is the ratio of the total harmonic content to the 
fundamental:

Eq. 6-4

 CURRENT HARMONICS
 SRC 1  SRC 1 THD Ia: 0.0

Ib: 0.0 Ic: 0.0%

 SRC 1 2ND Ia: 0.0
Ib: 0.0 Ic: 0.0%

 SRC 1 3RD Ia: 0.0
Ib: 0.0 Ic: 0.0%



 SRC 1 25TH Ia: 0.0
Ib: 0.0 Ic: 0.0%

 VOLTAGE HARMONICS
 SRC 1  SRC 1 THD Va: 0.0

Vb: 0.0 Vc: 0.0%

 SRC 1 2ND Va: 0.0
Vb: 0.0 Vc: 0.0%

 SRC 1 3RD Va: 0.0
Vb: 0.0 Vc: 0.0%



 SRC 1 25TH Va: 0.0
Vb: 0.0 Vc: 0.0%

Freal m h, 2
N
--- f m k– h 0 t kcos

k

=

Fimag m h, 2
N
--- f m k– h 0 t ksin

k

=

Fampl m h, Freal m h, 2 Fimag m h, 2+=

THD F2
2 F3

2 F25
2+ + +=
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6.4.3  Sensitive directional power
ACTUAL VALUES  METERING  SENSITIVE DIRECTIONAL POWER  DIRECTIONAL POWER 1(2)

The effective operating quantities of the sensitive directional power elements display here. The display is useful to calibrate 
the feature by compensating the angular errors of the CTs and VTs with the use of the RCA and CALIBRATION settings.

6.4.4  Synchrocheck
ACTUAL VALUES  METERING  SYNCHROCHECK  SYNCHROCHECK 1(4)

If synchrocheck or a setting is "Disabled," the corresponding actual values menu item does not display.

Voltage harmonics are not available on F60 relays configured with the high-impedance fault detection (Hi-Z) 
feature.

Voltage harmonics are calculated only for Wye connected phase VTs. Ensure that the SYSTEM SETUP  AC INPUTS 
 VOLTAGE BANK F5  PHASE VT XX CONNECTION setting is “Wye” to enable voltage harmonics metering.

 DIRECTIONAL
 POWER 1  DIRECTIONAL POWER 1

3: 0.000 W

 SYNCHROCHECK 1
  SYNCHROCHECK 1 DELTA

VOLT: 0.000 kV

 SYNCHROCHECK 1 DELTA
FREQ: 0.00 Hz

 SYNCHROCHECK 1
DELTA PHASE: 0.0°

 SYNCHROCHECK 1
SYNSCP D_PH: 0.0°

 SYNCHROCHECK 1
V1 MAG: 0.000 kv

 SYNCHROCHECK 1
V1 ANG: 0.0°

 SYNCHROCHECK 1
V2 MAG: 0.000 kV

 SYNCHROCHECK 1
V2 ANG: 0.0°

 SYNCHROCHECK 1 PROJ
V2 MAG: 0.000 kV

 SYNCHROCHECK 1 PROJ
V2 ANG: 0.0°

 SYNCHROCHECK 1 PROJ
DELTA_PHASE: 0.0°

 SYNCHROCHECK 1 PROJ
SYNSCP D_PH: 0.0°
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6.4.5  Tracking frequency
ACTUAL VALUES  METERING  TRACKING FREQUENCY

The tracking frequency displays here. The frequency is tracked based on the selection of the reference source with the 
FREQUENCY AND PHASE REFERENCE setting in the SETTINGS  SYSTEM SETUP  POWER SYSTEM menu. See the Power 
System section of chapter 5 for details.

6.4.6  Frequency rate of change
ACTUAL VALUES  METERING  FREQUENCY RATE OF CHANGE 1(4)

The metered frequency rate of change for the frequency rate of change elements is shown here.

6.4.7  FlexElements
ACTUAL VALUES  METERING  FLEXELEMENTS  FLEXELEMENT 1(8)

The operating signals for the FlexElements are displayed in pu values using the following definitions of the base units.

Table 6-2: FlexElement base units

 TRACKING FREQUENCY 
  TRACKING FREQUENCY:

60.00 Hz

 FREQUENCY RATE
 OF CHANGE 1  FREQUENCY RATE OF

CHANGE1: 0.00 Hz/s

 FLEXELEMENT 1 
  FLEXELEMENT 1

OpSig: 0.000

Base unit Description

BREAKER ACC ARCING AMPS
(Brk X Acc Arc Amp A, B, and C)

BASE = 2000 kA2  cycle

BREAKER ARCING AMPS
(Brk X Arc Amp A, B, and C)

BASE = 1 kA2  cycle

DCmA BASE = maximum value of the DCMA INPUT MAX setting for the two transducers configured 
under the +IN and –IN inputs.

FAULT LOCATION BASE = Line Length as specified in Fault Report

FREQUENCY fBASE = 1 Hz

FREQUENCY RATE OF CHANGE df/dtBASE = 1 Hz/s

PHASE ANGLE BASE = 360 degrees (see the UR angle referencing convention)

POWER FACTOR PFBASE = 1.00

RTDs BASE = 100°C

SENSITIVE DIR POWER
(Sns Dir Power)

PBASE = maximum value of 3  VBASE  IBASE for the +IN and –IN inputs of the sources configured 
for the sensitive power directional element(s).

SOURCE CURRENT IBASE = maximum nominal primary RMS value of the +IN and –IN inputs

SOURCE ENERGY
(Positive and Negative Watthours, 
Positive and Negative Varhours)

EBASE = 10000 MWh or MVAh, respectively

SOURCE POWER PBASE = maximum value of VBASE  IBASE for the +IN and –IN inputs

SOURCE THD & HARMONICS BASE = 1%

SOURCE VOLTAGE VBASE = maximum nominal primary RMS value of the +IN and –IN inputs

SYNCHROCHECK
(Max Delta Volts)

VBASE = maximum primary RMS value of all the sources related to the +IN and –IN inputs
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6.4.8  RxGOOSE analogs
ACTUAL VALUES  METERING  RxGOOSE Analogs

The RxGOOSE Analog values display in this menu. The RxGOOSE Analog values are received via IEC 61850 GOOSE 
messages sent from other devices.

6.4.9  Wattmetric ground fault
ACTUAL VALUES  METERING  WATTMETRIC GROUND FAULT 1(2)

This menu displays the wattmetric zero-sequence directional element operating power values.

6.4.10  Phasor Measurement Unit
ACTUAL VALUES  METERING  PHASOR MEASURMENT UNIT  PMU 1

 RxGOOSE
 Analogs  RxGOOSE Analog 1

0.000



 RxGOOSE Analog 32
0.000

The F60 is provided with optional GOOSE communications capability. This feature is specified as a software 
option at the time of ordering. See the Order Codes section of chapter 2 for details.

 WATTMETRIC
 GROUND FAULT 1  WATT GND FLT 1:

0.000 W

 PMU 1
  PMU 1 VA:

0.000 V 0.00°
Range: Va or Vab per VT bank connection

 PMU 1 VB:
0.000 V 0.00°

Range: Va or Vab per VT bank connection

 PMU 1 VC:
0.000 V 0.00°

Range: Va or Vab per VT bank connection

 PMU 1 VX:
0.000 V 0.00°

 PMU 1 V1:
0.000 V 0.00°

 PMU 1 V2:
0.000 V 0.00°

 PMU 1 V0:
0.000 V 0.00°

Range: Substituted with zero if delta-connected VTs

 PMU 1 IA:
0.000 A 0.00°

 PMU 1 IB:
0.000 A 0.00°

 PMU 1 IC:
0.000 A 0.00°

 PMU 1 IG:
0.000 A 0.00°
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These actual values display without the corresponding time stamp as they become available per the recording rate 
setting. Also, the recording post-filtering setting is applied to these values.

6.4.11  PMU aggregator
ACTUAL VALUES  METERING  PHASOR MEASURMENT UNIT  PMU AGGREGATOR 1

Actual values for the IEC 61850-90-5 PDU size are provided. These values allow you to know the approximate Ethernet 
frame size for the data streams from each aggregator. This can help to estimate network loading. The PDU size shown in 
the displays does not include the Ethernet, UDP, or IP layers. PDU sizes approaching approximately 1500 bytes result in 
fragmented data frames, causing increased network traffic.

6.4.12  Restricted ground fault
ACTUAL VALUES  METERING  RESTRICTED GROUND FAULT CURRENTS  RESTRICTED GROUND FAULT 1(4)

This menu displays the differential and restraint current values for the restricted ground fault element.

6.4.13  Transducer inputs and outputs
ACTUAL VALUES  METERING  TRANSDUCER I/O DCMA INPUTS  DCMA INPUT xx

Actual values for each DCmA input channel that is enabled are displayed with the top line as the programmed channel ID 
and the bottom line as the value followed by the programmed units.

ACTUAL VALUES  METERING  TRANSDUCER I/O RTD INPUTS  RTD INPUT xx

Actual values for each RTD input channel that is enabled are displayed with the top line as the programmed channel ID 
and the bottom line as the value.

 PMU 1 I1:
0.000 A 0.00°

 PMU 1 I2:
0.000 A 0.00°

 PMU 1 I0:
0.000 A 0.00°

 PMU 1 FREQUENCY:
0.000 Hz

 PMU 1 df/dt:
0.00 Hz/s

 PMU 1 CONFIG CHANGE
COUNTER: 0

Range: 0 to 65535

 PMU AGGREGATOR 1
  PMU AGGREGATOR 1

PDU SIZE: 0

 RESTRICTED
 GROUND FAULT 1  RGF 1 DIFF Igd:

0.000 A

 RGF 1 RESTR Igr:
0.000 A

 DCMA INPUT xx 
  DCMA INPUT xx

0.000 mA

 RTD INPUT xx
  RTD INPUT xx

-50 °C
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6.5  Remote resources

6.5.1  Field unit
ACTUAL VALUES  REMOTE RESOURCES  FIELD UNIT U1(U8)

This menu displays when using a Process Bus Module for a HardFiber Brick.

6.6  Process Bus Module

6.6.1  General status
ACTUAL VALUES  PB MODULE  GENERAL STATUS

Ports applicable to the Process Bus Module display. The example shows all eight ports.

The information also displays in a web browser under Process Card Menu > Process Card Port Information.

 FIELD UNIT U1
 ID: U 1  FIELD UNIT STATUS:

DISABLED
Range: Disabled, Enabled

 BRICK SERIAL NUMBER:

 BRICK ORDER CODE:
CC-05

 BRICK DIGITAL CORE:
0

 LOCAL TRANSCEIVER:
TX POWER: 0.0 dBm

 BRICK TRANSCEIVER
RX POWER: 0.0 dBm

 BRICK TRANSCEIVER
RX POWER: 0.0 dBm

 LOCAL TRANSCEIVER
RX POWER: 0.0 dBm

 GENERAL STATUS
  NETWORK CONFIG:

INDEPENDENT
Range: INDEPENDENT, PRP, HSR, Dual HSR

 Port 1a Status:
Disabled

Range: Disabled, Enabled, Active



 Port 4b Status:
Disabled

Range: Disabled, Enabled, Active

These menus display when the product includes a Process Bus Module with order code 85, 86, or 87. The 
actual values display on the front panel and software. Additional values display in a web browser; enter the IP 
address of the relay and access the Process Card Menu or Diagnostics Menu.
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6.6.2  RxSV status
ACTUAL VALUES  PB MODULE  RxSV Status

Additional actual values for sampled values display in a web browser. Enter the IP address of the relay and access Process 
Card Menu > Process Card Diagnostics, for which the following fields are explained. Also see Diagnostics Menu > 
Process Card Diagnostics Menu > Process Card Factory Diagnostics.

Sample Value processing delay...Min Delay — The minimum time delay in received sample values. The accuracy threshold 
of this diagnostics is within 1/8 of a power system cycle.

Sample Value processing delay...Max Delay — The maximum time delay in received sample values. The accuracy 
threshold of this diagnostics is within 1/8 of a power system cycle.

Sample Value processing delay...Avg Delay — The average time delay for received sample values. A delay up to about 1.5 
milliseconds (1500 µsec) is normal. The accuracy threshold of this diagnostics is within 1/8 of a power system cycle.

SV Delay Alarm Counter — The number of times that sampled values from a configured SV stream are delayed for more 
than the Settings > Process Bus Module > General > SV Delay Alarm setting. This diagnostic gets reset upon relay power 
cycle. Counters wrap around when they reach 4294967295.

Sample Estimation Counter — The number of times that the relay used an internal estimation algorithm to substitute a 
missing sample value. This diagnostic gets reset upon relay power cycle. Counters wrap around when they reach 
4294967295.

Stream Status — The status of a configured SV stream. If the Settings > Process Bus Module > SV Stream Config > SV 
Stream setting is set to Disabled, this value is shown as Disabled. If the setting is set to IEC 61850-9-2LE or IEC 61869-9 and 
received sample values are accepted by the relay, this value is shown as Online. If received sample values are rejected, or 
sample values are lost (frames not received), stream status changes to Offline. This diagnostic gets reset upon relay power 
cycle.

Latest Unacceptable Quality — Time stamp of the latest sample value with unacceptable quality, in any data item in a 
dataset. This time stamp has 1/8 of a power system cycle accuracy threshold. It resets upon relay power cycle.

Latest Sim Bit Change — The time stamp of latest change in simulation bit status of the received RxSV# messages. This 
time stamp has 1/8 of a power system cycle accuracy threshold. It resets upon relay power cycle.

SmpSync Latest Update Time — The time stamp of the latest sample value for which the SmpSync attribute was different 
from the previous samples. This value determines when the time source that sample value stream is synchronized to has 
changed. This time stamp has 1/8 of a power system cycle accuracy threshold. It resets upon relay power cycle.

SmpSync Changes in Past 24hrs — The number of times the SmpSync attribute in the sample value messages from this 
stream has changed in the past 24 hours. This counter is updated every hour. Counters wrap around when they reach 
4294967295.

Sample Estimate Fail-Last 10s — The number of times that three or more out of five consecutive samples has been lost in 
the last 10 seconds. This counter is updated every second and gets reset upon relay power cycle. Counters wrap around 
when they reach 4294967295.

Sample Value Trouble Counter — The number of times that the SV Stream Trouble minor self-test error is detected by the 
Process Bus Module. The counter resets upon relay power cycle. Counters wrap around when they reach 4294967295.

6.6.3  Clock synchronizing
This function is not supported at this time.

 RxSV Status
  All RxSV Online:

No
Range: Yes, No

 RxSV 1:
Off

Range: On, Off



 RxSV 8:
Off

Range: On, Off
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6.6.4  PRP
Actual values for the Parallel Redundancy Protocol (PRP) display in a web browser. Enter the IP address of the relay and 
access the Process Card Menu > Process Card PRP Statistics, which displays only when PRP is used.

PRP Status — PRP is Enabled if Settings > Process Bus Module > General > Network Config is set to PRP, else it is Disabled.

Total Rx Port A — Counter indicating the number of frames received on port A, for example port 1a.

Total Rx Port B — Counter indicating the number of frames received on port B, for example port 1b.

Total Tx Port A — Counter indicating the number of frames sent on port A, for example port 1a.

Total Tx Port B — Counter indicating the number of frames sent on port B, for example port 1b.

Mismatches Port A — Counter indicating the number of erroneous frames received on port A, for example port 1a.

Mismatches Port B — Counter indicating the number of erroneous frames received on port B, for example port 1b.

Duplicates Removed Port A — Number of PRP duplicate frames received from port A and discarded, for example port 1a.

Duplicates Removed Port B — Number of PRP duplicate frames received from port B and discarded, for example port 1b.

6.6.5  HSR
Actual values for High-Availability Seamless Redundancy (HSR) display in a web browser. Enter the IP address of the relay 
and access the Process Card Menu > Process Card HSR Statistics, which displays only when HSR is used.

HSR Status — HSR is Enabled if Settings > Process Bus Module > General > Network Config is set to HSR, dual HSR if set 
to Dual HSR, else it is Disabled. The field is HSR1 Status or HSR2 Status for the rings.

Total Rx Port A — Counter indicating the number of frames received on port A, for example port 1a.

Total Rx Port B — Counter indicating the number of frames received on port B for example port 1b.

Total Tx Port A — Counter indicating the number of frames sent on port A, for example port 1a.

Total Tx Port B — Counter indicating the number of frames sent on port B, for example port 1b.

Mismatches Port A — Counter indicating the number of erroneous frames received on port A, for example port 1a.

Mismatches Port B — Counter indicating the number of erroneous frames received on port B, for example port 1b.

Duplicates Removed Port A — Number of HSR duplicate frames received from port A and discarded, for example port 1a.

Duplicates Removed Port B — Number of HSR duplicate frames received from port B and discarded, for example port 1b.

6.7  Records

6.7.1  Fault reports
ACTUAL VALUES  RECORDS  FAULT REPORTS  FAULT REPORT 1(15)

NO FAULTS TO REPORT

or

 FAULT REPORT 1
  FAULT 1

LINE ID: SRC 1
Range: SRC 1, SRC 2

 FAULT 1 DATE:
2000/08/11

Range: YYYY/MM/DD

 FAULT 1 TIME:
00:00:00.000000

Range: HH:MM:SS.ssssss

 FAULT 1 TYPE:
ABG

Range: not available if the source VTs are in the 
“Delta” configuration
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The latest 15 fault reports can be stored. The most recent fault location calculation (when applicable) is displayed in this 
menu, along with the date and time stamp of the event which triggered the calculation. See the SETTINGS  PRODUCT 
SETUP  FAULT REPORTS menu for assigning the source and trigger for fault calculations. See the COMMANDS  CLEAR 
RECORDS menu for manual clearing of the fault reports and to the SETTINGS  PRODUCT SETUP  CLEAR RELAY RECORDS 
menu for automated clearing of the fault reports.

The FAULT 1 LOOP RESISTANCE and REACTANCE are expressed in secondary ohms, which are calculated as per the following 
equation.

 Zloop = Vloop / Iloop Eq. 6-5

The table defines the loop voltage and current.

Table 6-3: Quantities used to calculate fault loop impedances

Where VA, VB, VC are phase voltage phasors in secondary volts; IA, IB, IC are current phasors in secondary amps, I0 is the 
zero sequence current phasors in secondary amps; and IG is the ground current from the parallel line scaled to the source 
phase CT in secondary amps. Z0/Z1 is the zero sequence impedance to positive sequence impedance ratio, and Z0M/Z1 is 
mutual zero sequence impedance to positive sequence impedance ratio.

6.7.2  Event records

6.7.2.1  Enhanced and basic front panels
ACTUAL VALUES  RECORDS  EVENT RECORDS

 FAULT 1 LOCATION
00.0 km

Range: not available if the source VTs are in the 
“Delta” configuration

 FAULT 1 RECLOSE
SHOT: 0

Range: where applicable

 FAULT 1 LOOP
RESIST: 0.00 Ohms

Range: 0 to 327.67 Ohms

 FAULT 1 LOOP
REACT: 0.00 Ohms

Range: -327.67 to 327.67 Ohms

Fault type Vloop Iloop

AG VA IA + (Z0/Z1-1)*I0 + Z0M/Z1*IG/3

BG VB IB + (Z0/Z1-1)*I0 + Z0M/Z1*IG/3

CG VC IC + (Z0/Z1-1)*I0 + Z0M/Z1*IG/3

AB, ABG VA – VB IA - IB

BC, BCG VB – VC IB - IC

CA, CAG VC – VA IC - IA

ABC Average of AB, BC, CA loop impedances

VTs of the FAULT REPORT 1 SOURCE must be connected in Wye or VT SUBSTITUTION must be set correctly for the Delta 
connected VT to display the loop impedance and fault resistance for single phase-to-ground faults.

For the application of partially parallel circuits and in the case of single phase-to-ground faults, the reported fault 
resistance and fault loop impedance may not be accurate even the compensation method is applied.

 EVENT RECORDS
  EVENT: XXX

XXX

 Date and time stamps

 EVENT: 3
POWER ON   EVENT 3

DATE: 2000/07/14
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The event records menu shows the contextual data associated with up to the last 1024 events, listed in chronological 
order from most recent to oldest. When all 1024 event records have been filled, the oldest record is removed as a new 
record is added. Each event record shows the event identifier/sequence number, cause, and date/time stamp associated 
with the event trigger. See the COMMANDS  CLEAR RECORDS menu for clearing event records.

Only major output operands generate events, not every operand. Elements that assert output per phase, for example, log 
operating phase output only without asserting the common three-phase operand event.

See also the system log (syslog) information in the previous chapter.

The event records are viewable in the software and in a web browser. The figure shows the event records in the software.

Figure 6-6: Event records viewed in EnerVista software

To view events in a web browser:

1. Enter the IP address of the device.

To download an oscillography waveform:

1. Click the Oscillography icon in the Data column (not shown in the figure).

6.7.2.2  Graphical front panel
To display the event records page, press the Home pushbutton then the Event Record Tab pushbutton.

The newest event is always at the top.

Up and Down pushbuttons move the event selector up and down. When the selector is at the bottom of the display, the 
Down pushbutton also scrolls the page, and similarly when the active selector is at the top of the display the Up 
pushbutton scroll the page.

A selected event is highlighted in yellow and becomes active by pressing the Up or Down pushbutton.

There are two event markers, one green, the other cyan. To mark some an event, use the Up and Down pushbuttons to 
select it (highlight in yellow), then press the green or cyan Mark Event Tab pushbutton. The mark color hides the selector 
until the selector is moved. A field at the top of the page shows the interval between the two marks.

 EVENT: 2
POWER OFF  EVENT 3

TIME: 14:53:00.03405

 EVENT: 1
EVENTS CLEARED
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Figure 6-7: Event record

6.7.3  Oscillography

6.7.3.1  Enhanced and basic front panels
ACTUAL VALUES  RECORDS  OSCILLOGRAPHY

This menu allows the user to view the number of triggers involved and number of oscillography traces available. The cycles 
per record value is calculated to account for the fixed amount of data storage for oscillography. See the Oscillography 
section of chapter 5 for details.

A trigger can be forced here at any time by setting “Yes” to the FORCE TRIGGER? command. See the COMMANDS  CLEAR 
RECORDS menu for information on clearing the oscillography records.

To view a waveform:

2. Access Actual Values > Records > Oscillography in the EnerVista software.

3. In the window that opens, select the record number. The highest number is the most recent record (Newest Record 
Number).

4. Click the Read button to get the waveform. When available, waveforms are displayed graphically, and otherwise error 
messages display.

5. In the waveform window that opens, you can save the file, for example with the CFG extension.

6.7.4  Data logger
ACTUAL VALUES  RECORDS  DATA LOGGER

 OSCILLOGRAPHY
  FORCE TRIGGER?

No
Range: No, Yes

 NUMBER OF TRIGGERS:
0

 AVAILABLE RECORDS:
0

 CYCLES PER RECORD:
0

 LAST CLEARED DATE:
2000/07/14 15:40:16

 DATA LOGGER
  OLDEST SAMPLE TIME:

2000/01/14 13:45:51
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The OLDEST SAMPLE TIME represents the time at which the oldest available samples were taken. It is static until the log gets 
full, at which time it starts counting at the defined sampling rate.

The NEWEST SAMPLE TIME represents the time the most recent samples were taken. It counts up at the defined sampling 
rate. If the data logger channels are defined, then both values are static.

See the COMMANDS  CLEAR RECORDS menu for clearing data logger records.

6.7.5  Phasor Measurement Unit records
ACTUAL VALUES  RECORDS  PMU RECORDS

The number of triggers applicable to the Phasor Measurement Unit recorder is indicated by the NUMBER OF TRIGGERS value. 
The status of the phasor measurement unit recorder is indicated as follows.

ACTUAL VALUES  RECORDS  PMU RECORDS  PMU 1 RECORDING

6.7.6  Breaker maintenance
ACTUAL VALUES  RECORDS  MAINTENANCE  BREAKER 1(2)(4)

 NEWEST SAMPLE TIME:
2000/01/14 15:21:19

 PMU
 RECORDS  NUMBER OF TRIGGERS:

0
Range: 0 to 65535 in steps of 1

  PMU 1
 RECORDING

See below

 PMU 1
 RECORDINg  PMU 1 FORCE TRIGGER:

No
Range: No, Yes

 PMU 1 AVAILABLE
RECORDS: 0

Range: 0 to 65535 in steps of 1

 PMU 1 SECONDS PER
RECORD: 0.0

Range: 0 to 6553.5 in steps of 0.1

 PMU 1 LAST CLEARED:
2013/07/14 15:40:16

Range: YYYY/MM/DD HH:MM:SS

 BREAKER 1
  BKR 1 ACC ARCING AMP

A: 0.00 kA2-cyc

 BKR 1 ACC ARCING AMP
B: 0.00 kA2-cyc

 BKR 1 ACC ARCING AMP
C: 0.00 kA2-cyc

 BKR 1 OPERATING TIME
A: 0 ms

 BKR 1 OPERATING TIME
B: 0 ms

 BKR 1 OPERATING TIME
C: 0 ms

 BKR 1 OPERATING
TIME: 0 ms

 BKR 1 ARCING AMP A:
0.00 kA2-cyc
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There is an identical menu for each of the breakers.

The BKR 1 ACC ARCING AMP values are in units of kA2-cycles. See the COMMANDS  CLEAR RECORDS menu for clearing 
breaker arcing current records.

The BREAKER OPERATING TIME is defined as the slowest operating time of breaker poles that were initiated to open.

All of the values are stored in non-volatile memory and retained with power cycling.

6.7.7  Hi-Z records
ACTUAL VALUES  RECORDS  HIZ RECORDS

Two types of high impedance fault detection element records are stored in non-volatile memory and available from this 
menu. If the element is triggered by a high impedance overcurrent condition, then the records display in the RMS 1 to RMS 
4 actual values. If the element is triggered by high impedance fault detection arcing algorithm, then the records display in 
the HIZ 1 to HIZ 4 actual values. See the High-Impedance Fault Detection (Hi-Z) section near the end of chapter 5 for 
information.

 BKR 1 ARCING AMP B:
0.00 kA2-cyc

 BKR 1 ARCING AMP C:
0.00 kA2-cyc

 BKR 1 AMP MAX A:
0.00 kA

 BKR 1 AMP MAX B:
0.00 kA

 BKR 1 AMP MAX C:
0.00 kA

 HIZ RECORDS
  FORCE TRIGGER:

No

 HIZ 1:NONE
1970/01/01 00:00:00

 HIZ 2:NONE
1970/01/01 00:00:00

 HIZ 3:NONE
1970/01/01 00:00:00

 HIZ 4:NONE
1970/01/01 00:00:00

 RMS 1:NONE
1970/01/01 00:00:00

 RMS 2:NONE
1970/01/01 00:00:00

 RMS 3:NONE
1970/01/01 00:00:00

 RMS 4:NONE
1970/01/01 00:00:00
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6.8  Product information

6.8.1  Model information
ACTUAL VALUES  PRODUCT INFO  MODEL INFORMATION

The order code, serial number, Ethernet MAC address, date and time of manufacture, and operating time are shown here. 
The rear panel on the device contains similar information. The information is read-only in the software and modifiable on 
the front panel. For example, the order code can be corrected using the front panel.

ETHERNET MAC ADDRESS — UR devices with firmware 7.0x and above have three Ethernet ports that can be used on three 
networks. The MAC address displays for port 1. The MAC address for port 2 is one higher. The MAC address for port 3 is one 
higher than port 2. In redundant mode, the MAC addresses for ports 2 and 3 are the same as port 2.

6.8.2  Firmware revisions

6.8.2.1  Enhanced and basic front panels
ACTUAL VALUES  PRODUCT INFO  FIRMWARE REVISIONS

 MODEL INFORMATION
  ORDER CODE LINE 1:

F60-A00-AAA-A0A-A0A-
Range: standard GE order code format

 ORDER CODE LINE 2:
A0A-A0A-A0A

Range: up to 20 alphanumeric characters

 ORDER CODE LINE 3: Range: up to 20 alphanumeric characters

 ORDER CODE LINE 4: Range: up to 20 alphanumeric characters

 SERIAL NUMBER: Range: standard GE serial number format

 ETHERNET MAC ADDRESS
000000000000

Range: standard Ethernet MAC address format

 MANUFACTURING DATE: Range: YYYY/MM/DD HH:MM:SS

 OPERATING TIME:
0:00:00

Range: operating time in HH:MM:SS

 PMU FEATURE ACTIVE:
No

Range: Yes, No

 CT/ VT ADVANCED DIAG
ACTIVE: No

Range: Yes, No

 LAST SETTING CHANGE:
1970/01/01 23:11:19

Range: YYYY/MM/DD HH:MM:SS

 FIRMWARE REVISIONS
  F60 Relay

REVISION: 7.6x
Range: 0.00 to 655.35
Revision number of the application firmware.

 MODIFICATION FILE
NUMBER: 0

Range: 0 to 65535 (ID of the MOD FILE)
Value is 0 for each standard firmware release.

 BOOT PROGRAM
REVISION: 7.01

Range: 0.00 to 655.35
Revision number of the boot program firmware.

 FRONT PANEL PROGRAM
REVISION: 2.01

Range: 0.00 to 655.35
Revision number of front panel program firmware.
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The shown data is illustrative only. A modification file number of 0 indicates that, currently, no modifications have been 
installed.

6.8.2.2  Graphical front panel
ACTUAL VALUES  PRODUCT INFO  FIRMWARE REVISIONS

 COMPILE DATE:
2016/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS
Date and time when product firmware was built.

 BOOT DATE:
2013/09/15 16:41:32

Range: YYYY/MM/DD HH:MM:SS
Date and time when the boot program was built.

 FPGA PROGRAM
REVISION: 02.02

Range: 0.00 to 655.35
Revision number for FPGA.

 FPGA DATE:
2016/09/15 16:41:32

Range: YYYY/MM/DD HH:MM:SS
Date and time when the FPGA was built.

 FIRMWARE REVISIONS
  F60 Relay

REVISION: 7.6x
Range: 0.00 to 655.35
Revision number of the application firmware.

 MODIFICATION FILE
NUMBER: 0

Range: 0 to 65535 (ID of the MOD FILE)

 BOOT PROGRAM
REVISION: 7.02

Range: 0.00 to 655.35

 FRONT PANEL PROGRAM
REVISION: 2.01

Range: 0.00 to 655.35

 COMPILE DATE:
2018/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS

 BOOT DATE:
2016/09/15 16:41:32

Range: YYYY/MM/DD HH:MM:SS

 GFP PROGRAM
REVISION: 7.80

Range: 0.00 to 655.35

 GFP COMPILE DATE:
2018/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS

 GFP BOOT PROGRAM
REVISION: 655.35

Range: 0.00 to 655.35

 GFP BOOT COMP. DATE:
2016/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS

 PROCESS CARD / BRICK
REVISION: 0.000

Range: YYYY/MM/DD HH:MM:SS

 PROCESS BUS BOOT
REVISION: 0.00

Range: 0.00 to 655.35

 PB BOOT DATE:
2018/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS

 PROCESS BUS
REVISION: 0.00

Range: 0.00 to 655.35

 PROCESS BUS DATE:
2018/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS

 PB CVSOC FPGA
REVISION: 0.00

Range: 0.00 to 655.35

 PB CVSOC FPGA DATE:
2018/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS
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The shown data is illustrative only. A modification file number of 0 indicates that, currently, no modifications have been 
installed. The date format reflects the format specified for the clock and can vary from that shown here. GFP refers to a 
graphical front panel. PB and Process Card refer to a Process Bus Module.

 PB CVFPGA FPGA
REVISION: 0.00

Range: 0.00 to 655.35

 PB CVFPGA DATE:
2018/09/15 04:55:16

Range: YYYY/MM/DD HH:MM:SS

 FPGA PROGRAM
REVISION: 02.02

Range: 0.00 to 655.35

 FPGA DATE:
2016/09/15 16:41:32

Range: YYYY/MM/DD HH:MM:SS
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F60 Feeder Protection System

Chapter 7: Commands and targets

Commands and targets

This chapter outlines the Commands and Targets menus and self-tests/error messages. Commands related to the IEC 
61850 protocol are outlined in the IEC 61850 section of the Settings chapter. Log/error messages for IEC 61850 are 
outlined in the UR Family Communications Guide.

7.1  Commands menu

The commands menu contains relay directives intended for operations personnel. All commands can be protected from 
unauthorized access via the command password; see the Security section of chapter 5 for details. The following flash 
message appears after successfully command entry.

COMMANDS



  COMMANDS
 VIRTUAL INPUTS

  COMMANDS
 CLEAR RECORDS

  COMMANDS
 SET DATE AND TIME

  COMMANDS
 RELAY MAINTENANCE

  COMMANDS
 PMU ONE-SHOT

  COMMANDS
 SECURITY

COMMAND
EXECUTED
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7.1.1  Virtual inputs
COMMANDS  VIRTUAL INPUTS

The states of up to 64 virtual inputs are changed here. The first line of the display indicates the ID of the virtual input. The 
second line indicates the current or selected status of the virtual input. This status is a state off (logic 0) or on (logic 1).

7.1.2  Clear records
COMMANDS  CLEAR RECORDS

 COMMANDS
 VIRTUAL INPUTS  Virt Ip 1

Off
Range: Off, On

 Virt Ip 2
Off

Range: Off, On




Virt Ip 64
Off

Range: Off, On

 COMMANDS
 CLEAR RECORDS  CLEAR FAULT REPORTS?

No
Range: No, Yes

 CLEAR EVENT RECORDS?
No

Range: No, Yes

 CLEAR OSCILLOGRAPHY?
No

Range: No, Yes

 CLEAR DATA LOGGER?
No

Range: No, Yes

 CLEAR BREAKER 1
ARCING AMPS? No

Range: No, Yes

 CLEAR BREAKER 2
ARCING AMPS? No

Range: No, Yes

 CLEAR DEMAND
RECORDS? No

Range: No, Yes

 CLEAR ENERGY?
No

Range: No, Yes

 CLEAR HIZ RECORDS?
No

Range: No, Yes

 CLEAR UNAUTHORIZED
ACCESS? No

Range: No, Yes

 CLEAR DIRECT I/O
COUNTERS? No

Range: No, Yes. 
Valid only for units with Direct Input/Output module.

 CLEAR PMU 1 RECORDS?
No

Range: No, Yes

 CLEAR PMU 1 CONFIG
CHANGE COUNTER? No

Range: No, Yes

 CLEAR TELEPROTECT
COUNTERS? No

Range: No, Yes

 CLEAR INCIPIENT
FAULT COUNTERS? No

Range: No, Yes

  CLEAR IEC61850
 XWSI OPCNT

See below
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This menu contains commands for clearing historical data such as the event records. Data is cleared by changing a 
command setting to “Yes” and pressing the ENTER key. After clearing data, the command setting automatically reverts to 
“No.”

CLEAR PBM DIAGNOSTICS — Clears the sampled value diagnostics information for a non-HardFiber Process Bus Module. All 
other Process Bus Module diagnostics information is reset up relay power cycling, such as HSR and PTP.

COMMANDS  CLEAR RECORDS  CLEAR IEC61850 XWSI OPCNT

COMMANDS  CLEAR RECORDS  CLEAR IEC61850 XCBR OPCNT

The Clear XSWI commands clear the disconnect operation counters for each phase and the three-phase counter. Similarly, 
the Clear XCBR commands clear the circuit breaker operation counters for each phase and the three-phase counter.

7.1.3  Set date and time
COMMANDS  SET DATE AND TIME

The date and time can be entered on the front panel keypad. The time setting is based on the 24-hour clock. The complete 
date, as a minimum, must be entered to allow execution of this command. The new time and date take effect when the 
ENTER key is pressed.

The clock also can be synchronized to the local computer time among several UR devices. Use the Synchronize Devices 
entry in the Online Window area of the EnerVista software. (Click the button at the top of the window that opens.)

When the relay is synchronizing to an external time source such as PTP, IRIG-B, or SNTP, the manually entered time or the 
manually synchronized time is over-written.

The timescale of the entered time is local time, including daylight savings time where and when applicable.

7.1.4  Relay maintenance
COMMANDS  RELAY MAINTENANCE

  CLEAR IEC61850
 XCBR OPCNT

See below

 CLEAR PBM
DIAGNOSTICS? No

Range: No, Yes

 CLEAR ALL RELAY
RECORDS? No

Range: No, Yes

 CLEAR IEC61850
 XWSI OPCNT  CLEAR XSWI 1

OpCnt? No
Range: No, Yes



 CLEAR XSWI 24
OpCnt? No

Range: No, Yes

 CLEAR IEC61850
 XCBR OPCNT  CLEAR XCBR 1

OpCnt? No
Range: No, Yes



 CLEAR XCBR 8
OpCnt? No

Range: No, Yes

 COMMANDS
 SET DATE AND TIME  SET DATE AND TIME:

2000/01/14 13:47:03
Range: YYYY/MM/DD HH:MM:SS

 COMMANDS
 RELAY MAINTENANCE  PERFORM LAMP TEST?

No
Range: No, Yes
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This menu contains commands for relay maintenance purposes. Commands for the lamp test and order code are 
activated by changing a command setting to “Yes” and pressing the ENTER key. The command setting then automatically 
reverts to “No.” The service command is activated by entering a numerical code and pressing the ENTER key.

Not all commands display in the software; use the front panel when required.

PERFORM LAMP TEST — Turns on all front panel LEDs and display pixels for a short duration.

PERFORM LCD TEST — This command detects either stuck-ON or stuck-OFF pixels (dead pixels) in the display screen on the 
graphical front panel. RED/GREEN/BLUE is to display the solid background color in the whole screen. WHITE & TEXT 
PATTERN shows the white background and black texts. BLACK & TEXT PATTERN shows the black background and white 
texts. TV TEST PATTERN displays a standard television test pattern (SMPTE color bars). The test screen can be canceled by 
pressing any pushbutton or after 30 seconds of inactivity.

PERFORM PUSHBUTTON TEST — This command tests the pushbuttons on the graphical front panel. During testing, press the 
corresponding pushbutton according to the prompt text. A failure message is given if the expected action is not detected 
in one minute. Holding the ESCAPE button for five seconds to interrupt the test sequence. The designated function of a 
specific pushbutton is bypassed in the test.

UPDATE ORDER CODE — Use this command to read and update the order code, for example when hardware modules have 
been changed inside the relay. It causes the relay to scan the backplane for the modules and update the order code to 
match. All settings are defaulted with an update. When an update occurs, the following message displays and the relay 
restarts.

There is no impact if there have been no changes to the hardware modules. When an update does not occur, the ORDER 
CODE NOT UPDATED message displays.

REBOOT RELAY — Restarts the relay so that changes to configuration settings can take effect. In most cases, if changes are 
made to the configuration settings these changes do not take effect unless the relay is rebooted.

SERVICE COMMAND — Performs specific F60 service actions. Presently, there are two service actions available. Code "20511" 
returns all settings to their factory default value and restarts the relay (then you re-enter IP address, restart, set unit to 
"Programmed"). Code “101” is used to clear factory diagnostic information stored in the non-volatile memory. If a code 
other than these two is entered, the command is ignored and no action is taken. Various self-checking diagnostics are 
performed in the background while the F60 is running, and diagnostic information is stored on the non-volatile memory 
from time to time based on the self-checking result. Although the diagnostic information is cleared before the F60 is 
shipped from the factory, the user can want to clear the diagnostic information for themselves under certain 
circumstances. For example, you clear diagnostic information after replacement of hardware. Once the diagnostic 
information is cleared, all self-checking variables are reset to their initial state and diagnostics restart from scratch.

 PERFORM LCD TEST?
Off

Range: Off, Red, Green, Blue, White & Text Pattern, 
Black & Text Pattern, TV Test Pattern

 PERFORM PUSHBUTTON
TEST?  No

Range: No, Yes

 UPDATE ORDER CODE?
No

Range: No, Yes

 REBOOT RELAY?
No

Range: No, Yes

 SERVICE COMMAND
0

Range: 0, 101, 20511

 SAVE VOLATILE DATA?
No

Range: No, Yes

UPDATING...
PLEASE WAIT

With the CyberSentry option, the Administrator and Operator roles can initiate the Reboot Relay command.
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SAVE VOLATILE DATA — Saves this data to compact flash memory prior to shutdown. This allows the saved data to be as 
recent as possible instead of relying on the periodic timer to save the data.

7.1.5  Phasor Measurement Unit one-shot
COMMANDS  PMU ONE-SHOT

This feature allows pre-scheduling of a PMU measurement at a specific point in time. It can be used to test for accuracy of 
the PMU and for manual collection of synchronized measurements through the system, as explained here.

When enabled, the function continuously compares the present time with the pre-set PMU ONE-SHOT TIME. When the two 
times match, the function compares the present sequence number of the measured synchrophasors with the pre-set PMU 
ONE-SHOT FRACTIONAL SEC. When the two numbers match, the function freezes the synchrophasor actual values and the 
corresponding protocol data items for 30 seconds. This allows manual read-out of the synchrophasor values for the pre-
set time and pre-set sequence number (via the faceplate display, supported communication protocols such as Modbus or 
DNP, and the EnerVista UR Setup software).

When freezing the actual values, the function also asserts a PMU ONE-SHOT OP FlexLogic operand. This operand can be 
configured to drive an output contact and trigger an external measuring device such as a digital scope with the intent to 
verify the accuracy of the PMU under test.

With reference to the following figure, the PMU one-shot function (when enabled) controls three FlexLogic operands:

• The PMU ONE-SHOT EXPIRED operand indicates that the one-shot operation has been executed, and the present time is 
at least 30 seconds past the scheduled one-shot time

• The PMU ONE-SHOT PENDING operand indicates that the one-shot operation is pending; that is, the present time is 
before the scheduled one-shot time

• The PMU ONE-SHOT OP operand indicates the one-shot operation and remains asserted for 30 seconds afterwards

When the function is disabled, all three operands are de-asserted.

The one-shot function applies to all logical PMUs of a given F60 relay.

Figure 7-1: PMU one-shot FlexLogic operands 

 COMMANDS
 PMU ONE-SHOT  PMU ONE-SHOT

FUNCTION: Disabled
Range: Enabled, Disabled

 PMU ONE-SHOT
FRACTIONAL SEC: 0

Range: 0 to 99 in steps of 1

 PMU ONE-SHOT TIME:
2013/06/14 7:58:35

Range: YYYY/MM/DD HH:MM:SS
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7.1.5.1  Testing accuracy of the PMU
The one-shot feature is used to test accuracy of the synchrophasor measurement. GPS-synchronized tests sets perform a 
similar function to PMUs; instead of measuring the phasor from physical signals with respect to the externally provided 
time reference, they produce the physical signals with respect to the externally provided time reference, given the desired 
phasor values. Therefore the GPS-synchronized test sets cannot be automatically assumed more accurate than the PMUs 
under test. This calls for a method to verify both the measuring device (PMU) and the source of signal (test set).

With reference to the following figure, the one-shot feature can be configured to trigger a high-accuracy scope to capture 
both the time reference signal (rising edge of the 1 pps signal of the IRIG-B time reference) and the measured waveform. 
The high-accuracy high-sampling rate record of the two signals captured by the scope can be processed using digital 
tools to verify the magnitude and phase angle with respect to the time reference signal. As both the time reference and the 
measured signals are raw inputs to the PMU under test, their independently captured record, processed using third-party 
software, is a good reference point for accuracy calculations. Such a record proves useful when discussing the test results, 
and can be retained as a part of the testing documentation.

Figure 7-2: Using the PMU one-shot feature to test synchrophasor measurement accuracy 

7.1.5.2  Collecting synchronized measurements ad hoc
The one-shot feature can be used for ad hoc collection of synchronized measurements in the network. Two or more PMUs 
can be pre-scheduled to freeze their measurements at the same time. When frozen, the measurements can be collected 
using the EnerVista software or a protocol client.

7.1.6  Security
COMMANDS  SECURITY

With the CyberSentry option, this setting is available to enable or disable the following commands.

ADMINISTRATOR LOGOFF — Selecting ‘Yes’ allows the Supervisor to forcefully logoff an administrator session.

ENGINEER LOGOFF — Selecting ‘Yes’ allows the Supervisor to forcefully logoff an engineer session.

 SECURITY
  ADMINISTRATOR

LOGOFF: No
Range: Yes, No

 ENGINEER
LOGOFF: No

Range: Yes, No

 OPERATOR
LOGOFF: No

Range: Yes, No

 CLEAR SECURITY DATA:
No

Range: Yes, No
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OPERATOR LOGOFF — Selecting ‘Yes’ allows the Supervisor to forcefully logoff an operator session.

CLEAR SECURITY DATA — Selecting ‘Yes’ allows the Supervisor to forcefully clear all the security logs and clears all the 
operands associated with the self-tests.

7.2  Targets menu

A target enables the EnerVista UR Setup software to monitor automatically and display the status of any active target 
messages of all the devices inserted into that site.

Each F60 element with a TARGET setting has a target message that when activated by its element is displayed in sequence 
with any other currently active target messages in the TARGETS menu. In the example shown, the Phase TOC4 and Digital 
Element 48 target settings are active and so have their targets displayed. The down arrow below the two elements 
indicates that there can be other active elements beyond these two.

For more information, see the description of target messages in the next section, and the Introduction to Elements section 
in the Settings chapter for instructions on TARGET setting.

When no targets are active, the display reads NO ACTIVE TARGETS.

7.2.1  Target messages
When there are no active targets, the first target to become active causes the display to immediately default to that 
message. If there are active targets and the user is navigating through other messages, and when the default message 
timer times out (i.e. the keypad has not been used for a determined period of time), the display again defaults back to the 
target message.

The range of variables for the target messages is described below. Phase information is included if applicable. If a target 
message status changes, the status with the highest priority displays.

Table 7-1: Target message priority status

If a self test error is detected, a message appears indicating the cause of the error. For example UNIT NOT PROGRAMMED 
indicates that the minimal relay settings have not been programmed.

TARGETS



 PHASE TOC4
OP: A B -

Displayed only if targets for this element are active. 
Example shown.

 DIGITAL ELEMENT 48:
LATCHED

Displayed only if targets for this element are active. 
Example shown.





Priority Active status Description

1 OP element operated and still picked up

2 PKP element picked up and timed out

3 LATCHED element had operated but has dropped out
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7.2.2  Relay self-tests

7.2.2.1  Description
The relay performs a number of self-test diagnostic checks to ensure device integrity. The two types of self-tests (major 
and minor) are listed in the following tables. When either type of error occurs, the Trouble LED Indicator turns on and a 
target message displays. All errors record an event in the event recorder. Latched errors can be cleared by pressing the 
RESET key, providing the condition is no longer present.

Major self-test errors also result in the following:

• The critical fail relay on the power supply module de-energizes

• All other output relays de-energize and are prevented from further operation

• The front panel In Service LED indicator turns off

• A RELAY OUT OF SERVICE event is recorded

To view error messages in EnerVista software:

1. Access Actual Values > Records > Event Records.

Messages display on the front panel with one or two lines of text. An example is as follows. In the tables that follow, 
messages are grouped using the first line of text. For example, MAINTENANCE ALERT, then a row for 4L Discrepancy, then a 
row for Bad IRIG-B Signal.

7.2.2.2  Major self-test error messages
The major self-test errors are outlined in this section.

Table 7-2: Major self-test errors

MAINTENANCE ALERT:
4L Discrepancy

MAINTENANCE ALERT:
Bad IRIG-B Signal

Error Latched? Description Test frequency Action

DIAGNOSTIC FAILURE ___:

Self Test Error No Internal recovery failure 
detected

Upon recovery Extract a Service Report through UR 
Setup software. Contact technical 
support and supply details of the 
failure code on the display.

EQUIPMENT MISMATCH:

2nd line detail No The number or type of 
installed hardware modules 
does not match the order 
code stored in the F60. An 
example is when a basic front 
panel is installed and the 
order code on the F60 
expects a graphical front 
panel. As another example, 
"Card F8L Missing" means 
that hardware module 8L is 
missing from slot F inside the 
UR device.

On power up. 
Afterwards, the 
backplane is 
checked for missing 
cards every five 
seconds

Check all modules against the order 
code, ensure they are inserted 
properly, and cycle control power. If a 
module has intentionally been added 
or removed, refresh the order code 
under Device Setup. If the problem 
persists, contact the factory.

FLEXLOGIC ERROR:

2nd line detail No A FlexLogic equation is 
incorrect

Event driven, 
performed whenever 
FlexLogic equations 
are modified

Finish all equation editing and use self 
tests to debug any errors.
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7.2.2.3  Minor self-test error messages
Most of the minor self-test errors can be disabled. See the settings in the User-programmable Self-tests section in chapter 
5.

Table 7-3: Minor self-test errors

RAM FILESYSTEM FAIL:

Self-Test Error Yes The relay failed to create the 
RAM file system

On relay startup Contact factory service

SYSTEM FAILURE ___:

2nd line detail Yes Relay system failure detected Continuous Extract a Service Report through UR 
Setup software. Contact technical 
support and supply details of the 
failure code on the display.

SYSTEM FAILURE:

Card F8L Yes This is an indication that the 
DSP module has failed. The 
slot and DSP type are 
indicated in the message.

The recommendation is to replace this 
DSP. Extract a Service Report through 
UR Setup software and provide it to GE 
customer service.

TO INSTALL SETTINGS:

CHECK LOG AND REBOOT Yes Certain settings require a 
reboot to be applied, for 
example DNP settings, IEC 
104 settings. After a CID file 
was send to the relay, a 
manual reboot of the relay is 
required to apply those 
settings that require a
reboot

A new CID is sent 
and it includes 
changes in settings 
that require a reboot 
to be
applied

Restart relay

UNIT NOT PROGRAMMED:

Check Settings No The PRODUCT SETUP  
INSTALLATION  RELAY 
SETTINGS setting indicates 
the F60 is not programmed

On power up and 
whenever the 
PRODUCT SETUP 
 INSTALLATION 
 RELAY SETTINGS 
setting is altered

Program all settings and then set 
PRODUCT SETUP  INSTALLATION 
 RELAY SETTINGS to “Programmed”

Error Latched? Description Test frequency Action

AGGREGATOR ERROR: No The second line of this self-
test error indicates the 
problem with the PMU 
Aggregator

Each time a PMU’s 
related settings is 
changed

Correct the problem indicated in the 
second line or contact the factory

DIAGNOSTIC ALARM COP:

Self-test Error Yes This is a preliminary warning 
that transient errors were 
detected in the coprocessor. 
The relay remains operational 
but some elements can 
operate slightly delayed.

Module or feature 
dependent

Extract a Service Report through UR 
Setup software and provide it to GE 
customer service

DIAGNOSTIC ALARM DSP:

Card F8L Yes This is a preliminary warning 
that there is something wrong 
with a DSP. The slot and DSP 
type is indicated in the 
message.

One-eighth of a cycle Extract a Service Report through UR 
Setup software and provide it to GE 
customer service

Error Latched? Description Test frequency Action
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DIAGNOSTICS FAILURE Yes This is a warning that there is 
something wrong with the 
DSP/coprocessor subsystem. 
The source of the problem is 
unknown as there are 
multiple contributors.

One-eighth of a cycle Extract a Service Report through UR 
Setup software and provide it to GE 
customer service

DIRECT DEVICE OFF:

COMM Path Incomplete No A direct device is configured 
but not connected

Every second Check direct input and output 
configuration and wiring

DOS PARTITION ALARM:

SELF-TEST ERROR There is a problem with the 
Compact Flash memory in the 
CPU module

On relay power-up 
and afterwards once 
every 24 hours

Contact the factory

LOW ON MEMORY:

with 2nd line detail Yes The relay periodically checks 
the amount of free RAM 
memory available and the 
amount of free stack 
available for each task 
against pre-defined 
thresholds. The second line of 
the self-test indicates which 
of the tests failed. It asserts 
this self-test if those tests fail.

Every five seconds Contact the factory

MAINTENANCE ALERT:

4L Discrepancy No A discrepancy has been 
detected between the actual 
and desired state of a 
latching contact output of an 
installed type “4L” module

Upon initiation of a 
contact output state 
change

Verify the state of the output contact 
and contact the factory if the problem 
persists

Bad IRIG-B Signal No A bad IRIG-B input signal has 
been detected

Monitored whenever 
an IRIG-B signal is 
received

Ensure the following:
- The IRIG-B cable is properly 
connected.
- Proper cable functionality (that is, 
check for physical damage or perform 
a continuity test).
- The IRIG-B receiver is functioning.
- Check the input signal level (it can be 
less than specification).
If none of these apply, then contact the 
factory.

Bad PB PTP Signal
Bad PTP Signal

No No PTP enabled port has 
good PTP signal input

Activated when no 
acceptable signal is 
being received

Ensure the following:
- The Ethernet cable(s) are properly 
connected.
- At least one PTP grandmaster-
capable clock is functioning.
- If a strict power profile (PP) is enabled, 
that entire network is PP compliant.
- The network is delivering PTP 
messages to the relay.

Direct Ring Break No Direct input and output 
settings are configured for a 
ring, but the connection is not 
in a ring

Every second Check direct input and output 
configuration and wiring

FIRST ETHERNET FAIL
SECOND ETHERNET FAIL
THIRD ETHERNET FAIL

Yes A link loss detection on an 
Ethernet port. The link loss is 
due to unplugging the cable 
or the switch port being 
down.

Check the connection

Error Latched? Description Test frequency Action
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Front Panel Trouble No The graphical front panel is 
not responsive for more than 
five seconds. The relay is still 
protecting, and the main CPU 
is not affected by this self-
test.

Every second Contact the factory

GFP Version Mismatch No The graphical front panel 
firmware revision is not 
synchronized with that of the 
CPU module in the relay

Whenever 
connection is 
established between 
the graphical front 
panel and the CPU 
module in the relay

Perform a UR firmware upgrade with 
the graphical front panel connected to 
the CPU module in the relay. It can be 
done using any communication 
interface (Ethernet or USB). This 
synchronizes the graphical firmware 
revision with that of the relay. If trouble 
persists, contact the factory.

GGIO Ind xxx oscill No A data item in a configurable 
GOOSE data set is oscillating

Upon scanning of 
each configurable 
GOOSE data set

The “xxx” text denotes the data item 
that has been detected as oscillating. 
Evaluate all logic pertaining to this 
item.

Oscillatory GOOSE No A data item in a configurable 
GOOSE data set is oscillating

Upon scanning of 
each configurable 
GOOSE data set

Evaluate all logic pertaining to this item

Replace Battery Yes The battery is weak or not 
functioning. It powers the real 
time clock. This message 
displays as Battery Fail in the 
event records. When the 
battery weakness reaches a 
critical level, the message 
displays persistently on the 
front panel and no front panel 
key navigation is possible.

Every five seconds. 
The error message 
displays after 60 
seconds if the 
problem persists.

Replace the battery as outlined in the 
Maintenance chapter. To minimize the 
disruption until battery replacement, 
temporarily disable the battery fail 
function under Settings > Product 
Setup > User-Programmable Self 
Tests.

Setting Changed No Any device settings were 
changed over any available 
interface

On any setting 
changes, when new 
settings were written 
to device

Verify that the setting change was 
legitimate and essential for proper 
functioning of the protection and 
control system

SFP MODULE # FAIL No A faulty small form-factor 
pluggable port (SFP) or 
unplugging of the SFP 
generates this self test 
message

The web page "SFP Transceiver 
Information" described in the previous 
row applies for this self test as well. The 
"SFP Module Fail" has higher priority 
and it suppresses the "Ethernet Fail" 
target message. The "SFP MODULE FAIL 
FUNCTION" setting enables/disables 
this self test. The target for this self test 
is priority-based, with the third one 
being the highest priority. For example, 
if all three SFP modules fail, then the 
third SFP target is activated. If the third 
SFP module failure resolves, then the 
second SFP target is activated.

SNTP Failure No The SNTP server is not 
responding

Every 10 to 60 
seconds

Check that Ethernet cable(s) are 
properly connected. Check that 
configuration for the SNTP server 
corresponds to the actual server 
settings. Check connectivity to the 
server (ping the server IP address). 
Check that UR settings for both SNTP 
servers are configured with different IP 
addresses and port numbers.

PBEthPort-# Offline Process Bus Module Ethernet 
port failure.
Error registers when an 
enabled port fails.

Error Latched? Description Test frequency Action
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PB SFP Module # Fail Small form-factor pluggable 
port (SFP) at back of Process 
Bus Module is faulty or 
unplugged

Connect or replace with same SFP type

PROTOTYPE FIRMWARE:

Self Test Error Seen until the build is tagged 
as being 'release candidate' 
or 'gold' build

Seen on startup and 
then continuous

Update firmware to either of these 
builds

RRTD COMM FAIL:

Self Test Error No Communications with remote 
RTD unit (RRTD) or GPM-F 
failed for longer than 10 
seconds

Runs only if "Com2 
Usage" is set to RRTD 
or RRTD&GPM-F. 
Checked every five 
seconds.

Check COM2 port settings, check 
RS485 cables

RxGOOSE FAIL:

Missing messages No One or more RxGOOSE 
messages are not being 
received

The self-test is 
activated when no 
message is received 
within the expected 
time interval, which 
is the time-to-live 
time in the previous 
message. This time 
can be from 
milliseconds to 
minutes.

Check GOOSE setup

RxGOOSE OFFLINE:

COMM Path Incomplete No One or more RxGOOSE 
messages are not responding

Event driven. The test 
is performed when a 
device programmed 
to receive GOOSE 
messages stops 
receiving. This can be 
from 1 to 60 
seconds, depending 
on GOOSE packets.

Check GOOSE setup

SETTINGS SAVE ERROR:

Contact Factory Yes The relay failed to store the 
settings to the flash memory

When a setting is 
changed

Contact the factory

STORAGE MEDIA ALARM:

Self Test Error No The CPU module fails to read 
from or write to the Compact 
Flash (CF) card inside the 
module. The CF card stores 
certain non-volatile data, 
such as event records, 
oscillography and datalogger 
records, fault report values, 
and non-volatile actual 
values. Settings are not stored 
in CF and hence are 
unaffected by this self-test.

On power up. 
Afterwards, every 
time the CPU 
accesses the CF card 
for reading or writing

Contact the factory

Error Latched? Description Test frequency Action
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7.2.2.4  HardFiber major self-test error messages
In addition to those provided by the standard UR-series devices, the UR devices implement HardFiber self-tests. These are 
listed here. Any abnormal diagnostic condition indicated by the LEDs or the critical failure relay also results in a self-test 
message, so troubleshooting is described here. For other relays, such at the B95Plus, see that product’s instruction manual.

SV# STREAM TROUBLE Yes Asserted when "3 out of 5 
lost" errors are detected or 
when no sampled values 
have been received for 160 
samples

SYSTEM EXCEPTION:

Press RESET key Yes Abnormal restart from 
modules being removed or 
inserted while the F60 is 
powered-up, when there is an 
abnormal DC supply, or as a 
result of internal relay failure.

Event driven Contact the factory

TEMP MONITOR:

OVER TEMPERATURE Yes The ambient temperature is 
greater than the maximum 
operating temperature 
(+80°C)

Every hour Remove the F60 from service and 
install in a location that meets 
operating temperature standards

UNIT NOT CALIBRATED:

with 2nd line DSP slot number 
detail

Yes DSP module is not calibrated 
or calibration data is out of 
range

On relay startup The respective DSP module has to be 
replaced, contact factory service

VOLTAGE MONITOR:

with 2nd line detail

Power Supply 12V Low
Power Supply 12V High
Power Supply 5V Low
Power Supply 5V High

Yes The relay detected a problem 
with the internal voltage rails 
for longer than 25 seconds

Every five seconds Contact GE customer service

WRONG TRANSCEIVER:

Self Test Error Yes The type of SFP does not 
match the CPU type. The SFP 
is a silver device that plugs 
into the rear of the CPU 
module.

T-type CPU = All ports support 
fiber SFPs only
U-type CPU = Maintenance 
port needs RJ45 SFP and the 
other two ports fiber SFPs
V-type CPU = All ports support 
RJ45 SFPs only

The consequence of an 
incorrect SFP can range from 
damage to the F60 to no 
power information for the F60 
on its web page (enter IP 
address in a web browser, 
then click the SFP 
Transceiver Information — 
only the type of SFP displays 
and not power data).

A web page "SFP Transceiver 
Information" is provided. This page 
displays the type of the SFP in it. This 
data is to be used with the CPU type to 
know the cause of the problem.

Error Latched? Description Test frequency Action
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Table 7-4: HardFiber major self-test errors

Error Description Severity Action

EQUIPMENT MISMATCH The number or type of installed 
hardware modules does not 
match the order code stored in 
the CPU. The standard UR-series 
Equipment Mismatch self-test is 
extended to cover the possible 
presence of a Process Card.

Protection is not 
available and all 
contact outputs and 
shared outputs are de-
asserted

Check all modules against the order code. Ensure 
they are inserted properly, and cycle the control 
power. If a module has intentionally been added 
or removed use the Update Order Code 
command to notify the relay that the current 
module configuration is correct.

MODULE FAILURE UR-series device module 
hardware failure detected

Protection is not 
available and all 
contact outputs and 
shared outputs are de-
asserted

Contact the factory and supply the failure code 
noted in the display. Text in the message 
identifies the failed module (for example, H81). If 
operated on a Process Card failure, the Module 
Fail self-test seals-in (latches) till the UR-series 
device is restarted.

PROCESS BUS FAILURE Mission critical data is not 
available via the process bus. An 
AC quantity is considered critical 
if both AC bank origins and the 
crosschecking settings are other 
than None. This self-test is also 
initiated by an AC input 
discrepancy being detected. See 
the description in the 
Crosschecking setting in the 
HardFiber manual for further 
information. In addition, this self-
test can be initiated by user logic 
responding to loss of critical 
contact input/output or other 
data using the Process Bus 
Failure Operand user-
programmable self-test setting. 
This setting is located in the 
Settings > Product Setup > 
User-Programmable Self Test 
menu.

Protection is not 
available and all 
contact outputs and 
shared outputs are de-
asserted

First rectify any Process Bus Trouble and Brick 
Trouble self-test errors. Check the actual value of 
the operand referenced by the Process Bus 
Failure Operand setting, and if “On,” determine 
the cause and rectify.

If the problem persists with the foregoing all clear, 
the cause must be an AC input discrepancy, 
which is typically the result of problems in the 
input signals to the Bricks, or faults in the Brick 
input conditioning hardware. If the error was 
annunciated the first time significant signal was 
encountered, suspect the former cause and 
check the copper connections external to the 
Brick. Where multiple UR-series devices have 
self-test errors, look for common causes.

To further isolate AC input discrepancy errors, put 
the relay in test-isolated mode, then one by one, 
temporally change an AC bank Crosschecking 
setting to None, until the Process Bus Failure 
clears. Once the problem AC bank has been 
identified, the values from each of the two Bricks 
can be examined individually by temporarily 
mapping each to an AC bank with a single origin.
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7.2.2.5  HardFiber minor self-test error messages

Table 7-5: HardFiber minor self-test errors

Error Description Severity Action

BRICK TROUBLE Brick internal self-testing has 
detected trouble internal to the 
Brick

This self-test error does 
not directly inhibit 
protection. However, 
some or all of the 
affected Brick inputs/
outputs may not be 
available to the UR 
device.

Check the Brick environment for over/under 
temperatures and the voltage of its power 
source. If the ambient temperature and supply 
voltage are within Brick specifications, consult 
the factory. Troubles resulting from a Brick output 
failing to respond to an output command can 
only be detected while the command is active, 
and so in this case the target is latched. A latched 
target can be unlatched by pressing the front 
panel reset key if the command has ended, 
however the output can still be non-functional.

PROCESS BUS TROUBLE Communications problems with 
one or more Bricks. The text of 
the message identifies the 
affected field units. This self-test 
is initiated by low received signal 
levels at either the Brick or 
Process Card end, and by the 
sustained failure to receive poll 
responses from the proper Brick.

This self-test error does 
not directly inhibit 
protection. However, 
the affected Brick 
inputs/outputs may 
not be available to the 
UR device.

Check the field unit actual values. An indication of 
equipment mismatch means that messages are 
being received from a Brick, but there is a 
discrepancy between the settings and the actual 
Brick serial number, order code, and/or core 
number.

Check that the correct core on the correct Brick is 
patched through to the correct Process Card 
port, and that the field unit settings are correct. 
An indication of communications loss means that 
no messages are being received.

Check that the patching is correct, and that the 
Brick has power. If that is not the problem, use a 
professional optical fiber connector cleaning kit 
to clean both sides of all optical fiber connections 
from the Process Card through to the affected 
Brick. If the problem continues after cleaning, 
consult the factory.

RTD TROUBLE:

Self Test Error The Brick is reporting that the 
sensed RTD field connection 
does not match that of an RTD or
the reported DC input value is 
outside of the RTD temperature 
range, greater than 250°C (likely 
open sensor circuit fault) or less 
than -50°C (likely shorted sensor 
fault).

Not latched Check field RTD settings and connections

TDR TROUBLE:

Self Test Error The Brick is reporting that the 
sensed transducer field 
connection does not match that 
of a transducer, or the reported 
DC input value is outside of the 
set transducer input range, or 
the minimum value setting is 
equal to the maximum value 
setting.

Not latched Check field transducer settings and connections



7-16 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

TARGETS MENU CHAPTER 7: COMMANDS AND TARGETS

7



F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL 8-1

F60 Feeder Protection System

Chapter 8: Commissioning

Commissioning

This chapter outlines how to test frequency timing.

8.1  Testing

8.1.1  Testing underfrequency and overfrequency elements
Underfrequency and overfrequency protection requires techniques with subtle testing implications. Whereas most 
protection is designed to detect changes from normal to fault conditions that occur virtually instantaneously, power 
system inertia requires frequency protection to pick up while the frequency is changing slowly. Frequency measurement is 
inherently sensitive to noise, making high precision in combination with high speed challenging for both relays and test 
equipment.

Injection to a particular F60 frequency element must be to its configured source and to the channels that the source uses 
for frequency measurement. For frequency measurement, a source uses the first quantity configured in the following 
order:

1. Phase voltages

2. Auxiliary voltage

3. Phase currents

4. Ground current

For example, if auxiliary voltage and phase currents are configured, the source uses the auxiliary voltage, not the phase 
voltages or any of the currents.

When phase voltages or phase currents are used, the source applies a filter that rejects the zero-sequence component. As 
such, the same signal must not be injected to all three phases, or the injected signal is completely filtered out. For an 
underfrequency element using phase quantities, the phase A signal must be above the MIN VOLT/AMP setting value. 
Therefore, either inject into phase A only, or inject a balanced three-phase signal.
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Figure 8-1: Typical underfrequency element test timing 

The static accuracy of the frequency threshold is determined by slowly adjusting the frequency of the injected signal about 
the set pickup. If the F60 frequency metering feature is used to determine the injected frequency, verify the metering 
accuracy by checking it against a known standard (for example, the power system).

To accurately measure the time delay of a frequency element, a test emulating realistic power system dynamics is 
required. Let the injected frequency ramp smoothly through the set threshold, with the ramp starting frequency sufficiently 
outside the threshold so that the relay becomes conditioned to the trend before operation. For typical interconnected 
power systems, the recommended testing ramp rate is 0.20 Hz/s.

The required delay time is the interval from the point the frequency crosses the set threshold to the point that the element 
operates. Some test sets can measure only the time from the ramp start to element operation, necessitating the 
subtraction of the pre-threshold ramp time from the reading. For example, with a ramp rate of 0.20 Hz/s, start the ramp 
0.20 Hz before the threshold and subtract 1 second from the test set time reading of ramp start to relay operation.

Note that the F60 event records only show the “pickup delay” component, a definite time timer. This is exclusive of the time 
taken by the frequency responding component to pickup.

F60 oscillography can be used to measure the time between the calculated source frequency crossing the threshold and 
element operation; however, this method omits the delay in the calculated source frequency. The security features of the 
source frequency measurement algorithm result in the calculated frequency being delayed by two to four cycles (or longer 
with noise on the input). In addition, oscillography resolution is 0.004 Hz, which at 0.20 Hz/s corresponds to a delay of 20 
ms. Do not use the tracking frequency in timing measurements, as its algorithm involves phase locking, which purposely 
sets its frequency high or low to allow the F60 sample clock to catch-up or wait as necessary to reach synchronism with 
the power system.
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Chapter 9: Theory of operation

Theory of operation

This chapter outlines advanced information on operation.

9.1  High-impedance (Hi-Z) fault detection

9.1.1  Description
The Hi-Z element accomplishes high-impedance fault detection using a variety of algorithms, all coordinated by an expert 
system. At the heart of the high-impedance fault-detection system is the identification of arcing on a feeder. If the Hi-Z 
element detects arcing, it then determines whether or not the arcing persists for a significant period of time. If it does, the 
Hi-Z element determines whether the persistent arcing is from a downed conductor or from an intact conductor and then 
generates an output to indicate either the detection of a downed conductor or the detection of arcing, respectively.

Distinction between an arcing intact conductor and an arcing downed conductor is determined by looking at patterns in 
the load current at the beginning of the fault. A downed conductor is indicated when a precipitous loss of load or an 
overcurrent condition precedes arcing detection. Otherwise, the Hi-Z element assumes that the line is intact, even if arcing 
is present. In such a case, if the detected arcing can be classified as persistent, and an output contact is configured for 
'arcing detected,' the Hi-Z element closes that contact.

In some cases, arcing is determined to be present, but not persistent. For example, when it is caused by tree limb contact 
or insulator degradation, arcing typically is present intermittently with relatively long periods of inactivity (such as minutes) 
interspersed. In such cases, arcing can be affected by such factors as the motion of a tree limb or the moisture and 
contamination on an insulator. Conditions such as these, characterized by a high number of brief occurrences of arcing 
over an extended period of time (for example from a fraction of an hour to one or two hours), lead the Hi-Z element to 
recognize and flag an “arcing suspected” event. None of these brief occurrences of arcing, if taken individually, are 
sufficient to indicate detection of a downed conductor or to set off an alarm indicating that persistent arcing has been 
detected. When considered cumulatively, however, they do indicate a need for attention. If an output contact is configured 
to indicate 'arcing suspected,' the Hi-Z element recognition of such sporadic arcing closes that contact and appropriate 
actions can be taken.

If the Hi-Z element determines that a downed conductor exists, oscillography and fault data are captured. In addition, 
target messages and appropriate LEDs are activated on the relay faceplate.

The detection of a downed conductor or arcing condition is accomplished through the following algorithms:

• Energy algorithm

• Randomness algorithm

• Expert Arc Detector algorithm
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• Load Event Detector algorithm

• Load Analysis algorithm

• Load Extraction algorithm

• Arc Burst Pattern Analysis algorithm

• Spectral Analysis algorithm

• Arcing-Suspected Identifier algorithm

• Even Harmonic Restraint algorithm

• Voltage Supervision algorithm

The following sections explain the algorithms.

9.1.2  Energy algorithm
The Energy algorithm monitors a specific set of non-fundamental frequency component energies of phase and neutral 
current. After establishing an average value for a given component energy, the algorithm indicates arcing if it detects a 
sudden, sustained increase in the value of that component. The Hi-Z element runs the Energy algorithm on each of the 
following parameters for each phase current and for the neutral:

• Even harmonics

• Odd harmonics

• Non-harmonics

On a 60 Hz system, the non-harmonic component consists of a sum of the 30, 90, 150,..., 750 Hz components, while on a 50 
Hz system, it consists of a sum of the 25, 75, 125,..., 625 Hz components. If the Energy algorithm detects a sudden, 
sustained increase in one of these component energies, it reports this to the Expert Arc Detector algorithm, resets itself, 
and continues to monitor for another sudden increase.

9.1.3  Randomness algorithm
The Randomness algorithm monitors the same set of component energies as the Energy algorithm but differs slightly. 
Rather than checking for a sudden, sustained increase in the value of the monitored component energy, it looks for a 
sudden increase in a component followed by highly erratic behavior. This type of highly erratic behavior is indicative of 
many arcing faults. Just as with the Energy algorithm, if the Randomness algorithm detects a suspicious event in one of its 
monitored components, it reports it to the Expert Arc Detector algorithm, resets itself, and continues to monitor for another 
suspicious event.

9.1.4  Expert Arc Detector algorithm
The Expert Arc Detector algorithm assimilates the outputs of the basic arc detection algorithms into one "arcing 
confidence" level per phase. Note that there are actually 24 independent basic arc detection algorithms, since both the 
Energy algorithm and the Randomness algorithm are run for the even harmonics, odd harmonics, and non-harmonics for 
each phase current and for the neutral. The assimilation performed by the Expert Arc Detector algorithm, then, is 
accomplished by counting the number of arcing indications determined by any one of the 24 algorithms over a short 
period of time (for example the last 30 seconds). Also taken into account is the number of different basic algorithms that 
indicate arcing.

In the Expert Arc Detector algorithm, the arcing confidence level for each phase increases as the number of basic 
algorithms that indicate arcing (per phase) increases. It also increases with increasing numbers of indications from any 
one basic algorithm. These increases in confidence levels occur because multiple, consecutive indications from a given 
algorithm and indications from multiple independent algorithms are more indicative of the presence of arcing than a 
single algorithm giving a single indication.
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9.1.5  Spectral Analysis algorithm
The Spectral Analysis algorithm is the third and final confirmation algorithm performed only when a high impedance 
condition is suspected.

The Spectral Analysis algorithm receives five seconds of averaged non-harmonic residual current spectrum data and 
compares it to an ideal 1 / f curve. Depending on the result, three percent can be added to the arcing confidence level 
generated by the Expert Arc Detector algorithm.

9.1.6  Load Event Detector algorithm
The Load Event Detector algorithm examines, on a per-phase basis, one reading of RMS values per two-cycle interval for 
each phase current and the neutral. It then sets flags for each phase current and for the neutral based on the following 
events:

• An overcurrent condition

• A precipitous loss of load

• A high rate-of-change

• A significant three-phase event

• A breaker open condition

These flags are examined by the Load Analysis algorithm. Their states contribute to that algorithm's differentiation 
between arcing downed conductors and arcing intact conductors, and inhibit the Expert Arc Detector algorithm from 
indicating the need for an arcing alarm for a limited time following an overcurrent or breaker open condition.

Any of these five flags zero the Expert Arc Detector buffer, since the power system is in a state of change and the values 
being calculated for use by the Energy and Randomness algorithms are probably not valid.

An extremely high rate of change is not characteristic of most high impedance faults and is more indicative of a breaker 
closing, causing associated inrush. Since this type of inrush current causes substantial variations in the harmonics used by 
the high impedance algorithms, these algorithms ignore all data for several seconds following a high rate-of-change event 
that exceeds the associated rate-of-change threshold, in order to give the power system a chance to stabilize.

9.1.7  Load Analysis algorithm
The Load Analysis algorithm differentiates between arcing downed conductors and arcing intact conductors by looking for 
a precipitous loss of load and/or an overcurrent disturbance at the beginning of an arcing episode. The presence of arcing 
on the system is determined based on the output of the Expert Arc Detector algorithm. If the Hi-Z element finds persistent 
arcing on the power system, the Load Analysis algorithm then considers the type of incident that initiated the arcing and 
classifies the arcing conductor as either downed or intact. Another function of the algorithm is to provide coordination 
between the Hi-Z element and the power system's conventional overcurrent protection by observing a timeout, via the HI-
Z OC PROTECTION COORD TIMEOUT setting from the beginning of the arcing before giving an indication of arcing.

If the Load Analysis algorithm determines that a downed conductor or arcing exists, it attempts to determine the phase on 
which the high impedance fault condition exists. It does this in a hierarchical manner. First, if a significant loss of load 
triggered the Load Analysis algorithm, and if there was a significant loss on only one phase, that phase is identified. If there 
was not a single phase loss of load, and if an overcurrent condition on only one phase triggered the algorithm, that phase 
is identified. If both of these tests fail to identify the phase, the phase with a significantly higher confidence level (for 
example higher than the other two phases by at least 25%) is identified. Finally, if none of these tests provides phase 
identification, the result of the Arc Burst Pattern Analysis algorithm is checked. If that test fails, the phase is not identified.

9.1.8  Load Extraction algorithm
The Load Extraction algorithm attempts to find a quiescent period during an arcing fault so that it can determine the 
background load current level in the neutral current. If it is successful in doing so, it then removes the load component 
from the total measured current, resulting in a signal that consists only of the fault component of the neutral current. This 
information is then provided as input to the Arc Burst Pattern Analysis algorithm.
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9.1.9  Arc Burst Pattern Analysis algorithm
The Arc Burst Pattern Analysis algorithm attempts to provide faulted phase identification information based on a 
correlation between the fault component of the measured neutral current and the phase voltages. The phase identified is 
the one whose phase voltage peak lines up with the neutral current burst. The fault component is received from the Load 
Extraction algorithm. The result of the analysis is checked by the Load Analysis algorithm if its other phase identification 
methods prove unsuccessful.

9.1.10  Arcing Suspected algorithm
The purpose of the Arcing Suspected algorithm is to detect multiple, sporadic arcing events. If taken individually, such 
events are not sufficient to warrant an arcing alarm. When taken cumulatively, however, these events do warrant an alarm 
to system operators so that the cause of the recurrent arcing can be investigated.

9.1.11  Overcurrent disturbance monitoring
This function is part of High Impedance Fault Detection and is not be confused with conventional overcurrent protection. 
The Hi-Z element monitors for an overcurrent condition on the feeder by establishing overcurrent thresholds for the 
phases and for the neutral and then checking for a single two-cycle RMS current that exceeds those thresholds. 
Oscillography and fault data are captured if it is determined that an overcurrent condition exists.

9.1.12  Hi-Z Even Harmonic Restraint algorithm
Every two-cycle interval, the algorithm evaluates the even harmonic content of each phase current. The even harmonic 
content is evaluated as a percentage of the phase RMS current. If for any phase the percentage is greater than the HI-Z 
EVEN HARMONIC RESTRAINT setting, the algorithm inhibits setting of the overcurrent flags. This is to prevent a cold-load 
pickup event from starting the Hi-Z logic sequence (which requires the overcurrent flag or the loss-of-load flag to be set at 
the beginning of an arcing event). The duration over which the algorithm inhibits the setting of the overcurrent flag(s) is 
from the time the even-harmonic level (as a percentage of RMS) increases above the threshold until one second after it 
falls back below the threshold.

9.1.13  Hi-Z Voltage Supervision algorithm
This algorithm was implemented to minimize the probability of a false Hi-Z indication due to bus voltage dips, for example 
from parallel feeder faults. A fault on a parallel line can cause voltage dips that produce a decrease in the line load that 
can be mistaken by the Hi-Z element as Loss of Load.

Every two cycles, the voltage on each phase is checked against the HI-Z V SUPV THRESHOLD. If the voltage on any phase has 
dropped by a percentage greater than or equal to this setting, the Loss of Load flag is blocked. The blocking is not done on 
a per-phase basis. If one phase voltage shows a dip, the block is applied for all phases. Also the High Impedance 
Oscillography records that a voltage dip was experienced. The Oscillography record is phase-specific.

9.2  Fault locator

9.2.1  Fault type determination
Fault type determination is required for calculation of fault location. The algorithm uses the angle between the negative 
and positive sequence components of the relay currents. To improve accuracy and speed of operation, the fault 
components of the currents are used; that is, the pre-fault phasors are subtracted from the measured current phasors. In 
addition to the angle relationships, certain extra checks are performed on magnitudes of the negative and zero-sequence 
currents.

The single-ended fault location method assumes that the fault components of the currents supplied from the local (A) and 
remote (B) systems are in phase. The figure shows an equivalent system for fault location.
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Figure 9-1: Equivalent system for fault location 

The following equations hold true for this equivalent system.

Eq. 9-1

where

m = sought pu distance to fault
Z = positive sequence impedance of the line
IF = fault current flowing through the fault point

The fault network during a fault can be decomposed into a pre-fault and a pure-fault network. Therefore, the fault current 
IF is calculated as follows by using the current division rule in the pure-fault network.

Eq. 9-2

where

d is the current distribution factor, which is a complex value

Substituting the second equation into the first equation and multiplying both sides by the complex conjugate of IAF,

Eq. 9-3

where

* denotes complex conjugate

Assuming the system is homogeneous, d is then a real number. The fault resistance does not have any imaginary part. The 
preceding equation solved for the unknown m yields the following fault location algorithm:

Eq. 9-4

where

Im( ) stands for the imaginary part of a complex number

Depending on the fault type, appropriate voltage and current signals are selected from the phase quantities before 
applying the preceding equation (the superscripts denote phases, the subscripts denote stations).

For AG faults:

Eq. 9-5
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For BG faults:

Eq. 9-6

For CG faults:

Eq. 9-7

For AB and ABG faults:

Eq. 9-8

For BC and BCG faults:

Eq. 9-9

For CA and CAG faults:

Eq. 9-10

where K0 is the zero sequence compensation factor (for the first six equations)

Z0M is the mutual zero sequence impedance

I0M = IG/3 and IG is the ground current of the adjacent line. The I0M compensation term is applied for the entirely parallel 
line.

For ABC faults, all three AB, BC, and CA loops are analyzed and the final result is selected based upon consistency of the 
results.

The element calculates the distance to the fault (with m in miles or kilometers) and the phases involved in the fault.

The relay allows locating faults from delta-connected VTs. If the FAULT REPORT 1 VT SUBSTITUTION setting is set to “None,” 
and the VTs are connected in wye, the fault location is performed based on the actual phase to ground voltages. If the VTs 
are connected in delta, fault location is suspended.

If the FAULT REPORT 1 VT SUBSTITUTION setting value is “V0” and the VTs are connected in a wye configuration, the fault 
location is performed based on the actual phase to ground voltages. If the VTs are connected in a delta configuration, fault 
location is performed based on the delta voltages and externally supplied neutral voltage:

Eq. 9-11

If the FAULT REPORT 1 VT SUBSTITUTION setting value is “I0” and the VTs are connected in a wye configuration, the fault 
location is performed based on the actual phase to ground voltages. If the VTs are connected in a delta configuration, fault 
location is performed based on the delta voltages and zero-sequence voltage approximated based on the zero-sequence 
current:

Eq. 9-12
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where ZSYS0 is the equivalent zero-sequence impedance behind the relay as entered under the fault report setting menu.

Figure 9-2: Fault locator scheme 
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F60 Feeder Protection System

Chapter 10: Maintenance

Maintenance

This chapter outlines monitoring, maintenance, repair, storage, and disposal of the hardware and software.

10.1  Monitoring
Devices and data can be monitored.

10.1.1  Devices with Site Targets
To view an overview of devices:

1. Access the Site Targets item in the Online Window area, below the list of devices. It can take a few minutes for all 
devices to be read.

2. Acknowledge any messages for unaccessible devices. The Site Targets window opens when done.

Figure 10-1: Site Targets window

10.1.2  Data with Modbus Analyzer
Use the Modbus Analyzer under Maintenance > Modbus Analyzer to monitor the values of the UR device. Use the Modbus 
memory map addresses outlined in the UR Family Communications Guide for the entries.

The upper part of the window displays values. The lower part of the window is for factory service use.
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The first row in the figure shows that Contact Output 1 operation is being monitored. Its Modbus address is CAFA. The 
actual value read from the device is 0, which means that it is off.

The second row in the figure shows the Contact Output 1 Name. It has a Modbus address of CAF0 and a default value of 
"Cont Op 1." None of Selection column settings render this value because they present the information based on 
numbering systems.

Figure 10-2: Modbus Analyzer used to monitor actual values on a UR

Address (HEX) — Modbus address in hexadecimal. See the Modbus memory map in the UR Family Communications Guide 
or in the web interface (enter IP address of UR device in a web browser).

Modbus Type 
Actual Value — To read the data in the UR device
Setting — To read a setting in the UR device
Coil — To read a command in the UR device

# of — Element, input, or output to read. An example is 1 for Contact Output 1.

Selection (examples demonstrate various ways to represent 0)
Hex — A decimal numbering system based on 16 possible values, from 0 to 9 and A to F. An example is 0x0000.
Char — A single unicode character, such as C. An example is 0.
Int — A 32-bit number, either positive or negative. An example is 0.
UInt — Unsigned 32-bit integer, which means that it cannot be negative but can be twice as large as a signed integer. An 
example is 0.
Long — A 64-bit number, either positive or negative. An example is 0.
ULong — Unsigned 64-bit number, which means that it cannot be negative but can be twice as large as a signed 64-bit 
number. An example is 0.
Float — A numbering system with no fixed number of digits before or after the decimal point. An example is 0.000000.
Binary — A numbering system using 0 and 1. An example is 0000-0000-0000-0000.

Entries are not saved when closing the window.
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10.2  General maintenance
The F60 requires minimal maintenance. As a microprocessor-based relay, its characteristics do not change over time. 
Expected service life is 20 years for UR devices manufactured June 2014 or later when applied in a controlled indoor 
environment and electrical conditions within specification.

While the F60 performs continual self-tests, it is recommended that maintenance be scheduled with other system 
maintenance. This maintenance can involve in-service, out-of-service, or unscheduled maintenance.

10.2.1  In-service maintenance
1. Visual verification of the analog values integrity, such as voltage and current (in comparison to other devices on the 

corresponding system).

2. Visual verification of active alarms, relay display messages, and LED indications.

3. LED test.

4. Visual inspection for any damage, corrosion, dust, or loose wires.

5. Event recorder file download with further events analysis.

10.2.2  Out-of-service maintenance
1. Check wiring connections for firmness.

2. Analog values (currents, voltages, RTDs, analog inputs) injection test and metering accuracy verification. Calibrated 
test equipment is required.

3. Protection elements setting verification (analog values injection or visual verification of setting file entries against 
relay settings schedule).

4. Contact inputs and outputs verification. This test can be conducted by direct change of state forcing or as part of the 
system functional testing.

5. Visual inspection for any damage, corrosion, or dust.

6. Event recorder file download with further events analysis.

7. LED Test and pushbutton continuity check.

10.2.3  Unscheduled maintenance (system interruption)
View the event recorder and oscillography or fault report for correct operation of inputs, outputs, and elements.

10.3  Retrieve files
Data, oscillography, log, events, routing, ARP, and other files can be transferred using the EnerVista software to a computer 
or to a USB flash drive when using the graphical front panel. These files can be requested by technical support staff.

To retrieve a file using EnerVista software:

1. If the CyberSentry option is enabled, log in to the EnerVista software using the Administrator role.

2. In the Online Window area of EnerVista, access Maintenance > Retrieve File. The window opens.

3. Note the destination folder to which the file is to be saved at the top and change it if required. You can copy the path 
or open the folder for convenience at this time.

4. Select the file to download from the UR device.

To avoid deterioration of electrolytic capacitors, power up units that are stored in a de-energized 
state once per year, for one hour continuously.
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5. Click the Read File button. The file is saved to the destination folder. The EnerVista window remains open to download 
additional files.

To retrieve a file using a USB drive:

1. Insert the USB drive into the bottom USB port on the graphical front panel. The page displays on the front panel.

2. Using the Up or Down pushbuttons on the front panel, select the file.

3. Press the COPY pushbutton. The files are copied from the F60 to the USB drive.

4. When done, to exit unplug the USB drive or press the ESCAPE pushbutton.

10.3.1  CyberSentry security event files
CyberSentry security events are available in the following two files: SECURITY_EVENTS.CSV and SETTING_CHANGES.LOG.

10.3.1.1  Security events file
The figure shows the content for the SECURITY_EVENTS.CSV file.

Figure 10-3: Security events file

Time — Local time.

Activity — The actual security event.
1 = Authentication Failed
2 = User Lockout
3 = FW Upgrade
4 = FW Lock
5 = Settings Lock
6 = Settings Change, this can fill the entire event log. Hence it is supported by the already existing 
SETTINGS_CHANGE.LOG file. This event is not required.
7 = Clear Oscillography command
8 = Clear Data Logger command
9 = Clear Demand Records command
10 = Clear Energy command
11 = Reset Unauthorized Access
12 = Clear Teleprotection Counters
13 = Clear All Records
14 = Role Log out
15 = Role Log in

Change Method — Format code F229 for the settings control change method.

Do not unplug the USB drive while copying is in progress, else the USB drive can be compromised.
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0 = None
1 = Keypad
2 = Front port
3 = COM1 (not used)
4 = COM2 (RS485)
5 = Ethernet

10.3.1.2  Setting changes file
The SETTING_CHANGES.LOG file stores all the setting changes. A total of 1024 events are stored in a circular buffer in non-
volatile memory.

Figure 10-4: Setting changes file

10.4  Convert device settings
Settings files can be upgraded or downgraded to other firmware versions. For example, version 7.4 settings can be 
upgraded to version 7.6.

Settings are reset to factory default upon conversion. For a graphical front panel, for example when upgrading from 
version 7.6 to 7.7, single-line diagrams and cells configured for the Metering Editor are defaulted, while other graphical 
front panel settings are retained.

When converting a settings file from version 7.20 or earlier to 7.70 or later, any IEC 61850 settings are defaulted, and 
Edition 2 is used.

When converting a settings file from version since 7.30 inclusive to 7.70 or later, any IEC 61850 settings are converted and 
Edition 2 is used.

When converting a settings file with IEC 61850 Edition 1 to version 7.80 or later with a non-HardFiber Process Bus Module 
(order code 85, 86, or 87), conversion does not take place and an error message displays. The Process Bus Module does not 
support Edition 1.

To convert settings:

1. If not already in the Offline Window area, right-click the online device in the EnerVista software and select the Add 
Device to Offline Window option. This copies the settings to the Offline Window area. Any message about file repair 
usually means that settings were missing in the original file and have been added with default values to the new file.

2. Make a copy of the settings file in the Offline Window area by right-clicking the file and selecting Duplicate Device. A 
copy of the file is made and the file name start with "Copy of." Optionally rename the file by right-clicking it and 
selecting the Rename Device option.

3. Convert the settings by right-clicking one of the files in the Offline Window and selecting the Convert Device Settings 
option.

If the option does not display, click the Admin > User Management menu item and enable the Update Info check box 
for the user. Save.
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Or if the option does not display, click the Admin > User Management menu item and enable the Enable Security 
check box. Save. Select the Admin > User Login menu item. Enter "Administrator" for the user and enter the password. 
(Contact GE Grid Solutions if you do not know the default password.)

GE recommends converting settings in firmware steps, for example when converting from 6.0 to 7.4x, convert first to 
7.0 then 7.4 in order to follow embedded conversion rules and keep settings.

The settings convert and a report generates.

Figure 10-5: Upgrade settings

4. Review the conversion report. The values of all settings that have been defaulted during conversion are not listed in 
the conversion report; to find the value of a setting before conversion, inspect the device backup file made before 
conversion.

In the example shown here, settings have been reset to factory defaults and several settings are new in firmware 
version 7.6 under Settings > System Setup > Switches and Breakers.

Figure 10-6: Conversion report

5. Change settings in the new file, for example by looking at the original file.

6. Write the converted file to the device, for example by dragging and dropping from the Offline Window to the Online 
Window.
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7. Check settings and operation.

10.5  Copy settings to other device
Settings from one F60 device can be copied to another F60 device for rapid deployment. The order codes and IEC 61850 
edition must match. See the Settings File section at the beginning of the Interfaces chapter for a list of settings not 
deployed.

1. Right-click the device in the Online window and select the Add Device to Offline Window option. A window opens.

2. Check the file path and name the file, then click the Receive button. An example is to save the files in 
D:\Users\Public\Public Documents\GE Power Management\URPC\Data\ and to name the source device 
F60_Deployment. At the prompt, confirm the action. The settings are saved in .cid, .icd, and .urs files, and the entry 
displays in the Offline window area.

3. Right-click the device in the Offline window area and select the Duplicate Device option. The device is copied with a 
prefix of "Copy of." Multiple duplicates results in files being named "Copy of Copy of" for example, which can be 
avoided by deleting the folder copies from the path shown on mouse-over.

4. Right-click the copied device and rename it.

5. Right-click the copied device and select the Edit Device Properties option. Make the changes for the new device.

6. Send the file to new device by dragging and dropping it into the Online Window area. Or right-click and select the 
Write Settings to Device option.

7. Update the remaining settings, such as IP address.

10.6  Compare settings
Settings are comparable against default values and between two UR devices.

Some of the IEC 61850 settings use floating point data, which guarantees accurate representation of real numbers up to 
seven digits. Numbers with more than seven digits are approximated within a certain precision. This can result in 
differences between what is entered and what is saved, and for example results in differences shown on a settings 
comparison report.

When comparing two settings files with the graphical front panel, all graphical front panel features are compared except 
for the single-line diagrams.

10.6.1  Compare against defaults
1. Right-click the device in the Offline Window area and select Compare Settings With Defaults. The file generates and 

the number of differences displays.

2. To save the report, click File > Save As, select the TXT, PDF, or CSV format from the drop-down list, and enter a name 
for the file.

In the figure, the first entry is from the device, while the second is the default value.

Figure 10-7: Device settings compared with default values
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10.6.2  Compare two devices
Preferences are set under File > Preferences as follows:

• Comparison Report: Sequential File 1, File 2 Layout — When disabled (default), the report shows only what differs, as 
shown in the previous figure. When enabled, the report indicates differences by device.

Figure 10-8: Device settings compared between two devices, displayed sequentially

There are two ways to compare devices: devices in the Offline area or between Online and Offline devices.

To compare settings of two devices in the Offline Window area:

1. Right-click a first device in the Offline Window area and select Compare Two Devices.

2. In the window that opens, select a second device and click the Receive button. The file generates and the number of 
differences displays.

3. To save the report, click File > Save As, select the TXT, PDF, or CSV format from the drop-down list, and enter a name 
for the file.

To compare settings between Online and Offline devices:

1. Right-click a device in the Online Window area and select Compare with Device.

2. In the window that opens, enter a path/file name at the bottom o f the window.

3. Select the second device.

4. Click the OK button. The file generates, and the differences are highlighted in red, which is for the first device.

10.7  Back up and restore settings
Back up a copy of the in-service settings for each commissioned UR device, so as to revert to the commissioned settings 
after inadvertent, unauthorized, or temporary setting changes are made, after the settings defaulted due to firmware 
upgrade, or when the device has to be replaced. This section describes how to backup settings to a file and how to use 
that file to restore the settings to the original relay or to a replacement relay.

For reference, settings can saved with Online > Print Device Information and Online > Export Device Information. They 
cannot be restored using these options.

10.7.1  Back up settings
The following file types can be saved:

• URS — UR settings file — When the IEC 61850 option is not present

• IID — Instantiated IED capability description file — Actual settings on UR

• ICD — IED Capability Description file — Default settings on UR

• CID — Configured IED description file — Settings sent to the UR (may or may not contain the present settings)

UR device settings can be saved in a backup URS file using the EnerVista UR Setup software. The URS file is the standard 
UR settings file. For an introduction to settings files in the URS format, see the beginning of the Interfaces chapter.
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When the IEC 61850 option is present, the settings can be saved alternatively in a backup IID file either using the EnerVista 
UR Setup software in online mode or by using any of the supported file transfer protocols. The IID file is one of several IEC 
61850 Substation Configuration Language (SCL) file types; see the IEC 61850 chapter in the UR Series Communications 
Guide for an introduction to SCL.

"TBD" displays when a setting in a modeled element is configured with a non-modeled operand. For example, Phase IOC is 
modeled in a firmware release, while the LED operands are not modeled. If the block setting of the Phase IOC is configured 
with LED operands, its displays as TBD in IID and CID files, the web interface, or in an MMS client.

The options that display in the EnerVista software when right-clicking depend on device options.

Preferences are set in the File > Preferences > IEC 61850 menu. There are two options as follows:

• Preserve custom attributes when importing SCD/CID files — Applies to the Add Device to Offline Window option. 
When enabled, the IID file also is to be copied to the computer. The IID file that is retrieved from the relay is therefore 
assumed to be in synchronization with the resulting .urs file, and in fact in this situation the IID file on the computer is 
a copy of the IID file that was read from the online device. When disabled, the IID file on the computer is to be left 
unchanged. The location of the IID file is C:\ProgramData\GE Power Management\urpc\Offline, for example.

• Do not update IID file when updating SCL files — When enabled (default), an IID file is not to be created on the 
computer and if one is already present there, it is neither removed nor updated. Have this option enabled when you 
want to keep the IID file from the UR device instead of from another tool. The location of the file is C:\ProgramData\GE 
Power Management\urpc\Offline, for example.

An Environment backup stores a list of sites and devices in the Online and Offline Window areas. Settings files are not 
contained within the environment file. If a settings file is moved, renamed, or deleted after the backup, it is removed from 
the Offline Window during the restore.

To save a settings file in the URS format in EnerVista Online Window:

1. In EnerVista, connect to the device in the Online Window area.

2. Right-click the device name in the Online Window area and select Add Device to Offline Window. A window opens.

3. Select or enter a file name and location, and click the Receive button. A .urs file is created in the Offline Window area.

To create a new settings file in the URS format in EnerVista Offline Window:

1. In EnerVista, right-click in the Offline Window area and select New Device. A window opens.

2. Change the file name at the end of the Path field, keeping the .urs extension.

3. From the Associate File with Device drop-down list, select the UR device. Other fields complete automatically. 
Otherwise, when you do not select a device from the drop-down list, all fields need to be completed manually and 
only devices that match the entered order code and version display in the list.

4. The Serial # Lock field is the serial number of the intended device. It ensures that the settings file is sent only to the 
specific relay that matches the serial number.

5. Click the OK button to create the .urs file in the Offline Window area.

To save settings in the IID format in EnerVista Online Window:

1. In EnerVista, connect to the device in the Online Window area.

2. Right-click the device name in the Online Window area and select Read IID File. The option is not present when the 
device does not have the IEC 61850 option. A window opens when successful.

3. Select or enter a file name and location, and click the Receive button. A .iid file is created.

To save settings in the IID format in EnerVista Offline Window:

1. In EnerVista, right-click the device in the Offline Window area.

2. Select the Create IID File option for firmware below 7.3. The option is not always available. Select the Save As option 
for firmware 7.3 and later, and select the IID option from drop-down list.
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No file is generated. The IID file on the computer is copied to the location specified.

3. If the Do not update IID file when updating SCL files preference is enabled under File > Preferences > IEC 61850, 
then a message displays to that effect. This means that there is no IID file available on the computer to be copied, so 
a new one is generated.

To save settings in the IID format using TFTP:

1. On a computer on the same subnetwork as the UR device, open a command window.

2. Enter
TFTP <IP address> GET ur.iid <destination>

where

<IP address> is the IP address of the UR device
ur.iid is the internal name of the IID file in the UR device
<destination> is the path and file name of the IID file. If omitted, the file is saved as ur.iid in the command window 
default directory.

An example is 
TFTP 192.168.1.101 GET ur.iid Feeder1.iid

To save settings in the ICD format in EnerVista Online Window:

1. In EnerVista, right-click the device in the Online Window area.

2. Select the Read ICD File option. A window opens.

3.  Enter a path/name for the file, and click the Save button.

To save settings in the ICD format in EnerVista Offline Window:

1. In EnerVista, right-click the device in the Offline Window area.

2. Select the Create ICD File option. Or select the Save As option, and select the ICD option from drop-down list.

You can be prompted to specify if the file is for firmware version 7.12 or later.

The file is saved to the location specified.

To save settings in the CID format in EnerVista Online Window:

1. In EnerVista, right-click the device in the Online Window area.

2. Select the Read ICD File option. A window opens.

3.  Enter a path/name for the file, and click the Save button.

To save settings in the CID format in EnerVista Offline Window:

1. In EnerVista, right-click the device in the Offline Window area.

2. Select the Save As option, which displays for firmware 7.3 and later, and select the CID option from the drop-down list.

The file is copied from the computer to the location specified.

To save list of sites and devices with an Environment backup:

1. In EnerVista, click File > Environment > Backup. A window opens.

2. Name and save the .ENV file.
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10.7.2  Restore settings
UR device settings can be restored to the values they were at when a URS backup file was created using the EnerVista UR 
Setup software. When the IEC 61850 option is present, the settings can alternatively be to the values they were at when an 
IID type backup was created either using the EnerVista UR Setup software in online mode or by using any of the supported 
file transfer protocols. Note that TFTP cannot be used here, as TFTP "put" mode is disabled for security reasons.

To restore completely, a few settings need to be entered manually either via EnerVista UR Setup or via the UR device front 
panel. If the restore operation is to be via Ethernet, first the UR device must have its IP address settings entered via the 
front panel. These are located at SETTINGS  PRODUCT SETUP  COMMUNICATIONS  NETWORK 1(3) and SETTINGS  
PRODUCT SETUP  COMMUNICATIONS  IPv4 ROUTE TABLE 1(6)  DEFAULT IPv4 ROUTE  GATEWAY ADDRESS.

When importing a file, it cannot have a blank numeric value. All numeric values must be non-blank, otherwise the file is 
rejected.

URS and IID procedures are outlined here.

To restore settings from a URS file:

1. In EnerVista, connect to the device in the Online Window area.

2. Right-click the .urs file in the Offline Window area and select Add Device from File to locate a file, and/or drag-and-
drop the file from the Offline Window area to the device in the Online Window area.

Figure 10-9: Restoring a URS settings file

3. Two prompts are possible, first that the URS file does not include the complete IEC 61850 configuration and that it 
needs to be recreated if you continue. This means that the URS file is from UR version 7.30 or higher, has the IEC 61850 
software option in the order code, but any IEC 61850 content will be compromised and will need to be configured.

Second, a message can display that the URS file is part of a device folder and to use the device’s CID file. This means 
that the URS file is from UR version 7.3 or higher, has the IEC 61850 software option in the order code, and is part of the 
device folder. The user is trying to add a URS file from inside a device’s folder. Instead, the user needs to use the CID file 
from the device folder.

These messages display because the roles of the protection engineer and network engineer can be separate. The 
former can require a URS file, while the latter can require stored Modbus settings and protection schemes.
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4. Manually copy the remaining settings, outlined as follows.

To restore settings from an IID file using EnerVista software:

1. In Windows, make a copy the IID file with a cid extension.

2. Connect to the device in the Online Window area.

3. In the Offline Window area, right-click Devices and select Import Devices from SCD.

Figure 10-10: Importing an SCD or CID file

4. Navigate to and select the file with .cid extension. When prompted, enter a file name to give to an intermediate URS 
file. The URS file is added to the Offline Window area.

5. Drag the imported file in the Offline Window to the device in the Online Window. Note that the RELAY SETTINGS value 
also is written to a device, and the accepting relay is put into "Programmed" or "Not Programmed" mode as 
configured in the offline file.

6. Manually copy the remaining settings, outlined as follows.

To restore settings from an IID using SFTP:

1. In Windows, make a copy the IID file with a cid extension.

2. On a computer on the same subnetwork as the UR device, open a SFTP client application, such as WinSCP. Note that 
TFTP cannot be used here.

3. Use the device's IP address as the host name.

4. If the device has the CyberSentry option, use the User Name of "Administrator" or "Engineer," and the password 
programmed for the selected role. The default password is "ChangeMe1#" (without quotation marks).

5. If the device does not have the CyberSentry option, use the User Name of "Setting," and the password programmed for 
the Setting role. The default password is "ChangeMe1#" (without quotation marks).

6. Upload the backup file copy with the CID extension. WinSCP uses drag-and-drop or copy-and-paste for this.

7. Manually copy the remaining settings, outlined as follows.

To manually copy remaining settings:

1. Settings listed in section 4.1.2 Settings Files are not transferred to the UR device with settings files. Enter them 
manually either via the front panel or via EnerVista UR Setup software. The values that these settings had at the time 
the backup was created are contained within the backup file, accessed through EnerVista UR Setup software.

To restore the list of sites and devices from an Environment backup:

1. In EnerVista, click File > Environment > Restore. A window opens.

2. Select the .ENV file to restore.
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10.8  Upgrade software
In general, the latest releases of the EnerVista software can be used with all firmware versions. For example, EnerVista 
software released for UR 7.4 can be used to access multiple UR devices that have version 7.4x, 7.2x, and 6.0x firmware 
installed.

Existing installations do not need to be uninstalled before upgrade.

You can also downgrade the software; use the same procedure.

To upgrade the EnerVista software:

1. If a beta version of the EnerVista UR Setup software is installed, uninstall it, for example using the Windows Control 
Panel.

2. For Windows 10, disconnect any USB cable to the F60, else the UR USB drivers do no install correctly.

3. Download the latest EnerVista software and/or firmware from 
http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=7 

4. Double-click the file and complete the wizard. The software installs.

5. Access the software and check the version number under Help > About. If the new version does not display, try 
uninstalling the software and reinstalling the new versions.

6. For Windows 10, to finish installing the UR USB driver, open Device Manager > Ports, then plug in the USB cable (to 
connect the relay and computer). A new port starting with "GE Virtual Serial Port" is available. If available, click the OK 
button to complete the installation.

If not available, uninstall the existing GE USB driver in the Device Manager > Ports. (Right-click and "Uninstall.")

When complete, unplug and re-plug the USB cable connecting the UR device. The "GE Virtual Serial Port" driver is now 
available.

A message can display about a version not being supported. An example is when upgrading from version 7.12K to 7.4x. 
The 7.12K entry is removed from the Offline Window area.

A message can display in the EnerVista software upon launch that "a device from the environment was not recognized." 
This means that a device is online and its firmware version conflicts with the software version. In the example shown, a 
C60 with firmware version 7.5x is online, but the software version is 7.3x. Updating removed incompatible files and 
changed the device to version 7.3x, after which you need to make the order codes consistent as outlined next.

Figure 10-11: Mismatch in order code between software and device

To make the order codes consistent:

1. In EnerVista, click the Device Setup button. The window opens.

2. Expand the entry for the UR device.

3. Click the Read Order Code button. The order code and version of the device are populated to the software.

4. Click the OK button to save the change.

http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=7
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10.9  Upgrade firmware
If upgrading both EnerVista software and F60 firmware, upgrade the software first.

The firmware of the F60 device can be upgraded, locally or remotely, using the EnerVista software.

Upgrades are possible for the same release (such as 7.01 to 7.02) and from one firmware version to another (such as 7.2 to 
7.3). When upgrading to another firmware version, check the release notes on the GE Multilin website for compatibility.

If you are upgrading from version 7.0 or 7.1 to 7.2 or later, some CPU modules require a new boot version. Update this first.

Address equipment mismatch error before upgrade. For example, if you have a basic front panel attached and the order 
code in the device is for a graphical front panel, the upgrade only works with a graphical front panel.

You can also downgrade firmware; use the same procedure.

To upgrade the firmware using EnerVista software:

1. If required, download the boot file and/or firmware from 
http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=7 
The firmware and boot files are .bin files.

2. Navigate to Settings > Product Setup > Security and ensure that the Remote Setting Authorized and Local Setting 
Authorized settings are "ON." On the front panel of the device, the path is SETTINGS  PRODUCT SETUP  SECURITY  
DUAL PERMISSION SECURITY ACCESS.

If using CyberSentry security, also ensure that the relay and firmware are not locked under the Settings > Product 
Setup > Security > Supervisory settings. A Supervisor role is required for these settings.

3. In EnerVista, back up the device settings by right-clicking the device and selecting Add Device to Offline Window. In 
the window that displays, select an existing file to overwrite, or enter a name for a new settings file and optionally a 
location for the new file. Click the Receive button to start the backup.

If an "Incompatible device order codes or versions" message displays, it means that you are trying to overwrite a file 
for another product. You access the Convert Device Settings option by right-clicking the file in the Offline Window 
area at the lower left. GE recommends converting settings in firmware steps, for example when converting from 6.0 to 
7.4x, convert first to 7.0 then 7.4 in order to follow embedded conversion rules and keep settings. Note that the values 
of all settings that have been defaulted during conversion are not listed in the conversion report; to find the value of a 
setting before conversion, inspect the device backups made before conversion.

4. In EnerVista, navigate to Maintenance > Update Firmware.

First select the boot file if applicable, locating the .bin file, and proceed. Restart the device, the EnerVista software, and 
refresh the order code in EnerVista under the Device Setup button.

To update the firmware, click Maintenance > Update Firmware, select the firmware update by locating the .bin file, 
and proceed with the update.

When asked if upgrading over the Internet, the difference is the flash memory buffer size each time the software 
sends data to the relay. Yes means that the flash memory buffer size is 256 bytes. No means that it is 1024 bytes, 
which is faster.

If a warning message displays about the firmware not being supported by the EnerVista software, it means that the 
firmware is a later version than the software. Upgrade the software to the same or later version as the firmware, then 
try again.

If an "Unable to put relay in flash mode" message displays, set the Settings > Product Setup > Security > Dual 
Permission Security Access > Remote Setting Authorized and Local Setting Authorized settings to "ON" and try 
again.

When the update is finished, the relay restarts automatically. The upgrade process takes about 20 minutes when 
using a graphical front panel because of writing to the front panel.

5. Restart the EnerVista software, and refresh the order code in EnerVista under the Device Setup button.

6. Verify the boot and firmware version while the device is starting up or in EnerVista under Actual Values > Product Info 
> Firmware Revisions. The boot revision is not the same as the firmware revision, and the firmware revision reflects 
the UR release, for example firmware revision 7.40 is UR release 7.40.

7. Set the device to "programmed" under Settings > Product Setup > Installation. A self-test error displays on the device 

http://www.gegridsolutions.com/app/ViewFiles.aspx?prod=urfamily&type=7
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until this is done.

8. If you changed the Remote Setting Authorized, the Local Setting Authorized settings, or relay lock settings, return 
them to their previous settings.

9. To apply any previously saved settings, right-click the saved settings file in the Offline Window area and select Write 
to Device. Optionally convert the saved settings to the new firmware version before writing to the device by right-
clicking and selecting Convert Device Settings.

10.10  Replace front panel
This section outlines how to install a graphical front panel.

A graphical front panel with a seven-inch (17.8 cm) color display and USB port is available for horizontal units. When 
purchased separately as a retrofit for an existing relay, there is one kit for an enhanced front panel replacement and 
another kit for the basic front panel replacement, with mounting brackets differing between the two kits. A kit includes the 
graphical front panel, mounting brackets, and screws. The graphical front panel requires CPU module type W or module 
type T, U, or V (newer type that has two connector slots on the front of the module--the second is difficult to see), upgrades 
of software and firmware, then a settings update to recognize the graphical front panel.

The graphical front panel can replace a basic front panel on newer models where the hinges are not riveted to the chassis. 
It cannot replace a basic front panel where the hinges are riveted onto the chassis; both front panel and chassis require 
replacement. See the photo of the riveted hinges later in this section.

The following procedures are outlined:

• Remove front panel

• Install graphical front panel

• Replace CPU module

• Upgrade software and firmware, then update setting

The following procedure can be used for the Rev. 1 and Rev. 2 enhanced front panels, with Rev. 1 is documented here. The 
Rev. 2 enhanced horizontal front panel introduced starting November 2017 uses a screw to close it and internal hinge 
screws as per the graphical front panel.

To remove an enhanced or basic front panel:

1. In the EnerVista software or on the front panel, access Settings > Product Setup > Communications > Network and 
record the IP address and subnet mask of the port(s) being used. Record the gateway address under Default IPv4 
Route.

2. Turn off power to the unit. Hot-swapping of the front panel is not supported.

3. For an enhanced front panel, loosen the thumb screw and open slightly the front panel.

The field-programmable gate array (FPGA) can be upgraded under Maintenance > Update FPGA when the device 
is connected via serial cable and the firmware revision is 7.0 or higher.

Modbus addresses assigned to firmware modules, features, settings, and corresponding data items (that is, default 
values, minimum/maximum values, data type, and item size) can change slightly from version to version of 
firmware. The addresses are rearranged when new features are added or existing features are enhanced or 
modified. The EEPROM DATA ERROR message displayed after upgrading/downgrading the firmware is a resettable, 
self-test message intended to inform users that the Modbus addresses have changed with the upgraded firmware. 
This message does not signal any problems when appearing after firmware upgrades.

Withdraw or insert a module only when control power has been removed from the unit, and be 
sure to insert only the correct module type into a slot, else personal injury, damage to the unit or 
connected equipment, or undesired operation can result.

To avoid damage to the equipment, use proper electrostatic discharge protection (for example, a 
static strap) when coming in contact with modules while the relay is energized.
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For a basic front panel, lift up the black plastic latch on the right side of the front panel and open slightly the front 
panel.

Figure 10-12: Loosen thumb screw on enhanced front panel to open

Figure 10-13: Lift latch on basic front panel to open

4. With a Phillips screwdriver, unscrew and remove the mounting bracket on the right side of the unit. The bracket for the 
enhanced front panel looks similar to that for the graphical front panel, but they are not the same.
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Figure 10-14: Remove enhanced front panel mounting bracket on right side

Figure 10-15: Remove basic front panel mounting bracket on right side

5. Open the front panel. Unplug or unscrew the grey ground cable from the front panel. Unplug the RJ45 connector from 
the CPU module in the second slot on the left.
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Figure 10-16: Disconnected ground cable and CPU connector

6. Unscrew and remove the mounting bracket with the front panel from the left side.

Figure 10-17: Unscrew enhanced front panel mounting bracket on left side

Figure 10-18: Unscrew basic front panel mounting bracket on left side 
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(note riveted hinges with red arrows - cannot replace this front panel)

The front panel has been removed.

To install the graphical front panel:

1. With power to the unit off, screw the left mounting bracket to the outside of the relay. The power supply module can 
remain in the first slot.

Figure 10-19: Attach mounting bracket to relay on left side (no power supply module in first slot)

2. Screw the right mounting bracket to the right side of the relay.
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Figure 10-20: Attach mounting bracket to relay on right side

3. Attach the graphical front panel hinge to the left mounting bracket using the nuts provided.

Figure 10-21: Attach to left mounting bracket inside relay

4. Close the front panel without tightening the screw to the mounting bracket.

5. Optionally remove the protective plastic film on the graphical front panel. It is normally peeled off, but also can be left 
on.

The graphical front panel has been installed but not connected.
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To replace the CPU module:

1. With power to the unit off, at the back of the CPU module in the second slot, disconnect any cables. Remove the silver 
SFP connector(s) from the CPU module, and keep it handy. Then remove the CPU module by sliding the module out 
from the front of the relay. (See the next section for instructions.)

Figure 10-22: Remove silver SFP connector (shown here under LK1 label)

2. At the front of the relay, insert the new CPU module in the second slot. The new CPU has two connection slots on the 
front. Ensure that the RS485 connector and the black cover plate are not on the back of the CPU module before sliding 
the module into the front of the relay.

Figure 10-23: Rear of a CPU module before insertion without RS485 connector or cover plate
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3. Once the module is in place, connect the graphical front panel to the CPU module (ground and upper connector) and 
close the front panel. There are two connections possible on the front of the CPU module: upper for the graphical front 
panel and lower for the enhanced and basic front panels. The upper connection is black with holes, similar to the 
cover, so it is difficult to see.

Figure 10-24: Connect graphical front panel to top connection on CPU module

4. Tighten the embedded screw on the right side of the graphical front panel to the mounting bracket.

Figure 10-25: Screw to attach graphical front panel to mounting bracket

5. At the back of the CPU module, attach the new black cover plate to the back of the relay, then connect the new RS485 
connector.

Insert the silver SFP connector(s) at the back of the CPU module, then connect any Ethernet connection(s).

6. Power up the relay. If the graphical front panel does not power up immediately, disconnect power, open the front 
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panel, then check that the graphical front panel is plugged into the upper connection, not the lower silver connection 
on the CPU module.

To upgrade software and firmware.

1. Upgrade the EnerVista software as outlined in this chapter.

2. Input the IP address and subnet mask of the relay on the front panel under Settings > Product Setup > 
Communications > Network, and input the gateway address under Default IPv4 Route.

3. Upgrade the firmware in the EnerVista software as outlined in this chapter, for example under Maintenance > Update 
Firmware.

If you see error messages after the upgrade, disconnect power to the relay and shut down the software, then start 
both again. If you see a flashing message about front panel communications trouble, check the connection of the 
graphical front panel to the CPU module.

4. In the EnerVista software, click the Device Setup button and refresh the order code for the device.

5. Set the relay to Programmed mode under Settings > Product Setup > Installation.

6. Update the EnerVista software to recognize the graphical front panel under Maintenance > Change Front Panel. This 
setting does not display for units already with a graphical front panel.

If an equipment mismatch error displays on the front panel, it can mean that the order code on the device needs to be 
updated to the new front panel.

10.11  Replace module
This section outlines how to replace a module.

The relay, being modular in design, allows for the withdrawal and insertion of modules. Replace modules only with like 
modules in their original factory configured slots.

Two procedures follow: replace a module with the same module, and upgrade a module.

To replace a module with the same module:

1. Open the enhanced front panel to the left once the thumb screw has been removed. This allows for easy access of the 
modules for withdrawal. The new wide-angle hinge assembly in the enhanced front panel opens completely and 
allows easy access to all modules in the F60.

Withdraw or insert a module only when control power has been removed from the unit, and be 
sure to insert only the correct module type into a slot, else personal injury, damage to the unit or 
connected equipment, or undesired operation can result.

To avoid damage to the equipment, use proper electrostatic discharge protection (for example, a 
static strap) when coming in contact with modules while the relay is energized.
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Figure 10-26: Modules inside relay with front cover open (enhanced front panel)

The basic front panel can be opened to the left once the black plastic sliding latch on the right side has been pushed 
up, as shown below.

Figure 10-27: Removing module (basic front panel)

2. With power to the unit off, disconnect individually the connections at the front and back of the module before 
removing the module from the chassis.

For any Process Bus Module in slot H for use with a HardFiber Brick, also remove the two screws at the back that 
attach the module to the chassis.

3. To properly remove a module, pull simultaneously the ejector/inserter clips, located at the top and bottom of the 
module. Record the original location of the module to ensure that the same or replacement module is inserted into the 
correct slot. While modules with current input provide automatic shorting of external CT circuits, for CT/VT modules it 
is recommended to short/isolate external circuits accordingly for maximum safety.

4. To properly insert a module, ensure that the correct module type is inserted into the correct slot position. The ejector/
inserter clips located at the top and at the bottom of each module must be in the disengaged position as the module 
is smoothly inserted into the slot. Once the clips have cleared the raised edge of the chassis, engage the clips 
simultaneously. When the clips have locked into position, the module is fully inserted.

When adding a module (versus replacing a module), check that settings have not changed. Depending on the 
module, settings can reset to default values.
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An upgrade example is replacing the CPU module with a more recent one, such as swapping 9G/9H/9N with 9T/9U/9V/9W. 
A power supply module upgrade does not affect an order code.

To upgrade a module:

1. Back up settings by sending the device to the Offline Window area. Convert the settings to the new order code by 
right-clicking in the Offline Window area. Replace the module as outlined in the previous procedure. In the Online 
Window area, reset all settings to factory defaults and read the new order code from the device using Commands > 
Relay Maintenance > Update Order Code. Send the saved settings from the Offline Window area to the online device. 
Refresh the order code in the Device Setup window and set the device to "Programmed" under Settings > Product 
Setup > Installation.

10.12  Battery
A battery powers the real time clock on startup of the device.

When required, the battery can be replaced. The battery type is 3 V cylindrical.

The power supply module contains the battery. The power supply modules were upgraded in 2014 to SH/SL from RH/RL, 
but the order code when purchasing a UR with redundant power supply remained as RH/RL so that customers can 
continue to use the same order codes. The order code can read RH or RL, while the module inside the unit reads SH or SL. 
The order code for replacement redundant power supply modules was changed to SH/SL.

10.12.1  Replace battery
When required, the battery can be replaced. The power supply module contains the battery.

1. Turn off the power to the unit.

2. Wait a minimum of three minutes to ensure that there is no power to the battery.

3. As outlined in the previous section, open the unit by sliding up the plastic latch on the right side of the front panel 
(basic front panel) or unscrewing the panel (enhanced front panel).

4. For the basic front panel, it needs to be removed in order to access the power supply module, which is typically in the 
first slot on the left side and blocked by the hinge of the front panel. To remove the front panel, unscrew the bracket on 
the left side of the unit.

5. Remove the power supply module by simultaneously pulling the ejector clips at the top and bottom of the module and 
sliding it out.

6. Unscrew all four screws (not three) that attach the metal cover to the module. The fourth screw is at the back end of 
the module, on the opposite side from the clips, beside the white electronics part (see figure).

7. Slide the metal cover away from the clips about 0.5 cm (1/8 inch) and remove the cover.

8. Unclip the black plastic holder that keeps the battery in place. The plastic clips into the socket at the bottom on both 
sides—pull the plastic away from the battery. Use a flat-head screwdriver if you cannot unclip the plastic with your 
fingers.

9. Replace the battery with the identical make and model. For example, do not use a rechargeable battery. Observe the 
+ and - polarity of the battery and replace it with the same polarity as marked on the battery holder.

The new CT/VT modules can only be used with new CPUs; similarly, old CT/VT modules can only be used with old 
CPUs. In the event that there is a mismatch between the CPU and CT/VT module, the relay does not function and a 
DSP ERROR or HARDWARE MISMATCH error displays.

To avoid injury, ensure that the unit has been powered off for a minimum of three minutes before 
replacing the battery.

Risk of fire if battery is replaced with incorrect type or polarity.
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Figure 10-28: Battery location on power supply module

10. Reinstall the battery holder and the metal cover, and reinsert the power supply module into the unit.

11. Power on the unit.

12. Dispose of the old battery as outlined in the next section.

10.12.2  Dispose of battery

10.12.2.1  EN Battery disposal
This product contains a battery that cannot be disposed of as unsorted municipal waste in the European Union. See the 
product documentation for specific battery information. The battery is marked with this symbol, which may include 
lettering to indicate cadmium (Cd), lead (Pb), or mercury (Hg). For proper recycling return the battery to your supplier or to a 
designated collection point. For more information see: www.recyclethis.info.

10.12.2.2  CS Nakládání s bateriemi
Tento produkt obsahuje baterie, které nemohou být zneškodněny v Evropské unii jako netříděný komunální odpadu. Viz 
dokumentace k produktu pro informace pro konkrétní baterie. Baterie je označena tímto symbolem, který může zahrnovat 
i uvedena písmena, kadmium (Cd), olovo (Pb), nebo rtuť (Hg). Pro správnou recyklaci baterií vraťte svémudodavateli nebo 
na určeném sběrném místě. Pro více informací viz: www.recyclethis.info.

10.12.2.3  DA Batteri affald
Dette produkt indeholder et batteri som ikke kan bortskaffes sammen med almindeligt husholdningsaffald i Europa. Se 
produktinformation for specifikke informationer om batteriet. Batteriet er forsynet med indgraveret symboler for hvad 
batteriet indeholder: kadmium (Cd), bly (Pb) og kviksølv (Hg). Europæiske brugere af elektrisk udstyr skal aflevere kasserede 
produkter til genbrug eller til leverandøren. Yderligere oplysninger findes på webstedet www.recyclethis.info.
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10.12.2.4  DE Entsorgung von Batterien
Dieses Produkt beinhaltet eine Batterie, die nicht als unsortierter städtischer Abfall in der europäischen Union entsorgt 
werden darf. Beachten Sie die spezifischen Batterie-informationen in der Produktdokumentation. Die Batterie ist mit 
diesem Symbol gekennzeichnet, welches auch Hinweise auf möglicherweise enthaltene Stoffe wie Kadmium (Cd), Blei (Pb) 
oder Quecksilber (Hektogramm) darstellt. Für die korrekte Wiederverwertung bringen Sie diese Batterie zu Ihrem lokalen 
Lieferanten zurück oder entsorgen Sie das Produkt an den gekennzeichneten Sammelstellen. Weitere Informationen 
hierzu finden Sie auf der folgenden Website: www.recyclethis.info.

10.12.2.5  EL Απόρριψη μπαταριών
Αυτό το προϊόν περιέχει μια μπαταρία που δεν πρέπει να απορρίπτεται σε δημόσια συστήματα απόρριψης στην 
Ευρωπαϊκή Κοινότητα. ∆είτε την τεκμηρίωση του προϊόντος για συγκεκριμένες πληροφορίες που αφορούν τη μπαταρία. 
Η μπαταρία είναι φέρει σήμανση με αυτό το σύμβολο, το οποίο μπορεί να περιλαμβάνει γράμματα για να δηλώσουν το 
κάδμιο (Cd), τον μόλυβδο (Pb), ή τον υδράργυρο (Hg). Για την κατάλληλη ανακύκλωση επιστρέψτε την μπαταρία στον 
προμηθευτή σας ή σε καθορισμένο σημείο συλλογής. Για περισσότερες πληροφορίες δείτε: www.recyclethis.info.

10.12.2.6  ES Eliminacion de baterias
Este producto contiene una batería que no se pueda eliminar como basura normal sin clasificar en la Unión Europea. 
Examine la documentación del producto para la información específica de la batería. La batería se marca con este 
símbolo, que puede incluir siglas para indicar el cadmio (Cd), el plomo (Pb), o el mercurio (Hg ). Para el reciclaje apropiado, 
devuelva este producto a su distribuidor ó deshágase de él en los puntos de reciclaje designados. Para mas información : 
wwwrecyclethis.info.

10.12.2.7  ET Patareide kõrvaldamine
Käesolev toode sisaldab patareisid, mida Euroopa Liidus ei tohi kõrvaldada sorteerimata olmejäätmetena. Andmeid 
patareide kohta vaadake toote dokumentatsioonist. Patareid on märgistatud käesoleva sümboliga, millel võib olla 
kaadmiumi (Cd), pliid (Pb) või elavhõbedat (Hg) tähistavad tähed. Nõuetekohaseks ringlusse võtmiseks tagastage patarei 
tarnijale või kindlaksmääratud vastuvõtupunkti. Lisainformatsiooni saab Internetist aadressil: www.recyclethis.info.

10.12.2.8  FI Paristoje ja akkujen hävittäminen
Tuote sisältää pariston, jota ei saa hävittää Euroopan Unionin alueella talousjätteen mukana. Tarkista tuoteselosteesta 
tuotteen tiedot. Paristo on merkitty tällä symbolilla ja saattaa sisältää cadmiumia (Cd), lyijyä (Pb) tai elohopeaa (Hg). Oikean 
kierrätystavan varmistamiseksi palauta tuote paikalliselle jälleenmyyjälle tai palauta se paristojen keräyspisteeseen. 
Lisätietoja sivuilla www.recyclethis.info.

10.12.2.9  FR Élimination des piles
Ce produit contient une batterie qui ne peuvent être éliminés comme déchets municipaux non triés dans l'Union 
européenne. Voir la documentation du produit au niveau des renseignements sur la pile. La batterie est marqué de ce 
symbole, qui comprennent les indications cadmium (Cd), plomb (Pb), ou mercure (Hg). Pour le recyclage, retourner la 
batterie à votre fournisseur ou à un point de collecte. Pour plus d'informations, voir: www.recyclethis.info.

10.12.2.10  HU Akkumulátor hulladék kezelése
Ezen termék akkumulátort tartalmaz, amely az Európai Unión belül csak a kijelölt módon és helyen dobható ki. A terméken 
illetve a mellékelt ismertetőn olvasható a kadmium (Cd), ólom (Pb) vagy higany (Hg) tartalomra utaló betűjelzés. A hulladék 
akkumulátor leadható a termék forgalmazójánál új akkumulátor vásárlásakor, vagy a kijelölt elektronikai 
hulladékudvarokban. További információ a www.recyclethis.info oldalon.
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10.12.2.11  IT Smaltimento batterie
Questo prodotto contiene una batteria che non può essere smaltita nei comuni contenitori per lo smaltimento rifiuti, nell' 
Unione Europea. Controllate la documentazione del prodotto per le informazioni specifiche sulla batteria. La batteria è 
contrassegnata con questo simbolo e può includere alcuni caratteri ad indicare la presenza di cadmio (Cd), piombo (Pb) 
oppure mercurio (Hg). Per il corretto smaltimento, potete restituirli al vostro fornitore locale, oppure rivolgervi e consegnarli 
presso i centri di raccolta preposti. Per maggiori informazioni vedere: ww.recyclethis.info.

10.12.2.12  LT Baterijų šalinimas
Šios įrangos sudėtyje yra baterijų, kurias draudžiama šalinti Europos Sąjungos viešose nerūšiuotų atliekų šalinimo 
sistemose. Informaciją apie baterijas galite rasti įrangos techninėje dokumentacijoje. Baterijos žymimos šiuo simboliu, 
papildomai gali būti nurodoma kad baterijų sudėtyje yra kadmio (Cd), švino (Pb) ar gyvsidabrio (Hg). Eksploatavimui 
nebetinkamas baterijas pristatykite į tam skirtas surinkimo vietas arba grąžinkite jas tiesioginiam tiekėjui, kad jos būtų 
tinkamai utilizuotos. Daugiau informacijos rasite šioje interneto svetainėje: www.recyclethis.info.

10.12.2.13  LV Bateriju likvidēšana
Šis produkts satur bateriju vai akumulatoru, kuru nedrīkst izmest Eiropas Savienībā esošajās sadzīves atkritumu sistēmās. 
Sk. produkta dokumentācijā, kur ir norādīta konkrēta informācija par bateriju vai akumulatoru. Baterijas vai akumulatora 
marķējumā ir šis simbols, kas var ietvert burtus, kuri norāda kadmiju (Cd), svinu (Pb) vai dzīvsudrabu (Hg). Pēc 
ekspluatācijas laika beigām baterijas vai akumulatori jānodod piegādātājam vai specializētā bateriju savākšanas vietā. 
Sīkāku informāciju var iegūt vietnē: www.recyclethis.info.

10.12.2.14  NL Verwijderen van baterijen
Dit product bevat een batterij welke niet kan verwijdert worden via de gemeentelijke huisvuilscheiding in de Europese 
Gemeenschap. Gelieve de product documentatie te controleren voor specifieke batterij informatie. De batterijen met deze 
label kunnen volgende indictaies bevatten cadium (Cd), lood (Pb) of kwik (Hg). Voor correcte vorm van kringloop, geef je de 
producten terug aan jou locale leverancier of geef het af aan een gespecialiseerde verzamelpunt. Meer informatie vindt u 
op de volgende website: www.recyclethis.info.

10.12.2.15  NO Retur av batteri
Dette produkt inneholder et batteri som ikke kan kastes med usortert kommunalt søppel i den Europeiske Unionen. Se 
produktdokumentasjonen for spesifikk batteriinformasjon. Batteriet er merket med dette symbolet som kan inkludere 
symboler for å indikere at kadmium (Cd), bly (Pb), eller kvikksølv (Hg) forekommer. Returner batteriet til leverandøren din 
eller til et dedikert oppsamlingspunkt for korrekt gjenvinning. For mer informasjon se: www.recyclethis.info.

10.12.2.16  PL Pozbywanie się zużytych baterii
Ten produkt zawiera baterie, które w Unii Europejskiej mogą być usuwane tylko jako posegregowane odpady komunalne. 
Dokładne informacje dotyczące użytych baterii znajdują się w dokumentacji produktu. Baterie oznaczone tym symbolem 
mogą zawierać dodatkowe oznaczenia literowe wskazujące na zawartość kadmu (Cd), ołowiu (Pb) lub rtęci (Hg). Dla 
zapewnienia właściwej utylizacji, należy zwrócić baterie do dostawcy albo do wyznaczonego punktu zbiórki. Więcej 
informacji można znaleźć na stronie internetowej www.recyclethis.info.

10.12.2.17  PT Eliminação de Baterias
Este produto contêm uma bateria que não pode ser considerado lixo municipal na União Europeia. Consulte a 
documentação do produto para obter informação específica da bateria. A bateria é identificada por meio de este símbolo, 
que pode incluir a rotulação para indicar o cádmio (Cd), chumbo (Pb), ou o mercúrio (hg). Para uma reciclagem apropriada 
envie a bateria para o seu fornecedor ou para um ponto de recolha designado. Para mais informação veja: 
www.recyclethis.info.
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10.12.2.18  RU Утилизация батарей
Согласно европейской директиве об отходах электрического и электронного оборудования, продукты, содержащие 
батареи, нельзя утилизировать как обычные отходы на территории ЕС. Более подробную информацию вы найдете в 
документации к продукту. На этом символе могут присутствовать буквы, которые означают, что батарея собержит 
кадмий (Cd), свинец (Pb) или ртуть (Hg). Для надлежащей утилизации по окончании срока эксплуатации пользователь 
должен возвратить батареи локальному поставщику или сдать в специальный пункт приема. Подробности можно 
найти на веб-сайте: www.recyclethis.info.

10.12.2.19  SK Zaobchádzanie s batériami
Tento produkt obsahuje batériu, s ktorou sa v Európskej únii nesmie nakladať ako s netriedeným komunálnym odpadom. 
Dokumentácia k produktu obsahuje špecifické informácie o batérii. Batéria je označená týmto symbolom, ktorý môže 
obsahovať písmená na označenie kadmia (Cd), olova (Pb), alebo ortuti (Hg). Na správnu recykláciu vráťte batériu vášmu 
lokálnemu dodávateľovi alebo na určené zberné miesto. Pre viac informácii pozrite: www.recyclethis.info.

10.12.2.20  SL Odlaganje baterij
Ta izdelek vsebuje baterijo, ki je v Evropski uniji ni dovoljeno odstranjevati kot nesortiran komunalni odpadek. Za posebne 
informacije o bateriji glejte dokumentacijo izdelka. Baterija je označena s tem simbolom, ki lahko vključuje napise, ki 
označujejo kadmij (Cd), svinec (Pb) ali živo srebro (Hg). Za ustrezno recikliranje baterijo vrnite dobavitelju ali jo odstranite na 
določenem zbirališču. Za več informacij obiščite spletno stran: www.recyclethis.info.

10.12.2.21  SV Kassering av batteri
Denna produkt innehåller ett batteri som inte får kastas i allmänna sophanteringssytem inom den europeiska unionen. Se 
produktdokumentationen för specifik batteriinformation. Batteriet är märkt med denna symbol, vilket kan innebära att det 
innehåller kadmium (Cd), bly (Pb) eller kvicksilver (Hg). För korrekt återvinning skall batteriet returneras till leverantören eller 
till en därför avsedd deponering. För mer information, se: www.recyclethis.info.

10.12.2.22  TR Pil Geri Dönüşümü
Bu ürün Avrupa Birliği genel atık sistemlerine atılmaması gereken pil içermektedir. Daha detaylı pil bilgisi için ürünün 
kataloğunu inceleyiniz. Bu sembolle işaretlenmiş piller Kadmiyum(Cd), Kurşun(Pb) ya da Civa(Hg) içerebilir. Doğru geri 
dönüşüm için ürünü yerel tedarikçinize geri veriniz ya da özel işaretlenmiş toplama noktlarına atınız. Daha fazla bilgi için: 
www.recyclethis.info.

10.12.2.23  Global contacts

From GE Part Number 1604-0021-A1, GE Publication Number GEK-113574.

10.13  Clear files and data after uninstall
The unit can be decommissioned by turning off power to the unit and disconnecting the wires to it.

To clear files and settings in the UR:

1. On the UR front panel, navigate to COMMANDS  RELAY MAINTENANCE  SERVICE COMMAND, enter the value 20511, 
and press the ENTER key. The relay restarts and clears the UR.

2. Clear the flash memory using the SETTINGS  PRODUCT SETUP  CLEAR RELAY RECORDS command.

North America 905-294-6222

Latin America +55 11 3614 1700

Europe, Middle East, Africa +(34) 94 485 88 00

Asia +86-21-2401-3208

India +91 80 41314617
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To clear files and settings on the computer:

1. Uninstall the EnerVista UR Setup software.

2. Find and delete the following UR files:

– .URS, .CID, and .ICD settings

– .EVT event records

– .CFG and .DAT COMTRADE

10.14  Repairs
The battery and modules inside the case can be replaced without return of the device to the factory. The firmware and 
software can be upgraded without return of the device to the factory.

Fuses in the power supply module are not field-replaceable.

Files can be requested for use by technical support staff, for example the Service Report (click the icon in the software or 
connect a USB drive to the graphical front panel) or under Maintenance > Retrieve File, as outlined elsewhere in this 
document.

For issues not solved by troubleshooting, the process to return the device to the factory for repair is as follows:

• Contact a GE Grid Solutions Technical Support Center. Contact information is found in the first chapter.

• Obtain a Return Materials Authorization (RMA) number from the Technical Support Center.

• Verify that the RMA and Commercial Invoice received have the correct information.

• Tightly pack the unit in a box with bubble wrap, foam material, or styrofoam inserts or packaging peanuts to cushion 
the item(s). You may also use double boxing whereby you place the box in a larger box that contains at least 5 cm of 
cushioning material.

• Ship the unit by courier or freight forwarder, along with the Commercial Invoice and RMA, to the factory.

GE GRID SOLUTIONS

650 MARKLAND STREET

MARKHAM, ONTARIO

CANADA    L6C 0M1

ATTN: SERVICE DEPT.

RMA# : ______________ 

Customers are responsible for shipping costs to the factory, regardless of whether the unit is under warranty.

• Fax a copy of the shipping information to the GE Grid Solutions service department in Canada at +1 905 927 5098.

Use the detailed return procedure outlined at

https://www.gegridsolutions.com/multilin/support/ret_proc.htm 

The current warranty and return information are outlined at 

https://www.gegridsolutions.com/multilin/warranty.htm 

10.15  Storage
Store the unit indoors in a cool, dry place. If possible, store in the original packaging. Follow the storage temperature range 
outlined in the Specifications.

https://www.gegridsolutions.com/multilin/support/ret_proc.htm
https://www.gegridsolutions.com/multilin/warranty.htm
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10.16  Disposal
Other than the battery, there are no special requirements for disposal of the unit at the end its service life. For customers 
located in the European Union, dispose of the battery as outlined earlier. To prevent non-intended use of the unit, remove 
the modules, dismantle the unit, and recycle the metal when possible.

To avoid deterioration of electrolytic capacitors, power up units that are stored in a de-energized 
state once per year, for one hour continuously.
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Appendices
FlexAnalog operands

This appendix outlines FlexAnalog parameters.

A.1  FlexAnalog items
A FlexAnalog parameter is an analog parameter.

FlexAnalog items specific to your device are viewable in a web browser. Enter the IP address of the UR, access the Device 
Information Menu option, then the FlexAnalog Parameter Listing option. Entries displayed online depend on order code.

Table A-1: F60 FlexAnalog data items

Address FlexAnalog name Units Description

5760 Sns Dir Power 1 Watts Sensitive directional power 1 actual value

5762 Sns Dir Power 2 Watts Sensitive directional power 2 actual value

5792 RGF 1 Igd Mag Amps Restricted ground fault 1 differential ground current magnitude

5794 RGF 1 Igr Mag Amps Restricted ground fault 1 restricted ground current magnitude

5796 RGF 2 Igd Mag Amps Restricted ground fault 2 differential ground current magnitude

5798 RGF 2 Igr Mag Amps Restricted ground fault 2 restricted ground current magnitude

5800 RGF 3 Igd Mag Amps Restricted ground fault 3 differential ground current magnitude

5802 RGF 3 Igr Mag Amps Restricted ground fault 3 restricted ground current magnitude

5804 RGF 4 Igd Mag Amps Restricted ground fault 4 differential ground current magnitude

5806 RGF 4 Igr Mag Amps Restricted ground fault 4 restricted ground current magnitude

5824 Field RTD 1 Value --- Field RTD 1 value

5825 Field RTD 2 Value --- Field RTD 2 value

5826 Field RTD 3 Value --- Field RTD 3 value

5827 Field RTD 4 Value --- Field RTD 4 value

5828 Field RTD 5 Value --- Field RTD 5 value

5829 Field RTD 6 Value --- Field RTD 6 value

5830 Field RTD 7 Value --- Field RTD 7 value

5831 Field RTD 8 Value --- Field RTD 8 value

5832 Field TDR 1 Value --- Field TDR 1 value

5834 Field TDR 2 Value --- Field TDR 2 value

5836 Field TDR 3 Value --- Field TDR 3 value
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5838 Field TDR 4 Value --- Field TDR 4 value

5840 Field TDR 5 Value --- Field TDR 5 value

5842 Field TDR 6 Value --- Field TDR 6 value

5844 Field TDR 7 Value --- Field TDR 7 value

5846 Field TDR 8 Value --- Field TDR 8 value

5856 Freq Rate 1 Value Hz/s Frequency rate of change 1 actual value

5860 Freq Rate 2 Value Hz/s Frequency rate of change 2 actual value

5864 Freq Rate 3 Value Hz/s Frequency rate of change 3 actual value

5868 Freq Rate 4 Value Hz/s Frequency rate of change 4 actual value

6144 SRC 1 Ia RMS Amps Source 1 phase A current RMS

6146 SRC 1 Ib RMS Amps Source 1 phase B current RMS

6148 SRC 1 Ic RMS Amps Source 1 phase C current RMS

6150 SRC 1 In RMS Amps Source 1 neutral current RMS

6152 SRC 1 Ia Mag Amps Source 1 phase A current magnitude

6154 SRC 1 Ia Angle Degrees Source 1 phase A current angle

6155 SRC 1 Ib Mag Amps Source 1 phase B current magnitude

6157 SRC 1 Ib Angle Degrees Source 1 phase B current angle

6158 SRC 1 Ic Mag Amps Source 1 phase C current magnitude

6160 SRC 1 Ic Angle Degrees Source 1 phase C current angle

6161 SRC 1 In Mag Amps Source 1 neutral current magnitude

6163 SRC 1 In Angle Degrees Source 1 neutral current angle

6164 SRC 1 Ig RMS Amps Source 1 ground current RMS

6166 SRC 1 Ig Mag Amps Source 1 ground current magnitude

6168 SRC 1 Ig Angle Degrees Source 1 ground current angle

6169 SRC 1 I_0 Mag Amps Source 1 zero-sequence current magnitude

6171 SRC 1 I_0 Angle Degrees Source 1 zero-sequence current angle

6172 SRC 1 I_1 Mag Amps Source 1 positive-sequence current magnitude

6174 SRC 1 I_1 Angle Degrees Source 1 positive-sequence current angle

6175 SRC 1 I_2 Mag Amps Source 1 negative-sequence current magnitude

6177 SRC 1 I_2 Angle Degrees Source 1 negative-sequence current angle

6178 SRC 1 Igd Mag Amps Source 1 differential ground current magnitude

6180 SRC 1 Igd Angle Degrees Source 1 differential ground current angle

6208 SRC 2 Ia RMS Amps Source 2 phase A current RMS

6210 SRC 2 Ib RMS Amps Source 2 phase B current RMS

6212 SRC 2 Ic RMS Amps Source 2 phase C current RMS

6214 SRC 2 In RMS Amps Source 2 neutral current RMS

6216 SRC 2 Ia Mag Amps Source 2 phase A current magnitude

6218 SRC 2 Ia Angle Degrees Source 2 phase A current angle

6219 SRC 2 Ib Mag Amps Source 2 phase B current magnitude

6221 SRC 2 Ib Angle Degrees Source 2 phase B current angle

6222 SRC 2 Ic Mag Amps Source 2 phase C current magnitude

6224 SRC 2 Ic Angle Degrees Source 2 phase C current angle

6225 SRC 2 In Mag Amps Source 2 neutral current magnitude

6227 SRC 2 In Angle Degrees Source 2 neutral current angle

6228 SRC 2 Ig RMS Amps Source 2 ground current RMS

6230 SRC 2 Ig Mag Amps Source 2 ground current magnitude

6232 SRC 2 Ig Angle Degrees Source 2 ground current angle

Address FlexAnalog name Units Description
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A6233 SRC 2 I_0 Mag Amps Source 2 zero-sequence current magnitude

6235 SRC 2 I_0 Angle Degrees Source 2 zero-sequence current angle

6236 SRC 2 I_1 Mag Amps Source 2 positive-sequence current magnitude

6238 SRC 2 I_1 Angle Degrees Source 2 positive-sequence current angle

6239 SRC 2 I_2 Mag Amps Source 2 negative-sequence current magnitude

6241 SRC 2 I_2 Angle Degrees Source 2 negative-sequence current angle

6242 SRC 2 Igd Mag Amps Source 2 differential ground current magnitude

6244 SRC 2 Igd Angle Degrees Source 2 differential ground current angle

6272 SRC 3 Ia RMS Amps Source 3 phase A current RMS

6274 SRC 3 Ib RMS Amps Source 3 phase B current RMS

6276 SRC 3 Ic RMS Amps Source 3 phase C current RMS

6278 SRC 3 In RMS Amps Source 3 neutral current RMS

6280 SRC 3 Ia Mag Amps Source 3 phase A current magnitude

6282 SRC 3 Ia Angle Degrees Source 3 phase A current angle

6283 SRC 3 Ib Mag Amps Source 3 phase B current magnitude

6285 SRC 3 Ib Angle Degrees Source 3 phase B current angle

6286 SRC 3 Ic Mag Amps Source 3 phase C current magnitude

6288 SRC 3 Ic Angle Degrees Source 3 phase C current angle

6289 SRC 3 In Mag Amps Source 3 neutral current magnitude

6291 SRC 3 In Angle Degrees Source 3 neutral current angle

6292 SRC 3 Ig RMS Amps Source 3 ground current RMS

6294 SRC 3 Ig Mag Amps Source 3 ground current magnitude

6296 SRC 3 Ig Angle Degrees Source 3 ground current angle

6297 SRC 3 I_0 Mag Amps Source 3 zero-sequence current magnitude

6299 SRC 3 I_0 Angle Degrees Source 3 zero-sequence current angle

6300 SRC 3 I_1 Mag Amps Source 3 positive-sequence current magnitude

6302 SRC 3 I_1 Angle Degrees Source 3 positive-sequence current angle

6303 SRC 3 I_2 Mag Amps Source 3 negative-sequence current magnitude

6305 SRC 3 I_2 Angle Degrees Source 3 negative-sequence current angle

6306 SRC 3 Igd Mag Amps Source 3 differential ground current magnitude

6308 SRC 3 Igd Angle Degrees Source 3 differential ground current angle

6336 SRC 4 Ia RMS Amps Source 4 phase A current RMS

6338 SRC 4 Ib RMS Amps Source 4 phase B current RMS

6340 SRC 4 Ic RMS Amps Source 4 phase C current RMS

6342 SRC 4 In RMS Amps Source 4 neutral current RMS

6344 SRC 4 Ia Mag Amps Source 4 phase A current magnitude

6346 SRC 4 Ia Angle Degrees Source 4 phase A current angle

6347 SRC 4 Ib Mag Amps Source 4 phase B current magnitude

6349 SRC 4 Ib Angle Degrees Source 4 phase B current angle

6350 SRC 4 Ic Mag Amps Source 4 phase C current magnitude

6352 SRC 4 Ic Angle Degrees Source 4 phase C current angle

6353 SRC 4 In Mag Amps Source 4 neutral current magnitude

6355 SRC 4 In Angle Degrees Source 4 neutral current angle

6356 SRC 4 Ig RMS Amps Source 4 ground current RMS

6358 SRC 4 Ig Mag Amps Source 4 ground current magnitude

6360 SRC 4 Ig Angle Degrees Source 4 ground current angle

6361 SRC 4 I_0 Mag Amps Source 4 zero-sequence current magnitude

Address FlexAnalog name Units Description
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6363 SRC 4 I_0 Angle Degrees Source 4 zero-sequence current angle

6364 SRC 4 I_1 Mag Amps Source 4 positive-sequence current magnitude

6366 SRC 4 I_1 Angle Degrees Source 4 positive-sequence current angle

6367 SRC 4 I_2 Mag Amps Source 4 negative-sequence current magnitude

6369 SRC 4 I_2 Angle Degrees Source 4 negative-sequence current angle

6370 SRC 4 Igd Mag Amps Source 4 differential ground current magnitude

6372 SRC 4 Igd Angle Degrees Source 4 differential ground current angle

6656 SRC 1 Vag RMS Volts Source 1 phase AG voltage RMS

6658 SRC 1 Vbg RMS Volts Source 1 phase BG voltage RMS

6660 SRC 1 Vcg RMS Volts Source 1 phase CG voltage RMS

6662 SRC 1 Vag Mag Volts Source 1 phase AG voltage magnitude

6664 SRC 1 Vag Angle Degrees Source 1 phase AG voltage angle

6665 SRC 1 Vbg Mag Volts Source 1 phase BG voltage magnitude

6667 SRC 1 Vbg Angle Degrees Source 1 phase BG voltage angle

6668 SRC 1 Vcg Mag Volts Source 1 phase CG voltage magnitude

6670 SRC 1 Vcg Angle Degrees Source 1 phase CG voltage angle

6671 SRC 1 Vab RMS Volts Source 1 phase AB voltage RMS

6673 SRC 1 Vbc RMS Volts Source 1 phase BC voltage RMS

6675 SRC 1 Vca RMS Volts Source 1 phase CA voltage RMS

6677 SRC 1 Vab Mag Volts Source 1 phase AB voltage magnitude

6679 SRC 1 Vab Angle Degrees Source 1 phase AB voltage angle

6680 SRC 1 Vbc Mag Volts Source 1 phase BC voltage magnitude

6682 SRC 1 Vbc Angle Degrees Source 1 phase BC voltage angle

6683 SRC 1 Vca Mag Volts Source 1 phase CA voltage magnitude

6685 SRC 1 Vca Angle Degrees Source 1 phase CA voltage angle

6686 SRC 1 Vx RMS Volts Source 1 auxiliary voltage RMS

6688 SRC 1 Vx Mag Volts Source 1 auxiliary voltage magnitude

6690 SRC 1 Vx Angle Degrees Source 1 auxiliary voltage angle

6691 SRC 1 V_0 Mag Volts Source 1 zero-sequence voltage magnitude

6693 SRC 1 V_0 Angle Degrees Source 1 zero-sequence voltage angle

6694 SRC 1 V_1 Mag Volts Source 1 positive-sequence voltage magnitude

6696 SRC 1 V_1 Angle Degrees Source 1 positive-sequence voltage angle

6697 SRC 1 V_2 Mag Volts Source 1 negative-sequence voltage magnitude

6699 SRC 1 V_2 Angle Degrees Source 1 negative-sequence voltage angle

6720 SRC 2 Vag RMS Volts Source 2 phase AG voltage RMS

6722 SRC 2 Vbg RMS Volts Source 2 phase BG voltage RMS

6724 SRC 2 Vcg RMS Volts Source 2 phase CG voltage RMS

6726 SRC 2 Vag Mag Volts Source 2 phase AG voltage magnitude

6728 SRC 2 Vag Angle Degrees Source 2 phase AG voltage angle

6729 SRC 2 Vbg Mag Volts Source 2 phase BG voltage magnitude

6731 SRC 2 Vbg Angle Degrees Source 2 phase BG voltage angle

6732 SRC 2 Vcg Mag Volts Source 2 phase CG voltage magnitude

6734 SRC 2 Vcg Angle Degrees Source 2 phase CG voltage angle

6735 SRC 2 Vab RMS Volts Source 2 phase AB voltage RMS

6737 SRC 2 Vbc RMS Volts Source 2 phase BC voltage RMS

6739 SRC 2 Vca RMS Volts Source 2 phase CA voltage RMS

6741 SRC 2 Vab Mag Volts Source 2 phase AB voltage magnitude

Address FlexAnalog name Units Description
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A6743 SRC 2 Vab Angle Degrees Source 2 phase AB voltage angle

6744 SRC 2 Vbc Mag Volts Source 2 phase BC voltage magnitude

6746 SRC 2 Vbc Angle Degrees Source 2 phase BC voltage angle

6747 SRC 2 Vca Mag Volts Source 2 phase CA voltage magnitude

6749 SRC 2 Vca Angle Degrees Source 2 phase CA voltage angle

6750 SRC 2 Vx RMS Volts Source 2 auxiliary voltage RMS

6752 SRC 2 Vx Mag Volts Source 2 auxiliary voltage magnitude

6754 SRC 2 Vx Angle Degrees Source 2 auxiliary voltage angle

6755 SRC 2 V_0 Mag Volts Source 2 zero-sequence voltage magnitude

6757 SRC 2 V_0 Angle Degrees Source 2 zero-sequence voltage angle

6758 SRC 2 V_1 Mag Volts Source 2 positive-sequence voltage magnitude

6760 SRC 2 V_1 Angle Degrees Source 2 positive-sequence voltage angle

6761 SRC 2 V_2 Mag Volts Source 2 negative-sequence voltage magnitude

6763 SRC 2 V_2 Angle Degrees Source 2 negative-sequence voltage angle

6784 SRC 3 Vag RMS Volts Source 3 phase AG voltage RMS

6786 SRC 3 Vbg RMS Volts Source 3 phase BG voltage RMS

6788 SRC 3 Vcg RMS Volts Source 3 phase CG voltage RMS

6790 SRC 3 Vag Mag Volts Source 3 phase AG voltage magnitude

6792 SRC 3 Vag Angle Degrees Source 3 phase AG voltage angle

6793 SRC 3 Vbg Mag Volts Source 3 phase BG voltage magnitude

6795 SRC 3 Vbg Angle Degrees Source 3 phase BG voltage angle

6796 SRC 3 Vcg Mag Volts Source 3 phase CG voltage magnitude

6798 SRC 3 Vcg Angle Degrees Source 3 phase CG voltage angle

6799 SRC 3 Vab RMS Volts Source 3 phase AB voltage RMS

6801 SRC 3 Vbc RMS Volts Source 3 phase BC voltage RMS

6803 SRC 3 Vca RMS Volts Source 3 phase CA voltage RMS

6805 SRC 3 Vab Mag Volts Source 3 phase AB voltage magnitude

6807 SRC 3 Vab Angle Degrees Source 3 phase AB voltage angle

6808 SRC 3 Vbc Mag Volts Source 3 phase BC voltage magnitude

6810 SRC 3 Vbc Angle Degrees Source 3 phase BC voltage angle

6811 SRC 3 Vca Mag Volts Source 3 phase CA voltage magnitude

6813 SRC 3 Vca Angle Degrees Source 3 phase CA voltage angle

6814 SRC 3 Vx RMS Volts Source 3 auxiliary voltage RMS

6816 SRC 3 Vx Mag Volts Source 3 auxiliary voltage magnitude

6818 SRC 3 Vx Angle Degrees Source 3 auxiliary voltage angle

6819 SRC 3 V_0 Mag Volts Source 3 zero-sequence voltage magnitude

6821 SRC 3 V_0 Angle Degrees Source 3 zero-sequence voltage angle

6822 SRC 3 V_1 Mag Volts Source 3 positive-sequence voltage magnitude

6824 SRC 3 V_1 Angle Degrees Source 3 positive-sequence voltage angle

6825 SRC 3 V_2 Mag Volts Source 3 negative-sequence voltage magnitude

6827 SRC 3 V_2 Angle Degrees Source 3 negative-sequence voltage angle

6848 SRC 4 Vag RMS Volts Source 4 phase AG voltage RMS

6850 SRC 4 Vbg RMS Volts Source 4 phase BG voltage RMS

6852 SRC 4 Vcg RMS Volts Source 4 phase CG voltage RMS

6854 SRC 4 Vag Mag Volts Source 4 phase AG voltage magnitude

6856 SRC 4 Vag Angle Degrees Source 4 phase AG voltage angle

6857 SRC 4 Vbg Mag Volts Source 4 phase BG voltage magnitude

Address FlexAnalog name Units Description
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6859 SRC 4 Vbg Angle Degrees Source 4 phase BG voltage angle

6860 SRC 4 Vcg Mag Volts Source 4 phase CG voltage magnitude

6862 SRC 4 Vcg Angle Degrees Source 4 phase CG voltage angle

6863 SRC 4 Vab RMS Volts Source 4 phase AB voltage RMS

6865 SRC 4 Vbc RMS Volts Source 4 phase BC voltage RMS

6867 SRC 4 Vca RMS Volts Source 4 phase CA voltage RMS

6869 SRC 4 Vab Mag Volts Source 4 phase AB voltage magnitude

6871 SRC 4 Vab Angle Degrees Source 4 phase AB voltage angle

6872 SRC 4 Vbc Mag Volts Source 4 phase BC voltage magnitude

6874 SRC 4 Vbc Angle Degrees Source 4 phase BC voltage angle

6875 SRC 4 Vca Mag Volts Source 4 phase CA voltage magnitude

6877 SRC 4 Vca Angle Degrees Source 4 phase CA voltage angle

6878 SRC 4 Vx RMS Volts Source 4 auxiliary voltage RMS

6880 SRC 4 Vx Mag Volts Source 4 auxiliary voltage magnitude

6882 SRC 4 Vx Angle Degrees Source 4 auxiliary voltage angle

6883 SRC 4 V_0 Mag Volts Source 4 zero-sequence voltage magnitude

6885 SRC 4 V_0 Angle Degrees Source 4 zero-sequence voltage angle

6886 SRC 4 V_1 Mag Volts Source 4 positive-sequence voltage magnitude

6888 SRC 4 V_1 Angle Degrees Source 4 positive-sequence voltage angle

6889 SRC 4 V_2 Mag Volts Source 4 negative-sequence voltage magnitude

6891 SRC 4 V_2 Angle Degrees Source 4 negative-sequence voltage angle

7168 SRC 1 P Watts Source 1 three-phase real power

7170 SRC 1 Pa Watts Source 1 phase A real power

7172 SRC 1 Pb Watts Source 1 phase B real power

7174 SRC 1 Pc Watts Source 1 phase C real power

7176 SRC 1 Q Vars Source 1 three-phase reactive power

7178 SRC 1 Qa Vars Source 1 phase A reactive power

7180 SRC 1 Qb Vars Source 1 phase B reactive power

7182 SRC 1 Qc Vars Source 1 phase C reactive power

7184 SRC 1 S VA Source 1 three-phase apparent power

7186 SRC 1 Sa VA Source 1 phase A apparent power

7188 SRC 1 Sb VA Source 1 phase B apparent power

7190 SRC 1 Sc VA Source 1 phase C apparent power

7192 SRC 1 PF --- Source 1 three-phase power factor

7193 SRC 1 Phase A PF --- Source 1 phase A power factor

7194 SRC 1 Phase B PF --- Source 1 phase B power factor

7195 SRC 1 Phase C PF --- Source 1 phase C power factor

7200 SRC 2 P Watts Source 2 three-phase real power

7202 SRC 2 Pa Watts Source 2 phase A real power

7204 SRC 2 Pb Watts Source 2 phase B real power

7206 SRC 2 Pc Watts Source 2 phase C real power

7208 SRC 2 Q Vars Source 2 three-phase reactive power

7210 SRC 2 Qa Vars Source 2 phase A reactive power

7212 SRC 2 Qb Vars Source 2 phase B reactive power

7214 SRC 2 Qc Vars Source 2 phase C reactive power

7216 SRC 2 S VA Source 2 three-phase apparent power

7218 SRC 2 Sa VA Source 2 phase A apparent power

Address FlexAnalog name Units Description
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A7220 SRC 2 Sb VA Source 2 phase B apparent power

7222 SRC 2 Sc VA Source 2 phase C apparent power

7224 SRC 2 PF --- Source 2 three-phase power factor

7225 SRC 2 Phase A PF --- Source 2 phase A power factor

7226 SRC 2 Phase B PF --- Source 2 phase B power factor

7227 SRC 2 Phase C PF --- Source 2 phase C power factor

7232 SRC 3 P Watts Source 3 three-phase real power

7234 SRC 3 Pa Watts Source 3 phase A real power

7236 SRC 3 Pb Watts Source 3 phase B real power

7238 SRC 3 Pc Watts Source 3 phase C real power

7240 SRC 3 Q Vars Source 3 three-phase reactive power

7242 SRC 3 Qa Vars Source 3 phase A reactive power

7244 SRC 3 Qb Vars Source 3 phase B reactive power

7246 SRC 3 Qc Vars Source 3 phase C reactive power

7248 SRC 3 S VA Source 3 three-phase apparent power

7250 SRC 3 Sa VA Source 3 phase A apparent power

7252 SRC 3 Sb VA Source 3 phase B apparent power

7254 SRC 3 Sc VA Source 3 phase C apparent power

7256 SRC 3 PF --- Source 3 three-phase power factor

7257 SRC 3 Phase A PF --- Source 3 phase A power factor

7258 SRC 3 Phase B PF --- Source 3 phase B power factor

7259 SRC 3 Phase C PF --- Source 3 phase C power factor

7424 SRC 1 Pos Watthour kWh Source 1 positive Watthour

7426 SRC 1 Neg Watthour Wh Source 1 negative Watthour

7428 SRC 1 Pos varh varh Source 1 positive varhour

7430 SRC 1 Neg varh varh Source 1 negative varhour

7440 SRC 2 Pos Watthour kWh Source 2 positive Watthour

7442 SRC 2 Neg Watthour Wh Source 2 negative Watthour

7444 SRC 2 Pos varh varh Source 2 positive varhour

7446 SRC 2 Neg varh varh Source 2 negative varhour

7456 SRC 3 Pos Watthour kWh Source 3 positive Watthour

7458 SRC 3 Neg Watthour kWh Source 3 negative Watthour

7460 SRC 3 Pos varh varh Source 3 positive varhour

7462 SRC 3 Neg varh varh Source 3 negative varhour

7552 SRC 1 Frequency Hz Source 1 frequency

7554 SRC 2 Frequency Hz Source 2 frequency

7556 SRC 3 Frequency Hz Source 3 frequency

7680 SRC 1 Demand Ia Amps Source 1 phase A current demand

7682 SRC 1 Demand Ib Amps Source 1 phase B current demand

7684 SRC 1 Demand Ic Amps Source 1 phase C current demand

7686 SRC 1 Demand Watt Watts Source 1 real power demand

7688 SRC 1 Demand var Vars Source 1 reactive power demand

7690 SRC 1 Demand VA VA Source 1 apparent power demand

7696 SRC 2 Demand Ia Amps Source 2 phase A current demand

7698 SRC 2 Demand Ib Amps Source 2 phase B current demand

7700 SRC 2 Demand Ic Amps Source 2 phase C current demand

7702 SRC 2 Demand Watt Watts Source 2 real power demand

Address FlexAnalog name Units Description
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7704 SRC 2 Demand var Vars Source 2 reactive power demand

7706 SRC 2 Demand VA VA Source 2 apparent power demand

7712 SRC 3 Demand Ia Amps Source 3 phase A current demand

7714 SRC 3 Demand Ib Amps Source 3 phase B current demand

7716 SRC 3 Demand Ic Amps Source 3 phase C current demand

7718 SRC 3 Demand Watt Watts Source 3 real power demand

7720 SRC 3 Demand var Vars Source 3 reactive power demand

7722 SRC 3 Demand VA VA Source 3 apparent power demand

8064 SRC 1 Va THD % Source 1 phase A voltage total harmonic distortion (THD)

8065 SRC 1 Va Harm[2] % Source 1 phase A voltage second harmonic

8066 SRC 1 Va Harm[3] % Source 1 phase A voltage third harmonic

8067 SRC 1 Va Harm[4] % Source 1 phase A voltage fourth harmonic

8068 SRC 1 Va Harm[5] % Source 1 phase A voltage fifth harmonic

8069 SRC 1 Va Harm[6] % Source 1 phase A voltage sixth harmonic

8070 SRC 1 Va Harm[7] % Source 1 phase A voltage seventh harmonic

8071 SRC 1 Va Harm[8] % Source 1 phase A voltage eighth harmonic

8072 SRC 1 Va Harm[9] % Source 1 phase A voltage ninth harmonic

8073 SRC 1 Va Harm[10] % Source 1 phase A voltage tenth harmonic

8074 SRC 1 Va Harm[11] % Source 1 phase A voltage eleventh harmonic

8075 SRC 1 Va Harm[12] % Source 1 phase A voltage twelfth harmonic

8076 SRC 1 Va Harm[13] % Source 1 phase A voltage thirteenth harmonic

8077 SRC 1 Va Harm[14] % Source 1 phase A voltage fourteenth harmonic

8078 SRC 1 Va Harm[15] % Source 1 phase A voltage fifteenth harmonic

8079 SRC 1 Va Harm[16] % Source 1 phase A voltage sixteenth harmonic

8080 SRC 1 Va Harm[17] % Source 1 phase A voltage seventeenth harmonic

8081 SRC 1 Va Harm[18] % Source 1 phase A voltage eighteenth harmonic

8082 SRC 1 Va Harm[19] % Source 1 phase A voltage nineteenth harmonic

8083 SRC 1 Va Harm[20] % Source 1 phase A voltage twentieth harmonic

8084 SRC 1 Va Harm[21] % Source 1 phase A voltage twenty-first harmonic

8085 SRC 1 Va Harm[22] % Source 1 phase A voltage twenty-second harmonic

8086 SRC 1 Va Harm[23] % Source 1 phase A voltage twenty-third harmonic

8087 SRC 1 Va Harm[24] % Source 1 phase A voltage twenty-fourth harmonic

8088 SRC 1 Va Harm[25] % Source 1 phase A voltage twenty-fifth harmonic

8089 SRC 1 Vb THD % Source 1 phase B voltage total harmonic distortion (THD)

8090 SRC 1 Vb Harm[2] % Source 1 phase B voltage second harmonic

8091 SRC 1 Vb Harm[3] % Source 1 phase B voltage third harmonic

8092 SRC 1 Vb Harm[4] % Source 1 phase B voltage fourth harmonic

8093 SRC 1 Vb Harm[5] % Source 1 phase B voltage fifth harmonic

8094 SRC 1 Vb Harm[6] % Source 1 phase B voltage sixth harmonic

8095 SRC 1 Vb Harm[7] % Source 1 phase B voltage seventh harmonic

8096 SRC 1 Vb Harm[8] % Source 1 phase B voltage eighth harmonic

8097 SRC 1 Vb Harm[9] % Source 1 phase B voltage ninth harmonic

8098 SRC 1 Vb Harm[10] % Source 1 phase B voltage tenth harmonic

8099 SRC 1 Vb Harm[11] % Source 1 phase B voltage eleventh harmonic

8100 SRC 1 Vb Harm[12] % Source 1 phase B voltage twelfth harmonic

8101 SRC 1 Vb Harm[13] % Source 1 phase B voltage thirteenth harmonic

8102 SRC 1 Vb Harm[14] % Source 1 phase B voltage fourteenth harmonic

Address FlexAnalog name Units Description
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A8103 SRC 1 Vb Harm[15] % Source 1 phase B voltage fifteenth harmonic

8104 SRC 1 Vb Harm[16] % Source 1 phase B voltage sixteenth harmonic

8105 SRC 1 Vb Harm[17] % Source 1 phase B voltage seventeenth harmonic

8106 SRC 1 Vb Harm[18] % Source 1 phase B voltage eighteenth harmonic

8107 SRC 1 Vb Harm[19] % Source 1 phase B voltage nineteenth harmonic

8108 SRC 1 Vb Harm[20] % Source 1 phase B voltage twentieth harmonic

8109 SRC 1 Vb Harm[21] % Source 1 phase B voltage twenty-first harmonic

8110 SRC 1 Vb Harm[22] % Source 1 phase B voltage twenty-second harmonic

8111 SRC 1 Vb Harm[23] % Source 1 phase B voltage twenty-third harmonic

8112 SRC 1 Vb Harm[24] % Source 1 phase B voltage twenty-fourth harmonic

8113 SRC 1 Vb Harm[25] % Source 1 phase B voltage twenty-fifth harmonic

8114 SRC 1 Vc THD % Source 1 phase C voltage total harmonic distortion (THD)

8115 SRC 1 Vc Harm[2] % Source 1 phase C voltage second harmonic

8116 SRC 1 Vc Harm[3] % Source 1 phase C voltage third harmonic

8117 SRC 1 Vc Harm[4] % Source 1 phase C voltage fourth harmonic

8118 SRC 1 Vc Harm[5] % Source 1 phase C voltage fifth harmonic

8119 SRC 1 Vc Harm[6] % Source 1 phase C voltage sixth harmonic

8120 SRC 1 Vc Harm[7] % Source 1 phase C voltage seventh harmonic

8121 SRC 1 Vc Harm[8] % Source 1 phase C voltage eighth harmonic

8122 SRC 1 Vc Harm[9] % Source 1 phase C voltage ninth harmonic

8123 SRC 1 Vc Harm[10] % Source 1 phase C voltage tenth harmonic

8124 SRC 1 Vc Harm[11] % Source 1 phase C voltage eleventh harmonic

8125 SRC 1 Vc Harm[12] % Source 1 phase C voltage twelfth harmonic

8126 SRC 1 Vc Harm[13] % Source 1 phase C voltage thirteenth harmonic

8127 SRC 1 Vc Harm[14] % Source 1 phase C voltage fourteenth harmonic

8128 SRC 1 Vc Harm[15] % Source 1 phase C voltage fifteenth harmonic

8129 SRC 1 Vc Harm[16] % Source 1 phase C voltage sixteenth harmonic

8130 SRC 1 Vc Harm[17] % Source 1 phase C voltage seventeenth harmonic

8131 SRC 1 Vc Harm[18] % Source 1 phase C voltage eighteenth harmonic

8132 SRC 1 Vc Harm[19] % Source 1 phase C voltage nineteenth harmonic

8133 SRC 1 Vc Harm[20] % Source 1 phase C voltage twentieth harmonic

8134 SRC 1 Vc Harm[21] % Source 1 phase C voltage twenty-first harmonic

8135 SRC 1 Vc Harm[22] % Source 1 phase C voltage twenty-second harmonic

8136 SRC 1 Vc Harm[23] % Source 1 phase C voltage twenty-third harmonic

8137 SRC 1 Vc Harm[24] % Source 1 phase C voltage twenty-fourth harmonic

8138 SRC 1 Vc Harm[25] % Source 1 phase C voltage twenty-fifth harmonic

8139 SRC 2 Va THD % Source 2 phase A voltage total harmonic distortion (THD)

8140 SRC 2 Va Harm[2] % Source 2 phase A voltage second harmonic

8141 SRC 2 Va Harm[3] % Source 2 phase A voltage third harmonic

8142 SRC 2 Va Harm[4] % Source 2 phase A voltage fourth harmonic

8143 SRC 2 Va Harm[5] % Source 2 phase A voltage fifth harmonic

8144 SRC 2 Va Harm[6] % Source 2 phase A voltage sixth harmonic

8145 SRC 2 Va Harm[7] % Source 2 phase A voltage seventh harmonic

8146 SRC 2 Va Harm[8] % Source 2 phase A voltage eighth harmonic

8147 SRC 2 Va Harm[9] % Source 2 phase A voltage ninth harmonic

8148 SRC 2 Va Harm[10] % Source 2 phase A voltage tenth harmonic

8149 SRC 2 Va Harm[11] % Source 2 phase A voltage eleventh harmonic
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A
8150 SRC 2 Va Harm[12] % Source 2 phase A voltage twelfth harmonic

8151 SRC 2 Va Harm[13] % Source 2 phase A voltage thirteenth harmonic

8152 SRC 2 Va Harm[14] % Source 2 phase A voltage fourteenth harmonic

8153 SRC 2 Va Harm[15] % Source 2 phase A voltage fifteenth harmonic

8154 SRC 2 Va Harm[16] % Source 2 phase A voltage sixteenth harmonic

8155 SRC 2 Va Harm[17] % Source 2 phase A voltage seventeenth harmonic

8156 SRC 2 Va Harm[18] % Source 2 phase A voltage eighteenth harmonic

8157 SRC 2 Va Harm[19] % Source 2 phase A voltage nineteenth harmonic

8158 SRC 2 Va Harm[20] % Source 2 phase A voltage twentieth harmonic

8159 SRC 2 Va Harm[21] % Source 2 phase A voltage twenty-first harmonic

8160 SRC 2 Va Harm[22] % Source 2 phase A voltage twenty-second harmonic

8161 SRC 2 Va Harm[23] % Source 2 phase A voltage twenty-third harmonic

8162 SRC 2 Va Harm[24] % Source 2 phase A voltage twenty-fourth harmonic

8163 SRC 2 Va Harm[25] % Source 2 phase A voltage twenty-fifth harmonic

8164 SRC 2 Vb THD % Source 2 phase B voltage total harmonic distortion (THD)

8165 SRC 2 Vb Harm[2] % Source 2 phase B voltage second harmonic

8166 SRC 2 Vb Harm[3] % Source 2 phase B voltage third harmonic

8167 SRC 2 Vb Harm[4] % Source 2 phase B voltage fourth harmonic

8168 SRC 2 Vb Harm[5] % Source 2 phase B voltage fifth harmonic

8169 SRC 2 Vb Harm[6] % Source 2 phase B voltage sixth harmonic

8170 SRC 2 Vb Harm[7] % Source 2 phase B voltage seventh harmonic

8171 SRC 2 Vb Harm[8] % Source 2 phase B voltage eighth harmonic

8172 SRC 2 Vb Harm[9] % Source 2 phase B voltage ninth harmonic

8173 SRC 2 Vb Harm[10] % Source 2 phase B voltage tenth harmonic

8174 SRC 2 Vb Harm[11] % Source 2 phase B voltage eleventh harmonic

8175 SRC 2 Vb Harm[12] % Source 2 phase B voltage twelfth harmonic

8176 SRC 2 Vb Harm[13] % Source 2 phase B voltage thirteenth harmonic

8177 SRC 2 Vb Harm[14] % Source 2 phase B voltage fourteenth harmonic

8178 SRC 2 Vb Harm[15] % Source 2 phase B voltage fifteenth harmonic

8179 SRC 2 Vb Harm[16] % Source 2 phase B voltage sixteenth harmonic

8180 SRC 2 Vb Harm[17] % Source 2 phase B voltage seventeenth harmonic

8181 SRC 2 Vb Harm[18] % Source 2 phase B voltage eighteenth harmonic

8182 SRC 2 Vb Harm[19] % Source 2 phase B voltage nineteenth harmonic

8183 SRC 2 Vb Harm[20] % Source 2 phase B voltage twentieth harmonic

8184 SRC 2 Vb Harm[21] % Source 2 phase B voltage twenty-first harmonic

8185 SRC 2 Vb Harm[22] % Source 2 phase B voltage twenty-second harmonic

8186 SRC 2 Vb Harm[23] % Source 2 phase B voltage twenty-third harmonic

8187 SRC 2 Vb Harm[24] % Source 2 phase B voltage twenty-fourth harmonic

8188 SRC 2 Vb Harm[25] % Source 2 phase B voltage twenty-fifth harmonic

8189 SRC 2 Vc THD % Source 2 phase C voltage total harmonic distortion (THD)

8190 SRC 2 Vc Harm[2] % Source 2 phase C voltage second harmonic

8191 SRC 2 Vc Harm[3] % Source 2 phase C voltage third harmonic

8192 SRC 2 Vc Harm[4] % Source 2 phase C voltage fourth harmonic

8193 SRC 2 Vc Harm[5] % Source 2 phase C voltage fifth harmonic

8194 SRC 2 Vc Harm[6] % Source 2 phase C voltage sixth harmonic

8195 SRC 2 Vc Harm[7] % Source 2 phase C voltage seventh harmonic

8196 SRC 2 Vc Harm[8] % Source 2 phase C voltage eighth harmonic
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A8197 SRC 2 Vc Harm[9] % Source 2 phase C voltage ninth harmonic

8198 SRC 2 Vc Harm[10] % Source 2 phase C voltage tenth harmonic

8199 SRC 2 Vc Harm[11] % Source 2 phase C voltage eleventh harmonic

8200 SRC 2 Vc Harm[12] % Source 2 phase C voltage twelfth harmonic

8201 SRC 2 Vc Harm[13] % Source 2 phase C voltage thirteenth harmonic

8202 SRC 2 Vc Harm[14] % Source 2 phase C voltage fourteenth harmonic

8203 SRC 2 Vc Harm[15] % Source 2 phase C voltage fifteenth harmonic

8204 SRC 2 Vc Harm[16] % Source 2 phase C voltage sixteenth harmonic

8205 SRC 2 Vc Harm[17] % Source 2 phase C voltage seventeenth harmonic

8206 SRC 2 Vc Harm[18] % Source 2 phase C voltage eighteenth harmonic

8207 SRC 2 Vc Harm[19] % Source 2 phase C voltage nineteenth harmonic

8208 SRC 2 Vc Harm[20] % Source 2 phase C voltage twentieth harmonic

8209 SRC 2 Vc Harm[21] % Source 2 phase C voltage twenty-first harmonic

8210 SRC 2 Vc Harm[22] % Source 2 phase C voltage twenty-second harmonic

8211 SRC 2 Vc Harm[23] % Source 2 phase C voltage twenty-third harmonic

8212 SRC 2 Vc Harm[24] % Source 2 phase C voltage twenty-fourth harmonic

8213 SRC 2 Vc Harm[25] % Source 2 phase C voltage twenty-fifth harmonic

8692 Brk 3 Arc Amp A kA2-cyc Breaker 3 arcing amp phase A

8694 Brk 3 Arc Amp B kA2-cyc Breaker 3 arcing amp phase B

8696 Brk 3 Arc Amp C kA2-cyc Breaker 3 arcing amp phase C

8698 Brk 3 Op Time A ms Breaker 3 operating time phase A

8699 Brk 3 Op Time B ms Breaker 3 operating time phase B

8700 Brk 3 Op Time C ms Breaker 3 operating time phase C

8701 Brk 3 Op Time ms Breaker 3 operating time

8702 Brk 4 Arc Amp A kA2-cyc Breaker 4 arcing amp phase A

8704 Brk 4 Arc Amp B kA2-cyc Breaker 4 arcing amp phase B

8706 Brk 4 Arc Amp C kA2-cyc Breaker 4 arcing amp phase C

8708 Brk 4 Op Time A ms Breaker 4 operating time phase A

8709 Brk 4 Op Time B ms Breaker 4 operating time phase B

8710 Brk 4 Op Time C ms Breaker 4 operating time phase C

8711 Brk 4 Op Time ms Breaker 4 operating time

8784 HIZ Status --- High impedance fault detection status

8785 HIZ Phase A Arc Conf --- High impedance fault detection phase A arc confidence

8786 HIZ Phase B Arc Conf --- High impedance fault detection phase B arc confidence

8787 HIZ Phase C Arc Conf --- High impedance fault detection phase C arc confidence

8788 HIZ Neutral Arc Conf --- High impedance fault detection neutral arc confidence

9024 Prefault Ia Mag [1] Amps Fault 1 pre-fault phase A current magnitude

9026 Prefault Ia Ang [1] Degrees Fault 1 pre-fault phase A current angle

9027 Prefault Ib Mag [1] Amps Fault 1 pre-fault phase B current magnitude

9029 Prefault Ib Ang [1] Degrees Fault 1 pre-fault phase B current angle

9030 Prefault Ic Mag [1] Amps Fault 1 pre-fault phase C current magnitude

9032 Prefault Ic Ang [1] Degrees Fault 1 pre-fault phase C current angle

9033 Prefault Va Mag [1] Volts Fault 1 pre-fault phase A voltage magnitude

9035 Prefault Va Ang [1] Degrees Fault 1 pre-fault phase A voltage angle

9036 Prefault Vb Mag [1] Volts Fault 1 pre-fault phase B voltage magnitude

9038 Prefault Vb Ang [1] Degrees Fault 1 pre-fault phase B voltage angle

9039 Prefault Vc Mag [1] Volts Fault 1 pre-fault phase C voltage magnitude
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9041 Prefault Vc Ang [1] Degrees Fault 1 pre-fault phase C voltage angle

9042 Fault Ia Mag [1] Amps Fault 1 post-fault phase A current magnitude

9044 Fault Ia Ang [1] Degrees Fault 1 post-fault phase A current angle

9045 Fault Ib Mag [1] Amps Fault 1 post-fault phase B current magnitude

9047 Fault Ib Ang [1] Degrees Fault 1 post-fault phase B current angle

9048 Fault Ic Mag [1 Amps Fault 1 post-fault phase C current magnitude

9050 Fault Ic Ang [1] Degrees Fault 1 post-fault phase C current angle

9051 Fault Va Mag [1] Volts Fault 1 post-fault phase A voltage magnitude

9053 Fault Va Ang [1] Degrees Fault 1 post-fault phase A voltage angle

9054 Fault Vb Mag [1] Volts Fault 1 post-fault phase B voltage magnitude

9056 Fault Vb Ang [1] Degrees Fault 1 post-fault phase B voltage angle

9057 Fault Vc Mag [1] Volts Fault 1 post-fault phase C voltage magnitude

9059 Fault Vc Ang [1] Degrees Fault 1 post-fault phase C voltage angle

9060 Fault Type [1] --- Fault 1 type

9061 Fault Location [1] --- Fault 1 location

9062 Prefault Ia Mag [2] Amps Fault 2 pre-fault phase A current magnitude

9064 Prefault Ia Ang [2] Degrees Fault 2 pre-fault phase A current angle

9065 Prefault Ib Mag [2] Amps Fault 2 pre-fault phase B current magnitude

9067 Prefault Ib Ang [2] Degrees Fault 2 pre-fault phase B current angle

9068 Prefault Ic Mag [2] Amps Fault 2 pre-fault phase C current magnitude

9070 Prefault Ic Ang [2] Degrees Fault 2 pre-fault phase C current angle

9071 Prefault Va Mag [2] Volts Fault 2 pre-fault phase A voltage magnitude

9073 Prefault Va Ang [2] Degrees Fault 2 pre-fault phase A voltage angle

9074 Prefault Vb Mag [2] Volts Fault 2 pre-fault phase B voltage magnitude

9076 Prefault Vb Ang [2] Degrees Fault 2 pre-fault phase B voltage angle

9077 Prefault Vc Mag [2] Volts Fault 2 pre-fault phase C voltage magnitude

9079 Prefault Vc Ang [2] Degrees Fault 2 pre-fault phase C voltage angle

9080 Fault Ia Mag [2] Amps Fault 2 post-fault phase A current magnitude

9082 Fault Ia Ang [2] Degrees Fault 2 post-fault phase A current angle

9083 Fault Ib Mag [2] Amps Fault 2 post-fault phase B current magnitude

9085 Fault Ib Ang [2] Degrees Fault 2 post-fault phase B current angle

9086 Fault Ic Mag [2] Amps Fault 2 post-fault phase C current magnitude

9088 Fault Ic Ang [2] Degrees Fault 2 post-fault phase C current angle

9089 Fault Va Mag [2] Volts Fault 2 post-fault phase A voltage magnitude

9091 Fault Va Ang [2] Degrees Fault 2 post-fault phase A voltage angle

9092 Fault Vb Mag [2] Volts Fault 2 post-fault phase B voltage magnitude

9094 Fault Vb Ang [2] Degrees Fault 2 post-fault phase B voltage angle

9095 Fault Vc Mag [2] Volts Fault 2 post-fault phase C voltage magnitude

9097 Fault Vc Ang [2] Degrees Fault 2 post-fault phase C voltage angle

9098 Fault Type [2] --- Fault 2 type

9099 Fault Location [2] --- Fault 2 location

9581 PMU 1 Va Mag Volts Phasor measurement unit 1 phase A voltage magnitude

9583 PMU 1 Va Angle Degrees Phasor measurement unit 1 phase A voltage angle

9584 PMU 1 Vb Mag Volts Phasor measurement unit 1 phase B voltage magnitude

9586 PMU 1 Vb Angle Degrees Phasor measurement unit 1 phase B voltage angle

9587 PMU 1 Vc Mag Volts Phasor measurement unit 1 phase C voltage magnitude

9589 PMU 1 Vc Angle Degrees Phasor measurement unit 1 phase C voltage angle
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A9590 PMU 1 Vx Mag Volts Phasor measurement unit 1 auxiliary voltage magnitude

9592 PMU 1 Vx Angle Degrees Phasor measurement unit 1 auxiliary voltage angle

9593 PMU 1 V1 Mag Volts Phasor measurement unit 1 positive-sequence voltage magnitude

9595 PMU 1 V1 Angle Degrees Phasor measurement unit 1 positive-sequence voltage angle

9596 PMU 1 V2 Mag Volts Phasor measurement unit 1 negative-sequence voltage magnitude

9598 PMU 1 V2 Angle Degrees Phasor measurement unit 1 negative-sequence voltage angle

9599 PMU 1 V0 Mag Volts Phasor measurement unit 1 zero-sequence voltage magnitude

9601 PMU 1 V0 Angle Degrees Phasor measurement unit 1 zero-sequence voltage angle

9602 PMU 1 Ia Mag Amps Phasor measurement unit 1 phase A current magnitude

9604 PMU 1 Ia Angle Degrees Phasor measurement unit 1 phase A current angle

9605 PMU 1 Ib Mag Amps Phasor measurement unit 1 phase B current magnitude

9607 PMU 1 Ib Angle Degrees Phasor measurement unit 1 phase B current angle

9608 PMU 1 Ic Mag Amps Phasor measurement unit 1 phase C current magnitude

9610 PMU 1 Ic Angle Degrees Phasor measurement unit 1 phase C current angle

9611 PMU 1 Ig Mag Amps Phasor measurement unit 1 ground current magnitude

9613 PMU 1 Ig Angle Degrees Phasor measurement unit 1 ground current angle

9614 PMU 1 I1 Mag Amps Phasor measurement unit 1 positive-sequence current magnitude

9616 PMU 1 I1 Angle Degrees Phasor measurement unit 1 positive-sequence current angle

9617 PMU 1 I2 Mag Amps Phasor measurement unit 1 negative-sequence current magnitude

9619 PMU 1 I2 Angle Degrees Phasor measurement unit 1 negative-sequence current angle

9620 PMU 1 I0 Mag Amps Phasor measurement unit 1 zero-sequence current magnitude

9622 PMU 1 I0 Angle Degrees Phasor measurement unit 1 zero-sequence current angle

9623 PMU 1 Freq Hz Phasor measurement unit 1 frequency

9625 PMU 1 df dt Hz/s Phasor measurement unit 1 rate of change of frequency

9626 PMU 1 Conf Ch --- Phasor measurement unit 1 configuration change counter

10240 SRC 1 Ia THD % Source 1 phase A current total harmonic distortion

10241 SRC 1 Ia Harm[2] % Source 1 phase A current second harmonic

10242 SRC 1 Ia Harm[3] % Source 1 phase A current third harmonic

10243 SRC 1 Ia Harm[4] % Source 1 phase A current fourth harmonic

10244 SRC 1 Ia Harm[5] % Source 1 phase A current fifth harmonic

10245 SRC 1 Ia Harm[6] % Source 1 phase A current sixth harmonic

10246 SRC 1 Ia Harm[7] % Source 1 phase A current seventh harmonic

10247 SRC 1 Ia Harm[8] % Source 1 phase A current eighth harmonic

10248 SRC 1 Ia Harm[9] % Source 1 phase A current ninth harmonic

10249 SRC 1 Ia Harm[10] % Source 1 phase A current tenth harmonic

10250 SRC 1 Ia Harm[11] % Source 1 phase A current eleventh harmonic

10251 SRC 1 Ia Harm[12] % Source 1 phase A current twelfth harmonic

10252 SRC 1 Ia Harm[13] % Source 1 phase A current thirteenth harmonic

10253 SRC 1 Ia Harm[14] % Source 1 phase A current fourteenth harmonic

10254 SRC 1 Ia Harm[15] % Source 1 phase A current fifteenth harmonic

10255 SRC 1 Ia Harm[16] % Source 1 phase A current sixteenth harmonic

10256 SRC 1 Ia Harm[17] % Source 1 phase A current seventeenth harmonic

10257 SRC 1 Ia Harm[18] % Source 1 phase A current eighteenth harmonic

10258 SRC 1 Ia Harm[19] % Source 1 phase A current nineteenth harmonic

10259 SRC 1 Ia Harm[20] % Source 1 phase A current twentieth harmonic

10260 SRC 1 Ia Harm[21] % Source 1 phase A current twenty-first harmonic

10261 SRC 1 Ia Harm[22] % Source 1 phase A current twenty-second harmonic
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10262 SRC 1 Ia Harm[23] % Source 1 phase A current twenty-third harmonic

10263 SRC 1 Ia Harm[24] % Source 1 phase A current twenty-fourth harmonic

10264 SRC 1 Ia Harm[25] % Source 1 phase A current twenty-fifth harmonic

10273 SRC 1 Ib THD % Source 1 phase B current total harmonic distortion

10274 SRC 1 Ib Harm[2] % Source 1 phase B current second harmonic

10275 SRC 1 Ib Harm[3] % Source 1 phase B current third harmonic

10276 SRC 1 Ib Harm[4] % Source 1 phase B current fourth harmonic

10277 SRC 1 Ib Harm[5] % Source 1 phase B current fifth harmonic

10278 SRC 1 Ib Harm[6] % Source 1 phase B current sixth harmonic

10279 SRC 1 Ib Harm[7] % Source 1 phase B current seventh harmonic

10280 SRC 1 Ib Harm[8] % Source 1 phase B current eighth harmonic

10281 SRC 1 Ib Harm[9] % Source 1 phase B current ninth harmonic

10282 SRC 1 Ib Harm[10] % Source 1 phase B current tenth harmonic

10283 SRC 1 Ib Harm[11] % Source 1 phase B current eleventh harmonic

10284 SRC 1 Ib Harm[12] % Source 1 phase B current twelfth harmonic

10285 SRC 1 Ib Harm[13] % Source 1 phase B current thirteenth harmonic

10286 SRC 1 Ib Harm[14] % Source 1 phase B current fourteenth harmonic

10287 SRC 1 Ib Harm[15] % Source 1 phase B current fifteenth harmonic

10288 SRC 1 Ib Harm[16] % Source 1 phase B current sixteenth harmonic

10289 SRC 1 Ib Harm[17] % Source 1 phase B current seventeenth harmonic

10290 SRC 1 Ib Harm[18] % Source 1 phase B current eighteenth harmonic

10291 SRC 1 Ib Harm[19] % Source 1 phase B current nineteenth harmonic

10292 SRC 1 Ib Harm[20] % Source 1 phase B current twentieth harmonic

10293 SRC 1 Ib Harm[21] % Source 1 phase B current twenty-first harmonic

10294 SRC 1 Ib Harm[22] % Source 1 phase B current twenty-second harmonic

10295 SRC 1 Ib Harm[23] % Source 1 phase B current twenty-third harmonic

10296 SRC 1 Ib Harm[24] % Source 1 phase B current twenty-fourth harmonic

10297 SRC 1 Ib Harm[25] % Source 1 phase B current twenty-fifth harmonic

10306 SRC 1 Ic THD % Source 1 phase C current total harmonic distortion

10307 SRC 1 Ic Harm[2] % Source 1 phase C current second harmonic

10308 SRC 1 Ic Harm[3] % Source 1 phase C current third harmonic

10309 SRC 1 Ic Harm[4] % Source 1 phase C current fourth harmonic

10310 SRC 1 Ic Harm[5] % Source 1 phase C current fifth harmonic

10311 SRC 1 Ic Harm[6] % Source 1 phase C current sixth harmonic

10312 SRC 1 Ic Harm[7] % Source 1 phase C current seventh harmonic

10313 SRC 1 Ic Harm[8] % Source 1 phase C current eighth harmonic

10314 SRC 1 Ic Harm[9] % Source 1 phase C current ninth harmonic

10315 SRC 1 Ic Harm[10] % Source 1 phase C current tenth harmonic

10316 SRC 1 Ic Harm[11] % Source 1 phase C current eleventh harmonic

10317 SRC 1 Ic Harm[12] % Source 1 phase C current twelfth harmonic

10318 SRC 1 Ic Harm[13] % Source 1 phase C current thirteenth harmonic

10319 SRC 1 Ic Harm[14] % Source 1 phase C current fourteenth harmonic

10320 SRC 1 Ic Harm[15] % Source 1 phase C current fifteenth harmonic

10321 SRC 1 Ic Harm[16] % Source 1 phase C current sixteenth harmonic

10322 SRC 1 Ic Harm[17] % Source 1 phase C current seventeenth harmonic

10323 SRC 1 Ic Harm[18] % Source 1 phase C current eighteenth harmonic

10324 SRC 1 Ic Harm[19] % Source 1 phase C current nineteenth harmonic
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A10325 SRC 1 Ic Harm[20] % Source 1 phase C current twentieth harmonic

10326 SRC 1 Ic Harm[21] % Source 1 phase C current twenty-first harmonic

10327 SRC 1 Ic Harm[22] % Source 1 phase C current twenty-second harmonic

10328 SRC 1 Ic Harm[23] % Source 1 phase C current twenty-third harmonic

10329 SRC 1 Ic Harm[24] % Source 1 phase C current twenty-fourth harmonic

10330 SRC 1 Ic Harm[25] % Source 1 phase C current twenty-fifth harmonic

10339 SRC 2 Ia THD % Source 2 phase A current total harmonic distortion

10340 SRC 2 Ia Harm[2] % Source 2 phase A current second harmonic

10341 SRC 2 Ia Harm[3] % Source 2 phase A current third harmonic

10342 SRC 2 Ia Harm[4] % Source 2 phase A current fourth harmonic

10343 SRC 2 Ia Harm[5] % Source 2 phase A current fifth harmonic

10344 SRC 2 Ia Harm[6] % Source 2 phase A current sixth harmonic

10345 SRC 2 Ia Harm[7] % Source 2 phase A current seventh harmonic

10346 SRC 2 Ia Harm[8] % Source 2 phase A current eighth harmonic

10347 SRC 2 Ia Harm[9] % Source 2 phase A current ninth harmonic

10348 SRC 2 Ia Harm[10] % Source 2 phase A current tenth harmonic

10349 SRC 2 Ia Harm[11] % Source 2 phase A current eleventh harmonic

10350 SRC 2 Ia Harm[12] % Source 2 phase A current twelfth harmonic

10351 SRC 2 Ia Harm[13] % Source 2 phase A current thirteenth harmonic

10352 SRC 2 Ia Harm[14] % Source 2 phase A current fourteenth harmonic

10353 SRC 2 Ia Harm[15] % Source 2 phase A current fifteenth harmonic

10354 SRC 2 Ia Harm[16] % Source 2 phase A current sixteenth harmonic

10355 SRC 2 Ia Harm[17] % Source 2 phase A current seventeenth harmonic

10356 SRC 2 Ia Harm[18] % Source 2 phase A current eighteenth harmonic

10357 SRC 2 Ia Harm[19] % Source 2 phase A current nineteenth harmonic

10358 SRC 2 Ia Harm[20] % Source 2 phase A current twentieth harmonic

10359 SRC 2 Ia Harm[21] % Source 2 phase A current twenty-first harmonic

10360 SRC 2 Ia Harm[22] % Source 2 phase A current twenty-second harmonic

10361 SRC 2 Ia Harm[23] % Source 2 phase A current twenty-third harmonic

10362 SRC 2 Ia Harm[24] % Source 2 phase A current twenty-fourth harmonic

10363 SRC 2 Ia Harm[25] % Source 2 phase A current twenty-fifth harmonic

10372 SRC 2 Ib THD % Source 2 phase B current total harmonic distortion

10373 SRC 2 Ib Harm[2] % Source 2 phase B current second harmonic

10374 SRC 2 Ib Harm[3] % Source 2 phase B current third harmonic

10375 SRC 2 Ib Harm[4] % Source 2 phase B current fourth harmonic

10376 SRC 2 Ib Harm[5] % Source 2 phase B current fifth harmonic

10377 SRC 2 Ib Harm[6] % Source 2 phase B current sixth harmonic

10378 SRC 2 Ib Harm[7] % Source 2 phase B current seventh harmonic

10379 SRC 2 Ib Harm[8] % Source 2 phase B current eighth harmonic

10380 SRC 2 Ib Harm[9] % Source 2 phase B current ninth harmonic

10381 SRC 2 Ib Harm[10] % Source 2 phase B current tenth harmonic

10382 SRC 2 Ib Harm[11] % Source 2 phase B current eleventh harmonic

10383 SRC 2 Ib Harm[12] % Source 2 phase B current twelfth harmonic

10384 SRC 2 Ib Harm[13] % Source 2 phase B current thirteenth harmonic

10385 SRC 2 Ib Harm[14] % Source 2 phase B current fourteenth harmonic

10386 SRC 2 Ib Harm[15] % Source 2 phase B current fifteenth harmonic

10387 SRC 2 Ib Harm[16] % Source 2 phase B current sixteenth harmonic
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10388 SRC 2 Ib Harm[17] % Source 2 phase B current seventeenth harmonic

10389 SRC 2 Ib Harm[18] % Source 2 phase B current eighteenth harmonic

10390 SRC 2 Ib Harm[19] % Source 2 phase B current nineteenth harmonic

10391 SRC 2 Ib Harm[20] % Source 2 phase B current twentieth harmonic

10392 SRC 2 Ib Harm[21] % Source 2 phase B current twenty-first harmonic

10393 SRC 2 Ib Harm[22] % Source 2 phase B current twenty-second harmonic

10394 SRC 2 Ib Harm[23] % Source 2 phase B current twenty-third harmonic

10395 SRC 2 Ib Harm[24] % Source 2 phase B current twenty-fourth harmonic

10396 SRC 2 Ib Harm[25] % Source 2 phase B current twenty-fifth harmonic

10405 SRC 2 Ic THD % Source 2 phase C current total harmonic distortion

10406 SRC 2 Ic Harm[2] % Source 2 phase C current second harmonic

10407 SRC 2 Ic Harm[3] % Source 2 phase C current third harmonic

10408 SRC 2 Ic Harm[4] % Source 2 phase C current fourth harmonic

10409 SRC 2 Ic Harm[5] % Source 2 phase C current fifth harmonic

10410 SRC 2 Ic Harm[6] % Source 2 phase C current sixth harmonic

10411 SRC 2 Ic Harm[7] % Source 2 phase C current seventh harmonic

10412 SRC 2 Ic Harm[8] % Source 2 phase C current eighth harmonic

10413 SRC 2 Ic Harm[9] % Source 2 phase C current ninth harmonic

10414 SRC 2 Ic Harm[10] % Source 2 phase C current tenth harmonic

10415 SRC 2 Ic Harm[11] % Source 2 phase C current eleventh harmonic

10416 SRC 2 Ic Harm[12] % Source 2 phase C current twelfth harmonic

10417 SRC 2 Ic Harm[13] % Source 2 phase C current thirteenth harmonic

10418 SRC 2 Ic Harm[14] % Source 2 phase C current fourteenth harmonic

10419 SRC 2 Ic Harm[15] % Source 2 phase C current fifteenth harmonic

10420 SRC 2 Ic Harm[16] % Source 2 phase C current sixteenth harmonic

10421 SRC 2 Ic Harm[17] % Source 2 phase C current seventeenth harmonic

10422 SRC 2 Ic Harm[18] % Source 2 phase C current eighteenth harmonic

10423 SRC 2 Ic Harm[19] % Source 2 phase C current nineteenth harmonic

10424 SRC 2 Ic Harm[20] % Source 2 phase C current twentieth harmonic

10425 SRC 2 Ic Harm[21] % Source 2 phase C current twenty-first harmonic

10426 SRC 2 Ic Harm[22] % Source 2 phase C current twenty-second harmonic

10427 SRC 2 Ic Harm[23] % Source 2 phase C current twenty-third harmonic

10428 SRC 2 Ic Harm[24] % Source 2 phase C current twenty-fourth harmonic

10429 SRC 2 Ic Harm[25] % Source 2 phase C current twenty-fifth harmonic

10438 SRC 3 Ia THD % Source 3 phase A current total harmonic distortion

10439 SRC 3 Ia Harm[2] % Source 3 phase A current second harmonic

10440 SRC 3 Ia Harm[3] % Source 3 phase A current third harmonic

10441 SRC 3 Ia Harm[4] % Source 3 phase A current fourth harmonic

10442 SRC 3 Ia Harm[5] % Source 3 phase A current fifth harmonic

10443 SRC 3 Ia Harm[6] % Source 3 phase A current sixth harmonic

10444 SRC 3 Ia Harm[7] % Source 3 phase A current seventh harmonic

10445 SRC 3 Ia Harm[8] % Source 3 phase A current eighth harmonic

10446 SRC 3 Ia Harm[9] % Source 3 phase A current ninth harmonic

10447 SRC 3 Ia Harm[10] % Source 3 phase A current tenth harmonic

10448 SRC 3 Ia Harm[11] % Source 3 phase A current eleventh harmonic

10449 SRC 3 Ia Harm[12] % Source 3 phase A current twelfth harmonic

10450 SRC 3 Ia Harm[13] % Source 3 phase A current thirteenth harmonic
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A10451 SRC 3 Ia Harm[14] % Source 3 phase A current fourteenth harmonic

10452 SRC 3 Ia Harm[15] % Source 3 phase A current fifteenth harmonic

10453 SRC 3 Ia Harm[16] % Source 3 phase A current sixteenth harmonic

10454 SRC 3 Ia Harm[17] % Source 3 phase A current seventeenth harmonic

10455 SRC 3 Ia Harm[18] % Source 3 phase A current eighteenth harmonic

10456 SRC 3 Ia Harm[19] % Source 3 phase A current nineteenth harmonic

10457 SRC 3 Ia Harm[20] % Source 3 phase A current twentieth harmonic

10458 SRC 3 Ia Harm[21] % Source 3 phase A current twenty-first harmonic

10459 SRC 3 Ia Harm[22] % Source 3 phase A current twenty-second harmonic

10460 SRC 3 Ia Harm[23] % Source 3 phase A current twenty-third harmonic

10461 SRC 3 Ia Harm[24] % Source 3 phase A current twenty-fourth harmonic

10462 SRC 3 Ia Harm[25] % Source 3 phase A current twenty-fifth harmonic

10471 SRC 3 Ib THD % Source 3 phase B current total harmonic distortion

10472 SRC 3 Ib Harm[2] % Source 3 phase B current second harmonic

10473 SRC 3 Ib Harm[3] % Source 3 phase B current third harmonic

10474 SRC 3 Ib Harm[4] % Source 3 phase B current fourth harmonic

10475 SRC 3 Ib Harm[5] % Source 3 phase B current fifth harmonic

10476 SRC 3 Ib Harm[6] % Source 3 phase B current sixth harmonic

10477 SRC 3 Ib Harm[7] % Source 3 phase B current seventh harmonic

10478 SRC 3 Ib Harm[8] % Source 3 phase B current eighth harmonic

10479 SRC 3 Ib Harm[9] % Source 3 phase B current ninth harmonic

10480 SRC 3 Ib Harm[10] % Source 3 phase B current tenth harmonic

10481 SRC 3 Ib Harm[11] % Source 3 phase B current eleventh harmonic

10482 SRC 3 Ib Harm[12] % Source 3 phase B current twelfth harmonic

10483 SRC 3 Ib Harm[13] % Source 3 phase B current thirteenth harmonic

10484 SRC 3 Ib Harm[14] % Source 3 phase B current fourteenth harmonic

10485 SRC 3 Ib Harm[15] % Source 3 phase B current fifteenth harmonic

10486 SRC 3 Ib Harm[16] % Source 3 phase B current sixteenth harmonic

10487 SRC 3 Ib Harm[17] % Source 3 phase B current seventeenth harmonic

10488 SRC 3 Ib Harm[18] % Source 3 phase B current eighteenth harmonic

10489 SRC 3 Ib Harm[19] % Source 3 phase B current nineteenth harmonic

10490 SRC 3 Ib Harm[20] % Source 3 phase B current twentieth harmonic

10491 SRC 3 Ib Harm[21] % Source 3 phase B current twenty-first harmonic

10492 SRC 3 Ib Harm[22] % Source 3 phase B current twenty-second harmonic

10493 SRC 3 Ib Harm[23] % Source 3 phase B current twenty-third harmonic

10494 SRC 3 Ib Harm[24] % Source 3 phase B current twenty-fourth harmonic

10495 SRC 3 Ib Harm[25] % Source 3 phase B current twenty-fifth harmonic

10504 SRC 3 Ic THD % Source 3 phase C current total harmonic distortion

10505 SRC 3 Ic Harm[2] % Source 3 phase C current second harmonic

10506 SRC 3 Ic Harm[3] % Source 3 phase C current third harmonic

10507 SRC 3 Ic Harm[4] % Source 3 phase C current fourth harmonic

10508 SRC 3 Ic Harm[5] % Source 3 phase C current fifth harmonic

10509 SRC 3 Ic Harm[6] % Source 3 phase C current sixth harmonic

10510 SRC 3 Ic Harm[7] % Source 3 phase C current seventh harmonic

10511 SRC 3 Ic Harm[8] % Source 3 phase C current eighth harmonic

10512 SRC 3 Ic Harm[9] % Source 3 phase C current ninth harmonic

10513 SRC 3 Ic Harm[10] % Source 3 phase C current tenth harmonic
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A
10514 SRC 3 Ic Harm[11] % Source 3 phase C current eleventh harmonic

10515 SRC 3 Ic Harm[12] % Source 3 phase C current twelfth harmonic

10516 SRC 3 Ic Harm[13] % Source 3 phase C current thirteenth harmonic

10517 SRC 3 Ic Harm[14] % Source 3 phase C current fourteenth harmonic

10518 SRC 3 Ic Harm[15] % Source 3 phase C current fifteenth harmonic

10519 SRC 3 Ic Harm[16] % Source 3 phase C current sixteenth harmonic

10520 SRC 3 Ic Harm[17] % Source 3 phase C current seventeenth harmonic

10521 SRC 3 Ic Harm[18] % Source 3 phase C current eighteenth harmonic

10522 SRC 3 Ic Harm[19] % Source 3 phase C current nineteenth harmonic

10523 SRC 3 Ic Harm[20] % Source 3 phase C current twentieth harmonic

10524 SRC 3 Ic Harm[21] % Source 3 phase C current twenty-first harmonic

10525 SRC 3 Ic Harm[22] % Source 3 phase C current twenty-second harmonic

10526 SRC 3 Ic Harm[23] % Source 3 phase C current twenty-third harmonic

10527 SRC 3 Ic Harm[24] % Source 3 phase C current twenty-fourth harmonic

10528 SRC 3 Ic Harm[25] % Source 3 phase C current twenty-fifth harmonic

10537 SRC 4 Ia THD % Source 4 phase A current total harmonic distortion

10538 SRC 4 Ia Harm[2] % Source 4 phase A current second harmonic

10539 SRC 4 Ia Harm[3] % Source 4 phase A current third harmonic

10540 SRC 4 Ia Harm[4] % Source 4 phase A current fourth harmonic

10541 SRC 4 Ia Harm[5] % Source 4 phase A current fifth harmonic

10542 SRC 4 Ia Harm[6] % Source 4 phase A current sixth harmonic

10543 SRC 4 Ia Harm[7] % Source 4 phase A current seventh harmonic

10544 SRC 4 Ia Harm[8] % Source 4 phase A current eighth harmonic

10545 SRC 4 Ia Harm[9] % Source 4 phase A current ninth harmonic

10546 SRC 4 Ia Harm[10] % Source 4 phase A current tenth harmonic

10547 SRC 4 Ia Harm[11] % Source 4 phase A current eleventh harmonic

10548 SRC 4 Ia Harm[12] % Source 4 phase A current twelfth harmonic

10549 SRC 4 Ia Harm[13] % Source 4 phase A current thirteenth harmonic

10550 SRC 4 Ia Harm[14] % Source 4 phase A current fourteenth harmonic

10551 SRC 4 Ia Harm[15] % Source 4 phase A current fifteenth harmonic

10552 SRC 4 Ia Harm[16] % Source 4 phase A current sixteenth harmonic

10553 SRC 4 Ia Harm[17] % Source 4 phase A current seventeenth harmonic

10554 SRC 4 Ia Harm[18] % Source 4 phase A current eighteenth harmonic

10555 SRC 4 Ia Harm[19] % Source 4 phase A current nineteenth harmonic

10556 SRC 4 Ia Harm[20] % Source 4 phase A current twentieth harmonic

10557 SRC 4 Ia Harm[21] % Source 4 phase A current twenty-first harmonic

10558 SRC 4 Ia Harm[22] % Source 4 phase A current twenty-second harmonic

10559 SRC 4 Ia Harm[23] % Source 4 phase A current twenty-third harmonic

10560 SRC 4 Ia Harm[24] % Source 4 phase A current twenty-fourth harmonic

10561 SRC 4 Ia Harm[25] % Source 4 phase A current twenty-fifth harmonic

10570 SRC 4 Ib THD % Source 4 phase B current total harmonic distortion

10571 SRC 4 Ib Harm[2] % Source 4 phase B current second harmonic

10572 SRC 4 Ib Harm[3] % Source 4 phase B current third harmonic

10573 SRC 4 Ib Harm[4] % Source 4 phase B current fourth harmonic

10574 SRC 4 Ib Harm[5] % Source 4 phase B current fifth harmonic

10575 SRC 4 Ib Harm[6] % Source 4 phase B current sixth harmonic

10576 SRC 4 Ib Harm[7] % Source 4 phase B current seventh harmonic
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A10577 SRC 4 Ib Harm[8] % Source 4 phase B current eighth harmonic

10578 SRC 4 Ib Harm[9] % Source 4 phase B current ninth harmonic

10579 SRC 4 Ib Harm[10] % Source 4 phase B current tenth harmonic

10580 SRC 4 Ib Harm[11] % Source 4 phase B current eleventh harmonic

10581 SRC 4 Ib Harm[12] % Source 4 phase B current twelfth harmonic

10582 SRC 4 Ib Harm[13] % Source 4 phase B current thirteenth harmonic

10583 SRC 4 Ib Harm[14] % Source 4 phase B current fourteenth harmonic

10584 SRC 4 Ib Harm[15] % Source 4 phase B current fifteenth harmonic

10585 SRC 4 Ib Harm[16] % Source 4 phase B current sixteenth harmonic

10586 SRC 4 Ib Harm[17] % Source 4 phase B current seventeenth harmonic

10587 SRC 4 Ib Harm[18] % Source 4 phase B current eighteenth harmonic

10588 SRC 4 Ib Harm[19] % Source 4 phase B current nineteenth harmonic

10589 SRC 4 Ib Harm[20] % Source 4 phase B current twentieth harmonic

10590 SRC 4 Ib Harm[21] % Source 4 phase B current twenty-first harmonic

10591 SRC 4 Ib Harm[22] % Source 4 phase B current twenty-second harmonic

10592 SRC 4 Ib Harm[23] % Source 4 phase B current twenty-third harmonic

10593 SRC 4 Ib Harm[24] % Source 4 phase B current twenty-fourth harmonic

10594 SRC 4 Ib Harm[25] % Source 4 phase B current twenty-fifth harmonic

10603 SRC 4 Ic THD % Source 4 phase C current total harmonic distortion

10604 SRC 4 Ic Harm[2] % Source 4 phase C current second harmonic

10605 SRC 4 Ic Harm[3] % Source 4 phase C current third harmonic

10606 SRC 4 Ic Harm[4] % Source 4 phase C current fourth harmonic

10607 SRC 4 Ic Harm[5] % Source 4 phase C current fifth harmonic

10608 SRC 4 Ic Harm[6] % Source 4 phase C current sixth harmonic

10609 SRC 4 Ic Harm[7] % Source 4 phase C current seventh harmonic

10610 SRC 4 Ic Harm[8] % Source 4 phase C current eighth harmonic

10611 SRC 4 Ic Harm[9] % Source 4 phase C current ninth harmonic

10612 SRC 4 Ic Harm[10] % Source 4 phase C current tenth harmonic

10613 SRC 4 Ic Harm[11] % Source 4 phase C current eleventh harmonic

10614 SRC 4 Ic Harm[12] % Source 4 phase C current twelfth harmonic

10615 SRC 4 Ic Harm[13] % Source 4 phase C current thirteenth harmonic

10616 SRC 4 Ic Harm[14] % Source 4 phase C current fourteenth harmonic

10617 SRC 4 Ic Harm[15] % Source 4 phase C current fifteenth harmonic

10618 SRC 4 Ic Harm[16] % Source 4 phase C current sixteenth harmonic

10619 SRC 4 Ic Harm[17] % Source 4 phase C current seventeenth harmonic

10620 SRC 4 Ic Harm[18] % Source 4 phase C current eighteenth harmonic

10621 SRC 4 Ic Harm[19] % Source 4 phase C current nineteenth harmonic

10622 SRC 4 Ic Harm[20] % Source 4 phase C current twentieth harmonic

10623 SRC 4 Ic Harm[21] % Source 4 phase C current twenty-first harmonic

10624 SRC 4 Ic Harm[22] % Source 4 phase C current twenty-second harmonic

10625 SRC 4 Ic Harm[23] % Source 4 phase C current twenty-third harmonic

10626 SRC 4 Ic Harm[24] % Source 4 phase C current twenty-fourth harmonic

10627 SRC 4 Ic Harm[25] % Source 4 phase C current twenty-fifth harmonic

10848 Synchchk 1 Delta V Volts Synchrocheck 1 delta voltage

10850 Synchchk 1 Delta Phs Degrees Synchrocheck 1 delta phase

10851 Synchchk 1 SSCP DPh Degrees Synchrocheck 1 synchscope

10852 Synchchk 1 Delta F Hz Synchrocheck 1 delta frequency
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A
10853 Synchchk 1 V1 Mag Volts Synchrocheck 1 V1 mag

10855 Synchchk 1 V1 Ang Degrees Synchrocheck 1 V1 angle

10856 Synchchk 1 V2 Mag Volts Synchrocheck 1 V2 mag

10858 Synchchk 1 V2 Ang Degrees Synchrocheck 1 V2 angle

10859 Synchchk 1 V2’ Mag Volts Synchrocheck 1 V2_mag

10861 Synchchk 1 V2’ Ang Degrees Synchrocheck 1 V2_angle

10862 Synchchk 1 Delta’ Phs Degrees Synchrocheck 1 delta_phase

10863 Synchchk 1 SSCP DPh’ Degrees Synchrocheck 1 _synchscope

10864 Synchchk 2 Delta V Volts Synchrocheck 2 delta voltage

10866 Synchchk 2 Delta Phs Degrees Synchrocheck 2 delta phase

10867 Synchchk 2 SSCP DPh Degrees Synchrocheck 2 synchscope

10868 Synchchk 2 Delta F Hz Synchrocheck 2 delta frequency

10869 Synchchk 2 V1 Mag Volts Synchrocheck 2 V1 mag

10871 Synchchk 2 V1 Ang Degrees Synchrocheck 2 V1 angle

10872 Synchchk 2 V2 Mag Volts Synchrocheck 2 V2 mag

10874 Synchchk 2 V2 Ang Degrees Synchrocheck 2 V2 angle

10875 Synchchk 2 V2’ Mag Volts Synchrocheck 2 V2_mag

10877 Synchchk 2 V2’ Ang Degrees Synchrocheck 2 V2_angle

10878 Synchchk 2 Delta’ Phs Degrees Synchrocheck 2 delta_phase

10879 Synchchk 2 SSCP DPh’ Degrees Synchrocheck 2 _synchscope

10880 Synchchk 3 Delta V Volts Synchrocheck 3 delta voltage

10882 Synchchk 3 Delta Phs Degrees Synchrocheck 3 delta phase

10883 Synchchk 3 SSCP DPh Degrees Synchrocheck 3 synchscope

10884 Synchchk 3 Delta F Volts Synchrocheck 3 delta frequency

10885 Synchchk 3 V1 Mag Volts Synchrocheck 3 V1 mag

10887 Synchchk 3 V1 Ang Degrees Synchrocheck 3 V1 angle

10888 Synchchk 3 V2 Mag Volts Synchrocheck 3 V2 mag

10890 Synchchk 3 V2 Ang Degrees Synchrocheck 3 V2 angle

10891 Synchchk 3 V2’ Mag Volts Synchrocheck 3 V2_mag

10893 Synchchk 3 V2’ Ang Degrees Synchrocheck 3 V2_angle

10894 Synchchk 3 Delta’ Phs Degrees Synchrocheck 3 delta_phase

10895 Synchchk 3 SSCP DPh’ Degrees Synchrocheck 3 _synchscope

10896 Synchchk 4 Delta V Volts Synchrocheck 4 delta voltage

10898 Synchchk 4 Delta Phs Degrees Synchrocheck 4 delta phase

10899 Synchchk 4 SSCP DPh Degrees Synchrocheck 4 synchscope

10900 Synchchk 4 Delta F Hz Synchrocheck 4 delta frequency

10901 Synchchk 4 V1 Mag Volts Synchrocheck 4 V1 mag

10903 Synchchk 4 V1 Ang Degrees Synchrocheck 4 V1 angle

10904 Synchchk 4 V2 Mag Volts Synchrocheck 4 V2 mag

10906 Synchchk 4 V2 Ang Degrees Synchrocheck 4 V2 angle

10907 Synchchk 4 V2’ Mag Volts Synchrocheck 4 V2_mag

10909 Synchchk 4 V2’ Ang Degrees Synchrocheck 4 V2_angle

10910 Synchchk 4 Delta’ Phs Degrees Synchrocheck 4 delta_phase

10911 Synchchk 4 SSCP DPh’ Degrees Synchrocheck 4 _synchscope

12032 Brk 1 Acc Arc Amp A kA2-cyc Breaker 1 Acc arcing amp phase A

12034 Brk 1 Acc Arc Amp B kA2-cyc Breaker 1 Acc arcing amp phase B

12036 Brk 1 Acc Arc Amp C kA2-cyc Breaker 1 Acc arcing amp phase C
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A12038 Brk 1 Op Time A ms Breaker 1 operating time phase A

12039 Brk 1 Op Time B ms Breaker 1 operating time phase B

12040 Brk 1 Op Time C ms Breaker 1 operating time phase C

12041 Brk 1 Op Time ms Breaker 1 operating time

12042 Brk 1 Arc Amp A kA2-cyc Breaker 1 arcing amp phase A

12044 Brk 1 Arc Amp B kA2-cyc Breaker 1 arcing amp phase B

12046 Brk 1 Arc Amp C kA2-cyc Breaker 1 arcing amp phase C

12048 Brk 1 Amp Max A kA2-cyc Breaker 1 amp max phase A

12050 Brk 1 Amp Max B kA2-cyc Breaker 1 amp max phase B

12052 Brk 1 Amp Max C kA2-cyc Breaker 1 amp max phase C

12054 Brk 2 Acc Arc Amp A kA2-cyc Breaker 2 Acc arcing amp phase A

12056 Brk 2 Acc Arc Amp B kA2-cyc Breaker 2 Acc arcing amp phase B

12058 Brk 2 Acc Arc Amp C kA2-cyc Breaker 2 Acc arcing amp phase C

12060 Brk 2 Op Time A ms Breaker 2 operating time phase A

12061 Brk 2 Op Time B ms Breaker 2 operating time phase B

12062 Brk 2 Op Time C ms Breaker 2 operating time phase C

12063 Brk 2 Op Time ms Breaker 2 operating time

12064 Brk 2 Arc Amp A kA2-cyc Breaker 2 arcing amp phase A

12066 Brk 2 Arc Amp B kA2-cyc Breaker 2 arcing amp phase B

12068 Brk 2 Arc Amp C kA2-cyc Breaker 2 arcing amp phase C

12070 Brk 2 Amp Max A kA2-cyc Breaker 2 amp max phase A

12072 Brk 2 Amp Max B kA2-cyc Breaker 2 amp max phase B

12074 Brk 2 Amp Max C kA2-cyc Breaker 2 amp max phase C

12076 Brk 3 Acc Arc Amp A kA2-cyc Breaker 3 Acc arcing amp phase A

12078 Brk 3 Acc Arc Amp B kA2-cyc Breaker 3 Acc arcing amp phase B

12080 Brk 3 Acc Arc Amp C kA2-cyc Breaker 3 Acc arcing amp phase C

12082 Brk 3 Op Time A ms Breaker 3 operating time phase A

12083 Brk 3 Op Time B ms Breaker 3 operating time phase B

12084 Brk 3 Op Time C ms Breaker 3 operating time phase C

12085 Brk 3 Op Time ms Breaker 3 operating time

12086 Brk 3 Arc Amp A kA2-cyc Breaker 3 arcing amp phase A

12088 Brk 3 Arc Amp B kA2-cyc Breaker 3 arcing amp phase B

12090 Brk 3 Arc Amp C kA2-cyc Breaker 3 arcing amp phase C

12092 Brk 3 Amp Max A kA2-cyc Breaker 3 amp max phase A

12094 Brk 3 Amp Max B kA2-cyc Breaker 3 amp max phase B

12096 Brk 3 Amp Max C kA2-cyc Breaker 3 amp max phase C

12098 Brk 4 Acc Arc Amp A kA2-cyc Breaker 4 Acc arcing amp phase A

12100 Brk 4 Acc Arc Amp B kA2-cyc Breaker 4 Acc arcing amp phase B

12102 Brk 4 Acc Arc Amp C kA2-cyc Breaker 4 Acc arcing amp phase C

12104 Brk 4 Op Time A ms Breaker 4 operating time phase A

12105 Brk 4 Op Time B ms Breaker 4 operating time phase B

12106 Brk 4 Op Time C ms Breaker 4 operating time phase C

12107 Brk 4 Op Time ms Breaker 4 operating time

12108 Brk 4 Arc Amp A kA2-cyc Breaker 4 arcing amp phase A

12110 Brk 4 Arc Amp B kA2-cyc Breaker 4 arcing amp phase B

12112 Brk 4 Arc Amp C kA2-cyc Breaker 4 arcing amp phase C

12114 Brk 4 Amp Max A kA2-cyc Breaker 4 amp max phase A
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A
12116 Brk 4 Amp Max B kA2-cyc Breaker 4 amp max phase B

12118 Brk 4 Amp Max C kA2-cyc Breaker 4 amp max phase C

12306 Oscill Num Triggers --- Oscillography number of triggers

13504 DCmA Ip 1 mA DCmA input 1 actual value

13506 DCmA Ip 2 mA DCmA input 2 actual value

13508 DCmA Ip 3 mA DCmA input 3 actual value

13510 DCmA Ip 4 mA DCmA input 4 actual value

13512 DCmA Ip 5 mA DCmA input 5 actual value

13514 DCmA Ip 6 mA DCmA input 6 actual value

13516 DCmA Ip 7 mA DCmA input 7 actual value

13518 DCmA Ip 8 mA DCmA input 8 actual value

13520 DCmA Ip 9 mA DCmA input 9 actual value

13522 DCmA Ip 10 mA DCmA input 10 actual value

13524 DCmA Ip 11 mA DCmA input 11 actual value

13526 DCmA Ip 12 mA DCmA input 12 actual value

13528 DCmA Ip 13 mA DCmA input 13 actual value

13530 DCmA Ip 14 mA DCmA input 14 actual value

13532 DCmA Ip 15 mA DCmA input 15 actual value

13534 DCmA Ip 16 mA DCmA input 16 actual value

13536 DCmA Ip 17 mA DCmA input 17 actual value

13538 DCmA Ip 18 mA DCmA input 18 actual value

13540 DCmA Ip 19 mA DCmA input 19 actual value

13542 DCmA Ip 20 mA DCmA input 20 actual value

13544 DCmA Ip 21 mA DCmA input 21 actual value

13546 DCmA Ip 22 mA DCmA input 22 actual value

13548 DCmA Ip 23 mA DCmA input 23 actual value

13550 DCmA Ip 24 mA DCmA input 24 actual value

13552 RTD Ip 1 --- RTD input 1 actual value

13553 RTD Ip 2 --- RTD input 2 actual value

13554 RTD Ip 3 --- RTD input 3 actual value

13555 RTD Ip 4 --- RTD input 4 actual value

13556 RTD Ip 5 --- RTD input 5 actual value

13557 RTD Ip 6 --- RTD input 6 actual value

13558 RTD Ip 7 --- RTD input 7 actual value

13559 RTD Ip 8 --- RTD input 8 actual value

13560 RTD Ip 9 --- RTD input 9 actual value

13561 RTD Ip 10 --- RTD input 10 actual value

13562 RTD Ip 11 --- RTD input 11 actual value

13563 RTD Ip 12 --- RTD input 12 actual value

13564 RTD Ip 13 --- RTD input 13 actual value

13565 RTD Ip 14 --- RTD input 14 actual value

13566 RTD Ip 15 --- RTD input 15 actual value

13567 RTD Ip 16 --- RTD input 16 actual value

13568 RTD Ip 17 --- RTD input 17 actual value

13569 RTD Ip 18 --- RTD input 18 actual value

13570 RTD Ip 19 --- RTD input 19 actual value

13571 RTD Ip 20 --- RTD input 20 actual value
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A13572 RTD Ip 21 --- RTD input 21 actual value

13573 RTD Ip 22 --- RTD input 22 actual value

13574 RTD Ip 23 --- RTD input 23 actual value

13575 RTD Ip 24 --- RTD input 24 actual value

13576 RTD Ip 25 --- RTD input 25 actual value

13577 RTD Ip 26 --- RTD input 26 actual value

13578 RTD Ip 27 --- RTD input 27 actual value

13579 RTD Ip 28 --- RTD input 28 actual value

13580 RTD Ip 29 --- RTD input 29 actual value

13581 RTD Ip 30 --- RTD input 30 actual value

13582 RTD Ip 31 --- RTD input 31 actual value

13583 RTD Ip 32 --- RTD input 32 actual value

13584 RTD Ip 33 --- RTD input 33 actual value

13585 RTD Ip 34 --- RTD input 34 actual value

13586 RTD Ip 35 --- RTD input 35 actual value

13587 RTD Ip 36 --- RTD input 36 actual value

13588 RTD Ip 37 --- RTD input 37 actual value

13589 RTD Ip 38 --- RTD input 38 actual value

13590 RTD Ip 39 --- RTD input 39 actual value

13591 RTD Ip 40 --- RTD input 40 actual value

13592 RTD Ip 41 --- RTD input 41 actual value

13593 RTD Ip 42 --- RTD input 42 actual value

13594 RTD Ip 43 --- RTD input 43 actual value

13595 RTD Ip 44 --- RTD input 44 actual value

13596 RTD Ip 45 --- RTD input 45 actual value

13597 RTD Ip 46 --- RTD input 46 actual value

13598 RTD Ip 47 --- RTD input 47 actual value

13599 RTD Ip 48 --- RTD input 48 actual value

13600 Ohm Inputs 1 Value Ohms Ohm inputs 1 value

13601 Ohm Inputs 2 Value Ohms Ohm inputs 2 value

14189 PTP–IRIG-B Delta ns PTP time minus IRIG-B time

24432 Communications Group --- Groups communications group

24447 Active Setting Group --- Current setting group

32768 Tracking Frequency Hz Terminal tracking frequency

39168 FlexElement 1 Value --- FlexElement 1 actual value

39170 FlexElement 2 Value --- FlexElement 2 actual value

39172 FlexElement 3 Value --- FlexElement 3 actual value

39174 FlexElement 4 Value --- FlexElement 4 actual value

39176 FlexElement 5 Value --- FlexElement 5 actual value

39178 FlexElement 6 Value --- FlexElement 6 actual value

39180 FlexElement 7 Value --- FlexElement 7 actual value

39182 FlexElement 8 Value --- FlexElement 8 actual value

41138 V0 3rd Harmonic 1 Volts VTFF 1 V0 3rd Harmonic

41140 V0 3rd Harmonic 2 Volts VTFF 2 V0 3rd Harmonic

41142 V0 3rd Harmonic 3 Volts VTFF 3 V0 3rd Harmonic

45584 RxGOOSE Analog 1 --- RxGOOSE analog input 1

45586 RxGOOSE Analog 2 --- RxGOOSE analog input 2
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A
45588 RxGOOSE Analog 3 --- RxGOOSE analog input 3

45590 RxGOOSE Analog 4 --- RxGOOSE analog input 4

45592 RxGOOSE Analog 5 --- RxGOOSE analog input 5

45594 RxGOOSE Analog 6 --- RxGOOSE analog input 6

45596 RxGOOSE Analog 7 --- RxGOOSE analog input 7

45598 RxGOOSE Analog 8 --- RxGOOSE analog input 8

45600 RxGOOSE Analog 9 --- RxGOOSE analog input 9

45602 RxGOOSE Analog 10 --- RxGOOSE analog input 10

45604 RxGOOSE Analog 11 --- RxGOOSE analog input 11

45606 RxGOOSE Analog 12 --- RxGOOSE analog input 12

45608 RxGOOSE Analog 13 --- RxGOOSE analog input 13

45610 RxGOOSE Analog 14 --- RxGOOSE analog input 14

45612 RxGOOSE Analog 15 --- RxGOOSE analog input 15

45614 RxGOOSE Analog 16 --- RxGOOSE analog input 16

45616 RxGOOSE Analog 17 --- RxGOOSE analog input 17

45618 RxGOOSE Analog 18 --- RxGOOSE analog input 18

45620 RxGOOSE Analog 19 --- RxGOOSE analog input 19

45622 RxGOOSE Analog 20 --- RxGOOSE analog input 20

45624 RxGOOSE Analog 21 --- RxGOOSE analog input 21

45626 RxGOOSE Analog 22 --- RxGOOSE analog input 22

45628 RxGOOSE Analog 23 --- RxGOOSE analog input 23

45630 RxGOOSE Analog 24 --- RxGOOSE analog input 24

45632 RxGOOSE Analog 25 --- RxGOOSE analog input 25

45634 RxGOOSE Analog 26 --- RxGOOSE analog input 26

45636 RxGOOSE Analog 27 --- RxGOOSE analog input 27

45638 RxGOOSE Analog 28 --- RxGOOSE analog input 28

45640 RxGOOSE Analog 29 --- RxGOOSE analog input 29

45642 RxGOOSE Analog 30 --- RxGOOSE analog input 30

45644 RxGOOSE Analog 31 --- RxGOOSE analog input 31

45646 RxGOOSE Analog 32 --- RxGOOSE analog input 32

61439 PMU Num Triggers --- Phasor measurement unit recording number of triggers

63236 HZ Ia RMS Volts HIZ Ia RMS current

63238 HZ Ib RMS Volts HIZ Ib RMS current

63240 HZ Ic RMS Volts HIZ Ic RMS current

63242 HZ In RMS Volts HIZ In RMS current

63244 HZ Ia Odd Harmonics Volts HIZ Ia odd harmonics

63246 HZ Ib Odd Harmonics Volts HIZ Ib odd harmonics

63248 HZ Ic Odd Harmonics Volts HIZ Ic odd harmonics

63250 HZ Ig Odd Harmonics Volts HIZ Ig odd harmonics

63252 HZ Ia Even Harmonics Volts HIZ Ia even harmonics

63254 HZ Ib Even Harmonics Volts HIZ Ib even harmonics

63256 HZ Ic Even Harmonics Volts HIZ Ic even harmonics

63258 HZ Ig Even Harmonics Volts HIZ Ig even harmonics

63260 HZ Ia Non Harmonics Volts HIZ Ia non harmonics

63262 HZ Ib Non Harmonics Volts HIZ Ib non harmonics

63264 HZ Ic Non Harmonics Volts HIZ Ic non harmonics

63266 HZ Ig Non Harmonics Volts HIZ Ig non harmonics

Address FlexAnalog name Units Description



APPENDIX A: FLEXANALOG OPERANDS FLEXANALOG ITEMS

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL A-25

A63268 HZ Ig Harmonics[1] Volts HIZ Ig harmonics 1

63269 HZ Ig Harmonics[2] Volts HIZ Ig harmonics 2

63270 HZ Ig Harmonics[3] Volts HIZ Ig harmonics 3

63271 HZ Ig Harmonics[4] Volts HIZ Ig harmonics 4

63272 HZ Ig Harmonics[5] Volts HIZ Ig harmonics 5

63273 HZ Ig Harmonics[6] Volts HIZ Ig harmonics 6

63274 HZ Ig Harmonics[7] Volts HIZ Ig harmonics 7

63275 HZ Ig Harmonics[8] Volts HIZ Ig harmonics 8

63276 HZ Ig Harmonics[9] Volts HIZ Ig harmonics 9

63277 HZ Ig Harmonics[10] Volts HIZ Ig harmonics 10

63278 HZ Ig Harmonics[11] Volts HIZ Ig harmonics 11

63279 HZ Ig Harmonics[12] Volts HIZ Ig harmonics 12

63280 HZ Ig Harmonics[13] Volts HIZ Ig harmonics 13

63281 HZ Ig Harmonics[14] Volts HIZ Ig harmonics 14

63282 HZ Ig Harmonics[15] Volts HIZ Ig harmonics 15

63283 HZ Ig Harmonics[16] Volts HIZ Ig harmonics 16

63284 HZ Ig Harmonics[17] Volts HIZ Ig harmonics 17

63285 HZ Ig Harmonics[18] Volts HIZ Ig harmonics 18

63286 HZ Ig Harmonics[19] Volts HIZ Ig harmonics 19

63287 HZ Ig Harmonics[20] Volts HIZ Ig harmonics 20

63288 HZ Ig Harmonics[21] Volts HIZ Ig harmonics 21

63289 HZ Ig Harmonics[22] Volts HIZ Ig harmonics 22

63290 HZ Ig Harmonics[23] Volts HIZ Ig harmonics 23

63291 HZ Ig Harmonics[24] Volts HIZ Ig harmonics 24

63292 HZ Ig Harmonics[25] Volts HIZ Ig harmonics 25

63293 HZ Ig Harmonics[26] Volts HIZ Ig harmonics 26

63294 HZ Ig Harmonics[27] Volts HIZ Ig harmonics 27

63295 HZ Ig Harmonics[28] Volts HIZ Ig harmonics 28

63296 HZ Ig Harmonics[29] Volts HIZ Ig harmonics 29

63297 HZ Ig Harmonics[30] Volts HIZ Ig harmonics 30

63298 HZ Ig Harmonics[31] Volts HIZ Ig harmonics 31

63299 HZ Ig Harmonics[32] Volts HIZ Ig harmonics 32

63300 HZ Ig Harmonics[33] Volts HIZ Ig harmonics 33

63301 HZ Ig Harmonics[34] Volts HIZ Ig harmonics 34

63302 HZ Ig Harmonics[35] Volts HIZ Ig harmonics 35

63303 HZ Ig Harmonics[36] Volts HIZ Ig harmonics 36

63304 HZ Ig Harmonics[37] Volts HIZ Ig harmonics 37

63305 HZ Ig Harmonics[38] Volts HIZ Ig harmonics 38

63306 HZ Ig Harmonics[39] Volts HIZ Ig harmonics 39

63307 HZ Ig Harmonics[40] Volts HIZ Ig harmonics 40

63308 HZ Ig Harmonics[41] Volts HIZ Ig harmonics 41

63309 HZ Ig Harmonics[42] Volts HIZ Ig harmonics 42

63310 HZ Ig Harmonics[43] Volts HIZ Ig harmonics 43

63311 HZ Ig Harmonics[44] Volts HIZ Ig harmonics 44

63312 HZ Ig Harmonics[45] Volts HIZ Ig harmonics 45

63313 HZ Ig Harmonics[46] Volts HIZ Ig harmonics 46

63314 HZ Ig Harmonics[47] Volts HIZ Ig harmonics 47

Address FlexAnalog name Units Description
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63315 HZ Ig Harmonics[48] Volts HIZ Ig harmonics 48

63316 HZ Ig Harmonics[49] Volts HIZ Ig harmonics 49

63317 HZ Ig Harmonics[50] Volts HIZ Ig harmonics 50

63318 HZ Ig Harmonics[51] Volts HIZ Ig harmonics 51

63319 HZ Ig Harmonics[52] Volts HIZ Ig harmonics 52

63320 HZ Ig Harmonics[53] Volts HIZ Ig harmonics 53

63321 HZ Ig Harmonics[54] Volts HIZ Ig harmonics 54

63322 HZ Ig Harmonics[55] Volts HIZ Ig harmonics 55

63323 HZ Ig Harmonics[56] Volts HIZ Ig harmonics 56

63324 HZ Ig Harmonics[57] Volts HIZ Ig harmonics 57

63325 HZ Ig Harmonics[58] Volts HIZ Ig harmonics 58

63326 HZ Ig Harmonics[59] Volts HIZ Ig harmonics 59

63327 HZ Ig Harmonics[60] Volts HIZ Ig harmonics 60

63328 HZ Ig Harmonics[61] Volts HIZ Ig harmonics 61

63329 HZ Ig Harmonics[62] Volts HIZ Ig harmonics 62

63330 HZ Ig Harmonics[63] Volts HIZ Ig harmonics 63

63331 HZ Ig Harmonics[64] Volts HIZ Ig harmonics 64

Address FlexAnalog name Units Description
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RADIUS server configuration

This appendix outlines how to set up a RADIUS server for user authentication.

B.1  RADIUS server configuration
The following procedure is an example of how to set up a simple RADIUS server. You install the RADIUS server software on 
a separate computer. In this example, we use FreeRADIUS third-party software.

1. Download and install FreeRADIUS from www.freeradius.net as the RADIUS server. This is a Windows 32-bit installation 
that is known to work. If you try another third-party tool and it does not work, use the FreeRADIUS software from 
freeradius.net.

2. Open the radiusd.conf file in the <Path_to_Radius>\etc\raddb folder, locate the "bind_address" field, and enter your 
RADIUS server IP address. An example is

bind_address = 10.14.61.122

Text editor software that supports direct editing and saving of UNIX text encodings and line breaks, such as EditPad 
Lite, is needed for this editing.

3. In the users.conf file in the <Path_to_Radius>\etc\raddb folder, add the following text to configure a user "Tester" with 
an Administrator role.

Tester               User-Password == "TesterPw1#"
                     GE-UR-Role = Administrator

4. In the clients.conf file in the <Path_to_Radius>\etc\raddb folder, add the following text to define the UR as a RADIUS 
client, where in this example the client IP address is 10.14.61.132, the shared secret specified here is also configured 
on the UR device for successful authentication, and the shortname is a short, optional alias that can be used in place 
of the IP address.

client 10.14.61.132 {
secret = Testing!123

shortname = ur1-test

}

Alternatively, you may specify one secret for a network of clients, where in the example below the clients are all within 
the 10.14.61.0/24 subnet and the shared secret specified here is also configured on all the UR devices in the subnet for 
successful authentication.

client 10.14.61.0/24 {

secret = Testing!123

shortname = net1-test
}

http://freeradius.net
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5. In the <Path_to_Radius>\etc\raddb folder, create a file called dictionary.ge and add the following content.
# ##########################################################

#  GE VSAs

############################################################

VENDOR                          GE               2910

# Management authorization

BEGIN-VENDOR                    GE

# Role ID

ATTRIBUTE                       GE-UR-Role        1             integer

# GE-UR-ROLE values

VALUE GE-UR-Role                Administrator     1

VALUE GE-UR-Role                Supervisor        2
VALUE GE-UR-Role                Engineer          3

VALUE GE-UR-Role                Operator          4

VALUE GE-UR-Role                Observer          5

END-VENDOR                      GE

#############################################################

6. In the dictionary file in the <Path_to_Radius>\etc\raddb folder, add the following line.
$INCLUDE dictionary.ge

For example, the file can look like the following:
$INCLUDE ../share/freeradius/dictionary
$INCLUDE dictionary.ge

7. For the first start, run the RADIUS server in debug mode to ensure that there are no compiling errors.
<Path_to_Radius>/start_radiusd_debug.bat

8. Set up the RADIUS parameters on the UR as follows.

8.1. If logging in, select Device for the Authentication Type, and use Administrator for the User Name. The default 
password is "ChangeMe1#".

8.2. Access Settings > Product Setup > Security. Configure the IP address (10.14.61.122 in this example) and ports 
(default values in this example) for the RADIUS server. Leave the GE vendor ID field at the default of 2910. 
Update the RADIUS shared secret (Testing!123 in this example) as specified in the clients.conf file. Restart the 
relay for the IP address and port changes to take effect.

9. Verify operation. Log in to the UR software as follows. In the login window, select Server as the Authentication Type, 
enter the user name entered (for example user name Tester and password "TesterPw1#"). Check that the RADIUS 
server log file shows the access with an "Access-Accept" entry.

Recall that if you tried another third-party tool and it did not work, you can use the FreeRADIUS software from 
freeradius.net.
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Command line interface

This appendix outlines command line access to the software.

C.1  Command line interface
SetupCLI is a command line interface to communicate with the EnerVista UR Setup software. Commands can be sent from 
a DOS prompt or a Windows batch file.

The interface is installed with the EnerVista software. Its default location is similar to
C:\Program Files\EnerVista\Tools\SetupCLI

The EnerVista software needs to be installed on a computer to run the command line interface. The command line 
interface does not provide a remote connection to a computer running the EnerVista software.

Items to note are as follows:

• Works with EnerVista UR Setup version 6.10 and later

• Available in English only

• The graphical user interface of the software is not available concurrently with the command line interface

• It does not support concurrent commands

• It has limited functionality with CyberSentry

• It does not interface with UR Engineer

• It does not work when EnerVista UR Setup security is enabled, meaning when login is required

Command syntax is as follows:

• Options enclosed in [ ] are optional

• Values enclosed in < > are replaced with your own values

• <Application> is replaced with the EnerVista software to receive the command. Use "URPC" for EnerVista UR Setup.

• <device> is the UR device name, as displayed in the Device Name field of the Device Setup window and listed in the 
Online Window. Use quotes with spaces, such as "B30 Belfort".

• "-s" can be used with any command to suppress error messages

• All commands, their return codes, and error description are logged in the file 
C:\ProgramData\EnerVista\Tools\SetupCLI\SetupCLI.log

• When the Supervisor account is enabled, the 'Lock Relay' setting must first be changed to No before the putsettings, 
inservice, or reboot command can be used. This setting cannot be changed using the command line interface.

• Use quotes ("") to enclose any parameter containing a space
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• Commands, options, and parameters are case sensitive

• All commands have a return code of 0-255. 0 indicates success and 1-255 indicate different errors

• If SetupCLI is automated (in a batch file), make sure that only a single batch is running at a time. SetupCLI does not 
support concurrent operations.

To run the command line interface:

1. In Windows, click the Start button, enter cmd, and press the Enter key. After prompting for permission, the Windows 
command window opens.

2. Enter SetupCLI followed by the action to execute. An example of use is to enter "SetupCLI -h" to display help, 
specifically the commands and explanations outlined here.

Figure C-1: Command line interface run in the command window

SetupCLI -h

Display help.

It displays the content outline here.

SetupCLI <Application> start [-c] [-s]

Launch application with name <Application>.

To start in client mode, which is the graphical user interface, include option '-c'. Before use, the software must be idle 
without any windows open. Any activity or open windows can cause unexpected behavior. When in client mode, do not 
use Launchpad's Site Management feature.

To suppress errors, include option -s.

Example: SetupCLI URPC start -c

SetupCLI <Application> exit [-s]

Exit application with name <Application>.

Example: SetupCLI URPC exit

SetupCLI <Application> login -d <device> [-A <authentication type>] [-a <account>] -w <password> [-s]

Authenticate with device <device> using password <password>.

For non-CyberSentry devices — Set <authentication type> to "traditional". Note that <authentication type> defaults to 
"traditional" if not specified. Set <account> to "COMMANDS" or "SETTINGS". If not specified, the SETTINGS account is 
used.

Example: SetupCLI URPC login -d "C30 Melbourne" -A traditional -a SETTINGS -w 1password1
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Example of a batch file that checks for an error (this batch file uses standard batch file operations to check the return 
code (ERRORLEVEL) and jump to an error handler):

SetupCLI URPC start
SetupCLI URPC login -d demoDevice -a SETTINGS -w WrongPassword -A traditional
IF NOT ERRORLEVEL 0 GOTO FAILED
SetupCLI URPC putsettings -d demoDevice  -f "example file.urs"
SetupCLI URPC inservice -d demoDevice 
SetupCLI URPC reboot -d demoDevice
SetupCLI URPC exit
exit

:FAILED
echo Please try again
exit

For CyberSentry devices with local authentication — Set <authentication type> to "local". Set <account> to 
"Supervisor", "Administrator", "Engineer", "Operator", or "Observer".

For CyberSentry devices with RADIUS authentication — Set <authentication type> to "radius". Set <account> to the 
user's account on the RADIUS server.

SetupCLI <Application> logout -d <device> [-s] 

Log out of device <device>.

Example: SetupCLI URPC logout -d C30

SetupCLI <Application> getsettings -d <device> -f <File> [-s]

Read settings from device <device> and save them to the .urs file <File>. The <File> must not already exist. The default 
path to the output file is C:\Users\Public\Public Documents\GE Power Management\URPC\Data

Example: SetupCLI URPC getsettings -d C30 -f "C30 Markham.urs"

Example of a batch file to retrieve a settings file:

SetupCLI URPC start
SetupCLI URPC getsettings -d demoDevice -f C:\example.urs 
SetupCLI URPC exit

Example of a batch file to retrieve a settings file from a relay that requires RADIUS authentication:

SetupCLI URPC start
SetupCLI URPC login -d demoDevice -a %1 -w %2 -A radius
SetupCLI URPC getsettings -d demoDevice -f "example file.urs"
SetupCLI URPC logout -d demoDevice
SetupCLI URPC exit

Although a user name and password could have been entered in this batch file, it would have created a security risk. 
Batch files allow you to pass in runtime parameters and refer to them in your script as %1, %2, and so on. For example, 
if this file is called example.bat, one calls it as follows:  "example.bat MyUserName MyPassword" 

SetupCLI <Application> putsettings -d <device> -f <File> [-s]

Write the settings file <File> to the device <device>.

For CyberSentry devices, putsettings is only supported for users with the "Administrator" role.

Example: SetupCLI URPC putsettings -d C30 -f "C30 Markham.urs"
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SetupCLI <Application> compare -f <File1> -r <File2> -o <OutputFile> [-s]

Compare settings files <File1> and <File2>, and save output to <OutputFile>.

Example: SetupCLI URPC compare -f may.urs -r september.urs -o compared.txt

Batch file example that retrieves a settings file, compares it with an existing settings file, and opens the resulting 
comparison file:

SetupCLI URPC start
SetupCLI URPC getsettings -d demoDevice  -f devicefile.urs
SetupCLI URPC compare -f existingfile.urs -r devicefile.urs -o output.txt

The output is similar to the following:
Comparing settings file aaa.urs : C:\Users\Public\Public Documents\GE Power Management\URPC\Data\ with bbb.urs 
: C:\Users\Public\Public Documents\GE Power Management\URPC\Data\

  #      Setting Name                    (Group,Module,Item)   Value

    1 + Default Message Timeout                (1,1,1) = 299 s
    2 - Default Message Timeout                 (1,1,1) = 300 s
    3 + Flash Message Time                          (1,1,1) = 0.9 s
    4 - Flash Message Time                           (1,1,1) = 1.0 s

SetupCLI <Application> inservice -d <device> [-n] [-s]

Put the device in service. Include option -n to take the device out of service.

Example: SetupCLI URPC inservice -d C30

SetupCLI <Application> reboot -d <device> [-s]

Reboot the relay <device>. This is necessary after changing IEC 61850 settings and aggregator source settings.

Example: SetupCLI URPC reboot -d "C30_Instanbul"

SetupCLI <Application> adddevice -I <IP Address> -S <Slave Address> -P <Modbus Port>

Connect to a device using its IP address, slave address, and Modbus port. Show the device in the EnerVista interface 
under the SetupCLI Site as DEV@SETUP_CLI.

EnerVista UR Setup 7.30 or higher supports this command.

Figure C-2: Device added using IP address

The device is named as DEV@SETUP_CLI, which is used as the device name required by the <device> parameter of other 
SetupCLI commands.
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The device name DEV@SETUP_CLI is always assigned to the device that is connected most recently by performing 
'adddevice' command. It means that the Application only keeps up to one device named as DEV@SETUP_CLI, the 
'adddevice' command disconnects/deletes the device DEV@SETUP _CLI that was connected previously by performing 
'adddevice' command.

The device name DEV@SETUP_CLI is never used to configure/connect to a device through the graphical user interface.

Example of a batch file using a device IP address to retrieve its settings file:

 SetupCLI URPC start
 SetupCLI URPC adddevice -I 192.168.140.113 -S 113 -P 502
 SetupCLI URPC getsettings -d DEV@SETUP_CLI -f C:\example.urs
 SetupCLI URPC exit

After connecting the device using IP address, the device name DEV@SETUP_CLI is used to identify this device in 
'getsettings' command.

Example of a batch file using a device IP address to retrieve a settings file when RADIUS authentication is required:

SetupCLI URPC start
SetupCLI URPC adddevice -I 192.168.140.113 -S 113 -P 502 
SetupCLI URPC login -d DEV@SETUP_CLI -a %1 -w %2 -A radius
SetupCLI URPC getsettings -d DEV@SETUP_CLI -f "example file.urs"
SetupCLI URPC logout -d DEV@SETUP_CLI
SetupCLI URPC exit

DEV@SETUP_CLI has to be used as the device name in the commands followed by the 'adddevice' command.



C-6 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

COMMAND LINE INTERFACE APPENDIX C: COMMAND LINE INTERFACE

C



F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL D-1

F60 Feeder Protection System

Appendix D: Miscellaneous

Miscellaneous

This chapter provides the warranty and revision history.

D.1  Warranty
For products shipped as of 1 October 2013, GE Grid Solutions warrants most of its GE manufactured products for 10 years. 
For warranty details including any limitations and disclaimers, see the Terms and Conditions at 

http://www.gegridsolutions.com/multilin/warranty.htm

For products shipped before 1 October 2013, the standard 24-month warranty applies.

D.2  Revision history
The tables outline the releases and revision history of this document.

Table D-1: Revision history (English)

Manual P/N F60 revision Release date ECO

1601-0093-A1 1.5x 23 March 1999 N/A

1601-0093-A2 1.6x 10 August 1999 URF-012

1601-0093-A3 1.8x 29 October 1999 URF-014

1601-0093-A4 1.8x 15 November 1999 URF-015

1601-0093-A5 2.0x 17 December 1999 URF-016

1601-0093-A6 2.2x 12 May 2000 URF-017

1601-0093-A7 2.2x 14 June 2000 URF-020

1601-0093-A7a 2.2x 28 June 2000 URF-020a

1601-0093-B1 2.4x 08 September 2000 URF-022

1601-0093-B2 2.4x 03 November 2000 URF-024

1601-0093-B3 2.6x 09 March 2001 URF-025

1601-0093-B4 2.8x 28 September 2001 URF-027

1601-0093-B5 2.9x 03 December 2001 URF-030

1601-0093-B6 2.6x 27 February 2004 URX-120

1601-0093-C1 3.0x 02 July 2002 URF-032

http://www.gegridsolutions.com/multilin/warranty.htm


D-2 F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

REVISION HISTORY APPENDIX D: MISCELLANEOUS

D

1601-0093-C2 3.1x 30 August 2002 URF-034

1601-0093-C3 3.0x 18 November 2002 URF-036

1601-0093-C4 3.1x 18 November 2002 URF-038

1601-0093-C5 3.0x 11 February 2003 URF-040

1601-0093-C6 3.1x 11 February 2003 URF-042

1601-0093-D1 3.2x 11 February 2003 URF-044

1601-0093-D2 3.2x 02 June 2003 URX-084

1601-0093-E1 3.3x 01 May 2003 URX-080

1601-0093-E2 3.3x 29 May 2003 URX-083

1601-0093-F1 3.4x 10 December 2003 URX-111

1601-0093-F2 3.4x 09 February 2004 URX-115

1601-0093-G1 4.0x 23 March 2004 URX-123

1601-0093-G2 4.0x 17 May 2004 URX-136

1601-0093-H1 4.2x 30 June 2004 URX-145

1601-0093-H2 4.2x 23 July 2004 URX-151

1601-0093-J1 4.4x 15 September 2004 URX-156

1601-0093-K1 4.6x 15 February 2005 URX-176

1601-0093-L1 4.8x 05 August 2005 URX-202

1601-0093-M1 4.9x 15 December 2005 URX-208

1601-0093-M2 4.9x 27 February 2006 URX-214

1601-0093-N1 5.0x 31 March 2006 URX-217

1601-0093-N2 5.0x 26 May 2006 URX-220

1601-0093-P1 5.2x 23 October 2006 URX-230

1601-0093-P2 5.2x 24 January 2007 URX-232

1601-0093-R1 5.4x 26 June 2007 URX-242

1601-0093-R2 5.4x 31 August 2007 URX-246

1601-0093-R3 5.4x 17 October 2007 URX-251

1601-0093-S1 5.5x 7 December 2007 URX-253

1601-0093-S2 5.5x 22 February 2008 URX-258

1601-0093-S3 5.5x 12 March 2008 URX-260

1601-0093-T1 5.6x 27 June 2008 08-0390

1601-0093-U1 5.7x 29 May 2009 09-0938

1601-0093-U2 5.7x 30 September 2009 09-1165

1601-0093-V1 5.8x 29 May 2010 09-1457

1601-0093-V2 5.8x 04 January 2011 11-2237

1601-0093-W1 5.9x 12 January 2011 11-2227

1601-0093-X1 6.0x 21 December 2011 11-2840

1601-0093-X2 6.0x 5 April 2012 12-3254

1601-0093-Y1 7.0x 30 September 2012 12-3529

1601-0093-Y2 7.0x 11 November 2012 12-3601

1601-0093-Z1 7.1x 30 March 2013 13-0126

1601-0093-AA1 7.2x 1 August 2013 13-0401

1601-0093-AB1 7.3x 7 November 2014 14-1408

1601-0093-AB2 7.3x 1 September 2015 15-2215

1601-0093-AC1 7.40x 8 December 2016 16-3319

1601-0093-AE1 7.41x 31 January 2017 17-3427

1601-0093-AE3 7.4x 28 April 2017 17-3561

Manual P/N F60 revision Release date ECO
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Table D-2: Major changes for F60 manual version AH1 (English)

Table D-3: Major changes for F60 manual version AG2 (English)

Table D-4: Major changes for F60 manual version AG1 (English)

1601-0093-AF1 7.6x 30 June 2017 17-3779

1601-0093-AF2 7.6x 31 October 2017 17-3935

1601-0093-AG1 7.7x 31 March 2018 18-4430

1601-0093-AG2 7.7x 4 May 2018 18-4517

1601-0093-AH1 7.8x 17 December 2018 18-4703

Page Description

--- General revision

2-11 Added order codes 85, 86, 87 for Process Bus Modules that support IEC 61850-9-2LE and IEC 61869. Added to the two process 
bus order code tables for all products except B90, C30, L60, and to the Replacement Modules tables.

3- Updated CPU module on Typical Wiring diagram, CPU Module Communications Wiring diagram, and Options for IRIG-B 
Connection diagram

5-203 Added Process Bus Module operands to the FlexLogic operands table and Process Bus PTP Failure, Clock Mismatch, and PB 
Clock Unsynchronized operands under Self-Diagnostics of same

5-278 Updated Settings > Control Elements > Setting Groups section, including addition of Control Mode setting

5-364 Added Process Bus Module settings section for the non-HardFiber Process Bus Modules

6-35 Added Process Bus Module actual values section for the non-HardFiber Process Bus Modules

7-2 Added Clear SV Diagnostics command to the Commands > Clear Records table

B- Updated RADIUS chapter

Page Description

--- General revision. Improved figure quality by using conditional text to switch between PDF and PNG figures.

Page Description

--- General revision

2-8 Updated order codes from SH / SL to RH / RL for the redundant power supply for horizontal units. The power supply modules 
were upgraded in 2014 to SH and SL, but the order codes when purchasing a UR remain as RH and RL so that customers do 
not need to change order codes. The order codes for the power supply replacement modules are correct as SH and SL.

3-15 Updated Figure 3-15 Typical Wiring Diagram with High-Impedance Detection, removing Power Supply Critical Failure 
connection to ground

3-60 Added IP and subnet mask address rules to the Set IP Address in UR section

5-58 Added IEC 61850 Editions 1 and 2 section

5-113 Added support for a redundant SNTP server as a time source

5-198 Added GOOSE simulation operands to FlexLogic operands table

5-360 Added Settings > Simulation > GOOSE section

6-4 Added Actual Values > Graphical Panel > LEDs and Pushbuttons information

6-13 Added Actual Values > Status > Protocol section

Manual P/N F60 revision Release date ECO
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Abbreviations

Abbreviations

A Ampere
AC Alternating Current
A/D Analog to Digital
AE Accidental Energization, Application Entity
AMP Ampere
ANG Angle
ANSI American National Standards Institute
APDU Application Protocol Data Unit
AR Automatic Reclosure
ARP Address Resolution Protocol
ASDU Application-layer Service Data Unit
ASYM Asymmetry
AUTO Automatic
AUX Auxiliary
AVG Average
AWG American Wire Gauge

BCS Best Clock Selector
BER Bit Error Rate
BF Breaker Fail
BFI Breaker Failure Initiate
BKR Breaker
BLK Block
BLKG Blocking
BNC Bayonet Neill-Concelman
BPNT Breakpoint of a characteristic
BRKR Breaker

CA Certificate Authority
CAP Capacitor
CC Coupling Capacitor
CCVT Coupling Capacitor Voltage Transformer
CFG Configure / Configurable
.CFG Filename extension for oscillography files
CHK Check
CHNL Channel
CID Configured IED Description
CLS Close
CLSD Closed
CMND Command
CMPRSN Comparison
CO Contact Output
COM Communication
COMM Communications
COMP Compensated, Comparison
ConfRev Configuration Revision
CONN Connection

CONT Continuous, Contact
CO-ORD Coordination
CPU Central Processing Unit
CRC Cyclic Redundancy Code/Check
CRL Certificate Revocation List
CRT, CRNT Current
CSA Canadian Standards Association
CT Current Transformer
CVT Capacitive Voltage Transformer

D/A Digital to Analog
DANH Doubly Attached Node with HSR
DANP Doubly Attached Node with DANP
DC (dc) Direct Current
DCE Data Communications Equipment
DCS Distributed Control System
DD Disturbance Detector
DFLT Default
DGNST Diagnostics
DIFF Differential
DIR Directional
DISCREP Discrepancy
DIST Distance
DMD Demand
DNP Distributed Network Protocol
DPO Dropout
DPS Double-Point Status
DSP Digital Signal Processor
DST Daylight Savings Time
dt Rate of Change
DTT Direct Transfer Trip
DUTT Direct Under-reaching Transfer Trip

EGD Ethernet Global Data
ENCRMNT Encroachment
EPRI Electric Power Research Institute
.EVT Filename extension for event recorder files
EXT Extension, External

F Field
FAIL Failure
FD Fault Detector
FDH Fault Detector high-set
FDL Fault Detector low-set
FIR Finite Impulse Response
FLA Full Load Current
FO Fiber Optic
FPGA Field-programmable Gate Array

Glossary



ii F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL

ABBREVIATIONS

FREQ Frequency
FSK Frequency-Shift Keying
FTP File Transfer Protocol
FxE FlexElement™
FWD Forward

G Generator
GCM Galois Counter Mode
GDOI Group Domain of Interpretation
GE General Electric
GFP Graphical Front Panel
GND Ground
GNTR Generator
GoCB GOOSE Control Block
GOOSE General Object Oriented Substation Event
GPS Global Positioning System
GSU Generator Step-Up

HARM Harmonic / Harmonics
HCT High Current Time
HGF High-Impedance Ground Fault (CT)
HIZ High-Impedance and Arcing Ground
HMI Human-Machine Interface
HSR High-availability Seamless Redundancy
HTTP Hyper Text Transfer Protocol
HV High Voltage
HYB Hybrid
Hz Hertz

I Instantaneous
I_0 Zero Sequence current
I_1 Positive Sequence current
I_2 Negative Sequence current
IA Phase A current
IAB Phase A minus B current
IB Phase B current
IBC Phase B minus C current
IC Phase C current
ICA Phase C minus A current
ICD IED Capability Description
ID Identification
IED Intelligent Electronic Device
IEC International Electrotechnical Commission
IEEE Institute of Electrical and Electronic Engineers
IG Ground (not residual) current
Igd Differential Ground current
IGMP Internet Group Management Protocol
IID Instantiated IED Capability Description
IN CT Residual Current (3Io) or Input
INC SEQ Incomplete Sequence
INIT Initiate
INST Instantaneous
INV Inverse
I/O Input/Output
IOC Instantaneous Overcurrent
IOV Instantaneous Overvoltage
IRC Inter-Relay Communication
IRIG Inter-Range Instrumentation Group
ISO International Standards Organization
IUV Instantaneous Undervoltage

K0 Zero Sequence Current Compensation
kA kiloAmpere
KDC Key Distribution Center
kV kiloVolt

LCD Liquid Crystal Display
LED Light Emitting Diode
LEO Line End Open
LFT BLD Left Blinder
LOOP Loopback
LPU Line Pickup

LRA Locked-Rotor Current
LTC Load Tap-Changer
LV Low Voltage

M Machine
M2M Machine to Machine
mA MilliAmpere
MAG Magnitude
MAN Manual / Manually
MAX Maximum
Mb Megabit
MIC Model Implementation Conformance
MIN Minimum, Minutes
MMI Man Machine Interface
MMS Manufacturing Message Specification
MRT Minimum Response Time
MSG Message
MTA Maximum Torque Angle
MTR Motor
MU Merging Unit
MVA MegaVolt-Ampere (total 3-phase)
MVA_A MegaVolt-Ampere (phase A)
MVA_B MegaVolt-Ampere (phase B)
MVA_C MegaVolt-Ampere (phase C)
MVAR MegaVar (total 3-phase)
MVAR_A MegaVar (phase A)
MVAR_B MegaVar (phase B)
MVAR_C MegaVar (phase C)
MVARH MegaVar-Hour
MW MegaWatt (total 3-phase)
MW_A MegaWatt (phase A)
MW_B MegaWatt (phase B)
MW_C MegaWatt (phase C)
MWH MegaWatt-Hour

N Neutral
N/A, n/a Not Applicable
NEG Negative
NMPLT Nameplate
NOM Nominal
NTR Neutral

O Over
OC, O/C Overcurrent
OCSP Online Certificate Status Protocol
OF Overload Factor
O/P, Op Output
OP Operate
OPER Operate
OPERATG Operating
O/S Operating System
OSI Open Systems Interconnect
OSB Out-of-Step Blocking
OUT Output
OV Overvoltage
OVERFREQ Overfrequency
OVLD Overload

P Phase
PC Phase Comparison, Personal Computer
PCNT Percent
PF Power Factor (total 3-phase)
PF_A Power Factor (phase A)
PF_B Power Factor (phase B)
PF_C Power Factor (phase C)
PFLL Phase and Frequency Lock Loop
PHS Phase
PICS Protocol Implementation & Conformance 

Statement
PKI Public Key Infrastructure
PKP Pickup
PLC Power Line Carrier
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POS Positive
POTT Permissive Over-reaching Transfer Trip
PP Power Profile
PPP Point-to-Point
PPS Pulse per Second
PRESS Pressure
PRI Primary
PROT Protection
PRP Parallel Redundancy Protocol
PSEL Presentation Selector
PTP Precision Time Protocol
pu Per Unit
PUIB Pickup Current Block
PUIT Pickup Current Trip
PUSHBTN Pushbutton
PUTT Permissive Under-reaching Transfer Trip
PWM Pulse Width Modulated
PWR Power

QUAD Quadrilateral

R Rate, Reverse
RA Registration Authority
RCA Reach Characteristic Angle
RedBox Redundancy Box
REF Reference
REM Remote
REV Reverse
R-GOOSE Routable GOOSE
RI Reclose Initiate
RIP Reclose In Progress
RGT BLD Right Blinder
RMA Return Materials Authorization
RMS Root Mean Square
ROCOF Rate of Change of Frequency
ROD Remote Open Detector
RRTD Remote Resistance Temperature Detector
RST Reset
RSTR Restrained
RTD Resistance Temperature Detector
RTU Remote Terminal Unit
RX (Rx) Receive, Receiver

s second
S Sensitive
SAN Singly Attached Node
SAT CT Saturation
SBO Select Before Operate
SCADA Supervisory Control and Data Acquisition
SCC Serial Communication Controller
SCD System Configuration Description
SCL Substation Configuration Language
SCEP Simple Certificate Enrollment Protocol
SEC Secondary
SEL Select / Selector / Selection
SENS Sensitive
SEQ Sequence
SFTP Secure Shell (SSH) File Transfer Protocol, Secure 

File Transfer Protocol
SIR Source Impedance Ratio
SmpSynch Samples Synchronized
SNTP Simple Network Time Protocol
SRC Source
SSB Single Side Band
SSEL Session Selector
STATS Statistics
SUPN Supervision
SUPV Supervise / Supervision
SV Supervision, Service, Sampled Value
SYNC Synchrocheck
SYNCHCHK Synchrocheck

T Time, transformer
TC Thermal Capacity
TCP Transmission Control Protocol
TCU Thermal Capacity Used
TD MULT Time Dial Multiplier
TEMP Temperature
TFTP Trivial File Transfer Protocol
THD Total Harmonic Distortion
TMR Timer
TOC Time Overcurrent
TOV Time Overvoltage
TRANS Transient
TRANSF Transfer
TSEL Transport Selector
TUC Time Undercurrent
TUV Time Undervoltage
TX (Tx) Transmit, Transmitter

U Under
UC Undercurrent
UCA Utility Communications Architecture
UDP User Datagram Protocol
UL Underwriters Laboratories
UNBAL Unbalance
UR Universal Relay
URC Universal Recloser Control
.URS Filename extension for settings files
UV Undervoltage

V/Hz Volts per hertz
V_0 Zero Sequence voltage
V_1 Positive Sequence voltage
V_2 Negative Sequence voltage
VA Phase A voltage
VAB Phase A to B voltage
VAG Phase A to Ground voltage
VARH Var-hour voltage
VB Phase B voltage
VBA Phase B to A voltage
VBG Phase B to Ground voltage
VC Phase C voltage
VCA Phase C to A voltage
VCG Phase C to Ground voltage
VF Variable Frequency
VIBR Vibration
VT Voltage Transformer
VTFF Voltage Transformer Fuse Failure
VTLOS Voltage Transformer Loss Of Signal

WDG Winding
WH Watt-hour
w/ opt With Option
WGS World Geodetic System
WRT With Respect To

X Reactance
XDUCER Transducer
XFMR Transformer

Z Impedance, Zone
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Index

Symbols
 ........................................................................................................................5-71

Numerics
10BASE-F settings ...............................................................................5-45
4L Discrepancy message ................................................................7-10
7R module ................................................................................................3-44
7S module ................................................................................................3-43
87L blocked with Process Bus Module synchronization ....5-

198

A
AC Bank assigned is not configured ......................................5-210
AC current inputs

explained ..............................................................................................3-18
settings ...............................................................................................5-149
specifications ......................................................................................2-29

AC voltage input specifications ...................................................2-30
Accents ......................................................................................................4-56
Access Violation message ..............................................................3-71
Acknowledge alarm ............................................................................. 6-4
Activate relay .........................................................................................3-56
Active setting group ........................................................................5-236
Actual values ............................................................................................ 6-1

alarms for graphical front panel ................................................. 6-4
display on graphical front panel ...................................4-34, 4-35
monitor with Modbus Analyzer ..................................................10-1
not activated graphical front panel .........................................4-53

Add Device from File option
restore settings to online device ............................................10-11
save to Offline Window ..................................................................3-75

Add Device to Offline Window preferences .........................10-9
Add module, check settings not defaulted ........................10-24

Add relay .................................................................................................. 3-60
Administrator

add user account ............................................................................. 5-14
command to force logoff ................................................................7-6
no automatic logout from front panel ................................... 5-21
role for CyberSentry ...........................................................................2-4

Aggregator
actual values ...................................................................................... 6-27
error message ......................................................................................7-9
settings ...............................................................................................5-188

Alarm LEDs ............................................................................................5-127
Alarms

acknowledge .............................................................................4-33, 6-4
add .............................................................................................. 4-34, 5-36
messages ................................................................................................7-8
overview ............................................................................................... 4-31
reset ...............................................................................................4-33, 6-4

AND gate explained ........................................................................... 4-83
Annunciator editor ............................................................................. 4-34
ANSI device numbers ...........................................................................2-2
Apparent power

actual values ...................................................................................... 6-20
specifications ..................................................................................... 2-29

Application examples
breaker trip circuit integrity .......................................................5-324
contact inputs ..................................................................................5-363
direct inputs and outputs ...........................................................5-370
latching outputs ..............................................................................5-366
sensitive directional power .......................................................5-294

Apply settings to other device ..................................................... 10-7
Approvals ................................................................................................. 2-39
Arc Burst Pattern Analysis algorithm for Hi-Z .......................9-4
Architecture, relay ............................................................................5-210
Arcing current .....................................................................................5-333
Arcing Suspected algorithm for Hi-Z ..........................................9-4
Audit list of port numbers ............................................................... 5-45
Authentication by device or server ........................................... 5-16
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Automatic discovery of UR devices .......................................... 3-70
Autoreclose

actual values ......................................................................................... 6-8
FlexLogic operands .......................................................................5-213
logic diagram ...................................................................................5-319
settings ...............................................................................................5-316
single shot sequence ...................................................................5-321

Auxiliary overvoltage
FlexLogic operands .......................................................................5-213
logic ......................................................................................................5-293
settings ...............................................................................................5-292
specifications ..................................................................................... 2-23

Auxiliary undervoltage
FlexLogic operands .......................................................................5-213
logic diagram ...................................................................................5-292
settings ...............................................................................................5-291
specifications ..................................................................................... 2-22

Auxiliary voltage channel ............................................................... 3-18
Auxiliary voltage metering ............................................................ 6-20
AWG wire size ....................................................................................... 3-50

CT/VT ...................................................................................................... 3-18
F485 converter .................................................................................. 3-58
G.703 interface .................................................................................. 3-43
module 7S ........................................................................................... 3-43
modules 6X, 6W ................................................................................ 3-23
modules 7E, 7F, 7G, 7Q, 75 .......................................................... 3-50
modules 7L, 7M, 7N, 7P, 74 ......................................................... 3-49
modules 7T, 7W ................................................................................ 3-47
RS422 and fiber interface ............................................................ 3-49

B
Back up settings ...................................................................... 5-60, 10-8
Bad IRIG-B Signal message .......................................................... 7-10
Bad PTP Signal message ................................................................ 7-10
Banks ............................................................................................. 5-7, 5-149
Basic front panel

dimensions ............................................................................................. 3-2
FlexLogic ............................................................................................5-213
interface ............................................................................................... 4-15
IP rating ................................................................................................ 2-37
keypad .................................................................................................. 4-37
labels ...................................................................................................... 4-48
LEDs ..........................................................................................4-39, 5-127
navigation ........................................................................................... 4-50
order code over two lines ............................................................ 4-37
order codes ............................................................................................ 2-7
pushbuttons .....................................................................................5-131
specifications ..................................................................................... 2-26
use, change setting ......................................................................... 4-52

Battery
disposal ..............................................................................................10-26
monitor with annunciator alarm .............................................. 4-34
monitor with Engineer ................................................................... 4-75
monitor with FlexLogic ................................................................5-224
monitor with metering window ................................................. 4-35
monitor with self-test alarm .....................................................5-128
replace ................................................................................................10-25

Baud rate ................................................................................................. 5-42
Blinking alarm ....................................................................................... 4-33
Block setting ..............................................................................................5-5
Blocking scheme

FlexLogic operands ...................................................................... 5-215
Breaker arcing current

actual values ...................................................................................... 6-34
clearing ........................................................................................5-41, 7-2
FlexAnalogs .............................................................................A-11, A-20
FlexLogic operands ...................................................................... 5-214
logic diagram .................................................................................. 5-336
measurement ................................................................................. 5-335
settings ............................................................................................... 5-333
specifications ..................................................................................... 2-24

Breaker control
control of two breakers ................................................................. 4-58
dual breaker logic ......................................................................... 5-157
FlexLogic operands ...................................................................... 5-215
settings ............................................................................................... 5-154
with IEC 61850 ................................................................................... 5-92

Breaker failure
description ........................................................................................ 5-278
determination ................................................................................. 5-278
FlexLogic operands ...................................................................... 5-214
logic diagram ....................................................................5-282, 5-283
main path sequence .................................................................... 5-279
settings .................................................................................5-276, 5-280
specifications ..................................................................................... 2-24

Breaker flashover
FlexLogic operands ...................................................................... 5-214
logic diagram .................................................................................. 5-341
settings ............................................................................................... 5-337
specifications ..................................................................................... 2-24

Breaker restrike
FlexLogic operands ...................................................................... 5-214
logic diagram .................................................................................. 5-344
settings ............................................................................................... 5-342
specifications ..................................................................................... 2-24

Breaker-and-a-half scheme ............................................................5-6
Brick

interface module described ........................................................ 3-20
remote resources actual values ............................................... 6-28
remote resources settings ........................................................ 5-148
self-test errors ................................................................................... 7-13
Trouble message .............................................................................. 7-15

Brightness ................................................................................................ 5-26
Broken conductor

FlexLogic operands ...................................................................... 5-215
settings ............................................................................................... 5-353

C
C37.94 communications ..................................................... 3-51, 3-54
Cannot log in .............................................................................................2-4
Caution symbol in Offline Window ............................................ 4-69
CE certification ...................................................................................... 2-39
Certification ............................................................................................ 2-39
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Changes ......................................................................................................D-1
Channel

banks ...................................................................................................5-149
tests .........................................................................................................6-11

Check Settings message ................................................................... 7-9
Chinese limited to 10 character input .....................................5-27
CID file, SCD file .............................................................5-77, 5-79, 5-80
CID files

create .....................................................................................................5-60
explained ..............................................................................................3-75
import ......................................................................................3-75, 10-12
import preferences ..........................................................................10-9
view .........................................................................................................5-60

Circuit monitoring applications ................................................5-323
Cleaning ....................................................................................................2-39
Clear

files and records .............................................................................10-29
LEDs .....................................................................................................5-368
relay records using IEC 61850 ....................................................5-97
relay records using settings ........................................................5-40
security logs .......................................................................................... 7-6

Clock
actual values ......................................................................................... 6-9
graphical front panel format .......................................................5-30
IRIG-B ......................................................................................................3-39
PTP ........................................................................................................5-113
set .............................................................................................................. 7-3
settings ...............................................................................................5-112
synchronize several devices .....................................................5-113

Close
HTTP port ...........................................................................................5-102
IEC 60870-5-104 port ..................................................................5-104
Modbus port ........................................................................................5-51
TFTP port ............................................................................................5-103
Web access port ............................................................................5-102

Cold load pickup
explained ...........................................................................................5-355
FlexLogic operands .......................................................................5-215
logic diagram ...................................................................................5-356
settings ...............................................................................................5-355

COMM Path Incomplete message .................................7-10, 7-12
Comm status remaining connections .....................................6-12
Command line interface to software .........................................C-1
Command password .............................................................4-59, 5-10
Commands

control user accounts .....................................................................5-14
menu ......................................................................................................... 7-1
with IEC 61850 ...................................................................................5-97

Commissioning ....................................................................................... 8-1

Communications
10BASE-F .............................................................................................. 5-45
connecting to the UR .......................................................... 3-68, 3-71
DNP ......................................................................................................... 5-53
EGD .......................................................................................................5-105
HTTP .....................................................................................................5-102
IEC 60870-5-10 ...............................................................................5-106
IEC 60870-5-104 .............................................................................5-103
inter-relay specifications .............................................................. 2-35
Modbus registers ............................................................................5-111
Modbus settings ............................................................................... 5-51
modem .................................................................................................. 3-69
Protocol selection ............................................................................ 5-52
RS232 ......................................................................................... 3-35, 5-42
RS485 ......................................................................................... 3-37, 5-42
settings ..................................................................................... 5-45, 5-53
specifications ......................................................................... 2-34, 2-35
timeout .................................................................................................. 5-52
web server .........................................................................................5-102

Compare settings ................................................................................ 10-7
Compliance ............................................................................................. 2-39
COMTRADE files, view ....................................................................... 4-80
Conducted RFI specifications ....................................................... 2-38
Connect, unable to ................................................................. 3-71, 5-46
Connection timeout ........................................................................... 5-52
Connectors, LC and ST ..................................................................... 3-13
Contact inputs

actual values .........................................................................................6-5
explained ............................................................................................5-362
FlexLogic operands .......................................................................5-221
settings ...............................................................................................5-361
specifications ..................................................................................... 2-30
thresholds ..........................................................................................5-361
wet and dry connections .............................................................. 3-28

Contact outputs
actual values .........................................................................................6-6
explained ............................................................................................5-364
FlexLogic operands .......................................................................5-221
settings ...............................................................................................5-364

Control elements ...............................................................................5-296
Control power

description ........................................................................................... 3-16
specifications ..................................................................................... 2-33

Control pushbuttons
FlexLogic operands .......................................................................5-213
logic diagram ...................................................................................5-131
settings ...............................................................................................5-129
specifications ..................................................................................... 2-27

Convert device settings ................................................................... 10-5
Copy of Copy of .................................................................................... 10-7
Copy settings for upgrading ......................................................... 10-5
Copy settings to other device ...................................................... 10-7
Counters

actual values .........................................................................................6-8
settings ...............................................................................................5-325

CPU module diagram ....................................................................... 3-12
CPU, new types T, U, V ....................................................................10-15
CRC alarm ..............................................................................................5-145
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Critical failure relay specifications ............................................ 2-32
CSA certification .................................................................................. 2-39
CT bank settings ................................................................................5-149
CT failure

FlexLogic operands .......................................................................5-215
logic diagram ...................................................................................5-346
settings ...............................................................................................5-344

CT inputs .......................................................................... 3-17, 5-7, 5-149
CT wiring .................................................................................................. 3-18
Current bank ........................................................................................5-149
Current demand ................................................................................5-123
Current harmonics specifications ............................................. 2-29
Current metering actual values ................................................. 6-18
Curves

definite time ...................................................................... 5-244, 5-286
FlexCurves .......................................................................... 5-164, 5-244
IAC .........................................................................................................5-242
IEC .........................................................................................................5-241
IEEE .......................................................................................................5-240
inverse time undervoltage ........................................................5-286
types ....................................................................................................5-239

Cutout, panel ............................................................................................ 3-2
CyberSentry

FlexLogic operands .......................................................................5-213
installation ............................................................................... 3-74, 5-24
RS485 port limitation ...................................................................... 5-17
security commands ........................................................................... 7-6
security overview ................................................................................ 2-4
software options .............................................................................. 2-37
specifications ..................................................................................... 2-37
system logs ......................................................................................... 5-25

D
D400 connection ................................................................................. 3-76
Dark graphical front panel ............................................................ 5-31
Data logger

actual values ...................................................................................... 6-33
clearing ........................................................................................ 5-41, 7-2
settings ...............................................................................................5-121
specifications ..................................................................................... 2-27

Data, reading values ............................................................................ 6-1
Dataset member is empty message ....................................... 5-69
Date

firmware ............................................................................................... 6-36
last cleared oscillography date ................................................. 6-33
last PMU cleared date ................................................................... 6-34
last settings change ....................................................................... 6-36
manufacturing date ....................................................................... 6-36
set .................................................................................... 5-29, 5-112, 7-3

DCB3
FlexLogic operands .......................................................................5-215
logic diagram ...................................................................................5-361
settings ...............................................................................................5-358

DCmA inputs .......................................................................................... 6-27
actual values ...................................................................................... 6-27
FlexAnalogs .........................................................................................A-22
settings ............................................................................................... 5-375
specifications ..................................................................................... 2-30

DCmA outputs
description ........................................................................................... 3-33
settings ............................................................................................... 5-377
specifications ..................................................................................... 2-34

Decommission ................................................................................... 10-29
Default password ................................................................................ 5-14
Default settings ........................................................................ 10-7, 10-8
Default settings to factory default ...............................................7-3
Definite time curve ............................................................5-244, 5-286
Delete files and records .................................................... 5-40, 10-29
Demand metering

actual values ...................................................................................... 6-21
specifications ..................................................................................... 2-29

Demand records, clearing ....................................................5-41, 7-2
Demand, current .............................................................................. 5-123
Deploy relay ..............................................................................................8-1
Deploy settings ..................................................................................... 10-7
Device authentication ...................................................................... 5-16
Device Connectivity Report in Engineer ................................. 4-76
Device information files ..........................................................1-2, 4-76
Device overview ................................................................................... 10-1
Device setup ........................................................................................... 3-70
Diagnostic Alarm COP message ....................................................7-9
Diagnostic Alarm DSP message ....................................................7-9
Diagnostic Failure message .............................................................7-8
Diagnostics Failure message ....................................................... 7-10
Dielectric strength .............................................................................. 3-15
Digital counters

actual values .........................................................................................6-8
FlexLogic operands ...................................................................... 5-215
logic diagram .................................................................................. 5-327
settings ............................................................................................... 5-325

Digital elements
application example .................................................................... 5-324
FlexLogic operands ...................................................................... 5-216
logic diagram .................................................................................. 5-323
settings ............................................................................................... 5-322

Digital outputs
see Contact outputs

Dimensions ................................................................................................3-2
Direct Device Off message ............................................................ 7-10
Direct devices

settings ............................................................................................... 5-369
status ..................................................................................................... 6-11

Direct I/O
application example .................................................................... 5-370
configuration examples ............................................................. 5-141
settings ............................................................................................... 5-369



INDEX

F60 FEEDER PROTECTION SYSTEM – INSTRUCTION MANUAL v

Direct inputs
actual values .......................................................................................6-10
application example .....................................................................5-370
clearing counters ................................................................................ 7-2
FlexLogic operands .......................................................................5-221
settings ...............................................................................................5-369
specifications ......................................................................................2-31

Direct outputs
application example .....................................................................5-370
clearing counters ................................................................................ 7-2
settings ...............................................................................................5-369
specifications ......................................................................................2-33

Direct Ring Break message ............................................................7-10
Directional comparison blocking 3

FlexLogic operands .......................................................................5-215
logic diagram ...................................................................................5-361
settings ...............................................................................................5-358

Directional overcurrent
see Phase, Ground, and Neutral directional

Directional polarization .................................................................5-248
Directional power, sensitive actual values ...........................6-24
Directional power, sensitive specifications ..........................2-22
Disconnect switch

FlexLogic operands .......................................................................5-220
logic ......................................................................................................5-162
settings ...............................................................................................5-159

Discover button ....................................................................................3-70
Disk space required ............................................................................3-58
Display settings .....................................................................................5-26
Disposal ..................................................................................................10-31
Dispose of battery ............................................................................10-26
Disturbance detector

FlexLogic operands .......................................................................5-219
internal ................................................................................................5-152

DNP
connections remaining ..................................................................6-12
select protocol ...................................................................................5-52
settings ..................................................................................................5-53
view Points List in web browser .................................................5-56

DOS Partition Alarm message ......................................................7-10
Downed conductor ....................................................... 2-28, 6-10, 9-1
Downgrade

firmware .............................................................................................10-14
software .............................................................................................10-13

Download
files from relay ...................................................................................10-3
settings to relay .................................................................................10-7

Drag and drop files ............................................................................... 4-3
Duplicate

device settings ...................................................................................10-7
settings for upgrading ....................................................................10-5

E
Edition 1 and 2 IEC 61850 ...............................................................5-58

EGD protocol
actual values ...................................................................................... 6-11
settings ...............................................................................................5-105

Electrostatic discharge specifications .................................... 2-38
Elements ......................................................................................................5-4
End of life ...............................................................................................10-31
Energy algorithm for Hi-Z ..................................................................9-2
Energy metering

actual values ...................................................................................... 6-21
clearing ........................................................................................5-41, 7-2
specifications ..................................................................................... 2-29

Energy metering, clearing .....................................................5-41, 7-2
EnerVista UR setup

command line interface ...................................................................C-1
drag and drop files .............................................................................4-3
event recorder ......................................................................................4-2
firmware upgrade or downgrade ..........................................10-14
installation ........................................................................................... 3-59
oscillography .........................................................................................4-2
requirements ...................................................................................... 3-58
restart relay ...........................................................................................5-1

Engineer
command to force user logoff ......................................................7-6
create logic diagram ...................................................................... 4-62
Error messages ................................................................................. 4-70
toolbar ................................................................................................... 4-80
Warning messages ......................................................................... 4-71

Enhanced front panel
FlexLogic ............................................................................................5-213
interface ............................................................................................... 4-15
IP rating ................................................................................................ 2-37
keypad ................................................................................................... 4-37
labels ...................................................................................................... 4-43
LEDs ..........................................................................................4-38, 5-127
navigation ............................................................................................ 4-50
order codes ............................................................................................2-7
pushbuttons .....................................................................................5-131
Rev. 1 and 2 explained .....................................................................3-2
specifications ..................................................................................... 2-26
use, change setting ......................................................................... 4-52

Environment backup ......................................................................... 10-9
Equations

definite time curve ..........................................................5-244, 5-286
FlexCurves .........................................................................................5-244
FlexLogic ............................................................................................5-231
FlexLogic, protect ................................................................................4-9
IAC curves ..........................................................................................5-242
IEC curves ..........................................................................................5-241
IEEE curves ........................................................................................5-240

Equipment Mismatch message .........................................7-8, 7-14
Error messages .......................................................................................7-8

device not recognized ..................................................................10-13
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